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1Introduction

AutoCAD Land Development Desktop is the AutoCAD 

for land development professionals such as surveyors, 

civil engineers, and land planners. This product is 

equipped with an Application Programming Interface 

(API), so that other add-on products, such as Autodesk 

Survey Release 2 and Autodesk Civil Design Release 2, 

can be designed to work with AutoCAD Land Develop-

ment Desktop. 

In this chapter

� About AutoCAD Land 
Development Desktop

� Getting Started

� Finding Serial Numbers for 
Your Installed Programs
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About AutoCAD Land Development 
Desktop

AutoCAD Land Development Desktop Release 2i is part of the Land 
Development Solutions suite of applications for professionals in the land 
planning and development industries. The Land Development Solutions 
suite includes:

� AutoCAD Land Development Desktop Release 2i: This is the 
AutoCAD for Land Development professionals. It provides a base level of 
functionality that meets the needs of everyone in the land development 
process, including land planners, surveyors, civil engineers, drafters, and 
anyone who creates supporting documents. 

� Autodesk Survey Release 2i: An add-on to AutoCAD Land Develop-
ment Desktop that provides a streamlined ability to communicate survey 
data to and from the field. 

� Autodesk Civil Design Release 2i: An add-on to AutoCAD Land 
Development Desktop that provides transportation and site engineering 
tools, and hydrology and hydraulics design and analysis. 

For more information about Autodesk Survey and Autodesk Civil Design, see 
the Autodesk Survey User’s Guide and the Autodesk Civil Design User’s Guide.

Getting Started

Much of the basic information on how to get started with AutoCAD Land 
Development Desktop is located in the AutoCAD Land Development Desktop 
Getting Started Guide. The Getting Started Guide describes the AutoCAD Land 
Development Desktop documentation set and tells you where to look for the 
information you need. 

The Getting Started Guide also describes how to start the program and how to 
switch menu palettes so you can access all of the AutoCAD Land 
Development Desktop commands.

Path Conventions
In this documentation, c:\Program Files\Land Desktop R2 is shown as the 
folder into which AutoCAD Land Development Desktop is installed. There-
fore, all paths refer to this location.
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If you installed AutoCAD Land Development Desktop into a different folder, 
then please substitute that folder for c:\Program Files\Land Desktop R2.

Multiple Sessions of AutoCAD Land Development Desktop
Running multiple sessions of AutoCAD Land Development Desktop is now 
supported for AutoCAD Land Development Desktop Release 2i. 

Multiple Drawing Environment (MDE) Support
AutoCAD Land Development Desktop is designed to work in the Single 
Drawing Environment (SDE), as opposed to the Multiple Drawing 
Environment (MDE). This means that for each session of AutoCAD Land 
Development Desktop you have running, only one drawing can be open at a 
time per session.

However, you can run AutoCAD (without AutoCAD Land Development 
Desktop functionality) in MDE mode. When you install AutoCAD Land 
Development Desktop, an icon named Land Enabled AutoCAD is placed in 
the AutoCAD Land Development Desktop R2 program group. 

Use the Land Enabled AutoCAD icon to start an object enabled AutoCAD 
that runs in MDE mode. This version of AutoCAD has the ability to display 
custom AutoCAD Land Development Desktop objects, and you can open 
multiple drawings at a time while using it. 

NOTE You cannot use Land Development Desktop-specific functionality when 
running Land Enabled AutoCAD, but your custom AutoCAD Land Development 
Desktop objects are visible in the drawing. 

If you need to work on objects in more than one drawing at a time using 
Land Development Desktop-specific functionality, then you can run more 
than one session of AutoCAD Land Development Desktop at a time, or you 
can attach multiple drawings in the AutoCAD Map Project Workspace.

Finding Serial Numbers for Your Installed 
Programs

If you need to locate serial numbers for your installed programs, then do one 
of the following:
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� For AutoCAD Land Development Desktop, select Help ➤ About AutoCAD 
Land Development. The program's serial number is displayed at the top of 
the dialog box.

� For Autodesk Survey, select Help ➤ About Autodesk Civil Design. The 
serial number is then displayed at the command line.

� For Autodesk Civil Design, select Help ➤ About Autodesk Survey. The 
serial number is then displayed at the command line.
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2Drawing Sessions

When you first start AutoCAD Land Development 

Desktop, the AutoCAD Land Development Desktop 

Today window is displayed. From this window you can 

create a new drawing or open an existing drawing. To 

use the AutoCAD Land Development Desktop com-

mands, you must be working in a named drawing, and 

the drawing must be associated with a project. 

By default, the standard AutoCAD Land Development 

Desktop menu palette is displayed when you start a 

drawing session. If you want to use a menu palette that 

contains different menus, such as the Autodesk Civil 

Design menus, then you can load that menu palette.

In this chapter

� Starting a Drawing Session from 
the Start Up Dialog Box

� Starting a New Drawing

� Opening an Existing Drawing

� Using Menu Palettes

� Unloading Applications
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Drawing Sessions

You can use the following links to start a new drawing, load menu palettes or 
unload an application.

Starting a Drawing Session

When you start AutoCAD Land Development Desktop, the AutoCAD Land 
Development Desktop Today window is displayed. 

The My Drawings area of Today contains an Open/Create tab. Using the 
options on this tab, you can open drawings, create new drawings, and access 
the Project Manager.

Today provides quick access to your drawings. One of the Today options is to 
display the four most recently used drawings. Hold your cursor over a draw-
ing name to show a preview, and click once to open that drawing. If you want 
to view drawings by history, select one of the other display options from the 
Select how to begin list. For example, you can view drawings by file name, by 
date, and by location.

To open drawings by specifying the project name they are associated with, 
click the Open button on the Open/Create tab to display the Open Drawings: 
Project Based dialog box. 

If you close Today, you can reopen it by typing today at the command line, 
by clicking the Today icon in the Toolbar, or by selecting the Today command 
from the Help menu.

Starting a New Drawing

AutoCAD Land Development Desktop uses an enhanced, project-based, New 
command for creating new drawings. By selecting a project to associate the 
drawing with, the drawing is created in the correct folder for the project 
automatically.

AutoCAD Land Development Desktop requires that a drawing be named to 
be associated with a project. The unnamed “drawing.dwg” cannot be 
associated with a project.
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NOTE This topic describes how to use the AutoCAD Land Development 
Desktop New command. If you chose to use the AutoCAD New command in the 
User Preferences, then see “Starting AutoCAD” in the AutoCAD User’s Guide for 
more information. 

������������	
����
��

� Do one of the following to display the New Drawing: Project Based dialog 
box:

� Upon initialization, click New on the Open/Create Drawings tab in the 
AutoCAD Land Development Desktop Today window.

� From the File menu, choose New.
� Type New at the command line.

� Under Drawing Name, type the name of the drawing you want to create.

The drawing name can be up to 255 characters, including path and file exten-
sion, and it must be unique. You cannot create two drawings with the same 
name in the same drawing folder. It is not necessary to add .dwg to the end 
of the name; the drawing file extension is created automatically.

� Under Project and Drawing Location, do one of the following:
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� Select an existing project. For more information, see “Selecting an Existing 
Project from the New Drawing: Project Based Dialog Box” on page 8.

� Create a new project. For more information, see “Creating a New Project 
from the New Drawing: Project Based Dialog Box” on page 10.

NOTE For detailed information about projects, see “AutoCAD Land 
Development Desktop Projects” on page 24.

� Under Select Drawing Template, select a drawing template. The Preview win-
dow shows a preview of the drawing template.

If the template you want to use is not visible in the list, then click Browse to 
locate it. You can select the Show sub-folders check box to view the files 
inside any sub-folders that may exist in the template folder. For more infor-
mation about drawing templates, see “Basing a Drawing on a Drawing Tem-
plate” on page 8.

� Click OK.

Basing a Drawing on a Drawing Template

When you create a new drawing, you can base it on a drawing template. A 
drawing template is a drawing file with pre-established settings for new draw-
ings and has the extension .dwt. For example, you can set up all your stan-
dard layers in a drawing and save the drawing as a .dwt file. If you base a new 
drawing on this template, then the new drawing is created with all your stan-
dard layers. Templates also store text styles, line types, dimension styles, and 
AutoCAD variables like Aperture. They can also store blocks, such as a border 
or a company logo. 

A template also stores drawing setup values. For example, if you use the 
Drawing Setup Wizard or the Drawing Setup command to set up a drawing, 
and then you save that drawing as a .dwt file, then the next time you create 
a new drawing based on the drawing template, all of the drawing setup val-
ues will be loaded.

Selecting an Existing Project from the New 
Drawing: Project Based Dialog Box

����	�	������	�����������	����������	��	
����
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� Complete steps 1–2 in “Starting a New Drawing” on page 6.
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� Under Project and Drawing Location, select a Project Path from the list. Select 
the folder in which the project you want to select is stored. By default, the 
project path is c:\Land Projects R2. 

If the list does not show a project path, then you can browse for one by click-
ing the Browse button to display the Browse for Folder dialog box.

� Locate the path and click OK to return to the New Drawing: Project Based 
dialog box.

� Under Project Name, select the name of the project you want to associate the 
new drawing with. This list shows all projects stored in the Project Path that 
you selected in step 2. 

If this list does not show the project name that you want to select, then verify 
that you selected the correct Project Path in step 2.

TIP Click Filter Project List to filter the project list by keyword or creator. For 
more information, see “Using Filters to Find a Project” on page 11.

� The Drawing Path shows where the drawing is created. If the drawing path 
has any sub-folders, then you can choose a sub-folder. Otherwise, this path 
is fixed. 

This path is based on the drawing location that you specify when you create 
a new project. For example, the recommended storage location for drawings 
is in the <project name>\dwg folder. If you create a sub-folder in the drawing 
storage location, such as <project name>\dwg\plotting, then it is also listed 
in the Drawing Path list for you to choose.
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Creating a New Project from the New Drawing: 
Project Based Dialog Box
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� Complete steps 1–2 in “Starting a New Drawing” on page 6.

� Under Project and Drawing Location, click Create Project to display the 
Project Details dialog box. 

� Under Initial Settings for New Drawings, select the prototype to base the 
project on. A prototype contains default settings for new drawings associated 
with the project. 

� Under Project Information, type a Name for the project. This name can be up 
to 64 characters. 

� Type a Description for the project. This description can be up to 255 
characters. 

! You can type keywords for the project. Type a comma or press SPACEBAR to 
separate each keyword. Keywords can help you identify a project when you 
are searching for a project. For example, you could use a keyword called 
“county” to help you locate all your county projects.

" Under Drawing Path for this Project, select one of the following options to 
determine where drawings that you create in this project are stored:
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� Select Project “DWG” Folder if you want to store the drawings in the DWG 
folder in the project folder, c:\Land Projects R2\<project name>\dwg. 
This is the recommended location for storing drawings, because it keeps 
all the project files together.

� Select Fixed Path, and type or browse for a path for the drawings. 

# Click OK to create the project and return to the New Drawing: Project Based 
dialog box.

NOTE For detailed information about projects and prototypes, see “AutoCAD 
Land Development Desktop Projects” on page 24 and “Prototypes” on page 
41.

Using Filters to Find a Project 

When you click Filter Project List from the New Drawing: Project Based dia-
log box, the Project Filter Criteria dialog box is displayed. For more informa-
tion about the New Drawing: Project Based dialog box see “Starting a New 
Drawing” on page 6.

���$�	�����	�����������������	��

� From the Keywords list, select the keyword you want to search for. If you do 
not want to search by keyword, then select Unfiltered by keyword. 

� From the Created By list, select the AutoCAD login name of the person who 
created the project. If you do not want to search by the person who created 
the project, then select Unfiltered by created by.
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The filtered list of projects is displayed in the Filtered Projects List. 

TIP If you want to save the filtered project list, then select the Save filter criteria 
check box. 

� Click OK to return to the previous dialog box.

The Name list now contains only the list of projects that you filtered on.

� Select the project that you want to use from the Name list.

Opening an Existing Drawing

AutoCAD Land Development Desktop uses an enhanced, project-based, 
Open command for opening drawings. First select the project to work with, 
and then select the drawing to open from a list of available drawings. If you 
need to search for a drawing outside of the project folder, then use the Browse 
button to open the drawing.

NOTE Only one drawing can be open at a time with AutoCAD Land 
Development Desktop Release 2.

NOTE This topic describes how to use the AutoCAD Land Development 
Desktop Open command. If you selected the User Preference for using the 
AutoCAD Open command, then see “Opening Existing Drawings” in the 
AutoCAD User’s Guide. 

�����	�����	����������
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� Do one of the following to display the Open Drawing: Project Based dialog 
box:

� Upon initialization, click Open on the Open/Create Drawings tab in the 
AutoCAD Land Development Desktop Today window.

� From the File menu, choose Open.
� Type Open at the command line.
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� Under Project and Drawing Location, select a Project Path from the list. Select 
the folder in which the project you want to select is stored. By default, the 
project path is c:\Land Projects R2. 

You can click Browse to locate a project path if it is not shown in the list. 

TIP Click Filter Project List to filter the project name list by keyword or creator. 
For more information, see “Using Filters to Find a Project” on page 11.

� Under Project Name, do one of the following:

� Select the name of the project that contains the drawing you want to 
open. This list shows all the projects stored in the Project Path you 
selected in step 2. 

NOTE If this list does not show the project name that you want to select, 
then verify that you selected the correct Project Path in step 2.

When you select the project, the Drawing Path shows where the drawing 
is stored. If the drawing path has any sub-folders, then you can choose a 
sub-folder. Otherwise, this path is fixed. 



14 | Chapter 2 Drawing Sessions

This path is based on the drawing location that you specify when you cre-
ate a new project. For example, the recommended storage location for 
drawings is in the <project name>\dwg folder. If you create a sub-folder in 
the drawing storage location, such as <project name>\dwg\plotting, then 
it is also listed in the Drawing Path list for you to choose.

� Select *By Drawing* to select the drawing to open without having to spec-
ify which project the drawing is associated with. When you select *By 
Drawing*, the Drawing Path list shows all of the sub-folders in your 
project folder. Select a drawing path from the list and then select the Show 
sub-folders check box. All the drawings located in the selected folder are 
then listed in the Select Project Drawing list. 

NOTE When you open a drawing using the *By Drawing* option, the 
drawing automatically finds the associated project. It does this by searching 
through all project paths listed in the dialog box. If the same project is found 
in more than one path, then you are prompted to select the correct path.

� Under Select Project Drawing, select the drawing you want to open. The pre-
view window displays a preview of a drawing.

If the drawing is located in a sub-folder of the Drawing Path, then you can 
select the Show Sub-folders check box to display the contents of any sub-
folders that exist in the Drawing Path.

NOTE If the drawing you want to open is not located in a project drawing 
path, then use the Browse button to search for the drawing. 

� Click OK.

NOTE If the drawing is associated with a project name that is different than 
the project selected, then you are prompted to choose a project. 

Accessing the Project Management Dialog Box 
from the Today Window

From the Project Management dialog box, you can locate a project, create or 
remove a project path, search for a project, create a project, and much more.
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� Display the Today window by starting AutoCAD Land Development Desktop, 
by typing today at the command line, or by clicking the Today icon.

� Click Project Manager on the Open/Create tab to display the Project Manage-
ment dialog box. For more information, see “Managing Projects” on page 26.

Using Menu Palettes

AutoCAD Land Development Desktop menus are arranged in palettes. A 
menu palette defines which pull-down menus appear on screen. The default 
menu palettes that are installed with AutoCAD Land Development Desktop 
include the following:

� Land Desktop R2i: A menu palette that contains all the AutoCAD Land 
Development Desktop menus (Projects, Points, Lines/Curves, Alignments, 
Parcels, Labels, Terrain, Inquiry, Utilities, Help), the Map menu, and the 
AutoCAD File, Edit, and View menus. This menu palette is loaded by 
default when you start AutoCAD Land Development Desktop for the first 
time.

� Land Desktop R2 Completei: A menu palette that contains all the 
AutoCAD Land Development Desktop menus, the Map menu, and the 
AutoCAD File, Edit, View, Insert, Format, Tools, Draw, Dimension, and 
Modify menus.

� AutoCAD Map 2000i: A menu palette that contains the standard 
AutoCAD Map 2000 menu, the AutoCAD Land Development Desktop 
Projects menu, and the AutoCAD File, Edit, View, Insert, Format, Tools, 
Draw, Dimension, and Modify menus.

� Civil Design R2i (If installed): A menu palette that contains the Civil 
Design menus (Grading, Layout, Profiles, Cross Sections, Hydrology, 
Pipes, Sheet Manager), the AutoCAD Land Development Desktop Projects, 
Points, Terrain, Alignments, Inquiry, Utilities, and Help menus, the Map 
menu, and the AutoCAD File, Edit, and View menus.

� Survey R2i (If installed): A menu palette that contains the Survey menus 
(Data Collection/Input, Analysis/Figures), the AutoCAD Land 
Development Desktop Projects, Points, Lines/Curves, Labels, Terrain, 
Inquiry, Utilities, and Help menus, the Map menu, and the AutoCAD File, 
Edit, and View menus.

NOTE Menu palettes with toolbars are not supported in AutoCAD Land 
Development Desktop Release 2. 
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To create a custom menu palette, you can use the MENULOAD command to 
set up the AutoCAD, AutoCAD Map, and AutoCAD Land Development 
Desktop menus the way you want them, and then save this configuration as 
a palette.

Menu palettes are saved in the following folder:

c:\Land Desktop R2\data\Menu Palettes

Release 2i menu palettes have the file extension .apm2, whereas Release 1 
menu palettes have the file extension .apm.

Restoring Original Palettes
If you customize the default menu palettes and you want to return to the 
original palettes, backups are stored in the \data\Menu Palettes\Original 
folder. You can copy these palettes up one level to the \data\Menu Palettes 
folder to restore the original palettes.

Selecting a Menu Palette

By default, the Land Desktop R2i menu palette is displayed the first time that 
you run AutoCAD Land Development Desktop. You can select a different 
menu palette, such as the Land Desktop R2i Complete menu palette, if you 
want to access different menus.

There are three different ways to select a menu palette. You can select a menu 
palette from the Menu Palette Manager dialog box, you can use a macro, or 
you can use a command-line command. For more information, see “Select-
ing a Menu Palette by Using a Macro” on page 17 and “Selecting a Menu Pal-
ette by Using a Command at the Command Line” on page 18.

����	�	������	�$����	��	��������	�%	�$����	��	�%���	�������� ��

� From the Projects menu, choose Menu Palettes to display the Menu Palette 
Manager dialog box. Or, type MP at the command line.
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� Select the menu palette that you want to load.

� To use AutoCAD Land Development Desktop commands, select the Land 
Desktop R2i palette. 

� To use AutoCAD Land Development Desktop and commands in the 
AutoCAD Insert, Format, Tools, Dimension, and Modify menus, select the 
Land Desktop R2i Complete palette. 

� If you have Autodesk Civil Design installed and want to use Civil Design 
commands, then select the Civil Design R2i menu palette.

� If you have Autodesk Survey installed and want to use Survey commands, 
then select the Survey R2i menu palette.

� To use the AutoCAD Map 2000i menu palette, select the AutoCAD 
Map 2000i palette.

� Click Load.

Selecting a Menu Palette by Using a Macro

����	�	������	�$����	��	� &�$�����������

� Type one of the following macros at the command line to quickly load a 
menu palette:

� MLD: AutoCAD Land Development Desktop 
� MLC: AutoCAD Land Development Desktop with additional 

AutoCAD menus
� MCD: Autodesk Civil Design
� MSV: Autodesk Survey
� MMP: AutoCAD Map 2000
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Selecting a Menu Palette by Using a Command at 
the Command Line

�����������	�$����	��	������	������������	

� Type (AeccLoadMenuPalette “MenuPaletteName”) at the command line. 

For example, to load the Land Desktop R2i menu palette, type the following:

(AeccLoadMenuPalette “Land Desktop R2i.apm2”)

Creating a Menu Palette

You can create a new menu palette that contains the menus that you use fre-
quently. Configure the AutoCAD, Map, and AutoCAD Land Development 
Desktop menus the way you want them, and then save the configuration as 
a menu palette. Menu palettes make it easy to switch between different 
menus when you focus on different aspects of a project.

Menu palettes are saved in the following folder:

c:\Land Desktop R2\data\Menu Palettes

Release 2 menu palettes have the file extension, .apm2.

NOTE If Autodesk Survey and Civil Design are installed, then you can also cre-
ate menu palettes that include the menus from these programs. 

NOTE Menu palettes with toolbars are not supported in AutoCAD Land 
Development Desktop Release 2. 

�����	��	����	�$����	��	

� Use the MENULOAD command to select which pull-down menus you want 
to include in the menu palette.

� Click the Menu Bar tab.
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� From the Menu Group, choose a program to display the menus for that 
program.

� Use the Insert, Remove, or Remove All buttons to add or delete menus to the 
Menu Bar.

� Click Close.

! From the Projects menu, choose Menu Palettes to display the Menu Palette 
Manager dialog box.

" Click Save to display the Save Menu Palette dialog box.

# In the Name box, type the name for the new palette.

' In the Description box, type the description of the new palette. You may 
want to include the names of the menus in this description.

�( Click OK to return to the Menu Palette Manager dialog box.
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�� Click Close.

The menu palette is saved to the following folder with an .apm2 file 
extension:

c:\Land Desktop R2\data\Menu Palettes

Changing the Name or Description of a Menu 
Palette

You can change the name or description of a menu palette. For example, if 
you copy a menu palette and make changes to the copy, you may want to 
alter the description of that palette.

�������	���	����	�����	����������������	�$����	��	

� From the Projects menu, choose Menu Palettes to display the Menu Palette 
Manager dialog box.

� Select the menu palette that you want to rename.

� Click Rename to display the Rename Menu Palette dialog box.

� Do one or both of the following:

� In the Name box, type a new name.
� In the Description box, type a new description.

� Click OK to return to the Menu Palette Manager dialog box.

! Click Close.

Saving a Menu Palette

You can create a new menu palette that contains the menus that you use fre-
quently. Configure the AutoCAD, Map, and AutoCAD Land Development 
Desktop menus the way you want them, and then save the configuration as 
a menu palette. Menu palettes make it easy to switch between different 
menus when you focus on different aspects of a project.
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Menu palettes are saved in the following folder:

c:\Land Desktop R2\data\Menu Palettes

Release 2 menu palettes have the file extension .apm2.

NOTE If Autodesk Survey and Civil Design are installed, then you can also cre-
ate menu palettes that include the menus from these programs. 

NOTE Menu palettes with toolbars are not supported in AutoCAD Land 
Development Desktop Release 2. 

�����)	����	�$����	��	

� From the Projects menu, choose Menu Palettes to display the Menu Palette 
Manager dialog box.

� Click Save to display the Save Menu Palette dialog box.

� In the Name box, type the name for the new palette.

� In the Description box, type the description of the new palette.

� Click OK to save the menu palette and return to the Menu Palette Manager 
dialog box.

! Click Close.

The menu palette is saved to the following folder with an .apm2 file 
extension:

c:\Land Desktop R2\data\Menu Palettes

Deleting a Menu Palette

����	�	�	����	�$����	��	

� From the Projects menu, choose Menu Palettes to display the Menu Palette 
Manager dialog box.

� Select the name of the menu palette that you want to delete.

� Click Delete to display a warning dialog box.
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� Click Yes if you want to delete the menu palette, or click No to cancel the 
command.

� Click Close.

Unloading Applications

To unload Autodesk Civil Design or Autodesk Survey floating licenses with-
out exiting AutoCAD Land Development Desktop, you can use the Unload 
Applications command. 

Unloading Civil Design

You can use the Unload Applications ➤ Autodesk Civil Design command to 
unload Civil Design and free up a floating license for someone else to use.
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� From the Projects menu, click Unload Applications ➤ Autodesk Civil Design.

Unloading Survey

You can use the Unload Applications ➤ Autodesk Survey command to 
unload Survey and free up a floating license for someone else to use.
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� From the Projects menu, click Unload Applications ➤ Autodesk Survey.
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3Projects and Prototypes

When you install AutoCAD Land Development 

Desktop, a projects folder is created. Projects act as a 

central location for shared files. Use the Project Manager 

command to create, copy, delete, and rename projects.

Projects are based on prototypes. You can assign draw-

ing settings to prototypes, and then when you create a 

new drawing in a project, the default drawing settings 

for the new drawing are copied from the prototype.

In this chapter

� AutoCAD Land Development 
Desktop Projects

� Managing Projects

� Project Locks

� Associating the Current 
Drawing with a Different 
Project

� Prototypes

� Managing Prototypes
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AutoCAD Land Development Desktop 
Projects

AutoCAD Land Development Desktop uses projects to manage and organize 
all the data for a job that you are working on. This data includes the project 
point file, alignment database, parcel database, surface database, drawing 
files, and more. 

� You can assign a drawing to only one project, but you can change the 
project association if necessary. The project association is stored in the 
drawing file.

� Projects can contain many drawings. 
� All the drawings in a project share the same data files.
� You are prompted to select a project if you open an existing drawing that 

is not assigned to a project, or if the project is not found. This assignment 
is saved when you save the drawing.

When you install AutoCAD Land Development Desktop, a project folder 
(c:\Land Projects R2, by default) is created. When you create a project, a sub-
folder named <project name> is created within the project folder. For exam-
ple, if you create a project named 97201, then Land Development creates the 
following folder:

c:\Land Projects R2\97201

NOTE You can change the Project Path or add new paths by using the Project 
Management dialog box. For more information, see “Managing Projects” on 
page 26.

You must assign every drawing to a project. When you start a new drawing, 
you are prompted to select a project for the drawing. You can either create a 
new project or assign the drawing to an existing project. The drawing stays 
associated to that project as long as the project exists in the current Project 
Path. If you delete the project or if you change the project path, then you are 
prompted to select the project the next time you open the drawing. You can 
also associate an existing drawing (already assigned to a project) with a dif-
ferent project by using the Reassociate Drawing command. For more infor-
mation, see “Associating the Current Drawing with a Different Project” on 
page 38.
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NOTE AutoCAD Land Development Desktop requires drawings to be associ-
ated with projects so that it has a location in which to store its external files. If 
you open a drawing, or create a new drawing, without using the AutoCAD Land 
Development Desktop versions of the New and Open commands, you will be 
prompted to select a project with which to associate the drawing. If you decline 
to select a project, then AutoCAD Land Development Desktop automatically cre-
ates a project called “_scratch” and attaches the drawing to it so that AutoCAD 
Land Development Desktop can function.

When you create a new project, you must specify a prototype (default set-
tings for new drawings that are associated with the project) and a name for 
the project. You can also add a description of the project and any keywords 
that help you identify the project; these can be very helpful if you have many 
projects. You can filter the list of projects based on the keywords to find a par-
ticular project, and then check the description to make sure it is the project 
you are looking for.

Although it is not required, we suggest that you save your drawings in the 
\dwg subfolder that is created in your project folder. This keeps the drawing 
and the project files together for easier archiving.

Creating Projects Outside of AutoCAD Land Development 
Desktop
It is not recommended to use Windows Explorer to create folders to use for 
AutoCAD Land Development Desktop projects. Use the Project Manager 
instead. The Project Manager ensures that the proper folder structure is cre-
ated and the correct default files are copied into the new project. For more 
information, see “Creating a Project Using the Project Management Dialog 
Box” on page 28.
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Managing Projects

From the Project Management dialog box, you can locate a project, create or 
remove a project path, search for a project, create a project, and much more.

Adding a Project Path by Using the Project 
Management Dialog Box

Projects are stored in a folder called the project path. By default, the project 
path is c:\Land Projects R2. You can change the project path and store mul-
tiple paths as needed.
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Under Project Location, click the Browse button.

� Select the folder for the project path and then click OK.

This creates a new project path in which you can create projects.
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Removing a Project Path by Using the Project 
Management Dialog Box
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Under Project Location, select the path you want to remove from the Path 
list. 

� Click Remove.

NOTE This just removes the path from the list. It does not delete folders or 
files. 

Selecting a Project When Using the Project 
Management Dialog Box

To use the Project Management dialog box to rename, copy, or delete 
projects, you must first select the project that you want to work with. 
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Under Project Location, select a project path from the Path list. Select the 
folder in which the project you want to select is stored. By default, the project 
path is c:\Land Projects R2. 

You can click Browse to look for a project path if it is not shown in the list, 
you can click Remove to remove a project path if it is no longer valid, and 
you can create a new project path. 

� Under Project, do one of the following:

� Select a project from the Name list.
� Click Filter Project List to filter the project list by keyword or creator. For 

more information, see “Finding a Project Using Filters” on page 28.
� Create a new project. For more information, see “Creating a Project Using 

the Project Management Dialog Box” on page 28.
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Finding a Project Using Filters

When you click Filter Project List, the Project Filter Criteria dialog box is dis-
played. You can filter on keywords that you assigned to projects, or you can 
filter on the login name of the person who created the project.
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� From the Keywords list, select the keyword you want to search for. If you do 
not want to search by keyword, then select Unfiltered by keyword. 

� From the Created By list, select the AutoCAD login name of the person who 
created the project. If you do not want to search by the person who created 
the project, then select Unfiltered by created by.

The filtered list of projects is displayed in the Filtered Project List. 

� Click OK.

TIP If you want to save the filter settings, then select the Save filter criteria 
check box. 

� Select the project you want to use.

Creating a Project Using the Project 
Management Dialog Box
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Click Create New Project to display the Project Details dialog box. 
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� Under Initial Settings for New Drawings, select the prototype to base the 
project on. A prototype contains default settings for new drawings associated 
with the project.

� Under Project Information, type a name for the project in the Name box. 
This name can be up to 64 characters. 

� In the Description box, type a description for the project. This description 
can be up to 255 characters. 

 In the Keywords box, you can type keywords for the project. Type a comma 
or press SPACEBAR to separate each keyword. Keywords can help you identify 
a project when you are searching for a project. For example, you could use a 
keyword called “county” to help you locate all your county projects.

! Under Drawing Path for this Project, select one of the following options to 
determine where drawings that you create in this project are stored:

� Select Project “DWG” Folder if you want to store the drawings in the DWG 
folder in the project folder (c:\Land Projects R2\<project name>\dwg). 
This is the recommended location for storing drawings, because it keeps 
all the drawing and project files together.

� Select Fixed Path and then browse for a path for the drawings. 

" Click OK to create the project and return to the Project Management dialog 
box.
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Changing the Project Detail Settings When 
Using the Project Management Dialog Box

For each project, you can assign a project description and project keywords. 
You can also choose a location in which the drawing files associated with the 
project are stored. These settings are called the project detail settings.
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Click Project Details to display the Project Details dialog box.

� You can do any of the following:

� Change the project description. The description can be up to 255 
characters.

� Change the project keywords.
� Change the drawing path for the project. Select Project “DWG” Folder if 

you want to store the drawings in the DWG folder in the project folder 
(c:\Land Projects R2\<project name>\dwg). This is the recommended 
location for storing drawings, because it keeps all the project files together. 
Or, you can select Fixed Path and then type or browse for a path.

NOTE Changing the drawing path for the project does not move any 
existing drawings. 

� Click OK to return to the Project Management dialog box.

Copying a Project

You can use an automated command to copy a project. The Copy option in 
the Project Management dialog box copies everything that is in the 
c:\Land Projects R2\<project name> folder. 

When you copy the project, you are asked if you want to change the associ-
ation of the drawings in that project. This means that the drawings will point 
to the new, copied project. 

NOTE Do not use Windows Explorer to copy a project. 
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Select the project that you want to copy. For more information, see “Selecting 
a Project When Using the Project Management Dialog Box” on page 27.

NOTE You cannot copy the current project. 

� Click Copy to display the Copy dialog box. 

The details of the project you are copying are listed under Copy Project From. 

� Under Copy Project To, select a path for the copied project. 

NOTE You can select only defined project paths from this list. If you want to 
copy the project to a folder other than what is listed in the Path list, then click 
Cancel to return to the Project Management dialog box and create a new project 
path. 

� In the Name box, type a name for the new project. This name can be up to 
64 characters. 

 In the Description box, type a description for the project. This description 
can be up to 255 characters. 

! In the Keywords box, you can type keywords for the project. Type a comma 
or press SPACEBAR to separate each keyword.

" Click OK.
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If there are drawings in the project you are copying, then a message dialog 
box is displayed, asking if you want to change the association of drawings so 
they will point to the new, copied project. 

NOTE The Copy command copies only the drawing files that are stored in the 
project folder structure. 

$ Click Yes to associate the copied drawings with the copied project, or click 
No if you want the copied project drawings to retain their original project 
association.

Deleting a Project

You can use an automated command to delete a project. The Delete option 
in the Project Management dialog box deletes everything in the <project 
name> folder, including the drawing files if they are located in the project 
folder.

NOTE You can also use Windows Explorer to delete a project. Just delete 
everything in the <project name> folder. 
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Select the project you want to delete. For more information, see “Selecting a 
Project When Using the Project Management Dialog Box” on page 27.

NOTE You cannot delete the current project. 

� Click Delete.

A warning dialog box is displayed to inform you that the Delete command 
permanently deletes the files and folders within the project folder. This com-
mand deletes the project drawings if they are stored within the <project 
name> folder.
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� Click Yes to delete the project.

Renaming a Project

You can use an automated command to rename a project. The Rename 
option in the Project Management dialog box renames the 
c:\Land Projects R2\<project name> folder to the new name. If drawings are 
located in the project folder you want to rename, then you are asked if you 
want to associate the drawings with the new project name. 

NOTE Do not use Windows Explorer to rename a project.
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� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Select the project you want to rename. For more information, see “Selecting 
a Project When Using the Project Management Dialog Box” on page 27. 

NOTE You cannot rename the current project.

� Click Rename to display the Rename dialog box.
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� Under Rename Project To, type a new name for the project in the Name box. 

 If needed, you can type a new description in the Description box and type 
new keywords in the Keywords box. Type a comma or press SPACEBAR to sep-
arate each keyword.

! Click OK.

If there are drawings in the project you are renaming, then a message dialog 
box is displayed, asking if you want to change the project associations for all 
drawings found in the project. 

" Click Yes to associate the drawings with the renamed project, or click No if 
you want the project drawings to retain their original project association.
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Project Locks

To support the multi-user environment, AutoCAD Land Development 
Desktop places locks on specific project data files when they are accessed dur-
ing a drawing session. Project locks prevent multiple people from changing 
the same project data simultaneously.

� Some locks protect access to individual files, others protect entire data 
folders.

� Some data files can be accessed by one person at a time. After someone 
locks the data file, everyone else is denied access.

� Other data files let the first person access the data file with read/write 
capabilities; anyone else who accesses the file has read-only status and 
cannot edit the data.

� The point database allows several people to access the file with read/write 
capabilities so that more than one person can modify the data file. These 
locks are created to prevent other people from changing the point data-
base Open Mode to single-user when multiple people are working with 
the database.

Lock files are created and removed automatically by AutoCAD Land 
Development Desktop. The locks are created in the project folders and have 
the file extension .lk#. These locks contain information about the data files 
that have been locked, the owner of the lock, and when the lock was created. 
The locks are automatically removed from project data files when someone 
completes a procedure that releases the file, or ends the drawing session.

NOTE AutoCAD login names are used to identify the owners of project locks. 
Each person working on a project must have a unique AutoCAD login name in 
order for locks to work correctly. 

If a drawing session ends unexpectedly, through an event such as a power 
failure or system error, then the lock files may remain in the project folders 
even though the drawing session has ended. In a single-user setting, the lock 
files are removed automatically the next time the project data is accessed. In 
a multi-user setting, you can use the Project Management dialog box to man-
ually delete the locks. 

Managing Locked Files in a Project

Use the Project Management dialog box to view which files in a project are 
locked, and who currently owns the locks. The lock owner is the person who 
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opens the file first, locking the project files so that other people cannot make 
changes to them.

You can also delete project locks. While you never want to delete a project 
lock for someone currently working on a project, you may need to delete 
project locks in the event of a power failure or system error.

WARNING! Clicking Cancel does not restore project locks if you have already 
clicked the Delete or Delete All buttons.

����������������%���������
������

���	
����

� From the Projects menu, choose Project Manager to display the Project 
Management dialog box.

� Select the project from which you want to view and/or remove locks. For 
more information, see “Selecting a Project When Using the Project Manage-
ment Dialog Box” on page 27. 

� Click File Locks to display the Project File Locks dialog box. 

NOTE If a project contains no lock files, then a message dialog box is displayed 
informing you that there are no lock files. 

Under Lock Files, the lock files for the selected project are displayed, with the 
following information for each lock:
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� File: Displays the location and name of the lock file.
� Label: Displays the name of the data file that is locked.
� Type: Displays the current access rights of the locked file. The letter r indi-

cates that the file owner has the file in a read-only state; w indicates the 
file is in a read/write state; and s indicates that the file is shared. Shared 
means that the lock owner has read-write access to the alignment but 
another user can obtain read-only access to it.

� Owner: Displays the AutoCAD login name of the person who created the 
lock file.

� Date/Time: Displays the date and time when the lock file was created.

� Select a method of displaying the locks:

� Click Display All to display all the locks for the current project.
� Click By Owner to display the locks for one person at a time. 

The Project Owners dialog box is displayed.

� Under Lock Owners, select the owner whose locks you want to display.

NOTE Select the Display All Locks check box if you want to display all the locks 
in the project. 

 If you need to manually delete a lock, such as in the event of a power failure, 
then do one of the following:

� Select the lock that you want to delete and click Delete. You can select the 
lock by clicking any of the four lines that contain the lock information. 
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� Click Delete All to delete all project locks currently displayed in the Lock 
Files list. To delete the locks for one person, click By Owner to display only 
the lock files for that person, then click Delete All. The lock files that are 
not displayed in the Lock Files list are not affected.

WARNING! Never delete the lock files for anyone else who currently has 
access to the project. This may result in data corruption or loss of data. 

! Click OK to return to the Project Management dialog box. 

For more information about Alignment Database locking, see “Alignment 
File Locking” on page 428.

Associating the Current Drawing with a 
Different Project

You can change which project the current drawing is associated with. For 
example, you may need to re-associate a drawing if you create a new drawing 
but accidentally select the wrong project.
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� From the Projects menu, choose Reassociate Drawing.

A message box is displayed, informing you that you must save and reopen 
the drawing if you change the project association for the current drawing. 
Until you close the drawing it remains associated with the original project.

� Click Yes to display the Select or Create a Project dialog box.
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NOTE Re-associating a drawing does not change the drawing folder location. 
After closing the drawing, use Windows® Explorer if you want to move the draw-
ing to a new location. 

For more information on using the Select or Create a Project dialog box, see 
the topics that follow.

Selecting or Creating a Project

If you open a drawing that is not associated with a project, or if you select 
the Reassociate Drawing command, then you are prompted to attach the 
drawing to an existing project or create a new project for the drawing. All 
drawings must be associated with a project if you want to use the AutoCAD 
Land Development Desktop commands. AutoCAD and Map commands do 
not require drawings to be associated with a project.

You may be prompted to select or create a project if the drawing was origi-
nally created in AutoCAD or AutoCAD Map, if you deleted a project but 
saved the project drawing, if you moved the drawing out of the drawing 
folder of the project, or if you are using the Reassociate Drawing command.

Attaching a Drawing to an Existing Project

In some instances, such as when you run the Reassociate Drawing command, 
you are prompted to select a project or create a new project to associate a 
drawing with.
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� Display the Select or Create a Project dialog box. The Select or Create a 
Project dialog box is displayed whenever you open a drawing that is not asso-
ciated with a project. In addition, it is displayed when you select Reassociate 
Drawing from the Projects menu.
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� Under Project Information, select a project path from the Path list. By 
default, the project path is c:\Land Projects R2. 

You can click Browse to look for a project path if it is not shown in the list. 

� Do one of the following:

� From the Name list, select the project you want to associate the drawing 
with.

� Click Filter Project List to filter the project list by keyword or creator, and 
then select the project you want to associate the drawing with. For more 
information, see “Finding a Project Using Filters” on page 28.

� Click OK.

NOTE Attaching a drawing to a project does not move the drawing to the 

project’s drawing folder. To move the drawing, use Windows® Explorer. 

Associating a Drawing with a New Project

In some instances, such as when you run the Reassociate Drawing command, 
you are prompted to select a project or create a new project to associate a 
drawing with.
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� Display the Select or Create a Project dialog box.

The Select or Create a Project dialog box is displayed whenever you open a 
drawing that is not associated with a project. In addition, it is displayed when 
you select Reassociate Drawing from the Projects menu.

� Under Project Information, click Create Project to display the Project Details 
dialog box.

� Under Initial Settings for New Drawings, select the prototype to base the 
project on. 

� Under Project Information, type a name for the project in the Name box. 
This name can be up to 64 characters. 

� In the Description box, type a description for the project. This description 
can be up to 255 characters. 

 In the Keywords box, you can type keywords for the project. Type a comma 
or press SPACEBAR to separate each keyword.

! Under Drawing Path for this Project, select one of the following options to 
determine where drawings that you create in this project are stored:
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� Select Project “DWG” Folder if you want to store the drawings in the DWG 
folder in the project folder (c:\Land Projects R2\<project name>\dwg). 
This is the recommended location for storing drawings, because it keeps 
all the project files together.

� Select Fixed Path and either type a path or click Browse to select a path. 

" Click OK to create the project and return to the Select or Create a Project dia-
log box.

$ In the Name box, verify that the new project name is listed.

�& Click OK.

Displaying Project Details for an Existing Project

For each project, you can assign a project description and project keywords. 
You can also choose a location in which the drawing files associated with the 
project are stored. These settings are called the project detail settings.
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� Display the Select or Create a Project dialog box.

The Select or Create a Project dialog box is displayed whenever you open a 
drawing that is not associated with a project. In addition, it is displayed when 
you select Reassociate Drawing from the Projects menu.

� Click Project Details to display the Project Details dialog box.

� You can change any of the following:

� The project description.
� The project keywords.
� The drawing location for the project. Select Project “DWG” Folder if you 

want to store the drawings in the DWG folder in the project folder 
(c:\Land Projects R2\<project name>\dwg). This is the recommended 
location for storing drawings, because it keeps all the project files together. 
Or, you can select Fixed Path and either type a path, or click Browse to 
select a path. 

� Click OK to return to the Select or Create a Project dialog box.

Prototypes

AutoCAD Land Development Desktop uses prototypes as a convenient way 
for you to maintain standard settings for your drawings. After you set up the 
drawing settings by using the Drawing Settings command on the Projects 
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menu, you may want to save them back to a prototype and use them when-
ever you create a new drawing. When you create a new project, you can select 
a prototype to use for the default settings for new drawing creation. 

NOTE For more information about changing drawing settings and saving 
them to prototypes, see “Changing the AutoCAD Land Development Desk-
top Drawing Settings” on page 76.

When you install AutoCAD Land Development Desktop, a root prototype 
folder (c:\Program Files\Land Desktop R2\data\prototypes) is created. Each 
prototype is represented by a subfolder of this root prototype folder. For 
example, if you create a prototype named MYPROTO, then AutoCAD Land 
Development Desktop creates the following folder:

c:\Program Files\Land Desktop R2\data\prototypes\myproto

AutoCAD Land Development Desktop always maintains default prototypes, 
one for feet and the other for meters. If you delete these prototypes, then 
they are recreated, using the default system settings, the next time you start 
AutoCAD Land Development Desktop. 

Whenever a new drawing is attached to a project, its default settings are cop-
ied from this prototype. The settings are copied to each drawing so that after 
a drawing is created, its settings can be modified independently of any of the 
other drawings in the project.

Managing Prototypes

From the Prototype Management dialog box, you can copy, rename, and 
delete prototypes.

Copying a Prototype
You can create a new prototype by copying an existing prototype. By default, 
there is always at least one prototype you can copy. After you copy the pro-
totype, you can change the prototype settings to customize it. For more 
information, see “Changing the Prototype Settings” on page 45.
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� From the Projects menu, choose Prototype Manager to display the Prototype 
Management dialog box.
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� From the Prototype list, select the prototype you want to copy.

� Click the Copy button to display the Copy Prototype dialog box.

� In the Name box, type a name for the copy.

� In the Description box, type an optional description for the copy.

 Click OK to return to the Prototype Management dialog box.

Renaming a Prototype
Use the Rename command in the Prototype Manager to rename a prototype. 
If you rename a prototype that you have already associated with a project, 
then you must update the prototype name in the Project Details. For more 
information, see “Changing the Project Detail Settings When Using the 
Project Management Dialog Box” on page 30.
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� From the Projects menu, choose Prototype Manager to display the Prototype 
Management dialog box.

� From the Prototype list, select the prototype you want to rename.

� Click the Rename button to display the Rename Prototype dialog box.

� Type a new name for the prototype.

� Click OK to return to the Prototype Management dialog box. 

Deleting a Prototype
Use the Delete command in the Prototype Manager to delete a prototype that 
you no longer use.
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� From the Projects menu, choose Prototype Manager to display the Prototype 
Management dialog box.

� From the Prototype list, select the prototype you want to delete.

� Click the Delete button.

A warning dialog box is displayed, informing you that all files and folders 
within the prototype folder are deleted.

� Click Yes to continue.
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Changing the Prototype Settings

You can use the Prototype Settings command to edit the settings for a project 
prototype. Whenever a new drawing is created in a project, the customized 
settings in the prototype are copied to the new drawing.

NOTE Settings changed in a prototype have no effect on the current drawing. 
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� From the Projects menu, choose Prototype Settings to display the Select 
Prototype dialog box.

� Select the prototype that you want to edit.

� Click OK to display the Edit Prototype Settings dialog box.

� Edit the prototype settings as necessary, and then click OK to save the proto-
type with the new settings. For more information about changing the set-
tings, see “Changing the AutoCAD Land Development Desktop Drawing Set-
tings” on page 76.
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4Setting Up Drawings

After you create a new drawing, you are prompted to set 

up the drawing. Drawing setup includes establishing 

units, zones, text styles, and several other settings. 

Depending on your preference, you can use a wizard to 

set up drawings, you can automatically load a setup pro-

file, or you can use the Drawing Setup dialog box.

In this chapter

� Drawing Setup

� Setting Up a Drawing Using the 
Drawing Setup Wizard

� Setting Up a Drawing by 
Automatically Loading a Pre-
Existing Drawing Setup File

� Setting Up a Drawing Using the 
Drawing Setup Command
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Drawing Setup

Every time you create a new drawing, you must set it up. Drawing setup 
involves several drawing parameters. You can set the units to feet or meters, 
the angle type to bearing or azimuth, the horizontal and vertical scale, and 
define the display precision for linear, angular, coordinate, and elevation 
units. You can control the sheet size, import a drawing border, load text 
styles, save the current settings to a setup profile, or load settings from a pre-
viously created setup profile.

You have three options for drawing setup: use the Drawing Setup Wizard, use 
the Drawing Setup command, or load a pre-existing setup file. For more 
information, see “Selecting How to Set Up New Drawings” on page 74.

NOTE You may not need to set up a drawing if you based the drawing on a 
drawing template. For more information about using drawing templates, see 
“Basing a Drawing on a Drawing Template” on page 8.

Setting Up a Drawing Using the Drawing 
Setup Wizard

You can use a wizard to set up a new drawing. 
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� From the Projects menu, choose User Preferences to display the User 
Preferences dialog box.
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� Under First Time Drawing Setup, select the Use the Drawing Setup Wizard 
option.

� Click OK.

The next time you create a new drawing, the Drawing Setup wizard is dis-
played automatically. The wizard has tips and context-sensitive help that 
describe each option on each page of the wizard. For more information about 
each setting in the wizard, see “Setting Up a Drawing Using the Drawing Setup 
Command” on page 49.

Setting Up a Drawing by Automatically 
Loading a Pre-Existing Drawing Setup File
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� From the Projects menu, choose User Preferences to display the User 
Preferences dialog box.

� Under First Time Drawing Setup, select the AutoLoad Setup File option.

� From the list, select the setup file that you want to use.

� Click OK.

The next time you create a new drawing, the setup file is loaded 
automatically. 

NOTE You can create drawing setup files when you use the Drawing Setup dia-
log box. For more information, see “Saving Drawing Setup Profiles” on page 51.

Setting Up a Drawing Using the Drawing 
Setup Command

One option you can use to set up your drawing is the Drawing Setup com-
mand. You can use this command to set units, scale, current zone, base point 
and north rotation, and more.
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NOTE You can set a User Preference so that the Drawing Setup dialog box is 
always displayed after you create a new drawing. For more information, see 
“Selecting How to Set Up New Drawings” on page 74.

If you have an existing drawing setup profile, then you can load the profile 
when you are setting up your drawing. You can also save drawing setup pro-
files to use on other drawings.

Loading Drawing Setup Profiles
If a drawing setup profile exists, then you can load it when setting up a draw-
ing. The setup profile contains all the drawing settings necessary for setting 
up a drawing, like units, text style, current zone, and so on.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Load/Save Settings tab.

All the available drawing setup profiles that are stored in the current path are 
displayed under Load a Drawing Setup Profile in the Profile Name list. 
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NOTE If you want to load a drawing setup profile from a different path, then 
click Browse and select a new path. The setup profiles are called <Name>.set. 

� From the Profile Name list, select the drawing setup profile that you want to 
use. 

� Click Load to load the setup profile.

TIP You can click View to display the setup profile details, such as the units, 
drawing orientation, and so on, before loading the profile. 

After you load a drawing setup profile, you can click any other tab on the 
Drawing Setup dialog box to change any of the individual settings. If you 
want to make these changes permanent (within the setup profile), then save 
the setup profile. For more information, see “Saving Drawing Setup Profiles” 
on page 51.

Saving Drawing Setup Profiles
You can save all your custom drawing setup settings as a setup profile. When 
you want to set up another drawing using the same settings, you can load 
this setup profile. For more information, see “Loading Drawing Setup Profiles” 
on page 50.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Load/Save Settings tab.

� Verify that the Path box displays the correct path. If you want to save the 
drawing setup profile to a different folder, then click Browse and select a new 
path.

� Under Save a Drawing Setup Profile, type the name of the file that you want 
to save in the Profile Name box. This name can be up to 64 characters, 
including path and file extension. This file is saved with an .set file 
extension.
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! Click Save to save the setup profile.

" Click OK. 

Changing the Unit Settings for a Drawing
You can specify whether you want to use feet or meters in your drawing. You 
can specify which type of angle measurement you want to use (azimuths, south 
azimuths, or bearings), as well as the angle unit type (degrees, grads, or radi-
ans).
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Units tab.
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NOTE Whenever you change the settings on the Units tab, the Samples 
change to reflect the new settings. 

� Under Linear Units, select either Feet or Meters.

� Under Angle Units, select one of the following options on which to base 
angular output:

� Degrees
� Grads

NOTE When you type degrees at AutoCAD Land Development Desktop com-
mand prompts, type them in the decimal format indicated (DD.MMSS). Use a 
period (.) between the degree value and the minutes and seconds. For example, 
to enter 67°45'15" type the value as 67.4515. If you use bearings, then type the 
bearing quadrant first, and then the angle in degrees. 

! Under Angle Display Type, select one of the following options on which to 
base angular output:

� Bearings
� North Azimuths
� South Azimuths
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" Click OK or set the precision settings. For more information, see “Changing 
the Precision Values for a Drawing” on page 54.

NOTE The linear units that you select must be the same for all drawings in a 
project. You cannot mix foot-based drawings with meter-based drawings in the 
same project. 

Changing the Precision Values for a Drawing
You can set the angular, linear, coordinate, and elevation precision for the 
drawing. The precision settings are used only for labeling and listing values, 
not actual computations. AutoCAD Land Development Desktop commands 
always calculate all numbers up to the highest internal precision.

The following illustration is a line that is labeled with different precisions:
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Units tab.

� Under Display Precision, you can change the values for the following types 
of measurements by either typing values in the boxes or clicking the up or 
down arrows:

� Linear: Sets the linear precision for the drawing. This is used for all 
distances.

� Elevation: Sets the elevation precision for the drawing.
� Coordinate: Sets the coordinate precision for the drawing. This is used to 

display all northing/easting coordinate information.
� Angular: Sets the angular precision for the drawing. This is used to dis-

play minutes and seconds.

� Click OK.
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Changing the Scale Settings for a Drawing
You can control how the horizontal and vertical scales of the drawing are 
displayed.

NOTE If you change the horizontal scale, then you may need to change the 
Text Style as well. Text style is controlled by the horizontal scale. For more infor-
mation, see “Loading Pre-defined Text Styles and Changing the Current Text 
Style” on page 63.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Scale tab.

� Under Drawing Scale, select a Horizontal scale from the list. If you do not see 
the scale you want to use, then select Custom and type the scale in the 
Horizontal box. For example, for a 1:200 scale, type 200.

� Select a Vertical scale from the list. If you do not see the scale you want to 
use, then select Custom and type the scale in the Vertical box. For example, 
for a 1:200 scale, type 200.

For more information about choosing a scale for your drawings, see “Deter-
mining the Scale at Which to Draw Objects” in this chapter.
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! Click OK or set the sheet size. For more information, see “Changing the Sheet 
Size for a Drawing” on page 57.

Determining the Scale at Which to Draw Objects
The horizontal scale controls how objects are drawn in plan view. The verti-
cal scale controls how objects are drawn in profile and sectional views. 

Information for Users of Autodesk Civil Design
The Profile and Section commands in Autodesk Civil Design automatically 
take into account the vertical scale. 

However, if you want to use the POLYLINE or LINE command instead of the 
Profile commands to draw an object in a profile that reflects the vertical exag-
geration, then you can compensate for the vertical exaggeration.

To compensate for vertical exaggeration, divide the horizontal scale by the 
vertical scale, and then use this factor to draw objects. For example, a hori-
zontal scale of 50 (1"=50'), and a vertical scale of 5 (1"=5'), results in a ratio of 
50/5. To draw a 1' long vertical line in the profile, you factor it by a ratio 50/
5, meaning you actually draw a 10-foot line. 

The following is an illustration of a profile with a vertical scale of 10:
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For more exaggeration, you can specify a smaller vertical scale. The following 
is an illustration of a profile with a vertical scale of five (5): 
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Changing the Sheet Size for a Drawing
You can modify the limits of the drawing by selecting a sheet size. The sheet 
size and the horizontal scale determine the effective area on the drawing in 
relation to the plotted drawing. For more information, see “Changing the 
Scale Settings for a Drawing” on page 55.

For example, if you set the horizontal scale of a drawing to 100 (or 1" = 100' 
in English units) and the sheet size to 22" x 34", then the limits of the draw-
ing are set from (0,0) to (2200, 3400) feet.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Scale tab.

� Under Sheet Size, select one of the pre-defined sheet sizes. If you do not see 
the sheet size you want to use, then select Custom and type the sheet dimen-
sions in the Height and Width boxes. 

This sets the AutoCAD drawing limits based on your horizontal scale. For 
example, the drawing limits are set to 960' x 1440' for a 24" x 36" sheet at 
1" = 40'.

� Click OK.

Changing the Current Zone for a Drawing
Drawings in a project can have the same or different coordinate zones 
assigned to them. To work in real-world coordinates, you must establish a 
current zone for the drawing.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box.

� Click the Zone tab.

� From the Categories list, select a zone category. Categories include Lat/Longs, 
US states, and so on.

When you select a category, the Available Coordinate Systems list displays all 
the defined zones in that category. 

� Select the zone you want to use. To select no zone, leave the CS Code box 
blank.

The CS Code box lists the code for that coordinate system.

TIP If you know the coordinate system code for a zone, you can just type it in 
the CS Code box and click OK to select the zone. 

The other information in the dialog box includes a description, the projec-
tion type, and the datum that was used for the zone.

! Click OK.

Changing the Base Point for a Drawing
AutoCAD Land Development Desktop uses two coordinate systems for locat-
ing points: X,Y and northing/easting. When you start a new project, these 
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values all default to 0 so that the Y coordinate is the same as the northing 
and the X coordinate is the same as the easting. 

The following illustration is the default coordinate system, where X,Y is 0,0 
and the northing/easting is 0,0:
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You can change the base point so that a different X,Y coordinate equals a dif-
ferent northing/easting coordinate. For example, if the points in your draw-
ing begin at northing and easting coordinates of 5000,5000, then you can set 
a new base point to translate these coordinates so they fit onto your drawing 
screen. You can set the base point by assigning a northing and easting value 
to a fixed X,Y location. For example, you can assign X,Y coordinates 100,100 
the northing and easting values of 5000,5000. 

The following is an illustration of the coordinate system after the base point 
and northing/easting values are adjusted: 
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NOTE Setting a different base point affects only the view of the points in the 
current drawing and does not alter the point database coordinates. The point 
commands take only the base point into account and translate the information. 
All points are stored in the point database using their northing and easting coor-
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dinates. Setting a different base point does not move any objects such as lines, 
polylines, or figures. We recommend that you set the base point before creating 
such figures in your drawing. 
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Orientation tab.

� Under Base Point, do one of the following:

� In the X and Y boxes, type the X, Y coordinates that you want to translate 
the northing/easting coordinates to.

� Click Pick and select an X,Y point in your drawing.

� Under Northing and Easting, type the northing and easting coordinates that 
you want to associate with the X,Y base point. 

� The northing value corresponds to the Y coordinate.
� The easting value corresponds to the X coordinate.

NOTE If you change the base point in an existing drawing, then you must 
move any objects in the drawing to match the new coordinate system. Use the 
Inquiry commands to verify the coordinates in the drawing. 
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! Click OK or set the north rotation. For more information, see “Changing the 
North Rotation for a Drawing” on page 61.

Changing the North Rotation for a Drawing
By default, north is always represented in a drawing as the top of the screen. 
But you can define a different orientation of north if your drawing layout 
requires it. Changing the north rotation affects only the commands that use 
a northing/easting coordinate system; it does not rotate the X,Y angular base 
or affect any CAD commands.

You should typically set the north rotation when you create a new drawing, 
but you can change it at any time. 
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TIP Different drawings that are associated with the same project can have dif-
ferent north rotations. This provides different views of the project point data rel-
ative to the X,Y coordinates. 

There are two parts to defining a north direction. The first is to identify a 
direction in the drawing, and the second is to define what the direction 
represents.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Orientation tab.

� Under North Rotation, do one of the following:
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� Select the Angle option and then type the rotation angle in the format 
indicated. This number is a clockwise angle from the vertical. The default 
value of 0 sets north to the top of the screen.

� Select the Define by Points option. Click Pick Points and select the points 
that represent an angle. This angle can represent north, a known bearing 
or azimuth, or the angle between two known points.

To specify what the angle between the two points represents, select one of the 
following under Points Represent:

� Select North if the angle represents the North direction.
� Select Bearing and enter the bearing value for the rotation angle in the for-

mat DD.MMSS, and then specify the quadrant. For example, if you have a 
line in the drawing that is drawn at a known angle, then you can use this 
reference angle as a method of defining the north rotation.

� Select Azimuth and enter the azimuth value for the rotation angle in the 
format in the format DD.MMSS.

� Select Coordinate and enter two sets of northing/easting coordinates that 
define the direction of the rotation angle. For example, if you know the 
start and end coordinates of a line in the drawing, then you can use these 
coordinates to define a reference angle.

TIP Select the Use First Point as New Base Point check box if you want the 
Coordinate 1 point to become the new base point.
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NOTE If you change the north rotation in an existing drawing, then you 
must move any objects in the drawing to match the new coordinate system. 
Use the Inquiry commands to verify the coordinates in the drawing. 

� Click OK.

Loading Pre-defined Text Styles and Changing the Current 
Text Style
You can load predefined text styles and set the current text style to use in the 
drawing. 

The height of a text style is converted to values based on the drawing’s hori-
zontal scale. For example, a L100 style in a 50 scale drawing is created with a 
height of 5'. Therefore, when plotted at 1 = 50 scale, all text defined as L100 
is plotted 0.1" high.

For more information on text styles, look up “Working with Text Styles” in 
the AutoCAD User’s Guide or online Help.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box.

� Click the Text Style tab.
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� Verify that the Path for the text style sets is correct. If it is incorrect, then click 
Browse and locate the folder where the text style sets are stored. By default, 
text style sets are stored in the following folder:

c:\Program Files\Land Desktop R2\data\setup

A style set is a group of styles that are related. Style sets have the file exten-
sion *.stp.

� Under Style Set Name, select the style set you want to load into the current 
drawing. When you select a style set, all the text styles in the style set are 
shown in the Styles In This Set list.

� If you use feet as your units in the drawing, then select a Point, Leroy, or 
Fraction style set. Point is based on point standards, Leroy is based on 
standard Leroy sizes, and Fraction is based on font sizes in fractions.

NOTE Point and Fraction style sets have style names that start with C and S.
S stands for Simplex, meaning that the fonts uses only one stroke. Whereas C 
stands for Complex, meaning that the font uses two strokes to delineate the 
characters in the font set. 

� If you use Metric units, select a Metric Leroy (mleroy) or Millimeter (milli) 
type. 

! Click Load to load the selected style set and update the Select Current Style 
list. 

" Under Select Current Style, select the name of the style that you want to use. 
This list shows all existing styles in the current drawing. You can change the 
current style at any time. 

NOTE To change the current text style, you can also use the STYLE command 
or you can select the Set Text Style command from the Utilities menu. 

) Click OK.

NOTE Many of the AutoCAD Land Development Desktop commands that cre-
ate text require styles with fixed (non-zero) heights. The included style sets all 
contain fixed-height styles. Standard is the default zero-height text style that 
exists in a drawing. 
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Changing the Border Style for a Drawing
You can insert a border in a drawing that is either a polyline or a block. Sev-
eral border blocks, which are designed to match typical plot sheets (such as 
18x24 inch and 24x36 inch), are included with AutoCAD Land Development 
Desktop.

These border blocks should be inserted using the Scaled Block border option, 
which inserts the borders using the drawing’s horizontal scale. The border 
blocks contain title and revision boxes where you can enter text using the 
TEXT command, such as revision number, job name, and date.

Defining a Line Border
Using the Line option, you can insert a polyline border in the drawing. 
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Border tab.

� Under Border Selection, select Line to insert a polyline with a line width at 
specified margins.

NOTE The following values are all based on the current units for the drawing. 
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� Under Border Line, in the Line Width box, type a line width for the border. 
This is the plotted width of the polyline that is used to draw the border.

! In the Left Margin box, type a left margin for the border. 

The margins are the offsets in plotted units from the edge of the sheet to the 
border. The size of the border is based on the sheet size and the horizontal 
scale, less the margins.

" In the Right Margin box, type a right margin for the border.

) In the Top Margin box, type a top margin for the border.

* In the Bottom Margin box, type a bottom margin for the border.

+ Click OK.

Defining an Unscaled Block as a Border
Using the Unscaled Block option, the block you select is inserted into the 
drawing at 1:1 scale.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 

� Click the Border tab.

� Under Border Selection, select Unscaled Block to insert a block at a 1:1 scale.

� Under Custom Block, click Browse and locate the name of the folder in 
which the border you want to insert is located. By default, this location is the 
following:

c:\Program Files\Land Desktop R2\data\borders

! Under Block Name, select the name of the block that you want to insert:

NOTE Several sample borders are included with AutoCAD Land Development 
Desktop. However, they should be inserted using the Scaled Block option. 

" Click OK.

Defining a Scaled Block as a Border
Using the Scaled Block option, the block you select is inserted using the cur-
rent horizontal scale. For more information, see “Changing the Scale Settings 
for a Drawing” on page 55.
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� From the Projects menu, choose Drawing Setup to display the Drawing Setup 
dialog box. 
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� Click the Border tab.

� Under Border Selection, select Scaled Block.

� Under Custom Block, click Browse and locate the name of the folder in 
which the block you want to insert is located. By default, this location is the 
following:

c:\Program Files\Land Desktop R2\data\borders 

! Under Block Name, select the name of the block that you want to insert. The 
block names comply with the following naming conventions:

� pf_ are plan borders for drawings that use feet as units
� pm_ are plan borders for drawings that use meters as units
� df_ are detail borders for drawings that use feet as units
� dm_ are detail borders for drawings that use meters as units

" Click OK.
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5AutoCAD Land 
Development Desktop 
Settings

There are several settings you can configure to control 

how AutoCAD Land Development Desktop functions. 

These include path settings, New and Open command 

preferences, and zone transformation settings, among 

others. In addition, you can access and change label 

styles, import/export formats, contour styles, and draw-

ing settings from a central location.

In this chapter

� Changing the AutoCAD Land 
Development Desktop Settings

� Changing the AutoCAD 
Options

� Changing the User Preferences

� Editing Data Files

� Changing the AutoCAD Land 
Development Desktop 
Drawing Settings

� Changing the Geodetic Zone 
Transformation Settings
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Changing the AutoCAD Land Development 
Desktop Settings

AutoCAD Land Development Desktop provides system variables that you 
can use to control various features of the program. These settings include 
AutoCAD Options, User Preferences, Data Files settings, Drawing Settings, 
and Prototype Settings.

Changing the AutoCAD Options

The AutoCAD options control saving, colors, paths, printers, and much 
more. 
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� Type OPTIONS at the command line to display the Options dialog box.

For more information, see “Modifying the AutoCAD Environment” in the 
AutoCAD User’s Guide, or click the Help button in the Options dialog box.
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Changing the User Preferences

The User Preferences control program-wide preferences such as the project 
paths for various files, the AutoCAD overrides, and the drawing setup 
method. 

The file paths include paths for storing prototypes, speed tables, and drawing 
setup profiles. The AutoCAD overrides include options you can select to use 
the non-project based version of AutoCAD New and Open commands. For 
drawing setup, you can select among three options. You can choose to use 
the drawing wizard, the Drawing Setup command, or automatically load a 
drawing setup profile when you start a new drawing.

The preference settings are stored in the following folder:

c:\Program Files\Land Desktop R2\data\pref

The file name is <AutoCAD login name>.dfm. The preference path settings 
are stored in the sdsk.dfm file in the program folder.

Changing the Program Paths Settings

AutoCAD Land Development Desktop uses paths to find installed compo-
nents. The installation program defines these path settings. If you want to 
move components of the installed software, such as the prototypes, the tem-
porary folder, or the data folder, then you must update the paths to the files.

NOTE If you change a path setting, it won’t take effect until you shut down 
AutoCAD Land Development Desktop and restart it. 
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� From the Projects menu, choose User Preferences to display the User 
Preferences dialog box.
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� Under File Locations, select the path that you want to change from the Type 
list: 

� Contour Styles: The location of the Contour Style files.
� Drawing Setup Borders: The location of the border .dwg files used by 

drawing setup. By default, this path is the following:

c:\Program Files\Land Desktop R2\data\borders

� Drawing Setup Files: The location of the drawing setup profiles. By 
default, this path is the following:

c:\Program Files\Land Desktop R2\data\setup

� Import/Export Formats: The location of the point import and export 
formats.

� Label Styles: The location of the line, curve, spiral, and point label style 
files.

� Project Prototypes: The location of the project prototypes. By default 
this path is the following:

c:\Program Files\Land Desktop R2\data\prototypes

� Speed Tables: The location of speed tables used to calculate spiral geom-
etry. By default this path is the following:

c:\Program Files\Land Desktop R2\data\Speed Tables

� Symbol Manager Files: The location of symbol sets that are used in the 
Symbol Manager. By default this path is the following:

c:\Program Files\Land Desktop R2\data\Symbol Manager

� Temporary Files: The location of any temporary files generated by 
AutoCAD Land Development Desktop. By default this path is c:\temp.
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NOTE The Cross Section and Sheet Manager template paths are only used 
if Autodesk Civil Design is installed. 

� Cross Section Templates: The location of the Civil Design cross section 
templates. By default this path is the following:

c:\Program Files\Land Desktop R2\data\tplates

� Sheet Manager Templates: The location of the Autodesk Civil Design 
Sheet Manager files.

NOTE The Survey Data Files path is only used if Autodesk Survey is 
installed. 

� Survey Data Files: The location of the Survey equipment, synonyms, and 
the figure prefix files.

� Click Browse to locate the new folder for the file location type.

NOTE Changing a path for a folder location type does not move that compo-
nent’s files. It just tells AutoCAD Land Development Desktop where to look for 

the files. You must move the files using Windows® Explorer. 

� Click OK.

NOTE Paths are saved in the sdsk.dfm file in the program folder. This file also 
contains many program paths that should not be modified. 

Changing the Open Command Preference

If you want to use the basic AutoCAD Open dialog box instead of the 
AutoCAD Land Development Desktop Open Drawing: Project Based dialog 
box, then you can change the Open command preference.
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� From the Projects menu, choose User Preferences to display the User 
Preferences dialog box.

� Under AutoCAD Overrides, do one of the following:

� Select the “Open” drawing dialog check box to use the AutoCAD Land 
Development Desktop Open command, a project-based command.
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� Clear the “Open” drawing dialog check box to use the AutoCAD Open 
command.

� Click OK.

NOTE If you clear the “Open” drawing dialog check box (and use the 
AutoCAD Open command to open a drawing), then you are automatically 
prompted to select a project if the drawing isn’t associated with a project or if 
the drawing’s project is not found. 

Changing the New Command Preference

If you want to use the standard AutoCAD New dialog box instead of the 
AutoCAD Land Development Desktop New Drawing: Project Based dialog 
box, then you can change the New command preference.
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� From the Projects menu, choose User Preferences to display the User 
Preferences dialog box.

� Under AutoCAD Overrides, do one of the following:

� Select the “New” drawing dialog check box to use the AutoCAD Land 
Development Desktop New command, a project-based command.

� Clear the “New” drawing dialog check box to use the AutoCAD New 
command.

� Click OK.

NOTE If you clear the “New” drawing dialog check box and use the AutoCAD 
NEW command to create a new drawing, then you must save the new drawing 
to name it. Only named drawings can be associated with a project. 

Selecting How to Set Up New Drawings

You must assign drawing setup values for every new drawing that you create 
and for any existing drawing that hasn’t been used with AutoCAD Land 
Development Desktop. To set up the drawing, you can use a wizard or the 
Drawing Setup command, or a setup file can be loaded automatically for the 
drawing.
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NOTE Even if you select to use the wizard by default, you can still make 
changes to the drawing setup after running the wizard by using the Drawing 
Setup command or by loading a drawing setup file. 
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� From the Projects menu, choose User Preferences to display the User 
Preferences dialog box.

� Under First Time Drawing Setup, select one of the following:

� Use the Drawing Setup Wizard: Select this option if you want to use the 
wizard each time you create a new drawing.

� Use the Drawing Setup Command: Select this option if you want to use 
the Drawing Setup command to change the drawing settings for a new 
drawing.

� Autoload Setup File: Select this option to load a setup file automatically 
when you start a new drawing. Then select the setup file that will be 
loaded.

NOTE You can create custom setup files using either the Drawing Setup com-
mand or the Drawing Setup Wizard. 

� Click OK.

Editing Data Files

The Edit Data Files dialog box is a central location from which you can edit 
data files. These data files include import/export formats, speed tables, label 
styles, tag styles, and contour styles. 
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� From the Projects menu, choose Data Files to display the Edit Data Files 
dialog box.
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� Under Program, select Land Development Desktop. 

NOTE If Autodesk Survey or Autodesk Civil Design is installed, then you can 
also edit data files for those programs. 

The Data Files list displays the data files that you can edit.

� Select one of the following data files and then click Edit Data:

� Import/Export Formats. For more information, see “Creating a Point 
Import/Export Format” on page 267.

� Speed Tables. For more information, see “Editing a Speed Table” on page 
397.

� Label Styles. For more information, see “Selecting the Current Label 
Style” on page 529.

� Tag Styles. For more information, see “Tag Label Styles” on page 588.
� Contour Style Manager. For more information, see “Managing Contour 

Styles” on page 799.

Changing the AutoCAD Land Development 
Desktop Drawing Settings

Drawing settings control many different parameters in AutoCAD Land 
Development Desktop. When you create a new drawing in a project, the 
drawing is assigned default drawing settings based on the prototype. 
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Drawing settings are divided by program so they are easy to locate. If you 
have Autodesk Civil Design or Autodesk Survey, then you can change the 
drawing settings for those programs as well. 

After you change the drawing settings, you can save the settings to a proto-
type so the settings can be used by other drawings. When you create a new 
drawing in a project that is based on that prototype, then the drawing set-
tings that you saved to the prototype are used for the drawing. If you 
changed settings and you want to restore them to the original drawing set-
tings, then you can reload the prototype settings.

The drawing settings file is stored in the project’s \dwg folder. The current 
drawing name is used as the file name with the extension .dfm.

NOTE Each of the drawing settings available in the Edit Settings dialog box is 
documented in this manual in the applicable section. For example, Alignment 
Label settings are documented in “Changing the Alignment Label Settings” 
on page 476.

Saving Drawing Settings to a Prototype

Each new drawing that you create in a project is assigned the drawing set-
tings that are saved to the prototype that the project is associated with. You 
can save drawing settings to a prototype so that each drawing you create in 
a project associated with the prototype are assigned the same drawing set-
tings by default.
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box.
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� Change the settings as needed. For more information, see “Changing the 
AutoCAD Land Development Desktop Drawing Settings” on page 76.

� Do one of the following:

� From the Settings list, select the setting you want to save to the prototype 
and then click Save to Prototype under Selected Item.

� Under All Settings, click Save to Prototype. 

The Select Prototype dialog box is displayed.

� Select the prototype you want to save the setting(s) to.

 Click OK.

Loading Drawing Settings from a Prototype

You can assign drawing settings to a drawing by loading the settings from a 
prototype.
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box.

� Do one of the following:

� From the Settings list, select the setting that you want to load from the 
prototype and then click Load from Prototype under Selected Item.

� Under All Settings, click Load from Prototype.

The Select Prototype dialog box is displayed.
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� Select the prototype that you want to load the setting(s) from.

Changing the Output Settings

There are several different commands that you can use to display the Output 
Settings dialog box. The following task describes how to access the dialog box 
from the Edit Settings dialog box.
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box.

� Under Programs, select Land Development Desktop.

� From the Settings list, select Output Settings.

� Click the Edit Settings button to display the Output Settings dialog box.

 Under Output Options, select how you want to output the file.

� Select the File check box to output the information to a text file.
� Select the Screen check box to output the information to the screen.

NOTE Some commands write output information specifically to the screen 
or to a file and ignore these two options. 

" Under Output Format, select or clear the following check boxes:
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� Date: Select this check box to place the date on the report. For example:
����������	�
����	�
�

� Title: Select this check box to place a title on the report. For example:
����������������������������������	�
����	�
�
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� Page Breaks: Select this check box to place page breaks in the report. 
When you select this check box, and create a Screen report, the text win-
dow displays only the first page of the information and then prompts you 
to press a key to continue. When you press a key, the next page of the 
report is displayed. If you do not select this check box, then the screen 
report does not stop at each page as the information is output. When you 
select this check box, and create a File report, the report is created with 
page breaks instead of having all the information displayed in one long 
list. 

If you select the Sub Headers and Page Breaks check boxes, then sub head-
ers are placed at the beginning of each page break as shown in the follow-
ing example. 
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------------------------------------------------------------

� Page Numbers: Select this check box to place page numbers on a report. 
This setting applies to File output only. 

� Sub Headers: Select this check box to place sub headers at the beginning 
of each new page of a report. This setting applies to File output only. You 
must also select the Page Breaks check box if you want sub headers to 
appear. The sub headers are placed at the beginning of each page break.

� Overwrite File: Select this check box to overwrite a file if it already exists. 
Clear this check box to append new information to the end of an existing 
file. Be sure to also specify the correct Output File Name for the report.

NOTE If you select the Overwrite File option, then each time you create a 
new report, be aware that if you do not assign a unique name to the report, 
the existing output report is overwritten. 

# Under Output Format, specify the following information:

� Page Length: In this box, type the number of rows of type you want to 
have on each page. The spacing is measured in characters. This setting 
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only applies if the Page Breaks check box is selected and if File is selected 
as an output option.

� Page Width: In this box, type the number of characters you want to have 
across each page. This setting applies only to File output. It also affects the 
output of the Stakeout file. If the page width is too narrow, the lines wrap.

� Left Margin: In this box, type the number of characters you want to have 
as a left margin. This setting applies only to File output.

� Right Margin: In this box, type the number of characters you want to 
have as a right margin. This setting applies only to File output.

� Top Margin: In this box, type the number of characters you want to have 
as a top margin. The margin is inserted between the page number (if you 
select the Page Numbers option) and the report title. This setting applies 
only to File output.

� Bottom Margin: In this box, type the number of characters you want to 
have as a bottom margin. This setting applies only to File output.

$ Enter the Output File Name. 

NOTE Each time you create a new report, be sure to change the default out-
put file name so you do not overwrite the previous report if you select the Over-
write file check box. 

% If needed, you can click Output File Name to specify a folder for the output 
file. If you do not specify an output folder, then the file that is created is 
placed in the following folder by default: 

c:\Program Files\Land Desktop 2

�& Click OK when you have finished changing the settings.

Changing the Geodetic Zone Transformation 
Settings

Before using any geodetic-related commands, like the geodetic labeling com-
mands, you must set the zone transformation settings. The transformation 
settings relate the local northing and local easting coordinates of your survey 
with the current zone’s grid northing and grid easting coordinates. 

The zone transformation settings do the following:

� Relate local coordinates to grid coordinates by transforming distances 
measured on the Earth (or geoid) to distances on an ellipsoid. 
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� Relate distances on the ellipsoid to the flat plane (projection) of the cur-
rent zone’s grid coordinate system.

These transformations are accomplished through the use of scaling factors. 
First, a sea level scale factor is applied to the local values measured on the 
geoid, and then a grid scale factor is applied in order to relate the ellipsoid 
values to the grid projection. The scaling factors can be defined in two ways:

� The sea level scale factor relates the distances on the geoid to the distances 
on the ellipsoid. 

� The grid scale factor relates the distances on the ellipsoid to the distances 
on the grid projection.

In addition to setting scale factors, you must also specify reference points. 
These reference points are the two points that tie the local and grid coordi-
nates together. The reference points can be defined in two ways:

� By the grid and local coordinates of two known reference points in your 
drawing.

� By the grid and local coordinates of one known point and a known rota-
tion to grid north.
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� Select the current zone for the drawing. For more information, see “Chang-
ing the Current Zone for a Drawing” on page 57.

� From the Projects menu, choose Transformation Settings to display the 
Transformation Settings dialog box. 



Changing the Geodetic Zone Transformation Settings | 83

The description of the current zone is displayed at the top of the dialog box.

� Select the Apply Transform Settings check box. When this box is selected, the 
other settings in the dialog box become active.

� Select the Apply Sea Level Scale Factor check box. 

TIP If you know the combined scale factor, then you can clear the Apply Sea 
Level Scale Factor check box, select User Specified as the Grid Scale Factor, and 
type a combined scale factor in the Grid Scale Factor box. The combined scale 
factor is the combination of the scale factor for converting local to sea level and 
the scale factor for converting sea level to grid. 

 Type a Default Elevation, such as the average elevation of your project site 
from sea level.

" You can change the Spheroid Radius. The Spheroid Radius is the radius of a 
mathematical figure close to the shape of the Earth at sea level, approxi-
mately 6,370 km. The value shown in this box is initially derived from the 
current zone’s ellipsoid and can be changed if local observations differ. In 
most cases, the default value shown is the accepted value.

# Select one of the following Grid Scale Factor options:

� Unity: To set the grid scale factor to 1.00 for all points within the zone.
� User Specified: To activate the Grid Scale Factor box, where you can type 

the grid scale factor value. For example, you can type the average scale fac-
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tor of the points in your survey. This value is used for all points or loca-
tions within the zone and is constant.

NOTE If you specify a User Specified grid scale factor and then clear the 
Apply Transform Settings check box, the scale factor is still used in Autodesk 
Survey calculations. If the Scale Factor check box is selected in the Survey 
Correction Settings dialog box, then this scale factor is applied to all 
horizontal distances in Survey measurement calculations. For example, if you 
specify a horizontal distance of 500 feet to a sideshot point using the Survey 
Sideshot Instructional method, and the Scale Factor check box is selected and 
the scale factor value is set to 0.5, then the horizontal distance to the sideshot 
point will be 250 feet. The Survey Command Language command SF 
(SCALEFACTOR) always overrides the value specified for the scale factor in the 
Transformation Settings dialog box.

� Reference Point: To use the scale factor of the specified reference point 
(see the following equation) as the grid scale factor for all points or loca-
tions within the zone.

� Prismoidal Formula: To use the prismoidal formula to calculate the grid 
scale factor. This is the recommended method because it accounts for the 
fact that every point has a different scale factor.

IMPORTANT When you use the Attach drawings feature of AutoCAD 
Map and you bring a source drawing that is set up in a different zone into the 
Map project, the source drawing is converted to the zone of the Map project. 
The Prismoidal Formula option sets a different value for each point within the 
zone. However, when you bring a source drawing that uses the Prismoidal 
Formula option into a Map project, a fixed scale factor is used. Therefore, the 
points that are brought into the Map project from the source drawing would 
not line up exactly with the points in the actual source drawing (when looked 
at independently of the Map project drawing).

The following equation is used to calculate prismoidal scale:

Where Keff is the grid scale factor, Kref is the scale factor of the reference 
point, Kpt is the scale factor of the current point, and Kmid is the scale factor 
of the midpoint between the reference point and the current point. A differ-
ent value is used for each point or locations within the zone.
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$ Specify the Reference Point values. The reference point could be a benchmark 
that was used in a survey. It can be any point for which you know both the 
local coordinates and the grid coordinates. To specify the Reference Point val-
ues, do one of the following:

� Select a COGO point from the drawing. For more information, see 
“Selecting a Point from the Drawing to Define the Transformation Refer-
ence Point” on page 85.

� Type a COGO point number. For more information, see “Typing a COGO 
Point Number to Define the Transformation Reference Point” on page 86.

� Type coordinate values in the boxes. For more information, see “Typing 
Point Coordinate Values to Define the Transformation Rotation Point” on 
page 87.

% To define the rotation angle for the transformation, do one of the following:

� Select a COGO point from the drawing. For more information, see 
“Selecting a Point from the Drawing to Define the Transformation Rota-
tion Point” on page 86.

� Type a COGO point number. For more information, see “Typing a COGO 
Point Number to Define the Transformation Rotation Point” on page 87.

� Type coordinate values in the boxes. For more information, see “Typing 
Point Coordinate Values to Define the Transformation Rotation Point” on 
page 87.

� Type the rotation to grid north. For more information, see “Typing a 
Rotation to Grid North to Define the Transformation Rotation Angle” on 
page 87.

The Grid Azimuth is calculated automatically when you define the rotation 
angle.

�& Click OK.

IMPORTANT Always save the drawing after you change the Transformation 
Settings if you are going to use the drawing in a Map project and perform que-
ries on it. The changes you make to the Transformation Settings are not recog-
nized in a Map query if you do not save the drawing first.

Selecting a Point from the Drawing to Define the 
Transformation Reference Point

� Complete steps 1–7 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.
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� Click the Reference Point button.

� Select a COGO point from the drawing. 

The local northing and easting values are retrieved from the point database 
and are displayed in the dialog box. 

� Type the reference point’s Grid Northing and Grid Easting values.

Typing Point Coordinate Values to Define the 
Transformation Reference Point

� Complete steps 1–7 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.

� Under the Reference Point button, type local northing and easting values in 
the Local Northing and Local Easting boxes. 

NOTE The local northing and easting coordinates are automatically displayed 
if you select a point from the drawing or if you type a point number. 

� Type the reference point’s Grid Northing and Grid Easting values.

Typing a COGO Point Number to Define the 
Transformation Reference Point

� Complete steps 1–7 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.

� Under the Reference Point button, type the point number in the Point 
Number box.

The Local Northing and the Local Easting coordinates are obtained from the 
point database and entered into the dialog box.

� Type the reference point’s Grid Northing and Grid Easting values.

Selecting a Point from the Drawing to Define the 
Transformation Rotation Point

� Complete steps 1–8 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.

� Click the Rotation Point button.

� Select a COGO point from the drawing. 

The local northing and easting values are retrieved from the point database 
and displayed in the dialog box. 
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� Type the rotation point’s Grid Northing and Grid Easting values.

Typing a COGO Point Number to Define the 
Transformation Rotation Point

� Complete steps 1–8 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.

� Under the Rotation Point button, type the point number in the Point 
Number box.

The Local Northing and the Local Easting coordinates are obtained from the 
point database and entered into the dialog box.

� Type the rotation point’s Grid Northing and Grid Easting values.

Typing Point Coordinate Values to Define the 
Transformation Rotation Point

� Complete steps 1–8 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.

� Under the Rotation Point button, type local northing and easting values in 
the Local Northing and Local Easting boxes. 

NOTE The local northing and easting coordinates are automatically displayed 
if you select a point from the drawing or if you type a point number. 

� Type the rotation point’s Grid Northing and Grid Easting values.

Typing a Rotation to Grid North to Define the 
Transformation Rotation Angle

� Complete steps 1–8 in “Changing the Geodetic Zone Transformation Set-
tings” on page 81.

� In the Rotation to Grid North box, type the grid north rotation.

The rotation to grid north is the difference between the local coordinate sys-
tem’s north meridian and the grid north meridian (of the current zone). 

If you are using True North, then this value may equal the convergence 
angle. If you are using magnetic north, then this value would be derived from 
the declination angle and the convergence angle.
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6Getting Started with 
Points

When you start a new project, you are prompted to set 

up the project point database. At this time you can 

enable the use of point names and establish character 

limits for each point data type.

Before you start working with points you should config-

ure the point settings. The point settings control how 

points are created, inserted, displayed, and updated. 

They control whether point labels are used, and there-

fore whether description key substitution can occur 

when points are created or inserted into a drawing.

In this chapter

� COGO Points

� Creating the Point Database

� Point Names

� Changing the Point Creation 
Settings

� Changing the Point Insertion 
Settings

� Changing the Point Update 
Settings

� Changing the Coordinate 
Display Settings

� Changing the Description Key 
Settings

� Differences Between Point 
Markers and Point Labels

� Changing the Point Marker 
Symbol Settings

� Changing the Point Marker Text 
Settings

� Changing the Point Preferences
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COGO Points

COGO points are the foundation for any civil engineering or surveying 
project. AutoCAD Land Development Desktop stores COGO points in an 
external database called points.mdb. Because points are stored outside of the 
drawing, the drawing file size is minimized and multiple people can access 
the database over a network.

You may work with a point database that contains thousands of points. To 
make point management easier, you can create point groups, which allow 
you to logically group points for surface creation, point editing, and point 
exporting. You can also use description keys to place points in the drawing 
with symbols on specific layers. In addition, you can create links with exter-
nal, user-defined point databases for labeling points with extended informa-
tion or for parameter substitution. 

Creating the Point Database

When you create a new project, the Create Point Database dialog box is dis-
played. This dialog box lists the project and the point file name and contains 
options you can use to control the length of point descriptions and the use 
of point names.

NOTE After you set these options for a project, they are not editable. 
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� Create a new project. For more information, see “Creating a Project Using the 
Project Management Dialog Box” on page 28.

In the process of creating a new project, the Create Point Database dialog box 
is displayed.
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� In the Point Description Field Size box, type the number of characters you 
want to use for point descriptions. You can enter any number between 2 and 
254.

� To use alpha-numeric strings to identify points, select the Use Point Names 
check box. Point names are used in addition to the point numbers; they are 
not a replacement for point numbers. For more information, see “Using 
Point Names” on page 91.

� If you selected the Use Point Names check box, then type the number of 
characters you want to use for point names. You can enter any number 
between 2 and 254.

� Click OK to create the point database.

Using Point Names

To associate alpha-numeric text strings with points, you can enable the use 
of point names when you create a project. Point numbers are always required 
for points, but if you require more descriptive, alpha-numeric names, then 
use point names in addition to point numbers.

To use point names, you must set up the point database at the start of a 
project so that it uses point names. 

To assign point names to points you create manually, you must turn off 
sequential (automatic) point numbering in the point settings. With this set-
ting off, you see the following prompt when you create points:
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The character string that you enter at this prompt determines whether the 
string is used as the point’s name or the point’s number. To assign a name to 
the point, the name must start with an alphabetic character (a-z, A-Z) or an 
underscore ( _ ) in order to be recognized as a name. After that you can use 
any number, alphabetic character, or underscore. 
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Valid Point Names

� abc123
� a1234_5678_xyz
� _1234

The last example is a valid point name because it begins with an underscore 
character. However, you cannot name a point “1234”, because “1234” would 
just be accepted as the point's number.

Invalid Point Names

� 3abc (starts with a number)
� abc-def (illegal character)

If you type an invalid point name, the command line reports that it is an 
“invalid entry”. If you enter a point name at the “point name or number” 
prompt, then the point is automatically assigned a point number, starting 
with the next available point number. If you enter a point number at the 
“point name or number” prompt, then no point name is assigned to the 
point.

For identification purposes, the point name is treated as an “alias” for the 
point number, but the point number is always considered the point’s primary 
identifier.

Point names are never shown in point marker text; you must label points to 
see point names in the drawing. To label points with point names, you can 
create a point label style that has “Point Name” as a data element. 

Using Point Filters to Select Points

You can use the following point filters to select points at most Select Points 
prompts.
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� Type .P to select a point by point number. The point does not have to be 
in the drawing to select a point with this filter (however, it must be in the 
point database). 

� Type .N to select a point by northing/easting coordinates.
� Type .G to select points. Using this filter, you can select any part of the 

point object. The point must be in the drawing to select a point with this 
filter.
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NOTE To turn off a point filter, type .P, .N, or .G at the command line again. 
For example, if you use the .P option to type point numbers, type .P again to 
exit the point number mode. Each time you activate one of the point selection 
filters, it remains in effect until you turn it off.

Changing the Point Settings

The point settings control how points are created, inserted, and displayed in 
the drawing. 

Changing the Point Creation Settings

Depending on how you set up options in the point settings, each time you 
set a point, you may be prompted for descriptions, elevations, and point 
numbers, or these features can be automatically created. 
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Adding Points to the Drawing as Points Are Created
When you create or import points, the points are always added to the point 
database. However, you can control whether points are inserted into the 
drawing when you create or import them. For example, if you import a large 
number of points, you can choose to insert them into the project point data-
base only. You can then use the Insert Points to Drawing command to insert 
a subset of the points into the drawing for viewing and editing purposes.
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� Do one of the following to display the Point Settings dialog box:

� From the Points menu, choose Point Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Point Settings and click the Edit Settings button.

� Click the Create tab.

� Select the Insert To Drawing As Created check box to place the points into 
the drawing and into the point database as you are creating or importing 
points. If you clear this check box, then the points are placed into the point 
database only.

NOTE Points are always inserted into the point database when you create or 
import points.

� Click OK.

Changing the Numbering Convention for Points
Use the point numbering settings to control whether points are numbered 
sequentially or manually (which in turn controls whether point names are 
prompted for), whether points are inserted into the drawing as they are cre-
ated, and what the current point number is. 

����	������	���������������������������
�����

� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Create tab.

� Under Numbering, select or clear the Insert To Drawing As Created check 
box:
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� Select the Insert To Drawing As Created check box to place the points into 
the drawing and into the point database as you are creating or importing 
points. 

� Clear the Insert To Drawing As Created check box to place the points into 
the point database only.

� Under Numbering, select or clear the Sequential Numbering check box:

� Select the Sequential Numbering check box to sequentially number the 
points from the current point number as they are created.

NOTE If you select this check box, then you are not prompted for a point 
name even if point names are enabled. 

� Clear the Sequential Numbering check box to be prompted to enter a 
point name or number each time that you create a point.

NOTE If you clear this check box, and point names are enabled, then you 
are prompted to enter a point name or number at point creation prompts. 
The program recognizes any string that starts with an alphabetic character (a-
z, A-Z) or an underscore character ( _ ) as a point name. If you type a numeric-
only string, then the program recognizes it as a point number. If you type a 
point name, then the point is automatically assigned the next available point 
number. Point numbers are required for points. 

� Under Numbering, you can type an integer in the Current number box to 
change the start number for the points. The default number when you begin 
a project is 1. All sequential points use available point numbers starting with 
the current point number.

NOTE If you type an already-used number into the Current number box, then 
a message box is displayed, informing you that the point number is already in 
use or is invalid.

The current point number can differ by drawing and user, as described in the 
following topics:

Current Point Number for a Drawing
Each drawing can have a unique starting point number because this value is 
saved with the drawing. Every time you set a point in the project, it incre-
ments to the next available number. If that point number has been used 
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already, or is locked, then the program continues to scan upward to the next 
available, unused and unlocked point.

Current Point Number for a User
In a networked environment where more than one person is adding new 
points, we recommend that each person set a different current point number 
to avoid confusion. For example, if you set points in a project at the same 
time someone else starts with the same current point number, then your 
numbering sequence has gaps. 

You may end up setting point numbers 1,2,4,7,8,10, while the other person 
sets point numbers 3,5,6,9. If the other person sets his/her current point 
number to 100, then you would have ended up with point numbers 
1,2,3,4,5,6, while the other person set points 100,101,102,103. It may also be 
convenient to pre-assign ranges of points to each person, minimizing the 
need for frequent coordination.

Changing the Point Elevation Settings
You can create points with a pre-set elevation, create points without eleva-
tions, or be prompted for point elevations when you create points.
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� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Create tab.

� Under Elevations, select one of the following options:

� Select Automatic to automatically assign elevations to points, and then 
type the elevation to use in the Default Elevation box.

NOTE The default elevation defaults to the last elevation you enter when 
creating points. 

� Select Manual to manually assign elevations to points as they are created.
� Select None to not assign elevations to points. 

When points are created without elevations, a period (.) is displayed as the 
elevation value, as shown in the following illustration:
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NOTE When you are importing points, the elevations from the file that you are 
importing are used regardless of the option you select here. 

� Click OK.

Changing the Point Description Settings
You can create points with a pre-set description, create points without 
descriptions, or be prompted for point descriptions when you create points.
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� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Create tab.

� Under Descriptions, select one of the following options:

� Select Automatic to automatically assign descriptions to points, and then 
type the description in the Default Description box. Descriptions can be 
between 2 and 254 characters, depending on the character limit you 
assigned to point descriptions when you created the project.

NOTE The default description defaults to the last description you enter 
when creating points. 

� Select Manual to manually assign descriptions to points as they are cre-
ated.

� Select None to not assign descriptions to points. 

When points are created without descriptions, a period (.) is displayed as the 
description value, as shown in the following illustration:
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NOTE When you are importing points, the descriptions from the file that you 
are importing are used regardless of the option you select here. 

� Click OK.

Changing the Point Insertion Settings

Use the point insertion settings to control what the search path is for sym-
bols inserted with point labels or description keys. The point insertion set-
tings control whether to insert points at actual or fixed elevations, and 
whether to use the current label style when inserting or creating points.

NOTE In order to label points that already exist in the drawing, the Use the 
Current Point Label Style When Inserting Points check box must be selected in 
the Point Settings dialog box. If this check box is selected when you are creating 
or inserting points, then the current point label style is automatically applied to 
the points—you do not have to label the points after they are inserted or created.
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� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Insert tab.
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� Under Search Path for Symbol Block drawing files, type a path for the sym-
bols or click Browse and locate a path. This is the path for symbols inserted 
with point labels and description keys.

� Under Insertion Elevation, select one of the following options:

� Select Actual Elevation to insert the points in 3D, using the actual eleva-
tions of the points stored in the point database (or the elevations from the 
XDRef if an XDRef was used for elevations). If you select this option, then 
specify an elevation to assign to points that do not have elevational data 
assigned to them in the If No Elevation, Use box.

� Select Fixed Elevation to insert the points using a fixed elevation for all 
points, and then type an elevation in the Fixed Elevation box. 

NOTE The Insertion Elevation settings do no affect the elevations in the 
point database, or the elevations that exist in an external database that are 
assigned by an XDRef. These settings just control how the point’s elevation is 
represented in the 3D AutoCAD drawing. 

IMPORTANT In Autodesk S8 Civil/Survey, the points were always inserted 
into the drawing at an elevational value of 0, regardless of their actual 
elevations. Because of this, the DISTANCE command always reported the 
correct X,Y 2D distance between points. If you select the Actual Elevation 
check box, then the DISTANCE command (and any other command that 
reports distances) reports 3D distances.
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� Under Point Labeling, select or clear the Use Current Point Label Style When 
Inserting Points check box: 

� Select the Use Current Point Label Style When Inserting Points check box 
to label points with the current point label style. When this option is 
selected, points that you create or insert are automatically labeled with the 
current point style, and you can label points that already exist in your 
drawing. When you select this option, the current label style is displayed 
beneath it.

NOTE To insert points with description keys, you must select this option 
and set the current point label style to a label style that is set up to use 
description keys. 

� Clear the Use Current Point Label Style When Inserting Points check box 
to create or insert points with their default marker text only.

NOTE The Use Current Point Label Style When Inserting Points check box 
must be selected to label points that already exist in the drawing.

� Click OK.

Changing the Point Update Settings

Use the point update settings to control whether points can be edited with 
the AutoCAD MOVE command, whether the point database is updated when 
the MOVE command is used, and whether the drawing is checked against the 
point database when the drawing is opened.
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� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Update tab.
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� Under AutoCAD MOVE Command, select or clear the Allow Points To Be 
MOVE’d In Drawing check box:

� Select the Allow Points To Be MOVE’d In Drawing check box to use the 
AutoCAD MOVE, ROTATE, or ALIGN command to move points. Using 
these AutoCAD commands to move points in the drawing does not 
update the point database unless you select the Update Point Database 
After MOVE Command check box. 

� Clear the Allow Points To Be MOVE’d In Drawing check box if you do not 
want to use AutoCAD MOVE, ROTATE, or ALIGN to move points. When 
this check box is cleared, you can use the MOVE command to move point 
marker text, but leaders are created, pointing back to the unmoved point 
node.

NOTE Unlike AutoCAD MOVE, the AutoCAD Land Development Desktop 
Move command automatically moves the points in the drawing and updates 
the point database. For more information, see “Moving Points” on page 
305.

� Under AutoCAD MOVE Command, select or clear the Update Point Database 
After MOVE Command check box:

� Select the Update Point Database After MOVE Command check box to 
update the COGO point database with the point coordinates when you 



102 | Chapter 6 Getting Started with Points

use the MOVE command. The update does not happen automatically; you 
are prompted to confirm the update. 

� Clear the Update Point Database After MOVE Command check box if you 
do not want to update the COGO point database with the point coordi-
nates when you use the MOVE command.

� Under Point Checking, select or clear the Check Drawing Points Against 
Point Database On Open check box:

� Select the Check Drawing Points Against Point Database On Open check 
box to check the drawing against the point database whenever you open 
the drawing. The drawing is then updated with any changes that were 
made to the point database. This option is very useful if you are working 
on the same project with other people. 

� Clear the Check Drawing Points Against Point Database On Open check 
box if you do not want to check the drawing against the point database 
when you open the drawing. Any differences between the drawing and 
the point database can be reconciled by using the Check Points com-
mands. For more information, see “Checking for Points in Projects and 
Drawings” on page 192.

� Under Point Checking, do one of the following to specify how symbols react 
when you use the Check Points commands:

� Select the Re-unite Symbol With Description During Check Points check 
box to return point symbols to the exact insertion points of the points if 
the symbols are not already there. Symbols that are affected are the sym-
bols that are inserted by using description keys or that are inserted with 
point labels. When a command such as Modify Drawing updates the point 
or symbol location, then the symbol returns exactly to the insertion point 
of the point.

� Clear the Re-unite Symbol With Description During Check Points check 
box to have symbols maintain their relative locations to the points so that 
if a point is moved, the symbol moves with it while staying the same dis-
tance away from the point. 

� Click OK.

Changing the Coordinate Display Settings

Use the coordinate display settings to control whether point coordinates are 
displayed in Northing - Easting, Easting - Northing, X - Y, or Y - X format, and 
whether the point coordinates are echoed at the command line.
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NOTE The points’ northing and easting coordinates are always displayed 
regardless of whether you select to display the points’ northing-easting coordi-
nates or X-Y coordinates. AutoCAD Land Development Desktop points are 
stored with northing-easting coordinates, and the display X and Y values corre-
spond to the northing and easting, not to the AutoCAD X,Y coordinates. For 
example, if you select the X-Y option on the Coords tab, and then use the List 
Points command, the column headings for the coordinates are X and Y. How-
ever, the X column contains the points’ easting values and the Y column contains 
the points’ northing values.

����	������	��������������
������������

� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Coords tab.

� Under Coordinate Display, select one of the following options:

� Northing - Easting: Displays point coordinates in northing/easting 
format.

� Easting - Northing: Displays point coordinates in easting/northing 
format.

� X - Y: Displays point coordinates in X/Y format.
� Y - X: Displays point coordinates in Y/X format.
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NOTE These options only affect point coordinates. Other objects in a drawing 
are not affected by this setting. These options control what you are prompted 
for at the command line as well as listing operations. 

� Select the Echo Coordinates on the Command Line check box to display the 
coordinates of the points that you create in the AutoCAD Text Window.

� Click OK.

Changing the Description Key Settings

You can use description keys any time you are prompted to enter a descrip-
tion for a point, or when you are importing points that use description keys. 
For more information, see “Using Description Keys” on page 144.

The description key settings control the matching capabilities of description 
keys. You can control other description key settings when editing point label 
styles. For more information, see “Description Keys for Point Labels” on page 
559.

����	������	�������
����� �����������

� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Description Keys tab.

� Under Description Key Search Order, select one of the following options:
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� Select Ascending to search the description key file from top to bottom. 
The ascending option searches the file from A to Z. In the ASCII character 
sequence, A is the lowest number of the alphabet, and Z is the highest 
number in the alphabet, which is why a search of this type is called 
ascending. For example, if you select Ascending, the description key ST* is 
used before the description key STA*, and every description starting with 
ST would use the ST* description key. 

� Select Descending to search the description key file from bottom to top. If 
you select Descending, then the STA* description key would be used 
before ST*, so that every description starting with STA would use the STA* 
description key. Then, if there are other descriptions that start with ST (but 
not STA), they would use the ST* description key.

� Under Matching Options, select or clear the Match on Description 
Parameters ($1, $2, etc.) check box:

� Select the Match on Description Parameters ($1, $2, etc.) check box to use 
description parameters in the description format, and for scaling and 
rotating the description key symbols.

� Clear the Match on Description Parameters ($1, $2, etc.) check box if you 
do not want to use description parameters in the description format and 
for scaling and rotating the description key symbols. 

For more information, see “Using Description Parameters in Description 
Keys” on page 162.

� Under Matching Options, select or clear the Perform Extended Default 
Search for Description Keys in DEFAULT.MDB check box:

� Select the Perform Extended Default Search for Description Keys in 
DEFAULT.MDB check box to search the default description key file for 
matching description keys, after the current description key file is 
searched and a match is not found.

� Clear the Perform Extended Default Search for Description Keys in 
DEFAULT.MDB check box to limit the search to the current description 
key file.

NOTE You set the current description key file in the Edit Label Styles dialog 
box. For more information, see “Description Keys for Point Labels” on page 
559.

� Click OK.
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Changing the Point Marker Symbol Settings

The point marker settings control the appearance of the point markers, such 
as the marker symbol and text. For more information about the differences 
between point markers and point labels, see “Differences Between Point 
Markers and Point Labels” on page 109.
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� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Marker tab.

� Select one of the following options:

� Select Use Custom Marker to customize the marker settings. When you 
select this option, the other options in the dialog box become available for 
you to use.

� Select Use AutoCAD POINT for Marker to use an AutoCAD point type as 
the point marker. If you select this option, then the other options in the 
dialog box are grayed out. To change the AutoCAD point type you can use 
the DDPTYPE, PDMODE, and PDSIZE commands.

� Under Custom Marker Style, select one of the five options for displaying the 
marker. You can use an ✕, a dot, and so on. The blank icon inserts no point 
marker.
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� Under Superimposed, you can choose to have a square and/or a circle super-
imposed around the point marker in the drawing by selecting the square or 
circle check boxes.

� Under Custom Marker Size, select one of the following options:

� Select Size Relative to Screen to scale the point marker size to a fixed per-
centage of the AutoCAD graphics screen. This option maintains the rela-
tive size of the point marker to the screen regardless of the zoom level. If 
you select this option, then type the percentage in the Size box. 

� Select Size in Absolute Units to make the point markers a fixed size in the 
drawing. If you select this option, then type the fixed size in units in the 
Size box.

� Select the Align Marker With Text Rotation box to rotate the point marker at 
the same angle specified for the marker text rotation.

NOTE To change the default rotation angle for the point marker text, type a 
rotation angle in the Text Rotation box on the Text tab of the Point Settings 
dialog box. 

! Click OK.

Changing the Point Marker Text Settings

Use the point marker text settings to control the following:

� The visibility of point marker leaders
� The color and visibility of the point marker text
� Whether point markers show full descriptions instead of raw descriptions
� Whether point marker size remains constant relative to the screen after 

zooming, or whether it is a fixed size in the drawing
� The rotation of the point marker text

NOTE For more information about changing the point marker settings for 
points already in the drawing, see “Changing the Display Properties for Points 
in the Drawing” on page 298.

����	������	��
�������"����������

� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Text tab.
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� Under Color and Visibility, choose which point marker components you 
want to be visible in the drawing and what color they are.

� Select the Visible check boxes next to the marker component to view the 
feature in the drawing.

� Click the color boxes next to the marker features to change the color of 
the component, or type a color number in the text box.

� Select one of the following options:

� Select Show Raw Descriptions to show the point descriptions that were 
originally assigned to the points before description key matching is 
applied.

� Select Show Full Descriptions to show the descriptions after description 
key matching is applied. The description key settings of the point label 
style that is current at the time the point object is inserted in the drawing 
are used to match the description.

NOTE To show the full descriptions, the Use the Current Point Label Style 
When Inserting Points check box must be selected on the Insert Tab of the 
Point Settings dialog box. For more information, see “Changing the Point 
Insertion Settings” on page 98.

� Under Style and Size, select a text style to use for the point markers from the 
Text Style list.
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� Do one of the following to control the display size of the point markers:

� Select Size Relative To Screen to scale the point marker text to a fixed per-
centage of the AutoCAD graphics screen. This option maintains the rela-
tive size of the point marker text to the screen regardless of the zoom level. 
If you select this option, then type the percentage in the Size box. 

� Select Size In Absolute Units to make the point marker text a fixed size in 
the drawing. If you select this option, then type the fixed size in units in 
the Size box.

� To run off the display of leaders, clear the Automatic Leaders check box. If 
this check box is selected, then leaders are created when you drag the point 
marker text away from the point.

! To change the default rotation angle for the point marker text, type a rota-
tion angle in the Text Rotation box in 0d0'0" format. 

NOTE To control the rotation of the point marker symbol, select the Align 
Marker With Text Rotation check box on the Marker tab of the Point Settings 
dialog box. 

# Click OK. 

Differences Between Point Markers and Point 
Labels

There are two different modes you can use to view point information on 
screen:

� Point markers 
� Point labels

You can use point markers as a “working mode” and then you can label the 
points to place additional data on the point node. 

Point markers have the following benefits:

� You can set their size relative to the screen, so when you zoom in or out, 
they stay the same size.

� You can drag the marker text away from the point node, creating a leader 
with an arrow.

� They can show point number, elevation, and description. If description 
keys are in use, the full description of the point can be substituted for the 
raw description.
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Point labels have the following benefits:

� You can label points with XDRef information. For more information 
about XDRefs, see “Using External Data References (XDRefs)” on page 
172.

� You can label points with any amount of data: you are not limited to point 
number, elevation, or description. You can keep the marker text visible, 
showing point number, elevation, and description, and use the point 
labels to label the points with different information.

� You can observe the full affect of description key substitution when points 
are labeled. The full description is substituted for the raw description and 
the symbol is placed in the drawing.

� You can turn off point markers when labels are created.

Both labels and markers can exist at the same time, making a point appear 
like it has duplicate information. You can turn markers or labels off so that 
only one of the two is displayed.

NOTE In order to label points, the Use the Current Point Label Style When 
Inserting Points check box must be selected in the Point Settings dialog box. If 
this check box is selected when you are creating or inserting points, then the cur-
rent point label style is automatically applied to the points—you do not have to 
label the points after they are inserted or created. For more information, see 
“Changing the Point Insertion Settings” on page 98.

Changing the Point Preferences

Use the point preference settings to control whether to display dialog boxes 
instead of command line prompts for certain commands, and whether to 
regenerate the point marker display when zooming.
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� From the Points menu, choose Point Settings to display the Point Settings 
dialog box.

� Click the Preferences tab.
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� Under Command Line Input, select or clear the Allow Command Line Input 
of Point Lists check box:

� Select the Allow Command Line Input of Point Lists check box to use 
command line options to define the list of points to use for point com-
mands. When this check box is selected, a prompt similar to the following 
is displayed when you select point editing/inserting/removing 
commands:
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� Clear the Allow Command Line Input of Point Lists check box to define 
point lists from the Point List dialog box.

� Under Command Line Input, select or clear the Allow Command Line Input 
of Point Group Names check box:

� Select the Allow Command Line Input of Point Group Names check box 
to type point group names at the command line to select the groups. 

� Clear the Allow Command Line Input of Point Group Names check box 
to select point groups from a dialog box only.

� Under Point List Dialog, select or clear the Sort Point List After Remove 
Duplicates is Pressed check box:

� Select the Sort Point List After Remove Duplicates is Pressed check box to 
sort the point list when you click the Remove Duplicates button in the 
Point List dialog box. 
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� Clear the Sort Point List After Remove Duplicates is Pressed check box if 
you do not want the point list to be sorted when you click the Remove 
Duplicates button in the Point List dialog box. This is useful in cases where 
you are creating order-dependent lists and yet want to remove the dupli-
cate points in the list. For example, when you are creating a point list to 
use for a Best Fit Line, the order of the points in the list is imperative.

� Under Point List Dialog, select or clear the Sort Point List After Remove is 
Pressed check box:

� Select the Sort Point List After Remove is Pressed check box to sort the 
point list when you click the Remove button in the Point List dialog box.

� Clear the Sort Point List After Remove is Pressed check box if you do not 
want the point list to be sorted when you click the Remove button in the 
Point List dialog box. 

WARNING! Clear these check boxes when you are creating order-dependent 
point lists. For example, when you are creating a point list to use for a Best Fit 
Line, the order of the points in the list is imperative. 

� Under Point Display, select or clear the Always Regenerate Point Display After 
Zoom check box:

� Select the Always Regenerate Point Display After Zoom check box to 
regenerate the point display when you change the zoom level. Point 
markers only resize if the point display is regenerated. Therefore, if you set 
the point marker display size as Size Relative to Screen, and you select the 
Always Regenerate Point Display After Zoom check box, then when you 
zoom, the point marker display is updated.

NOTE This setting does not perform a REGEN on the drawing. Only the 
points are regenerated, not the entire drawing. 

� Clear the Always Regenerate Point Display After Zoom check box if you do 
not want to regenerate the point display when you change the zoom level. 
If you set the point marker display size as Size Relative to Screen, and you 
clear the Always Regenerate Point Display After Zoom check box, then 
when you zoom, the point marker size is not updated.

! Click OK.
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7Point Groups and Lists

A point database can contain thousands of points. It is 

easier to organize and access these points if you create 

point groups. You can create a point group by selecting 

the points you want in the group and building a point 

list. You can also apply overrides to point groups to sub-

stitute point data in the project point database.

In this chapter

� Point Groups

� Creating a Point Group

� Point Group Overrides

� Removing Points from a Point 
Group

� Changing the Properties of a 
Point Group

� Creating Point Lists
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Point Groups

You may work with a point database that contains thousands of points. To 
make point management easier, you can create point groups, which allow 
you to logically group points for surface creation, point editing, and point 
exporting. 

Point groups are a collection of point numbers that you can use to simplify 
point selection for several different functions. For example, to build a surface 
out of points, you can create an EG point group that contains all the points 
you want to use to build an existing ground surface. After you set up the EG 
point group, you can reuse it every time you want to rebuild the surface. You 
can also add points to the group later.

You can add the points that exist in the point database file to point groups. 
A point number can be in more than one point group at a time. If you insert 
a point group into a drawing, and then insert another point group into the 
drawing that contains some of the same points that was in the first group, 
then those duplicate points take on the attributes of the second group (such 
as labeling settings and so on).

To create a point group, you must first create a point list. This list contains 
the point numbers that you want to add to the group. You can select all the 
points in the project, specific points in the drawing, or filter points based on 
elevation range, description, and so on. Point lists are also used for selecting 
points to edit or insert.

NOTE After you create the COGO point groups database file using Release 2 
of AutoCAD Land Development Desktop, the point groups database file may not 
be used with any prior version of AutoCAD Land Development Desktop.

Using The Point Group Manager

To create, modify, or delete point groups, you can use the Point Group 
Manager. Point groups are a collection of point numbers in the project point 
database that you can use to simplify point selection for several different 
functions, such as inserting points, importing points, and for including 
points from the point database in a surface.
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The Point Group Manager has the following new features for Release 2 of 
AutoCAD Land Development Desktop: 

� Printing commands available through shortcut menu and Manager menu
� Drag-and-drop column ordering
� Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore col-
umn visibility.

Creating a Point Group

To create a point group, you must first build a point list. You can build a point 
list from all or selected points in the project, from existing point groups, or 
you can use advanced options to filter points. You can use overrides to estab-
lish a single fixed value for a point, or to reference a column of data in a cus-
tom Microsoft Access database. These overrides include the Point Label 
Style, the description, the elevation, and the point name.
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� From the Points menu, choose Point Management ➤ Point Group Manager 
to display the Point Group Manager dialog box.
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� Do one of the following to display the Create Point Group dialog box:

� Click .
� Right-click in the left-hand pane of the Point Group Manager and select 

Create Point Group.
� From the Manager menu in the Point Group Manager, choose Create 

Point Group.

� In the Group Name box, type a name for the group. 

Point group names are limited to the following characters: alphanumeric 
(A–Z, a–z, 0–9), dash (-), underscore (_), and space ( ). There is no restriction 
on the first character, so point group names can begin with any of these char-
acters. The total length of a point group name must not exceed 32 characters.

� Click Build List to display the Point List dialog box.
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� Select the points to add to the list.

� Select All Points to add all the points from the project point database to 
the list. 

� Select Drawing Selection Set and then click the Select button to select 
points from the drawing. You can use the 'Zoom and 'Pan commands 
transparently to help you locate the points to select.

� Select Point Group and then select a group name to create the list from a 
pre-existing group. 

TIP Click the Advanced button to use advanced point selection options. For 
more information, see “Creating a Point List Using Advanced Point Selection 
Options” on page 135.

� To remove duplicate points from the list, click Remove Duplicates.

NOTE If you selected the Sort Point List after Remove Duplicates is Pressed 
check box in the Point Settings dialog box, then the Remove Duplicates button 
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also sorts the list. For more information, see “Changing the Point Preferences” 
on page 110.

NOTE The Create Group button is grayed out in this dialog box because it is 
assumed that you are already creating a group. This dialog box is also used for 
selecting points to edit and insert and the Create Group button is enabled for 
those functions. 

� You can set up point group overrides. For more information, see “Setting Up 
Point Group Overrides” on page 131.

� Click OK to return to the Point Group Manager. The point group you created 
is displayed in the left-hand pane of the dialog box, and the points in the 
point group are listed in the right-hand pane.

Using Advanced Point Source Options To Build a Point List
When you click the Advanced button in the Point List dialog box, three tabs 
appear: Source, Filter, and List.
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� Do one of the following to display the Point List dialog box:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Edit List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

NOTE The dialog box can also be displayed when you type Dialog at the 
following prompt, which is displayed when you select several different point 
editing commands, such as Lock Points.

Points to Lock (All/Numbers/Group/Selection/Dialog)? <Dialog>:

� Click the Advanced button.

� Click the Source tab.
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� Do one or more of the following to create the point list:

� Select All Points to add all the points from the project point database to 
the list. 

� Select Drawing Selection Set and then click the Select button to select 
points from the drawing. You can use the 'Zoom and 'Pan commands 
transparently to help you locate the points to select.

� Select Drawing Selection Set and then click the All Project Points in 
Window button to select points from the drawing and the project data-
base. When you select this option, all the project points that are inside the 
window that you draw are selected, regardless of whether they are in the 
drawing or not. 

� Select Group Points and then select a group name from the Group list to 
create the list from a pre-existing group. 

� Select Group Points with Overrides and then select a group name from the 
Group list to add a group to the list and to use the overrides that you have 
already set up for that group. 

When you select the points, the source points are listed in the Source 
Point List box. 

� Click one of the following options:
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� Click Add to add the points in the Source Point List box to the Current 
List, which is displayed at the top of the dialog box.

� Click Remove to remove the points in the Source Point List box from the 
Current List.

NOTE If you selected the Sort Point List after Remove is Pressed check box 
in the Point Settings dialog box, then the Remove button also sorts the list. 

� Click Remove Duplicates to remove duplicate points from the list. 

NOTE If you selected the Sort Point List after Remove Duplicates is Pressed 
check box in the Point Settings dialog box, then the Remove Duplicates button 
also sorts the list. For more information, see “Changing the Point Preferences” 
on page 110.

� Click Create Group to create a point group from the list.

NOTE This button is not enabled when you access the Point List dialog box 
from the Create Point Group dialog box. 

� Click OK.

Filtering a Point List
When you click the Advanced button in the Point List dialog box, three tabs 
appear: Source, Filter, and List. You can use the filtering options to create a 
point list of specific ranges of point numbers, elevations, descriptions, and 
names, among other options.
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� Do one of the following to display the Point List dialog box:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Edit List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

NOTE The dialog box can also be displayed when you type Dialog at the 
following prompt, which is displayed when you select several different point 
editing commands, such as Lock Points.
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Points to Lock (All/Numbers/Group/Selection/Dialog)? <Dialog>:

� Click the Advanced button.

� Click the Filter tab.

The Source label shows which option you used to select the points and lists 
which points are in the list. 

� Set up the filter by selecting any of the following options:

� Ranging In Numbers From. For more information, see “Filter Option: 
Ranging in Numbers From” on page 124.

� Ranging In Elevations From. For more information, see “Filter Option: 
Ranging in Elevations From” on page 125.

� With Name Matching. For more information, see “Filter Option: With 
Name Matching” on page 125.

� With Description Matching. For more information, see “Filter Option: 
With Description Matching” on page 125.

� With XDRef Matching. For more information, see “Filter Option: With 
XDRef Matching” on page 126.
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� Select one of the following options to specify whether you want to include 
the matching (filtered) points in the resulting point list or exclude the 
matching points from the Resulting Point list.

� Include Matching Points: Select this option to add the matching points 
to the Resulting Point List. For example, if the source list is 1–45, and you 
include points 1–10 by filtering them, then the list 1–10 is displayed in the 
Resulting Point list.

� Exclude Matching Points: Select this option to exclude the matching 
points from the Resulting Point List. For example, if the source list is 1–45, 
and you excluded points 1–3 by filtering them out, then the list 4–45 is 
displayed in the Resulting Point list. 

� Click the Filter button to filter the list. The resulting list is displayed in the 
Resulting Point List box.

� Click one of the following buttons:

� Add: Click this button to add the Resulting Point list to the Current List, 
which is displayed at the top of the dialog box.

� Remove: Click this button to remove the Resulting Point list from the 
Current List.

� Click Remove Duplicates to remove duplicate points from the Current List. 

NOTE If you selected the Sort Point List after Remove Duplicates is Pressed 
check box in the Point Settings dialog box, then the Remove Duplicates button 
also sorts the Current List. For more information, see “Changing the Point Pref-
erences” on page 110.

� Click Create Group to create a point group from the Current List.

NOTE This option is not enabled when you access this dialog box from the 
Create Point Group dialog box. 

Filter Option: Ranging in Numbers From

� Complete steps 1–4 in “Filtering a Point List” on page 122.

� Select the Ranging In Numbers From check box to filter points based on a 
number range.

� Type the beginning of the range (the lowest point number you want to use).

� Type the ending of the range (the highest point number you want to use).
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Filter Option: Ranging in Elevations From

� Complete steps 1–4 in “Filtering a Point List” on page 122.

� Select the Ranging In Elevations From check box to filter the points based on 
an elevation range.

� Type the beginning of the elevation range (the lowest elevation you want to 
use).

� Type the ending of the elevation range (the highest elevation you want to 
use).

Filter Option: With Name Matching

� Complete steps 1–4 in “Filtering a Point List” on page 122.

� Select the With Name Matching check box to filter the points based on a 
point name.

� Type the string that you want to use as a filter.

TIP You can use wildcard characters to filter point names. For example, you 
can type STA* to filter on all point names that start with STA. For more informa-
tion, see “Using Wildcard Characters When Filtering Point Lists” on page 
126.

Filter Option: With Description Matching

� Complete steps 1–4 in “Filtering a Point List” on page 122.

� Select the With Description Matching check box to filter the points based on 
a point description.

� Select one of the following options:

� Select the Raw Desc option to filter the points based on the original, raw, 
point descriptions.

� Select the Full Desc option to filter the points based on the point descrip-
tions that were substituted by description keys.

� Type the string that you want to use as a filter.

TIP You can use wildcard characters to filter descriptions. For example, you can 
type STA* to filter on all point descriptions that start with STA. For more infor-
mation, see “Using Wildcard Characters When Filtering Point Lists” on page 
126.
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Filter Option: With XDRef Matching

NOTE Before using this option, you must set up XDRefs. For more information 
on how to set up XDRefs, see “Creating an External Data Reference (XDRef)” 
on page 175.

� Complete steps 1–4 in “Filtering a Point List” on page 122.

� Select the With XDRef Matching check box to filter points based on values 
in an external database.

� Select the XDRef to use from the XDRef to Search list. 

� Enter the string that you want to use as a filter. The actual XDRef values in 
the external database are filtered for a match. This string is case-sensitive. 
TOPO is not the same as topo.

TIP You can use wildcard characters to filter XDRefs. For example, you can type 
STA* to filter on all XDRef values that start with STA. For more information, see 
“Using Wildcard Characters When Filtering Point Lists” on page 126.

For example, say you have an external database that contains a column of 
point description data. You can set up an XDRef for the column, and create 
a point group that uses the XDRef as the description override. However, you 
only want to include in the point group the points whose descriptions start 
with T. To do this, click the Advanced button in the Point List dialog box and 
then click the Filter tab. Select the With XDRef matching box, select the 
XDRef, and then type T* as the string you want to filter on. Click Filter to 
filter the points in the external database that have descriptions that start 
with T. You can click Add to add these points to the current point list.

NOTE You can also use this filtering mechanism when inserting points into the 
drawing, selecting points to edit, and so on. For example, you could set up a 
point group that uses an XDRef override to use all of the point descriptions in 
the external database. Then when using the Insert Points to Drawing command, 
select the Dialog option to select the points to insert from the Point List dialog 
box. Click the Advanced button, click the Filter tab, and then specify the XDRef 
and the string to filter on. 

Using Wildcard Characters When Filtering Point Lists
You can use any of the following wildcard characters to search for descrip-
tions, point names, and XDRefs when you are building a point list. For more 
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detailed information about using wildcard characters, see “Using Wildcard 
Characters in Description Keys” on page 164.

Viewing and Sorting a Point List
When you click the Advanced button in the Point List dialog box, three tabs 
appear: Source, Filter, and List.
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� Do one of the following to display the Point List dialog box:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Edit List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

Wildcard characters
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# (pound) Matches any single numeric digit

@ (at) Matches any alphabetic character

. (period) Matches any non-alphanumeric character

* (asterisk) Matches any string and can be used anywhere in the search 
string

? (question mark) Matches any single character, for example, ?BC matches ABC, 
3BC, and so on

~ (tilde) Matches anything but the pattern, for example, ~*AB* 
matches all strings that don’t contain AB

[...] Matches any one of the characters enclosed, for example, 
[AB]C matches AC and BC

[~...] Matches any character not enclosed, for example, [~AB]C 
matches XC but not AC

- (hyphen) Inside brackets, specifies a range for a single character, for 
example [A-G]C matches AC, BC, and so on to GC, but not 
HC

′ (reverse quote) Reads the next character literally, for example, ′*AB matches *AB
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NOTE The dialog box can also be displayed when you type Dialog at the 
following prompt, which is displayed when you select several different point 
editing commands, such as Lock Points.

Points to Lock (All/Numbers/Group/Selection/Dialog)? <Dialog>:

� Click the Advanced button.

� Click the Edit tab.

The Edit tab shows the point number, name, elevation, description, easting, 
northing, latitude, longitude of the points in the list.

� You can click on a column heading to sort the point list.

NOTE If you access this dialog box by selecting the List Points command, the 
tab is named List instead of Edit.
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Removing Points from a Point Group

To remove points from a point group you can use the Filter options in the 
Advanced section of the Point List dialog box. You can specify the points to 
remove by filtering on a range of point numbers, a set of points that fall 
within an elevation range, point names, descriptions, and XDRef 
information.
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� From the Points menu, choose Point Management ➤ Point Manager Group 
to display the Point Group Manager dialog box.

� In the right-hand pane, right-click the point group you want to edit to dis-
play the shortcut menu.

� Select Properties to display the Point Group Properties dialog box.

� Click Edit List to display the Point List dialog box.

� Click the Advanced button.

� Click the Filter tab.

� Use the Filter options to select the point or points you want to remove from 
the point group.

For example, to remove point numbers 5–10, select the Ranging in Numbers 
From check box, and then type 5 in the first edit box and 10 in the second 
edit box.

� Select the Include Matching Points option. This option adds the specified 
points to a selection set that you can later remove from the point group.

� Click Filter to filter the points.

The resulting point list is displayed in the Resulting Point List box. For exam-
ple, if you specified point numbers 5–10 and click Filter, then points 5–10 are 
listed in the Resulting Point List box.

�& Click OK to continue.

�� Click Remove to remove the points from the point group.

AutoCAD displays a message box informing you that the removal is 
complete.

�� Click OK to continue.

Deleting a Point Group

You can delete a point group if you no longer need to use it. Deleting a point 
group does not delete the points in the point group; the points remain intact 
in the COGO point database.
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� From the Points menu, choose Point Management ➤ Point Group Manager 
to display the Point Group Manager dialog box.

� Select the point group that you want to delete.

� Do one of the following to delete the point group:

� Click .
� Right-click to display the shortcut menu and select Delete.
� From the Manager menu, choose Delete. 

A message dialog box is displayed, asking you to confirm the deletion.

� Click Yes to delete the point group.

Point Group Overrides

When you create a point group, by default the points in that group retrieve 
all of their information from the COGO point database. For example, in the 
COGO point database, point 1 has a description of Benchmark and an eleva-
tion of 100. If you create a group that includes point 1, then the point 
retrieves its data from the COGO point database and have the description 
Benchmark and the elevation 100.

However, you can also set up overrides for the points in a point group. Over-
rides can substitute Point Label Style, description, elevation, and name. For 
example, you could set up an override for the group that replaces point 1’s 
description, Benchmark, with a description of TOPO. The data in the point 
database remains unchanged, but when the point is referenced in a group, 
the point has an override, TOPO, as its description. For more information, 
see “. Using Existing Overrides for Points in a Point Group When Selecting 
the Group” on page 135.

There are two ways to override point data in point groups:

� You can override the point label style, description, elevation, or name 
with a single fixed value that is used for all points in the group.
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� You can specify an XDRef name to substitute data that is in a Microsoft 
Access database on a point-by-point basis. Use this option to override each 
point with a different value. 

Setting Up Point Group Overrides

To override the existing properties of the points in a point group, you can 
apply point overrides. You can either establish a fixed value to use as an over-
ride, or reference an XDRef. By referencing an XDRef, you can substitute 
point properties from an external database, such as point elevations, for the 
current properties of the points.

The following dialog box shows a point group that has overrides assigned 
to it:
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� From the Points menu, choose Point Management ➤ Point Group Manager 
to display the Point Group Manager dialog box.

� Select the point group for which you want to set up overrides.

NOTE You can set up point group overrides while you create a point group, 
or you can use the Properties command to set up point group overrides for an 
existing group. 

� From the Manager menu in the Point Group Manager, choose Properties, or 

click  to display the Point Group Properties dialog box.

� Under Point Overrides, select the point Property check boxes for properties 
that you want to override:

� Point Label Style: Substitutes a fixed label style or label styles set up in 
an XDRef.



132 | Chapter 7 Point Groups and Lists

� Description: Substitutes a fixed description or descriptions set up in an 
XDRef. Description overrides are always applied to the point’s raw descrip-
tion.

� Elevation: Substitutes a fixed elevation or elevations set up in an XDRef.
� Name: Substitutes a fixed name or names set up in an XDRef. Available 

only if the point database is set up to use point names. For more informa-
tion, see “Creating the Point Database” on page 90.

� In the Override column, assign an override:

To assign a fixed override, click in a box (see the following example) and type 
the override that you want to use. 

The  icon indicates that the override is fixed. For example, to override the 

names of all of the points in the group with TOPO, select the Name check 
box, click in the override box, and then type the name that you want to use 
as an override in the adjacent box. 

Fixed overrides are limited to 32 characters. Point names and descriptions are 
also limited by the character limit you assigned when you first created the 
project.

NOTE If you use a point label style as a fixed override, and the point label style 
name is greater than 32 characters, you will receive an error message when you 
click OK to create the point group. In addition, the points will not be assigned 
the label style when the points are inserted into the drawing as a group.

To assign an XDRef override, click the  icon to display the  icon. The  
icon indicates that the override is an XDRef override. 

Then click in the box next to the  icon (see the following example) to dis-

play the Select External Data Reference dialog box, where you can select the 
XDRef to use. 
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When you select the XDRef, its name is displayed in the Override box. The 
following illustration shows that the point names in the point group are 
overridden by the point names in the external database defined by the XDRef 
called “PT Name XDRef”.

For more information about creating XDRefs, see“Creating an External Data 
Reference (XDRef)” on page 175.

You can determine whether overrides are in use by looking at the point group 
in the Point Group Manager. In the following illustration, the Elevation col-
umn shows that an XDRef override is applied to the data:

In the following illustration, the Raw Description column shows that a fixed 
override is applied to the data:

Example: Creating a Point Group with an XDRef 
Override

The following example describes how to use a sample user database to set up 
an XDRef and to use the XDRef to override point descriptions in a point 
group.
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� Create a new project and a new drawing.

� Place some points in the drawing, starting with point number 1.

� From the Points menu, choose Point Management ➤ XDRef Manager to dis-
play the XDRef Manager dialog box. 

� From the Manager menu, choose Create XDRef to display the Create External 
Data Reference dialog box.
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� Click  to display the Find User Database dialog box.

� Select the sample user database, SampleUserDb.mdb, from the following 
folder:

c:\Land Projects R2\<project name>\cogo\UserDb

� Click Open to return to the Create External Data Reference dialog box.

When you select the database, the table and column name lists become 
active.

� From the Table Name list, select SampleTable1.

� From the Column Name list, select DESC1. 

�& In the Name box, type XDREF Name. 

The Create External Data Reference dialog box should appear as shown in the 
following illustration:

�� Click OK.

�� Close the XDRef Manager.

�� From the Points menu, choose Point Management ➤ Point Group Manager 
to display the Point Group Manager dialog box. 

�� From the Manager menu, choose Create Point Group to display the Create 
Point Group dialog box. 

�� In the Name box, type a name for the point group.

�� Click Build List to build the point list. For more information, see “Creating a 
Point Group” on page 117. 

�� Click OK to return to the Create Point Group dialog box.

�� Under Point Overrides, select the Description check box.

�� Click the  icon to change it to the  icon.

�& Click in the box next to the  icon to display the Select External Data 
Reference dialog box. 
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�� Select XDREF Name.

�� Click OK to return to the Create Point Group dialog box. The Point Overrides 
section of the dialog box should appear as shown in the following 
illustration:

�� Click OK to return to the Point Group Manager.

The point descriptions substituted for the values in the COGO database 
appear in the Description column as shown in the following illustration:

Now when you insert the points as a group, the descriptions substituted from 
the XDRef are used instead of the raw descriptions in the COGO point 
database.

 Using Existing Overrides for Points in a Point 
Group When Selecting the Group

Overrides work for point groups only if you reference the group as a group. 
For example, say you create a point group that contains all the points in your 
project and you name the group EVERY POINT. You assign a description over-
ride of TOPO to the group, and then you insert the points into the drawing 
by selecting the EVERY POINT group. For example, when you select the 
Insert Points to Drawing command, the following prompt is displayed:
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When you use the Group option to insert the points, the override is applied 
to the group and the points are inserted into the drawing with the descrip-
tion TOPO.

However, if you do not reference the group as a group, overrides are not 
applied. For example, if you select the All option as displayed in the previous 
prompt, all the points would be inserted into the drawing, but because they 
were not referenced as a group, the overrides are not applied. 

Description Key Matching and Point Group 
Overrides

When you assign an override for the points’ descriptions, the points’ raw 
descriptions are overridden. If the raw description is a description key and 
the raw description is overridden, then the description key is not used.

However, if the description you assign as an override contains a description 
key code, then description key substitution is applied to the points. 

For more information on how description keys are applied to points, see 
“Description Keys and Point Markers and Point Labels” on page 146.

Creating a Point List from a Point Group that has 
Overrides Applied to It

When you select a command that requires a point selection set, such as the 
Insert Points to Drawing command, a prompt similar to the following is 
displayed:
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NOTE If you turned off the option to allow command line input of point 
groups in the Point Settings dialog box, then a dialog box is displayed instead of 
this prompt. 

At this prompt you have several options for selecting points. To select point 
groups that have overrides applied to them, you can do one of the following:

� You can use the Group option to select a group name from the current list 
of groups or to type the point group name at the command line. When 
you select a group this way, all the overrides that are set up for that group 
are applied to the group.
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� You can use the Dialog option to display the Point List dialog box. Click 
the Advanced button and then click the Source tab. Select the Group 
Points with Overrides option and then select the group from the list.

NOTE If you select the Group Points option, or if you select the point group 
from the Simple point group dialog box, then overrides are not applied. By using 
Group Points with Overrides option, all overrides are used. 

You can see the actual override values displayed for each point in the right-
hand pane of the Point Group Manager. If there is a check box in the column 
header, then the column has an override. If there is a  icon in the column 
header, then an XDRef controls the override, for example:

If there is a  icon in the column header, then the override is fixed, for 
example:

Changing the Properties of a Point Group

You can change point group overrides, point group name, and which points 
are in the point group by changing the point group properties. 
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� From the Points menu, choose Point Management ➤ Point Group Manager 
to display the Point Group Manager dialog box.

� Select the point group you want to edit.

� Do one of the following to display the Point Group Properties dialog box:

� Click .
� Right-click to display the shortcut menu and select Properties.
� From the Manager menu, choose Properties. 
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� In the Group Name box, you can type a different name to rename the point 
group.

� In the Point List box, you can type a different range of point numbers to 
change the points in the point group, or you can click the Edit List button to 
access the Point List dialog box, where you can use advanced point selection 
and filtering methods. For more information, see “Creating a Point List Using 
Advanced Point Selection Options” on page 135.

� Under Point Overrides, you can set up point group overrides. For more infor-
mation, see “Point Group Overrides” on page 130.

Creating Point Lists

You can create lists of points to add to a point group, to edit, to insert, or to 
list information about. Point groups are always based on a point list. The 
point list can contain all the points in the project, selected points from the 
graphics screen, or filtered points that match a specific criteria, such as points 
that are located at elevations between 100 and 200.

You can use the point list selection method for point editing, inserting, and 
removing points as well. When you select a point editing command, the fol-
lowing prompt is displayed:
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You can type Dialog at this prompt to build a list of points to select.

If you clear the Allow Command Line Input of Point Lists check box in the 
Point Settings, then the prompt is not displayed. Instead, the Point List dia-
log box is automatically displayed.

The Point List dialog box has the following new features for Release 2 of 
AutoCAD Land Development Desktop: 

� Printing commands available through shortcut menu and Printing menu
� Drag-and-drop column ordering
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� Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore col-
umn visibility. 
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� Do one of the following to display a dialog box you can use to create a point 
list:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Build List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

� Do one or more of the following to create the point list:

� Select All Points to add all the points from the project point database to 
the list. 

� Select Drawing Selection Set and then click the Select button to select 
points from the drawing. You can use the 'Zoom and 'Pan commands 
transparently to help you locate the points to select.
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� Select Point Group and then select a group name to create the list from a 
pre-existing group.

TIP Click the Advanced button to use advanced point selection options. For 
more information, see “Creating a Point List Using Advanced Point Selection 
Options” on page 135.

� Click Remove Duplicates to remove duplicate points from the list. 

NOTE If you selected the Sort Point List after Remove Duplicates is Pressed 
check box in the Point Settings dialog box, then the Remove Duplicates button 
also sorts the list. For more information, see “Changing the Point Preferences” 
on page 110.

� Click the Create Group button to create a group from the point list. 

NOTE This button is not enabled when you access the Point List dialog box 
from the Create Point Group dialog box. 

� Click OK to build the list.



Point Group Overrides | 141



142



143

8Description Keys

Description keys replace a point’s raw description with 

a full description, insert a symbol along with the point 

information, and place symbols and point nodes on 

specified layers. You can use the Description Key Man-

ager to create and manage description keys. To apply 

description key substitution to points, you can use point 

label styles.

In this chapter

� Using Description Keys

� Using the Description Key 
Manager

� Using Description Parameters 
in Description Keys

� Using Wildcard Characters in 
Description Keys

� Saving a Description Key File to 
a Prototype

� Loading a Description Key File 
from a Prototype
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Using Description Keys

Use description keys to associate symbols with COGO points, to place points 
on specific layers, and to substitute full descriptions for raw descriptions. The 
effect of description keys depends on whether you are using point markers or 
point labels. 

When you create COGO points, you can enter a description key at the 
Description prompt. The program searches for the description key in the 
description key file. If the key is found, then the full description, point layer, 
and symbol information are retrieved from the description key file. If the key 
is not found, then the entered key is used as the description for the point. 

Description keys are also used when you insert existing points into the draw-
ing from the point database file, or when you import points into the drawing 
from an external file or user database. When the point is inserted into the 
drawing, the point layer and symbol associations of the description key file 
are applied to the points.
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� Change the search path for symbol blocks so it points to the location of the 
symbols you want to use. For more information, see “Changing the Point 
Insertion Settings” on page 98.

� Turn on the option to use the current point label style when inserting points. 
For more information, see “Changing the Point Insertion Settings” on page 
98.

� Set up the Description Key settings. For more information, see “Changing the 
Description Key Settings” on page 104.

� Format a label style to use description keys. For more information, see 
“Example: Formatting a Point Label Style to Use Description Key Substitu-
tion” on page 170. Or, if you just want to use point markers, select the option 
to insert the points’ full descriptions on the Text tab of the Point Settings dia-
log box and make a point label style that is set up to use description key sub-
stitution the current point label style. For more information, see “Changing 
the Point Marker Text Settings” on page 107.

� Create description keys. For more information, see “Creating a Description 
Key” on page 147.

� Use a description key as a point’s raw description. A point’s raw description 
is the description originally assigned to the point. The description key is 
interpreted and the point’s raw description is replaced by a full description 
(optional); a symbol is inserted, and the symbol and point are placed on sep-
arate layers.
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All drawings within a project can use the description keys that you set up, so 
multiple people working across a network all have access to the same descrip-
tion keys. Description keys are stored in description key files. You can have 
multiple description key files per project. Description key files are saved 
externally, in the project directory. The files are named <name>.mdb, and are 
located in the following folder:

c:\Land Projects R2\<project name>\cogo\DescKey

You can use wildcard characters when you create description keys. Wildcards 
expand the flexibility of description keys. For example, if you create a 
description key named T*, then any point whose description starts with T 
(such as Topo, T-1, T2) is assigned the description key symbol. 

For examples of situations in which you can use description keys, see the fol-
lowing scenarios:

Description Key Scenario 1: Importing Points
When recording point data out in the field, use a description convention. 
This convention makes it easier to implement description key substitution. 
For example, use BM as a prefix for all benchmark points. You can set up a 
description key so that when you download the points and import the ASCII 
file into AutoCAD Land Development Desktop, all points that begin with a 
prefix of BM are assigned a symbol, layer, and full description.

Description Key Scenario 2: Creating Points
When creating points, decide on a point naming convention and set up 
description keys based on this convention. You can then create points and 
assign descriptions to them that are based on the description keys. For exam-
ple, if you use TOPO as a prefix for all topographic points, then create a 
description key called TOPO*. When you create points and are prompted to 
enter the description for a point, use TOPO as the description prefix. For 
example, you can create TOPO-1, TOPO-2, and so on. By doing this, each 
point with the TOPO prefix is assigned the symbol, layer, and optional 
description that was established for the TOPO* description key.

NOTE After you create the COGO description key database file using Release 2 
of AutoCAD Land Development Desktop, the description key database file may 
not be used with any prior version of AutoCAD Land Development Desktop.
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Description Keys and Point Markers and Point 
Labels

To fully implement description key substitution, you must set up and use a 
Point Label Style that is formatted to use description keys. The description 
key settings in the Point Label Style dialog box include the following: 

These settings must be selected if description key substitution is to be per-
formed on points when they are labeled.

To insert the point’s full description into a point marker, you must do the 
following:

� Select the Show Full Description option on the Text tab of the Point 
Settings dialog box. For more information, see “Changing the Point 
Marker Text Settings” on page 107.

� Select the Use the Current Point Label Style When Inserting Points option 
on the Insert tab of the Point Settings dialog box. For more information, 
see “Changing the Point Insertion Settings” on page 98.

� Make sure the current point label style is set up to use description keys. For 
more information, see “Example: Formatting a Point Label Style to Use 
Description Key Substitution” on page 170.

Description Key Symbols

The symbols that you use for description keys must be located in the symbol 
path that you set on the Insert tab in the Point Settings dialog box. For more 
information, see “Changing the Point Insertion Settings” on page 98.

Symbols that are inserted with the points by description keys are linked with 
the point object. They exist in the drawing as separate objects; however, any 
point command that modifies the point also affects the symbol, such as 
MOVE or ERASE.
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Description Key symbols are affected by the Reunite Key Symbol With Point 
setting in the Modify Drawing command. For more information, see “Updat-
ing the Drawing with Project Point Information” on page 195.

Using the Description Key Manager

All of the description key management commands are located in the 
Description Key Manager dialog box. You can use the Description Key 
Manager to create, delete, and change the properties of description keys and 
description key files.

The Description Key Manager has the following new features for Release 2 of 
AutoCAD Land Development Desktop: 

� Printing commands available through shortcut menu and Manager menu
� Drag-and-drop column ordering
� Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore col-
umn visibility. You can also import a project.dsc file, a previous version of a 
description key file from Softdesk 7 or Softdesk 8.

Creating a Description Key

Use the Description Key Manager to create a description key in a selected 
description key file.
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.
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� In the left-hand column of the dialog box, click the name of the description 
key file that you want to add a description key to. There is always a 

 description key file. 

NOTE By default, the description key file for a project is named default.mdb 
and is located in the following folder:

c:\Land Projects R2\<project name>\cogo\DescKey

� Do one of the following to display the Create Description Key dialog box:

� From the Manager menu, choose Create Description Key.

� Click .
� In the Manager, select the description key file that you want to add the 

description key to, right-click to display the shortcut menu, and then 
select Create Description Key.
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� In the DescKey Code box, type the description key code. This code is limited 
to 32 characters, including any wildcard characters. For more information, 
see “Using Wildcard Characters in Description Keys” on page 164. You can 
use the description key code as a description for any point that you import 
or create. Description keys are case sensitive. TOPO is not the same key as 
topo.

� Click the General tab if it is not already active.

� Type a Description Format. This code is limited to 255 characters. The 
Description Format is the text that replaces the points’ raw description. For 
example, you can set up a description key called Oak, and assign a 
Description Format of Oak Tree to the key. If you create a point and use a 
description key named Oak as the description, then Oak Tree becomes the 
full description of that point. 

NOTE You can use the dollar and asterisk ($*) description parameter code or 
other description parameters as the Description Format. For more information, 
see “Dollar Sign, Asterisk ($*) Description Format Substitution Code” on 
page 164 and “Using Description Parameters in Description Keys” on page 
162.

� In the Point Layer box, type the layer name for the point. If the layer does 
not exist, then AutoCAD Land Development Desktop creates it. This is the 
layer on which a point that you create with the description key is placed. 
Layer names are limited to 255 characters.

� Under Symbol Insertion, select the symbol that you want to use for the 
description key from the Symbol Block Name list. This is the symbol that is 
inserted at the point’s insertion point when you create a point with the 
description key.
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NOTE The symbols shown in this list are located in the symbol block path set 
up on the Insert tab on the Point Settings dialog box. To use symbols stored else-
where, change this path. For more information, see “Changing the Point Inser-
tion Settings” on page 98. You can also create a custom symbol to use in your 
drawing and then use the WBLOCK command to save the block to the symbol 
directory. 

� Under Symbol Insertion, type the layer name for the symbol in the Symbol 
Layer box. This is the layer on which the description key symbol is placed. 
Layer names are limited to 255 characters.

�� Click the Scale/Rotate Symbol tab and set up scale and rotation factors for the 
symbol. For more information, see “Scaling and Rotating a Description Key 
Symbol” on page 150.

�� Click OK to add the description key to the Description Key Manager.

Scaling and Rotating a Description Key Symbol
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� Complete steps 1–9 in “Creating a Description Key” on page 147.

� Click the Scale/Rotate Symbol tab.

� Under Scale Symbol By, select one or more of the following. For more infor-
mation about these choices, see “Parameters for Scaling and Rotating a 
Description Key Symbol” on page 151.

� Description Parameter
� Fixed Scale Factor
� Current Dwg Scale
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NOTE You can apply more than one scale factor to the symbol. The 
resulting scale is the combination of all the scale factors. 

� Under Apply Scale To, select one or more of the following options:

� X-Y Dimensions: Select this check box to apply the scale to the X-Y 
dimensions. This option scales the symbol in 2D view.

� Z Dimension: Select this check box to apply the scale to the Z dimension. 
This option scales the symbol in 3D view.

NOTE If the X,Y, and Z dimensions of a symbol are not the same, then you 
cannot explode the symbol. 

� Under Rotate Symbol By, select one or more of the following. For more infor-
mation about these choices, see “Parameters for Scaling and Rotating a 
Description Key Symbol” on page 151.

� Description Parameter
� Fixed Rotation

NOTE You can apply more than one rotation factor to the symbol. The 
resulting rotation angle is the combination of all the rotation factors. 

NOTE The units of rotation are the same as those set in the drawing. 

� Under Direction, select Clockwise or Counter-Clockwise:

� Select Clockwise to insert the description key symbol at a clockwise rota-
tion angle in relation to north.

� Select Counter-Clockwise to insert the description key symbol at a 
counter-clockwise rotation angle in relation to north.

� Click Save to save the description key.

� Click OK.

Parameters for Scaling and Rotating a Description Key Symbol
This section describes the different parameters that you can use when scaling 
and rotating a description key symbol.
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Description Parameter (Scaling)
You can use a description parameter to apply a scale to a symbol. For exam-
ple, say you create points with a description of Oak 18 and Oak 24. These 
points represent oak trees with 18″ and 24″ diameters. You can use the 18 and 
24 parameters to scale the symbol on insertion.
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� Complete steps 1 and 2 in “Scaling and Rotating a Description Key Symbol” 
on page 150.

� Under Scale Symbol By, select the Description Parameter check box.

� In the Description parameter $ box, type the description parameter substitu-
tion code that you want to use for the scale factor. 

These numbers use the naming convention $n, where n is the number of the 
description parameter in the entry. Description parameters to scale by must 
be in the range 1–9. For more information, see “Using Description Parame-
ters to Scale and Rotate Description Keys” on page 163.

For example:

� In the description Oak 18, Oak is the $0 field and 18 is the $1 field.
� In the description Oak Tree 18, Oak is the $0 field, Tree is the $1 field, and 

18 is the $2 field.

If the description is Oak 18, then in the Description parameter $ box, type 1 
to apply a scale of 18 units to the symbol.

� If you must apply an additional scale to the symbol, then select the Fixed 
Scale Factor check box and type the scale factor in the box. For example, if 
you created the symbol so that it was 1 unit in a drawing that was set up to 
use feet as the units, then you need to scale it by .083 to scale the symbol 
down to inches.

Fixed Scale Factor

� Complete step 1 and 2 in “Scaling and Rotating a Description Key Symbol” 
on page 150.

� Under Scale Symbol By, select the Fixed Scale Factor check box.

� In the box, type the scale factor to apply to the symbol. 

� Under Apply Scale To, select whether you want the scale to be applied to X-Y 
Dimensions and/or the Z Dimension. By applying the scale to the X-Y 
dimensions, the symbol is scaled in 2D view. By applying the scale to the Z 
dimension, the symbol is scaled in 3D view.
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NOTE If the X,Y, and Z dimensions of a symbol are not the same, then you 
cannot explode the symbol. 

Current Drawing Scale

� Complete step 1 and 2 in “Scaling and Rotating a Description Key Symbol” 
on page 150.

� Under Scale Symbol By select the Current Dwg Scale check box to apply the 
scale factor of the drawing to the symbol. For example, if your horizontal 
scale is 1:40, then the symbol is inserted using that scale.

� Under Apply Scale To, select whether you want the scale to be applied to X-Y 
Dimensions and/or the Z Dimension. By applying the scale to the X-Y 
dimensions, the symbol is scaled in 2D view. By applying the scale to the Z 
dimension, the symbol is scaled in 3D view.

NOTE If the X,Y, and Z dimensions of a symbol are not the same, then you 
cannot explode the symbol. 

Description Parameter (Rotation)
You can use a description parameter for applying a rotation to a symbol. 

� Complete step 1 through 4 in “Scaling and Rotating a Description Key Sym-
bol” on page 150.

� Under Rotate Symbol By, select the Description Parameter check box.

� In the Description Parameter $ box, type the description parameter substitu-
tion code that you want to use for the rotation factor. 

These numbers use the naming convention $n, where n is the number of the 
description parameter in the entry. Description parameters to rotate by must 
be in the range 1–9. For more information, see “Using Description Parame-
ters to Scale and Rotate Description Keys” on page 163.

For example:

� In the description Oak 18, Oak is the $0 field and 18 is the $1 field.
� In the description Oak Tree 18, Oak is the $0 field, Tree is the $1 field, and 

18 is the $2 field.

� If you must apply an additional rotation to the symbol, then select the Fixed 
Rotation check box and type the rotation factor in the box. 

� Specify whether the rotation angle is clockwise from north, or counter-clock-
wise from north, by selecting either the Clockwise or the Counter-Clockwise 
option.
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Fixed Rotation

� Complete steps 1–4 in “Scaling and Rotating a Description Key Symbol” on 
page 150.

� Under Rotate Symbol By, select the Fixed Rotation check box.

� In the box, type the rotation angle. Type this rotation angle in DD.MMSS 
format.

� Specify whether the rotation angle is clockwise from north, or counter-clock-
wise from north, by selecting either the Clockwise or the Counter-Clockwise 
option.

Globally Controlling the Scale of Description Key 
Symbols

Use the AEC_DescKeyFixedScale command to globally control the Fixed 
Scale used to insert description key symbol blocks. 

Each description key has a Fixed Scale option that can be found on the Scale/
Rotate tab of the Description Key Properties dialog box. If this option is 
selected, the scale factor that you enter is applied to the description key sym-
bol block when it is inserted. You can use the AEC_DescKeyFixedScale com-
mand to simultaneously adjust all of the Fixed Scale factors in a description 
key file, and to set defaults for creating new description keys.
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� Type AEC_DescKeyFixedScale at the command line to display the following 
prompt:
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� Type Multiply. 

Description key files in the current project are listed at the command line, 
and the following prompt is displayed:
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� Press ENTER to accept the default description key file, named “default,” or 
type a name of the description key file to update. 

The following prompt is displayed:
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� Type the multiplication factor for the fixed scale. 

NOTE Typing “1” leaves the scale unchanged.
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� You are prompted to confirm the change. Press ENTER to accept the default 
(No) to not change the description key file, or type Yes to update the descrip-
tion key file.
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� Type AEC_DescKeyFixedScale at the command line to display the following 
prompt:
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� Type Replace. 

Description key files in the current project are listed at the command line, 
and the following prompt is displayed:
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� Press ENTER to accept the default description key file, named “default,” or 
type a name of the description key file to update. 

The following prompt is displayed:
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� Type the factor for the fixed scale. This scale factor replaces whatever fixed 
scale is defined for all description keys in the description key file.

� You are prompted to confirm the change. Press ENTER to accept the default 
(No) to not change the description key file, or type Yes to update the descrip-
tion key file.
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� Type AEC_DescKeyFixedScale at the command line to display the following 
prompt:
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� Type Default to set a given scale factor as the default when a new description 
key is created. There are default values for both Imperial and Metric draw-
ings.

The following prompt is displayed:
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� Type the fixed scale factor for Imperial drawings (when the Drawing Setup 
linear units are set to Feet).

The following prompt is displayed:
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� Type the fixed scale factor for Metric drawings (when the Drawing Setup lin-
ear units are set to Meters).

The following message is displayed at the command line:
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� To save these default scale factors to a prototype, use the Drawing Settings 
command to save the Point Settings to a selected prototype.

By using this command, you can use the same symbols in both Imperial and 
Metric drawings. For example, assume that the Current Drawing Scale option 
is selected for all description keys in the current description key file. And 
assume you have created symbol blocks whose drawing units are inches. This 
is the case, for example, for all of the COGO symbol blocks installed with 
AutoCAD Land Development Desktop. Based on these settings, symbols 
inserted with this description key file will appear at the correct scale when 
used in Imperial drawings, where the drawing scale is given as 1 inch = XX 
feet. But the same symbols would appear 39.37 times too big when inserted 
into a metric drawing, where the drawing scale is equivalent to 1 meter = XX 
meter. 

To properly scale the symbols in metric units, you can create a copy of the 
original description key file, and use the AEC_DescKeyFixedScale command 
to replace the Fixed Scale factors with 0.0254. This creates a new description 
key file that uses the same symbols as the original, but it inserts the symbols 
at the proper scale into a metric drawing. At the same time, you can also use 
the AEC_DescKeyFixedScale command to set the default Fixed Scale for met-
ric drawings to 0.0254, so that all subsequent description keys created in that 
new description key file (when you are in a Metric drawing) will have the 
Imperial-to-Metric factor included by default.

One additional item to note when creating new description keys is that if you 
have an existing description key selected when you create a new one, the 
new description key will have all the settings of the selected one by default. 
This is another convenient way to create metric description keys with the 
proper default, even if you are not currently in a metric drawing. It should 
also be noted that new symbol blocks that you create for use in metric draw-
ings can be created originally in meters rather than inches. In that case, no 
Fixed Scale is needed, since those blocks will scale correctly without adjust-
ment.

Creating a Description Key File

By default, the description key file for a project is named default.mdb and is 
located in the following folder:
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c:\Land Projects R2\<project name>\cogo\DescKey

You can create a new description key file.

NOTE All description key files for a project must reside in the following folder:

c:\Land Projects R2\<project name>\cogo\DescKey. 
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� Do one of the following to display the Create Description Key File dialog box:

� From the Manager menu in the Description Key Manager dialog box, 
choose Create DescKey File.

� Click .
� In the left pane of the Manager, right-click to display the shortcut menu, 

and then select Create DescKey File.

� In the DescKey File Name box, type the name of the new file.

� Click OK to create the new file and return to the Description Key Manager 
dialog box.

The new file is listed in the left-hand pane of the manager.

Deleting a Description Key

You can remove a description key and its associated information from a 
description key file. 
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� In the right-hand pane of the dialog box, select the description key that you 
want to delete by clicking any box that contains the description key data 
(except for the Code box).
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� Do one of the following:

� Click .
� Right-click and select Delete.
� From the Manager menu, choose Delete.

A message dialog box is displayed, asking you to confirm the deletion.

� Click Yes to delete the description key.

Deleting a Description Key File

A description key file stores description keys. If you no longer need the 
description keys in the file, you can delete it.
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� In the left-hand pane of the manager, select the description key file that you 
want to delete.

� Do one of the following:

� Click .
� Right-click and select Delete.
� From the Manager menu, choose Delete. 

A message dialog box is displayed, asking you to confirm the deletion.

� Click Yes to delete the description key file.
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Changing the Properties of a Description Key

You can edit an existing description key by changing the description key 
properties. 
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� Do one of the following:

� In the right-hand pane of the dialog box, move your cursor so that it is 
over the description key code that you want to edit. The properties icon 

 is displayed. Click to display the Description Key Properties dialog 

box.
� In the right-hand pane of the dialog box, click the line that contains the 

description key anywhere but over the code column, then select Manager 

➤ Properties or click .

For more information about changing the description key properties, see 
“Creating a Description Key File” on page 156.

NOTE If you change the symbol to be used for a description key, and have 
already placed points in the drawing with the description key, then use the 
Modify Drawing command to replace the old symbols with the new symbols. 
For more information, see “Updating the Drawing with Project Point Infor-
mation” on page 195. 

Importing a Previous Version of a Description 
Key File

Using the Import .DSC command, you can import a Softdesk 7.X or 
Softdesk 8.X version of a description key file into a selected AutoCAD Land 
Development Desktop description key file. Previous versions of description 
key files have the extension .dsc.
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� From the left pane of the Description Key Manager, click on the description 
key file that you want to add the description keys to.
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� Do one of the following to display the Select .DSC File to Import dialog box:

� From the Manager menu in the Description Key Manager dialog box, 
select Import .DSC.

� Click 

� Select the .dsc file you want to import and click Open.

The description keys from the .dsc file are added to the selected description 
key file.

Saving a Description Key File to a Prototype

After you set up a description key file, you can save it to a prototype. When 
you save a description key file to a prototype, the next project you create that 
is based on that prototype contains the description key file and the descrip-
tion keys defined in that file. 

When you save a description key file to a prototype, the file is saved to the 
following folder:

c:\Land Desktop R2\data\prototypes\<prototype name>\cogo\DescKey
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� In the right pane of the Description Key Manager, right-click the description 
key file that you want to save to a prototype.

� Select Save File to Prototype from the shortcut menu. The Select Prototype 
dialog box is displayed.

� Select the prototype to which you want to save the description key file.
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� Click OK.

If a description key file with the same name already exists in the prototype, 
a warning dialog box is displayed, asking whether you want to overwrite the 
existing file.

� Click Yes to overwrite the existing file, or click No to cancel.

Loading a Description Key File from a Prototype

To access description keys that you saved to a prototype with the Save File to 
Prototype command, you can use the Load File from Prototype command. 

NOTE The description keys you save to a prototype with the Save File to 
Prototype command are automatically available in a new project if the new 
project is based on that prototype. You only need to load description keys from 
a prototype to access a description key file that you saved to a prototype that is 
different than the prototype that the current project is based on.
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� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

� From the Manager menu, choose Load File from Prototype to display the 
Select Prototype dialog box.

� Select the prototype from which you want to load the description key file.

� Click OK to display the Find DescKey Files dialog box. By default this dialog 
box displays the description key .mdb files that are located in the following 
folder:

c:\Land Desktop R2\data\prototypes\<prototype name>\cogo\DescKey

� Select the description key file that you want to load.

� Click Open to load the description key file into the Description Key Manager.

If a description key file with the same name is already loaded in the 
Description Key Manager dialog box, then a warning dialog box is displayed, 
asking whether you want to overwrite the existing file.

� Click Yes to overwrite the existing file, or click No to cancel.
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Using Description Parameters in Description 
Keys

When surveyors are entering data in the field, they can use description 
parameters. Description parameters are entries, separated by a space, that 
expand the description of a point. For example, TREE OAK 7 is a description 
that has three parameters. 

By formatting a description key to use description parameters, you can use 
one description key that maintains but reorders the point’s description infor-
mation. When you create a point, a description (termed the point’s raw 
description) is saved with the point. When the point is created or inserted, 
and Description Key matching is turned on, this raw description string is 
inspected for a matching description key at the beginning of the string. If one 
is found, then any parameters that follow the description key can be inserted 
as the full description (and they can also be used to scale and rotate the 
description key symbol).

The following dialog box shows an example of how you can use description 
parameters to set up a description key that converts a point description such 
as TREE OAK 7 to 7 inch Oak tree.

� DescKey Code: TREE is used as the description key code because it is at 
the beginning of the description string (for example, TREE OAK 7). The 
description key code must match the first description parameter (TREE, in 
TREE OAK 7) to make the description key parameter substitution work. 

� Description Format: $2 inch $1 Tree is used because in the string TREE 
OAK 7, TREE = the zero character, OAK = the first character, and 7 = the 
second character. You can type any additional text here as well, for exam-



Using Description Parameters in Description Keys | 163

ple, inch and tree. This format produces the final description of 7-inch 
Oak tree.

Using Description Parameters to Scale and 
Rotate Description Keys

You can also use description parameters to scale and rotate description key 
symbols as they are inserted into the drawing. For example, if you create a 
point that represents a 7-inch oak tree, then you can use the 7 (the second 
character that follows the description key in the TREE OAK 7 string) to scale 
the symbol. The following dialog box shows how you can use the description 
parameter to scale the symbol.

� Description Parameter: This value is $2, because in the string TREE OAK 
7, the value 7 corresponds to the second character after the description 
key, TREE.

� Apply Scale To: The scale factor can be applied to both the X-Y dimen-
sions and the Z dimension. If you ever want to explode a symbol, the sym-
bol must be the same size in all dimensions.

Description parameter substitution codes

%�������	���& ��''' (�	����'''

$0 match the description key itself TREE Oak 7 

$1 match the first parameter after the 
description key

TREE Oak 7

$2 match the second parameter after 
the description key

TREE Oak 7
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Dollar Sign, Asterisk ($*) Description Format Substitution 
Code
The $* (dollar sign, asterisk) wildcard can be used in Description Formats.

Using Wildcard Characters in Description 
Keys

You can use wildcard characters to expand the matching capabilities of 
description keys. For example, say you have a point description prefix that 
you use repeatedly to describe benchmarks, such as BM. You may want to cre-

$3 match the third parameter after the 
description key

TREE Oak 7 24

$4 - $9 match the fourth parameter after the 
description key (and so on up until 
$9)

$+ match all the parameters after the 
description key

TREE Oak 7

$* match all the parameters including 
the description key

TREE Oak 7

$$ insert a single $ into the description If you used $$200.00 as part 
of the Description Format for 
a description key, then the 
actual description placed 
with the point would be 
$200.00.

Dollar sign, asterisk ($*) description format substitution code

%����������	
������
����!�
��& ��& (�	����'''

$* use the point’s raw 
description instead of 
substituting a 
description.

If you used the descriptions, UP-1, 
UP-2, and UP-3, and you want to 
maintain these descriptions, then use 
the $* as the Description Key Format. 

Description parameter substitution codes (continued)

%�������	���& ��''' (�	����'''
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ate points with descriptions of BM-1, BM-2, and so on. 

Instead of having to create different description keys for each point, you can 
create a description key that contains an asterisk wildcard (BM*) that searches 
for just the prefix of a point description, BM. That way, the same symbol is 
applied to all points that you create whose descriptions start with BM.

The following dialog box shows how you can set up this description key:

� DescKey Code: The description key code BM* matches point descriptions 
of BM-1, BM-2, BM-A, BM-Oak Tree. This means that if you create a point 
and give it the description of BM-5, this description key is used.

� Description Format: By using the dollar sign, asterisk ($*) description 
format substitution code as the Description Format, the description key 
does not substitute a description for the raw description entered in the 
field. For example, if you create a point and give it the description of 
BM-1, and the $* is used as the description format, then the point still has 
the description of BM-1 even after description key matching has occurred. 
To contrast, if you enter Benchmark in this box, then all the points that 
you create with descriptions that start with BM are changed so that Bench-
mark is their description. You can also use other description parameters in 
the Description Format box.

� Point Layer: Any point inserted with a description that begins with BM 
is placed on the BENCHMARK_POINTS layer. 

� Symbol Block Name: Any point inserted with a description that begins 
with BM uses the symbol block named Benchmark as the point symbol. 
This symbol is placed at the insertion point of the point object.
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� Symbol Layer: The symbol, benchmark, is placed on the layer BENCH-
MARK SYMBOLS.

Description key and point list filter wildcard characters

)��
�	�
 *�!������

# (pound) Matches any single numeric digit

@ (at) Matches any alphabetic character

. (period) Matches any non-alphanumeric character

* (asterisk) Matches any string and can be used anywhere in the search 
string

? (question mark) Matches any single character, for example, ?BC matches ABC, 
3BC, and so on

~ (tilde) Matches anything but the pattern, for example, ~*AB* 
matches all strings that don’t contain AB

[...] Matches any one of the characters enclosed, for example, 
[AB]C matches AC and BC

[~...] Matches any character not enclosed, for example, [~AB]C 
matches XC but not AC

- (hyphen) Inside brackets, specifies a range for a single character, for 
example [A-G]C matches AC, BC, and so on to GC, but 
not HC

′ (reverse quote) Reads the next character literally, for example, ′*AB 
matches *AB

Using the pound (#) character in description keys

*��	
����������	��� +��	���

T# Works for T1, T2...T9. 
For example, if you type T1 as the description for a point, 
then this description key is used.

STA# Works for STA1 or STA2. 
It does NOT work for a point with the description STA, since 
STA is not followed by a number.
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NOTE Unlike previous releases of Softdesk Civil/Survey software, you cannot 
use the asterisk character in the Description Format field. Instead, use the $* 
(dollar sign, asterisk) combination.

Example: Creating a Utility Pole Description Key

The following example describes how you can set up a description key and 
then use it to place a point in the drawing.

The scenario is that you are creating points that represent utility poles. You 
want to use a prefix of UP for all these points, for example, UP5A, UP4B, and 
so on. 

If you create a description key code that translates these descriptions, then 
you can do the following:

� Assign a symbol to the points

Using the at (@) character in description keys

*��	
����������	��� +��	���

1@ Works for 1A, 1B, 1C. 
It does NOT work for a point with the description 1, 
since 1 is not followed by an alphabetic character.
For example, if you type 1A as the description for a 
point, then this description key is used.

Using the period (.) in description keys

*��	
����������	��� +��	���

T. Works for T-, T+ 
For example, if you type T+ as the description for a 
point, then this description key is used.

Using the asterisk (*) in description keys

*��	
����������	��� +��	���

T* Works for T1, TOPO, T-2.
For example, if you type TREE as a description, then 
this description key is used.
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� Place all the points on a layer
� Place all the symbols on a different layer
� Assign a new point description automatically, or maintain the raw 

description you enter initially

By using wildcard characters, you do not need to create a description key for 
each different point description—you can just create a description key that 
references the UP prefix.

���	
�������� ����� �����	
���������

� From the Points menu, choose Point Settings to display the Point Settings 
dialog box. 

� Click the Create tab.

� Verify that the Insert To Drawing As Created check box is selected.

� Verify that under Descriptions, the Manual option is selected.

� Click the Insert tab.

� Verify that the Search Path for Symbol Block drawing files path points to the 
location of the symbols you want to use. In this example, the path must 
point to the following:

c:\Program Files\Land Desktop R2\data\Symbol Manager\cogo

For more information, see “Changing the Point Insertion Settings” on page 
98.

� Verify that the option to use the current label style when inserting points 
option is selected on the Insert tab in the Point Settings dialog box. For more 
information, see “Changing the Point Insertion Settings” on page 98.

� Click the Update tab.

� You can select the Reunite Symbol With Description During Check Points 
check box. By selecting this option, the description key symbol is moved 
back to the point if you move the point and then run the Check 
Points ➤ Modify Drawing command.

�� Click the DescKeys tab. The options on this tab control advanced description 
key matching and searching functions. You do not need to set up any of these 
options for this example. For more information, see “Changing the Descrip-
tion Key Settings” on page 104.

�� Click OK.

�� From the Points menu, choose Point Management ➤ Description Key 
Manager to display the Description Key Manager dialog box.

�� From the left-hand pane of the Description Key Manager, right-click on 
 to display the shortcut menu.
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�� Select Create Description Key to display the Create Description Key dialog 
box. 

�� In the DescKey Code box, type UP*. The asterisk (*) matches any point 
description that starts with UP. For example, UP5A, UP5B.

�� In the Description Format box, type $*. 

The dollar sign asterisk ($*) description format substitution code preserves 
the points’ raw descriptions, such as UP5A and UP4B. However, you can 
assign a new, full description—just remember that this description is used for 
all points that start with UP. 

�� In the Point Layer box, type PTS_UP as the layer. This places the COGO 
points on the PTS_UP layer.

�� From the Symbol Block Name list, select U_POLE.

�� Type SYMBOLS in the Symbol Layer box. This places the U_POLE symbols 
on the SYMBOLS layer.

The dialog box should appear as shown in the following illustration: 

�� Click OK.

�� Close the Description Key Manager dialog box.

�� Format a label style named Desckey to use description keys. For more infor-
mation, see “Example: Formatting a Point Label Style to Use Description Key 
Substitution” on page 170.

�� Choose the Desckey point style as the current point label style. For more 
information, see “Selecting the Current Label Style” on page 529.

�� From the Points menu, choose Create Points ➤ Manual. 

�� Pick the location for a new point.

�� When you are prompted for the description, type UP1A.

The description UP1A and the utility pole symbol are placed with the point.
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Example: Formatting a Point Label Style to Use 
Description Key Substitution

To fully implement description key substitution, you must set up and use a 
point label style that uses description keys.

���!�
���������� �"� ��� ��!�
����	
������������"������

� Complete steps 1–21 in “Example: Creating a Utility Pole Description Key” 
on page 167.

� Click the Point Label Styles tab.

� In the Name box, type Desckey.

� From the Data list, select Point Number and click the Text button.

{Point Number} appears in the Text box.

� In the Text box, place your cursor after {Point Number} and press ENTER.

� Repeat steps 4 and 5 to insert the Description and Elevation data elements 
into the Text box.

� Select the Turn Off Marker Text check box. This option turns off the display 
of point markers when you label the points.

� Under Description Keys, select the DescKey Matching On check box.

� From the DescKey File list, select the description key file in which your 
description keys are stored, for example, Default.

NOTE If you followed the “Example: Creating a Utility Pole Description 
Key,” then select the Default file from this list. 

�� Select the Substitute DescKey Description check box.

�� Select the Insert DescKey Symbol check box. 

�� Click Save to save the label style.

�� Click OK to close the dialog box. 
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9External Data 
References (XDRefs)

You can customize point databases to substitute point 

data and label points with data. The customized point 

databases are linked to AutoCAD Land Development 

Desktop by External Data References, or XDRefs. XDRefs 

allow you to substitute point data in a custom database 

for point data in the project point database. You can use 

XDRefs as point group overrides and you can label 

points with XDRef information.

In this chapter

� Using External Point 
References (XDRefs)

� Creating an External Point 
Database with Microsoft® 
Access

� Creating an External Data 
Reference (XDRef)

� Changing the Properties of an 
External Data Reference 
(XDRef)

� Deleting an External Data 
Reference (XDRef)
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Using External Data References (XDRefs)

AutoCAD Land Development Desktop creates and maintains a point data-
base file that contains all the point information in the project. The COGO 
point database stores point number, name (optional), northing, easting, ele-
vation, and description. 

You can also create your own customized point databases and use them to do 
the following:

� Substitute point data, like elevation or description, when points are 
accessed through a point group

� Label points with data that is substituted from the custom database, or 
label points with data that supplements COGO point database 
information

These custom point databases are linked to AutoCAD Land Development 
Desktop by External Data References (XDRefs). An XDRef is a pointer to an 
entire column of data in a custom Microsoft Access database. All of the data-
base entries must have a point number. Then, when you use an XDRef to get 
a value for a point, the point number is looked up in the custom database, 
and the value from the specified column is used instead of the point’s origi-
nal value that is stored in the COGO database.

NOTE XDRefs do not overwrite or alter the COGO database. 

External Data Reference Requirements

The custom databases that you can use for XDRefs must have the following 
features: 

� They must be Microsoft Access database files.
� There must be a Long Integer field named PNO, which contains the point 

numbers.
� PNO must be an indexed field, and the index must be named PNOIDX.
� Currently, only Integer, Long Integer, Single, Double, and Text type fields 

are supported.
� Any number of Tables can be defined in this database, but any that are ref-

erenced by XDRefs must have the PNOIDX index and the PNO column 
defined.
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� Any number of additional Text or Number columns may also be defined 
in this database table. There are no restrictions on the names and order of 
the columns after PNO.

� XDRefs can be placed anywhere on your system; they do not need to exist 
in a specific location in order for AutoCAD Land Development Desktop to 
read them. 

For more information about setting up a Microsoft Access database, see “Cre-
ating an External Point Database with Microsoft Access” on page 173.

New Features in the XDRef Manager for 
Release 2 of AutoCAD Land Development 
Desktop 

The XDRef Manager has the following new features for Release 2 of AutoCAD 
Land Development Desktop: 

� Printing commands available through shortcut menu and Manager menu
� Drag-and-drop column ordering
� Columns retain widths after sizing

In addition, you can right-click on a column heading to hide and restore col-
umn visibility.

Creating an External Point Database with 
Microsoft Access

You can use Microsoft Access to create custom point databases, and you can 
link these databases to AutoCAD Land Development Desktop by using exter-
nal data references (XDRefs).

TIP If you do not want to set up a database from scratch, you can copy the 
following sample user database file:

c:\Land Projects R2\<project name>\cogo\UserDB\SampleUserDb.mdb
Then edit that file. By default this sample is created in the following directory 
when a new project is created:

c:\Land Projects R2\<project name>\Cogo\UserDB
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� Start Microsoft Access.

The startup dialog box is displayed. 

� Select Blank Database and click OK to display the File New Database dialog 
box.

� Use the Save In list to locate the following directory:

c:\Land Projects R2\<project name>\cogo\UserDb 

� In the File Name box, type a name for the database.

� Click Create to display the Database dialog box.

� On the Table tab, click New to display the New Table dialog box.

� Select Design View.

� Click OK to display the design view of the table.

� In the first table cell in the Field Name column, type PNO.

NOTE The PNO field is required; you must name this field PNO. 

�� In the first table cell in the Data Type column, select Number.

�� In the lower part of the dialog box, verify the following information:

� Long Integer is the Field Size
� Auto is the Decimal Places

�� In the Required field, select Yes.

�� In the Indexed field, select Yes (No Duplicates).

�� Add any additional field names below PNO as needed for your point infor-
mation, such as DESC 1, DESC 2, ELEV 1, ELEV 2. There are no restrictions 
on the names and order of the columns after PNO. 

�� From the View menu, choose Indexes to display the Indexes dialog box.

�� In the first table cell in the Index Name column, type PNOIDX.

NOTE The PNOIDX is required. You must name this index PNOIDX. 

�� In the first table cell in the Field Name column, type PNO.

�� In the first table cell in the Sort Order column, select either Ascending or 
Descending.

�� In the lower part of the dialog box, change the following settings:

� The Primary field must be Yes.
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� The Unique field must be Yes.
� The Ignore Nulls field must be No.

�� From the View menu, choose Datasheet.

You are prompted to save the table.

�� Click Yes to display the Save As dialog box.

�� Type a name for the table and click OK.

The Table dialog box is displayed.

�� Type the point information, such as point numbers, elevations, and descrip-
tions, into the table.

�� From the File menu, choose Save to save the table.

�� Close Microsoft Access.

Now you can create XDRefs to the table columns.

You can use either the Map ➤ Database commands or Microsoft Access to 
manually edit the data in the database. You can also change the layout of a 
database at any time—as long as the referenced column is still in the data-
base, the XDRef finds the data.

Creating an External Data Reference 
(XDRef)

To substitute or supplement data in a Microsoft Access database file for 
COGO point information, you must create an external data reference 
(XDRef) to the column of data in the Microsoft Access table.

������	���	
������
	��	�	�������
��

� From the Points menu, choose Point Management ➤ XDRef Manager to 
display the XDRef Manager dialog box.
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� Do one of the following to display the Create External Data Reference 
dialog box:

� Click .
� Right-click on one of the external data references and then select Create 

XDRef.
� From the Manager menu, choose Create XDRef.

� In the Name box, type a name for the XDRef. 

XDRef names are limited to the following characters: alphanumeric 
(A–Z, a–z, 0–9), dash (-), underscore (_), and space ( ). There is no restriction 
on the first character, so XDRef names can begin with any of these characters. 
The total length of an XDRef name must not exceed 32 characters.
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� Click  to locate the database file. By default, a sample database file is cop-
ied to the project directory of each project you create. This file is named 
SampleUserDB.mdb, and is located in the following:

c:\Land Projects R2\<project name>\cogo\UserDb

� Click Open to return to the Create External Data Reference dialog box.

� From the Table Name list, select the table name that you want to use. These 
are the available tables that exist in the database file.

� From the Column Name list, select the column name that you want to use. 
These are the names of the columns that exist in the table. For example, you 
can choose Elevation if the table has a column named Elevation.

� Click OK to create the XDRef and to return to the XDRef Manager dialog box.

Example: Creating a Point Label Style that Labels 
Points with XDRef Information

You can use external data references (XDRefs) to label points with point data 
that is not in the COGO point database. This data may be a substitute for 
point values that are already in the COGO point database, such as point ele-
vation, or it may be new data, such as multiple elevations.

������	���	����
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� Start a new drawing in a new project.

� Create an XDRef for each value you want to use in the point labels. For exam-
ple, say you have a Microsoft Access database called SURFACE.MDB that con-
tains the following information:

XDRef information

!"# $%&'()*)+ $%&'(,)$-

1 125.3 EG

2 126.5 EG

3 127.5 EP

4 125.2 EP
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To create a point label style that labels points with the elevation and descrip-
tion data of the surface points, you must set up two XDRefs. One XDRef must 
point to the SURF_ELEV column in the database, and the other must point 
to the SURF_DESC column in the database. For this example, assume that the 
XDRef for the SURF_ELEV column is named Surface Elevation and the XDRef 
for the SURF_DESC column is called Surface Description. For more informa-
tion, see “Creating an External Data Reference (XDRef)” on page 175 and 
“Creating an External Point Database with Microsoft Access” on page 173.

� From the Labels menu, choose Edit Label Styles to display the Edit Label 
Styles dialog box.

� Click the Point Label Styles tab.

� Type XDRef Style in the Name box.

� From the Data list, select Point Number and then click the Text button. 

{Point Number} appears in the Text box.

� In the Text box, place your cursor after {Point Number} and press ENTER.

� From the XDRef list, select Surface Elevation (one of the two XDRefs that are 
defined) and click the Text button.

{XDRef=Surface Elevation} appears in the Text box.

� In the Text box, place your cursor after {XDRef=Surface Elevation} and press 
ENTER.

�� From the XDRef list, select Surface Description and click the Text button.

The text box should appear as shown in the following illustration:

�� Click Save to save the XDRef Style.

�� Set the XDRef Style as the current point label style and turn on the option to 
use the current point label style on the Insert tab of the Point Settings dialog 
box. For more information, see “Selecting the Current Label Style” on page 
529 and “Changing the Point Insertion Settings” on page 98.

�� On the Create tab of the Point Settings dialog box, select Insert To Drawing 
As Created, Sequential Numbering, and None for both Elevations and 
Descriptions. For more information, see “Changing the Point Creation Set-
tings” on page 93.

�� Use the Manual command to create four points. For more information, see 
“Creating Points at Selected Coordinates” on page 204.

The points are labeled with the data from the Microsoft Access database.
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Example: Using an External Database File and 
Point Groups to Substitute Point Information

The following example describes how you can substitute point information 
from an external database file for point information in the point database. In 
this case, borehole information (elevation and description) is substituted for 
the points’ original elevations and descriptions by creating XDRefs to an 
external database.

Suppose the point database has these points in it:

And suppose there is an external database called TBORING.MDB that con-
tains the following information:

To substitute the elevation and description information in the 
TBORING.mdb file for the information in the point database, you must 
define the following two XDRefs: 

!"# "#&�./"0 )1$�/"0 )*)+1�/#" ,)$-&/!�/#"

1 1254125.3 142543.5 130.2 PAD

2 1254126.5 142551.4 130.3 PAD

3 1255127.5 142520.8 130.1 PAD

4 1255125.2 142520.9 130.5 PAD

!"# $%&'()*)+ $%&'(,)$- $%2�()*)+ $%2�(,)$-

1 125.3 EG 120.5 SG

2 126.5 EG 121.0 SG

3 127.5 EP 119.8 LG

4 125.2 EP 119.1 SG

3,&�� ,1�121$) -#*%4"

EL1 TBORING.MDB SURF_ELEV

DS1 TBORING.MDB SURF_DESC
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These XDRefs point to the SURF_ELEV and SURF_DESC columns in the 
TBORING external database.

To access this new information, you must create a point group with over-
rides. For example, you use the EL1 external reference to access the point’s 
elevation, and the DS1 external reference to access the point’s description. 

Instead of getting the original elevation and description stored in the point 
database, the XDRefs now point to the TBORING.MDB database. This is 
where the elevation stored under column SURF_ELEV is retrieved, and the 
description stored under column SURF_DESC is retrieved. So the points, 
when accessed through this group, appear like the following:

To use these points, you must set up a point group with XDRef overrides and 
then access the points through a group as a group. For more information, see 
“. Using Existing Overrides for Points in a Point Group When Selecting the 
Group” on page 135.

NOTE When these points are inserted with overrides applied, you do not need 
to set up point label styles to view the elevation and description obtained by the 
XDRef. The descriptions and elevations that are inserted from the XDRef are con-
sidered the points’ elevations and descriptions. However, to add a new category 
for points, such as a second elevation, a point label is necessary to display this 
information in the drawing. 

Changing the Properties of an External Data 
Reference (XDRef)

You can edit an existing XDRef by changing its properties, such as which 
table and column in the Microsoft Access database the XDRef points to.

!"# "#&�./"0 )1$�/"0 )*)+1�/#" ,)$-&/!�/#"

1 1254125.3 142543.5 125.3 EG

2 1254126.5 142551.4 126.5 EG

3 1255127.5 142520.8 127.5 EP

4 1255125.2 142520.9 125.2 EP
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� From the Points menu, choose Point Management ➤ XDRef Manager to dis-
play the XDRef Manager dialog box.

� Do one of the following to display the External Data Reference Properties 
dialog box:

� Click the XDRef that you want to edit (anywhere but the Name column) 
and click your pointing device. 

� In the Name column of the XDRef Manager, move your cursor so that it 

is over the XDRef that you want to edit. The properties icon  is dis-
played. Click your pointing device.

� Right-click the XDRef that you want to edit, and then select Properties.

The Name box displays the name of the XDRef (this box cannot be edited).

� To change the properties of the XDRef, you can use any of the following 
options:

� Click  to locate a different database file. 
� From the Table Name list select a different table name. These are the avail-

able tables that exist in the database file.
� From the Column Name list select a different column name. These are the 

names of the columns that exist in the table. 

� Click OK to return to the XDRef Manager dialog box.

Deleting an External Data Reference (XDRef)

You can delete an XDRef that you no longer require.
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� From the Points menu, choose Point Management ➤ XDRef Manager to dis-
play the XDRef Manager dialog box.

� Do one of the following:
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� Select the XDRef that you want to delete by clicking on any cell except the 

Name cell, and click .
� Click the XDRef that you want to delete and then select 

Manager ➤ Delete.
� Right-click on the XDRef that you want to remove, and select Delete.

A message dialog box is displayed, asking you to confirm the deletion.

� Click Yes to delete the XDRef.
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10Managing Points

When working with points you have the option to limit 

write access to the project point database to yourself, or 

you can open it so everyone working on the project has 

read-write access. If you are concerned about points get-

ting inadvertently changed or deleted, then you can 

lock the points.

If multiple people are working on a project over a net-

work, then you may need to use the Check Points com-

mands, which reconcile the differences between points 

in the project point database and the points in the 

drawing.

In this chapter

� Selecting Points to Edit

� Changing the Point Database 
Setup Settings

� Displaying Information About 
Points in the Project

� Printing Point Lists

� Locking and Unlocking Points

� Checking for Points in Projects 
and Drawings

� Inserting Points into a Drawing

� Removing Points from the 
Drawing
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Managing Points

When you are working with multiple people over a network, you can use the 
following commands to manage the point database.

Selecting Points to Edit

Several topics in this manual contain a reference to the following prompt, 
and the options in this prompt. This prompt is displayed whenever you 
select a command that requires a selection set of points:
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The following are descriptions of the options:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.

Specifying Point Numbers
When you type Numbers, you can type point numbers individually, separate 
each number with a comma (,), or type them in a range by using a hyphen 
(for example, type 1–5).

If point names are enabled for the project, then the following prompt is 
displayed:
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Type the point name you want to select, or type point numbers.

Specifying a Point Group
When you type Group, the following prompt is displayed:
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Type one of the following options:

� Type Name and then type the name of the group.
� Type Dialog to display the Select a Point Group dialog box. Select the 

group and then click OK.
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NOTE You can click the Manage button to access the Point Group Manager 
dialog box to create a point group. 

Using Filtering and Advanced Selection Methods
When you type Dialog, a dialog box is displayed. You can use this dialog box 
to create a list of points. For more information, see “Creating Point Lists” on 
page 138.

Changing the Point Database Setup Settings

By changing the point database setup settings, you can control whether the 
point database file is accessible by a single user or multiple users. You can also 
close the point database to give another person access to it.

If the Open Mode is set to multiple users and more than one person has the 
point database open, then you cannot switch the Open Mode from multi-
user mode to single-user mode. If the database is open in single-user mode 
and another person tries to access the project, he or she can only open the 
project with the point database closed. 

NOTE When you set the Open Mode to Single-User, the setting is maintained 
for the current drawing session only. The next time you open the drawing, the 
Open Mode returns to Multi-User.
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� From the Points menu, choose Point Management ➤ Point Database Setup 
to display the Point Database Setup dialog box. 
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The current project name, point file, and the character limits that were estab-
lished for descriptions and point names are displayed.

NOTE If point names are not enabled for the project, then Not Used is dis-
played next to Point Names. 

� Under Open Mode, select one of the following options:

� Close: Select Close to close the point data file and disable all commands 
that require the point database. You can select Close if:
� The database is set to Open As Single-User and you want to give some-

one else access to the file.
� You are working on a project with a very large point database and you 

don’t need to use the point information. Closing the point database in 
this situation can speed up performance.

� You are working in a multi-user environment and need to run one of 
the commands that require the point database to be open in Single-
User mode (Translate Points or Rotate Points). In this case, each person 
must close the point database so that one person can set it to Single-
User mode and run the command.

� Open as Single-User: Select Open as Single-User to prevent other people 
from accessing the point database while you are working on it. If you are 
the first person to open the point database and single-user is selected as 
the Open Mode, then no one else has read/write access to the point data-
base until you close the point database file.

If another person has the point database open, then you cannot switch to 
the single-user setting until the other person closes the point database.

� Open as Multi-User: Select Open as Multi-User to give multiple people 
access to the point database while you are working on it. Use this option 
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if you work on a network and want several people to have read/write 
access to the data simultaneously.

� To see which people currently have the point database open, click the Other 
Users button to display the Other Users dialog box.

Under Other Logins Using Point Database, the AutoCAD login names of each 
person who has the point database open are listed. 

Unless points are locked, all users have read-write access to the point data-
base. To restrict the point database to a single user, each person listed in the 
Other Users dialog box must close the point database.

NOTE The Other Users button is unavailable when no other users have the 
current point database open or when Open as Single-User is selected. 

� Click OK.

NOTE You cannot use the Translate Points or Rotate Points command when 
the point database is set to Multi-User mode. These commands impact the point 
database and can be used only when the point database is open in Single-User 
mode. 

Displaying Information About Points in the 
Project

You can display and print information about the points in the project. The 
information that is displayed includes point number, northing, easting, ele-



188 | Chapter 10 Managing Points

vation, point name, raw description, and full description. An L next to a 
point number indicates that the point is locked. 
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� From the Points menu, choose List Points to display the List Points dialog 
box.

� Create a selection set of the points about which you want to display informa-
tion. For more information, see “Creating Point Lists” on page 138.

NOTE When you create a selection set, point information for each point you 
selected is displayed in the List Points dialog box. If you click the Advanced but-
ton in the Point List dialog box to use advanced point selection methods, then 
you can also view the points on the List tab, or you can click the Simple button 
and view the points in the list. 

The dialog box shows each point’s name, elevation, description, coordinates, 
latitude, and longitude. You can drag and drop column headings to change 
the display of data in the dialog box.

NOTE How the point coordinates are displayed is based on the Point 
Coordinate Display settings. In the Point Coordinate Display settings, you can 
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specify whether to display the points in Northing-Easting, Easting-Northing, X-
Y, or Y-X. format. The coordinates that are shown are the points' northing and 
easting coordinates, regardless of whether the columns are set to Northing and 
Easting or X and Y. For more information, see “Changing the Coordinate Dis-
play Settings” on page 102.

Printing Point Lists

From the Point List dialog box, you can print point information by using the 
options in the Printing menu. You can send the point list to a printer, or you 
can print the list to an ASCII text file.

Printing a Point List

You can print a point list from the Point List dialog box. You use this dialog 
box when you create a point list for the purpose of listing point information, 
or for creating or editing a point group. 
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� Display the Point List dialog box by using one of the following methods:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Build List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

� From the Printing menu, choose Print to display the Print dialog box.

� From the Name list, select the printer you want to use.

� Under Copies, specify how many copies of the point list you want to print.

� Click OK to print the point list.

Printing a Point List to a File

You can print a point list to an ASCII text file from the Point List dialog box. 
You use this dialog box when you create a point list for the purpose of listing 
point information, or for creating or editing a point group. 
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� Display the Point List dialog box by using one of the following methods:
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� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Build List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

� From the Printing menu, choose Print to File to display the Select Output file 
dialog box.

� Specify the folder and file name for the point file.

� Click Save to create the file. The file is saved with a .txt file extension in the 
folder you specified.

Setting Up the Printer for Printing a Point List
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� Display the Point List dialog box by using one of the following methods:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Build List button.

� From the Points menu, choose List Points.
� From the Points menu, choose Edit Points ➤ Edit Points.

� From the Printing menu, choose Printer Setup to display the Print Setup 
dialog box.

� From the Name list, select the default printer you want to use when printing 
point lists. You can click Properties to view and change printer properties. 

� Under Paper, select the paper size and source.

� Under Orientation, select whether you want to orient the page in Portrait or 
Landscape layout mode.

� Click OK to save the print setup changes.

Previewing a Point List Before Printing
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� Display the Point List dialog box by using one of the following methods:

� From the Points menu, choose Point Management ➤ Point Group 
Manager. From the Manager menu, choose Create Point Group to display 
the Create Point Group dialog box. Click the Build List button.

� From the Points menu, choose List Points.
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� From the Points menu, choose Edit Points ➤ Edit Points.

� From the Printing menu, choose Print Preview to display a preview of how 
the point list will print.

� Click Print to print the point list, or click Close to return to the Point List 
dialog box.

Locking and Unlocking Points

When you work with a team on the same project over a network, you may 
want to lock some points to prevent them from being edited. By default, each 
person who accesses the project files has read/write access to the point data-
base. To prevent unwanted changes from occurring, you can lock the points 
in a project so that people have read access to the points, but they cannot 
edit them.

Locking points does not prevent you from inserting them into a drawing, 
from creating point groups from them, or exporting them to an external file. 

Displaying the Locked Point Numbers in a 
Project
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� From the Points menu, choose Lock/Unlock Points ➤ Locked #’s.

The locked point numbers in the project are displayed. If the drawing has no 
locked points, a message is displayed stating there are no locked points.

Locking Points in a Project

You can lock points in a project so that they cannot be edited. 
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� From the Points menu, choose Lock/Unlock Points ➤ Lock Points.

The following prompt is displayed:

������������	
���������������������	������������������

� Do one of the following to select the points to lock:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
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� Type Selection and then select the points from the drawing. This option 
only selects points that are visible in the drawing.

� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

Unlocking Points in a Project
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� From the Points menu, choose Lock/Unlock Points ➤ Unlock Points.

The following prompt is displayed:
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� Do one of the following to select the points to unlock:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

Checking for Points in Projects and Drawings

There are several situations where the project points may not match the 
drawing points. For example, the project database won’t match the drawing 
points if you:

� Use commands such as ERASE or COPY to modify the points.
� Edit points in the drawing and database, and then quit the drawing with-

out saving it.
� Restore an old version of a drawing.
� Edit points in one drawing and then open another drawing that contains 

the same points.

Whenever you want to change the drawing so that it matches the project 
point database, or change project points to match the drawing, you can use 
the Check Points commands. 
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Updating the Project Point Database with 
Drawing Point Information

You can check the project point database against the drawing points, and 
update the project point database to match the drawing point information. 
You can change, add, or delete points in the project file based on the points 
in the drawing. Adding points to the project file is useful if you create a new 
project from an existing drawing that already has points in it. You can also 
search for Softdesk point blocks and replace them with COGO point objects.
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� From the Points menu, choose Check Points ➤ Modify Project to display the 
Modify Project Database Points from Drawing dialog box.

NOTE If any points in your drawing are locked, a warning dialog box is dis-
played, alerting you that you cannot alter any locked points. Click OK to 
continue. 

� Under Scan Drawing for, select one of the following options:

� Select COGO Point Objects to search for point objects that are in the draw-
ing and update the point database.

� Select Softdesk Point Blocks to search for point blocks that were created in 
Softdesk Civil/Survey programs. This option searches for blocks named 
POINT and replaces the blocks with point objects. 

� Under Modify Project Database, select one or more of the following options: 
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� Change Points in Project Database: This option changes the northing/
easting, elevation, or description of any point in the project point data-
base that does not match the drawing points. 

This option affects only points that are in both the drawing and the 
project point database. If any of the point information differs, then the 
project point database is updated to reflect the points within the drawing. 
If a duplicate point number is found, then you are prompted to select the 
correct point number.

� Add Unregistered Points to Project Database: This option adds point 
information to the point database from the drawing. If any of the points 
in the current drawing are not present in the point database, then the 
information is added, creating new point information.

NOTE If you create a new project from an existing drawing with points 
already placed in it, use the Add unregistered points to project database 
option to create the new point database information. 

� Select one of the Delete Points From Project Database options. 

� Off: Points are not deleted from the project point database or the 
drawing.

� Points Erased by AutoCAD ERASE Command: Points that you erased 
from the drawing with the AutoCAD ERASE command during the current 
session are removed from the project.

� All Points Not in the Current Drawing: Points not in the current draw-
ing are removed from the project. Because all drawings in the project are 
linked to the same point database, and not all points have to be in a draw-
ing, the command prompts you for confirmation.

� Select the Echo status to screen check box to echo the status of the point 
database modification to the screen.

� Click OK to exit the dialog box and update the database.

The command then searches the drawing and updates the database accord-
ing to the options you selected. 

Duplicate point numbers may be found. For more information, see “Dupli-
cate Point Numbers” on page 194.

Duplicate Point Numbers

If a duplicate point number is found in the project when you use the Check 
Points commands, then the command displays prompts similar to the ones 
shown in the following example:
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� Type the correct number.

The following prompt is displayed: 
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� Type Delete or Renumber:

� Type Delete to delete the duplicate.
� Type Renumber to renumber the duplicate with the next available point 

number.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to automatically repeat the process for all other duplicates that 
are found.

� Type No to be prompted each time a duplicate point is found. 

Updating the Drawing with Project Point 
Information

You can check the drawing points against the project point database and 
change points in the drawing to match the database information.
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� From the Points menu, choose Check Points ➤ Modify Drawing to display 
the Modify Drawing Points from Project Database dialog box.
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� Under Modify Drawing Points, select one or more of the following check 
boxes. These options can update the existing points in the drawing, but do 
not add new points or delete existing points. 

� Change Points in Drawing: This option changes points in the current 
drawing so that they match the point database information. This option 
changes the northing/easting, elevation, or description of the points. 
Only points that exist both in the project and in the drawing are checked.

� Change Description Key Symbols: This option verifies that symbols 
associated with the points through description keys are correct. If you 
have changed the description key file, then this option updates any sym-
bols as required.

� Reunite Key Symbol with Point: This option returns the description key 
symbol exactly to the insertion point of the point, if it is not already there. 
If this box is cleared and the point is moved when you update the drawing 
with the Modify Drawing command, then the symbol moves with the 
point, but maintains its relative location to the point. 

NOTE The Change description key symbols and Reunite key symbol with 
point options affect both common symbol blocks and description key 
symbols. For more information about setting up point labels to use common 
symbol blocks, see “Editing Point Label Styles” on page 552.

� Under Add/Remove Points, select one or both of the following options:

� Select the Add All Points To Drawing check box to add to the drawing the 
points in the project point database that are not present in the current 
drawing. 

� Select the Remove Points From Drawing check box to remove any points 
in the current drawing that are not in the project point database. A warn-
ing dialog box is displayed when you select this option, prompting you to 
confirm the remove option.
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� Select the Echo Status To Screen check box to display the status of the point 
update at the command line.

� Click OK.

Duplicate point numbers may be found. For more information, see “Dupli-
cate Point Numbers” on page 194.

Inserting Points into a Drawing

You can insert points into a drawing from the project database, based on sev-
eral different selection methods. You can insert all points in the project, or 
you can insert them by group, range, window, description, or elevation, or 
by creating a selection set from the Point List dialog box.
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� From the Points menu, choose Insert Points to Drawing.

The following prompt is displayed:
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� To select the points, type one of the following options:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Window and then draw a selection window around the area of the 

drawing where you want to insert the project points. This selection 
method selects points in the point database and inserts them into the 
drawing.

� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

If you select points that are already in the drawing, then the Point In Draw-
ing dialog box is displayed.

� Click one of the following options:
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� Click Skip to leave the existing point in the drawing.
� Click Replace to replace the existing point in the drawing with the 

selected point in the point database.
� Click Skip All to leave all existing points in the drawing.
� Click Replace All to replace the existing points in the drawing with the 

selected points in the point database.
� Click Cancel to cancel the command.

NOTE If you use the UNDO command after using the point insertion 
command and then reinsert the points, duplicate points will be created in the 
drawing, and you will not be prompted to skip or replace the points. A 
solution to this is to run the UNDO command twice, first to eliminate the 
duplicate point objects, then again to remove the first points (the points that 
the previous UNDO restored). This will remove the points from the drawing 
so you can reinsert them without creating duplicates.

Removing Points from the Drawing

You can remove points from the drawing without deleting the point database 
information.
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� From the Points menu, choose Remove from Drawing.

The following prompt is displayed: 
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� Type Yes or No:

� Type No to keep the description key symbols in the drawing.
� Type Yes to remove the description key symbols from the drawing. If you 

do not remove symbols when you remove points, then the symbols 
become detached from the point. Subsequent changes to the location of 
the point do not affect the symbol.

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
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� Type Selection and then select the points from the drawing. This option 
only selects points that are visible in the drawing. 

� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.
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11Creating Points

AutoCAD Land Development Desktop has several 

commands you can use to create COGO points in your 

project. You can create points at intersections, in rela-

tion to an alignment, and in relation to a surface. All 

point data that you create is stored in the project data-

base which can be set up so that multiple people work-

ing over a network can create points simultaneously.

In this chapter

� Creating Points

� Creating Points at Intersections

� Creating Points at Alignment 
Intersections

� Creating Points Based on 
Horizontal Alignments

� Creating Points Based on a 
Surface

� Creating Points Based on 
Slopes

� Interpolating Points
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Creating Points

You can use many different methods to create points in a drawing. You can 
create points based on: 

� Station and offset, turned angles, objects, northing/easting, and AutoCAD 
objects

� Intersections of directions and distances, as well as at the intersections of 
alignments

� Horizontal alignment geometry and station offsets
� Surface elevations and grid points
� Slopes
� Interpolations

The sequence of point creation prompts depends on how you establish the 
point creation settings. For example, to enter an elevation for each point that 
you create, you must select the Manual option in the point creation settings. 
For more information, see “Changing the Point Creation Settings” on page 
93 and “The Effect of Point Settings on Point Prompts” on page 202.

To use description key substitution for points that you create and import, you 
must modify the point creation settings and set up description keys. For 
more information, see “Description Keys” on page 143.

The Effect of Point Settings on Point Prompts

Depending on how you change the point creation settings, the command 
sequence of the Points commands differ. For example:

� If you choose Sequential numbering, then the points are numbered using 
the next available point number. However, if you clear the Sequential 
numbering check box, then you are prompted to enter a point number 
each time that you create a point. In addition, if point names are enabled 
for the project, you can enter point names at this prompt. For more infor-
mation, see “Changing the Numbering Convention for Points” on page 
94.

� If you select the Manual options under the Elevations and Descriptions 
sections of the Create tab in the Point Settings dialog box, then you are 
prompted to enter descriptions and elevations for the points that you 
create. 

� If you select the Automatic options under the Elevations and Descriptions 
sections of the Create tab in the Point Settings dialog box, then you are 
not prompted to enter descriptions or elevations. They are automatically 
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created using the defaults you specify in the Default Description and 
Default Elevation boxes.

In the documentation, the descriptions of the Points commands assume that 
the Sequential Numbering check box is selected, and the Manual options are 
selected. For more information, see “Changing the Point Creation Settings” 
on page 93.

Selecting Points and Locations

You can select points using several different methods. Some commands do 
not require you to select COGO points that are in the drawing. You can just 
use your pointer to select locations in the drawing, or type X,Y coordinates.
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� Type X,Y coordinates at the command line, separated by a comma.
� Click a location in your drawing with your pointing device. You can use 

AutoCAD Object Snaps to select a point accurately.
� Use point filters to select COGO points by number, graphically, or by spec-

ifying northing/easting coordinates. 

You can use the following point filters to select points at most Select Points 
prompt:

� Type .P to select a point by point number. The point does not have to be 
in the drawing to select a point with this filter (however, it must be in the 
point database). 

� Type .N to select a point by northing/easting coordinates. 
� Type .G to select points. Using this filter, you can select any part of the 

point object. The point must be in the drawing to select a point with this 
filter.

To turn off a point filter, type .P, .N., or .G at the command line again. For 
example, if you use the .P option to type point numbers, type .P again to exit 
the point number mode. Each time you activate one of the point selection 
filters, it remains in effect until you turn it off. 

Selecting Lines, Curves, and Spirals by Selecting 
Points

Some commands prompt you to select the objects to work with. When you 
select one of these commands, a prompt, similar to the following example, 
is displayed:
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At this prompt, you can select the object with your pointing device. How-
ever, you can also select the object by selecting points.
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� Type PO. 

� Select the start point of the object. 

The following prompt is displayed:
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� Select the remainder of the points using one of the following methods:

� If the object is a line: Select the endpoint of the line and press ENTER. 
You can use the AutoCAD ENDpoint Object Snap to make it easier to select 
the endpoint of the line.

� If the object is a spiral: Select the spiral point of intersection (spi), and 
the endpoint.

� If the object is an arc: Select the center point of the arc, and then select 
the endpoint of the arc. 

When you select the center point, the command determines the arc’s radius 
point. Because you can draw two different arcs from the same start point, 
endpoint, and radius point, the following prompt may be displayed: 
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Your response determines which of the two possible arcs you want to select. 
If the arc you want to select has an included angle of less than 180 degrees, 
then press ENTER. Type No if the angle of the arc is greater than 180 degrees. 

You may also be prompted for the arc’s direction:
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This is the direction of the arc from the start point to the endpoint. Type C 
if the direction is clockwise, or CC if the direction is counterclockwise.

Creating Points at Selected Coordinates
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Manual.

� Select a location at which to place the point.
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� Type the description for the point, or type a period to skip the description.

� Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� Select another location at which to place a point, or press ENTER to end the 
command.

Creating Points at Northing/Easting Coordinates

You can create points by specifying northing and easting coordinates. The 
base point and north rotation settings determine the actual location where 
the point is created in the drawing. For more information, see “Changing the 
Base Point for a Drawing” on page 58 and “Changing the North Rotation for 
a Drawing” on page 61.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Northing/Easting.

� Type the northing.

� Type the easting.

� Type the description for the point, or type a period to skip the description.

� Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� Type additional northing and easting coordinates to set another point, or 
press ENTER to end the command. 

Creating Points by Specifying Directions

You can create a point by specifying a direction, or by selecting two points 
and then entering a distance. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Direction.

� Select the starting point.

The following prompt is displayed:
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� Do one of the following to define the direction:

� Type Azimuth, and then type the azimuth of the direction line in 
DD.MMSS format.

� Type B, and then type a quadrant number and a bearing in DD.MMSS 
format.
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� Type PO, and select two points to define the direction. The direction is cal-
culated from the first point that you select to the second point that you 
select.

� Type .P to activate the point number filter, and then type the point num-
bers you want to use for defining the direction. 
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� Type the distance at which to place the point. This is the distance from the 
point you selected at step 3.

� Type the description for the point, or type a period to skip the description.

� Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� Do one of the following:

� Specify another direction to set another point using the same starting 
point.

� Press ENTER and select a new starting point.
� Press ENTER twice to end the command.

Creating Points by Turned or Deflection Angle

You create points by specifying a turned angle or a deflection angle and 
distance. 

���������	�
����������������������
��������

� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Turned Angle. 

The following prompt is displayed:
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� Do one of the following to select the reference line from which the angle is 
turned or deflected:

� Select the reference line near the end you want to draw the new line from. 
This end point acts as the reference point for the new point.

� Type PO and then select the starting and ending points of the reference 
line. The starting point acts as the reference point for the new point.

� Specify the type of angle measurement to use, Deflection or Turned. 

� Type the angle in DD.MMSS format. 

If you specify a positive value at the Angle prompt, then the command places 
the point clockwise from the reference line. A negative angle value places the 
point counterclockwise from the reference line.

� Define the distance between the point that is drawn and the reference point.

� Type the description for the point, or type a period to skip the description.

� Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

 Do one of the following:

� Type another angle to set another point. This angle is based on the 
original reference line you selected. 

� Press ENTER and select a new reference line.
� Press ENTER twice to end the command.

The following illustration shows points created by deflected or turned angle:
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Creating Points by Azimuths and Geodesic 
Distances
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� Set the current zone. For more information, see “Changing the Current Zone 
for a Drawing” on page 57.

� Set the Transformation Settings. For more information, see “Changing the 
Geodetic Zone Transformation Settings” on page 81.

� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Geodetic Direction.

� Select the start point, which is the point the angle measurement starts from. 

The northing, easting, latitude, and longitude of the point are displayed at 
the command line.

� Type the geodetic azimuth, which is the geodetic azimuth from the existing 
point to the new point.

� Type the geodesic distance, which is the distance as measured on the coordi-
nate zone grid from the existing point to the new point.

� Do one of the following:

� Press ENTER to end the command.
� Select a new starting point.

Creating Points by Resection

You can create a point at a position that is calculated from the measured 
angles between three known points. You can do this when you need to set 
up an instrument at an unreferenced point.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Resection.

The following prompt is displayed:
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� Select the first point, which is assumed to be the backsight or reference point.
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� Select the second point. The second and third points are the points that are 
sighted on.

� Select the third point.

� Type the angle between the first point to the second point.

� Type the angle between the first and third point.

These two angles are used to calculate the location of the point to be placed.
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� Type the description for the point, or type a period to skip the description.

 Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as 
created option is selected in the Point Settings. The point is placed on the 
current layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

Creating Points by Station and Offset from an Object

You can create a point at a specified station and offset distance from an arc, 
line, or spiral. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Station/Offset Object. 

� Select the object.

� Type the starting station.

The ending station is automatically calculated.

� Type the station at which you want to place the point.
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� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

 Do one of the following:

� Type another offset to place another point at a different offset from the 
same station. 

� Press ENTER and specify a new station.
� Press ENTER twice to end the command.

The following illustration shows a point created that is offset from a station:
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Creating Points at Object Vertices

You can automatically create points at the end points of lines, at the end 
points and center point of arcs, and at the end points and spiral points of 
intersection. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Automatic.

� Select the objects you want to place points on.
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� Press ENTER to complete the selection set.

The command inserts the points in the drawing if the Insert to drawing as 
created option is selected in the Point Settings. The points are placed on the 
current layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The Automatic command does not create points where lines cross each other 
unless one of these points is an end point. To create a point where lines cross 
each other, use the Manual command. For more information, see “Creating 
Points at Selected Coordinates” on page 204.

Creating Points Along a Line, Curve, or Spiral

You can create points along a selected line, curve, or spiral, at a given distance 
from the nearest end point. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Along Line/Curve/Spiral.

� Select the line, curve, or spiral.

The end point nearest to the point you selected is marked with an X.

� Do one of the following:

� Type the distance from the end point that you want to set the point. If you 
type a positive distance, then the point is placed along the object selected. 
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If you type a negative distance, then the point is placed at a projected 
point away from the object.

� Select two points to define a distance. For more information, see “Select-
ing Points and Locations” on page 203.

� Type the description for the point, or type a period to skip the description.

� Type the elevation for the point, or type a period to skip the elevation.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� Do one of the following:

� Specify another distance, to create a point at a different distance from the 
end point.

� Press ENTER and select a different object.
� Press ENTER twice to end the command.

NOTE All distances are measured from the end point of the selected object, 
not from the last point placed on the object. 

The following illustration shows a point created at a positive distance along 
a curve:
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Creating Points on Lines, Curves, or Spirals

You can create a point at the endpoints of a selected line, curve, or spiral, as 
well as on points of intersections (PIs) for spirals and radius points for curves. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ On Line/Curve/Spiral.
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The following prompt is displayed:
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� Select the object. For more information, see “Selecting Lines, Curves, and Spi-
rals by Selecting Points” on page 203.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� To continue placing points at each location, type elevations and descriptions 
for the points. The command ends after it has processed each point on the 
object, or you can press ENTER to end the command.

If an arc is selected the command places points at the endpoints and radius 
points of the arc. For a spiral, the command places points at the endpoints 
and PI of the spiral.
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Creating a Specific Number of Points Along an 
Object

You can set a specific number of points, equal distances apart, along a 
selected line, curve, or spiral, or at an offset distance from the object. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points ➤ Divide Object.
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� Select the object. For more information, see “Selecting Lines, Curves, and Spi-
rals by Selecting Points” on page 203.

The end point nearest to the point you selected is marked with an X. This is 
considered the start point of the object when calculating offset values. 

� Type the number of segments to divide the object by. A point is placed at 
each segment vertex.

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� Repeat steps 6 and 7 for each point on the object.
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Creating Points Equal Distances Along an Object

You can create points at equal distances along a selected line, arc, or spiral, 
or at an offset distance from the object. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89.

� From the Points menu, choose Create Point ➤ Measure Object.
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� Select the object.

� Type the starting station of the object. 

� Press ENTER to accept the starting station, or type a new value.

� Press ENTER to accept the default ending station, or type a new value.

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Type the station interval. Points are placed along the object at this interval.

 Type the elevation for the point, or type a period to skip the elevation.

�) Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

�� Repeat steps 9 and 10 for each point on the object.

The following illustration shows points set by the Measure Object command:
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Creating Points on Polylines and Contours by 
Using the Elevation of the Current Polyline

You can use the Polyline/Contour Vertices – Automatic command to create 
points on a polyline or a contour object that are the same elevation as the 
polyline or contour vertices. For example, you can use the 3D Polylines com-
mands in the Terrain menu to draw 3D polylines with elevations, and then 
use this command to place points along the polylines you create. For more 
information, see “Creating 3D Polylines” on page 834.
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� From the Points menu, choose Create Points ➤ Polyline/Contour Vertices - 
Automatic. 

The following prompt is displayed:
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� Select a polyline or contour.

Points are created at the vertices of the polyline or contour. 

NOTE Depending on the Point Settings, you may be prompted for point 
descriptions.

The following prompt is displayed:
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� Select another polyline or contour, or press ENTER to end the command. 

Creating Points on Polylines or Contours by 
Using a Default Elevation

You can use the Polyline/Contour Vertices – Manual command to create 
points on a polyline or contour at a specified elevation. 
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� From the Points menu, choose Create Points ➤ Polyline/Contour Vertices - 
Manual. 

The following prompt is displayed:
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� Type the default elevation to use for all of the points.

The following prompt is displayed:
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� Select a polyline or contour from your drawing.

Points are created at the vertices of the polyline or contour. 

NOTE Depending on the Point Settings, you may be prompted for point 
descriptions.

� Select another polyline or contour, or press ENTER to end the command. 
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Creating Points at Intersections

Using the point intersection commands, you can create points at a variety of 
“virtual” intersections. Instead of working with real lines, for example, you 
can define virtual lines by defining directions. You can then place a point at 
the intersection of these two directions. Virtual arcs are used to calculate 
radial distances, which can intersect with each other, with directions, and 
with objects.

Creating Points at the Intersections of Directions

You can create a point at the intersection of two directions that are defined 
by two points, a bearing, or an azimuth. 

������������	�
����������
��������
�������%���
����
���

� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Direction/
Direction.

� Select a point. This point, along with the direction you define in step 4, 
defines the first direction line. 

The following prompt is displayed:
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� Do one of the following to define the direction:

� Type Azimuth, and then type the azimuth of the direction line in 
DD.MMSS format.

� Type B, and then type a quadrant number and a bearing in DD.MMSS 
format.

� Type PO, and select two points to define the direction. The direction is cal-
culated from the first point that you select to the second point that you 
select.

� Type .P to activate the point number filter, and then type the point num-
bers you want to use for defining the direction. 

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Repeat to steps 3–5 to define the second direction line. 

� Type the elevation for the point, or type a period to skip the elevation.



Creating Points at Intersections | 219

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created at the intersection of two 
directions, using an offset distance from each direction line:
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Creating Points at the Intersections of Radial 
Distances

You can create a point at the intersection of two distances that are defined by 
radius lengths. 

TIP When you are defining the radial points and distances, keep in mind that 
you are essentially designing two circles that intersect each other. The locations 
where the circles intersect are where the points are created. Think of the radial 
point as the equivalent of the center point of a circle, and think of the radial 
distance as the radius of a circle.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Distance/
Distance.

� Select the first radial point. 
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� Define the radius by typing either a value or selecting a point.

� Select the second radial point.

� Define the second radius by typing a value or by selecting a point.

The command displays X’s that mark the intersection points. If only one 
intersection is located, then the command automatically places the point at 
that intersection.

� If two intersections are located, then do one of the following:

� Click near the X you want to create a point on. 
� Type A to place points at both intersections. 

� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

�) Repeat steps 8 and 9 for the second point if you chose to place both points.

The following illustration shows a point created at the intersection of two 
distances:
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Creating Points at the Intersections of Directions 
and Distances

You can create a point at the intersection of a direction (line) and distance 
(circle). 
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TIP When you define the radial point and radial distance, keep in mind that 
you are essentially designing a circle that intersects with a direction line. The 
locations where the circle intersects the direction line are where the points are 
created. Think of the radial point as the equivalent of the center point of a circle, 
and think of the radial distance as the radius of a circle.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Direction/
Distance.

� Select the radial point. 

� Define the radius by either typing a value or selecting a point.

� Select the start point for the direction line. This point, with the angle you 
define in step 6, defines the direction line.

The following prompt is displayed:
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� Do one of the following to define the direction:

� Type Azimuth, and then type the azimuth of the direction line in 
DD.MMSS format.

� Type B, and then type a quadrant number and a bearing in DD.MMSS 
format.

� Type PO, and select two points to define the direction. The direction is cal-
culated from the first point that you select to the second point that you 
select.

� Type .P to activate the point number filter, and then type the point num-
bers you want to use for defining the direction. 

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

The command displays X’s that mark the intersection points. If only one 
intersection is located, then the command automatically places the point at 
that intersection.

� If two intersections are located, then do one of the following:

� Click near the X you want to create a point on. 
� Type A to place points at both intersections. 
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 Type the elevation for the point, or type a period to skip the elevation.

�) Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

�� Repeat steps 9 and 10 for the second point if you chose to place both points.

The following illustration shows a point created at the intersection of a direc-
tion and distance:
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Creating Points that Are Perpendicular to Points 
and Directions

You can create a point that is perpendicular to a direction line and a selected 
point. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Direction/-
Perpendicular.

� Select a point. This point, with the direction you define in step 4, defines the 
direction line.

The following prompt is displayed:
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� Do one of the following to define the direction:
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� Type Azimuth, and then type the azimuth of the direction line in 
DD.MMSS format.

� Type B, and then type a quadrant number and a bearing in DD.MMSS 
format.

� Type PO, and select two points to define the direction. The direction is cal-
culated from the first point that you select to the second point that you 
select.

� Type .P to activate the point number filter, and then type the point num-
bers you want to use for defining the direction. 

� Select the perpendicular point. The command then calculates a perpendicu-
lar intersection between this point and the direction line.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The command displays the ahead and offset distance of each selected point 
as the point is being placed. The ahead distance is the distance along the 
direction line from the beginning point selected in step 3. The offset distance 
is the offset distance from the direction line of the perpendicular point 
selected in step 5.

The following illustration shows a point created perpendicularly to a 
direction:
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Creating Points that Are Radial to Arcs and 
Points

You can create a point that is radial to both a circle and a selected point. 
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TIP When you define the radial point and radial distance, keep in mind that 
you are essentially designing a circle. Think of the radial point as the equivalent 
of the center point of a circle, and the radial distance as the radius of a circle.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Distance/
Perpendicular.

� Select the radial point. 

� Define the radius by either typing a value or by selecting a point.

� Select a point. The command then calculates how this point intersects radi-
ally with the circle you defined in steps 3 and 4.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created radial to a distance:
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Creating Points at the Intersections of Objects 
and Directions

You can create a point at the intersection of a line, curve, or spiral object and 
a direction line. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Direction/
Object.

� Select the object.

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Select a point. This point, with the angle you define at step 6, defines the 
direction line.

The following prompt is displayed:
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� Do one of the following to define the direction:

� Type Azimuth, and then type the azimuth of the direction line in 
DD.MMSS format.

� Type B, and then type a quadrant number and a bearing in DD.MMSS 
format.

� Type PO, and select two points to define the direction. The direction is cal-
culated from the first point that you select to the second point that you 
select.

� Type .P to activate the point number filter, and then type the point num-
bers you want to use for defining the direction. 

� Define an offset from the direction line.

� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created that is offset from the inter-
section of an object and a direction line:
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Creating Points at the Intersections of Objects 
and Radial Distances

You can set a point at the intersection of an object and a radial distance. 

TIP When you define the radial point and radial distance, keep in mind that 
you are essentially designing a circle. Think of the radial point as the equivalent 
of the center point of a circle, of the radial distance as the radius of a circle.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Distance/
Object.

� Select the object.

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Select the radial point. 

� Define the radius by either typing a value or by selecting a point.

The command displays X's that mark the intersection points. If only one 
intersection is located, then the command automatically places the point at 
that intersection.

� If two intersections are located, then do one of the following:

� Click near the X you want to create a point on. 
� Type A to place points at both intersections. 
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� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

�) Repeat steps 8 and 9 for the second point if you chose to place both points.

The following illustration shows points created that are offset from the inter-
sections of an object and a radial distance:
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Creating Points at Intersections of Objects

You can create a point at the intersection of two lines, arcs, or spirals in your 
drawing. 

NOTE The two objects that you select do not have to physically intersect in 
the drawing. The program calculates the intersection by temporarily extending 
either or both of the objects until they meet, and then the program places the 
point at that intersection. The objects cannot be parallel. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Object/Object.

� Select the first object. 



228 | Chapter 11 Creating Points

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Select the second object. 

� Type an offset from the second object.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created that is offset from the inter-
section of two objects:
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Creating Points on Objects that Are 
Perpendicular or Radial to Points

On an object, you can create a point that is perpendicular or radial to a 
selected point. If you create the point on a line, then the point is placed on 
the line perpendicular to the point that you select. If you create the point on 
an arc or spiral, then the point is placed on the object radial to the selected 
point. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Intersections ➤ Perpendicular.

� Select the object.
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� Select the point. The command then calculates the perpendicular or radial 
intersection between the object and this point.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

� Do one of the following:

� Select another radial or perpendicular point.
� Press ENTER to end the command.

The following illustration shows a point that is perpendicular to a selected 
point and a line:
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Creating Points at Alignment Intersections

Using the alignment intersections commands, you can create points at the 
intersections of alignments with directions, distances, objects, and other 
alignments. An alignment must be present in the project in order to use the 
alignment intersection commands. 

Creating Points at the Intersections of Direction 
Lines and Alignments

You can create points at the intersection of a direction line and the current 
alignment, or a point that is offset from this intersection. 

NOTE The direction line is not an object; it is only for calculating direction. For 
more information on how to create a point at the intersection of an object and 
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an alignment, see “Creating Points at the Intersections of Objects and Align-
ments” on page 233. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Intersections ➤ Direction and 
Alignment. 

� Define the offset distance between the alignment and the point to create. 
The offset value is the perpendicular or radial distance between the current 
alignment and the point that you want to create. For more information, see 
“Offset Distances” on page 262.

� Select the starting point for the direction line.

The following prompt is displayed: 
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� To define the direction, type one of the following options:

� Type a quadrant number and then type the bearing of the direction line 
in DD.MMSS format.

� Type Azimuth and then type the azimuth of the direction line in 
DD.MMSS format.

� Type PO, and then select two points to define the angle of the direction 
line.

� Type .P, and then type two point numbers to define the angle of the 
direction line.

� Define the offset distance between the direction line and the point to create. 
This is the perpendicular offset distance from the direction line to the point. 
For more information, see “Offset Distances” on page 262.

The offset distance is based on the current drawing units. 

The command then determines the intersection between the current align-
ment and the line defined by direction.

� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
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rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created that is offset from the inter-
section of a direction and an alignment:
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Creating Points at the Intersections of Distances and 
Alignments

You can create points at the intersections of a distance line and the current 
alignment. The distance is defined radially; you define a radius for a swing 
arc, and then the intersections are located where the radius crosses the 
alignment.

TIP When you are defining the radial point and radial distance, keep in mind 
that you are essentially designing a circle. Think of the radial point as the equiv-
alent of the center point of a circle, and the radial distance as the radius of a 
circle.

You can set points either on the alignment where the distance line crosses it, 
or at an offset distance from the alignment. The arc does not have to physi-
cally intersect the alignment.

NOTE The arc is not an object. It is only for calculating direction. For more 
information about how to create a point at the intersection of an object and an 
alignment, see “Creating Points at the Intersections of Objects and Align-
ments” on page 233.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Intersections ➤ Distance and 
Alignment. 

� Define the offset distance. The offset value is the perpendicular or radial dis-
tance between the current alignment and the point that you want to create. 
For more information, see “Offset Distances” on page 262.

� Select the radial point. 

� Define the radius by either typing a value or by selecting a point.

The command displays X’s that mark the intersection points. If only one 
intersection is located, then the command automatically places the point at 
that intersection.

� If two intersections are located, then do one of the following:

� Click near the X you want to create a point on. 
� Type A to place points at both intersections. 

� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows points created that are offset from the inter-
sections of a radial distance and an alignment:
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Creating Points at the Intersections of Objects 
and Alignments

You can create points at the intersections of any object and the current align-
ment, or you can set the point at offsets from this intersection. The object 
can be a line, arc, or spiral. The object does not have to physically intersect 
the alignment; this command automatically extends either object to deter-
mine an intersection point.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Intersections ➤ Object and 
Alignment. 

� Define the offset distance from the alignment. The offset value is the perpen-
dicular or radial distance between the current alignment and the point that 
you want to create. For more information, see “Offset Distances” on page 
262.

� Do one of the following to select the object:

� Click the object.
� Type PO and then select points to select the object.

� Define the offset distance from the selected object. This is the distance 
between the selected object and the point that you are creating. 
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The command displays X’s that mark the intersection points. If only one 
intersection is located, then the command automatically places the point at 
that intersection.

� If two intersections are located, then do one of the following:

� Click near the X you want to create a point on. 
� Type A to place points at both intersections. 

� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows points created that are offset from the inter-
section of an alignment and an object:
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Creating Points at the Intersections of 
Alignments

You can create points at the intersections of the two alignments, or at an off-
set distance from either or both of the alignments. The intersection of the 
alignments must be present in the drawing; this command does not extend 
the alignments in order to calculate an intersection point. 

����������	�
�����������
��������
��������%����
��"����

� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.
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� Select the current alignment. The current alignment can be either one of the 
two alignments that intersect. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Intersections ➤ Two 
Alignments. 

� Define the offset distance from the current alignment. The offset value is the 
perpendicular or radial distance between the current alignment and the 
point that you want to create. For more information, see “Offset Distances” 
on page 262.

� Select the second alignment.

� Define the offset distance from the second alignment. 

The command displays X’s that mark the intersection points. If only one 
intersection is located, then the command automatically places the point at 
that intersection.

� If two intersections are located, then do one of the following:

� Click near the X you want to create a point on. 
� Type A to place points at both intersections. 

� Type the elevation for the point, or type a period to skip the elevation.

 Type the description for the point, or type a period to skip the description.

The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created that is offset from the inter-
section of two alignments:
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Creating Points Based on Horizontal 
Alignments

When you need to create points either on an alignment or offset from an 
alignment, then you can use the Create Points - Alignments commands. An 
alignment must be present in the project in order to use these commands.

Creating Points that Are Offset from Alignment 
Stations

By creating points that are offset from stations on an alignment, you can cre-
ate points along the alignment offsets, such as the ROW, shoulder, passing 
lanes, and so on.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Alignments ➤ Station and 
Offset. 

The command line displays the current point number.

� Press ENTER to create points starting with the current point number, or type 
a new point number. 

� Type the station number that you want to offset a point from. Do not type 
the station plus (+) sign when typing this number.

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Type the elevation for the point, or type a period to skip the elevation.

� Type the description for the point, or type a period to skip the description.

After you are prompted for elevation and description information, you are 
prompted to type another offset value.

 Do one of the following:

� Type another offset value to offset another point from the current station.
� Press ENTER and then select a new station to offset a point from.
� Press ENTER twice to end the command.
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The command inserts the point in the drawing if the Insert to drawing as cre-
ated option is selected in the Point Settings. The point is placed on the cur-
rent layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows a point created that is offset from an align-
ment station:
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Creating Points on an Alignment Based on a 
Segment Length
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Alignments ➤ Divide 
Alignment. 

� Type the number of segments you want to divide the current alignment into.  

� The command calculates the distances between points by dividing the total 
length of the alignment by the number of segments specified. 

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� The command line displays the current point number.

� Press ENTER to create points starting with the current point number, or type 
a new point number. 

 Type the elevation for the point, or type a period to skip the elevation.

�) Type the description for the point, or type a period to skip the description.
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�� Continue to type the elevations and descriptions of the points until the com-
mand is completed.

The command inserts the points in the drawing if the Insert to drawing as 
created option is selected in the Point Settings. The points are placed on the 
current layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows points created that are both on the align-
ment and offset from the alignment. The distance between the points is 
determined by a specified number of segments:
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Creating Points on an Alignment Based on 
Station Intervals

You can create points a specified distance apart either on the current align-
ment or at an offset distance from the alignment. The command divides the 
total length of the alignment by the specified distance (station interval) to 
determine the number of points to create.
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Alignments ➤ Measure 
Alignment.

The command line displays the starting station of the current alignment.

� Press ENTER to start placing points from the starting station of the alignment, 
or type a different station at which to start creating points.
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The command line displays the ending station of the current alignment.

� Press ENTER to end the points at the ending station of the current alignment, 
or type a different station at which to end the points. 

� Define the offset distance. For more information, see “Offset Distances” on 
page 262.

� Type the station interval. 

For example, specifying a station interval of 5 places a point at every fifth sta-
tion along the alignment. 

The command line displays the current point number.

� Press ENTER to accept the current point number, or type a different number 
at which to start numbering the points.

 Type the elevation for the point, or type a period to skip the elevation.

�) Type the description for the point, or type a period to skip the description.

�� Continue to type the elevations and descriptions of the points until the com-
mand is completed.

The command inserts the points in the drawing if the Insert to drawing as 
created option is selected in the Point Settings. The points are placed on the 
current layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

Creating Points on the Intersection Points of 
Alignments

You can create points at every intersection point on an alignment, as well as 
at the curve and spiral points of intersections (PIs).
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Alignments ➤ At PC, PT, SC, 
etc.

The command line displays the starting station of the current alignment.

� Press ENTER to create points starting at the starting station of the alignment, 
or type a different station at which to start creating points.

The command line displays the ending station of the current alignment.
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� Press ENTER to end the points at the ending station of the current alignment, 
or type a different station at which to end the points. 

The command line displays the current point number.

� Press ENTER to accept the current point number, or type a different number 
at which to start numbering the points.

� Type the elevation of each point.

NOTE The point objects are automatically labeled with labels that indicate the 
type of vertex. 

The following illustration shows points created at alignment intersection 
points, such as the point where a curve meets a spiral, and at the curve and 
spiral PIs:
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Alignment vertex labels and description
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PI Point of intersection

CPI Curve point of intersection

PT Point of tangency

PC Point of curvature

SPI Spiral point of intersection

TS Tangent-Spiral intersection

CS Curve-Spiral intersection

ST Spiral-Tangent intersection

CC Curve center or radius point
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Creating Points on Alignments that are Radial or 
Perpendicular to Selected Points

You can create points on an alignment that are radial or perpendicular to a 
selected point. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Points menu, choose Create Points-Alignments ➤ Radial or 
Perpendicular.

� Select a point that is radial or perpendicular to the current alignment. 

The command creates the point on the alignment. The command also lists 
the ahead distance (the distance from the beginning of the alignment) and 
offset of the point that you selected. The command does not create the point 
if the point that you selected is not radial or perpendicular to the alignment.

The following illustration shows a point created on an alignment that is per-
pendicular to a selected point, and a point created that is radial to a selected 
point:

��
���������������
��������	��	���
��������������������	�
����



242 | Chapter 11 Creating Points

Creating Points on an Alignment by Importing 
ASCII Files

You can create an ASCII text file with point information, and then import it 
into your drawing to place the points along the alignment at offsets from sta-
tions. This file can also contain the descriptions and/or the elevations of 
points. The elevation can either be a value or a rod reading and height of 
instrument. The command can calculate rod readings and can create the 
point at the appropriate elevation.
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���������������
��"�������"����-./++���0���
��

� Create and save an ASCII text file of point information that uses one of the 
following formats:

� Station, Offset
� Station, Offset, Elevation
� Station, Offset, Rod, Hi
� Station, Offset, Description
� Station, Offset, Elevation, Description
� Station, Offset, Rod, Hi, Description

Use commas or spaces as delimiters. You can insert comments if you place a 
leading semi-colon (;) or pound sign (#) in front of the comment line.

The following is an example of a text file that is formatted using the Station, 
Offset, Elevation format.

3����������,,��������/���������*��/�������

��4�-����4-��

���45-6���2-72

4��44-6���7-67

5��45-����7-54

2��44-����6-�5

Save the file to the \align subdirectory of the current project.

� From the Points menu, choose Create Points-Alignments ➤ Import From File 
to display the File to Import dialog box.
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� Select the ASCII file that you created.

� Click OK to exit the dialog box.

The following prompt is displayed: 

�-�����������,,���

4-�����������,,�����.��/�����

5-�����������,,�����8������

2-�����������,,�����"����������

6-�����������,,�����.��/�������"����������

7-�����������,,�����8��������"����������

.�����,����,��'���
��4�5�2�6�7��

� Specify the file format that you used when creating the text file by typing its 
number at the command line.

� Specify the type of file delimiter that you used: spaces or commas.

� If you selected a file format other than file format 1 or 4, then do one of the 
following:

� If you selected file format 2 or 5, then type an Invalid elevation. You can 
use an invalid value to mark any point that should not be imported. 

� If you selected file format 3 or 6, then type an Invalid rod/hi and an 
Invalid station/offset. Use an invalid value to mark any point that should 
not be imported.

The command inserts the points in the drawing if the Insert to drawing as 
created option is selected in the Point Settings. The points are placed on the 
current layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.
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Creating Points Based on a Surface

You can use the commands in the Create Points - Surface menu to create 
points based on elevations in the current surface.

Creating a Point that Obtains Its Elevation from 
the Current Surface

������������	�
�����������
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������"������������

� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� Select the current surface. For more information, see “Making a Surface Cur-
rent” on page 694.

� From the Points menu, choose Create Points-Surface ➤ Random Points.

� Select a location within the surface boundary for the point.

Creating a Grid of Points that Obtain Their 
Elevations from the Current Surface

You can generate a grid of points that are automatically assigned the eleva-
tions of the current surface. 

��������������
�����	�
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Surface ➤ On Grid.

� Type the rotation angle for the grid as a numeric value, or define it by select-
ing two points on the screen.

� Select the Grid base point. This is the lower-left corner of the grid. Type the 
AutoCAD X,Y coordinates or select a point from the screen.

� Specify the Grid X Spacing and Grid Y Spacing by typing numeric values or 
by selecting two points on the screen.

These values describe the density of points for the grid. For example, if the 
specified X and Y values are X=50 and Y=50, then the grid is made entirely 
of 50 by 50 unit squares with a point at each corner. 
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� Select the upper-right corner of the grid. The AutoCAD SNAP is set to the size 
of a grid square for the selection of the upper-right corner.

One grid square, and the extents of the entire grid, is drawn on the screen.

� Do one of the following:

� To create the points based on this grid, press ENTER.
� To change the size or rotation of the grid or grid squares, type Yes and 

change the grid base point, rotation angle, grid X spacing, grid Y spacing, 
and/or upper-right corner. 

The command calculates the coordinates of each corner of each grid square, 
and then extracts the elevation of each calculated point from the specified 
surface to create the grid of points.

The following illustration shows the parameters for using the On Grid 
command:
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Creating Points Along a Polyline or Contour that 
Obtain Their Elevations from the Current 
Surface

You can place points along a polyline or contour object that are automati-
cally assigned the elevations of the current surface. 

����������	�
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points-Surface ➤ Along Polyline/
Contour.
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� Specify the distance between the points by typing a numeric value or by 
selecting two points on the screen to define the distance.

� Select the polyline or contour.

The points are placed along the polyline or contour at the specified interval.

NOTE Depending on the Point Settings, you may be prompted to define point 
descriptions.

� Select another polyline or contour, or press ENTER to end the command.

The following illustration shows points created along a polyline at a specified 
distance:
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Creating Points at Polyline or Contour Vertices by 
Using the Elevations of the Surface

You can place points based on the elevations of the current surface at the ver-
tices of polylines or contours.
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� From the Points menu, choose Create Points – Surface ➤ Polyline/Contour 
Vertices. 

If no surface has been set current, the Select Surface dialog box is displayed.

� Select a surface and click OK.

The following prompt is displayed:

����������	�������������

� Select a polyline or contour. 

The points are created and added to the polyline vertices. 

NOTE Depending on the Point Settings, you may be prompted to define point 
descriptions.
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� Select another polyline or contour, or press ENTER to end the command. 

If a vertex of the selected polyline or contour falls outside the current surface, 
then the command displays the following message:

������,�������/������,��������9��:3;��	��:3;

The command does not place points at vertices that fall outside the surface.

Creating Points Based on Slopes

You can use the Create Points – Slope commands to create finished ground 
points where two grades or slopes intersect, at a specified slope and distance, 
and at a given slope or grade based on an ending elevation.

Creating Points Where Two Grades or Slopes 
Intersect

Using the High/Low Point command on the Create Points – Slope menu, you 
can place a point where two grades or slopes intersect in order to create fin-
ished ground data. 

����������	�
����%������%���������������	���
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� From the Points menu, choose Create Points - Slope ➤ High/Low Point.

� Select the two points to locate the high/low point in between. For more 
information, see “Selecting Points and Locations” on page 203.

The first point you select is marked with an X and an arrow, pointing in the 
direction of the second point. 

The following prompt is displayed: 

)�����������
���<���������,�����!�

� At this prompt, do one of the following:

� Type a slope value.
� Select two points to define a slope. 

The distance between the two selected points are entered as the slope.

� Type G and a grade, or select two points to define the grade. 

The distance between the two selected points are entered as the grade.

� Define the slope or grade between the second point and the high/low point 
in the same manner as the first point.
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The command calculates the location where the slope or grade would inter-
sect, and places a temporary X in the drawing where the new point would be 
located. When the slope/grade intersection point is not between the points, 
it places an X outside of the two points. This may not be apparent if the solu-
tion is outside of your current view.

The following prompt is displayed: 

%���������
 �������� ��!�

� At this prompt, press ENTER to place the point in the drawing. Type No to not 
place the point.

� Continue to select points, or press ENTER to exit the command.

The following illustration shows points created at the intersection of slopes 
and grades:
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Creating Points at a Given Slope or Grade for a 
Specified Distance

You can create points at a specified slope and a specified distance using the 
Create Points – Slope ➤ Slope/Grade – Distance command.
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� From the Points menu, choose Create Points - Slope ➤ Slope/Grade - 
Distance.

The following prompt is displayed:

(���������������
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� Select the first point.

The following prompt is displayed:

"���������

� Select a point to define the direction in which the points are placed.

An X is drawn at each point as a temporary vector.

The following prompt is displayed: 

������
���<���������,�����!�

� At this prompt, do one of the following to define the grade or slope:

� Type a slope value.
� Select two points to define a slope. 

The distance between the two selected points is entered as the slope.

� Type G and a grade value, or select two points to define the grade. 

The distance between the two selected points is entered as the grade.

The following prompt is displayed:

"���������3!�

The number displayed in the brackets is the distance between the beginning 
point and the point you selected to define the direction.

� Press ENTER to accept this distance, or type a new distance.

� Specify the number of intermediate points to insert.

� You can specify an offset distance. For more information, see “Offset Dis-
tances” on page 262.

The following prompt is displayed: 

%����������������
 �������� ��!�

At this prompt press ENTER to add an ending point. Type No to place only 
the intermediate points you specified in step 6.

The following prompt is displayed:

"���������

� At this prompt, do one of the following:

� Select another direction in which to place points. 
� Press ENTER and select another beginning point.
� Press ENTER twice to exit the command.

The following illustration shows points created at a given slope or grade 
based on distance:
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Create Points at a Given Slope or Grade Based on 
an Ending Elevation

You can set points at a given slope/grade based on an ending elevation in 
order to create finished ground data. For example, you can specify a grade 
and an ending elevation, and then place points along the distance it takes to 
achieve the final elevation. 
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� From the Points menu, choose Create Points - Slope ➤ Slope/Grade - 
Elevation. 

The following prompt is displayed:

(���������������

� Select the first point.

The following prompt is displayed:

"���������

� Select a point from your drawing to define the direction in which the points 
are placed.

An X is drawn at each point as a temporary vector.

The following prompt is displayed: 

������
���<���������,�����!�

� At this prompt, do one of the following to define the grade or slope:

� Type a slope value.
� Select two points to define a slope.

The distance between the two selected points is entered as the slope.

� Type G and a grade value, or select two points to define the grade.

The distance between the two select points is entered as the grade.

� Specify the elevation at the end point of the slope or grade. 

This is measured in current drawing units.
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The command determines the horizontal distance it would take to achieve 
the elevational difference at the specified slope or grade, and displays this 
information, along with the slope, grade, and elevational information. 

� Specify the number of intermediate points to insert.

� You can specify an offset distance. For more information, see “Offset Dis-
tances” on page 262.

A positive number offsets the points to the right, and a negative number off-
sets the points to the left by that distance.

The following prompt is displayed: 

%����������������
 �������� ��!�

� At this prompt, do one of the following to determine whether to place an 
ending point:

� Press ENTER to add an ending point.
� Type No to place only the intermediate points you specified in step 6.

The following prompt is displayed:

"���������

 At this prompt, do one of the following:

� Select another direction.
� Press ENTER and select another beginning point.
� Press ENTER twice to exit the command.

The following illustration shows points created along the reference line at a 
horizontal distance between the beginning point and the point specified by 
the elevation override:
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Interpolating Points

You can use the Points – Interpolate commands to create points for addi-
tional grading data. Whenever you use a point interpolation command, you 
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need to define the interpolation region by selecting either two points to place 
the new points between, or an object on which to place the new points.

The following illustration shows the general interpolation parameters when 
selecting two points to define the interpolation region:
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Interpolating Points Along a Line

You can place a specified number of interpolated points between two selected 
points. 

NOTE At least two points with elevations must exist in the drawing for this 
command to work properly. 
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� Change the Point Settings. For more information, see “Getting Started with 
Points” on page 89, “Changing the Point Creation Settings” on page 93, and 
“The Effect of Point Settings on Point Prompts” on page 202.

� From the Points menu, choose Create Points - Interpolate ➤ Interpolate.

� Specify the elevational precision for the new points.

� Select the two points that you want to interpolate points between.

These points must be COGO point objects that have elevational values. If the 
point that you select does not have an elevation, then the command assigns 
an elevational value of zero (0).

� Type the number of points to create.

� Type the description for the point. If no description was previously entered, 
then the default value is INTERP.

The command inserts the points in the drawing if the Insert to drawing as 
created option is selected in the Point Settings. The points are placed on the 
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current layer unless you are using description keys. For more information, see 
“Description Keys” on page 143.

The following illustration shows interpolated points:

+����	���������
���

Creating Points Along a Specified Distance by 
Interpolation

You can interpolate points between two selected points, based on a distance.
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� From the Points menu, choose Create Points - Interpolate ➤ By Relative 
Location. 

The following prompt is displayed:

)�����������
���.����	�

� Specify the interpolation region using one of the following methods:

� Select two points by picking a point on the screen, snapping to an entity, 
selecting a point object (.g), typing a point number (.p), or specifying 
northing/easting (.n). Next, specify the elevations of the points. For more 
information, see “Selecting Points and Locations” on page 203.

� Select a 2D or 3D polyline. For more information, see “Defining a 2D or 
3D Polyline as an Interpolation Region” on page 254.

� Select an arc. For more information, see “Defining an Arc as an Interpola-
tion Region” on page 255.

� Select a line. For more information, see “Defining a Line as an Interpola-
tion Region” on page 256.

NOTE The interpolation is calculated along the length of the entity selected. 
On 2D or 3D polylines, the first and second point can be at any vertex on the 
entity. The elevation of the second point can be as selected, or a function of a 
slope or elevation distance from the first point.
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The following illustration shows the By Relative Location command 
parameters:
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Defining a 2D or 3D Polyline as an Interpolation 
Region

You can define the interpolation region by selecting a 2D or 3D polyline as 
the entity using any of the Create Points - Interpolate commands on the 
Points menu. The points are placed along or offset from the entity as 
specified.
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� From the Points menu, choose any Create Points - Interpolate command.  

The following prompt is displayed:

)�����������
���.����	��

� Select the polyline by selecting points, or type E and select the polyline by 
clicking on it.

The beginning and ending points of the polyline are initially set as the first 
and second control points.

The following prompt is displayed: 

�=���#���������/���9���#������!�

� At this prompt, type one of the following options:

� Type P to move to the previous vertex on the entity.
� Type N to move to the next vertex on the entity.
� Type C when you are ready to select the current vertex for the first or sec-

ond point.

� Accept or type the elevation for the first point.

� Select the next vertex to use as the second point, using the methods in step 4. 
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A temporary arrow is displayed, showing the direction from the first control 
point to the second. This arrow is useful when determining the general offset 
from the entity, because it points from the first control point to the second, 
and the program determines all offsets along that direction.

The following prompt is displayed: 

.��/������
�=���"�,,����������������-��!�

� At this prompt, define the second point using one of the following methods:

� Type the elevation for the second point.
� Type D and the difference in elevation between the first and second 

points.
� Type S and a slope between the first and second points, or G and a grade.

The specified slope extends the length of the entity between the points. 
The command then prompts for a distance and defaults to the length 
between the two points along the entity.

� Press ENTER to end the command.

Defining an Arc as an Interpolation Region

You can define an arc as an interpolation region using any of the Create 
Points - Interpolate commands.

������
����������������
����	����
������
��

� From the Points menu, choose any Create Points - Interpolate command.

The following prompt is displayed:

)����������
���.����	��

� Select the arc by selecting points, or type E and select the arc by clicking on it.

The control points are automatically set at the arc endpoints.

� Type the elevation for the first point, and press ENTER.

The following prompt is displayed: 

.��/������
�=���"�,,����������������-��!�

� At this prompt, define the second point using one of the following methods:

� Type the elevation for the second point.
� Type D and the difference in elevation between the first and second 

points.
� Type S and a slope between the first and second points, or type G and a 

grade. 
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The specified slope extends along the length of the arc between the 
points. The command then prompts for a distance, and defaults to the 
length between the two points along the arc.

� Press ENTER to end the command.

Defining a Line as an Interpolation Region

You can define a line as an interpolation region using any of the Create 
Points - Interpolate commands.
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� From the Points menu, choose any Create Points - Interpolate command.

The following prompt is displayed:

)����������
���.����	��

� Select the line by selecting points, or type E and select the line by clicking 
on it.

The command locates the vertex to use that is closest to the selection point. 

� Type the elevation for the vertex and press ENTER. 

The following prompt is displayed: 

.��/������
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� At this prompt, define the second point using one of the following methods:

� Type the elevation for the second point.

� Type D and the difference in elevation between the first and second 
points.

� Type S and a slope between the first and second points, or type G and a 
grade.

The specified slope extends along the length of the arc between the 
points. The command then prompts for a distance, and defaults to the 
length between the two points along the arc.

� Press ENTER to end the command.

Creating a Point at an Elevation by Interpolating 
Between Two Points or Contours

You can create a point at an elevation by interpolating between two points 
or contours using the Create Points - Interpolate ➤ By Relative Elevation 
command.



Interpolating Points | 257

������������	�
������������#��
�����
����	����
�����%�����%��	�
����������7

�����

� From the Points menu, choose Create Points - Interpolate ➤ By Relative 
Elevation. 

The following prompt is displayed:

)�����������
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� Select the interpolation region using one of the following methods:

� Select two points. For more information, see “Selecting Points and Loca-
tions” on page 203.

� Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 
3D Polyline as an Interpolation Region” on page 254.

� Select an arc. For more information, see “Defining an Arc as an Interpola-
tion Region” on page 255.

� Select a line. For more information, see “Defining a Line as an Interpola-
tion Region” on page 256.

The following illustration shows the By Relative Elevation command param-
eters:
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Creating a Number of Points Along a Specified 
Distance by Interpolation

You can create a number of interpolated points using the Create Points - 
Interpolate ➤ Number By Distance command.
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� From the Points menu, choose Create Points - Interpolate ➤ Number By 
Distance.

The following prompt is displayed:

)�����������
���.����	��
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� Select the interpolation region using one of the following methods:

� Select two points. For more information, see “Selecting Points and Loca-
tions” on page 203.

� Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 
3D Polyline as an Interpolation Region” on page 254.

� Select an arc. For more information, see “Defining an Arc as an Interpola-
tion Region” on page 255.

� Select a line. For more information, see “Defining a Line as an Interpola-
tion Region” on page 256.

The following illustration shows the Number By Distance command 
parameters:
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Interpolating Points that are Perpendicular to the 
Control Points

You can set points perpendicularly along a line based on the location of adja-
cent points.
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� From the Points menu, choose Create Points - Interpolate ➤ Perpendicular. 

The following prompt is displayed:

)�����������
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� Select the interpolation region using one of the following methods:

� Select two points. For more information, see “Selecting Points and Loca-
tions” on page 203.



Interpolating Points | 259

� Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 
3D Polyline as an Interpolation Region” on page 254.

� Select an arc. For more information, see “Defining an Arc as an Interpola-
tion Region” on page 255.

� Select a line. For more information, see “Defining a Line as an Interpola-
tion Region” on page 256.

The following illustration shows the Perpendicular command parameters:
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Interpolating Points Using Distance Increments

With the Create Points - Interpolate ➤ Incremental Distance command, you 
can interpolate points using distance increments.
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� From the Points menu, choose Create Points - Interpolate ➤ Incremental 
Distance. 

The following prompt is displayed:
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� Select the interpolation region using one of the following methods:

� Select two points. For more information, see “Selecting Points and Loca-
tions” on page 203.

� Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 
3D Polyline as an Interpolation Region” on page 254.

� Select an arc. For more information, see “Defining an Arc as an Interpola-
tion Region” on page 255.

� Select a line. For more information, see “Defining a Line as an Interpola-
tion Region” on page 256.



260 | Chapter 11 Creating Points

The following illustration shows the Incremental Distance command 
parameters:
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Interpolating Points by Using Elevation 
Increments

You can place a series of points at an even elevation increment along a 
straight line. Points or contours must exist in the drawing for this command 
to work properly.
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� From the Points menu, choose Create Points - Interpolate ➤ Incremental 
Elevation. 

The following prompt is displayed:
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� Select the interpolation region using one of the following methods:

� Select two points. For more information, see “Selecting Points and Loca-
tions” on page 203.

� Select a 2D or 3D Polyline. For more information, see “Defining a 2D or 
3D Polyline as an Interpolation Region” on page 254.

� Select an arc. For more information, see “Defining an Arc as an Interpola-
tion Region” on page 255.

� Select a line. For more information, see “Defining a Line as an Interpola-
tion Region” on page 256.

The following illustration shows the Incremental Elevation command 
parameters:
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Interpolating Points at Intersections of Entities 

You can set points where one entity intersects another, or where it intersects 
another if its lines are extended. 
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� From the Points menu, choose Create Points - Interpolate ➤ Intersection. 

The following prompt is displayed:
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� Select two points to place the new points between and define their eleva-
tional difference, or select an entity to place the new points on and define 
the elevational difference between vertices.

� After selecting the second control point, define an offset from that position.

� Select another entity for locating an intersection point.

If one intersection point is found, then a point is created at that point. If 
more than one intersection point is found, then temporary Xs are placed at 
the intersection points. 

The following prompt is displayed:
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� At the command prompt, type one of the following options:

� Type All to set a point at all intersection points.
� Type Point to set specific intersections as points in the project or drawing; 

you can select individual locations when more than one intersection is 
found. Using the pointing device, select near the highlighted intersections 
to designate the area in which the points are to be placed.
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� Type X (Exit) to display the Select POints/Entity prompt. 

� Press ENTER to exit the command.

The following illustration shows the Intersection command parameters:
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Offset Distances
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� Type a positive offset distance to place the point to the right of the object, 
direction line, or location. Right and left are determined by station pro-
gression or the direction in which the object was drawn. 

� Type a negative offset distance to place the point to the left of the object, 
direction line, or location.

� Type 0 as the offset distance to place the point directly on the object, 
direction line, or location.

� Select two points in the drawing to define the offset distance.

The offset distance is based on the current drawing units. 
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12Importing and Exporting 
Points

If you have point data that is saved as an ASCII text file 

or in a Microsoft® Access database file, then you can 

import it into the project. Likewise, point data from the 

project point database can be exported to ASCII text 

files, and point data can be transferred from a database 

or text file to a text file. All import, export, and transfer 

operations require import/export formats. Use the 

Format Manager to create and manage import/export 

formats.

In this chapter

� Importing and Exporting Points

� Changing the COGO Database 
Import Options

� Creating a Point Import/Export 
Format

� Column Headings

� Copying, Viewing, and 
Modifying an Existing Import/
Export Format

� Removing a Point Import/
Export Format

� Importing Point Data

� Exporting Point Data

� Transferring Points

� Converting Points in the 
COGO Database to a Different 
Coordinate Zone

� Merging a Point Database into 
the Current Point Database
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Importing and Exporting Points

Use the import and export commands to import points into the COGO point 
database, to export points to ASCII text files, and to transfer point data 
between files.

Importing and Exporting Point Files into or out of the COGO 
point database
You can import points into the COGO point database from external sources, 
such as ASCII text files and Microsoft Access database files. You can also 
export points from the COGO point database to ASCII text files. 

Merging Point Databases
You can merge points from a COGO point database into the current COGO 
point database. The point database that you want to merge must be an .mdb 
file. Older versions of COGO point databases, project.pdf, cannot be merged 
into the current database.

Transferring Points Between Files
You can transfer points from ASCII or Microsoft Access .mdb files to ASCII 
files. For example, you can transfer points from one point file to another, 
using different import/export formats for both the source and destination 
files. 

NOTE Points that are transferred from a source to a destination are not deleted 
from the source file. 

Importing Point Files into the Terrain Model Explorer
To include external point files in a surface model, you can import ASCII text 
files or Microsoft Access .mdb files into the surface folder. When you import 
points into the surface folder, the points are not added to the COGO point 
database.

Import/Export Formats
To import, export, or transfer point files, import/export formats are required. 
The formats define what information is being imported, exported, or trans-
ferred. For example, to import a point file that lists point number, northing, 
easting, and elevation, you must define an import/export format that refer-
ences the number, northing, easting, and elevation. 
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Changing the COGO Database Import 
Options

The COGO database import options control how the COGO point database 
handles points that are imported into it. For example, you can choose to 
overwrite existing points in the database when you import, or you can 
choose to merge the points. You can also specify how to number the points.
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� From the Points menu, choose Import/Export Points ➤ Import Options to 
display the COGO Database Import Options dialog box.

� Under What to do if the point numbers are supplied by the source, select one 
of the following options:

� Select the Use option to use the point numbers from the source. For exam-
ple, if the point file you want to import has point numbers defined in it, 
and you want to use these numbers, then select this option.

� Select the Ignore option if you do not want to use the point numbers that 
are defined in the point profile. When you select this option, the points 
are numbered based on the option you select in the What to do when 
point numbers need to be assigned to the points section.

� Select the Add an offset option and type a value in the box to add an 
amount to each point number in the point file. For example, if you type 
200 in the box, then points 1, 2, and 3 in the point file are numbered 201, 
202, and 203, when imported.
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� Under What to do when point numbers need to be assigned to the points, 
select one of the following options:

� Select the Use next point number option to number the new point start-
ing with the next available point number.

� Select the Sequence from option and type a value in the box to number 
the new point starting at a fixed number, such as 100.

� Under What to do when the point number already exists in the point data-
base, select one of the following options:

� Select the Renumber option to assign new numbers to any points in the 
source file that have point numbers that already exist in the point data-
base. The assignment of the new numbers is based on the What to do 
when point numbers need to be assigned to the points option.

� Select the Merge option to overwrite point data that exists in the COGO 
points database with data that exists in the source file; and to preserve 
data in the COGO database that is not supplied by the source file. For 
more information, see the section “Example: What to Do When the Point 
Number Already Exists in the Point Database” on page 266.

� Select the Overwrite option to overwrite any existing points in the COGO 
point database that have the same numbers as the points in the file you 
are importing. For more information, see the section “Example: What to 
Do When the Point Number Already Exists in the Point Database” on page 
266.

� Click OK.

Example: What to Do When the Point Number 
Already Exists in the Point Database

The following scenarios provide examples of what happens when you select 
the Merge or Overwrite options in the “What to do when the point number 
already exists in the point database” section of the COGO Database Import 
Options dialog box. For more information, see “Changing the COGO Data-
base Import Options” on page 265.

For example, if there is a point in the project point database with the follow-
ing information:
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And you import a file that contains just number, northing, easting as follows:
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With the Overwrite option selected, the point in the project database would 
become:

��������	


�����������	�� 

���������!" �#�

�����������$����%�&���'(

�������������$����%�&���'(

All fields are overwritten, even elevation and description.

With the Merge option selected, the point in the project database would 
become:
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The number, northing, and elevation are overwritten, but the elevation and 
description in the point database are preserved. 

Creating a Point Import/Export Format

There are two different types of import/export formats that you can create:

� User Point File: For importing ASCII text files into the COGO point data-
base, for exporting COGO point database information to an ASCII text 
file, and for transferring data from and to ASCII text files.

� User Point Database: For importing Microsoft Access user database files 
into the COGO point database and for transferring data from a user point 
database to an ASCII text file.
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� From the Points menu, choose Import/Export Points ➤ Format Manager to 
display the Format Manager dialog box. 
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� Click Add to display the Format Manager - Select Format Type dialog box.

� Select one of the following format types and click OK:

� User Point File: Select this option to create a format for an ASCII text file. 
For more information, see “Creating a User Point File Import/Export For-
mat” on page 268.

� User Point Database: Select this option to create a format for a Microsoft 
Access point database file. For more information, see “Creating a User 
Point Database Import/Export Format” on page 272.

Creating a User Point File Import/Export Format
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� From the Points menu, choose Import/Export Points ➤ Format Manager.

� Click Add.

� Select User Point File and click OK to display the Point File Format dialog 
box.
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� Click Load to load the text file you want to import. This step is optional, but 
by loading the file, you can see the contents of the file.

NOTE At any time you can click the Parse button to format your loaded file 
according to how the format is set up. When you click Parse, the loaded file is 
placed in the top frame and formatted. If you subsequently edit the format, the 
parsed text disappears and the Parse button becomes available to use. 

� In the Format Name box, type a name for the format.

# From the Default Ext. list, select a file extension for the point file you are 
importing or exporting: 

� .txt: Delimited ASCII text file.
� .csv: Comma Separated Value file; ASCII text file delimited by commas.
� .prn: Formatted text, space delimited.
� .xyz: Coordinates X, Y, and Z.
� .auf: Autodesk Uploadable File, comma delimited. Values in such a file 

are limited to Number, Easting, Northing, Elevation, Description (in that 
order).

� .nez: Northing, Easting, and Elevation data.

If the file extension you want to use is not in the list, then you can type one 
in the box.
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$ In the Comment Tag box, type the symbol that you used when writing com-
ments in the file. For example, if a point file contains a line like #Autodesk 
Point File, you would type # in the Comment Tag box. The Comment Tag 
indicates where the comment starts. A comment always ends at the end of 
the line.

% Select one of the following options:

� Select Columnated if the entries in the point file are separated by tabs (or, 
for exporting or transferring, to determine how the resulting text file 
appears). For example: 

������ ������� ������� ���������

� Select Delimited if the entries in the point file are separated by a delimiter 
like a comma (or, for exporting or transferring, to determine how the 
resulting text file appears). For example:

������)'����������)�������)�������)���������

If you select Delimited, then type the delimiter, such as a comma (,) in the 
box. Tabs and spaces are always used as delimiters so it is unnecessary to 
specify them. There is no restriction on which characters you can use as 
file delimiters.

& Select the Read no more than check box to limit the import or export to a 
specific number of points, starting from the top of the file. If you select this 
check box, then type a limit in the box. This option does not include com-
ment lines or errors in the text file; if you type 100 as the limit, then 100 
points are imported.

�' Select the Sample every check box and type a value in the box to take a sam-
ple of point data at a specified interval. For example, if you type 100 in the 
box, then AutoCAD Land Development Desktop imports, exports, or trans-
fers only every 100th point.

�� If you are working with point data from defined coordinate zones, then select 
the Coordinate Zone Transform check box and click  to display the Select 
Coordinate Zone dialog box.
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This option can transform points from one zone into another. For example, 
to import an ASCII text file that was created in an NAD27 zone, and the zone 
of the current drawing is an NAD83 zone, specify the NAD27 zone in the 
Point File Format dialog box. When you import the points, they are con-
verted to NAD83.

�� Select a coordinate zone you want to convert the file to and then click OK.

�� Set up the columns of the point file format by clicking the column headings, 
such as . When you click on a heading, the Format Manager - 
Select Column Name dialog box is displayed.

�� From the drop-down list, select what the column contains (based on the 
setup of your text file). For more information, see “Select Column Name Dia-
log Box” on page 274.

�� If you loaded the text file by clicking the Load button, then when you have 
finished setting up the columns, click Parse.

Depending on the option you selected in step 8, Columnated or Delimited, 
the appearance of the lower part of the dialog box changes. If you selected 
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Columnated and click Parse, then the top and bottom panes of the lower part 
of the dialog box appear as follows:
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The editable column headers are in the bottom pane, and the results of pars-
ing appear in the top pane. 

If you select Delimited and click Parse, then the top and bottom panes of the 
lower part of the dialog box appear as follows:
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The editable column headers are in the top pane, and the results of parsing 
appear in the top pane as well. The bottom pane is used only for displaying 
the contents of the file that you loaded.

You can resize the columns by positioning your cursor over a heading divider 
and dragging the divider back and forth. The resulting width defines a col-
umn in the file. You can rearrange the column headers by dragging one onto 
another.

�# Click OK to return to the Format Manager dialog box.

Creating a User Point Database Import/Export 
Format

�����	�
	�����	������
��� 	�!����
�"����
������


� From the Points menu, choose Import/Export Points ➤ Format Manager.

� Click Add.
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� Select User Point Database and click OK to display the User Point Database 
Format dialog box.

� Click Load to load the Microsoft Access file you want to import. This step is 
optional, but by loading the file, you can see the contents of the file and 
which tables are defined in the file. 

� In the Format Name box, type a name for the format.

# From the Table Name list, select the table in the Microsoft Access file that you 
want to use. If you do not see any table names listed, then click the Load but-
ton to load the .mdb file, or type the name of the table you want to use.

NOTE Microsoft Access databases can have multiple tables per .mdb file. 

$ If you are working with point data from defined coordinate zones, then select 

the Coordinate Zone Transform check box and click  to display the Select 
Coordinate Zone dialog box.

This option can transform points from one zone into another. For example, 
to import data that was created in an NAD27 zone, and the zone of the cur-
rent drawing is an NAD83 zone, specify the NAD27 zone in the User Point 
Database Format dialog box. When you import the points, they are con-
verted to NAD83.

% Select a coordinate zone you want to convert the file to and then click OK.

& Set up the columns of the user point database format by clicking the column 

headings, such as  . When you click on a heading, the Format 
Manager - Select Column Name dialog box is displayed.
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�' From the drop-down list, select what the column contains (based on the 
setup of your Microsoft Access file). For more information, see “Select Col-
umn Name Dialog Box” on page 274.

You can resize the columns by positioning your cursor over a heading divider 
and dragging the divider back and forth. You can rearrange the column head-
ers by dragging one onto another.

�� Click OK to return to the Format Manager dialog box.

Select Column Name Dialog Box

The following are possible headings in the Format Manager – Select Column 
Name dialog box. The headings that appear depend on the setup of your 
Microsoft Access file or ASCII text file.

Elevational Headings

� Elevation, for more information, see “Elevation” on page 279
� Z+, for more information, see “Z+” on page 276
� Z-, for more information, see“Z-” on page 277
� Thickness, for more information, see “Thickness” on page 277

Coordinate Value Headings

� Easting, for more information, see “Easting” on page 279
� Northing, for more information, see “Northing” on page 279
� Grid Northing, for more information, see “Grid Northing” on page 281
� Grid Easting, for more information, see “Grid Easting” on page 281

Angular Value Headings

� Longitude, for more information, see “Longitude” on page 279
� Latitude, for more information, see “Latitude” on page 280
� Degrees Longitude, for more information, see “Degrees Longitude” on 

page 281
� Minutes Longitude, for more information, see “Minutes Longitude” on 

page 281
� Seconds Longitude, for more information, see “Seconds Longitude” on 

page 281
� Degrees Latitud, for more information, see “Degrees Latitude” on page 

282
� Minutes Latitude, for more information, see “Minutes Latitude” on page 

282
� Seconds Latitude, for more information, see “Seconds Latitude” on page 

282
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� Hemisphere Longitude, for more information, see “Hemisphere Longi-
tude” on page 282

� Hemisphere Latitude, for more information, see “Hemisphere Latitude” 
on page 282

� DECDEG Longitude, for more information, see “DECDEG Longitude” on 
page 283

� DECDEG Latitude, for more information, see “DECDEG Latitude” on page 
283

� DASHED Longitude, for more information, see “DASHED Longitude” on 
page 283

� DASHED Latitude, for more information, see “DASHED Latitude” on page 
283

Miscellaneous Headings

� <unused>, for more information, see “<unused>” on page 276
� Number, for more information, see “Number” on page 280
� Name, for more information, see “Name” on page 280
� Raw, for more information, see “Raw” on page 280
� Description, for more information, see “Description” on page 280
� Full Description, for more information, see “Full Description” on page 280
� XDRef, for more information, see “XDRef” on page 278
� User Defined, for more information, see “User Defined” on page 276
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<unused>
Select the <unused> option to skip the column. For example, if your text file 
contains a column of information that you do not want to import, set the 
column heading to <unused>.

User Defined
Select the User Defined option to customize columns. If you select User 
Defined, then specify the following:

� In the User Defined Column Name, type the name of the column.

� Under Data Type, select one of the following options:

� Double: (double-precision floating-point), 8 bytes, 
-1.79769313486232E308 to -4.94065645841247E-324 for negative values; 
4.94065645841247E-324 to 1.79769313486232E308 for positive values. 
Use Double for northings, eastings, grid northings, grid eastings, and lat-
itudes and longitudes, among others. Use Double for any numbers that 
contain decimal points, including elevations.

� Long: (long integer) 4 bytes,-2,147,483,648 to 2,147,483,647. Use Long 
for point numbers.

� String: (variable length) 10 bytes + string length, 0 to approximately 2 bil-
lion. Use String for descriptions and point names.

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

� In the Precision box, type the precision value to be used.

� Click OK to return to the Point File Format dialog box.

Z+
Select the Z+ option to define a column for data that was taken at a height 
above the datum elevation. For example, if a point was measured at 10 ft. 
above the surface, then you can use the Z+ option.

The Z+ option performs calculations on the elevation. Any data that is in a 
Z+ column is added to the data in the Elevation column as the points are 
imported or transferred. For example, say a point at datum elevation is 100 
ft., and say a point was measured at 10 ft. above the datum elevation at the 
same northing and easting coordinates. By setting up a format that includes 
a column for elevation and a column for Z+, the point is assigned an eleva-
tion of 110 ft. when it is imported or transferred.

If you select Z+, then specify the following:



Creating a Point Import/Export Format | 277

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

� Click OK to return to the Point File Format dialog box.

Z-
Select the Z- option to define a column for data that was taken at a height 
below the datum elevation, such as borehole data. For example, if a point was 
measured at 10 ft. below the surface, then you can use the Z- option.

The Z- option performs calculations on the elevation. Any data that is in a Z- 
column is subtracted from the data in the Elevation column as the points are 
imported or transferred. For example, say a point at datum elevation is 100 
ft., and say a point was measured at 10 ft. below the datum elevation at the 
same northing and easting coordinates. By setting up a format that includes 
a column for elevation and a column for Z-, the point is assigned an elevation 
of 90 ft. when it is imported or transferred.

If you select Z-, then specify the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

� Click OK to return to the Point File Format dialog box.

Thickness
Select the Thickness option if your data includes surface thickness values, 
such as the thickness of a layer of topsoil or clay. 

The Thickness option performs calculations on the elevation. Any data that 
is in a Thickness column is subtracted from the data in the Elevation column 
when the points are imported or transferred. For example, say a point at 
datum elevation is 100 ft., and say the topsoil thickness is 5 ft. By setting up 
a format that includes a column for elevation and a column for Thickness, 
the point is assigned an elevation of 95 ft. when it is imported or transferred.

If you select Thickness, then specify the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

� Click OK to return to the Point File Format dialog box.
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XDRef
If you have a point file that you want to import into a project but the point 
file contains more information than what can be stored in the COGO point 
database, then set up columns in an import/export format to use XDRefs.

The COGO database can only store point number, name, elevation, descrip-
tion, northing, and easting. If you have a text file that contains additional 
information, such as engineer name and time and date, then you can send 
this data to a Microsoft Access .mdb file for storage. The text file’s point num-
ber, name, description, elevation, northing, and easting coordinates are 
imported into the COGO database, and the engineer’s name and time and 
date are imported into an .mdb file.

This Microsoft Access .mdb file must already exist, and must contain column 
definitions that have XDRefs defined for them.

You can also use the XDRef column definition on exporting points. Say you 
imported your text file that contains PNEZ data and engineer’s name and 
date into the project. On export of the same data, the PNEZ values are 
exported from the COGO point database to a text file, and the engineer’s 
name and time and date are exported from the Microsoft Access .mdb file to 
the same text file as the data from the COGO database.
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� Create a text file of point information. 

� Create a Microsoft Access .mdb file that is set up with the column headings. 
For example, if the text file of points contains PNEZ and engineer’s name and 
time and date, then set up columns for point number, engineer’s name, and 
time and date. For more information about creating Microsoft Access .mdb 
files, see “Creating an External Point Database with Microsoft Access” on 
page 173.

� Create XDRefs to the columns in the .mdb file that you want to import the 
data to. For example, engineer’s name and time and date. For more informa-
tion about creating XDRefs, see “Creating an External Data Reference 
(XDRef)” on page 175.

� Create a point file format that has columns for PNEZ and two XDRef columns 
(one for engineer’s name and one for time and date).

� Import the text file.

The PNEZ values are imported into the COGO point database and the engi-
neer’s name and time and date are imported into the Microsoft Access .mdb 
file.
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If you select XDRef, then specify the following:

� In the XDRef name list, select the XDRef that you want to store point infor-
mation in on import or export of points.

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

� In the Precision box, type the precision value to be used.

Easting
Select the Easting option to define a column for easting coordinates. 

If you select Easting, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Northing
Select the Northing option to define a column for northing coordinates. 

If you select Northing, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Elevation
Select the Elevation option to define a column for elevations. 

If you select Elevation, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Longitude
Select the Longitude option to define a column for longitudes. 

If you select Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 
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Latitude
Select the Latitude option to define a column for latitudes. 

If you select Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Number
Select the Number option to define a column for point numbers. 

If you select Number, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Name
Select the Name option to define a column for point names. 

If you select Name, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Raw
The original description of a point, before any description key substitution 
has occurred. 

Description
Select the Description option to define a column for point descriptions. 

If you select Description, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Full Description
The description of a point after any point description key substitution has 
occurred.
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Grid Northing
Select the Grid Northing option to define a column for grid northings. 

If you select Grid Northing, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Grid Easting
Select the Grid Easting option to define a column for grid eastings. 

If you select Grid Easting, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Degrees Longitude
Select the Degrees Longitude option to define a column for degrees 
longitude. 

If you select Degrees Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Minutes Longitude
Select the Minutes Longitude option to define a column for minutes 
longitude. 

If you select Minutes Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 

Seconds Longitude
Select the Seconds Longitude option to define a column for seconds 
longitude. 

If you select Seconds Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid. 
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Degrees Latitude
Select the Degrees Latitude option to define a column for degrees latitude. 

If you select Degrees Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid.

Minutes Latitude
Select the Minutes Latitude option to define a column for minutes latitude. 

If you select Minutes Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid.

Seconds Latitude
Select the Seconds Latitude option to define a column for seconds latitude. 

If you select Seconds Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid.

Hemisphere Longitude
Select the Hemisphere Longitude option to define a column for hemisphere 
longitude. 

If you select Hemisphere Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid.

Hemisphere Latitude
Select the Hemisphere Latitude option to define a column for hemisphere 
latitude. 

If you select Hemisphere Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the text file and marks that value as 
invalid.
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DECDEG Longitude
Select the DECDEG Longitude option to define a column for longitude 
expressed in decimal degrees. 

If you select DECDEG Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the point file and marks that value as 
invalid. 

NOTE Precision values for export operations are determined by the Drawing 
Setup values.

DECDEG Latitude
Select the DECDEG Latitude option to define a column for latitude expressed 
in decimal degrees. 

If you select DECDEG Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the point file and marks that value as 
invalid. 

NOTE Precision values for export operations are determined by the Drawing 
Setup values.

DASHED Longitude
Select the DASHED Longitude option to define a column for longitude 
expressed with dashes, such as 73-13-12.67.

If you select DASHED Longitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the point file and marks that value as 
invalid. 

NOTE Precision values for export operations are determined by the Drawing 
Setup values.

DASHED Latitude
Select the DASHED Latitude option to define a column for latitude expressed 
with dashes, such as 73-13-12.67.
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If you select DASHED Latitude, then do the following:

� Type a value in the Invalid Indicator box. On import, for example, the pro-
gram looks for the invalid indicator in the point file and marks that value as 
invalid. 

NOTE Precision values for export operations are determined by the Drawing 
Setup values.

Copying an Existing Import/Export Format

If you want to make variations to an existing import/export format, but you 
want to preserve the original format, you can copy the format and modify it.
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� From the Points menu, choose Import/Export Points ➤ Format Manager.

� From the list of defined formats, select the format that you want to copy.

� Click Copy to display the format in either the Point File Format or the User 
Point Database Format dialog boxes, depending on the type of format it is.

� Modify/rename the copy as needed.

Viewing an Existing Import/Export Format

If a format is not editable (for example, the formats included with Land 
Development Desktop), then you cannot modify the format. However, you 
can view the format to see how it is set up.
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� From the Points menu, choose Import/Export Points ➤ Format Manager.

� From the list of defined formats, select the format that you want to view.

� Click View to display the format in either the Point File Format or the User 
Point Database Format dialog boxes, depending on the type of format it is.
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Modifying an Existing Import/Export Format

You can modify an existing point import/export format if it is a format that 
you created yourself.

NOTE Default import/export formats cannot be modified. 
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� From the Points menu, choose Import/Export Points ➤ Format Manager.

� From the list of defined formats, select the format that you want to modify.

� Click Modify. For more information, see “Creating a User Point File Import/
Export Format” on page 268.

Removing a Point Import/Export Format

You can remove point import/export formats that you created and no longer 
need.

NOTE Default import/export formats cannot be removed. 
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� From the Points menu, choose Import/Export Point ➤ Format Manager.

� From the list of defined formats, select the format that you want to remove.

� Click Remove. 

An AutoCAD message dialog box is displayed.

� Click Yes to remove the format.
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Importing Point Data

You can import ASCII text files and custom Microsoft Access .mdb files into 
the COGO point database of the current project or into a surface folder in the 
Terrain Model Explorer to use in surface generation.

For example, a surveyor can enter point data into a data collector, and then 
create an ASCII file of that information when downloading the collector. To 
import these points into your drawing and project, you must create an 
import format for the points.

If the point data you want to import was created in a coordinate zone that is 
different from the zone of the current drawing, then you can select an option 
that performs a coordinate transformation of the point data as it is imported.

You can also specify a point group so all points are added to the group as they 
are imported.

Importing Points into the COGO Point Database

You can import points into the COGO point database from ASCII text files or 
Microsoft Access .mdb files.

NOTE On the Coords tab in the Point Settings dialog box there is an option 
to echo the points to the command line as they are created. This option does 
not apply when importing points from a file using the Import Points command.
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� Create an import/export format for the file you want to import. For example, 
to import points from a Microsoft Access database file, set up a User Point 
Database format. For more information, see “Creating a Point Import/Export 
Format” on page 267.

� From the Points menu, choose Import/Export Points ➤ Import Points to dis-
play the Format Manager - Import Points dialog box. 
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� From the Format list, select the format of the file you want to import. 

TIP Click  to access the Format Manager, where you can create new 

formats. 

� Click  next to the Source File list to display the Select Source File dialog 
box.

� Select the source file to import.

# Click Open to return to the Format Manager - Import Points dialog box.

$ Select the Add Points to Point Group check box to add the points that you 
import to a point group. If you select this check box, then do one of the 
following:

� From the list, select an existing group to which you want to add the 
points.

� Click  to create a new group for the points. The Format Manager - 
Create Group dialog box is displayed. Type the name for the group and 
click OK.

% Click the Advanced button to display advanced options.
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& Select the Do Elevation Adjustment If Possible check box if Z+, Z-, or Thick-
ness columns are set up in the import/export format, and you want eleva-
tional adjustments to occur. When this check box is selected, and Z+, Z-, or 
Thickness columns are defined in the format, then elevational calculations 
are performed on the file. For more information, see “Select Column Name 
Dialog Box” on page 274.

�' Select the Do Coordinate Transformation If Possible check box if you want 
coordinate transformations to occur. In order for coordinate transformations 
to occur, the import/export format must have a coordinate zone assigned to 
it. For example, if you are importing a point file into the COGO point data-
base, then the coordinates of the point file are transformed to match the 
zone of the current drawing.

�� Select the Do Coordinate Data Expansion If Possible check box if you are 
importing a file that contains pieces of information, such as degrees, min-
utes, seconds, and hemisphere for latitude and longitude values, and you 
want to calculate missing pieces of data based on these known pieces, such 
as grid northing and easting.

�� Click OK to display the COGO Database Import Options dialog box and then 
verify that the correct import settings are selected. For more information, see 
“Changing the COGO Database Import Options” on page 265.

�� Click OK to import the points.

NOTE You can use the Import Points command to import XDRef data from a 
MicrosoftAccess database. However, not all Microsoft Access field data types can 
be imported. All types of Number and Text fields can be imported, but Yes/No, 
Date/Time, and Currency fields cannot be imported. When exporting, there is 
no restriction. All five data types can be exported, or used as point group over-
rides, or used in point label styles.
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Exporting Point Data

When you export point data from the COGO point database, the points are 
exported to an ASCII text file. To export these points, you must create an 
export format for the points.

For example, the COGO point database stores point number, name, descrip-
tion, northing, easting, and elevation. To export only point number and ele-
vation, you must create an export format that has columns for point number 
and elevation.

In addition to exporting COGO point database information, you can also 
export grid northing, grid easting, latitude, and longitude if a coordinate 
zone and transformation settings are defined for the drawing.

You can also perform a coordinate transformation for the points as you 
export them. To export the point data so that it uses a different coordinate 
zone than the current drawing, you can select an option that performs a 
coordinate transformation of the point data as it is exported.

You can also export data to a pre-existing Microsoft Access database file. For 
more information, see “XDRef” on page 278.

Exporting Points from the COGO Point Database

You can export points from the COGO point database to ASCII text files.
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� Create an import/export format for the file you want to export to. For exam-
ple, to export only point number, northing, and easting values, set up a User 
Point File format with point number, northing, and easting columns. For 
more information, see “Creating a Point Import/Export Format” on page 
267.

� From the Points menu, choose Import/Export Points ➤ Export Points to dis-
play the Format Manager - Export Points dialog box. 
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� From the Format list, select the format of the file you want to export the 
points to. 

TIP Click  to access the Format Manager, where you can create new 
formats. 

� Click  next to the Destination File list to display the Select Destination File 
dialog box.

� Locate the drive/folder in which you want to save the exported text file.

# In the File name box, type a name for the text file you want to export the 
points to.

$ Click Save to return to the Format Manager - Export Points dialog box.

% Select or clear the Limit to Points in Point Group check box:

� Select the Limit to Points in Point Group check box to export only the 
points that are in a point group instead of the entire COGO point 
database. 

� Clear the Limit to Points in Point Group check box to export all the points 
in the COGO point database.

& If you selected the Limit to Points in Point Group box, then select the point 
group from which you want to export points from the drop-down list.

�' Click the Advanced button to display additional options.
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�� Select the Do Elevation Adjustment if Possible check box if Z+, Z-, or Thick-
ness columns are set up in the import/export format, and you want eleva-
tional adjustments to occur. When this check box is selected, and Z+, Z-, or 
Thickness columns are defined in the format, then elevational calculations 
are performed on the file. For more information, see “Select Column Name 
Dialog Box” on page 274.

�� Select the Do Coordinate Transformation if Possible check box to coordinate 
transformations to occur. In order for coordinate transformations to occur, 
the import/export format must have a coordinate zone assigned to it. For 
example, if you are exporting points to a point file, then the coordinates of 
the COGO points in the resulting ASCII file are transformed to match the 
zone assigned to the import/export format.

�� Select the Do Coordinate Data Expansion if Possible check box if you are 
exporting a file that contains pieces of information, such as degrees, minutes, 
seconds, and hemisphere for latitude and longitude values, and you want to 
calculate missing pieces of data based on these known pieces, such as grid 
northing and easting.

�� Click OK to export the points.

Transferring Points

You can transfer points between two different ASCII text files, or from a 
Microsoft Access database file to an ASCII text file. 

You can also transfer data to a pre-existing Microsoft Access database file. For 
more information, see “XDRef” on page 278.

NOTE Points that are transferred are not deleted from the source file. 
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� Create import/export formats for the files you want to transfer points 
between. For example, to transfer points from a Microsoft Access database file 
to an ASCII text file, set up a User Point Database format and a User Point File 
format. For more information, see “Creating a Point Import/Export Format” 
on page 267.

� From the Points menu, choose Import/Export Points ➤ Transfer Points to dis-
play the Format Manager - Import/Export dialog box. 

� From the Format list under Source, select the format of the file from which 
you want to transfer points.

TIP Click the Manage button to access the Format Manager, where you can 
create new formats. 

� Click  next to the Source File list to display the Select Source File dialog 
box.

� Select the source file to use and click Open to return to the Format 
Manager - Import/Export dialog box.

# Under Destination, select the format of the file you want to transfer points 
to.
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$ Click  next to the Destination File box to display the Select Destination 
File dialog box.

% Select the destination file to transfer the points to, or type a new file name, 
and click Save to return to the Format Manager - Import/Export dialog box.

& Click the Advanced button to display additional options.

�' Select the Do Elevation Adjustment if Possible check box if Z+, Z-, or Thick-
ness columns are set up in the import/export format, and you want eleva-
tional adjustments to occur. When this check box is selected, and Z+, Z-, or 
Thickness columns are defined in the format, then elevational calculations 
are performed on the file. For more information, see “Select Column Name 
Dialog Box” on page 274.

�� Select the Do Coordinate Transformation if Possible check box to coordinate 
transformations to occur. In order for coordinate transformations to occur, 
the import/export format must have a coordinate zone assigned to it. For 
example, if you are transferring a point file from one ASCII file to another, 
then the coordinates of the point file are transformed to match the zone of 
the format to which you are transferring points. 
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�� Select the Do Coordinate Data Expansion if Possible check box if you are 
transferring a file that contains pieces of information, such as degrees, min-
utes, seconds, and hemisphere for latitude and longitude values, and you 
want to calculate missing pieces of data based on these known pieces, such 
as grid northing and easting.

�� Click OK to transfer the points.

Converting Points in the COGO Database to 
a Different Coordinate Zone

You can convert the points in the COGO point database to a different zone 
by exporting the points to a file, switching the current zone of the drawing, 
and then importing the file back into the drawing.
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� Set up a export format for the points. This format must be an User Point File 
format and its columns must match the values in the COGO point database. 
For more information, see “Creating a Point Import/Export Format” on page 
267.

You must select the Coordinate Zone Transform check box and specify the 
coordinate zone for the format. This zone must be the zone you want to con-
vert the points from. For example, if the points were created in an NAD27 
zone and you want to convert them to an NAD83 zone, then specify the 
NAD27 zone as the coordinate zone for the format.

� Export the points from the COGO point database. For more information, see 
“Exporting Points from the COGO Point Database” on page 289.

� Change the COGO database import options. You should set the “What to do 
when a point is already in the point database” option to Overwrite. For more 
information, see “Changing the COGO Database Import Options” on page 
265.

� Change the current zone of the drawing to the new zone you want to use. 
For more information, see “Changing the Current Zone for a Drawing” on 
page 57.

� Import the points into the COGO point database. For more information, see 
“Importing Points into the COGO Point Database” on page 286.
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Merging a Point Database into the Current 
Point Database

You can merge points from a point database into the current point database. 
The point database that you want to merge must be a Microsoft Access .mdb 
file. 

NOTE Older versions of COGO point databases—named project.pdf—that 
were created in Autodesk S8 Civil/Survey programs, cannot be merged into the 
current database. However, you can open the older project in AutoCAD Land 
Development Desktop to convert the project.pdf file to a points.mdb file, a file 
which can be merged with the current project. 
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� From the Points menu, choose Import/Export Points ➤ Import Points to dis-
play the Format Manager - Import Points dialog box. 

� From the Format list, select the External Project Point Database format. 

� Click  next to the Source File list to display the Select Source Database 
dialog box.

� Select the points.mdb file that you want to merge into the current project 
point database. 

� Click Open to return to the Format Manager - Import Points dialog box.

# Select the Add Points to Point Group check box to add merged points to a 
point group. If you select this check box, then do one of the following:

� From the list, select an existing group to which you want to add the points.

� Click  to create a new group for the points. The Format Manager - 
Create Group dialog box is displayed. Type the name for the group and 
click OK.

$ Click OK to display the COGO Database Import Options dialog box and then 
verify that the correct settings are selected. For more information, see 
“Changing the COGO Database Import Options” on page 265.

% Click OK to merge the points into the project point database of the current 
project.
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13Editing Points

The AutoCAD Land Development Desktop point edit-

ing commands change the point data in both the draw-

ing and in the project point database. You can move, 

copy, rotate, erase, and renumber points, as well as 

change their elevations and descriptions.

In this chapter

� Editing Points

� Changing the Display 
Properties for Points in the 
Drawing

� Editing Point Data in a Dialog 
Box

� Changing the Elevations of 
Points

� Renumbering, Moving, Rotating, 
Copying, and Erasing Points

� Restoring Erased Point 
Information

� Changing the Coordinates of 
All Project Points

� Changing the Rotation of All 
Project Points
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Editing Points

Use the point editing commands to change point numbers, elevations, 
descriptions, names, and other data. There are commands you can use to 
move, erase, rotate, and copy points in both the drawing and in the point 
database. All of the point editing commands in the Points ➤ Edit Points 
menu update both the drawing and the point database with the changes that 
you make.

WARNING! If you use the AutoCAD commands like ERASE to edit drawing 
points, then the point database is not updated. Use the Modify Project com-
mand to update the point database to reflect the changes in the drawing. For 
more information, see “Updating the Project Point Database with Drawing Point 
Information” on page 193.

Changing the Display Properties for Points in 
the Drawing

You can change the point marker display properties for a selection set of 
points that already exist in the drawing. For example, you can rotate the 
points, adjust the point marker colors, display raw descriptions instead of full 
descriptions, and reset the point marker elevations in the drawing. You can 
also turn off the display of leaders, which are created when you drag point 
marker text away from the point.
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� From the Points menu, choose Edit Points ➤ Display Properties.

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the drawing.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.
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For more information about selection methods, see “Managing Points” on 
page 184.

When you have created the selection set, the Point Display Properties dialog 
box is displayed.

NOTE You can also create the selection set before using this command. Just 
select the points you want to change, right-click, and select Display Properties. 
If you select objects other than points when creating the selection set, the 
Display Properties command is not available from the shortcut menu.

� Click the Marker tab to change the appearance of the point markers. For 
more information, see “Changing the Point Marker Symbol Settings” on page 
106.

� Click the Text tab to change the appearance of point text. For more informa-
tion, see “Changing the Point Marker Text Settings” on page 107.
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� Click the Reset tab to specify whether to move marker text back to the marker 
location or to reset point elevations. 

� Under Text Location, select or clear the Move Marker Text Back to Marker 
Location check box:

� Select the Move Marker Text Back to Marker Location check box to reset 
the marker text back to its original location if you have moved it away 
from the point.
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� Clear the Move Marker Text Back to Marker Location check box to pre-
serve any changes you have made to marker text location.

� To restore the display elevations of points in the drawing that you have 
changed, under Point Elevation, select the Reset Point Elevation in Drawing 
check box. Select one of the following options:

� Select Actual Elevation to insert the points in 3D, using the actual eleva-
tions of the points stored in the point database (or the elevations from the 
XDRef if an XDRef was used for elevations). If you select this option, then 
specify an elevation to assign to points that do not have elevational data 
assigned to them in the If No Elevation, Use box.

� Select Fixed Elevation to insert the points using a fixed elevation for all 
points, and then type an elevation in the Fixed Elevation box. 

NOTE The Point Elevation settings do no affect the elevations in the point 
database, or the elevations that exist in an external database that are assigned 
by an XDRef. These settings just control how the point’s elevation is 
represented in the 3D AutoCAD drawing. 

� Click OK.

IMPORTANT In Autodesk S8 Civil/Survey, the points were always inserted 
into the drawing at an elevational value of 0, regardless of their actual 
elevations. Because of this, the DISTANCE command always reported the 
correct X,Y 2D distance between points. If you select the Actual Elevation 
check box, then the DISTANCE command (and any other command that 
reports distances) reports 3D distances.

Editing Point Data in a Dialog Box

You can edit point names, elevations, descriptions, northings, eastings, lati-
tudes, and longitudes from within a dialog box.
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� From the Points menu, choose Edit Points ➤ Edit Points to display the Edit 
Points dialog box.
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� Create a selection set of the points that you want to edit. For more informa-
tion, see “Creating Point Lists” on page 138.

NOTE When you create a selection set, point information for each point you 
selected is displayed in the Edit Points dialog box. If you click the Advanced but-
ton to use advanced point selection methods, then you can also edit the points 
on the Edit tab, or you can click the Simple button and edit the points in the list. 

� Click your pointing device in a cell to edit a point’s name, elevation, descrip-
tion, coordinates, latitude, longitude, grid northing, and grid easting.

NOTE The coordinates that are displayed for points are based on the Point 
Coordinate Display settings. For more information, see “Changing the Coordi-
nate Display Settings” on page 102.
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Changing the Elevations of Points

You can change the elevations of a group of points. This is useful when you 
have set points according to an assumed elevation datum, and then you 
transfer a benchmark elevation in at a later time.
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� From the Points menu, choose Edit Points ➤ Datum.

The following prompt is displayed:
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� Type one of the following options:

� Type a change in elevation. To specify a lower elevation, type a minus sign 
(-) in front of the value.

� Type Reference and then type the old and new datum elevations. The 
points are modified by the difference between the two values. 

The following prompt is displayed:
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� Type one of the following options to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

NOTE If there is a period (.) placemarker in the elevation for one of the points 
selected, the elevation for that point is not adjusted. 

Example: Changing the Datum Elevation of 
Points

You commonly change the datum elevation to adjust the points based on the 
actual elevation of a benchmark that was assumed in the field. For example, 
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to adjust for the 1045.67 benchmark elevation that was assumed to be 100 in 
the field, use the Reference option, as shown in the following prompts:
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The following example shows how you can also achieve the same result by 
calculating the change in elevation and entering it directly.
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Renumbering Points

You can use the Renumber command to assign new point numbers in your 
drawing.
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� From the Points menu, choose Edit Points ➤ Renumber.

� Type the point number additive factor. The additive factor increases each 
point in the selection set.

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

The Renumber command then checks for any duplication. If it finds a dupli-
cate, then the command displays the following prompts:
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� If duplicate points are located, do one of the following:

� Press ENTER to give the point the next available point number in the 
database. 

� Type Overwrite to overwrite the point. 
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Moving Points

You can move points in the drawing and automatically update the coordi-
nates for any point object in both the drawing and point database. 

������	�����
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� From the Points menu, choose Edit Points ➤ Move.

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

� Select a base point. This point acts as the reference point for the move.

� Select the second point of displacement. 

All points you selected are moved according to the displacement, and the 
point database is updated with the new coordinates.

Rotating Points

You can rotate points based on a rotation angle or reference angle for both 
drawing and project points. 
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� From the Points menu, choose Edit Points ➤ Rotate.

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
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� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing. 
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

� Select a base point for rotation.

� Type the rotation angle in DD.MMSS format.

NOTE To rotate the coordinate system, you can change the North Rotation. 

Copying Points

You can copy points from one location to another, and change the point 
elevations and layer while doing so.

������������
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� From the Points menu, choose Edit Points ➤ Copy. 

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing. 
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

� Select a base point to copy from.

� Select the point of displacement. 

The following prompt is displayed:

"#�����������$����������%�
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� Do one of the following to change the elevations of the selected points:
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� Type a change in elevation. To specify a lower elevation, type a minus sign 
(-) before the value.

� Type Reference, and then type the old and new datum elevations. The 
points are modified by the difference between the two values. 

� Type the name of the new layer, if necessary.

The command then copies the points to their new locations, layer, and/or 
elevations. Each point is numbered with the next available point number.

Erasing Points

You can erase points, which removes point information from the drawing 
and marks the point in the database as having been deleted. 

NOTE Unless you create new points using the erased point numbers, or pack 
the point database, you can restore erased points by using the Unerase com-
mand. For more information, see “Restoring Erased Point Information” on page 
308.

���	���	�����
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� From the Points menu, choose Edit Points ➤ Erase.

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing.
� Type Dialog to use filtering and advanced selection methods.

For more information about selection methods, see “Managing Points” on 
page 184.

The points are removed from the drawing, and are marked in the point data-
base file as deleted. However, you can use the Unerase command to recover 
the information if you haven’t created new points using the same point 
numbers, or packed the point database.
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To remove just the points from the drawing while keeping the point database 
intact, you can also use the Remove from DWG command. For more infor-
mation, see “Removing Points from the Drawing” on page 198.

Restoring Erased Point Information

You can restore erased points to the drawing and point database. If you 
haven’t created new points with the same numbers, or packed the point data-
base, you can recover the erased point information even if you erased it in a 
previous drawing session.
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� From the Points menu, choose Edit Points ➤ Unerase.

The following prompt is displayed:
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� Type one of the following options:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Window and then draw a selection window around the area of the 

drawing where you erased the points. This selection method selects erased 
points in the point database and restores them to the drawing.

For more information about selection methods, see “Managing Points” on 
page 184.

The command restores the erased points to the project.

Changing the Coordinates of All Project 
Points

You can change the coordinates of all project points by selecting a point in 
the drawing and then giving it a new location. This command moves all the 
other points in the project relative to this change in the base point.
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� Open the point database in single-user mode. You cannot translate the 
project points if other people have the point database open. For more infor-
mation, see “Changing the Point Database Setup Settings” on page 185.

� From the Points menu, choose Edit Points ➤ Translate Points.

The following prompt is displayed:
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� Select a reference point for the translation of coordinates. 

The following prompt is displayed:
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� Select a destination point for the translation. The distance and angle between 
the base point and the destination point controls how the points are moved. 

A warning box is displayed to warn you that this command modifies the 
entire project point database file.

� Click OK to continue the command.

The following prompt is displayed: 
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� Type Yes or No:

� Type Yes to change the base point setting of the drawing by the transla-
tion values. If you do this, then the points do not actually move in the 
drawing when the translation values are applied. 

For more information, see “Changing the Base Point for a Drawing” on page 
58.

� Type No if you do not want to change the base point setting of the 
drawing.

NOTE If you do not change the base point setting, then the drawing coordi-
nates of the points no longer match the project coordinates. You can use the 
Modify Drawing command later to reposition the drawing points to the new 
project coordinates. For more information, see “Updating the Drawing with 
Project Point Information” on page 195.

The following prompt is displayed:
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� Type Yes or No:
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� Type Yes to modify the base point of all the other drawings in the project 
the next time the drawings are opened.

� Type No if you do not want to modify the base point of all the other draw-
ings in the project. 

NOTE When you type Yes to modify the base point of the other drawings in 
the project, a <drawing name>.cor file is created for each drawing in the project. 
These files are used to update the other drawing files in the project with the 
changes you made to the base point in the current drawing. When you open 
another drawing in the project, the <drawing name>.cor file is used by the pro-
gram to automatically update that drawing with the changes to the base point. 
When you open the drawing, the changes are applied and the <drawing 
name>.cor file is deleted. If you manually delete the <drawing name>.cor file 
before opening the drawing, then the changes you made to the base point are 
not carried over to that drawing when you open it.

Changing the Rotation of All Project Points

You can modify the coordinates of all project points by rotating them about 
a base point.
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� Open the point database in single-user mode. You cannot rotate the project 
points if other people have the point database open. For more information, 
see “Changing the Point Database Setup Settings” on page 185.

� From the Points menu, choose Edit Points ➤ Rotate Points. 

The following prompt is displayed:
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� Select a base point for the rotation.

� Type the rotation angle in DD.MMSS format. This number is a clockwise 
angle from the vertical.

A warning box is displayed to warn you that this command modifies the 
entire project point database file.

� Click OK to continue the command. The following prompt is displayed:
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� Type Yes or No:
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� Type Yes to change the north rotation of the drawing so that the points 
do not move in the drawing when the rotation angle is applied.

� Type No if you do not want to change the north rotation of the drawing.

NOTE If you do not change the north rotation, then the drawing coordinates 
of the points no longer agree with the project coordinates. You can use the Mod-
ify Drawing command later to reposition the drawing points to the new project 
coordinates. For more information, see “Updating the Drawing with Project 
Point Information” on page 195.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to change the north rotation of all the drawings in the project 
the next time the drawings are opened.

� Type No if you do not want to change the north rotation of the drawings 
in the project.

NOTE When you type Yes to modify the north rotation of the other drawings 
in the project, a <drawing name>.cor file is created for each drawing in the 
project. These files are used to update the other drawing files in the project with 
the changes you made to the north rotation in the current drawing. When you 
open another drawing in the project, the <drawing name>.cor file is used by the 
program to automatically update that drawing with the changes to the north 
rotation. When you open the drawing, the changes are applied and the 
<drawing name>.cor file is deleted. If you manually delete the <drawing 
name>.cor file before opening the drawing, then the changes you made to the 
north rotation are not carried over to that drawing when you open it.
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14Creating Point Stakeout 
Reports

Stakeout reports list stake points, direction or angle, dis-

tance, northing/easting coordinates, description, and 

elevation of points. Using the Stakeout commands on 

the Points menu, you can generate stakeout reports 

based on turned or deflected angles, or you can generate 

reports by direction.

In this chapter

� Creating Point Stakeout 
Reports

� Changing the Stakeout Angle 
Type

� Changing the Settings for 
Outputting Stakeout Files

� Creating a Radial Stakeout 
Report

� Creating a Curve Stakeout 
Report by Direction

� Creating a Curve Stakeout 
Report of Offsets from Tangent

� Creating a Spiral Stakeout 
Report by Direction

� Creating a Spiral takeout 
Report of Offsets from Tangent

� Creating a Stakeout Report for 
Consecutive Points
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Creating Point Stakeout Reports

You can create several different types of stakeout reports that display the fol-
lowing information about each point:

� Stake number
� Direction or angle
� Distance
� Northing/easting coordinates
� Description and/or elevation

You can create the reports using different stakeout angle types: direction, 
turned angle right (+), turned angle left (-), deflected angle right (+), and 
deflected angle left (-).

Changing the Stakeout Angle Type

You can change the type of angle to use for creating stakeout reports. 
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� Do one of the following to display the Stakeout Settings dialog box:

� From the Points menu, choose Stakeout ➤ Stakeout Settings.
� From the Alignments menu, choose Stakeout Alignment ➤ Settings.
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, click Land Development Desktop. 
From the Settings list, select Point/Alignment Stakeout and click the Edit 
Settings button. 

� Select one of the following stakeout angle types: 
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� Turned +: turned angle right
� Turned -: turned angle left
� Deflect +: deflection angle right
� Deflect -: deflection angle left
� Direction: an angle that uses azimuths or bearings

The following illustration shows the different turned and deflected stakeout 
angle types:

�
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� Click OK to select the stakeout angle or Cancel to exit the command.

Changing the Settings for Outputting 
Stakeout Files

��������	�
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� From the Points menu, choose Stakeout Points ➤ Output Settings to display 
the Output Settings dialog box.
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For more information, see “Changing the Output Settings” on page 79.

Creating a Radial Stakeout Report

You can report stakeout data for points within a given distance of the occu-
pied point.
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.

� Change the stakeout angle type. For more information, see “Changing the 
Stakeout Angle Type” on page 314.

NOTE If you select the Direction stakeout angle, then the Stakeout commands 
do not prompt you for a backsight point. 

� From the Points menu, choose Stakeout ➤ Radial Point Stakeout.

� Type the number of the occupied point. 

� Type the number of the backsight point. 

The following prompt is displayed:
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�����������������������������������	������������

� Do one of the following to select the points:
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� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing. 
� Type Dialog to build a list of points by using filtering and advanced selec-

tion methods.

For more information about selection methods, see “Managing Points” on 
page 184.

The following prompt is displayed:

��	
���������	������� !"# ��$���%�&'%#%��

 Do one of the following to define the stakeout distance:

� Type a distance (in decimal format). All points within this distance from 
the occupied point are included in the stakeout report.

� Pick two points to define the distance.
� Press ENTER to include all points at any distance from the occupied point.

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.

Creating a Curve Stakeout Report by 
Direction

You can report stakeout data of a curve, with directions or angles as output.
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.

� Change the stakeout angle type. For more information, see “Changing the 
Stakeout Angle Type” on page 314.

NOTE If you select the Direction stakeout angle, then the Stakeout commands 
do not prompt you for a backsight point. 

� From the Points menu, choose Stakeout ➤ Curve By Direction.
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� Select the curve. For more information, see “Selecting Objects” in the 
AutoCAD User’s Guide.

The command draws an X at the point of curvature. If the X is drawn at the 
wrong end of the curve, then cancel the command and select the curve closer 
to the point of curvature.

� Type the starting station for the curve, in decimal units.

� Type the station increment. A stake location is calculated for each station 
that falls at the specified station increment.

TIP You can type additional stations at step 10 to add odd stations that are not 
covered by this increment. 

 Type the number of the occupied point.

" Type the number of the backsight point. 

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.

# Page down through the stakeout report if you selected the Page Breaks setting 
in the Output Settings. 

The following prompt is displayed:
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�$ Type the number of a station not covered by the station increment.

�� Press ENTER to end the command.

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.

Creating a Curve Stakeout Report of Offsets 
from Tangent

You can create a curve stakeout report that reports the perpendicular offset 
distances from the curve’s tangent.
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.
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� Change the stakeout angle type. For more information, see “Changing the 
Stakeout Angle Type” on page 314.

� From the Points menu, choose Stakeout ➤ Curve By Offsets.

� Select the curve. For more information, see “Selecting Objects” in the 
AutoCAD User’s Guide.

The command draws an X at the point of curvature. If the X is drawn at the 
wrong tangent’s end of the curve, then cancel the command and select the 
curve closer to the point of curvature.

� Type the starting station for the curve, in decimal units.

� Type the station increment. A stake location is calculated for each station 
that falls at the specified station increment.

TIP You can type additional stations at step 9 to add odd stations that are not 
covered by this increment. 

 Press ENTER to generate the report.

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.

" Page down through the stakeout report if you selected the Page Breaks setting 
in the Output Settings. 

The following prompt is displayed:
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# Type the number of an additional stations not covered by the station increment.

Creating a Spiral Stakeout Report by 
Direction

You can report spiral stakeout data with directions or angles as output. 
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.

� Change the stakeout angle type. For more information, see “Changing the 
Stakeout Angle Type” on page 314.
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TIP If you select the Direction stakeout angle, then the Stakeout commands do 
not prompt you for a backsight point. 

� From the Points menu, choose Stakeout ➤ Spiral By Directions.

� Select the spiral. 

For more information, see “Selecting Objects” in the AutoCAD User’s Guide.

� Type the starting station for the spiral, in decimal units.

� Type the station increment. A stake location is calculated for each station 
that falls at the specified station increment.

TIP You can type additional stations at step 9 to add odd stations that are not 
covered by this increment. 

 Type the number of the occupied point.

" Type the number of the backsight point.

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.

# Page down through the stakeout report if you selected the Page Breaks setting 
in the Output Settings. For more information, see “Changing the Settings for 
Outputting Stakeout Files” on page 315.

The following prompt is displayed:
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�$ Type the number of a station not covered by the station increment.

�� Press ENTER to end the command.

Creating a Spiral Stakeout Report of Offsets 
from Tangent

You can create a spiral stakeout report that reports the perpendicular offset 
distances from the spiral’s tangents.
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.
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� Change the stakeout angle type. For more information, see “Changing the 
Stakeout Angle Type” on page 314.

� From the Points menu, choose Stakeout ➤ Spiral By Offsets.

� Select the spiral. 

For more information, see “Selecting Objects” in the AutoCAD User’s Guide.

� Type the starting station for the spiral, in decimal units.

� Type the station increment. A stake location is calculated for each station 
that falls at the specified station increment.

TIP You can type additional stations at step 8 to add odd stations that are not 
covered by this increment. 

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.

 Page down through the stakeout report if you selected the Page Breaks setting 
in the Output Settings. 

The following prompt is displayed:
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" Type the number of a station not covered by the station increment.

# Press ENTER to end the command.

Creating a Stakeout Report for Consecutive 
Points

You can report stakeout data between consecutive points. A consecutive 
stakeout differs from a radial stakeout in that each point in the range 
becomes the occupied point.
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.

� Change the stakeout angle type. For more information, see “Changing the 
Stakeout Angle Type” on page 314.
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NOTE If you select the Direction stakeout angle, then the Stakeout commands 
do not prompt you for a backsight point. 

� From the Points menu, choose Stakeout ➤ Consecutive Stakeout. 

� Type the number of the occupied point.

� Type the number of the backsight point. 

The following prompt is displayed:
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� Do one of the following to select the points:

� Type All to select all the points in the project.
� Type Numbers to specify point numbers or names.
� Type Group to specify a point group.
� Type Selection and then select the points from the drawing. This option 

only selects points that are visible in the drawing. 
� Type Dialog to build a list of points by using filtering and advanced selec-

tion methods.

The text window displays the stakeout information if you selected the Screen 
option from the Output Settings, or the data is saved to a file if you selected 
the File option.
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15Point Utilities

When you want to find out which point numbers are 

available to use, where points are located in a drawing, 

what the grid northing and easting or latitude and lon-

gitude of a point is, use the point utilities. If you are 

upgrading from Autodesk S8 Civil/Survey, then you 

can replace Softdesk point blocks with COGO point 

objects. You can convert AutoCAD point nodes to 

COGO points, and pack the point database to remove 

unused point records.

In this chapter

� Point Utilities

� Displaying Which Point 
Numbers are Available to Use

� Displaying the Locations of 
Points in the Project

� Zooming to a Point Number

� Zooming to the Point Extents

� Drawing the Point Extents

� Replacing Softdesk Point Blocks

� Converting AutoCAD Points to 
COGO Point Objects

� Packing the Point Database

� Using the Geodetic Calculator
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Point Utilities

Use the point utilities to remove unused and deleted points from the point 
database, to replace old Softdesk point blocks with new COGO point objects, 
to zoom to points, to calculate geodetic values, and more.

Displaying Which Point Numbers Are 
Available to Use

You can display the point numbers that are available to use in the current 
project. 
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� From the Points menu, choose Point Utilities ➤ List Available Point #.

The command line lists the point numbers that have not yet been used. If 
point numbers are available above the highest point number, then the com-
mand displays a plus sign (+). For example, if the command line displays 49, 
54+, then it means that point number 49 has not been used, nor have point 
numbers 54 and above.

Displaying the Locations of Points in the 
Project

You can easily view the locations in your drawing that correspond to the 
points in the project point database.
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� From the Points menu, choose Point Utilities ➤ Quick View.

The program places X's in the drawing for each point in the project point 
database, based on the coordinates of each point.

To redraw the display and erase the X’s, use the AutoCAD REDRAW 
command.
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Zooming to a Point Number

You can change the view of a drawing so that the coordinates of a selected 
point number are located in the center of the screen. 
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� From the Points menu, choose Point Utilities ➤ Zoom to Point.

� Type the point number to zoom to. 

WARNING! The actual point does not have to be inserted in the current 
drawing; however it must exist in the project point database. 

The following prompt is displayed:
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This height defaults to the current zoom level of the drawing and represents 
the size in drawing units.

� Do one of the following to specify the zoom height:

� Press ENTER to accept the current zoom level.
� Type a larger number to zoom out.
� Type a smaller number to zoom in. 

Zooming to the Point Extents

You can zoom to the extents of the points in the project point database. This 
command is useful for quickly returning to the extents of the project. It also 
makes it easy to quickly establish the extents of the current project when 
starting a new drawing. This command ignores AutoCAD objects that are in 
the drawing. 
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� From the Points menu, choose Point Utilities ➤ Zoom to Extents.
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Drawing the Point Extents

You can draw a polyline boundary that is based on the minimum and maxi-
mum point database coordinates, indicating the extents of the points in the 
project point database. You can use this as an option to see the extents of the 
points, without importing them.
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� From the Points menu, choose Point Utilities ➤ Draw Extents.

The command draws a polyline around the extents of the points in the 
project point database. 

TIP You can use the AutoCAD ZOOM command to zoom to the extents of the 
drawing and to see the limits of all objects in the drawing.

Replacing Softdesk Point Blocks

If you are upgrading from Autodesk S8 Civil/Survey programs, or earlier ver-
sions of Softdesk Civil/Survey programs, then you can use the Replace 
Softdesk Point Blocks command to replace old point blocks with COGO 
point objects. This command searches the drawing for old point blocks 
(named POINT), reads the point numbers out of them, and then deletes the 
old blocks and any associated description key symbols. The command inserts 
new COGO points. 

If the old point block is out of position, then you need to run the Check 
Points command to rectify this before you run the Replace Softdesk Point 
Blocks command. 
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� Select the current point label style. For more information, see “Selecting the 
Current Label Style” on page 529. 

� Select the Use the Current Point Label Style When Inserting Points check box 
on the Insert tab of the Point Settings dialog box. For more information, see 
“Changing the Point Insertion Settings” on page 98.

NOTE The previous two steps are optional if you select the Replace Directly 
option in step 4. 



Replacing Softdesk Point Blocks | 329

� From the Points menu, choose Point Utilities ➤ Replace Softdesk Point 
Blocks to display the POINT Block Replacement dialog box.

 Click one of the following options:

� Click Replace Directly to replace the point blocks with COGO point 
objects that contain only the information in the current point block. If 
you select this option, then the points are not labeled as they are replaced, 
nor does description key substitution occur. Points are inserted with the 
current point marker settings.

� Click Delete and Reinsert to replace the point blocks with COGO point 
objects using the current label style and description key settings. 

� Click Cancel to cancel the command.

! Select the Softdesk point blocks you want to replace and press ENTER.

The command replaces the blocks with point marker text or with a point 
label, depending on which option you chose.

If the point blocks you select do not match the data in the point database, 
for example, if they have been moved, then a message dialog box is displayed 
that contains one of the following messages:

� Some Drawing Point Blocks selected are not in the database. Run Check 
Points to add them before replacing.

� Some Drawing Point Blocks selected disagree with the database. Run 
Check Points to correct before replacing them.

Use the Check Points commands to reconcile the differences between the 
drawing and the point database, and then run the Replace Softdesk Point 
Blocks command again.
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Converting AutoCAD Points to COGO Point 
Objects

If you have AutoCAD point nodes in a drawing, then you can convert those 
points to COGO point objects. By converting AutoCAD point nodes to 
COGO point objects, the points can have information associated with them, 
such as elevation, point number, and description. This information is also 
stored in an external point database that can be accessed by multiple people 
working over a network. An additional benefit is that after the points are con-
verted to COGO points, you do not need to keep the points in your drawing. 
Instead, you can insert the project points into the drawing as required.

NOTE All points that you create by using the Points menu (and all other 
AutoCAD Land Development Desktop commands that create points) are auto-
matically COGO point objects. 
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� Change the Point Settings. For more information, see “COGO Points” on 
page 90.

� From the Points menu, choose Point Utilities ➤ Convert from AutoCAD 
Points.

� Select the AutoCAD point node(s) that you want to convert.

 Type the description for the point, or type a period to skip the description.

The point is converted to a COGO point object, and the elevation of the 
AutoCAD point node automatically becomes the elevation of the COGO 
point. The points are added to the point database, points.mdb.

Packing the Point Database

To remove the records of unused and erased points from the project point 
database, you can pack the point database. 

WARNING! Erased points can be recovered by using the Unerase command, 
but packing the point database removes all deleted points from the point data-
base so they can no longer be recovered.
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� From the Points menu, choose Point Utilities ➤ Pack Point Database.

A prompt similar to the following is displayed:
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� Type Yes to delete the point records.

If you type Yes to delete the points, then a warning dialog box is displayed, 
informing you that all deleted and empty points from the point database are 
about to be deleted.

� Click OK to continue.

Using the Geodetic Calculator

You can use the geodetic calculator to calculate the latitude and longitude or 
grid northing and grid easting of a point by specifying local northing and 
local easting coordinates. You can also calculate the local northing and east-
ing coordinates by specifying latitude and longitude or grid northing and 
easting coordinates. You can create a point in your drawing based on the 
coordinate values you calculate using the geodetic calculator.
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� Set the current zone. For more information, see “Changing the Current Zone 
for a Drawing” on page 57.

� Define the Transformation Settings. For more information, see “Changing 
the Geodetic Zone Transformation Settings” on page 81.

NOTE The transformation settings do not have to be applied to the drawing 
in order to use the geodetic calculator. However, if they are not set then you can 
only view grid northing and easting and latitude and longitude values in the 
calculator. 

� From the Points menu, choose Point Utilities ➤ Geodetic Calculator to dis-
play the Geodetic Calculator dialog box.
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The Zone Description is listed at the top of the dialog box. The Scale Factor 
and Convergence angle are listed at the bottom of the dialog box, and are cal-
culated based on the point location within the current zone.

Two notes are displayed above the dialog box buttons. These notes can vary 
depending on what settings you specify in the Transformation Settings dia-
log box. For example, if you select the option to apply a sea level scaling fac-
tor in the Transformation Settings, then the first note says Sea level correc-
tions WILL be applied to Local Coordinates. If you clear the option, then the 
note says Sea level corrections WILL NOT be applied to Local Coordinates 
and the text is grayed out. When Transformation Settings are active for the 
drawing, the second note says Grid scale factor WILL be applied to local coor-
dinates. If you turn off the Transformation Settings, then the note says Grid 
scale factor WILL NOT be applied to local coordinates and the text is grayed 
out.

 Do one of the following to calculate values:

� Type a COGO point number in the Point # box to obtain the local coordi-
nates from the point database and to calculate the grid northing and east-
ing and the latitude and longitude. 

� Click the Select button and select a COGO point number in the drawing. 
This option has the same effect as typing a point number.

� Type a known Latitude and/or Longitude to calculate the grid and local 
northings and eastings.

� Type a known Grid Northing and/or Grid Easting to calculate the latitude 
and longitude and the local northing and easting. 
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� Type a known Local Northing, Local Easting, or Local Elevation to calcu-
late the latitude and longitude and the grid northing and easting 
coordinates.

NOTE If you clear the Apply Sea Level Scale Factor check box in the 
Transformation Settings dialog box, then the Local Elevation box is grayed 
out. 

! Click the Set Point button to create a new point in your drawing based on the 
local coordinates that you calculated.

' Click OK to exit the dialog box.
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16Drawing Lines

You can use the Line commands to draw and manipu-

late lines in the drawing. These commands draw lines in 

a variety of methods: by point numbers, in a specific 

direction, and by best fitting the line between points. 

You can also extend a line using the Line commands.

In this chapter

� Drawing Lines, Curves, and 
Spirals

� Drawing Lines
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Drawing Lines, Curves, and Spirals

To draw lines, curves, spirals, and special lines use the Lines/Curves com-
mands. You can use these commands to draw basic geometry that you can 
later define as alignments, parcels, or breaklines. When using these com-
mands to draw objects off of existing objects, tangency is guaranteed.

Although you can use the AutoCAD LINE or ARC commands to draw simple 
lines and curves, these commands provide more complex routines such as 
Line By Definition which is good for traversing. A set of Special Line symbols 
is included that you can use to draw lines and curves that use symbol 
linetypes.

Attaching Multiple Curves, Lines, and Spirals to 
Objects

To attach multiple lines, curves, or spirals from the end of any previously 
drawn object, use the Attach Multiple command on the Lines and Curves 
menu. The elements of this command have been included as separate com-
mands in the Lines, Curves, and Spirals menus. In other words, if you only 
need to draw a curve, then use one of the commands in the Curves menu and 
similarly for lines and spirals. 

Attaching a Line to an Object
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� Select an object in the drawing.

� From the Lines and Curves menu, choose Attach Multiple.

� At the command prompt, type T to attach a tangent.

� Enter the length of the new line section.

� Press ENTER to exit the command.

Attaching a Curve to an Object
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� Select an object in the drawing.

� From the Lines and Curves menu, choose Attach Multiple.

� Select the object nearest the end to which the new object(s) are to be 
attached.

� At the command prompt, type A to attach an arc.
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� Specify one of the following types of entries to use:

� Point: draws the curve through a selected point. Select a point and enter 
the chord length.

� Radius: draws the curve based on the radius or degree of curve. Enter the 
radius at the prompt, or type D and enter a degree of curve. When drawing 
a curve, specifying a positive radius or degree of curve draws the curve 
clockwise or to the right of the starting angle, whereas a negative radius or 
degree of curve draws the type curve counterclockwise or to the left.

After you enter the radius, the following prompt is displayed:
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� Do one of the following:

� Type Tan, then type the tangent length.
� Type Chord, then type the chord length.
� Type Delta, then type the delta angle.
� Type Length, then type the curve length.
� Type External, then type the external secant.
� Type Mid, then type the Middle Ordinate Distance.

All choices prompt for the value of the variable specified. After you define a 
curve with either the Point or Radius option, the curve data is displayed and 
the curve is drawn.

Attaching a Spiral to an Object
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� Select an object in the drawing.

� From the Lines and Curves menu, choose Attach Multiple.

� Select the object nearest the end to which the new object(s) are to be 
attached.

� At the command prompt, type S to attach a spiral.

� Select one of the following spiral types. The command uses the spiral type 
that you set with the Spiral Type command, but it also uses an additional spi-
ral type to link the spiral to the line segment.

� Compound: To draw the spiral from one curve to another.
� Incurve: To draw the spiral from a tangent to a curve.
� Outcurve: To draw the spiral from a curve to a tangent.
� Point: To draw the spiral from a tangent to a specified point.

� At the prompt, type the length and radius of the spiral or the degree of curve.
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The command displays the spiral data and draws the spiral.

The starting angle of the curve is specified by the closing angle of the line or 
curve you are attaching it to. If you attach a spiral to a curve or if you attach 
a curve to a curve or a spiral, the default value for the radius is the radius of 
the existing curve or spiral.

Drawing Lines

You can use the Line commands to draw lines between points or locations 
determined by direction or angle.

Drawing a Line by Selecting Start and End Points

You can draw a line by selecting locations, entering COGO point numbers, 
or entering coordinates. 
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� From the Lines/Curves menu, choose Line.

� Select the first point of the line.

� Continue to select points to draw the line. 

NOTE Type Undo to undo the last segment of the line. 

� When you are ready to finish the line, do one of the following:

� Press ENTER to end the line at the last selected point.
� Type C to unite the end of the last line segment drawn to the start point, 

which is called closing the line.

The following illustration shows a line drawn by point selection:
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Drawing a Line Using a Range of COGO Points

You can draw a line or curve—or a combination of both—between several 
COGO point numbers. 
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� From the Lines/Curves menu, choose By Point # Range. 

� Type the number of the point at which you want to start the line.

� Type a hyphen (-).

� Type the number of the point at which you want to end the line segment. 
For example: 
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NOTE You can also draw curves using this command. For more information, 
see “Drawing a Curve with a Fixed Radius and Start Point” on page 340 and 
“Drawing a Curve with Two Fixed Endpoints and a Variable Radius” on page 
341.

� Press ENTER to end the line at the last selected point.

The following illustration features a line and curve drawn by entering a range 
of point numbers:
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Drawing a Line Using Individual Point Numbers 
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� From the Lines/Curves menu, choose By Point # Range. 

� Type the number of the point at which you want to start the line.
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� Type each point number to use in the range, and separate each number with 
a comma. For example: 
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� Press ENTER to end the line at the last selected point.

NOTE You can use any combination of these methods to draw the lines and 
curves. At any time you can press ENTER to end the line/curve. 

Drawing a Line Using Individual Point Numbers 
and a Range of Point Numbers
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� From the Lines/Curves menu, choose By Point # Range. 

� Type the number of the point at which you want to start the line.

� Do one of the following:

� To draw part of the line through a discontinuous sequence of points, type 
each point number to use in the range, and separate each number with a 
comma. For example: 
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� To draw part of the line through a continuous sequence of points, type the 
beginning and end point numbers for the sequence, separated with a 
hyphen. For example:
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NOTE You can also draw curves using this command. For more 
information, see “Drawing a Curve with a Fixed Radius and Start Point” on 
page 340 and “Drawing a Curve with Two Fixed Endpoints and a Variable 
Radius” on page 341.

� Press ENTER to end the line at the last selected point.

Drawing a Curve with a Fixed Radius and Start 
Point
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� From the Lines and Curves menu, choose By Point # Range.
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� At the command prompt, type C.

� Type the point number that you want to use as the fixed radius point.

� Type R or L:

� Type R to specify a right or clockwise curve.
� Type L to designate a left or counterclockwise curve. 

For example, for a clockwise curve, type:
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In this example, the command draws a line from point 12 to 13. Next, it 
draws a curve from point 13 to point 15 (to the right) using point 14 as the 
radius point. The command then draws a line to point 16. 

For a counter-clockwise curve, type:
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NOTE When you use this command to draw a curve, the curve’s start point 
and radius point are held. Therefore, the end point might not be exact if the 
numbers you entered are not geometrically correct. 

Drawing a Curve with Two Fixed Endpoints and a 
Variable Radius
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� From the Lines and Curves menu, choose By Point # Range.

� At the command prompt, type F.

� Type the point number that you want to use as the variable radius point.

� Type R or L:

� Type R to specify a right or clockwise curve.
� Type L to designate a left or counterclockwise curve. 

For example, for a curve to the left, type:
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For a curve to the right, type:
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In the second example, the command draws a curve from point 13 to point 
15, using point 14 as the radius point. However, because points 13 and 15 are 
fixed, the radius point varies if it is not geometrically correct.
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Drawing a Line by Defining a Direction

You can draw a line from a start point to another point in a direction deter-
mined by either azimuth, bearing, point numbers, or screen picks and 
distance.
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� From the Lines/Curves menu, choose By Direction.

� Select a start point for the line.

The following prompt is displayed:
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� To define the direction, do one of the following:

� To use a bearing, type a quadrant number. For more information, see 
“Defining a Line by Bearing” on page 342.

� To use an azimuth, type azimuth. For more information, see “Defining a 
Line by Azimuth”.

� To use point selection, see “Defining a Line by Point Selection”.

The following illustration depicts using screen picks to define the direction 
and distance of the line:
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Defining a Line by Bearing
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� Complete steps 1–3 of “Drawing a Line by Defining a Direction” on page 342.

� Type the bearing.

� Type the distance for the line.

The following illustration shows a line drawn by bearing to define the direc-
tion and distance:
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Defining a Line by Azimuth

������	
�����	
������%	"���

� Complete steps 1–3 of “Drawing a Line by Defining a Direction” on page 342.

� Type the azimuth.

� Type the distance for the line. 

The following illustration shows a line drawn using an azimuth to define the 
direction:
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Defining a Line by Point Selection
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� Complete steps 1–3 of “Drawing a Line by Defining a Direction” on page 342.

� To define the direction of the line, do one of the following:

� Type two COGO point numbers to define the direction of the line. 
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� Click locations in the drawing to define the direction of the line. These 
can be either COGO points or any random location in your drawing. 

� Type the distance for the line.

The following illustration shows a line drawn by point numbers:
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Drawing a Line by Turned or Deflection Angle

You can draw a line at a turned or deflection angle from a reference line that 
exists in your drawing.
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� From the Lines/Curves menu, choose By Turned Angle.

The following prompt is displayed:

������������
����1���!��

� To select the reference line (or baseline) from which the angle is turned or 
deflected, do one of the following:

� Click the reference line near the end you want to draw the new line from. 
The end nearest to the point you clicked on is marked with an X. This is 
the point from which the new line is drawn.

� Type Points and then select the start and end point of the reference line. 
The first point you select is marked with an X. This is the point from 
which the new line is drawn.

� Select the type of angle measurement to use, Deflection or Turned. 

� Type the angle in decimal form in degrees, minutes, and seconds (DDMMSS). 
If you are working in grads, then enter the angle as a decimal. 

� Type a positive angle to draw the line segment clockwise from the refer-
ence line.

� Type a negative angle to draw the line segment counterclockwise from the 
reference line.
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� Enter the distance of the line by either typing a distance or selecting two 
points or locations. 

� Do one of the following:

� Continue drawing another line from the end of the line you just drew.
� Press ENTER to start a new line.
� Press ENTER repeatedly to exit the command. 

The following illustration shows a line drawn by turned or deflection angle:
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Drawing a Line by Station and Offset

You can draw lines using station and offset information for a defined align-
ment. You can either draw a line that runs along the alignment (by specifying 
one offset value for a succession of stations), or draw a line perpendicular to 
the alignment (by specifying multiple offsets per station). 

�����������	
���������	�
��
��������

� Draw and define an alignment. For more information about alignments, see 
“Alignments” on page 425.

� From the Lines/Curves menu, choose By Station/Offset.

The following prompt is displayed:
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� Type the number of the station where you want to begin the line. 

The following prompt is displayed:
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� Type the offset value:

� Type a positive offset value to set the point to the right of the alignment 
based on station progression.
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� Type a negative offset value to set the point to the left of the alignment 
based on station progression.

The following prompt is displayed:
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� Do one of the following:

� Press ENTER to return to the Enter Station prompt, and then type the next 
station and offset to draw the line along the alignment.

� Type another offset value to draw the line perpendicular (or radial) to the 
alignment. 

The following illustration shows lines drawn by station and offset that run 
along the alignment:

�	
������
��������	�
��
������������"��
���	�
"�
��

Extending or Shortening a Line by a Specified 
Distance

You can lengthen or shorten a line by a specified distance. 
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� From the Lines/Curves menu, choose Line Extension.

� Select the line that you want to extend or shorten near the end you want to 
adjust. 

The following prompt is displayed:
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� To define the length of the line, do one of the following:
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� Select two locations to specify the length that you want to add to the line.
� Type a positive distance to extend the line.
� Type a negative distance to shorten the line.
� Type T and then enter the total length of the segment. You can either type 

the new total length, or select two locations to define the total length. 
This total length can be greater than (to lengthen the line), or smaller than 
(to shorten the line), the current length of the line.

The following illustration shows how to extend the length of a line:
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Drawing Lines from the Ends of Objects

You can draw a line off the end of a curve, spiral, or another line. However, 
you cannot draw lines from blocks or inserts. The new line is drawn as a sep-
arate object on the current layer using the orientation of the selected object. 
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� From the Lines/Curves menu, choose From End Of Object. 

The following prompt is displayed:
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� Do one of the following:

� Select the object.
� Type PO and select points to define the object.

The following prompt is displayed:
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� Do one of the following:

� Type the length of the line you want to draw.
� Select the end point of the line.
� Type .P and a COGO point number at which to end the line. 
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NOTE You can press F2 to see the information about the line in the text 
window. 

The following illustration shows a line drawn from the end of a curve:
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Drawing a Best Fit Line Through Selected Points

You can draw a line that passes between a range of points using the method 
of Least Squares Adjustment. Least squares adjustment averages out the error 
between the point numbers. For example, you can draw a property line 
through points that were surveyed as edges of the property line. The Best Fit 
line averages out the error between the points to create the most accurate line 
possible. 
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� From the Lines/Curves menu, choose Best Fit Line.

The following prompt is displayed:
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� To select the points, do one of the following:

� Type Selection and then select the COGO point objects. You can use a 
window or crossing selection to help you select the points. These must be 
COGO points that exist in the drawing.

� Type Number and then type the COGO point numbers to draw the line 
between. 

To draw part of the line or curve through a discontinuous sequence of 
points, type each point number to use in the range, and separate each 
number with a comma. For example: 
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To draw part of the line or curve through a continuous sequence of points, 
type the beginning and end point numbers for the sequence, separated 
with a hyphen.
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� After you complete the selection set, press ENTER.

After you select all the COGO points, the text window displays the point 
number, assigned error, perpendicular offset to line, and northing/easting 
coordinates of the points on the line for each point. 

The following prompt is displayed:
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� Do one of the following:

� Type 1 to remove points from the list. For more information, see “Remov-
ing Points from the List for the Best Fit Line” on page 349.

� Type 2 to change the assigned error. For more information, see “Changing 
the Assigned Error of the Best Fit Line” on page 350.

� Type 3 to add points to the line. For more information, see “Adding Points 
to the Best Fit Line” on page 351.

� Type 4 to draw the line. For more information, see “Drawing the Best Fit-
ting Line” on page 351.

� Press ESC to exit the command.

The following illustration shows a best fit line:
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Removing Points from the List for the Best Fit Line
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� Complete steps 1–3 of “Drawing a Best Fit Line Through Selected Points” on 
page 348.
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� Type 1 to remove points.

� Type the number of the COGO point to remove from the list. 

The command displays an updated list and then displays the Press a key 
prompt again.

Changing the Assigned Error of the Best Fit Line
You can change the error value assigned to each point in a best fitting line by 
assigning either all points an equal error value (which gives each point equal 
weight when calculating the line) or different error values. Points with 
smaller errors are weighted more than points with larger errors. 

The program assigns all points you selected for the best fit line an error of 1. 
However, you can assign an error value between 0 and 1000 units to any 
point. You can hold a point (the line is drawn through that point) by assign-
ing it an error of zero (0).
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� Complete steps 1–3 of “Drawing a Best Fit Line Through Selected Points” on 
page 348.

� Type 2 to change the assigned error.

The following prompt is displayed:
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� To determine which points to adjust, type Individual or All:

� Type Individual and then at the following prompts, type the COGO 
point number and the new error: 

����������4�������� ������������������������2�
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� Type All to enter new errors for all the points, and then at the following 
prompts, type the new error or press ENTER to accept the default error 
value:
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This example shows that points 3 and 4 are accurate to one unit. Point 2 is 
accurate to one tenth of a unit. Entering a zero (0) error for point 1 holds this 
point.

The command displays an updated list and then the Press a key prompt 
again.
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Adding Points to the Best Fit Line
You can add more COGO points to your selection set for calculating the best 
fitting line.
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� Complete steps 1–3 of “Drawing a Best Fit Line Through Selected Points” on 
page 348.

� Type 3 to add points to the line.

� Enter the points.

The command displays an updated list and then the Press a key prompt 
again.

Drawing the Best Fitting Line
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� Complete steps 1–3 of “Drawing a Best Fit Line Through Selected Points” on 
page 348.

� Type 4 to draw the line.

� Press ENTER or SPACEBAR to continue. 

The command displays the text window and the Press a key prompt again.

� Do one of the following:

� Continue to edit the point list or the weighting factors. 
� Press ESC to exit the command.

Drawing a Line Tangent to a Line or Curve

You can draw a line tangent to a line, curve, or spiral. If you draw a line tan-
gent to a line, then the command draws the line as an extension of the first 
line segment. You can achieve similar results using the Line Extension com-
mand. For more information, see “Extending or Shortening a Line by a Speci-
fied Distance” on page 346.
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� From the Lines/Curves menu, choose Tangent.

� Select the line or curve. 

When you select the line or curve object, the program marks it with an X at 
the end closest to the point where you selected it.

� Select a location from which the line is drawn. 
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This location does not have to be on the object itself, but must be adjacent 
to it. If this location is not on the object, then the command draws the line 
from the perpendicular or radial point on the object.

� Select the second location.

The distance between the first location and this location defines the tangent 
length. The command automatically calculates tangency to the curve.

The following illustration shows a line drawn tangent to a line or curve:
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Drawing Lines Radial or Perpendicular to an 
Object

You can draw a line perpendicular to another line or radial to a curve or spiral 
section.
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� From the Lines/Curves menu, choose Perpendicular.

� Select the object from which to draw the line.

When you select the object, the program marks it with an X at the end closest 
to the point where you selected it.

� Select a location on the object to specify the start point of the line.

This location does not have to be on the object, but must be adjacent to the 
object. If this location is not on the object, then the command draws the line 
from the perpendicular or radial point on the object.

� Select another location to define the endpoint of the line.

The distance between the two locations defines the line length.

The following illustration shows radial and perpendicular lines:
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17Drawing Curves

The Curve commands are used to draw curves. You can 

draw a curve between two tangents, a curve off of a tan-

gent, a reverse or compound curve, a concentric curve, 

or a best fit curve using the method of least squares.

In this chapter

� Working with Curves



356 | Chapter 17 Drawing Curves

Working with Curves

Using the Curve commands, you can draw many different types of curves, 
including curves between tangents, reverse or compound curves, and best fit-
ting curves between points.

Drawing a Curve Between Two Lines
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� From the Lines/Curves menu, choose Curve Between Two Lines.

� Select the first tangent.

� Select the second tangent. 

The following prompt is displayed:
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� Enter one of the following options to define the curve:

� Length: For more information, see “Defining a Curve by Length” on page 
357.

� Tangent: For more information, see the “Defining a Curve by Tangent 
Length” on page 357.

� External (Secant): For more information, see “Defining a Curve by Exter-
nal Secant” on page 357.

� Degree: For more information, see “Defining a Curve by Degree of 
Curve” on page 357.

� Chord: For more information, see “Defining a Curve by Chord Length” 
on page 358.

� Mid (Middle Ordinate Distance): For more information, see “Defining a 
Curve by Middle Ordinate Distance” on page 358.

� MDist (Minimum Distance): For more information, see “Defining a 
Curve by Minimum Distance” on page 358.

� Radius: For more information, see “Defining a Curve by Radius” on page 
359.

The following illustration shows a curve drawn between two lines, breaking 
the tangents:
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Defining a Curve by Length
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Length to define the curve by length.

� Specify the length of the curve by either typing a value or using your point-
ing device to select two points.

Defining a Curve by Tangent Length
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Tangent to define the curve by tangent length.

� Specify the tangent length by either typing a value or using your pointing 
device to select two points.

Defining a Curve by External Secant
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type External to define the curve by external secant.

� Specify the external secant by either typing a value or using your pointing 
device to select the secant.

Defining a Curve by Degree of Curve
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Degree to define the curve by degree of curve.
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The following prompt is displayed:
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� To specify how the curve is defined, type Chord or Arc:

� Type Chord if the curve is a railway curve. For a railway curve, the degree 
of curve is the angle at the center of a circular curve subtended by a chord 
of 100 units.

� Type Arc if the curve is a roadway curve. For a roadway curve, the degree 
of curve is the central angle subtended by a circular arc of 100 units.

� Type the degree of curve in DD.MMSS format.

Defining a Curve by Chord Length
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Chord to define the curve by chord length.

� Specify the chord length by typing a value or by selecting two points with 
your pointing device.

Defining a Curve by Middle Ordinate Distance
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Mid to define the curve by the middle ordinate distance.

� Specify the middle ordinate distance by either typing a value or using your 
pointing device to select two points.

Defining a Curve by Minimum Distance

You can draw a curve between two lines that are a minimum distance from 
an existing curve in your drawing. 
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Mdist to define the curve by minimum distance.

� Select the end of an existing curve. 

The command sets the Object Snap to END for this prompt. The point you 
select does not have to be on an existing curve; it can be any point along the 
adjacent tangent. 
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� Enter the minimum distance between the end of the new curve and the point 
selected on the existing curve.

For example, if you need a minimum distance of 200 feet from the end of a 
curve to an intersection, then select the intersection at step 3. At step 4, type 
200. The command calculates a curve ending 200 units from the 
intersection.

Defining a Curve by Radius
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� Complete steps 1–3 of “Drawing a Curve Between Two Lines” on page 356.

� Type Radius to define a curve by radius.

� Specify the radius by either typing a value or using your pointing device to 
select two points.

Drawing a Curve on Two Lines 

You can join two lines to create a curve and leave the lines intact. 
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� From the Lines/Curves menu, choose Curve On Two Lines.

� Select the first line. 

� Select the second line.

� Specify the radius by either typing a value or using your pointing device to 
select two points.

NOTE If the computed curve is too large for the selected lines, an error mes-
sage is displayed. Select the lines again and enter a smaller radius. 

If you define this curve as part of an alignment, then you can station the 
alignment along the curves and not through the point of intersection. To sta-
tion the alignment along the curves and not through the point of intersec-
tion, break the tangent before you define the alignment. To do this, use the 
BREAK command as follows:
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The at symbol (@) indicates that the second point is the same as the first. This 
breaks the line at that single point without removing any of the line.

The following illustration shows a curve drawn on two lines:
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Drawing a Curve Through a Point

You can draw a curve between two tangents that passes through a selected 
point. 
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� From the Lines/Curves menu, choose Curve Through Point. 

� Select the two tangents from which the curve is drawn.

� Select the point through which the curve is drawn. 

The curve is drawn and information about the curve is listed at the command 
line.

The following illustration shows a curve drawn through a point:
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Drawing Multiple Curves

You can draw multiple curves between lines. You can use this command as 
an alternative to designing alignment curves with spiral sections. This com-
mand has a limit of ten curves. 

���������	�������	�
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� From the Lines/Curves menu, choose Multiple Curves.

� Select the two lines from which the curves are drawn.

� Type the number of curves to draw between the lines. 

� Specify which curve will have the floating length. One curve in the set must 
have a floating length. This is usually the middle curve. 

The command prompts you to enter the radius and length of each curve. 
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� Enter the radius and length for each curve.

These prompts repeat for all but the floating curve. The command prompts 
only for the radius of the floating curve because the length is determined by 
the lengths and radii of the other curves. 

The curve is then drawn from the specified parameters.

The following illustration shows multiple curves:

 	�������	�
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Drawing a Curve From the End of an Existing 
Object

You can draw a curve that extends from the end point of an existing line, 
curve, or spiral. 

�����������	�
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� From the Lines/Curves menu, choose From End of Object. 

� Select the object near the end from which to draw the curve. 

The command uses the ending angle of the original object for referencing the 
new curve. 

The following prompt is displayed:
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� Type Radius or Point:

� Type Radius to draw the curve based on the radius. For more information, 
see “Drawing a Curve Based on Radius” on page 362.

� Type Point to draw the curve through a selected point.

� Select the point for the curve to pass through.

� Specify the length of the curve.

The following illustration shows a curve drawn from the end of an object:
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Drawing a Curve Based on Radius
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� Complete steps 1 and 2 of “Drawing a Curve From the End of an Existing 
Object” on page 362.

� Type Radius to draw the curve base on the radius.
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The following prompt is displayed:
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� Do one of the following:

� Type a positive radius to draw the curve clockwise.
� Type a negative radius value to draw the curve counter-clockwise.
� Select two points to define the radius.
� Type Degree to enter the degree of curvature.

The following prompt is displayed:
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� Do one of the following to define the curve:

� Type Length and then the curve length.
� Type Tan and then the tangent length.
� Type Chord and then the chord length.
� Type Delta and then the delta angle.
� Type Ext and then the external secant.
� Type Mid and then the Middle Ordinate Distance.

Drawing a Reverse or Compound Curve

The Reverse or Compound command draws a reverse or compound curve 
from the endpoint of an existing curve. 

A reverse curve is an S-shaped curve. A compound curve is a curve consisting 
of two or more arcs of different radii curving in the same direction and hav-
ing a common tangent or transition curve at their point of junction.

NOTE There must be an existing curve in the drawing from which to draw the 
new curve. 
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� From the Lines and Curves menu, choose Reverse or Compound.

� Select a curve.

� Specify whether to draw a compound or reverse curve from the original end-
point of the curve.

� Select a radius and another factor of the curve.
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The command calculates and draws the curve. The new curve is drawn on the 
current layer.

Drawing a Best Fitting Curve Through Points

You can draw a curve between several COGO points, using the method of 
least squares to calculate where to draw the curve.
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� From the Lines/Curves menu, choose Best Fit Curve.

The following prompt is displayed:
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� To select the points, type Selection or Number:

� Type Selection and then select the COGO points with your pointing 
device. You can use a window or crossing selection to help you select the 
points. These must be COGO points that exist in the drawing.

� Type Number and then type the COGO point numbers.

To draw part of the line or curve through a discontinuous sequence of 
points, type each point number to use in the range, and separate each 
number with a comma. For example: 

-������#%
����,./.,0.,1

To draw part of the line or curve through a continuous sequence of points, 
type the beginning and end point numbers for the sequence, separated 
with a hyphen.
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� After you select all the points, press ENTER.

The text window displays the point number, assigned error, radial offset to 
curve, northing/easting coordinates of the points on the curve, and the fol-
lowing prompts:
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� Do one of the following:

� Type 1 to remove points from the list. For more information, see “Remov-
ing Points from the List for the Best Fit Curve” on page 365.

� Type 2 to change the assigned error. For more information, see “Changing 
the Assigned Error for the Best Fit Curve” on page 365.
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� Type 3 to add points to the curve. For more information, see “Adding 
Points to the Best Fit Curve” on page 366.

� Type 4 to draw the curve. For more information, see “Drawing a Best Fit-
ting Curve” on page 367.

� Press ESC to exit the command.

The following illustration shows a best-fitting curve drawn between points 
that represent objects on the terrain, such as surveyed points along an exist-
ing road centerline:
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Removing Points from the List for the Best Fit 
Curve
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� Complete steps 1–3 of “Drawing a Best Fitting Curve Through Points” on 
page 364.

� Type 1 to remove points from the list.

� Type the number of the COGO point to remove from the list. 

The command displays an updated list and then the Press a key prompt again.

Changing the Assigned Error for the Best Fit 
Curve

You can change the error value assigned to each COGO point in a best fitting 
curve by assigning either all points an equal error value (which gives each 
point equal weight when calculating the curve) or different error values. 
Points with smaller errors are weighted more than points with larger errors. 

The program assigns all points you selected for the best fit curve an error of 
1. However, you can assign an error value between 0 and 1000 units to any 
point. You can hold a point (the curve is drawn through that point) by 
assigning it an error of zero (0).
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� Complete steps 1–3 of “Drawing a Best Fitting Curve Through Points” on 
page 364.

� Type 2 to change the assigned error. 

The following prompt is displayed: 
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� To determine which points to adjust, type Individual or All:

� Type Individual and then at the following prompts, type the point num-
ber and the new error: 
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� Type All to enter new errors for all the points, and then at the following 
prompts, type the new error or press ENTER to accept the default error 
value:
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This example shows that points 3 and 4 are accurate to one unit. Point 2 is 
accurate to one tenth of a unit. Entering a zero (0) error for point 1 holds this 
point. The command displays an updated list and then the prompt to Press 
a key.

Adding Points to the Best Fit Curve

You can add more points to your selection set for calculating the best fitting 
curve.

������������

� Complete steps 1–3 of “Drawing a Best Fitting Curve Through Points” on 
page 364.

� Type 3 to add points to the best fit curve.

� Enter the points to add.

The command displays an updated list and the Press a key prompt again.
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Drawing a Best Fitting Curve
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� Complete steps 1–3 of “Drawing a Best Fitting Curve Through Points” on 
page 364.

� Type 4 to draw the best fit curve.

� Press ENTER or SPACEBAR to continue. 

The command displays the text window and the Press a key prompt again.

� Do one of the following:

� Continue to edit the point list or the weighting factors. 
� Press ESC to exit the command.
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18Drawing Spirals

With the Spiral commands, you can draw a variety of 

spiral types, including clothoid, quadratic, cosinusoidal, 

and sinusoidal. You can draw spirals between two tan-

gents, between tangents and curves, and between two 

curves. You can also attach spirals off the end of a tan-

gent or curve, or between a tangent and a point.

There are commands provided to change the speed table 

storage path, edit a speed table, and create spiral curves 

using a speed table to calculate superelevation.

In this chapter

� Working with Spirals

� Selecting the Current Spiral 
Type

� Drawing Spirals Between Two 
Lines

� Drawing Spirals Between 
Tangents and Curves

� Drawing Spirals Between Two 
Curves

� Drawing a Curve and Two 
Compound Spirals Between 
Two Curves

� Drawing a Curve and Two 
Reverse Spirals Between Two 
Curves

� Attaching Spirals to Objects

� Creating Spirals Using Speed 
Tables

� Spiral Types

� Attaching Multiple Curves, 
Lines, and Spirals to Objects
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Working with Spirals

In modern transportation design, vehicle dynamics, as well as safety and 
comfort considerations, dictate the need to avoid abrupt changes in horizon-
tal curvature. Such changes, which are encountered where a tangent meets a 
circular curve, or at points of compound curvature, can be avoided by the 
introduction of a general class of curves called spirals or “transition” curves. 
A spiral also provides the logical location for the introduction of supereleva-
tion so that it matches the local curvature of the alignment at every point.

In response to the needs of many roadway designers, AutoCAD Land 
Development Desktop includes a complete set of spiral design and computa-
tional tools.

A spiral is a curve comprised of short segments that have differing rates of 
curvature or radius. You must use the AutoCAD Land Development Desktop 
commands to create spirals. All AutoCAD Land Development Desktop com-
mands expect spirals to meet certain design criteria. If the spirals do not meet 
these criteria, then the commands do not process the spirals properly. Even 
though a spiral returns polyline information when listed using the LIST com-
mand, you cannot create them with the PLINE command. If the horizontal 
alignment includes spirals, you must define the alignment using the Define 
from Objects command. If you use the PEDIT command to join a spiral with 
other objects, the spiral definition will be lost.

The spiral commands are divided into two categories: Fit and Attach. The Fit 
commands create spirals between two objects; the Attach commands extend 
a spiral from the end of a selected object. 

Use the following guidelines when drawing spirals:

� The spiral commands prompt for either a length or spiral A parameter. The 
A parameter describes the flatness of the spiral, and is a commonly used 
metric parameter that equals the square root of the product of the length 
and the radius. To use the A value, type A at the First spiral length (or A) 
and/or Second length (or A) prompt, and then enter the “A” value.

� When attaching spirals or curves to an object, entering a positive radius 
draws the spiral or curve to the right (clockwise), and entering a negative 
radius draws the spiral or curve to the left (counter-clockwise).

� All the options in the Attach Spiral command prompt you for a radius or 
degree of curvature. The degree of curvature is not generally used as spiral 
parameter, but if you attach a spiral in or out of a curve and know the 
degree of curvature but not the radius, then the options calculate the 
radius of the spiral from the degree of curvature. 
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Selecting the Current Spiral Type

You can choose the current spiral type: clothoidal, sinusoidal, cosinusoidal, 
or quadratic. Any command that creates a spiral uses the equations for the 
current spiral type. Changing the type of spiral does not affect the definition 
of existing spirals. All existing spirals retain their original definitions if you 
change the spiral type in the middle of a project. The default spiral type is 
clothoidal. This spiral type meets the needs of most design cases. For more 
information about spirals, see “Drawing Spirals” on page 369.
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� Do one of the following to display the Alignment Values dialog box:

� From the Lines/Curves menu, choose Create Spirals ➤ Spiral Type.
� From the Projects menu, choose Drawing Settings to display the Drawing 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Spiral Type and then click the Edit Settings 
button.

� Select a spiral type:

� Clothoid: For more information, see “Clothoid Spirals” on page 401.
� Sinusoid: For more information, see “Quadratic, Cosinusoidal, and Sinu-

soidal Spirals” on page 402.
� Cosinusoid: For more information, see “Quadratic, Cosinusoidal, and 

Sinusoidal Spirals” on page 402.
� Quadratic: For more information, see “Quadratic, Cosinusoidal, and 

Sinusoidal Spirals” on page 402.

� Click OK.
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Drawing Spirals Between Two Lines

You can draw spirals between two lines, either with or without an intermedi-
ate curve. 

Drawing Two Spirals and an Intermediate Curve 
Between Two Tangents

You can create two spirals and the associated circular curve between two tan-
gents. The spirals can be either symmetrical or asymmetrical. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Tangent 
to display the Fit Spirals - Tangent to Tangent icon menu.

� From the Description list box, click Spiral-Curve-Spiral.

� Click OK.

� Select the tangents into and out of the curve.

The following prompt is displayed:
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� Do one of the following:

� Enter the radius. If you enter a negative radius value, then the command 
draws a clover leaf.

� Type Degree and enter the degree of curve. 

The following prompt is displayed:
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� To define the spiral length or A value, do one of the following:

� Enter the spiral length.
� Type A, and then type the A value.

� Repeat step 6 for the second spiral.

NOTE You can press F2 to view the text window, where the spiral data is listed. 

The following illustration shows two spirals and the associated circular curve 
between two tangents:
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Drawing Two Spirals Between Two Tangents 
Without an Intermediate Curve

You can draw two spirals between two tangents without a circular curve 
between them. The spirals can be either symmetrical or asymmetrical. 

������������
������������������������

� From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Tangent 
to display the Fit Spirals - Tangent to Tangent icon menu.
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� From the Description list box, click Spiral-Spiral.

� Click OK.

� Select the tangents to be joined with the spirals. 

The following prompt is displayed:
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� Do one of the following:

� Type Lengths and then enter the spiral length in and length out.
� Type Radius and then enter the radius of the spirals where they intersect. 
� Type Radius and then type Degree and enter a degree value.

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration shows two spirals between two tangents without a 
circular curve between them:
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Drawing Spirals Between Tangents and 
Curves

To draw spirals between tangents and curves, you can either fit a spiral 
between a tangent and a curve, or fit a spiral, curve, compound spiral, and 
reverse spiral between a tangent and a curve.

Drawing a Spiral Between a Tangent and a Curve

You can draw a spiral between a tangent and circular curve. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Curve to 
display the Fit Spirals - Tangent to Curve icon menu.

� From the Description list box, click Spiral. 

� Click OK.

� Select the tangent nearest to the end that is to be trimmed.

� Select the curve (this curve must be close to the tangent but not cross it).

The required spiral length is unique and calculated by the command. The 
command draws the spiral and then displays information about it.

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration shows a spiral between a tangent and circular 
curve:
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Drawing a Spiral, Curve, Compound Spiral, and a 
Reverse Spiral Between a Tangent and a Circular 
Curve

You can fit a spiral, curve, compound spiral, and reverse spiral between a tan-
gent and a circular curve. The tangent and curve are trimmed to fit the new 
objects. 

� From the Lines/Curves menu, choose Create Spirals ➤ Fit Tangent-Curve to 
display the Fit Spirals - Tangent to Curve icon menu.

� From the Description list box, click Spi-Crv-Spi-Rev-Spi. 

� Click OK.

� Select the tangent nearest to the end of the new spiral.

� Select the curve (this curve can be crossing the tangent).

The following prompt is displayed:
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� Do one of the following:

� Enter both the spiral length in and length out (for the spiral starting at the 
tangent).

� Type A, and then type the spiral A value. 

The following prompt is displayed:
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� Do one of the following:

� Enter the radius for the floating curve (the floating curve radius is the 
radius of the new circular curve between the two spirals). 

� Type Degree, and then enter the degree value of the floating curve.

The following prompt is displayed:
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� Do one of the following:

� Enter both the spiral length in and length out (for the reverse spiral).
� Type A, and then type the spiral A value. 

The compound spiral length is calculated based on the other parameters. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration shows a spiral, curve, compound spiral, and 
reverse spiral between a tangent and a circular curve:
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Drawing Spirals Between Two Curves

You can draw spirals between two curves several ways. You can fit spirals 
either in various combinations between two curves or between a curve and a 
reverse curve. 

Drawing a Tangent and Two Spirals Between Two 
Curves, Using the Spiral Lengths as the Control 
Factors

You can fit a tangent and two spirals between two curves. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu.

 

� From the Description list box, click Spi-Tan-Spi (s).

The (s) in the command name means that the spiral lengths (or A values) are 
the controlling factor.

� Click OK.

� Select the first curve nearest the end to which the spiral is fit.

� Select the second curve. It does not matter which end of the second curve 
you select.

The following prompt is displayed:
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� Do one of the following:
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� Enter the length of the first spiral.
� Type A, and then type an A value. 

� Repeat step 5 for the second spiral length.

The command calculates the length and orientation of the tangent to fit 
between the spiral sections. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration features a tangent and two spirals drawn between 
two curves:
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Drawing a Tangent and Two Spirals Between Two 
Curves, Using the Tangent Length as the Control 
Factor

You can fit a tangent and two spirals between two curves. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu.

� From the Description list box, click Spi-Tan-Spi (t).
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The (t) in the command name means that the tangent length is the control-
ling factor.

� Click OK.

� Select the first curve nearest the end to which the spiral is fit.

� Select the second curve. It does not matter which end of the second curve 
you select.

The following prompt is displayed:

���������������

� Enter the length of the tangent. You can define the tangent length by either 
entering a length or selecting two locations on screen.

This option calculates the length and orientation of the spiral sections on 
either side of the tangent. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration shows spirals when tangent length is greater than 
zero:

"����������
������	���������������	������������	��#���

The following illustration shows resulting spirals when tangent length is 
zero:
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Drawing a Tangent and Two Spirals Between a 
Curve and a Reverse Curve, Using the Spiral 
Lengths as the Control Factors

You can fit a tangent and two spiral segments between a curve and a reverse 
curve. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu.

� From the Description list box, click Rev Spi-Tan-Spi (s).

The (s) in the command name means that the spiral lengths are the control-
ling factors.

� Click OK.

� Select the first curve nearest the end to which the spiral is fit.

� Select the second curve. It does not matter which end of the second curve 
you select.

The following prompt is displayed:
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� Do one of the following:

� Enter the length of the first spiral.
� Type A, and then type an A value. 

� Repeat step 6 for the second spiral length.
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The option calculates the length and orientation of the tangent to fit 
between the spiral sections. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration features spirals and a tangent created with the Rev 
Spi-Tan-Spi(s) option:
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Drawing a Tangent and Two Spirals Between a 
Curve and a Reverse Curve, Using the Tangent 
Length as the Control Factor

You can fit a tangent and two spiral segments between a curve and a reverse 
curve. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu.

� From the Description list box, click Rev Spi-Tan-Spi (t).

The (t) in the command name means that the tangent length is the control-
ling factor.

� Click OK.

� Select the first curve nearest the end to which the spiral is fit.

� Select the second curve. It does not matter which end of the second curve 
you select.
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The following prompt is displayed:
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� Enter the length of the tangent. You can define the tangent length by either 
entering a length or selecting two reference points from the graphics screen.

The command calculates the length and orientation of the spiral sections on 
either side of the tangent. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration shows spirals and a tangent whose length is greater 
than zero:
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The following illustration features spirals and a tangent whose length is zero:
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Drawing a Compound Spiral Between Two 
Curves

You can draw a compound spiral between two curves. The path of the smaller 
curve must be reasonably close to, and completely within, the larger curve. 

If the paths of the curves intersect, then the spiral has no solution.

NOTE Compound spirals are only supported when using a clothoid spiral 
type. No matter what spiral type is set, the command always uses the clothoid 
spiral type. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu.

� From the Description list box, click Compound Spiral.

� Click OK.

� Select the first curve (the outer curve). 

� Select the second curve (the inner curve). 

The following prompt is displayed:
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� Type Right or Left:

� Type Right if the compound spiral starts from the larger of the two curves 
and curve right (clockwise).
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� Type Left if the compound spiral starts from the larger of the two curves 
and curve left (counterclockwise).  

The option draws the compound spiral and then displays information about 
it.

NOTE You can press F2 to view the spiral data in the text window. 

A spiral cannot have a deflection angle greater than 180 degrees. If the deflec-
tion angle of the full spiral (the compound spiral projected out to the tan-
gent) is greater than 180 degrees, then a message displays stating that the spi-
ral angle is greater than 180 degrees. 

The following illustration shows a compound spiral:
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Drawing a Curve and Two Compound Spirals 
Between Two Curves

You can fit a circular curve and two compound spiral segments between two 
curves. Compound spirals are supported only when using a clothoid spiral 
type. No matter what spiral type is set, the command always uses the 
clothoid spiral type. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu.

� From the Description list box, click Comp Spi-Crv-Spi.

� Click OK.

� Select the first curve.

� Select the second curve. 

The following prompt is displayed:
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� Do one of the following:

� Enter the length of the first spiral.
� Type A, and then type an A value. 

� Repeat step 5 for the second spiral.

The following prompt is displayed:
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� Do one of the following:

� Enter the radius of the floating curve between the spiral segments.
� Type Degree and the degree of curvature. 

NOTE You can press F2 to view the spiral data in the text window.

The following illustration features a curve and two compound spirals:
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Drawing a Curve and Two Reverse Spirals 
Between Two Curves

You can fit a circular curve and two sets of reverse spirals between two curves. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Fit Curve-Curve to dis-
play the Fit Spirals - Curve to Curve icon menu. 

� From the Description list box, click Quad Spiral.

� Click OK.

� Select the first curve.

� Select the second curve. 

The following prompt is displayed:
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� Do one of the following:

� Enter the length of the first spiral.
� Type A, and then type an A value. 

� Repeat step 5 for the second spiral.
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The following prompt is displayed:
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� Do one of the following:

� Enter the radius of the floating curve between the spiral segments.
� Type Degree and the degree of curvature. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration features reverse spirals and an intermediate curve:
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Attaching Spirals to Objects

Several options are available for attaching spirals off the ends of objects.

Drawing a Spiral off the End of a Tangent

You can attach a spiral to the nearest end of a selected tangent starting with 
the point of intersection between the spiral and tangent (TS) and ending 
with the point of intersection between the spiral and curve (SC). 

NOTE Although you can use the method described as follows to attach the 
spiral to any tangent, curve, or spiral, the command is intended to be used to 
attach the spiral to the end of a tangent, with the spiral leading into a curve. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to dis-
play the Attach Spirals icon menu.

 

� From the Description list box, click Spiral In.

� Click OK.

� Select the tangent.

The following prompt is displayed:
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� Do one of the following:

� Enter the length of the first spiral.
� Type A, and then type an A value. 
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The following prompt is displayed:
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� Do one of the following:

� Enter the radius (at the end of the spiral where it connects to a curve).
� Type Degree and the degree of curvature. 

NOTE You can press F2 to view the spiral data in the text window. 

The following illustration shows a spiral drawn from the end of a tangent:
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Drawing a Spiral off the End of a Curve

You can attach a spiral to the nearest end of a selected curve starting with the 
point of intersection between the curve and spiral (CS) and ending with the 
point of intersection between the spiral and tangent (ST). 

Although you can use the method described as follows to attach the spiral to 
any tangent, curve, or spiral, the command is intended to be used to attach 
the spiral to the end of a curve or spiral, with the spiral leading out of a curve 
into a tangent. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to dis-
play the Attach Spirals icon menu.

� From the Description list box, click Spiral Out.

� Click OK.

� Select the curve.

The following prompt is displayed:
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� Do one of the following:

� Press ENTER to accept the default radius, which is the radius of the selected 
curve.

� Type a new radius.
� Type Degree and the degree of curvature. 

The following prompt is displayed:

�������������������

� Do one of the following:

� Enter the length of the spiral.
� Type A, and then type an A value. 

The following illustration features a spiral drawn from the end of a curve:
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Drawing a Spiral Between a Tangent and a Point

You can draw a spiral to a selected point. You can start the spiral at the point 
of intersection between the tangent and spiral (TS), and end the spiral at the 
point of intersection between the spiral and curve (SC). Although you can 
use the method described as follows to attach the spiral to any tangent, 
curve, or spiral, the command is intended to be used to attach the spiral to 
the end of a tangent, with the spiral leading out of a tangent to a point. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to dis-
play the Attach Spirals icon menu.

� From the Description list box, click Spiral to Point.

� Click OK.

� Select the tangent (or other object).



392 | Chapter 18 Drawing Spirals

� Select the point to which the spiral is drawn. For more information, see 
“Selecting Points and Locations” on page 203.

The point you select can be the end of a curve, a COGO point, or a random 
location in your drawing. The command calculates the unique spiral length 
required. 

The following illustration shows a spiral drawn from a tangent to a point:
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Drawing a Compound Spiral off the End of a 
Curve

You can attach a compound spiral to the end of a selected object. Although 
you can use any object, this command is intended to attach a compound spi-
ral to a curve and, in turn, have another curve attached to it. 
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� From the Lines/Curves menu, choose Create Spirals ➤ Attach Spiral to dis-
play the Attach Spirals icon menu.

� From the Description list box, click Compound Spiral.

� Click OK.

� Select the curve.

The following prompt is displayed:
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� Do one of the following:

� Press ENTER to accept the default radius, which is the radius of the selected 
curve.

� Type a new radius.
� Type Degree and type the degree of curvature. 

The following prompt is displayed:
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� Do one of the following:
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� Enter the length of the compound spiral.
� Type A, and then type an A value. 

The following prompt is displayed:
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� Enter the ending radius or degree of curve to finish the definition of the com-
pound spiral.

The following illustration features a compound spiral off the end of a curve:
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Creating Spirals Using Speed Tables

Speed tables are common references found in various publications on high-
way design. A speed table for a horizontal alignment includes a design speed 
with a list of the following: degree of curve, radius, superelevation rate (e), 
spiral length or a factor for 2-lane designs, and spiral length or A factor for 4-
lane designs. 

AutoCAD Land Development Desktop provides several speed tables with 
common superelevation rates. These speed tables include the American 
Association of State Highway and Transportation Officials (AASHTO), 
Canadian RTAC, and Malaysian standards. You can modify these speed tables 
and also create new tables if needed.

You can use these speed tables to automatically calculate superelevation val-
ues for a spiral curve as you draw it. You can use this superelevation informa-
tion when using Autodesk Civil Design.

Speed tables are stored in a folder in the following:

c:\Program Files\Land Desktop R2\data\speed tables
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All commands that use speed tables reference this folder. If you want to share 
speed tables on a network, or if you move the speed table files, then you must 
update the path to this folder by changing the speed table path.

Default Speed Tables

AutoCAD Land Development Desktop includes the following speed tables.

� AASHTO 4 emax = 0.04
� AASHTO 6 emax = 0.06
� AASHTO 8 emax = 0.08
� AASHTO 10 emax = 0.010
� AASHTO 12 emax = 0.012
� RTAC Canada Table B.3.1.4a  emax = 0.04
� RTAC Canada Table B.3.1.4b  emax = 0.06
� RTAC Canada Table B.3.1.4c  emax = 0.08
� Malaysia Table 4–4C: emax = 0.060
� Malaysia Table 4–4C: emax = 0.010
� Malaysia Table 4–4A: (Rural)
� Malaysia Table 4–4B: (Urban)

NOTE The speed table naming convention is as follows: AASHTO 4 is the 
AASHTO speed table for the maximum superelevation rate of 0.04.

Changing the Speed Table Storage Path

The speed table path is set to the location that contains the default speed 
tables that are included with AutoCAD Land Development Desktop. By 
default this path is set to:

c:\Program Files\Land Desktop R2\data\speed tables

You must change this path if you move the speed table databases. You can 
also change this path if you work on a network and want to share the speed 
tables with multiple people. All speed tables have the extension .sup. 

We recommend that you maintain the speed table path as a project-based set-
ting. All drawings associated with a project should have the same path 
because they should use the same speed tables. 
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� From the Lines/Curves menu, choose Speed Tables ➤ Set Table Path to dis-
play the Speed Table Path dialog box.
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The Root path lists the path that is currently set for the speed tables. By 
default, the User Preferences Speed Tables root path check box is selected and 
the Path box is empty. When the User Preferences Speed Tables root path is 
selected, the Root path is derived from a program settings file, the sdsk.dfm 
file. The following default path is stored in this file. 

c:\Program Files\Land Desktop R2\data\speed tables

� Do one of the following:

� Clear the User Preferences Speed Tables root path check box if you do not 
want to use the default root path.

� Select the User Preferences Speed Tables root path check box to use the 
default root path.

� If you work on a network, see “Using Advanced Speed Table Path Settings” 
on page 396 for information about the User Preferences Speed Tables root 
path check box.

� In the Path box, enter the path where the speed tables are located. 

� If you cleared the User Preferences Speed Tables root path check box, then 
enter the entire path in the Path box. For example, c:\Speed Tables.

� If you selected the User Preferences Speed Tables root path check box, then 
type the path you want to append to the root path. For example, subdivi-
sion project. 

The updated Table path displays at the bottom of the dialog box, listing the 
entire path derived from either the Path box or a combination of the Root 
path and the Path boxes. In the second previous example, the Table path box 
would list the following path:

c:\Program Files\Land Desktop R2\data\speed tables\subdivision project

� Click OK.
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Using Advanced Speed Table Path Settings
Sometimes a fixed speed table path does not work for everyone. For example, 
if you plan to store the speed table files on a network, then each person has 
to map to the drive on which the tables are stored, using the same drive letter. 

To have more flexibility you can use the User Preferences Speed Tables root 
path option and then edit the default path that is located in the sdsk.dfm file. 

For example, if one person mounts the drive as j:\ and another person 
mounts it as k:\, then a fixed table path works for one, but not the other. By 
storing the path in the sdsk.dfm file, each person has a unique path pointing 
to the same table folder. The first person can set the User Preferences key to 
j:\ and the second person can set it to k:\. They can then set the path in the 
Path edit box to the portion of the path common to all. By entering tables\ 
in the path field, the first person can find the tables in j:\tables and the sec-
ond person would find the same tables with the path k:\tables. 

NOTE Although the User Preferences option was added to support multi-user 
environments, you can also use it for single-user systems. 
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� From the Lines/Curves menu, choose Speed Tables ➤ Set Table Path.

� Select the User Preferences Speed Tables root path check box. 

NOTE If you entered a path in the Path box, then that path is combined with 
the User Preferences Speed Table root path to create the entire table path. If the 
Path box is empty, then the entire table path is retrieved from the root user pref-
erences path. 

� Click OK to exit the dialog box.

� From the Projects menu, choose User Preferences to display the User Prefer-
ences dialog box:



Creating Spirals Using Speed Tables | 397

� Under File Locations, select Speed Tables from the Type pull-down menu.

� Click the Browse button and locate where the speed tables are stored.

For instance, in the example described previously, the first person set the 
value to j:\speed tables and the second person set it to k:\speed tables.

� Click OK to return to the User Preferences dialog box.

� Click OK.

Editing a Speed Table

You can edit a speed table if you need to add information to it. 
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� From the Lines/Curves menu, choose Speed Tables ➤ Edit Speed Tables to dis-
play the Select Speed Table dialog box.
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� Select the table you want to use and click OK to display the Horizontal Speed 
Table dialog box.

NOTE If you receive an error message stating that no speed table was found, 
then you may need to change the speed table path. For more information, see 
“Changing the Speed Table Storage Path” on page 394.

� From the Design Speed box, choose the design speed that is characteristic of 
the superelevated region. 

� Click the row in the speed table you want to edit. 

� Click Edit to edit an existing row, or click Add to add a new row.

The New/Edit Speed Table Item dialog box is displayed:
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� Edit the values in any or all of the five edit boxes.

� Degree of Curve: When you enter the degree of curve, you must include 
degrees, minutes, and seconds. The recommended method of entry 
matches the display in the dialog box, where a ̂  is used as the degree sym-
bol, a ' for minutes and a '' for seconds.

� Radius: The spiral radius at the SC or CS. 
� Superelevation Rate: The superelevation rate or e value. This value is typ-

ically represented by a decimal number representing the percent grade of 
full superelevation. Other representations supported are nc for no crown 
and rc for remove crown. The rc value in the speed tables is always set to 
a 2 percent grade. You can change this value when you edit the superele-
vation parameters in Autodesk Civil Design.

� 2 Lane Spiral Length: Spiral lengths in and out for two-lane roads.
� 4 Lane Spiral Length: Spiral lengths in and out for four-lane roads.

� Click OK to save your edits and return to the Horizontal Speed Table dialog 
box.

� Select another row to edit, or click OK to end the command.

Creating Spiral Curves by Using a Speed Table to 
Calculate Superelevation

You can create a spiral-curve-spiral between two specified tangents by refer-
encing speed tables. When you create the spiral, the spiral length in, spiral 
length out, and the radius values are retrieved from a speed table. 

When you use this command, the superelevation information is stored with 
the spiral objects. After you define the alignment, this superelevation infor-
mation is automatically added to the superelevation file of the alignment. 
You can use Autodesk Civil Design to edit the superelevation information if 
needed. 
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� From the Lines/Curves menu, choose Speed Tables ➤ Create Curves. 

� Click one of the following to select the two tangents going in and out of the 
curve:

� Two Lanes: If you are designing superelevation for a two-lane road.
� Four Lanes: If you are designing superelevation for a four-lane road.

The Horizontal Speed Table dialog box is displayed:

� Click Select to select the speed table you want to use. 

The Select Speed Table dialog box is displayed:
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� Select the table you want to use. 

� Click OK to return to the Horizontal Speed Table dialog box.

� From the Design speed box, choose the design speed that is characteristic of 
the superelevated region. 

� Click the row in the speed table you want to use. 

� Click OK to display the Select dialog box.

) Click one of the following:

� Two Lanes: If you are designing superelevation for a two-lane road.
� Four Lanes: If you are designing superelevation for a four-lane road.

The command draws either a spiral-curve-spiral transition or a curve transi-
tion between the two tangents. The superelevation information is stored 
with the spiral and curve objects. 

Spiral Types

Different types of spirals are classified by their curvature function (the equa-
tion that defines degree of curve as a function of station). Integration of this 
function gives an equation for the local azimuth (theta) at any given point 
on the spiral; subsequent integration of the cosine and sine of theta provide 
functions for the tangent and offset (X & Y) of that point. These equations 
allow the location of any point on a spiral.

Clothoid Spirals

AutoCAD Land Development Desktop currently supports four spiral types. 
However, in most cases, you use the clothoid (or linear) spiral. The clothoid 
spiral is used almost exclusively in the U.S. for both highway and track 
design, and is the most widely used type of spiral in most other countries as 
well. 

First investigated by the Swiss mathematician Leonard Euler, the curvature 
function of the clothoid is a linear function chosen such that the degree of 
curve is zero (0) where the spiral meets the tangent. The function then 
increases linearly until it equals the degree of the adjacent curve at the point 
where the spiral and curve meet.

Such an alignment provides for continuity of the position function and its 
first derivative (local azimuth), just as a tangent and curve do at a Point of 
Curvature (PC). However, unlike the simple curve, it also maintains continu-
ity of the second derivative (local curvature) which becomes increasingly 
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important at higher speeds. A number of approximations of the clothoid 
have been introduced including the A.R.E.A. spiral, the cubic parabola, and 
the Searles spiral, but none of these provide the exact match between align-
ment and vehicle dynamics that the clothoid does. These alternative spirals 
were developed to simplify the computation process in the pre-computer era.

Quadratic, Cosinusoidal, and Sinusoidal Spirals

At extremely high speeds, such as those experienced on the high speed rail 
systems of Europe and Japan, the third derivative of the alignment function, 
which is discontinuous for the clothoid, becomes important. For this pur-
pose, a number of “higher” spiral types have been introduced. Among these, 
the spirals with quadratic and sinusoidal curvature functions are widely used 
in Europe, while the cosine spiral is popular in Japan.

These three spiral types produce geometries that provide similar vehicle 
dynamics. Regional preferences play a significant role in decisions regarding 
what type of spiral a particular project should use.

The following illustration features the three spiral types:
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The following illustration shows how the three spiral types compared to the 
clothoid spiral:
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The following illustration depicts the spiral calculation parameters:
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The following illustration features the clothoid degree of curve function:
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Compound Spirals

In the same way that a simple spiral provides a transition between a tangent 
and a circular curve, a compound spiral provides a transition between two 
circular curves with different radii. As with the simple spiral, this allows for 
continuity of the curvature function and provides a way to introduce a tran-
sition in superelevation. Currently, AutoCAD Land Development Desktop 
supports only clothoid type compound spirals. 

The spiral resulting from the integration of this function is identical to a por-
tion of a simple spiral with the longer radius curve attached at the point on 
the spiral where the local curvature is the same as for that curve. The shorter 
radius curve attaches to the usual location on the spiral.

Compound spirals are best used in either difficult terrain where the radius of 
a curve must change to avoid excessive earthwork or entrance/exit ramps 
where vehicle speed changes significantly. Occasionally, the demands of a 
complex alignment in an urban setting is best met by using compound 
spirals.

The following illustration shows the design parameters of a compound spiral:
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The following illustration shows a compound spiral:
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Offset Spirals

When a circular curve or tangent is offset, the resulting object is a new curve 
or tangent, and is therefore easy to deal with computationally. For a spiral, 
however, this is not the case. A spiral does not retain its curvature function 
when offset, and you cannot deal with this parallel spiral using the same 
geometry as the base spiral. However, you can describe such offset objects 
mathematically, and compute stations along them. AutoCAD Land 
Development Desktop includes the capabilities to handle such computations 
and lets you include parallel clothoid spirals in alignments. You might use 
this type of alignment for edge of pavement figures or for special cases of par-
allel transit alignments.
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NOTE Although you can offset any type of spiral with AutoCAD Land 
Development Desktop commands, only the clothoid (simple or compound) cur-
rently maintains any mathematical integrity when offset. Do not include other 
types of offset spirals in alignments. 

Parallel Spiraled Alignments

In alignment design it is often desirable to construct two or more alignments 
that are parallel through a curve. For circular curves, this is a simple matter; 
however, when spirals are introduced, the complications in Offset Spirals 
come into play. For more information, see “Offset Spirals” on page 405. Fol-
lowing are two approaches to this problem.

The first method dictates that the alignments be everywhere at a uniform dis-
tance from each other. In this case, the first alignment is created and the spi-
rals are added using any of the Spiral commands. The second alignment is 
created such that it has no mathematical description of its own, except that 
it is at a uniform offset from the first. You can use the Offset Alignments com-
mand or the Offset command to create the second alignment. For more 
information, see “Creating Offsets for an Alignment” on page 440. Station-
ing and all computations regarding either alignment are generally done with 
respect to the first alignment.

The following illustration shows parallel alignments with offset spirals:
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The second method uses nearly parallel, true spirals to create the second 
alignment and has the added advantage of allowing for widening of track 
centers in the main body of the curve. This can be useful in mass transit 
design where car overhang in tight curves requires increased lateral clearance 
between adjacent tracks. As with the first method, create the first alignment 
with the usual commands, then offset the tangents and circular portions 
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with the Offset command. Finally, use the appropriate Create Spiral com-
mand to create the true spirals that connect the tangent(s) and curve(s).

NOTE These spirals have the length the program computes as necessary to 
join the selected objects, and are displaced (along the alignment) with respect 
to the spirals on the first alignment. 

Because the spirals are not perfectly parallel, use the Divide Alignment com-
mands to check clearances within the spirals.

The following illustration shows parallel alignments with true spirals:
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Basic Graphic Model of a Spiral

AutoCAD Land Development Desktop represents a spiral using a polyline 
constructed so as to follow the spiral closely, but also to preserve its underly-
ing mathematics precisely. This polyline has 10 segments with calculated 
bulge factors at each vertex. The bulge factors along the polyline are adjusted 
so that its local curvature best approximates the spiral and maintains tan-
gency with adjacent objects in an alignment. This feature lets spirals be off-
set, while still retaining the proper relationship to adjacent offset objects.

The following illustration shows the Autodesk 10 segment spiral:
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Although these models provide quite accurate graphic representations, it is 
important to understand their limitations. The spirals are graphically accu-
rate only at the vertices. For example, to determine the intersection of a spiral 
with another object, use the appropriate AutoCAD Land Development 
Desktop command. This uses the exact mathematics of the spiral to make the 
intersection, as opposed to an intersection OSNAP which finds an intersec-
tion with the graphic model, but might not be accurate enough. All 
AutoCAD Land Development Desktop commands for locating points, com-
puting stations and offsets, and making intersections, work with the precise 
mathematics of the chosen spiral.

NOTE Do not try to draw spiral segments using anything but the Create 
Spirals commands. Spirals drawn free-hand using the PLINE command may not 
have used the proper calculations, and do not always have the necessary infor-
mation associated with them. 

Spiral Terminology

Following is a list of terms used in discussing spirals. 

Spiral parameter definitions

(������ -�!�������

TS Point of change from tangent to spiral

SC Point of change from spiral to circular curve

CS Point of change from circular curve to spiral
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ST Point of change from spiral to tangent

i1 Central Q angle of spiral curve L1, called “spiral angle”

i2 Central Q angle of spiral curve L2, called “spiral angle”

L1 Total length of spiral from TS to SC

L2 Total length of spiral from CS to ST

T1 Total tangent distance from PI to TS

T2 Total tangent distance from PI to ST

X1 Tangent distance at SC from TS

X2 Tangent distance at CS from ST

Y1 Offset distance at SC from TS

Y2 Offset distance at CS from ST

P1 Offset of the initial tangent into the PC of the shifted curve

P2 Offset of the initial tangent out to the PT of the shifted curve

K1 Abscissa of the shifted PC referred to the TS

K2 Abscissa of the shifted PT referred to the ST

LT1 Long tangent of spiral 1

LT2 Long tangent of spiral 2

ST1 Short tangent of spiral 1

ST2 Short tangent of spiral 2

Spiral parameter definitions (continued)

(������ -�!�������
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Attaching Multiple Curves, Lines, and Spirals 
to Objects

To attach multiple lines, curves, or spirals from the end of any previously 
drawn object, use the Attach Multiple command on the Lines and Curves 
menu. The elements of this command have been included as separate com-
mands in the Lines, Curves, and Spirals menus. In other words, if you only 
need to draw a curve, then use one of the commands in the Curves menu and 
similarly for lines and spirals. 

Attaching a Line to an Object
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� Select an object in the drawing.

� From the Lines and Curves menu, choose Attach Multiple.

� At the command prompt, type T to attach a tangent.

� Enter the length of the new line section.

� Press ENTER to exit the command.

Attaching a Curve to an Object
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� Select an object in the drawing.

� From the Lines and Curves menu, choose Attach Multiple.

� Select the object nearest the end to which the new object(s) are to be 
attached.

� At the command prompt, type A to attach an arc.

� Specify one of the following types of entries to use:

� Point: draws the curve through a selected point. Select a point and enter 
the chord length.

� Radius: draws the curve based on the radius or degree of curve. Enter the 
radius at the prompt, or type D and enter a degree of curve. When drawing 
a curve, specifying a positive radius or degree of curve draws the curve 
clockwise or to the right of the starting angle, whereas a negative radius or 
degree of curve draws the type curve counterclockwise or to the left.

After you enter the radius, the following prompt is displayed:
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� Do one of the following:

� Type Tan, then type the tangent length.
� Type Chord, then type the chord length.
� Type Delta, then type the delta angle.
� Type Length, then type the curve length.
� Type External, then type the external secant.
� Type Mid, then type the Middle Ordinate Distance.

All choices prompt for the value of the variable specified. After you define a 
curve with either the Point or Radius option, the curve data is displayed and 
the curve is drawn.

Attaching a Spiral to an Object

������	���
�����������.���

� Select an object in the drawing.

� From the Lines and Curves menu, choose Attach Multiple.

� Select the object nearest the end to which the new object(s) are to be 
attached.

� At the command prompt, type S to attach a spiral.

� Select one of the following spiral types. The command uses the spiral type 
that you set with the Spiral Type command, but it also uses an additional spi-
ral type to link the spiral to the line segment.

� Compound: To draw the spiral from one curve to another.
� Incurve: To draw the spiral from a tangent to a curve.
� Outcurve: To draw the spiral from a curve to a tangent.
� Point: To draw the spiral from a tangent to a specified point.

� At the prompt, type the length and radius of the spiral or the degree of curve.

The command displays the spiral data and draws the spiral.

The starting angle of the curve is specified by the closing angle of the line or 
curve you are attaching it to. If you attach a spiral to a curve or if you attach 
a curve to a curve or a spiral, the default value for the radius is the radius of 
the existing curve or spiral.



412



413

19Drawing Special Lines 
and Curves

The Special Lines commands place special lines into a 

drawing. You can use these options to draw lines with 

regularly spaced text or symbols. Symbols include: 

barbed wire, stockade and chain-link fences, stone and 

retaining walls, tree, shore, and ledge lines, guardrails, 

and railroad tracks.

In this chapter

� Special Lines and Curves
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Special Lines and Curves

You can draw lines and curves that represent features on the terrain. You can 
draw tree lines, railroad tracks, and various fence and wall types. You can also 
draw lines and curves with any annotation or symbol you want.

Drawing a Stone Wall

You can draw a line that uses a series of ellipses to represent a stone wall. 

�����������	�
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu:

� From the Description list box, click Stone Wall.

� Click OK to close the dialog box.

� Select the start point for the stone wall. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size of the wall symbol, 
do one of the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on both the curve and the end 

of the curve.
� Type S and enter a new size for the stone wall symbol.

� After you finish drawing the line, press ENTER.
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NOTE The size of the stone wall ellipse is initially based on the current hori-
zontal scale in the drawing. 

The following illustration features a stone wall linetype:
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Drawing a Tree Line

You can draw a line that uses a series of curves to represent a tree line.
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� In the Description list box, click Tree Line.

� Click OK to close the dialog box.

� Select the start point for the tree line. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size of the tree line 
symbol, do one of the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on both the curve and the end 

of the curve.
� Type S and enter a new size for the stone wall symbol.

� After you finish drawing the line, press ENTER.

The command draws the tree line using a series of curves to the right of the 
first selected point, relative to the direction you draw the line. The size of the 
curves is initially based on the current horizontal scale. 

The following illustration features the curve parameters for the tree line 
symbol:



416 | Chapter 19 Drawing Special Lines and Curves

������������	��������	������
��������

The following illustration depicts a treeline:
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Drawing a Shore Line
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 Draw a line or polyline that represents the water’s edge.

� From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Shore Line.

� Click OK.

� Select the line representing the water’s edge. 

The following prompt is displayed:
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� Click in the area of your drawing that represents the body of water. 

Drawing a Ledge

You can draw a set of hatch lines that represents a ledge. 

���������������

 Draw a line or polyline that represents the ledge.

� From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Ledge.

� Click OK.
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� Click a point on the line you drew in step 1.

� Click a point in the area of your drawing where the ledge should appear. This 
must be a point inside the ledge area. 

The following illustration features a ledge:
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Drawing a Guard Rail

You can draw a line that represents a guard rail.
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Guard Rail.

� Click OK.

� Select the start point for the guard rail. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size of the guardrail 
symbol, do one of the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on both the curve and the end 

of the curve.
� Type S and enter a new size for the guard rail symbol.

� After you finish drawing the line, press ENTER.

The following illustration depicts a guard rail:
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Drawing a Railroad Track

You can draw a line that represents railroad tracks.
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Railroad.

� Click OK.

� Select the start point for the railroad. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size of the railroad sym-
bol, do one of the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on both the curve and the end 

of the curve.
� Type S and enter a new size for the railroad symbol.

� After you finish drawing the line, press ENTER.

The following illustration depicts a railroad track:
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Drawing a Retaining Wall

You can draw a line that represents a retaining wall.
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Retaining Wall.

� Click OK.

� Select the start point for the retaining wall. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size of the retaining wall 
symbol, do one of the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on both the curve and the end 

of the curve.
� Type S and enter a new size for the retaining wall symbol.

NOTE The line increment is how much space is inserted between each 
symbol. The space increment is how much space is inserted around the 
symbol itself. A space increment of zero draws the line through the symbol. 

� After you finish drawing the line, press ENTER.

The following illustration features a retaining wall:
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Drawing a Line with Text on It

You can insert text onto a line.
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NOTE This command uses the current text style and size. 
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Line With Text.

� Click OK.

� Type the text you want to insert.

� Select the start point for the line. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the text or spacing, do one 
of the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on the curve and the end of the 

curve.
� Type T to change the text
� Type S to change the line and/or space increments.

NOTE The line increment is how much space is inserted between each text 
string. The space increment is how much space is inserted around the text 
string itself. A space increment of zero draws the line through all the text. 

% After you finish drawing the line, press ENTER.

The following illustration shows text inserted onto a line:
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Drawing a Line with a Symbol

You can insert any symbol onto a line.
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Line With Symbol.

� Click OK.

� Type the name of the symbol you want to use. This symbol (block) must exist 
in the following folder for the command to function properly:

c:\Program Files\Land Desktop R2\data\Symbol Manager

NOTE Symbols used with the Line with Symbol command cannot contain 
attribute definitions. 

� Select the start point of the line. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the symbol type, do one of 
the following:

� Continue to select points to draw the line.
� Type C to draw a curve, and select a point on the curve and the end of the 

curve.
� Type T to change the text.
� Type S to change the line and/or space increments.

NOTE The line increment controls how much space is inserted between 
each symbol. The space increment controls how wide the line break is around 
the symbol itself. 

% After you finish drawing the line, press ENTER.

The following illustration features a symbol inserted onto a line:
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Drawing a Barbed Wire Fence

You can draw a line that represents a barbed wire fence. 
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, click Barbed Wire Fence.

� Click OK.

� Select the start point for the fence. 

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size or spacing of the 
fence symbol, do one of the following:

� Continue to select points.
� Type C to draw a curve, and select a point on the curve and the end of the 

curve.
� Type S to change the symbol size or the line and space increments.

NOTE The line increment controls how much space is inserted between 
each symbol. The space increment controls how wide the line break is around 
the symbol itself. 

� After you finish drawing the line, press ENTER.

The following illustration features a barbed wire fence line:
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Drawing a Stockade Fence

You can draw a line that represents a stockade fence. 
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, select Stockade Fence.

� Click OK.

� Select the start point of the line. 

The following prompt is displayed:

��������	��
�����������

� To select the next point, draw a curve, or change the size or spacing of the 
fence symbol, do one of the following:

� Continue to select points.
� Type C to draw a curve, and select a point on the curve and the end of the 

curve.
� Type S to change the symbol size or the line and space increments.

NOTE The line increment controls how much space is inserted between 
each symbol. The space increment controls how wide the line break is around 
the symbol itself. 

� After you finish drawing the line, press ENTER.

The following illustration depicts a stockade fence line:
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Drawing a Chain Link Fence

You can use this linetype to draw a line that represents a chain link fence. 
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 From the Lines/Curves menu, choose Special Lines to display the Special 
Lines icon menu.

� From the Description list box, select Chain Link Fence.
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� Click OK.

� Select the start point for the fence. For more information, see “Selecting 
Lines, Curves, and Spirals by Selecting Points” on page 203.

The following prompt is displayed:
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� To select the next point, draw a curve, or change the size or spacing of the 
fence symbol, do one of the following:

� Continue to select points.
� Type C to draw a curve, and select a point on the curve and the end of the 

curve.
� Type S to change the symbol size or the line and space increments.

NOTE The line increment controls how much space is inserted between 
each symbol. The space increment controls how wide the line break is around 
the symbol itself. 

� After you finish drawing the line, press ENTER.

The following illustration shows a chain link fence line:
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20Alignments

After you have drawn alignment geometry, you can use 

the Alignments commands to define and edit align-

ments. You can create offsets for alignments and import, 

delete, and merge alignments. You can also apply 

station equations to alignments and create station 

labels.

In this chapter

� Horizontal Alignments

� Drawing an Alignment

� Making an Alignment Current

� Defining an Alignment

� Creating Offsets for 
an Alignment

� Using Station Equations to 
Change the Stationing of 
an Alignment

� Editing Horizontal Alignments

� Reporting Data About a 
Horizontal Alignment

� Displaying Which Alignment 
is Current

� Listing the Alignments Defined 
in the Current Project

� Importing and Deleting 
Alignments

� Changing the Properties 
of Alignments

� Merging Alignments from 
Different Projects

� Stationing Alignments

� Labeling and Reporting Station 
and Offset Values

� Staking Out an Alignment
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Horizontal Alignments

One of the first steps in roadway or railroad design is to create and define the 
horizontal alignment. You first draw the alignment geometry and then 
define the named alignment from that geometry. Defining an alignment cre-
ates an external database so that the alignment definition can be accessed 
from all drawings associated with the project. The external database for hor-
izontal alignments contains all the information on each horizontal align-
ment defined in the project.

The alignment database is accessible by multiple people working on the 
project at the same time in different drawings. Each person can create and/
or edit different alignments at the same time. In AutoCAD Land 
Development Desktop Release 2, locking is now done on a per-alignment 
basis. 

The only limitation is when two people try to set the same alignment current 
at the same time. The first person to access an alignment by making it current 
opens that alignment with read-write capabilities. A lock file is created for 
that alignment and if another person selects that same alignment to set it 
current, they can open it with read-only access but they do not have write 
access, therefore they can’t make any edits. They are also locked out of access-
ing the profiles and cross sections for that alignment (which can be created 
with Autodesk Civil Design).

For more information about the alignment database, see “The Horizontal 
Alignment Database” on page 426.

You can edit the alignment data by using the Horizontal Alignment Editor. 
The Horizontal Alignment Editor is linked to the alignment, so any changes 
you make in the editor are automatically updated in the drawing. However, 
if you make changes to the graphical representation of the alignment in the 
drawing, you must then redefine the alignment to update the database with 
the changes.

The Horizontal Alignment Database

When you define a horizontal alignment from graphical objects in the draw-
ing, the information is stored in the horizontal alignment database, an exter-
nal file. All commands that work with alignments refer to the information in 
this database. 

The alignment database is named alignment.mdb, and it is stored in the 
project’s \align folder. 
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For example, c:\Land Projects R2\<project name>\align\alignment.mdb. 

Each drawing in a project has access to the alignment database. For example, 
if you create a new drawing in a project that already contains alignment def-
initions, you can import the graphical representation of the alignments from 
the alignment database into the new drawing. If you do not need to see the 
horizontal alignment, then you do not have to import it into the drawing to 
be able to work with it. The AutoCAD Land Development Desktop com-
mands always access the alignment data directly from the database.

All horizontal alignment data for a project is stored in the \align project 
folder. If you create profile or cross section data for an alignment then a 
unique sub-folder in the project's \align folder is created using the alignment 
name. This folder stores all profile and cross section data for the alignment. 
For example, if you sample a profile or cross sections for an alignment named 
Road1, then a \align\Road1 folder is created to store the data. 

Whenever you define or edit an alignment, the data is saved to the alignment 
database. For example, when you define an alignment, the definition is auto-
matically saved to the alignment database. 

NOTE Although the Release 2 alignment database is saved in a format that 

Microsoft® Access can open, the alignment database is not intended to be 
edited or viewed in this manner. Use the Horizontal Alignment Editor to edit the 
alignment data and generate reports, or edit the alignment objects and redefine 
the alignment. For more information about the Horizontal Alignment Editor, see 
“Editing Horizontal Alignments” on page 447.

Sharing Access to Alignments Over a Network

Because all of the alignment data is stored in an external database, you can 
share alignment data with other people working on the same project in a net-
worked environment. 

New in AutoCAD Land Development Desktop Release 2, alignment locking 
is handled on a per-alignment basis. The first person to access an alignment 
(by setting it current) obtains read-write access to that alignment. The next 
person who tries to access the same alignment obtains read-only access to the 
alignment, however, he or she could obtain read-write access to a different, 
unlocked alignment.

If you set a locked alignment as current, a message displays at the command 
line to let you know that you have read-only access. If you have read-only 
access to the alignment, then you can import the alignment into a drawing 
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and use alignment definition commands such as creating points along the 
alignment, stationing the alignment or listing station/offset. You can use the 
alignment editor to review the alignment data and print reports, but you can-
not save any changes you make in the editor.

You can use Autodesk Civil Design to create profiles and cross sections for an 
alignment. However, when you have an alignment open with read-only 
access, the profile and cross section commands cannot be used for that align-
ment. You must have read/write access to the alignment in order to use the 
profile and cross section commands.

NOTE In AutoCAD Land Development Desktop Release 1, the first person to 
access the alignment database locked all of the alignments. Now in Release 2, 
locking is handled on a per-alignment basis.

Alignment File Locking

Three different types of locks are created for the alignment database:

� hrz alignment: This lock is created when the alignment database is 
accessed in a Release 1 or Release 2 project. If this lock is instantiated by a 
Release 1 user accessing the project.adb alignment database, then the lock 
prevents someone using Release 2 from accessing the alignment.mdb 
database. If this lock is instantiated by a Release 2 user accessing the align-
ment.mdb database, then the lock prevents someone using Release 1 from 
accessing the project.adb alignment database.

� #UserCount#: This lock is created and updated when people access the 
alignment database. This lock keeps track of the number of people access-
ing the alignment database. The count is 1 when one person accesses the 
alignment database. The number is incremented by 1 for each additional 
person who accesses the alignment database.

� <alignment name>: This lock is created for each individual alignment 
that is accessed from the alignment database. It contains the Windows 
login name of the user who has the alignment locked. The user name is 
appended with the machine name and application ID. The machine name 
is used to avoid conflicts with two users in a network environment logging 
in with the same name. The application ID is used to avoid conflicts from 
a person running two sessions of AutoCAD Land Development Desktop at 
the same time.

You can see which lock files have been created in a project at any time by 
using the File Locks button in the Project Manager. You can also use the File 
Locks feature to remove locks that are left behind if a session is improperly 
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terminated. All project lock files have the file extension .lk#. For more infor-
mation, see “Managing Locked Files in a Project” on page 35.

The <alignment name> lock file (in the previous illustration, it is for 
lot55-44) is created when you make an alignment current. This file prevents 
other people (or other sessions of AutoCAD Land Development Desktop that 
you are running) from obtaining write access to that alignment. The lock for 
that alignment is deleted when you select a different current alignment, 
when you select the Close Database command, or when you end the drawing 
session.

The following is an example of the type of lock file that is created in the 
Project Manager when an alignment is set current:
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� The File row shows the lock file name and where the lock file is located.
� The Label row shows the alignment name, and whether the alignment is 

shared (s) or read-only (r). Shared means that the owner has read-write 
access to the alignment, but another person could obtain read access to 
the alignment. Read-only means that you can access the alignment data, 
but you cannot make changes to it. 

� The Owner row contains the AutoCAD login name, the computer name, 
and the application ID. 

� The Date/Time row shows the date and time the lock file was created.
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The type of lock file described previously is created for the current alignment 
only. For example, if you have an alignment set as current and then you 
make a different alignment current, then the lock on the first alignment is 
released and a lock is created for the second (current) alignment. 

When you define an alignment, the alignment that you define is made cur-
rent, and a lock file is created for it. To release the lock on the current align-
ment without setting another alignment current or ending the drawing ses-
sion, you can use the Close Database command. For more information, see 
“Closing the Horizontal Alignment Database” on page 433.

If an alignment is locked by another user, you can obtain read-only access to 
it by selecting it as the current alignment. When you select an alignment that 
is locked by another user, a lock file is created that contains an “r” (for 
read-only) on the Label row instead of an “s.” 

In the event of a power failure or unexpected shut-down, you can use the file 
locking management options in the Project Manager to release the locks on 
selected alignments. 

WARNING! You should never delete a lock for someone who is currently 
accessing the alignment file. This can lead to data loss or corruption of the 
database.

One command, Merge Database, cannot be used if there are locks on the 
alignment database. Everyone other than the person performing the merge 
must close the database before merging the database. 

Alignment Locking when Working in More than 
One Session of AutoCAD Land Development 
Desktop

When you run more than one session of AutoCAD Land Development 
Desktop on the same computer, the alignment locking is handled the same 
way it is when you are working over a network. 

If you make an alignment current in one session of AutoCAD Land 
Development Desktop, then that alignment is locked in the other session. 
You can only obtain read-only access to that alignment in the other session 
of AutoCAD Land Development Desktop, but you can set a different align-
ment as the current alignment in the second session with read/write access.
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Access to Profile and Cross Section Data

When you create profiles and cross sections in Autodesk Civil Design, vertical 
alignment files (such as <alignment name>.vrt) are created for the alignment 
in the \align\<alignment name>\ folder of the current project. 

When you select a current alignment and obtain read-write access to the 
alignment database, you also obtain read-write access to that alignment’s 
profiles and cross sections (if Autodesk Civil Design is installed). When you 
select a current alignment that is already locked by another person, you get 
read-only access to the horizontal alignment but you are locked out of using 
any of the profile or cross section commands for that alignment. If you try 
to edit profile or cross section data for an alignment that is locked by another 
user, a warning message is displayed. You cannot edit the profile or cross sec-
tion data for an alignment that is locked by another person.

Backwards Compatibility of Alignment Data

In previous releases of AutoCAD Land Development Desktop and Softdesk, 
the alignment database is named project.adb. The project.adb database for-
mat does not allow for alignment locking on a per-alignment basis. The first 
person to access an .adb alignment database obtains read-write access for the 
entire database, so no one else can work on another alignment at the same 
time. 

The older format .adb databases are automatically converted to the .mdb for-
mat and are renamed alignment.mdb when you open a Release 1 or Softdesk 
8 project in Release 2. However, the older .adb files are not deleted from your 
project folder. If no .adb file is detected in the project you open, then no con-
version occurs. Additionally, if an alignment.mdb file is detected in the 
\align folder for the project, indicating that the alignment database already 
exists in the new format, no additional conversion takes place.

You can save the new alignment.mdb format database as an .adb database if 
you require backwards compatibility with previous releases. When convert-
ing to an .adb file, a file called longfilenamesystem.mdb is created if the 
names of your alignments are longer than seven characters. This file was used 
in Release 1 of AutoCAD Land Development Desktop to allow the use of up 
to 40 characters for alignment names. The new .mdb format allows the long 
file names to be written directly to the alignment.mdb file, so the longfilena-
mesystem.mdb file is no longer created, unless you save the database as .adb.

NOTE Softdesk 8 supports up to eight-character alignment names only, and 
cannot use the longsystemfilename.mdb file. Any profile and cross section files 
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that are longer than eight characters are not readable by S8.

If you are sharing a Release 2 project with other people using Release 1 of 
AutoCAD Land Development Desktop, save the alignment database as an 
.adb file before you give them the project. When you receive the project back 
from them, use the Merge Database command to update the alignment.mdb 
file. For more information, see “Merging Alignments from Different Projects” 
on page 471.

Saving the Alignment Database as an .adb File

If you want to share a project that contains alignments with someone using 
Release 1 of AutoCAD Land Development Desktop or Softdesk 8, then save 
the alignment database as an .adb file, the previous format of the alignment 
database.

In AutoCAD Land Development Desktop Release 2, the alignment database 
is saved to a Microsoft Access .mdb file named alignment.mdb. The .mdb for-
mat allows alignment locking on a per-alignment basis. In previous releases, 
the database was saved to the project.adb file, which allowed read-write 
access to only the first person who accessed the database. 

NOTE When you open a Release 1 or Softdesk 8 project with Release 2 of 
AutoCAD Land Development Desktop, the alignment database is automatically 
converted from an .adb file to the alignment.mdb file.

If you give an .adb file to someone to work on, and later you want to incor-
porate their changes into your Release 2 project, then use the Merge Database 
command. For more information, see “Merging Alignments from Different 
Projects” on page 471.
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� From the Alignments menu, choose Alignment Commands ➤ Save as .adb.

NOTE The Alignment database does not have to be closed when saving it as 
an .adb file.

If a project.adb file already exists in the project, then a warning dialog box is 
displayed, informing you that you will overwrite the existing .adb file if you 
continue.
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� Click Yes if you want to continue, or click No to end the command.

The alignment database is saved to a project.adb file to the current project’s 
\align folder. If the alignment names contain more than eight characters, 
then a longfilenamesystem.mdb file is also written out. This file allows the 
use of up to 40 characters for alignment names in AutoCAD Land Develop-
ment Desktop Release 1.

NOTE Softdesk 8 does not support long file names for alignments. If align-
ment names contain more than eight characters, then the names are truncated. 
For example, “alignmentname” would appear as “alignm~1”. If you plan on 
sharing a project with someone using Softdesk 8, then it is recommended that 
you limit the alignment names to eight characters or fewer. You can add detail 
to the alignment definition by using the Description box when defining the 
alignment.

NOTE When you open a project that contains an .adb file, the .adb file is auto-
matically converted to an alignment.mdb file. However, if an alignment.mdb file 
already exists in the project, then no conversion occurs.

Closing the Horizontal Alignment Database

To release the lock on the current alignment without selecting another cur-
rent alignment, you can close the alignment database or close the drawing. 
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� From the Alignments menu, choose Alignment Commands ➤ Close 
Database.

By closing the database, you release the lock file on the current alignment. 
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Drawing an Alignment

You can define an alignment either from a polyline or from line, curve, and 
spiral objects. 

� Use the PLINE command to draw a continuous polyline with line and 
curve segments and define it as an alignment. When you define an align-
ment from a polyline using the Define from Polyline command, the align-
ment is defined in the direction in which you drew the polyline. For more 
information, see “Drawing Polylines” in the AutoCAD User’s Guide.

� Use the commands in the Lines/Curves menu to draw individual line, 
curve, and spiral objects that are joined at vertices and then define the 
entire group of objects as an alignment. The objects that comprise the 
alignment must meet exactly end-to-end. The Define from Objects com-
mand ends the alignment at any point it fails to find a connecting object.

Making an Alignment Current

To work on an alignment, you must select it as the current alignment. Only 
one alignment can be current at a time, even though a project may have sev-
eral alignments. The current alignment is the alignment that is referenced in 
all subsequent alignment commands. You can choose a different current 
alignment at any time. Each time you open a drawing, you must choose 
which alignment you want to work on.

TIP If you’re not sure which alignment is set as current in your drawing, you 
can use the Display Current command. For more information, see “Displaying 
Which Alignment Is Current” on page 463.

When you make an alignment current, a lock file is created for that align-
ment. This lock file prevents other people working on a network (or yourself, 
if you are running more than one session of AutoCAD Land Development 
Desktop) from editing the alignment that you have set as current.

NOTE When you define an alignment, it automatically becomes the current 
working alignment.
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� From the Alignments menu, choose Set Current Alignment. 
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You can make an alignment current by clicking on the alignment, by select-
ing the alignment from the Alignment Librarian dialog box, or by entering 
the alignment name or the alignment number. 

� Do one of the following:

� Click the alignment in your drawing to make it current and to end the 
command. If you used the selected object in more than one alignment 
definition, then the following prompt is displayed:
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The prompt displays the number, name, and description for each align-
ment name that has been assigned to these objects. 

� Specify No until the correct alignment name is displayed.
� Specify Yes when the correct alignment name is displayed. 

If you want to select the alignment by specifying its name or number, 
then use one of the following methods to select it:

� Press ENTER to display the Alignment Librarian dialog box. From the Selec-
tion list in the Alignment Librarian dialog box, select the alignment you 
want to set as current, and click OK.

� Type the alignment name in the Name box.

� Press ENTER to display the Alignment Librarian dialog box, and then click 
Cancel or press ESC to close the dialog box. The following prompt is 
displayed: 
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436 | Chapter 20 Alignments

Type the number of the alignment you want to set as current. 

Defining Alignments

After drawing an alignment, you must define it, which creates a link between 
the objects and the alignment database. The alignment database, align-
ment.mdb, is created when the first alignment is defined in the project.

You can define an alignment in two ways: you can define a combination of 
line, curve, and spiral objects as an alignment, or define a polyline as an 
alignment. Any spirals that you want to use in an alignment must be created 
using the Spiral commands on the Lines/Curves menu. In addition, when 
you create offsets for an alignment, you have the option of defining these off-
sets as alignments. 

When you define an alignment, that alignment is set as the current align-
ment in your drawing, and a lock file is created for it. When you create off-
sets, the centerline alignment (that you are offsetting) remains the current 
alignment after the offsets are defined.

For more information about the alignment database, see “The Horizontal 
Alignment Database” on page 426.

You establish the station range for the alignment when you define it. If you 
must change the stationing of an alignment with station equations, you can 
use the Station Equations command.

Defining an Alignment from Objects

You can define an alignment from a combination of line, curve, and spiral 
objects in your drawing. The objects that you draw must meet end-to-end, 
with no gaps in between, or the complete alignment cannot be defined. Use 
Object Snaps when drawing the alignment to ensure that the objects 
connect. 

NOTE You cannot use this command to define an alignment from a polyline; 
use the Define from Polyline command instead. For more information, see 
“Defining an Alignment from a Polyline” on page 438.

������������
�����������
�������������������
��������

� From the Alignments menu, choose Define from Objects.

� Select the first object nearest its point of beginning (POB). 
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The command snaps to the nearest endpoint of the object. An X automati-
cally appears at the nearest end of the line, curve, or spiral to indicate the 
start point of the alignment. If the X appears at the wrong end of the object, 
then cancel the command and try again by selecting closer to the other end 
of the first object.

� Select the remainder of the objects that you want to define as an alignment. 
The following illustration shows how to select several objects:
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NOTE If you use a window or crossing to select the objects, then the com-
mand filters out any objects that are not connected to the alignment (for exam-
ple, points or blocks).

� After you finish selecting the objects, press ENTER. 

� Press ENTER to accept the default stationing reference point or select a new 
reference point for defining the stationing. The alignment stationing is cal-
culated by applying the starting station value that is entered in the Define 
Alignment dialog box to this reference point. The default is the start point of 
the alignment, but you can select any point on the alignment. 

 In the Alignment Name box, type the alignment name. The alignment name 
can be up to 40 characters and can include any alphanumeric symbol. If you 
use a name that you have used previously, then you are prompted whether 
you want to overwrite the existing alignment after you click OK to exit the 
dialog box.
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! In the Description box, type the alignment description. The alignment 
description can be up to 80 characters in length and can include any alpha-
numeric symbol. 

" In the Starting Station box, review the starting station and change it if nec-
essary. The starting station listed is the reference point you selected in step 5. 
This station can have a negative value. When entering the starting station 
value, do not include the plus sign (+). Enter station 10+00 as 1000.

# Click OK.

The command records the new alignment in the alignment database file and 
the alignment is set as current. The Define from Objects command lists the 
starting and ending station and the length of the alignment defined, as well 
as the name, number, and description. 

NOTE The alignment number is automatically generated and cannot be 
changed.

The following is an example of defined alignment data:
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NOTE When you define an alignment that contains one or more spirals, then 
the message “Superelevation data created” is displayed on the command line.

For any spirals that were created with the Create Curves command from the 
Lines/Curves ➤ Speed Tables menu, the superelevation information from the 
speed table is written to the superelevation parameters. For spirals that were cre-
ated with any command other then the Create Curves command, then the 
default Civil Design Superelevation Control drawing settings are used for max e, 
runoff, runout, and so on.

Defining an Alignment from a Polyline

You can define a single polyline as an alignment. When you define an align-
ment from a polyline, it is defined in the direction in which you drew the 
polyline. The polyline you select can be a 2D, lightweight, or 3D polyline. If 
you use a 3D polyline, the elevational data is not used in the alignment 
definition.
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NOTE You cannot use this command to define an alignment from lines, 
curves, and spirals; use the Define from Objects command instead. for more 
information, see “Defining an Alignment from Objects” on page 436.
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� From the Alignments menu, choose Define from Polyline.

� Select a polyline. 

An X appears at the start point of the polyline (the first point that was drawn 
when the polyline was created). The command then connects the polyline 
vertices. 

� Press ENTER to accept the default stationing reference point, or select a new 
reference point for defining the stationing. The alignment stationing is cal-
culated by applying the starting station value that is entered in the Define 
Alignment dialog box to this reference point. The default is the start point of 
the alignment, but you can select any point on the alignment. 

The Define Alignment dialog box is displayed.

� In the Alignment box, type the alignment name. The alignment name can 
be up to 40 characters and can include any alphanumeric symbol. If you use 
a name that you have used previously, then you are prompted whether you 
want to overwrite the existing alignment after you click OK to exit the dialog 
box.

� In the Description box, type the alignment description. The alignment 
description can be up to 80 characters in length and can include any alpha-
numeric symbol. 

 In the Starting Station box, review the starting station and change it if nec-
essary. The starting station listed is the reference point you selected in step 3. 
This station can have a negative value. When entering the starting station 
value, do not include the plus sign (+). Enter station 10+00 as 1000.

! Click OK.

The command lists information about the alignment including the name, 
number, description, length, and starting and ending stations, and the new 
alignment is set as current.

NOTE The alignment number is automatically generated and cannot be 
edited.

The following is an example of defined alignment data:

5555555555555555555�4	6:/39/��*4�4�5555555555555555555555
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Creating Offsets for an Alignment

After you define the centerline alignment, you can add alignment offsets. 
The following illustration shows an example of alignment offsets:
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You can create up to eight offsets (four per side) at one time. If you need more 
than eight offsets for an alignment, then run the Create Offsets command 
again using new distances, layer names, and alignment names. When you 
create offsets, you have the option of defining the offsets as alignments.

NOTE You should select the current alignment before using this command. If 
no alignment is set as current, then you are prompted to select the current align-
ment when you run the Create Offsets command.
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� From the Alignments menu, choose Create Offsets to display the Alignment 
Offset Settings dialog box. 
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NOTE This dialog box is also available from the Projects ➤ Drawing Settings 
command so you can configure the offset defaults and save them to a prototype.

� Select the Define offset alignments check box to define the offsets to the 
alignment database when they are created. If you do not want the offsets to 
be added to the alignment database, then clear this check box. 

� If you selected the Define offset alignments check box, the Name prefix box 
becomes active. In the Name prefix box, type the (offset) alignment name 
prefix. This prefix is added to the alignment offset names to become the full 
name of the alignments that are created from the offsets. 

Use the following guidelines for naming offsets:

� The name prefix can be no longer than 20 characters.
� The left and right offset names can be no longer than 40 characters.
� The total alignment name length can be no longer than 40 characters.

Therefore, if you are prefixing the alignment names with 20 characters, you 
should limit the left and right alignment name length to 20 characters or 
they will be truncated when the offsets are created.

NOTE You can type an asterisk (*) in the Name prefix box to use the centerline 
alignment name as the prefix for the offset alignments. The asterisk is counted 
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as one character. You may also want to follow this asterisk with a dash (-) to sep-
arate the name.

� Choose which offsets to create by selecting the Outer offset, Second offset, 
Third offset, or Inner offset check boxes.

� In the Left offset and Right offset boxes, type the offset distances. Normally 
you would type in a positive value, but you can enter a negative number to 
draw the offset on the opposite site of the alignment. If an offset is not 
needed, enter zero (0). The command determines the left and right sides of 
an alignment based on station progression.

Offset widths do not need to be symmetrical; the left and right widths of the 
alignment can vary. The following illustration shows of symmetrical and 
asymmetrical offsets:
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 In the Left name and Right name boxes, type the offset names if you have 
selected the option to define new alignments from the offsets. The length of 
the names you type in the Left name and Right name boxes are limited to 40 
characters which is also the limit for an alignment name. These names are 
combined with the name prefix you set to become the full alignment offset 
names. If the combination of the name and the name prefix exceeds 40 char-
acters the name will be truncated. 

! In the Layer boxes, type the layer name for each offset. Both right and left 
offsets are placed on the same layer. If the layers do not exist, then the Create 
Offsets command creates them. When you create offsets, the layers specified 
in the dialog box are thawed and turned on if they exist.

" Click OK to exit the dialog box and create the offsets for the current align-
ment. If no alignment is set as current, then you are prompted to select the 
current alignment for which you want to create the offsets.



Using Station Equations to Change the Stationing of an Alignment | 443

Using Station Equations to Change the 
Stationing of an Alignment

Use station equations to change a station value. Station equations are used 
for creating station labels, and for creating, listing, and labeling profiles and 
cross sections.

If you create station equations or make changes to existing equations, then 
you must re-label the alignment with the Create Stations command. For 
more information, see “Creating Station Labels on an Alignment” on page 
480.

The following illustration shows the selection point on an alignment for 
placing station equations: 
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NOTE In some instances when adjusting stationing with station equations, 
duplicate station numbers are created for an alignment. 

If so, then several commands that require station numbers, such as the Create 
Stations command, will display the Duplicate Station Selection dialog box before 
proceeding.

This dialog box displays the duplicate stations in a scrolling list. To help you choose 
the correct station, each station lists the station back associated with it. The station 
back is the original station on the alignment before the equation was applied.

Clearing Station Equations
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� From the Alignments menu, choose Station Equations. 
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The Equations command displays the current alignment information and 
any station equations defined for it. Following is an example of station equa-
tion information:
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The following prompt is displayed: 
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� Type Clear. When you type Clear to remove all defined station equations for 
the current alignment, a confirmation prompt is displayed. 

� Type Yes to remove all station equations, or type No to exit the option with-
out removing any equations. 

Adding Station Equations
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� From the Alignments menu, choose Station Equations. 

The Equations command displays the current alignment information and 
any station equations defined for it. Following is an example of station equa-
tion information:
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The following prompt is displayed: 
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� Type Add.

� Select the location for the equation. The station equation takes effect from 
this point, and is called the station back. You can use Object Snaps to select 
the point if needed. For more information, see “Snapping to Points on 
Objects“ in the AutoCAD User’s Guide.

The station of the point you selected is displayed at the command line.

� Press ENTER to accept the station of the point you selected, or type a new sta-
tion value for the station back. 

� Type the station ahead. This is the station assigned to the next point on the 
alignment. 

The following prompt is displayed:
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 Do one of the following to specify the station order:

� Type Increase to continue stationing the alignment in increasing station 
value increments.

� Type Decrease to continue stationing the alignment in decreasing station 
value increments. 

Information about the station equation is then displayed in the text window. 
Make a note of the equation number(s); you must supply an equation num-
ber if you need to modify the station equation in the future.
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In some instances, duplicate stationing occurs when you apply station equa-
tions to an alignment.

Modifying Station Equations

��������$���������&������

� From the Alignments menu, choose Station Equations. 

The Equations command displays the current alignment information and 
any station equations defined for it. Following is an example of station equa-
tion information:
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The following prompt is displayed: 
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� Type Modify. 

� Type the equation number you want to modify. 

NOTE This number is generated when you create a station equation and is dis-
played in the text window. For more information, see “Adding Station Equa-
tions” on page 444.
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� Type the new value for the station back.

� Type the reference station (which is the new station ahead).

 Do one of the following to specify the station order:

� Type Increase to continue stationing the alignment in increasing station 
value increments.

� Type Decrease to continue stationing the alignment in decreasing station 
value increments. 

The station equation is modified and an updated list of defined equations is 
displayed in the text window.

Deleting Station Equations
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� From the Alignments menu, choose Station Equations. 

The Equations command displays the current alignment information and 
any station equations defined for it. Following is an example of station equa-
tion information:
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The following prompt is displayed: 
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� Type Delete.

� If only one station equation is defined when you type Delete to delete sta-
tion equations, then that equation is deleted. 

� If several equations are defined, then type the equation number to delete. 

NOTE This number is generated when you create a station equation and is 
displayed in the text window. For more information, see “Adding Station 
Equations” on page 444.

The station equation is then removed and an updated list of defined equa-
tions is displayed in the text window.
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Exiting the Equations Command

���������������&������

� From the Alignments menu, choose Station Equations. 

The Equations command displays the current alignment information and 
any station equations defined for it. Following is an example of station equa-
tion information:
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The following prompt is displayed: 
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� Type Exit.

When you type ✕ to exit the Equations command, all equation information 
is saved and applied to the horizontal and vertical alignments. 

If you previously created a profile or stationed the alignment, then you must 
do these tasks again in order to incorporate the changes made to the station 
equations.

Editing Horizontal Alignments

To edit an alignment after defining it, you can:

� Edit the individual objects or polyline and then redefine the alignment.
� Use a tabular editor called the Horizontal Alignment Editor.

This topic describes how to use the Horizontal Alignment Editor. When you 
make and save any changes in the Horizontal Alignment Editor, the changes 
are automatically updated in the drawing, and the changes are saved to the 
alignment database.

The Horizontal Alignment Editor lists each Point of Intersection (PI) in an 
alignment where a new objects starts. It also lists the start and end points of 
an alignment. For example, if you define an alignment that is composed of 
a straight line segment, a curve segment, and another line segment, then you 
see five stations listed in the Horizontal Alignment Editor:

� The first PI is the start point of the alignment.
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� The second PI is the Point of Curvature (PC) where the tangent meets the 
curve.

� The third PI is the Point of Intersection for the curve.
� The fourth PI is the Point of Tangency (PT) where the curve meets the 

tangent.
� The fifth PI is the end point of the alignment.

You can insert and delete Points of Intersection in the Horizontal Alignment 
Editor. The Horizontal Alignment Editor shows each PI station in the align-
ment. Each of these PIs is listed in the Station column, along with the North-
ing and Easting coordinates for each station. 

� The Distance column shows the distance between the PIs. 
� The type of angle displayed in the Direction column is the angle type that 

you chose when setting up the drawing. This is the reference angle of the 
object that exists between the two PIs.

� The station of a curve is equal to the PC station, plus the curve tangent 
length.

You can edit a curve PI by placing your cursor in the row that lists the PI of 
the curve and clicking Edit Curve. The following illustration shows a curve 
PI:
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You can edit a spiral PI by placing your cursor in the row that lists the PI of 
the spiral and clicking Edit Spiral. The following illustration shows a spiral PI:



Editing Horizontal Alignments | 449

�����
�������������������

Navigation Buttons
Within the Horizontal Alignment Editor, you can locate the PI you want to 
edit by using the following navigation buttons:

Inserting, Deleting, or Editing an Alignment 
Point of Intersection

You can insert, delete, and edit points of intersection in an alignment. A 
point of intersection is where two tangents meet. In the Horizontal Align-
ment Editor, the start and end points of an alignment are also considered PIs.

In AutoCAD Land Development Desktop, curves and spirals are drawn tan-
gent to the object they are drawn from. For curves and spirals, the PI is the 
virtual location where the two tangents would meet.

Home Moves the display to the first PI.

Page Up Moves up one page.

Up Moves up one row.

Down Moves down one row.

Page Down Moves down one page.

End Moves to the last PI.
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� You can do any of the following:

� Insert a Point of Intersection by placing your cursor in the row of the sta-
tion above which you want to insert the point of intersection, and then 
click Insert PI. 

� Delete a Point of Intersection by placing your cursor in the row of the sta-
tion that you want to delete, and then click Delete PI.

� Edit a Point of Intersection by placing your cursor in the row of the PI that 
you want to edit, and then edit the Northing and Easting coordinate val-
ues to change the location of a point of intersection. After you change the 
northing and easting values, the station, distance between the PIs, and 
direction values for the PI are automatically recalculated to reflect the new 
point of intersection coordinates.

NOTE If you edit a point of intersection with the Horizontal Alignment 
Editor, then the associated curve or spiral information is recalculated. The 
circular curve radius and the spiral lengths are maintained.
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Editing a Horizontal Alignment Curve

Use the Horizontal Alignment Editor to edit alignment curve parameters. 
The following illustration shows the curve parameters that you can either 
view or edit using the Horizontal Alignment Editor:
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Place your cursor in the row that lists the Point of Intersection (PI) for the 
curve that you want to edit. Use the navigation buttons if necessary. 

� Click Edit Curve to display the Curve Detail Window dialog box.



452 | Chapter 20 Alignments

Under Curve Stations, the station, northing, and easting information is dis-
played for the following items: 

� PC: Point of Curvature
� PI: Point of Intersection
� PT: Point of Tangency
� RP: Radius Point

You cannot edit this data. If the current PI has no curve, then only the PI sta-
tion, northing and easting, and overall PI central angle are displayed.

� You can edit the following information for the curve: 

� R: Radius 
� L: Length of curve
� Tc: Tangent length of the circular curve
� LC: Length of long chord
� D: Degree of curve
� Mc: Middle ordinate of the circular curve
� Ec:  External secant of the circular curve

After you make a change, press ENTER to accept the change and move to the 
next edit box. If you change any of the parameters, then the curve is recalcu-
lated based on the altered parameter. 

You can view, but not edit, the following information:

� lc: Central angle of the circular curve 
� I: Total central angle of the overall PI (curves and spirals) when a spiral 

exists
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� To move between the next or previous curves in the alignment, click the 
Next or Previous buttons.

 To edit a spiral, you can click the Spiral button to display the Spiral Detail 
Window. For more information, see “Editing Horizontal Alignments” on 
page 447.

! Click OK to return to the Horizontal Alignment Editor dialog box, or click 
Cancel. 

NOTE Clicking OK in the Curve Detail Window does not save the changes you 
made. You must click Save on the Horizontal Alignment Editor dialog box to save 
the edits you made to the curve(s).

Editing a Horizontal Alignment Spiral

Use the Horizontal Alignment Editor to edit both the radius of an alignment 
spiral curve and the spiral lengths. 
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Place your cursor in the row that lists the Point of Intersection (PI) informa-
tion for the spiral that you want to edit. Use the navigation buttons if 
necessary. 

� Click Edit Spiral to display the Spiral Detail Window. 
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Under Spiral Stations, the station, northing, and easting information is dis-
played for the following items: 

� TS: Point of change from tangent to spiral
� SC: Point of change from spiral to circular curve
� CS: Point of change from circular curve to spiral
� ST: Point of change from spiral to tangent

� You can edit the following three spiral parameters:

� Radius, which is the spiral radius at the SC or CS. Changing the radius for 
a spiral also changes the radius of the adjacent curve.

� L1, which is the total length of spiral from TS to SC.
� L2, which is the total length of spiral from CS to ST.

If you change the spiral lengths, then the command recalculates the circular 
curve for that PI and maintains the radius. If the spiral lengths exceed the 
limits of geometric possibility, then the error message Spirals are too large for 
the delta angle of the PI is displayed.

After you make an edit, press ENTER to accept the edit and move to the next 
edit box.
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� You can view, but not edit, the following spiral parameters:

For an explanation of these parameters, see “Spiral Parameters” on page 455.

 To move between the next or previous spirals in the alignment, click the Next 
or Previous buttons.

! To edit a curve, click the Curve button to display the Curve Detail Window. 
For more information, see “Editing Horizontal Alignments” on page 447.

" Click OK to return to the Horizontal Alignment Editor dialog box, or click 
Cancel.

NOTE Clicking OK in the Spiral Detail Window does not save the changes you 
made. You must click Save on the Horizontal Alignment Editor dialog box to save 
the edits you made to the spiral(s).

Spiral Parameters
The following illustration shows some of the spiral parameters you can view, 
and some parameters that you can edit:

L1 L2S T1 T2 

X1 X2 Y1 Y2 

P1 P2 K1 K2 

LT1 LT2 ST1 ST2 

A1 A2 
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Spiral parameter descriptions
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L1 The Central Q angle of spiral curve L1, which is the spiral 
angle.

L2 The Central Q angle of spiral curve L2, which is the spiral 
angle.

T1 The total tangent distance from PI to TS.

T2 The total tangent distance from PI to ST.

X1 The tangent distance at SC from TS.

X2 The tangent distance at CS from ST.

Y1 The tangent distance at SC from TS.

Y2 The offset distance at CS from ST.

P1 The offset of the initial tangent into the PC of the shifted curve.

P2 The offset of the initial tangent out to the PT of the shifted 
curve.

K1 The abscissa of the shifted PC referred to the TS.

K2 The abscissa of the shifted PT referred to the ST.
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Reporting Data About a Horizontal 
Alignment

You can generate reports about the horizontal alignments in a project that 
are based on the stations of an alignment, the curves in an alignment, and 
the station information based on increments.
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Click Settings to display the Output Settings dialog box. For more informa-
tion, see “Changing the Output Settings” on page 79.

LT1 The long tangent of spiral in.

LT2 The long tangent of spiral out.

ST1 The short tangent of spiral in.

ST2 The short tangent of spiral out.

Other spiral parameters
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A1 Flatness of spiral in. The A value equals the square root of the 
spiral length multiplied by the radius. A measure of the flatness 
of a spiral.

A2 Flatness of spiral out. The A value equals the square root of the 
spiral length multiplied by the radius. A measure of the flatness 
of a spiral.

Spiral parameter descriptions (continued)
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� Each time you create a report, be sure to change the default output file 
name so you do not overwrite the previous report.

� To keep a running record of all horizontal alignment data, clear the Over-
write file check box. 

� The Page breaks check box applies only to the screen display. The align-
ment reports are not displayed to the screen because the information is 
already available for viewing in the Horizontal Alignment Editor. 

� Click OK to return to the Horizontal Alignment Editor.

� You can generate reports for alignment data by Station, Curve, Station and 
Curve, and by Increments: 

� Station: For more information, see “Reporting Alignment Data by Sta-
tion” on page 458.

� Curve: For more information, see “Reporting Alignment Data by Curve” 
on page 459.

� Station and Curve: For more information, see “Reporting Alignment 
Data by Station and Curve” on page 460.

� By Increment: For more information, see “Reporting Alignment Data By 
Increments” on page 461.

Reporting Alignment Data by Station

The Station option reports all the horizontal tangent information for a range 
of stations to a file. The content and format of this file is similar to the one 
used to display information in the Horizontal Alignment Editor. No horizon-
tal curve information is written using this selection.
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Click Settings to display the Output Settings dialog box. For more informa-
tion, see “Changing the Output Settings” on page 79.

� Each time you create a report, be sure to change the default output file 
name so you do not overwrite the previous report.

� To keep a running record of all horizontal alignment data, clear the Over-
write file check box. 

� The Page breaks check box applies only to the screen display. The align-
ment reports are not displayed to the screen because the information is 
already available for viewing in the Horizontal Alignment Editor. 

� Click OK to return to the Horizontal Alignment Editor.

� To generate a station report, click the Station button. 

� Type the beginning station in the range of stations you want to report. 

 Type the ending station of the range.

! Accept the default output file name by pressing ENTER, or type a new file 
name.

Reporting Alignment Data by Curve

The Curve option writes all the horizontal curve information for the current 
alignment to a file. The content and format of this file is similar to the one 
used in the Curve Detail dialog box. 
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Click Settings to display the Output Settings dialog box. For more informa-
tion, see “Changing the Output Settings” on page 79.

� Each time you create a report, be sure to change the default output file 
name so you do not overwrite the previous report.

� To keep a running record of all horizontal alignment data, clear the Over-
write file check box. 

� The Page breaks check box applies only to the screen display. The align-
ment reports are not displayed to the screen because the information is 
already available for viewing in the Horizontal Alignment Editor. 

� Click OK to return to the Horizontal Alignment Editor.

� To generate a Curve report, click the Curve button.

� Type the beginning station in the range of stations you want to report. 

 Type the ending station of the range.

! Accept the default output file name by pressing ENTER, or type a new file name.

Reporting Alignment Data by Station and Curve

The Station and Curve option writes all the horizontal alignment informa-
tion for the current alignment to a file. This option outputs the tangent 
information interspersed with horizontal curve information at the appropri-
ate PVI stations.
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Click Settings to display the Output Settings dialog box. For more informa-
tion, see “Changing the Output Settings” on page 79.

� Each time you create a report, be sure to change the default output file 
name so you do not overwrite the previous report.

� To keep a running record of all horizontal alignment data, clear the Over-
write file check box. 

� The Page breaks check box applies only to the screen display. The align-
ment reports are not displayed to the screen because the information is 
already available for viewing in the Horizontal Alignment Editor. 

� Click OK to return to the Horizontal Alignment Editor.

� To generate a Station and Curve report, click the Station and Curve button.

� Type the beginning station in the range of stations you want to report. 

 Type the ending station of the range.

! Accept the default output file name by pressing ENTER, or type a new file name.

Reporting Alignment Data By Increments

The By Increment option writes horizontal alignment information to a file. 
This information displays according to an entered increment. 
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� From the Alignments menu, choose Edit to display the Horizontal Alignment 
Editor.

� Click Settings to display the Output Settings dialog box. For more informa-
tion, see “Changing the Output Settings” on page 79.

� Each time you create a report, be sure to change the default output file 
name so you do not overwrite the previous report.

� To keep a running record of all horizontal alignment data, clear the Over-
write file check box. 

The Page breaks check box applies only to the screen display. The alignment 
reports are not displayed to the screen because the information is already 
available for viewing in the Horizontal Alignment Editor. 

� Click OK to return to the Horizontal Alignment Editor.

� To generate a generate a horizontal alignment report by increment, click the 
By Increment button.

� Type the beginning station in the range of stations you want to report. 

 Type the ending station of the range.

! Type the increment by which you want to report the data.

" Accept the default output file name by pressing ENTER, or type a new file 
name.

The command outputs the station, northing and easting, and tangential 
direction at the specified increment.
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Displaying Which Alignment Is Current

You can display which alignment is the current alignment by using the 
Display Current command.
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� From the Alignments menu, choose Display Current.

The text window displays information about the current alignment. This 
information includes the alignment name, number, description, and starting 
and ending stations.

� Click OK.

Listing the Alignments Defined in the 
Current Project

If you want to see information about all of the alignments that exist in the 
project, then use the List Defined command.
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� From the Alignments menu, choose List Defined. 

The text window displays information on all alignments defined in the 
project. This information includes the alignment number, type, name, and 
description. 

� Press any key to return to the graphics screen.

Importing and Deleting Alignments

You may need to import a horizontal alignment into a drawing if you:

� Delete an alignment from the drawing (but do not delete it from the hor-
izontal alignment database) and you want to add the alignment back into 
the drawing.

� Define an alignment in a different drawing and need to bring it into the 
current drawing in the same project.
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NOTE Use the Merge Database command to bring an alignment from a dif-
ferent project into the current project. For more information, see “Merging 
Alignments from Different Projects” on page 471.

NOTE If you import an alignment that already exists in the drawing, then 
either delete the existing alignment to prevent outdated alignments from 
remaining in the drawing, or move it to a different layer.

You can delete an alignment from the drawing, the database, or both. When 
deleting alignments, you can also choose to delete the Autodesk Civil Design 
profile and cross section files at the same time. If you delete an alignment 
from the drawing, then you can always use the Import command to reinsert 
it. If you delete the alignment from the alignment database, then you can 
recreate the definition from the graphical objects. If you delete the alignment 
from both the screen and the database, then you cannot restore the align-
ment unless you redraw it.

Importing a Horizontal Alignment

You can import one horizontal alignment at a time into the drawing from the 
horizontal alignment database by using the Import command.

NOTE To import more than one alignment at the same time, use the Multiple 
Selections command. For more information, see “Importing Multiple Horizon-
tal Alignments” on page 466.

NOTE To bring alignments from another project into the drawing, you must 
first merge the other project’s alignment database with the alignment database 
of the current project. Then use the Import command to bring the merged align-
ments into the drawing.
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� From the Alignments menu, choose Import to display the Alignment Librar-
ian dialog box.

� Do one of the following to select the alignment to import:

� Select the name of the alignment you want to import.
� Click Cancel, and then type the number of the alignment you want to 

import.
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The alignment is imported onto the current layer. 

NOTE Alignments that were defined from a polyline are not imported as 
polylines; they are imported as individual objects, such as lines and curves.

Deleting a Horizontal Alignment

You can delete an alignment from the horizontal alignment database file 
and/or from the drawing. You can also delete all related vertical data (profile 
and cross section data) for the alignment simultaneously.

When you delete an alignment from the drawing, you can still access the 
data and you can also import the alignment back into the drawing later if 
needed. For more information, see “Importing a Horizontal Alignment” on 
page 464.

NOTE You cannot delete an alignment or its profile or cross section files from 
the project if the alignment is locked by another person, but you can delete the 
alignment from the drawing.

WARNING! You cannot restore an alignment after you delete it from both 
the database and the drawing unless you redraw then redefine it manually.
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� From the Alignments menu, choose Delete. 

The following prompt is displayed:

*������A����7����+<�����+;��"2��;��"��

� Do one of the following to specify what to delete:

� Type Both to delete the alignment from both the database and the 
drawing.

� Type File to delete the alignment from the database.
� Type Screen to delete the alignment from the drawing.

� Select the alignment you want to delete. You can click on the alignment if it 
was defined from lines, arcs, and/or spirals, or you can press ENTER to display 
the Alignment Librarian dialog box and select the alignment name. For more 
information, see “Making an Alignment Current” on page 434. 

The following prompt is displayed:
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� Type Yes if you want to delete the profile and cross section files, or type No 
to save the profile and cross section files.

NOTE To delete more than one alignment at a time, use the Multiple Selec-
tions command. For more information, see “Deleting Multiple Horizontal 
Alignments” on page 467.

Importing Multiple Horizontal Alignments

You can import multiple horizontal alignments into the drawing from the 
horizontal alignment database by using the Multiple Selections command.
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� From the Alignments menu, choose Alignment Commands ➤ Multiple 
Selections to display the Multiple Alignments Librarian dialog box.

� Under Selection, click each alignment you want to import. Selected align-
ments are marked by asterisks (*). You can click an alignment again to clear 
the selection.

� Click Import to insert the alignments into the drawing on the current layer.
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TIP After you import the alignments, you can select an alignment from the 
Selection list and then click Select to set that alignment current and close the 
dialog box.

� Click OK.

Deleting Multiple Horizontal Alignments

You can delete more than one alignment at a time by using the Multiple 
Selections command. You can delete multiple alignments from the horizon-
tal alignment database file and/or from the drawing. You can also delete all 
related vertical data (profile and cross section data) for the alignments 
simultaneously. 

When you delete alignments from the drawing, you can still access the data 
and import the alignments back into the drawing later if needed. For more 
information, see “Importing a Horizontal Alignment” on page 464.

NOTE You cannot delete an alignment or its profile or cross section files from 
the project if the alignment is locked by another person, but you can delete the 
alignment from the drawing.

WARNING! You cannot restore alignments after you delete them from both 
the database and the drawing.
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� From the Alignments menu, choose Alignment Commands ➤ Multiple 
Selections to display the Multiple Alignments Librarian dialog box.

� Under Selection, click each alignment you want to delete. Selected align-
ments are marked by asterisks (*). You can click an alignment again to clear 
the selection.

� Under Delete Options, select one or more of the Delete options:

� Delete from screen: Deletes the alignments from the drawing.
� Delete from database: Deletes the alignments from the horizontal align-

ment database.
� Delete vertical files: Deletes the alignments’ profile and cross section 

files. 

� Click Delete to display a confirmation dialog box. 
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� Click Yes to delete the alignments, or click No to cancel the command.

TIP After you delete the alignments, you can select an alignment from the 
Selection list and then click Select to set that alignment current and close the 
dialog box.

 Click OK.

Changing the Properties of Alignments

You can change the description, color, linetype, or layer of the current align-
ment by using the Modify Properties command. The color, linetype, and 
layer modifications change the objects that comprise the alignment in the 
current drawing. Alignment description changes are made to the alignment 
database, and are reflected in the commands that display the alignment 
information such as the Import and Edit commands.

NOTE The Modify Properties command Color, Layer, and Linetype options 
work only on alignments that have been defined from lines, curves, or spirals. If 
you want to modify the properties of an alignment that was defined from a 
polyline, delete the alignment from the drawing (not from the database) and 
then import the alignment back into the drawing. When you import polyline 
alignments back into a drawing they are imported as lines and arcs.

Moving an Alignment to a Different Layer

When you move an alignment to a different layer, the objects that comprise 
the alignment, such as the polyline, lines, curves, or spirals, are moved to the 
new layer. The objects take on the properties of the new layer, such as the 
layer color and linetype.
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� From the Alignments menu, choose Alignment Commands ➤ Modify 
Properties. 
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� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

The following prompt is displayed:
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� Type Layer to change the layer.

� Type the name of the layer on which you want to place the alignment 
objects. 

Layer names can be up to 255 characters.

Changing the Color of an Alignment 

You can change the color of the objects that comprise an alignment without 
modifying the alignment’s layer properties. 
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� From the Alignments menu, choose Alignment Commands ➤ Modify 
Properties. 

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

The following prompt is displayed:
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� Type Color to change the color. 

The following prompt is displayed:
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� Do one of the following to define the color:

� Type the first character of the color name. For example, type R for red.
� Type Number, press ENTER, and then type a Windows color number.

Alignment colors

'�
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1 Red

2 Yellow

3 Green

4 Cyan
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In addition, you can use any other color number from 0–255.

Changing the Linetype of an Alignment

You can change the linetype of the objects that comprise the current align-
ment without modifying the alignment’s layer properties. 
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� From the Alignments menu, choose Alignment Commands ➤ Modify 
Properties. 

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

The following prompt is displayed:
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� Type LType to change the linetype. 

� Type the linetype name. This linetype must exist in the drawing.

Changing the Description of an Alignment

You can change the description of an alignment after you define it. Align-
ment description changes are saved to the alignment database, and are 
reflected in the commands that display the alignment information such as 
the alignment Import and Edit commands.
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� From the Alignments menu, choose Alignment Commands ➤ Modify 
Properties. 

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

The following prompt is displayed:
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� Type Description to change the description.

5 Dark blue

6 Magenta

7 White or black, depending on 
background color of AutoCAD
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� Type the new description. 

The description can be up to 255 alphanumeric characters in length.

Merging Alignments from Different Projects

If you want to access alignments in another project, then you can merge 
alignments to copy them from that project into the current project. You can 
merge all of the alignments from the selected project file, or just a few 
selected alignments. You also have the option to include profile and cross 
section files in the merge.

When you merge databases, the alignments from the selected project are cop-
ied into the current project’s alignment.mdb file. To insert the merged align-
ments into a drawing, use the Import or the Multiple Selections command. 
When you merge the profile and cross section files, those files are copied into 
the following folder:

c:\Land Projects R2\<project name>\align\<alignment name> 

You can merge both alignment.mdb files (Release 2 files) and project.adb files 
from Release 1 of AutoCAD Land Development Desktop or Softdesk 8. 

NOTE Alignments from the source project can be merged even if they are 
locked. For example, if someone is working on an alignment in Project 1, and 
you want to merge that alignment into Project 2, the person working on Project 
1 does not have to release the lock on the alignment. The merge command has 
no effect on the source project. However, if someone other than you is working 
in the current “destination” project and has an alignment lock, then you cannot 
merge databases. To close the alignment database, use the Close Database com-
mand. For more information about the alignment database, see “The Horizon-
tal Alignment Database” on page 426.

����������
�������

� From the Alignments menu, choose Alignment Commands ➤ Merge 
Database to display the Select Source Alignment Database dialog box.

The Select Source Alignment Database dialog box is displayed. By default, the 
Files of type list displays LDDT R2 (*.mdb). These files are the AutoCAD Land 
Development Desktop Release 2 alignment database files. If you want to 
merge an alignment from a project you completed in Release 1 of AutoCAD 
Land Development Desktop or Softdesk, then select S7/LDDT R1 (*.adb) from 
the Files of type list.
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� Select the file you want to merge from the following folder of the project 
from which you want to merge the alignment:

c:\Land Projects R2\<project name>\align

You cannot select the alignment database for the current project.

� Click Open.

The Alignment Selection for Merge Database dialog box is displayed. This 
dialog box displays the alignment names from the selected project’s align-
ment database. 

NOTE To allow the use of long alignment file names for Release 1 of AutoCAD 
Land Development Desktop, a file named longfilenamesystem.mdb was created. 
If that file no longer exists in your project folder when you attempt to merge an 
.adb file into the current project, then short file names are shown in the Align-
ment Selection for Merge Database dialog box, and the merged alignments will 
have short file names.

� To select the names of the alignment(s) you want to merge, do one of the 
following:

� Select the name(s) of the alignment(s) that you want to merge by clicking 
on their names. Use SHIFT and CTRL to select a sequential list or a 
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non-sequential list of alignments. When an alignment is selected, its 
name is highlighted. Click on a highlighted alignment name to clear it 
from the selection.

� Click Select All to select all the alignments.
� Click Clear All to clear the selection set and then make a new selection.

� To merge the profile and cross section files, select the Include profile and 
cross section files check box. The files that are merged include *.tcd, *.tcp, 
*.tdf, *.vrt, *.xsd, *.xsp, and *.err. These files are placed in the following folder 
of the current project:

c:\Land Projects R2\<project name>\align\<alignment name>

 To import the alignments into the current drawing as they are merged into 
the project, select the Import alignments into drawing as merged check box.

! Click OK to merge the alignments.

If the alignment name already exists in the current project, then the Align-
ment Database Merge Warning dialog box is displayed. 

You can use the options in this dialog box to determine how to handle dupli-
cate incoming alignments. 

TIP Before you select to rename, skip, or overwrite an alignment name, decide 
whether you want to apply your choice to all other duplicate alignments, or just 
the alignment name that is shown in the Alignment Database Merge Warning 
dialog box. If you want to rename all duplicate alignments, for example, then 
select the Apply this choice to all subsequent existing alignments for this merge 
check box before you click Rename. If you do not select this check box, then the 
Alignment Database Merge Warning dialog box will be displayed for each dupli-
cate incoming alignment.

" Do one of the following to determine how to handle duplicate alignments:

� Click Rename to display the Rename Incoming Alignment dialog box, 
where you can assign a new name to the incoming alignment.
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� Click Overwrite to overwrite the alignment in the current project with the 
incoming alignment.

� Click Skip to cancel the merging of this particular alignment.
� Click Cancel to cancel the command.

Changing the Station Display Format

To control how stations appear in AutoCAD Land Development Desktop, use 
the Station Display Format command. This command controls how stations 
appear for many AutoCAD Land Development Desktop and Civil Design 
commands, and it also affects how station labels are created.

The Station Display Format command controls the numeric format for the 
appearance of station labels, as well as precision, decimal character, and the 
station ‘+’ character.
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� Do one of the following to display the Edit Station Format dialog box:

� From the Alignments menu, choose Station Display Format.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Station Format and click the Edit Settings button.

� Under the Preview section, a preview is shown that displays the edits that 
you make to the numeric format. You can change the number in the Preview 
Value edit box to change the preview value if needed. 
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� Use the Numeric Format Options check boxes to control the way the num-
bers are displayed:

� Show leading zeros: Select this check box to display leading zeros. For 
more information, see the description in step 4 of “Minimum display 
width.” 

� Use ( ) for negative values: Select this check box to display negative val-
ues in brackets. If you clear this check box, negative values are displayed 
with a minus (-) sign.

� Drop decimal for even values: Select this check box to drop the decimal 
precision for even numbers. Clear this check box to use the specified pre-
cision for even numbers. 

� Control the decimal display with the following edit boxes:

� Minimum display width: Use this option to specify the total number of 
characters that will be displayed when the “Show leading zeros” option is 
on. For example, if you enter a value of 6 in the minimum display width 
edit box, and set the decimal precision at 2, and enter a value of 50.02 in 
the preview value, then the value 050.02 will display in the preview. This 
option includes the decimal point in the total number of characters: 
050.02 has a width of 6. If the width you specified is less than the width 
of the number, then the number will still display in total, it just won’t 
have any leading zeros. For example, if you specify a width of 2 but the 
number is 50.02, then the number 50.02 will display in the preview.

� Decimal precision: Use this option to control how many characters to 
the right of the decimal point are displayed.

� Decimal character: Use this option to control what the decimal charac-
ter will be.

� In the Station/Chainage Numeric Format section, set the options for 
stationing:

� Use Station Format: Select this check box to display the station values 
with the station character and base value. Clear this check box to display 
the station values as decimal numbers.

� Station ‘+’ character: Type a character in this box that will be used as the 
‘+’ sign for the station label.

� Station base value: Use this control to determine how the station 
numeric format is displayed. For example, if the base value is 10, the 
station + character will be moved one position to the left of the decimal 
place.

 Click OK.
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Changing the Alignment Label Settings

You can use the Alignment Labels command to specify the label text that is 
used to describe points of change on alignments, such as “PC” beginning of 
curve. These Alignment Labels settings are used where ever these labels are 
displayed, including when you station the alignment in the drawing, create 
points on alignments with the At PC, PT, SC, etc. command, use the align-
ment editor, or when you use commands that output alignment data to text 
files. 

NOTE To create station point labels when you use the Create Station Labels 
command, the Station point labels check box in the Alignment Station Label Set-
tings dialog box must be selected. Station point labels include beginning of 
curve labels, curve/tangent intersection labels, and so on. For more information, 
see “Changing the Alignment Station Label Settings” on page 478 and “Cre-
ating Station Labels on an Alignment” on page 480.
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� Do one of the following to display the Alignment Labels Settings dialog box:

� From the Alignments menu, choose Alignment Labels.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Alignment Labels and click the Edit Settings 
button.
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� In the Layer prefix box, type a layer prefix if you want to add a prefix to the 
layer on which the label is created. This option is used when creating station 
labels. Type an asterisk (*) to use the alignment name as the prefix.

� Edit the label text for each type of alignment point of intersection:

� Station equation ahead: Labels the stations ahead of the station 
equation.

� Station equation back: Labels the stations behind the station equation.
� Tangent/Tangent intersect: Labels the stations of the point of intersec-

tion between two tangents.
� Beginning of curve: Labels the stations at the beginning of the point of 

curvature. You can replace the PC with BC, if desired.
� Curve/Tangent intersect: Labels the stations of the point of tangency 

where a curve and tangent intersect.
� Radius point of curve: Labels the stations at the radius of the point of 

curvature.
� Tangent/Spiral intersect: Labels the stations of the intersections 

between tangents and spirals.
� Spiral/Curve intersect: Labels the stations of the intersections between 

spirals and curves.
� Curve/Spiral intersect: Labels the stations of the intersections between 

curves and spirals.
� Spiral/Tangent intersect: Labels the stations of the intersections 

between spirals and tangents.
� Spiral/Spiral intersect: Labels the stations of the intersections between 

spirals.
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� Compound Curve/Curve intersect: Labels the stations of the intersec-
tions between compound curves and curves.

� Reverse Curve/Curve intersect: Labels the stations of the intersections 
between reverse curves and curves.

� Curve point of intersect: Labels the stations of the intersections of two 
curves.

� Spiral point of intersect: Labels the stations of the intersections of two 
spirals.

� Click OK.

Stationing Alignments

To create stations for the current alignment, use the Create Stations com-
mand. Labels inserted with this command use the current text style, and are 
placed on the layer specified in the Station Label Settings command. 

Before using the Create Stations command, you should set up the Station 
Display Format, establish the alignment station label settings, and set up the 
Alignment Label settings.

NOTE You can set the current text style for station labels by using the Set Text 
Style command on the Utilities menu.

Changing the Alignment Station Label Settings

You can determine which types of station labels are created when you station 
an alignment, such as station labels, station point labels, and station equa-
tion labels, by changing the Alignment Station Label Settings. These settings 
also control how the station labels are oriented, the stationing increments, 
the stationing options, and the offset distances for labeling.
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� Do one of the following to display the Alignment Station Label Settings 
dialog box:

� From the Alignments menu, choose Station Label Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Station Labels and click the Edit Settings button.
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� Select one or more of the following labeling options to determine which 
labels are created:

� Station Labels: To create station labels.
� Station Point Labels: To create station point labels.

NOTE You can choose how the station point labels are named by using the 
Alignments ➤ Alignment Labels command.

� Station Equations Labels: To insert station equation labels when you 
create stations. To specify the equations for the current alignment, you 
must use the Equations command.

� If needed, change the layer names for each station label type in the adjacent 
Layer boxes.

� Select one or more of the following labeling options to determine how the 
station labels are oriented:

� Perpendicular Labels: To insert labels into the drawing in a perpendicu-
lar orientation. If you clear this check box, then the station labels are 
inserted parallel to the alignment. 

� Stations Read Along Road: To rotate the labels to be read along the align-
ment. If you clear this check box, then the labels are inserted in relation 
to a fixed vertical.

� Plus Sign Location: To insert the station labels directly on the alignment, 
with the plus sign (+) in the label marking the station.

The following illustration shows the stationing parameters:
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� In the Station label increment box, type the distance between station labels. 
This value cannot be a negative value.

 In the Station tick increment box, type the distance between tick marks. The 
station tick increment must be evenly divisible into the stationing label 
increment. For example, if the label increment equals 1000, then the tick 
increment might be 100, 200, 250, or 500. This value cannot be a negative 
value.

! In the Station label offset edit box, type the offset distance. This is the dis-
tance from the alignment to the insertion point of the station label, and is in 
drawing units (feet or meters). Do not define a label offset if you selected the 
Plus sign location check box.

" Click OK.

NOTE Other settings that affect station labels include the station display for-
mat settings, which control how the station labels appear, and the alignment 
label settings, which control the layer prefix for the layers and how station labels 
are named. For more information, see “Changing the Station Display Format” 
on page 474 and “Changing the Alignment Label Settings” on page 476.

Creating Station Labels on an Alignment

You can create labels on the stations along an alignment by using the Create 
Station Labels command. Before using the Create Station Labels commands, 
you can establish station display format, alignment label, and alignment sta-
tioning settings.

The current linear precision from the Drawing Setup command is used when 
labeling the stations of the Point of Curvature (PC), Point of Tangency (PT), 
and intersections between spirals and tangents or spirals and curves (TS, SC, 
CS, and ST). 
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� Change the station display format. For more information, see “Changing the 
Station Display Format” on page 474.

� Change the alignment label settings. For more information, see “Changing 
the Alignment Label Settings” on page 476.

� Change the alignment station label settings. For more information, see 
“Changing the Alignment Station Label Settings” on page 478.

� Select the current text style for the drawing by using the Set Text Style com-
mand on the Utilities menu.

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

 From the Alignments menu, choose Create Station Labels.

! Type the station at which you want the station labels to begin. The default 
value is based on the starting station of the current alignment.

" Type the station at which you want the station labels to end. The default 
value is based on the ending station of the current alignment.

The command stations the current alignment. 

The following illustration shows a stationed alignment:
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Labeling and Reporting the Station and 
Offset Values of Points in Relation to the 
Current Alignment

By using the Station/Offset commands, you can list or label the station and 
offset of any location in relation to the current alignment. 
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Labeling the Station and Offset of a Location in 
Relation to the Current Alignment

You can label the station and offset of a location in relation to the current 
alignment. 
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� From the Alignments menu, choose Station/Offset ➤ Label. 

� Select the location to be labeled. 

The command starts a dimensioning leader arrow from the selected location, 
and the following prompt is displayed:
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� Select the second leader point.

The following prompt is displayed:
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� Select one or more additional leader points, if needed. 

� After you have selected all the leader points, press ENTER.

The label is inserted at the last leader point you selected. The label uses the 
current text size and is placed on the current layer.

NOTE If the selected location is not perpendicular or radial to the alignment, 
then the following message is displayed:
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The following illustration shows an illustration of a station and offset label:
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Reporting the Station and Offset of COGO Points 
in Relation to the Current Alignment

You can report the station and offset of COGO points in relation to the cur-
rent alignment by using the Display Points command. 

NOTE The steps in this command vary depending on the current Output 
Settings. You can access the Output Settings command from the Alignments 
menu by choosing Stakeout Alignment ➤ Output Settings. For more informa-
tion about Output Settings, see “Changing the Output Settings for Stakeout 
Reports” on page 486.

NOTE If neither the Screen nor File options are selected in the Output Settings 
dialog box, then a message is displayed at the command line when you run the 
Display Points command which says “All available printing methods are off. Press 
any key to continue.” Change the Output settings so that at least one of the 
Screen and File options are selected and then run the Display Points command 
again.
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� From the Alignments menu, choose Station/Offset ➤ Display Points. 

If you selected File as the output option in the Output Settings, then the fol-
lowing prompt is displayed:
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� Accept the default file name established in the Output Settings, or type a new 
file name. You can also specify a directory path for the file at this prompt. If 
you do not specify a directory path, then the file is created in the root of the 
project folder, c:\Land Projects R2\<project name>.

The following prompt is displayed:
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� Type Yes to sort the points by station, or type No to sort the points by point 
number.

The following prompt is displayed:
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� Do one of the following to specify how to select the points:  
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� Type Selection if you want to select the points graphically. You can use a 
window or crossing window to select the points. For more information, 
see “Using Selection Windows” in the AutoCAD User’s Guide.

� Type Number if you want to select the points by number. Separate the 
point numbers with commas (,) or hyphens (-). Point numbers separated 
by a hyphen indicate a range of point numbers.

� Select the points or type a numerical range, depending on the selection 
option you specified.

 After the selection set is complete, press ENTER. 

If you specified Screen as the Output Option in the Output Settings, then the 
text window displays the point number, station, offset, elevation, and 
description. Points are sorted by either station values or point numbers. The 
following is an example of a point list:

NOTE If a selected point is not perpendicular or radial to the alignment, then 
the following message is displayed:

Point is not adjacent to alignment.

Staking Out an Alignment

You can create stakeout reports of alignments for surveyors. You can report 
the information using either turned or deflected angles.

Changing the Alignment Stakeout Settings

You can set stakeout settings that are used for all Stakeout commands. These 
settings control which angle type is used for the stakeout reports.

Point list example:
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14 1124.75 - 12.68 214.12 setpoint

15 1174.32 12.52 216.35 setpoint
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� From the Alignments menu, choose Stakeout Alignment ➤ Settings to dis-
play the Stakeout Settings dialog box.

� Select the stakeout angle type to use.

� For a turned angle right, select Turned +
� For a turned angle left, select Turned -
� For a deflection angle right, select Deflect +
� For a deflection angle left, select Deflect -
� For an angle that uses azimuths or bearings, select Direction

The following illustration shows the different stakeout angle types:
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� Click OK.
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Changing the Output Settings for Stakeout 
Reports

Use the Output Settings command to specify how an alignment stakeout 
report is output. You can determine the format of the report, as well as the 
file name and destination. An Overwrite option is provided so that you can 
overwrite reports that may exist with the same name in the same location. If 
you choose not to overwrite existing files, then the new data is appended to 
the existing file.
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� From the Alignments menu, choose Stakeout Alignment ➤ Output Settings 
to display the Output Settings dialog box.

For more information about changing the Output Settings, see “Changing 
the Output Settings” on page 79.

Creating an Alignment Stakeout Report

You can write out alignment stakeout information for a surveyor that lists 
information for each occupied point, backsight point, starting station, end-
ing station, and station interval. 

Information is reported for each of the following stakeout points:

� Station
� Direction or angle
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� Distance
� Northing/easting coordinates

The points listed in a stakeout report are the coordinates of the locations of 
each station point in relation to the occupied point. 
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� Change the Stakeout Settings. For more information, see “Changing the 
Alignment Stakeout Settings” on page 484.

� Change the Output Settings. You can either display the report on the screen 
or save it to a file. For more information, see “Changing the Output Settings 
for Stakeout Reports” on page 486.

� From the Alignments menu, choose Stakeout Alignment ➤ Create File. 

� Type the point number of the occupied point. The occupied point does not 
need to exist on the alignment; it can be located anywhere in the project.

NOTE You cannot select the occupied point by picking a point with your 
pointing device. You must type the point number.

� Type the point number of the backsight point in the stakeout. 

NOTE If you chose the Direction type of angular entry in the Stakeout Set-
tings, then you are not prompted for a backsight point.

 Type the station on the alignment at which you want to start the stakeout 
report.

! Type the station on the alignment at which you want to end the stakeout 
report.

" Type the offset distance. The offset is the constant offset from the alignment 
used to determine the stakeout points. 

# Type the station interval. The default is the value set for the Station tick 
increment set in the Alignment Stationing Settings dialog box. 

�3 If you selected the option in the Output Settings to output the report to a file, 
then type the output file name. 

The Create File command then writes the stakeout information. 

The following is an example of an alignment stakeout report:

Sample Stakeout Information
�
���'
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Outputting Horizontal Alignment Data to 
ASCII Files

To use the alignment data in other programs that can read alignment data, 
you can create an ASCII file of alignment data.

Changing the Settings for Outputting ASCII Files

Use the Output Settings command to specify how alignment ASCII files are 
output. You can determine the format of the report, as well as the file name 
and destination. An Overwrite option is provided so that you can overwrite 
reports that may exist with the same name in the same location. If you 
choose not to overwrite existing files, then the new data is appended to the 
existing file. 

����	�����	��%�'))���
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� From the Alignments menu, choose ASCII File Output ➤ Output Settings. 

The Output Settings dialog box is displayed.
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For more information about changing the Output Settings, see “Changing 
the Output Settings” on page 79.

Outputting Horizontal Alignment Data to an 
ASCII File

You can output alignment data as an ASCII text file if you want to use the 
data in another program that has been created to read alignment data. 

NOTE The files created by this command are output in ASCII format only. 
These are data files and not intended to be a report. For more information, see 
“Reporting Data About a Horizontal Alignment” on page 457.

A multitude of different output formats exist worldwide. Some countries 
have standardized formats for profiles and cross sections, while in other 
countries the formats can vary greatly from region to region or even between 
corporations.

�����������
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�

� Select the current alignment. For more information, see “Making an Align-
ment Current” on page 434.

� From the Alignments menu, choose ASCII File Output ➤ Alignment. 

At the command line, the current alignment name, number, description, and 
starting and ending stations are displayed, and the following prompt is 
displayed:
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� Do one of the following to specify the output location:

� Press ENTER to accept the default directory. 
� Type a new directory path. 

� Type the file name you want to create. 

When entering the file name, be sure to include the extension. If the file 
already exists, then a prompt is displayed asking whether or not to overwrite 
the file. 

� Type Yes to overwrite the existing file, or type No and then type a new file 
name.
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The following table lists the alignment object types and the codes used in the 
ASCII text file:

The following text shows the format for the alignment ASCII text file:
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The internal station is the original station value as the alignment was 
defined, before station equations are used. The external station is the current 
station value. If you have not used station equations, then the internal and 
external values are the same.

Any line beginning with either a number character (#) or semicolon (;) is a 
comment line. Following is an example of the alignment output in the ASCII 
text file. 

��4��������� ,��,��'�)4

�'L'L'%&��K)))))L')?(�%(.K?(

��
�!
�����

(L'%&��K)))))L()))�))))))L)

)L'%&��K)))))L()))�))))))L&..)��.�?K)L&$�%�(')&)?L&.?%�?%$)$)L&%%)

�)'%K)(L'(&�(KK.K?L%�'K�($&

Alignment object types and codes used in the ASCII file

,��������� '����

Output types 0: Line Object
1: Curve object
2: Spiral object
3: Station equation

Spiral types 0: Clothoid spiral object
1: Sinusoid spiral object
2: Cosinusoid spiral object
3: Quadratic spiral object

Defined direction types for spirals 0: Defined from TS end
1: Defined from SC end

Station equation types 0: Increasing
1: Decreasing
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21Working with Parcels

The commands on the Parcels menu define, resize, 

report, and label parcel areas. Parcel definitions are 

stored in the parcel database file. Use the Parcel Manager 

to create reports on parcel area, traverse, and map check 

information, as well as to import, delete, and rename 

parcels.

Most of the Parcels commands require that existing 

parcel lines be present in the drawing. Parcels can be 

defined from points, lines, curves, and polylines.

In this chapter

� Using the Parcels Commands

� Changing the Parcel Settings

� Managing Parcels

� Merging Parcel Data into the 
Current Project

� Defining Parcels

� Sizing Parcels So They Are 
Specific Areas
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Using the Parcels Commands

Use the Parcels commands to define, size, and manage parcels. When you 
define a parcel, its definition is stored in the parcel database file. Because par-
cel data is stored externally, multiple people working on a network can access 
it. You can also delete the parcel geometry from the drawing, and import it 
back to the drawing later.

Drawing Parcels

To draw parcels, use the line and curve commands in the Lines/Curves menu. 
You can also use either the PLINE command, or any AutoCAD line or curve 
command.

NOTE Do not use spiral curves in the parcel geometry because incorrect parcel 
areas are calculated. If you want to create a parcel from a spiral, then use the 
BPOLY command to convert the spiral into a polyline before defining the parcel. 

After you draw the parcel geometry, you must define the parcels to the parcel 
database. For more information, see “Defining Parcels” on page 505.

NOTE Be sure to draw the parcels as closed regions. If any of the joining lines 
has a break, then you cannot define the parcels. 

Selecting a Curved Parcel Line

Several of the Parcels commands have the following prompt as part of their 
sequence:

��������	��
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This prompt allows you to select points or a curve as part of the parcel defi-
nition. The curve that you select must already exist in the drawing.

����������	��
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� At the Next point (or Curve) prompt, type C.
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NOTE This option automatically sets the object snaps to Center. Do not over-
ride this setting. 

� Select a point on the curve and the end of the curve.

The command then prompts for the position of the chord relative to the 
parcel: outside or inside:

�������	�����������������������������	������

� Do one of the following:

� Type O if the chord is outside the parcel. 
� Type I if the chord is inside the parcel area.

If the chord is on the inside of the parcel, then the area of the curve is added 
to the area of the parcel. If the chord is on the outside of the parcel, then the 
area of the curve is subtracted from the area of the parcel.

NOTE Curves are assumed to have an included angle of less than 180 degrees. 
A curve with more than 180 degrees must be treated as two curves with 
included angles that are less than 180 degrees. 

Changing the Parcel Settings

The Parcel Settings command controls the following factors: 

� Whether parcels are defined to the database when you use the Parcel Siz-
ing commands

� Whether parcel numbering is sequential (automatic) or manual
� How parcels are labeled
� Which layers the parcel commands use

�����	���������	�������������

� Do one of the following to display the Parcel Settings dialog box:

� From the Parcels menu, choose Parcel Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Parcel Settings and click the Edit Settings button.
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� To automatically save parcel definitions to the database when using the Par-
cel Sizing commands, select the Define parcels as sized check box. Clear this 
check box if you do not want to define the parcels as you experiment with 
the Parcel Sizing commands.

� To label the parcels as you define them, select the Label parcels as defined 
check box.

� Use the Map check across chord check box to determine how the Map Check 
report option calculates curve data. If this box is selected, then the traverse 
is checked based on the chord information of the curve. If the check box is 
cleared, then the traverse is calculated based on the curve length.

� To automatically place the label at the center of the parcel, select the Auto-
matic Label Placement check box. If you clear the Automatic Label Placement 
check box, you are prompted for the insertion point when you import a par-
cel; or when you define a parcel with the Label parcels as defined check box.

� To truncate area labels, select the Truncate area labels check box. The area val-
ues are truncated based on the precision settings that are set in the Square 
Feet/Meters Labeling and Acres/Hectares Labeling areas of the dialog box. If 
this check box is cleared, then the areas are rounded off based on the preci-
sion settings.

For example, if the exact parcel area equals 2.80857460 hectares, then the 
area is truncated or rounded as follows:
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� Truncated area with Square Feet/Meters precision set to 2 = 122,341.50 
sq.m.
Rounded area with Square Feet/Meters precision set to 2 = 122,341.51 
sq.m.

� Truncated area with Acres/Hectares precision set to 4 = 2.8085 hectares
Rounded area with Acres/Hectares precision set to 4 = 2.8086 hectares

Rounding may produce a label that states an area greater than the actual lot 
size.

NOTE A typical suffix used in conjunction with the Truncate area labels option 
is "Acres/Hectares %%P." This suffix produces the plus/minus symbol typically 
used when labeling acres/hectares.

� To include the parcel lines when you import parcels from the Parcel Manager, 
select the Include Parcel Lines on the Import check box.

� To label parcels with their number, select the Labels on check box in the 
Parcel Numbering section.

� To number parcels sequentially, select the Sequential on check box. When 
this check box is selected, the current parcel number is used as the parcels are 
defined. If you clear this check box, then you are prompted for parcel num-
bers as you define the parcels.

�� To use a prefix with the parcel numbers, type the prefix in the Prefix box in 
the Parcel Numbering section. For example, if you type Parcel as the prefix, 
then the parcels are labeled Parcel1, Parcel2, Parcel3, and so on.

�� To change the current parcel number, adjust the value in the Number box in 
the Parcel Numbering section. The parcel number is used as the value the 
next time the parcel is defined with Sequential on.

�� To set the text style for the parcel number labels, click the Select button and 
then choose a text style from the Text Style Selection dialog box, and then 
click OK to return to the Parcel Settings dialog box.

�� Set the Square Feet/Meters Labeling settings. This group of options deter-
mines how the square unit (feet or meters) value is labeled:

� To include square unit labels, select the Labels on check box.
� Set the labeling precision with the Precision box or slider bar.
� Set the text style by clicking the Select button, and then selecting the style 

from the Text Style Selection dialog box.
� In the Area suffix edit box, set the area suffix, such as sq.m or sq.ft. 

�� Set the Acres/Hectares Labeling settings. This group of options determines 
how the area unit (acres or hectares) value is labeled. There are options for 



498 | Chapter 21 Working with Parcels

the text style, label precision, and suffix for the area, such as acres and 
hectares. For instructions, see step 13.

�� Using the Parcel layer and Label layer boxes, set the layer names for the par-
cels, lines, and labels.

�� Click OK.

Managing Parcels

Use the Parcel Manager to import, delete, and rename parcels, as well as to 
report parcel data. 

Reporting Parcel Area, Inverse, or Map Check 
Data

You can create reports of parcel area, inverse, and map check information. 

Before you can report parcel information, you must first define the parcel to 
the database. For more information, see “Defining Parcels” on page 505.

�����������	�����	�	

� From the Parcels menu, choose Parcel Manager to display the Parcel Manager 
dialog box.

� From the Select parcel list box, select the parcels. You can either select each 
individual parcel or use the Select All button to select all of the parcels in the 
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list. An asterisk (*) indicates each parcel you select. To deselect all the parcels, 
click the Clear All button.

� To change the parcel settings, click the Parcel Settings button. For more infor-
mation, see “Changing the Parcel Settings” on page 495.

� To modify the output settings for the report options, click the Output 
Settings button. If you select the option to output to a file, then the parcel 
area, inverse, and map check information is written to a text file 
automatically.

� Click OK to return to the Parcel Manager.

For more information, see “Changing the Output Settings” on page 79.

� Select one of the report buttons:

� To report the parcel area, select the Area button. 

The Parcel Area dialog box displays the area and perimeter for all selected 
parcels.
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� To report the parcel traverse information, select the Inverse button. 

The Parcel Inverse dialog box displays the parcel traverse information, 
area, and perimeter for all selected parcels.

� To report the map check information, click the Map Check button. 

The Parcel Map Check dialog box displays the parcel closure calculation 
based on the traverse information, rounded off to the current drawing pre-
cisions as set in the Drawing Setup command. Set the drawing precisions 
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to the same values used when labeling the parcel lines. The report also 
includes the parcel traverse information, area, and perimeter.

NOTE The coordinates reported by the Map Check option are calculated from 
the directions and distances at the current drawing precisions. If you change the 
angular and linear precisions, then the coordinates of the parcel corners change 
accordingly. The coordinates reported by the Inverse option are calculated using 
the maximum precision allowed by AutoCAD. You can report these coordinates 
only to the coordinate precision set in the Drawing Setup, but the only changes 
in the reported parcel inverse coordinates are due to rounding. 

Each report option displays the parcel information in a dialog box, with 
options to print to either a file or printer. 

Importing Parcel Lines and Labels

If you delete parcels from the drawing, or want to add the parcels to a new 
drawing, you can import the parcels. When you import parcels, you can 
import any combination of parcel lines, parcel numbers, and parcel area 
labels.

NOTE To use this command, at least one parcel must exist in the parcel data-
base and one import option must be selected in Parcel Settings. 
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� From the Parcels menu, choose Parcel Settings to display the Parcels Settings 
dialog box. 

� Under Options, you must select one of the following options:

� Automatic Label Placement
� Include Parcel Lines on Import 

� Click OK.

� From the Parcels menu, choose Parcel Manager to display the Parcel Manager 
dialog box.

� From the Select parcel list, select the parcels you want to import. You can 
either select each individual parcel or click the Select All button to select all 
the parcels in the list. An asterisk (*) indicates each parcel you select. To dese-
lect all the parcels, click the Clear All button.

� Click Import to import the parcel definitions to the drawing.

� If you choose to import labels and Automatic Label Placement is not selected 
in the Parcel Settings, then choose both an insertion point and a rotation 
angle for each parcel label. 

As each parcel is being inserted, the parcel number is displayed at the com-
mand prompt. The imported parcels are brought into the drawing as 
polylines.

� Click OK to exit the dialog box.

Deleting Parcels

NOTE Parcel definitions are stored to the parcel database; therefore, to per-
manently remove the parcels from the project, you must delete them from the 
database. To erase parcel lines from the drawing, use the ERASE command. Eras-
ing parcel lines does not remove parcel definitions from the database. 
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� From the Parcels menu, choose Parcel Manager to display the Parcel Manager 
dialog box.

� From the Select parcel list, select the parcels you want to delete. You can 
either select each individual parcel or click the Select All button to select all 
the parcels in the list. An asterisk (*) indicates each parcel you select. To dese-
lect all the parcels, select the Clear All button.

� Click the Delete button. A warning box is displayed.
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� Click Yes or No:

� Click Yes to delete the parcels.
� Click No to end the command.

Renaming Parcels

������	����	�����

� From the Parcels menu, choose Parcel Manager to display the Parcel Manager 
dialog box.

� In the Select parcel list, select the parcel to rename.

� Click Rename to display the Rename Parcel dialog box.

� In the Name text box, type the new parcel name. Parcel names can be up to 
30 characters long, including spaces. They can include any valid file name 
characters, numbers, and letters.

� Click OK to exit the dialog box.

The new parcel name is now in the project database and anyone accessing 
the project will see this new name.

Merging Parcel Data into the Current Project 
from Other Projects

To merge parcel databases from other projects with the parcel database of the 
current project, use the Merge Parcels command.
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� From the Parcels menu, choose Merge Parcels to display the Parcel File to 
Import dialog box. The parcel database data is stored in the <project 
name>.gcf file, which resides in the \lots subfolder of the project folder. 

� Select the <project name>.gcf file that you want to merge with the current 
project parcel database.

NOTE You cannot merge the parcel database from the current project with 
itself. If you select the current project parcel database, then the following mes-
sage is displayed:

��		������������������	��������������

� Click OK to display the Merge Design Parcels dialog box.
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� Select the parcels to be merged. You can either select each parcel individually, 
or click the Select All button to select all the parcels in the list.

� Click OK to merge the parcels into the current project. 

If the merge selection has duplicate parcel names, then the following prompt 
is displayed:
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� Type one of the following:

� Overwrite: To overwrite the existing parcel in the current project.
� Rename: To rename the duplicate parcel in the current project.

The following prompt is displayed:

"�������������������	����������#��$�	�����������
%��������%����

� Type Yes or No:

� Type Yes to use the option you selected in step 6 for all subsequent dupli-
cate parcels.

� Type No to be prompted to overwrite or rename duplicate parcels each 
time a duplicate parcel is found.

Defining Parcels

After drawing the parcel geometry, you must define the parcels to the parcel 
database if you want to import, delete, or rename the parcel, or to report area, 
mapcheck, or inverse data.

Defining a Parcel from Lines and Curves

���������	��	����������������	���
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� From the Parcels menu, choose Define from Lines/Curves.

� Select the first object nearest the point of beginning (POB).

� Using a window or crossing, select the remaining objects. Select all the 
objects in the enclosed area. The parcel lines cannot extend past the parcel 
intersection points along the perimeter.

The following illustration shows parcel line selection guidelines:
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If the parcel does not close, then a closure error prompt is displayed and an 
X is placed at the invalid closure point. If it is at the start point of the parcel, 
then you can accept the default (Yes) to close from that point back to the 
POB; or you can type N (for No) to end the command and then correct the 
closure error.

� If the Sequential on check box is cleared in the Parcel Settings dialog box, 
then type the parcel number. If the parcel number has already been used, 
then a prompt is displayed to overwrite or rename the parcel. If the Label par-
cels as defined check box is selected, the parcel label is added to the drawing. 
If the Automatic Label Placement check box is cleared, select the label inser-
tion point and define the rotation angle. The label insertion point corre-
sponds to the center of the first line of inserted text. 

� Select additional objects to define as a parcel.

Defining a Parcel from a Polyline

NOTE Selecting a polyline that has been spline-fitted causes erroneous areas 
to be reported. 
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� From the Parcels menu, choose Define from Polylines. 

� Select the polyline. If the polyline does not close, then a closure error prompt 
is displayed and an X is placed at the end of the polyline. You can accept the 
default (Yes) to close back to the point of beginning (POB). If not, then type 
No to end the command and correct the closure error.

� If the Sequential on check box is cleared in the Parcel Settings, then type the 
parcel number. If the parcel number has already been used, then a prompt is 
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displayed to overwrite or rename the parcel. If the Label parcels as defined 
check box is selected, the parcel label is added to the drawing. If the Auto-
matic Label Placement check box is cleared, select the label insertion point 
and define the rotation angle. The label insertion point corresponds to the 
center of the first line of inserted text. 

� Specify the label insertion point and rotation angle. 

The label is inserted and the command prompts for another polyline. 

� Select another polyline to define as a parcel, or press ENTER to exit the 
command.

Defining a Parcel from Points
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� From the Parcels menu, choose Define from Points.

� Select the first point location. When using this command, set AutoCAD 
OSNAP to Endpoint.

� Select the points to define the area perimeter in either a clockwise or coun-
terclockwise direction. At a curve in the perimeter, type C to define the curve. 
For more information, see “Selecting a Curved Parcel Line” on page 494.

� If sequential numbering is turned off, type the parcel number. If the parcel 
number has already been used, then a prompt is displayed to overwrite or 
rename the parcel.

� Select the insertion point for the label and the rotation angle.

The label is inserted.

� Select points to define another parcel, or press ENTER to exit the command.

The following illustration features point selection guidelines to define a 
parcel:

"�������������������������	��	����
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Sizing Parcels So They Are Specific Areas

To calculate the size of a parcel you can use several different methods. The 
following methods require that three sides of the parcel already exist in the 
drawing as lines or curves. You can then use the parcel sizing commands to 
specify a specific area where you want the parcel to be.

Sizing a Parcel Using a Sliding Bearing Line

Use the Slide Bearing method to size a parcel size by sliding a line of fixed 
direction between two direction lines. This command defines the direction 
for the new parcel line by points, a bearing, or an azimuth. Original parcel 
lines must be present in the drawing in order to use this command. For more 
information, see “Drawing Parcels” on page 494.

NOTE To define the parcel to the database when you size it, select the Define 
parcels as sized check box in the Parcel Settings dialog box. 
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� From the Parcels menu, choose Slide Bearing.

� Select the first point to define the boundary around the parcel. Use the 
AutoCAD OSNAP command when selecting points, or the area will not be 
exact. 

� Select the next point on the parcel. 

NOTE If the defined perimeter of the parcel has a curve, then type C at the 
prompt and select the curve. For more information, see “Selecting a Curved 
Parcel Line” on page 494.

� After you finish selecting points, press ENTER. 

The command then draws a rubberband from the first parcel point selected 
and prompts you for the direction. 

� Select two direction points. The direction points define the direction in 
which each line slides. 

The following prompt is displayed:
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� Do one of the following to define the direction of the sliding line:
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� Select two points to define the direction.

NOTE If the new parcel line is to be parallel to another, then select points 
to specify the direction and use AutoCAD OSNAP command to snap to the 
endpoints of the line. 

� Type a quadrant number and then type the bearing.
� Type A and then type the azimuth.

The command displays the minimum area that can be defined by the new 
parcel line placed from the first point to the last point of the known parcel. 
Adjustments of the minimum area number may occur. 

� Type the area. The units are based on either English or Metric units. The 
English standard of measure uses square feet; metric uses square meters. 

The command draws a line between the first and second direction lines 
selected with the new parcel line direction specified, and places it on the cur-
rent layer.

� Type the parcel number, unless you selected sequential parcel numbering in 
the Parcel Settings dialog box. 

� Select another parcel to size, or press ENTER to exit the command.

The following illustration shows the points to pick when defining parcel size 
by a sliding line:
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Sizing a Parcel Using a Radial Line

Use the Radial method to size a parcel by using a line that is radial to an exist-
ing curve. Original parcel lines must be present in the drawing in order to use 
this command. You can use this method to create parcels that are radial to a 
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curve when you draw cul-de-sacs. For more information, see “Drawing Par-
cels” on page 494.

NOTE To define the parcel to the database when you size it, select the Define 
parcels as sized check box in the Parcel Settings dialog box. 
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� From the Parcels menu, choose Radial. 

� Select the first parcel point. 

NOTE To ensure proper calculation of the area, select all endpoints using the 
AutoCAD OSNAP END override. This command sets the AutoCAD OSNAP to 
CENTER for the selection of any curves. If you override this setting, then the area 
is miscalculated. 

� Select the next parcel points. Select the points starting at the backline and 
continuing up to the beginning of the radial curve. 

NOTE If the defined perimeter of the parcel has a curve, then type C at the 
prompt and select the curve. For more information, see “Selecting a Curved 
Parcel Line” on page 494.

� After you have finished selecting points, press ENTER. 

� Select a point both on the curve and the end of the curve. If the parcel line 
is extended, then it passes through the center point of the curve.

� Select the direction point. This point and the parcel first point define the 
direction of the line that the new parcel line is drawn to. After you select the 
direction line, the command draws a temporary line from the beginning of 
the curve to the point on the curve to draw the radial from. The position of 
this line (relative to the parcel) determines whether the command adds or 
subtracts the area of the curve.

NOTE If the position of the temporary line is inside the parcel (i.e., the curve 
is convex to the parcel), then the Radial command works only if the direction line 
passes between the radius point of the curve and the curve itself. 

The command displays the minimum area that can be defined by the new 
parcel line placed from the first point to the last point of the known parcel. 
Adjustments of the minimum area number may occur.
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� Enter the direction of the backline. 

� Type the area. The units are based on either English or Metric units. The 
English standard of measure uses square feet; the metric uses square meters. 
The command then draws a line radially from the curve to the selected direc-
tion line and places it on the current layer.

The command displays the computed area.

� Select another parcel to size, or press ENTER to exit the command.

The following illustration shows the points to pick when defining parcel size 
with a radial line:
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Sizing a Parcel by Swinging a Bearing to a Line

Use the Swing on Line command to size a parcel by swinging a bearing line 
from a known point along a line. Original parcel lines must be present in the 
drawing in order to use this command. For more information, see “Drawing 
Parcels” on page 494.

NOTE To define the parcel to the database when you size it, select the Define 
parcels as sized check box in the Parcel Settings dialog box. 
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� From the Parcels menu, choose Swing on Line.

� Select the point to swing from. 

NOTE To ensure proper calculation of this area, select all endpoints using the 
AutoCAD OSNAP END override. 
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� Select the points to define the parcel.

NOTE If there is a curve within the defined perimeter of the parcel, then type 
C at the prompt and select the curve. For more information, see “Selecting a 
Curved Parcel Line” on page 494.

� Press ENTER when you have finished selecting points.

� Select the direction point. This is a point along the line that the new line will 
swing to.

� Type the desired area. The units are based on either English or Metric units. 
The English standard of measure uses square feet; the metric uses square 
meters.

The command draws a line from the swing point to the direction line and 
places it on the current layer. The computed area is the minimum area that 
can be defined by the new parcel line placed from the first point to the last 
point of the known parcel. 

� Select another parcel to size, or press ENTER to end the command.

The following illustration shows how to select points from which to swing a 
bearing to a line:
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Sizing a Parcel by Swinging a Bearing to a Curve

Use the Swing on Curve command to size a parcel by swinging a bearing line 
from a known point to a curve. Original parcel lines must be present in the 
drawing in order to use this command. For more information, see “Drawing 
Parcels” on page 494.
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NOTE To define the parcel to the database when you size it, select the Define 
parcels as sized check box in the Parcel Settings dialog box. 
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� From the Parcels menu, choose Swing on Curve. 

� Select the point to swing from. 

� Continue selecting points to define the parcel.

NOTE If the defined perimeter of the parcel has a curve, then type C at the 
prompt and select the curve. For more information, see “Selecting a Curved 
Parcel Line” on page 494.

� Press ENTER when you have finished selecting points. 

� Select a point on the curve to which the line swings. 

� Select the end of the curve to which the line swings.

� Type the desired area. The units are based on either English or Metric units. 
The English standard of measure uses square feet; the metric uses square 
meters.

The command draws a line from the swing point to the curve and displays 
the computed area. If it is not mathematically possible to create a parcel with 
the given parameters, then the command displays the following error 
message:
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� Select another parcel to size, or press ENTER to exit the command.

The following illustration shows how to select points when sizing a parcel by 
swinging a bearing to a curve:
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Breaking Parcel Lines and Curves

The geometry that you draw to represent parcels must be discrete for each 
parcel. Parcel lines cannot cross each other. The only instance in which two 
parcels can share a line and curve is if the line or curve is a shared boundary 
between the two parcels. If you used lines or curves to draw the parcels, then 
you can break crossing lines by using the Break Lines/Curves command.
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� From the Parcels menu, choose Break Lines/Curves.

� Select the object to break. 

� Select the cutting object. 

The command breaks the object at the point where it intersects with the cut-
ting object.

The following illustration shows how to select objects to break:
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22Getting Started with 
Labels

Before you create labels for lines, curves, spirals, and 

points, you must establish the label settings. The label 

settings control how labels and label styles are updated. 

This functionality enables you to manipulate the 

current label styles, label alignment and rotation, 

current tag number, and the label style files path.

In this chapter

� Using the Labels Commands

� Changing the Label Settings

� Changing the Settings for 
Labeling Lines, Curves, Spirals, 
and Points
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Using the Labels Commands

Use the Labels commands to label the lines, polylines, curves, spirals, and 
points in your drawing. You can create four different label types:

� Dynamic: Labels that can automatically update whenever an object is 
moved or edited, or if the label style is edited. 

� Static: Labels that do not update if the label style or object changes. They 
always preserve their values and locations when an object or a style is 
edited. Static labels do not update when you use the Update All Labels or 
Update Selected Labels command. If you later want static labels to update 
dynamically, you can enable the dynamic updating property for 
individual labels.

� Tag: Labels that place tags on objects. You can insert tag tables that con-
tain the object information.

� Geodetic: Labels that can contain the latitude, longitude, grid northing, 
and grid easting of points, or label geodetic distances on lines based on the 
current zone for the drawing. Geodetic labels do not use label styles.

Each dynamic, static, and tag label is based on a label style. A label style con-
trols both the appearance of the label and the data that is labeled. 

NOTE AutoCAD Land Development Desktop displays a message dialog box if 
you open a drawing that was created in Autodesk S8 Civil/Survey or Softdesk 7.6 
and the drawing contains dynamic labels. This dialog box prompts you to select 
among three conversion options. You can choose to convert the labels, to con-
vert the labels to static labels, or to leave the labels as is (no conversion). 

Creating a Selection Set for Labeling

You can use two methods to select the objects that you want to label. 

If the PICKFIRST variable is set to one (<1>), then you can select the objects to 
label or edit before selecting a command from either the shortcut menu or the 
Labels menu. You can select an object by clicking on it or by selecting two points 
to draw a window or crossing around it. To clear the selection set, press ESC.

If the PICKFIRST variable is set to zero (<0>), then you must select the objects 
to label after selecting a command from the Labels menu. To select the 
objects, you can use any selection method, such as fence, window, crossing, 
and so on. For more information about the pickfirst variable, see “Selecting 
an Object in PICKFIRST Mode” in the AutoCAD 2000 User’s Guide. 
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The selection set that you create can contain any type of object. You can cre-
ate a selection set that contains both lines and curves, for example, and label 
them all simultaneously.

Changing the Label Settings

You can change the settings for line, curve, spiral, and point labels. The label 
settings control the following:

� The label styles path
� The global updating settings for the labels
� Which label styles and tag label styles are current
� Whether labels are aligned on the object

Specifying Which Folder Contains the Label Styles
Label styles are stored in a folder specified by the label style path. If you move 
the label styles, create label styles in a different location than the default 
(c:\Program Files\Land Desktop R2\data\labels), or if you want to use Leroy 
or Metric label styles, then you must change the default label style path. 

The Leroy and Metric styles are located in the following folders:

� \Land Desktop R2\data\labels\leroy
� \Land Desktop R2\data\labels\metric
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� Display the Label Settings dialog box by doing one of the following:

� From the Labels menu, choose Settings.

� From the Labels menu, choose Show Dialog Bar and then click .
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Label Settings and click the Edit Settings button.
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� Click the General tab.

� Click Browse and select a folder for the label styles. 

� Click OK.

NOTE Changing the path does not move the existing styles. To use the exist-
ing styles, they must be present in the Style Files Path. 

Specifying How Labels Are Updated
Dynamic labels can automatically update whenever you edit either the label 
style or the labeled object. The ability of labels to update depends on the glo-
bal and individual label update settings you specify before and after creating 
labels.

There are two different ways to specify how labels are updated:



Changing the Label Settings | 519

� You can use the Label Settings command to establish the global update 
settings for the drawing. This setting affects all new dynamic labels that 
are created, as well as the dynamic labels that already exist in the drawing 
(unless the individual label dynamic update property has been disabled). 
These global update settings do not affect static labels.

� You can use the Edit Label Properties command to establish the update 
setting for each individual label. For example, you can enable the dynamic 
updating settings for the drawing (in the Label Settings), but for selected 
labels, you can disable dynamic updating so those selected labels do not 
update. Static labels are created with the dynamic updating property dis-
abled. By enabling this option, the static labels become dynamic. For more 
information, see “Changing the Properties of Labels” on page 571.

NOTE If you create dynamic labels and then disable the automatic updating 
options in the Label Settings dialog box, you still have the ability to update 
dynamic labels if the drawing information or label style changes. Just use the 
Update All Labels or Update Selected Labels command to update the labels. For 
more information, see “Updating All Dynamic Labels in the Drawing” on page 
568 and “Updating Selected Dynamic Labels” on page 567. 

Static labels cannot be updated with the label update commands, but they can 
be updated by turning on the dynamic updating option in the Label Properties. 
For more information, see “Changing the Properties of Labels” on page 571.
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� From the Labels menu, choose Settings to display the Labels Settings dialog box. 

� Click the General tab.

� Under Label Options, select or clear the following check boxes: 
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� Update Labels When Style Changes: Select this check box to update 
dynamic labels when you edit a label style. Clear this check box if you do 
not want the labels to update when you edit a label style. If you create 
dynamic labels when this option is disabled, the dynamic labels do not 
update unless you re-enable this option. Use the Update All Labels or 
Update Selected Labels command, or use the Label Properties command.

� Update Labels When Objects Change: Select this check box to update 
dynamic labels when you edit labeled objects. This option updates the 
position and contents of the labels in your drawing when the objects are 
edited. If you have moved labels, and then you edit the object with this 
option enabled, then the labels are returned to their original insertion 
point relative to the object. If you create dynamic labels when this option 
is disabled, the dynamic labels do not update unless you re-enable the 
option. Use the Update All Labels or Update Selected Labels command, or 
use the Label Properties command.

� Click OK. 

NOTE These global update settings have no effect on static labels. Static labels 
are always created with the dynamic updating property disabled (this property 
is controlled on a per-label basis). However, you can edit the label’s properties at 
a later time to update the static label.

Example: Updating Labels Manually
The following example explains how to use the Update Selected Labels 
command on a dynamic label when the global label update settings are 
turned off.

NOTE If you have disabled the Dynamically Update Label Text property for a 
label in the Label Properties dialog box, then you cannot update the label man-
ually. For more information, see “Changing the Properties of Labels” on page 
571.
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� Label a line with a dynamic label.

� Select the line, and then from the Labels menu, select Settings to display the 
Label Settings dialog box.

� Click the General tab if it is not active.

� Clear the Update Labels When Objects Change check box.

� Click OK to exit the dialog box.



Changing the Label Settings | 521

� Select the line label and move it away from the line.

� Edit the line to make it shorter or longer. Notice that the label does not 
update.

� To update the label, from the Labels menu, select Update Selected Labels.

� Select the line and press ENTER. 

The label is moved back to its original position on the line and the label text 
is updated.

Changing the Settings for Labeling Lines

You can set up default settings for labeling the lines in your drawing. These 
settings include the default label style, the label alignment and rotation, and 
the tag style to use when you create tag labels.

NOTE These are global settings. You can edit the properties of individual 
labels by using the Edit Label Properties command. For more information, see 
“Changing the Properties of Labels” on page 571.
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� From the Labels menu, choose Settings to display the Labels Settings dialog 
box. 

� Click the Line Labels tab.

� From the Current Label Style list, select the line label style that you want to 
use.

� Do one of the following to specify the label alignment. For more informa-
tion, see “The Effects of Label Alignment” on page 523.



522 | Chapter 22 Getting Started with Labels

� Select the Align Label On Object check box to align the label text with the 
line. The label is rotated to match the angle of the line. 

� Clear the Align Label On Object check box if you do not want the label to 
match the line’s rotation angle. When this check box is cleared, the labels 
use the rotation angle specified in the Non-Aligned Label Rotation Angle 
box. 

Whenever you edit the line, the label is not moved or rotated; it stays in 
the same location.
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� In the Non-Aligned Label Rotation Angle box, type the rotation angle for 
labels that are not aligned. Type this value in decimal degrees. 

� From the Force Bearings list, select one of the following options for labeling 
bearings: 

� Mixed: Labels lines using either north or south bearings. The lines are 
labeled using the direction in which they are drawn.

� North: Labels lines using north bearings. For example, N45°45'58" E.
� South: Labels lines using south bearings. For example, S45°45'58" W.

� Under Tag Labels, select the Current Label Style for tags. 

� Under Tag Labels, specify the current tag number in the Current Tag Number 
box. The next tag that is created uses this number if it has not been used 
already.

� Click OK.
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The Effects of Label Alignment

When a dynamic label is aligned to an object, the following occurs:

� If you move the line, the label maintains its location relative to the object.
� If you move the label away from the line (using grip editing), the label is 

realigned with the object if you edit either the object or the label style.

When a label is not aligned to an object, the following occurs:

� If you move the object, the label does not maintain its location relative to 
the object. It remains in its original location.

� If you edit the label style, the label remains in its original location.

Changing the Settings for Labeling Curves

You can set up default settings for labeling the curves in your drawing. These 
settings include the default label style, the label alignment and rotation, and 
the tag style to use when you create tag labels.

NOTE These are global settings. You can edit the properties of individual 
labels by using the Edit Label Properties command. For more information, see 
“Changing the Properties of Labels” on page 571.
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� From the Labels menu, choose Settings to display the Labels Settings dialog 
box. 

� Click the Curve Labels tab.
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� From the Current Label Style list, select the curve label style that you want to 
use.

� Do one of the following to specify the label alignment:

� Select the Align Label On Object check box to align the label text with the 
curve. The label matches the curvature of the curve. 

� Clear the Align Label On Object check box to have the label match the 
curvature of the curve. When this check box is cleared, the labels use the 
rotation angle specified in the Non-Aligned Label Rotation Angle box. 
Whenever you edit the curve, the label is not moved or rotated; it stays in 
the same location.

See the Label alignment illustration in “Changing the Settings for Labeling 
Lines” on page 521. 

� In the Non-Aligned Label Rotation Angle box, type the rotation angle for 
labels that are not aligned. Type this value in decimal degrees.

� Under Tag Labels, select the Current Label Style for tags. 

� Under Tag Labels, specify the current tag number in the Current Tag Number 
box. The next tag that is created uses this number if it has not been used 
already.

� Click OK.

Changing the Settings for Labeling Spirals

You can set up default settings for labeling the spirals in your drawing. These 
settings include the default label style, the label alignment and rotation, and 
the tag style to use when you create tag labels.

NOTE These are global settings. You can edit the properties of individual 
labels by using the Edit Label Properties command. For more information, see 
“Changing the Properties of Labels” on page 571.
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� From the Labels menu, choose Settings to display the Labels Settings dialog 
box. 

� Click the Spiral Labels tab.
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� From the Current Label Style list, select the spiral label style that you want to 
use.

� Do one of the following to specify the label alignment:

� Select the Align Label On Object check box to align the label text with the 
spiral. 

� Clear the Align Label On Object check box to have the labels use the rota-
tion angle specified in the Non-Aligned Label Rotation Angle box. When-
ever you edit the spiral, the label is not moved or rotated; it stays in the 
same location.

See the Label Alignment illustration in “Changing the Settings for Labeling 
Lines” on page 521. 

� In the Non-Aligned Label Rotation Angle box, type the rotation angle for 
labels that are not aligned. Type this value in decimal degrees.

� Under Tag Labels, select the Current Label Style for tags. 

� Under Tag Labels, specify the current tag number in the Current Tag Number 
box. 

The next tag that is created uses this number if it has not been used already.

� Click OK.

Changing the Settings for Labeling Points

You can set up default settings for labeling the points in your drawing. These 
settings include the default label style and the label rotation.
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NOTE These are global settings. You can edit the properties of individual 
labels by using the Edit Label Properties command. For more information, see 
“Changing the Properties of Labels” on page 571.

NOTE In order to label points, the Use the Current Point Label Style When 
Inserting Points check box must be selected in the Point Settings dialog box. For 
more information, see “Changing the Point Insertion Settings” on page 98.
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� From the Labels menu, choose Settings to display the Labels Settings dialog 
box. 

� Click the Point Labels tab.

� From the Current Label Style list, select the point label style that you want to 
use.

� In the Label Rotation Angle box, type the rotation angle for the point labels. 
Type this value in decimal degrees.

� Click OK.
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23Label Styles

Label styles control how line, curve, spiral, and point 

labels appear and function. Styles control what is 

labeled, such as length, chord, or direction. They also 

control label position and text appearance, justification, 

and units. Point label styles can be set up to label points 

with information from an External Data Reference 

(XDRef) and to override point marker text. Point label 

styles also control the use of description key 

substitution.

In this chapter

� Label Styles

� Selecting the Current Label 
Style

� Style Properties Dialog Bar

� Editing Line, Curve, Spiral, and 
Point Label Styles

� Using a Formula Within a Label 
Style to Convert Values
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Label Styles

Each label is based on a label style. A label style determines how a label 
appears, and what information it contains. For example, a label style can be 
set up to label distance above the line and direction below the line. 

Styles make it easier to maintain consistency in your drawing: 

� Label appearance is controlled by the label style text properties, such as 
text style, layer, and justification. The label appearance is also affected by 
the precision values you select for the labels and formulas, and whether 
you choose to add crow’s feet, tick marks, or arrows to the label style.

� Label content is controlled by choosing data elements. Data elements are 
items such as Direction, Distance, Length, Latitude, and so on. These are 
the pieces of information that the label contains. You can apply formulas 
to data elements to convert label data to different units, for example. 

Label Style Files
AutoCAD Land Development Desktop includes several default label styles. 
Each of the four supported object types (lines, curves, spirals, and points) 
have different label styles. The label styles have different file extensions 
based on whether the style labels lines, curves, spirals, or points, or whether 
the label is a tag label:

� Line styles: .lns
� Curve styles: .crs
� Spiral styles: .sps
� Point styles: .pts
� Line tag styles: .ltt
� Curve tag styles: .ctt
� Spiral tag styles: .stt

Leroy and Metric Label Styles
By default, the label styles supplied with AutoCAD Land Development 
Desktop are located in the following folder:

c:\Land Desktop R2\Data\Labels

These styles reference your drawing’s current text style. 

There are two other sets of label styles you can use: Leroy and Metric. These 
styles use Leroy and Metric text styles. You must change the default label 
styles path in order to use Leroy and Metric label styles. For more informa-
tion, see “Specifying Which Folder Contains the Label Styles” on page 517.
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Text Styles and Label Styles
If a text style is referenced in a label style, that text style must exist in the 
current drawing. To load text styles into the current drawing, use the 
Drawing Setup command on the Projects menu, and load the text styles from 
the Text Style tab. For more information, see “Loading Pre-defined Text Styles 
and Changing the Current Text Style” on page 63. You can also create text 
styles using the AutoCAD STYLE command.

Point Block Only Label Style
The Point Block Only point label style mimics the Autodesk S8 Civil/Survey 
point block appearance. This style has no text, no description key symbol, 
and the common block is the Autodesk S8 POINT block. The POINT block 
has block attributes for elevation, point number, and description. When 
points are inserted into the drawing using this style, the attribute values are 
filled in. However, there is still a point object that is inserted into the draw-
ing, and AutoCAD Land Development Desktop functionality that depends 
on point objects operates correctly.

This style was implemented to provide a method whereby third-party and 
user routines and programs that depend upon the presence of POINT blocks 
can still be used.

NOTE For future upgrading purposes, it is recommended that you do not edit 
the default label styles. Instead, create new label styles for your custom require-
ments. Or, after editing a default label style, save it to a new name. 

Selecting the Current Label Style

All new labels are created with the current label styles. There are always seven 
current label styles, two each for lines, curves, spirals (for regular labels and 
tag labels), and one for points. For example, you can select a current line label 
style that is used when you create new line labels, and a current point label 
style that is used when you create new point labels.

NOTE Points use the current label style unless the points are inserted by a 
group that has a label override applied to it. 
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Making a Selected Label Style the Current Label 
Style

You can select any label in the drawing and make its style the current label 
style. 
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� Click on the label in your drawing that is the style you want to make current.

IMPORTANT You must select the label itself, not the object that is 
labeled. 

� Right-click to display the shortcut menu.

� Select Set Label Style Current.

Selecting the Current Label Style from the Style 
Properties Dialog Bar

A quick method of changing the current label styles is to use the Style 
Properties dialog bar. From the Style Properties dialog bar, you can select the 
current label styles for lines, curves, spirals, and points. You can also select 
the current tag label styles for lines, curves, and spirals.
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� From the Labels menu, choose Show Dialog Bar.

� Click one of the four tabs: Line, Curve, Spiral, or Point.

� From the Current Label list, select the current label style.

TIP To select regular label styles, be sure that the  icon is displayed. 

To select tag label styles, be sure that the  icon is displayed. You can switch 
the icons by clicking on the icon that is currently visible. 
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Selecting the Current Label Style from the 
Labels Settings Dialog Box

When you are specifying label settings you can select the current label and 
tag styles to use.
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� From the Labels menu, choose Settings to display the Labels Settings dialog 
box. 

� Click on the appropriate tab. For example, to select a different current line 
label style, click on the Line Labels tab.

� From the Current Label Style lists, select a current label style and a current 
tag label style.

NOTE Points do not use tag labels. 

� Click OK.

Using the Style Properties Dialog Bar

Use the Style Properties dialog bar to select the current label styles for lines, 
curves, spirals, and points; to access the Edit Label Styles and Labels Settings 
dialog boxes; and to change the label alignment setting.
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Displaying the Style Properties Dialog Bar

The Style Properties dialog bar is a modeless dialog box which you can keep 
open while you are using other commands. 
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� From the Labels menu, choose Show Dialog Bar.

Changing the Label Alignment Setting from the 
Style Properties Dialog Bar

You can change the alignment setting for labels from the Style Properties dia-
log bar. The alignment setting controls whether the labels are aligned to the 
object’s rotation angle or not. 

See the Label Alignment illustration in “Changing the Settings for Labeling 
Lines” on page 521. 
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� From the Labels menu, choose Show Dialog Bar.

� Do one of the following:

� Select the Align on Object check box to align the labels with the object’s 
rotation.

� Clear the Align on Object check box if you do not want to align the labels 
with the object’s rotation. When you clear this check box, the labels are 
created using the non-aligned label rotation angle in the Label Settings 
dialog box.

Accessing the Edit Label Styles Dialog Box from 
the Style Properties Dialog Bar

����
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� From the Labels menu, choose Show Dialog Bar.

� Click .
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Accessing the Label Settings Dialog Box from the 
Style Properties Dialog Bar
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� From the Labels menu, choose Show Dialog Bar.

� Click .

Switching Between Label Styles and Tag Label 
Styles in the Style Properties Dialog Bar

You can use the Style Properties dialog bar to select the current label styles for 
regular labels and tag labels. The dialog bar shows either the regular label 
styles or the tag label styles, depending on the mode of the dialog box. You 
can switch modes to access both sets of styles.
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� From the Labels menu, choose Show Dialog Bar.

� Do one of the following:

� If the label icon is displayed, then click it to display the tag icon . This 
populates the list of styles with tag styles.

� If the tag icon is displayed, then click it to display the label icon . This 
populates the list of styles with label styles.

Editing Line Label Styles

Each line label style has properties that define what type of data the label 
style contains, what text style it uses, and what units it uses. Each label style 
has a unique name. To change any of these aspects, you can edit a label style. 

NOTE The Save and Delete buttons in the Edit Label Styles dialog box commit 
the changes that you have made. Clicking Cancel after clicking Save or Delete 
does not undo your changes.
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� Display the Edit Label Styles dialog box by doing one of the following:
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� From the Labels menu, choose Edit Label Styles.
� From the Labels menu, choose Show Dialog Bar, verify that the label icon 

 is visible, and then click .
� Select a label, right-click, and then select Edit Label Style.

NOTE Be sure that you select the label text; do not select the object that is 
labeled. 

� From the Projects menu, choose Edit Data Files to display the Edit Data 
Files dialog box. From the Program list, select Land Development Desktop. 
From the Data Files list, select Label Styles and click Edit Data.

� Click the Line Label Styles tab.

� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit.

� To create a new label style, type a new name in the Name list. Be sure to 
click Save to save the new style. Label style names are limited to 255 char-
acters, including path and file extension. Invalid characters include \ / : * 
? " < > |.
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NOTE For future upgrading purposes, it is recommended that you do not 
edit the default label styles. Instead, create new label styles for your custom 
requirements. Or, after editing a default label style, save it to a new name. 

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label looks like. 

� You can specify the following label style items:

� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Line Label Styles” on page 
535.

� Data Elements: Controls which items the label style will label, such as 
distance or direction, text breaks, delta symbols, and the plus/minus sym-
bol. For more information, see “Data Elements for Line Label Styles” on 
page 536.

� Text Above and Text Below: Controls where the label is placed, either 
above or below the object. Controls the label prefix and the text and for-
mulas added to labels. For more information, see “Text Above and Text 
Below for Line Label Styles” on page 538.

� Units: Controls the linear and angular units. For more information, see 
“Units for Line Label Styles” on page 539.

� Arrow, Tick, Crows Feet: Controls whether symbols are placed on the 
object along with the label. For more information, see “Arrows, Ticks, and 
Crows Feet for Line Label Styles” on page 540.

Text Properties for Line Label Styles

� Complete steps 1–4 in “Editing Line Label Styles” on page 533.

� Under Text Properties, select a text style for the label. If you select *Current*, 
then any time that you label an object using this style, the label is created 
using the current text style.

NOTE If you subsequently change the current text style for the drawing 
(STYLE command), then the labels that were created using the *Current* option 
are updated to the new current style, even if the labels are static or disassociated.

� If you selected a zero-height style, then specify a height in the Height box. 
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NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an Offset for the label. This value is not a distance; it is a fac-
tor. The offset value that you specify is a factor that is multiplied by the text 
height to compute the actual offset distance.
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# Select a Layer for the label. If you select *Current*, then any time you label 
an object using this style, the label is placed on the current layer. 

NOTE If you subsequently change the current layer for the drawing, then the 
labels that were created using the *Current* option remain on their original 
layer.

$ Select one of the following justification methods for the text: 

� Left: Left-justifies the label on the object.
� Right: Right-justifies the label on the object. 
� Center: Centers the label on the object.

Data Elements for Line Label Styles

You can change what a label style will label by selecting different data 
elements.

� Complete steps 1–4 in “Editing Line Label Styles” on page 533.

� From the Data list, select the data element you want to include in the label. 

When you define line label styles, you can specify what items you want to 
label on each line. These items are called data elements. Select a data ele-
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ment, and then click the Text Above or Text Below button to add that ele-
ment to the label style.

NOTE The Plus/Minus symbol only appears in the labels if the text style being 
used for the label supports the Plus/Minus symbol. Many true type fonts do not 
support this character. 

Data elements for line label styles
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Length Labels the length of the line.

Direction Labels the direction of the line.

Data elements for editing line label styles (continued)
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Start Northing Labels the northing coordinate of the start point of the line.

Start Easting Labels the easting coordinate of the start point of the line.

End Northing Labels the northing coordinate of the end point of the line.

End Easting Labels the easting coordinate of the end point of the line.

Text Break Creates multiple text objects. A text break can be used to 
separate the labels on an object. When you insert this data 
element, it shows up as “100” in the preview box. 

���� ����

Plus/Minus Symbol Inserts a plus/minus ( + ) symbol into the label.
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� Do one of the following:

� Click the Text Above button to place the data element in the Text Above 
box. 

When you label an object with this style, any data element in the Text 
Above box appears in the label above the object.

� Click the Text Below button to place the data element in the Text Below 
box. Any data element in the Text Below box appears in the label below 
the object.

NOTE The 100.00 preview values next to the Text Above and Text Below 
boxes are numeric place holders and do not necessarily represent actual values.

The following illustration shows the effects of selecting Text Above and Text 
Below:
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Text Above and Text Below for Line Label Styles

This information follows the steps in “Editing Line Label Styles” on page 533.

The Text Above and Text Below boxes contain the data elements for a label 
style. The box on the right shows a preview of what the label looks like.

NOTE The 100.00 preview values next to the Text Above and Text Below 
boxes are numeric place holders and do not necessarily represent actual values.

You can type text into these boxes. This text appears in the label. For exam-
ple, you can type meters into one of these boxes to create metric labels with 
the word “meters” appended to the end of the label. 

You can make any of the following changes to the data elements for a label 
style:
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� In the Text Above or Text Below box, you can type, select, delete, copy, 
and paste text. 

� You can add prefixes or suffixes to labels. For example, you can type 
meters to append the word “meters” to the end of a label.

� You can add formulas to labels by inserting them into the Text Above or 
the Text Below boxes. For more information, see “Using a Formula Within 
a Label Style to Convert Values” on page 560.

Units for Line Label Styles

You can change the precision values for linear and angular units.

� Complete steps 1–4 in “Editing Line Label Styles” on page 533.

� Under Units, select Linear to display the Linear Units dialog box. 

� Enter the precision values for the following units:

� Linear: For labeling lengths.
� Formula: For labeling the results of formula calculations.
� Coordinate: For labeling northing and easting coordinates.

NOTE You can either type a value in the boxes, or use the up and down arrows 
to select a value. 

� Click OK to return to the Edit Label Styles dialog box.

# Under Units, select Angular to display the Angular Units dialog box. 
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$ Select the Allow Text Spaces check box to place spaces in angular labels. 
When this check box is selected, an angle is labeled in the format (N 
52°14'39"E). If you do not select this check box, then an angle is labeled with-
out spaces (N 52°14'39"E).

) In the Angular box, enter the precision for displaying angles. This precision 
value is used to label a line’s direction.

* In the Formula box, enter the precision for displaying the results of formula 
calculations. This precision value is used if you apply a formula to the line’s 
direction.

+ Click OK to return to the Edit Label Styles dialog box.

Arrows, Ticks, and Crows Feet for Line Label 
Styles
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� Complete steps 1–4 in “Editing Line Label Styles” on page 533.

� Under Text Above and/or Text Below, do the following:

� Select the Arrow check box to insert arrows on the objects you label to 
indicate their direction. 

� Select either Tick or Crows Feet to insert either tick marks or crows feet on 
the objects you label.

Editing Curve Label Styles

Each curve label style has properties that define what type of data the label 
style contains, what text style the label style uses, and what units the label 
style uses. Each label style has a unique name. You can edit a label style to 
change any of these aspects.

NOTE The Save and Delete buttons in the Edit Label Styles dialog box commit 
the changes that you have made. Clicking Cancel after clicking Save or Delete 
does not undo your changes.
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� From the Labels menu, choose Edit Label Styles to display the Edit Label 
Styles dialog box.

� Click the Curve Label Styles tab.
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� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit.

� Type a new name in the Name list to create a new label style. Be sure to 
click Save to save the new style. Label style names are limited to 255 char-
acters, including path and file extension. Invalid characters include \ / : * 
? " < > |.

NOTE For future upgrading purposes, it is recommended that you do not edit 
the default label styles. Instead, create new label styles for your custom require-
ments. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label would look like. 

� You can edit any of the following label style items:
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� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Curve Label Styles” on page 
542.

� Data Elements: Controls which items the label style will label, such as 
distance or direction, text breaks, delta symbols, and the plus/minus sym-
bol. For more information, see “Data Elements for Curve Label Styles” on 
page 543.

� Text Above and Text Below: Controls where the label is placed, either 
above or below the object. Controls the label prefix and text and formulas 
added to labels. For more information, see “Text Above and Text Below for 
Curve Label Styles” on page 544.

� Units: The linear and angular units. For more information, see “Units for 
Curve Label Styles” on page 545.

� Arrow, Tick, Crows Feet: Controls whether symbols are placed on the 
object along with the label. For more information, see “Arrows, Ticks, and 
Crows Feet for Curve Label Styles” on page 545.

Text Properties for Curve Label Styles

� Complete steps 1–4 in “Editing Curve Label Styles” on page 540.

� Under Text Properties, select a text style for the label. If you select *Current*, 
then any time that you label an object using this style, the label is created 
using the current text style.

NOTE If you subsequently change the current text style for the drawing 
(STYLE command), then the labels that were created using the *Current* option 
are updated to the new current style, even if the labels are static or disassociated.

� If you selected a zero-height style, then specify a height in the Height box. 

NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an Offset for the label. This value is not a distance; it is a fac-
tor. The offset value that you specify is a factor that is multiplied by the text 
height to compute the actual offset distance. 

See the illustration in “Text Properties for Line Label Styles” on page 535.

# Select a Layer for the label. If you select *Current*, then any time you label 
an object using this style, the label is placed on the current layer. 
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NOTE If you subsequently change the current layer for the drawing, then the 
labels that were created using the *Current* option remain on their original 
layer.

$ Select one of the following justification methods for the text: 

� Left: Left-justifies the label on the object.
� Right: Right-justifies the label on the object. 
� Center: Centers the label on the object.

Data Elements for Curve Label Styles

You can change what a label style will label by selecting different data 
elements.

� Complete steps 1–4 in “Editing Curve Label Styles” on page 540.

� From the Data list, select the data element that you want to include in the 
label. 

When you define curve label styles, you can specify what items you want to 
label on each curve. These items are called data elements. Select a data ele-
ment, and then click the Text Above or Text Below button to add that ele-
ment to the label style.The Plus/Minus symbol only appears in the labels if 

Data elements for curve label styles
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Radius Labels the radius of the curve.

Length Labels the length of the curve.

Delta Angle Labels the central angle of the curve.

Tangent Labels the tangent length of the curve.

Chord Direction Labels the direction of the chord.

Chord Labels the length of the chord.

Text Break Creates multiple text objects. A text break can be used to 
separate the labels on an object. When you insert this data 
element, it shows up as “100” in the preview box.
See the illustration in “Data Elements for Line Label 
Styles” on page 536.
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the text style being used for the label supports the Plus/Minus symbol. Many 
true type fonts do not support this character. 

� Do one of the following:

� Click the Text Above button to place the data element in the Text Above 
box. When you label an object with this style, any data element in the 
Text Above box appears in the label above the object.

� Click the Text Below button to place the data element in the Text Below 
box. Any data element in the Text Below box appears in the label below 
the object.

NOTE The 100.00 preview values next to the Text Above and Text Below 
boxes are numeric place holders and do not necessarily represent actual values.

Text Above and Text Below for Curve Label 
Styles

This information follows the steps in “Editing Curve Label Styles” on page 
540.

The Text Above and Text Below boxes contain the data elements for a label 
style. The box on the right shows a preview of what the label looks like.

NOTE The 100.00 preview values next to the Text Above and Text Below 
boxes are numeric place holders and do not necessarily represent actual values.

You can type text into these boxes. This text appears in the label. For exam-
ple, you can type meters into one of these boxes to create metric labels with 
the word “meters” appended to the end of the label. 

You can make any of the following changes to the data elements for a label 
style:

� First complete steps 1–4 in “Editing Curve Label Styles” on page 540.
� In the Text Above or Text Below box, you can type, select, delete, copy, 

and paste text. 

Plus/Minus Symbol Inserts a plus/minus ( + ) symbol into the label.

Delta Symbol Inserts a delta symbol into the label.
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� You can add prefixes or suffixes to labels. For example, you can type 
meters to append the word “meters” to the end of a label.

� You can add formulas to labels by inserting them into the Text Above or 
the Text Below boxes. For more information, see “Using a Formula Within 
a Label Style to Convert Values” on page 560.

Units for Curve Label Styles

You can change the precision values for linear and angular units.

� Complete steps 1–4 in “Editing Curve Label Styles” on page 540.

� Under Units, select Linear to display the Linear Units dialog box. 

� Enter the precision values for the following units:

� Linear: For labeling lengths. The precision value is used to label the delta 
angle.

� Formula: For labeling the results of formula calculations.
� Coordinate: For labeling northing and easting coordinates.

NOTE You can either type a value in the boxes, or use the up and down arrows 
to select a value. 

� Click OK to return to the Edit Label Styles dialog box.

# Under Units, select Angular to display the Angular Units dialog box. 

$ Select the Allow Text Spaces check box to place spaces in angular labels. This 
setting is typically used only for line labels.

) In the Angular box, enter the precision for displaying angles. This precision 
value is used to label chord direction only.

* In the Formula box, enter the precision for displaying the results of formula 
calculations. This precision value is used to label formulas that are applied to 
chord direction.

+ Click OK to return to the Edit Label Styles dialog box.

Arrows, Ticks, and Crows Feet for Curve Label 
Styles
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� Complete steps 1–4 in “Editing Curve Label Styles” on page 540.

� Under Text Above and/or Text Below, do the following:
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� Select the Arrow check box to insert arrows on the objects you label to 
indicate their direction. 

� Select either Tick or Crows Feet to insert either tick marks or crows feet on 
the objects you label.

Editing Spiral Label Styles

Each spiral label style has properties that define what type of data the label 
style contains, what text style it uses, and what units it uses. Each label style 
has a unique name. To change any of these aspects, you can edit a label style. 

NOTE The Save and Delete buttons in the Edit Label Styles dialog box commit 
the changes that you have made. Clicking Cancel after clicking Save or Delete 
does not undo your changes.
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� From the Labels menu, choose Edit Label Styles to display the Edit Label 
Styles dialog box.

� Click the Spiral Label Styles tab.
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� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit.

� To create a new label style, type a new name in the Name list. Be sure to 
click Save to save the new style. Label style names are limited to 255 char-
acters, including path and file extension. Invalid characters include \ / : * 
? " < > |.

NOTE For future upgrading purposes, it is recommended that you do not edit 
the default label styles. Instead, create new label styles for your custom require-
ments. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label looks like. 

� You can specify the following label style items:
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� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Spiral Label Styles” on page 
548.

� Data Elements: Controls which items the label style will label, such as 
distance or direction, text breaks, delta symbols, and the plus/minus sym-
bol. For more information, see “Data Elements for Spiral Label Styles” on 
page 549.

� Text Above and Text Below: Controls where the label is placed, either 
above or below the object. Controls the label prefix and text and formulas 
added to labels. For more information, see “Text Above and Text Below for 
Spiral Label Styles” on page 550.

� Units: Controls the linear units. For more information, see “Units for Spi-
ral Label Styles” on page 551.

� Arrow, Tick, Crows Feet: Controls whether symbols are placed on the 
object along with the label. For more information, see “Arrows, Ticks, and 
Crows Feet for Spiral Label Styles” on page 552

Text Properties for Spiral Label Styles

� Complete steps 1–4 in “Editing Spiral Label Styles” on page 546.

� Under Text Properties, select a text style for the label in the Style box. If you 
select *Current*, then any time that you label an object using this style, the 
label is created using the current text style.

NOTE If you subsequently change the current text style for the drawing 
(STYLE command), then the labels that were created using the *Current* option 
are updated to the new current style, even if the labels are static or disassociated.

� If you selected a zero-height style, then specify a height in the Height box. 

NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an offset for the label in the Offset box. This value is not a 
distance; it is a factor. The offset value that you specify is a factor that is mul-
tiplied by the text height to compute the actual offset distance. 

See the illustration in “Text Properties for Line Label Styles” on page 535.

# Select a layer for the label in the Layer box. If you select *Current*, then any 
time you label an object using this style, the label is placed on the current 
layer. 



Editing Spiral Label Styles | 549

NOTE If you subsequently change the current layer for the drawing, then the 
labels that were created using the *Current* option remain on their original 
layer.

$ Select one of the following justification methods for the text: 

� Left: Left-justifies the label on the object.
� Right: Right-justifies the label on the object. 
� Center: Centers the label on the object.

Data Elements for Spiral Label Styles

You can change what a label style will label by selecting different data 
elements.

� Complete steps 1–4 in “Editing Spiral Label Styles” on page 546.

� From the Data list, select the data element that you want to include in the 
label. 

When you define spiral label styles, you can specify what items you want to 
label on each spiral. These items are called data elements. Select a data ele-
ment, and then click the Text Above or Text Below button to add that ele-
ment to the label style.

Data elements for spiral label styles
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Radius Labels the radius of the spiral at the point of transition from 
spiral to curve (SC), or curve to spiral (CS). 

Length Labels the length of the spiral.

Theta Labels the theta angle of the spiral.

X Labels the tangent length between TS and SC, or CS and ST.

Y Labels the offset distance at SC from TS, or at CS from ST.

Short Tangent Labels the length of the short tangent.

Long Tangent Labels the length of the long tangent. 

P Labels the offset of the initial tangent in to the PC of the 
shifted curve, or the offset of the initial tangent out to the PT 
of the shifted curve.
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NOTE The Plus/Minus symbol only appears in the labels if the text style being 
used for the label supports the Plus/Minus symbol. Many true type fonts do not 
support this character. 

� Do one of the following:

� Click the Text Above button to place the data element in the Text Above 
box. 

When you label an object with this style, any data element in the Text 
Above box appears in the label above the object.

� Click the Text Below button to place the data element in the Text Below 
box. Any data element in the Text Below box appears in the label below 
the object.

NOTE The 100.00 preview values next to the Text Above and Text Below 
boxes are numeric place holders and do not necessarily represent actual values.

Text Above and Text Below for Spiral Label Styles

This information follows the steps in “Editing Spiral Label Styles” on page 
546.

The Text Above and Text Below boxes contain the data elements for a label 
style. The box on the right shows a preview of what the label looks like. 

K Labels the abscissa of the shifted PC referred to the TS, or the 
abscissa of the shifted PT referred to the ST.

A Labels the spiral A parameter, which is the square root of the 
product of the length and radius.

Text Break Creates multiple text objects. A text break can be used to 
separate the labels on an object. When you insert this data 
element, it shows up as “100” in the preview box.
See the illustration in “Data Elements for Line Label 
Styles” on page 536.

Plus/Minus Symbol Inserts a plus/minus ( + ) symbol into the label.

Data elements for spiral label styles
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NOTE The 100.00 preview values next to the Text Above and Text Below 
boxes are numeric place holders and do not necessarily represent actual values.

You can type text into these boxes. This text appears in the label. For exam-
ple, you can type meters into one of these boxes to create metric labels with 
the word “meters” appended to the end of the label. 

� First complete the steps in “Editing Spiral Label Styles” on page 546.
� In the Text Above or Text Below box, you can type, select, delete, copy, 

and paste text. 
� You can add prefixes or suffixes to labels. For example, you can type 

meters to append the word “meters” to the end of a label.
� You can add formulas to labels by inserting them into the Text Above or 

the Text Below boxes. For more information, see “Using a Formula Within 
a Label Style to Convert Values” on page 560.

Units for Spiral Label Styles

You can change the precision values for linear units.

NOTE Spiral labels do not use the angular precision values.

� Complete steps 1–4 in “Editing Spiral Label Styles” on page 546.

� Under Units, select Linear to display the Linear Units dialog box. 

� Enter the precision values for the following units:

� Linear: For labeling lengths.
� Formula: For labeling the results of formula calculations.
� Coordinate: For labeling northing and easting coordinates.

NOTE You can either type a value in the boxes, or use the up and down arrows 
to select a value. 

� Click OK to return to the Edit Label Styles dialog box.
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Arrows, Ticks, and Crows Feet for Spiral Label 
Styles
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� Complete steps 1–4 in “Editing Spiral Label Styles” on page 546.

� Under Text Above and/or Text Below, do the following:

� Select the Arrow check box to insert arrows on the objects you label to 
indicate their direction. 

� Select either Tick or Crows Feet to insert either tick marks or crows feet on 
the objects you label.

Editing Point Label Styles

Each point label style has properties that define what type of data the label 
style contains, what text style it uses, and what units it uses. Each label style 
has a unique name. To change any of these aspects, you can edit a label style.

Point label styles control the use of description keys and the insertion of 
common symbol blocks at point nodes. In order to achieve the full effects of 
description key substitution, you must use a point label style that is set up to 
label description keys.

In addition, you can label points with information that is not in the project 
point database. If you have a custom Microsoft Access database that con-
tains point information that you want to label points with, then you can 
define XDRefs (External Data References) and then use the XDRefs as part of 
label styles. For more information, see “Using External Data References 
(XDRefs)” on page 172.

Both point markers and point labels can be visible in the drawing at the same 
time. You can format the label style so that it automatically turns off the 
point markers when you label the points. For more information, see “Differ-
ences Between Point Markers and Point Labels” on page 109.

NOTE In order to label points that already exist in the drawing, the Use the 
Current Point Label Style When Inserting Points check box must be selected in 
the Point Settings dialog box. If this check box is selected when you are creating 
or inserting points, then the current point label style is automatically applied to 
the points—you do not have to label the points after they are inserted or created. 
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For more information, see “Changing the Point Insertion Settings” on page 
98.

NOTE The Save and Delete buttons in the Edit Label Styles dialog box commit 
the changes that you have made. Clicking Cancel after clicking Save or Delete 
does not undo your changes.

����������������	��	����	�

� From the Labels menu, choose Edit Label Styles to display the Edit Label 
Styles dialog box.

� Click the Point Label Styles tab.

� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit.

� To create a new label style, type a new name in the Name list. Be sure to 
click Save to save the new style. Label style names are limited to 255 char-
acters, including path and file extension. Invalid characters include \ / : * 
? " < > |.
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NOTE For future upgrading purposes, it is recommended that you do not edit 
the default label styles. Instead, create new label styles for your custom require-
ments. Or, after editing a default label style, save it to a new name.

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label looks like. 

� You can specify the following label style items:

� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Point Labels” on page 554.

� Data Elements: Controls the items that the label style will label, such as 
description or elevation, text breaks, and the plus/minus symbol. For 
more information, see “Data Elements for Point Labels” on page 555.

� XDRef Elements: Controls whether points are labeled with point data 
from custom databases. For more information, see “XDRef Elements for 
Point Labels” on page 557.

� Turn Off Marker Text: Controls whether point markers are turned off 
when labels are created. For more information, see “Turning Off Marker 
Text for Point Labels” on page 557.

� Text: Controls the point label prefix and text and formulas added to 
labels. For more information, see “Text for Point Labels” on page 557.

� Units: Controls the linear and angular units. For more information, see 
“Units for Point Labels” on page 558.

� Common Symbol: Controls the symbol block inserted at the point node. 
For more information, see “Common Symbols for Point Labels” on page 
558.

� Description Keys: Controls description keys for symbols, descriptions, 
and layer control. For more information, see “Description Keys for Point 
Labels” on page 559.

Text Properties for Point Labels

� Complete steps 1–4 in “Editing Point Label Styles” on page 552. 

� Under Text Properties, select a text style for the label in the Style box. If you 
select *Current*, then any time that you label an object using this style, the 
label is created using the current text style.

NOTE If you subsequently change the current text style for the drawing 
(STYLE command), then the labels that were created using the *Current* option 
are updated to the new current style, even if the labels are static or disassociated.
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� If you selected a zero-height style, then specify a height in the Height box. 

NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an offset for the label in the Offset box. This value is not a 
distance; it is a factor. The offset value that you specify is a factor that is mul-
tiplied by the text height to compute the actual offset distance. 

See the illustration in “Text Properties for Line Label Styles” on page 535.

# Select a layer for the label in the Layer box. If you select *Current*, then any 
time you label an object using this style, the label is placed on the current 
layer. 

NOTE If you subsequently change the current layer for the drawing, then the 
labels that were created using the *Current* option remain on their original layer.

$ Under Justification, select one of the justification methods for the point label. 

The option you select represents the location of the point node. The “X” in 
the center represents the location of the point label.

NOTE The On Elevation justification method uses the elevation’s decimal 
point as the point node. 

Data Elements for Point Labels

You can change what a label style will label by selecting different data elements.

� Complete steps 1–4 in “Editing Point Label Styles” on page 552.

� From the Data list, select the data element that you want to include in the label. 

When you define point label styles, you can specify what items you want to 
label on each point. These items are called data elements. Select a data ele-
ment, and then click the Text button to add that element to the label style.

Data elements for point label styles

%�����	����� &��
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Point Number Labels the point number.

Elevation Labels the point elevation.
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NOTE The Plus/Minus symbol only appears in the labels if the text style being 
used for the label supports the Plus/Minus symbol. Many true type fonts do not 
support this character. 

� Click the Text button to add the data element to the label style.

Description Labels the point description.

Northing Labels the northing.

Easting Labels the easting.

Point Name Labels the point name.

Point Name or 
Number

Labels the point name or number. If the point is named, 
then the name is labeled. If the point is unnamed, then 
the point number is labeled.

Latitude Labels the latitide.

Longitude Labels the longitude.

Grid North Labels the grid northing of the point, based on the 
current zone for the drawing.

Grid East Labels the grid easting of the point, based on the current 
zone for the drawing.

Group Name Labels the point with the name of the (most recent) 
group it was inserted from. 

Text Break Creates multiple text objects. When you insert this data 
element, it shows up as “100” in the preview box.
See the illustration in “Data Elements for Line Label 
Styles” on page 536.

Plus/Minus Symbol Inserts a plus/minus ( + ) symbol into the label.

Data elements for point label styles (continued)
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XDRef Elements for Point Labels

You can label points with point data from custom Microsoft Access database 
files by specifying an External Data Reference (XDRef). XDRefs must be 
present before you can format a label style using an XDRef. For more infor-
mation on formatting labels to use XDRefs, see “Example: Creating a Point 
Label Style that Labels Points with XDRef Information” on page 177.

� Complete steps 1–4 in “Editing Point Label Styles” on page 552.

� From the XDRef list, select the external reference file that you want to obtain 
data from.

� Click Text to insert the external reference into the label style.

When you label points using this style, the information from the custom 
database is inserted into the label text.

NOTE When floating point values are used as XDRefs and are displayed in the 
point label text, rounding is controlled by the Linear precision setting of the 
point label style.

Turning Off Marker Text for Point Labels

You can control whether point marker text is turned off when you label 
points.

Complete steps 1–4 in “Editing Point Label Styles” on page 552. Then, do one 
of the following:

� Select the Turn Off Marker Text check box to turn off marker text when 
point labels are created using this label style.

� Clear the Turn Off Marker Text check box to keep marker text in the draw-
ing when you label points.

Text for Point Labels

This information follows the steps in “Editing Point Label Styles” on page 
552.

The Text box contains the data elements for a label style. You can type text 
into these boxes. This text appears in the label. For example, you can type 
meters into one box to create metric labels with the word “meters” appended 
to the end of the label (for example, for an elevation label). 

� In the Text box, you can type, select, delete, copy, and paste text. 
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� You can add prefixes or suffixes to labels. 
� You can add formulas to labels by inserting them into the Text box. For 

more information, see “Using a Formula Within a Label Style to Convert 
Values” on page 560.

NOTE The 100.00 preview value next to the Text box is a numeric place 
holder and does not necessarily represent an actual value.

Units for Point Labels

You can change the precision values for linear and angular units. For point 
labels, the linear units apply to the point elevation labels. The angular units 
apply to latitude and longitude labels.

� Complete steps 1–4 in “Editing Point Label Styles” on page 552.

� Under Units, select Linear to display the Linear Units dialog box. 

� Enter the precision values for the following units:

� Elevation: For labeling elevations.
� Formula: For labeling the results of formula calculations.
� Coordinate: For labeling northing and easting coordinates.

NOTE You can either type a value in the boxes, or use the up and down arrows 
to select a value. 

� Click OK to return to the Edit Label Styles dialog box.

# Under Units, select Angular to display the Angular Units dialog box. 

$ Select the Allow Text Spaces check box to place spaces in angular labels. This 
setting is typically used only for line labels.

) In the Angular box, enter the precision for displaying latitudes and 
longitudes.

* In the Formula box, enter the precision for displaying the results of formula 
calculations applied to latitudes and longitudes.

+ Click OK to return to the Edit Label Styles dialog box.

Common Symbols for Point Labels

You can use a symbol block to represent the point node.

� Complete steps 1–4 in “Editing Point Label Styles” on page 552.
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� Under Common Symbol, select the Insert Common Symbol check box. 

� From the Block list, select the symbol block that you want to use.

NOTE If the symbol you want to use is not in the list, then verify that it is 
located in the symbol path, or change the symbol path. For more information, 
see “Changing the Point Insertion Settings” on page 98.

� Select a layer for the symbol. You can select a layer from the Layer list, or type 
a new name in the Layer list.

NOTE You can use the WBLOCK command to create custom symbol blocks. 

NOTE Common symbols are affected by the Modify Drawing command. For 
example, if you select the option to Reunite key symbol with point, then both 
description key symbols and common symbol blocks are reunited with the 
points if they have been moved away from the points. For more information, see 
“Updating the Drawing with Project Point Information” on page 195.

Description Keys for Point Labels

Point label styles control description key substitution. You can use descrip-
tion keys to insert symbols and full descriptions for points, and to place point 
nodes and symbols on specified layers. 

For more information about formatting a label style to use description keys, 
see “Example: Formatting a Point Label Style to Use Description Key Substi-
tution” on page 170.

� Complete steps 1–4 in “Editing Point Label Styles” on page 552.

� Under Description, select the Description Key Matching check box. 

� From the DescKey File list, select the description key file that contains the 
description keys you want to use.

� You can select one or both of the following options to control the description 
key matching:

� Substitute DescKey Description: Uses the description located in the 
description key file. If you clear this check box, then the raw description 
that you defined when the point was created is used.

� Insert DescKey Symbol: Inserts the symbol associated with the descrip-
tion key. If you clear this check box, then the symbol is not used. 
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NOTE If you do not select either of these check boxes, then the points are 
created on the layer specified by the description key, but no symbol insertion 
or description substitution occurs. 

The following illustration shows point labels that use description keys: 
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Using a Formula Within a Label Style to 
Convert Values

You can insert formulas into any label style or table by typing the formula 
within the { } (curly brackets) in either the Text Above or Text Below boxes 
(line, curve, and spiral label styles) or the Text box (point label styles). The 
preview box located to the right of the text boxes displays how the formula 
appears when it is calculated.

NOTE All internal angle calculations are done in radians. 
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Formula Function Symbols

Use the following functions to perform calculations on label values. These 
functions extend the capability of label styles.

Formula function symbols

&��
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+ addition

- subtraction

* multiplication

/ division

^ exponent

( open parenthesis

) closed parenthesis

ABS absolute value of a number

ACOS arccosine of a number

ASIN arcsine of a number

ATAN arctangent of a number

COS cosine of a number

COSH hyperbolic cosine of a number

EXP e raised to the power of a number

LOG logarithm of a number to a specified base

LOG10 base-10 logarithm of a number

POW10 number raised to a power of 10

ROUND rounds to the closest integer

SIN sine of a number

SINH hyperbolic sine of a number
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NOTE Use parentheses ( ) with formulas as required by standard mathematical 
notation. 

Example: Converting Feet to Meters

You can use a formula to label a line with both feet and meters. 
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� From the Labels menu, choose Edit Label Styles to display the Edit Label 
Styles dialog box. 

� Click the Line Label Styles tab.

� From the Name box, select direction above, distance below. In the Text Below 
box, {Length}′ is displayed. This labels the line with its length, followed by a ′ 
(foot) symbol. 

You can now use a formula to label the distance in both feet and meters.

� From the Data list, select Length.

# Click Text Below. 

You now have two Length entries in the Text Below box. One labels the 
length in feet. You can edit the second entry so that it labels the length in 
meters. 

$ In the Text Below box, place your cursor after the second Length entry (but 
inside the closing curly bracket).

) Press SPACEBAR and then type *  .3048, the conversion factor for feet to 
meters. The asterisk, *, is the formula symbol for multiplication.

SQRT square root of a number

SQR square of a number

TAN tangent of a number

TANH hyperbolic tangent of a number

TRUNC number truncated to an integer

Formula function symbols (continued)
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* Type m for meters after the closing curly bracket, and place straight brackets 
[ ] around the metric length entry so that the Text Below box appears as 
follows:

{Length}′ [{Length * .3048}m]

+ Click Units to display the Linear Units dialog box.

�0 In the Linear box, type 2. This labels the line length in feet with a precision 
of 2. 

�� In the Formula box, type 3. This labels the line length in meters with a pre-
cision of 3.

�� Click Save to save the style.

�� Click OK to exit the dialog box.

Example: Labeling the Magnetic Direction

All internal angle calculations are done in radians. Take this into account 
when you apply a formula to an angle, such as when you label a line with 
both a true direction and a magnetic direction. 

For example, to subtract a 15d 30′ 15″ magnetic declination from an astro-
nomic direction to derive the magnetic direction, and then label the mag-
netic direction, you can use the following formula:

Known:

PI = 3.141592654

360 degrees = 2(PI)

1 radian = 57.29577951 degrees

Given:

15d 30′ 15″ =  15.50417 degrees

Formula Syntax:

{Direction-(15.50417*((2* 3.141592654)/360))} or,

{Direction-(15.50417/57.29577951)}

For more information about applying a formula within a label style, see 
“Example: Converting Feet to Meters” on page 562.

Example: Using the TRUNC Function

This formula:
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[TRUNC(Length)]′ - [((Length) - TRUNC(Length))*12]″

Produces a label that looks like this:

149' - 10"

when you set the precision for the formula to zero.
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24Labeling Objects

You can label lines, curves, spirals, points, and polylines 

with static or dynamic labels. Static labels never update 

if you edit the object or change the label style. Dynamic 

labels can automatically update if the object or style is 

edited.

In addition, you can label points and lines with geodetic 

information such as grid northing and easting, latitude 

and longitude, scale factor, and convergence angle.

In this chapter

� Dynamic Labels

� Static Labels

� Labeling Polylines

� Labeling Points with Northing 
and Easting, and Geodetic 
Information

� Creating a Building Offset Label
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Dynamic Labels

To update the labels in a drawing when you edit the label style or the labeled 
object, label the objects in your drawing with dynamic labels. By default, 
dynamic labels are automatically updated whenever you edit either a label 
style or the object itself.

Any label style can be dynamic—the dynamic or static nature of a label is not 
defined within the label style. Whether a label is dynamic or static depends 
on the command you use to create the label and the current label updating 
property. 

You can swap the text of dynamic labels so that the label above the object 
and the label below the object are exchanged. This is useful, for example, 
when you want to label an enclosed area with direction labels on the outside, 
and distance labels on the inside. You can also flip direction labels so that a 
label that says N79°47′58”E is changed to S79°47′58”W.

If you create dynamic labels and later you do not want them to update, you 
can:

� Disable the global update settings in the Label Settings dialog box. This 
prevents all dynamic labels in the drawing from changing. However, you 
can still use the Update All Labels, Update Selected Labels, and Edit Label 
Properties commands to update the labels. For more information, see 
“Specifying How Labels Are Updated” on page 518.

� Disable the Dynamically Update Label Text option in the Label Properties 
dialog box. By disabling this option, the label becomes static, and you can-
not use the Update All Labels or Update Selected Labels commands to 
update the labels. You must enable the dynamic property to update the 
labels. The global update setting does not affect the labels when the 
Dynamically Update Label Text option is disabled. For more information, 
see “Changing the Properties of Labels” on page 571.

� Disassociate labels After you disassociate labels, they can never be 
dynamic again, and can never update, regardless of the global setting. For 
more information, see “Disassociating Labels to Prevent Auto-Updating” 
on page 570.

Creating Dynamic Labels

To create labels that update automatically if you change the label style or edit 
the object that is labeled, use the Add Dynamic Labels command. 
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Using this command, you can select any group of objects to label. For exam-
ple, the selection set can contain lines, arcs, spirals, and points, or any com-
bination of the different object types. The current label styles are used for 
each different type of object. If you select an object that cannot be labeled 
with the Add Dynamic Labels command, such as a contour object, then the 
command ignores it. 

NOTE In order to label points, the Use the Current Point Label Style When 
Inserting Points check box must be selected in the Point Settings dialog box. For 
more information, see “Changing the Point Insertion Settings” on page 98.

NOTE The global update settings in the Label Settings dialog box affect how 
dynamic labels behave after they have been created. The global update settings 
must be enabled for the dynamic labels to update when the objects or styles 
change. “Specifying How Labels Are Updated” on page 518.
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� Select the current label styles. For more information, see “Selecting the Cur-
rent Label Style” on page 529. 

� From the Labels menu, choose Add Dynamic Labels.

� Select the object(s) that you want to label.

� Press ENTER.

or

� Select the current label styles.

� Select the object(s) that you want to label.

� Right-click to display the shortcut menu.

� Select Add Dynamic Labels.

Updating Selected Dynamic Labels

If you disabled the global updating options in the Label Settings dialog box, 
and you want to update selected dynamic labels, then you can use the 
Update Selected Labels command. This command updates the label style, 
label position, and label content.

NOTE This command does not work with static labels (labels that have the 
Dynamically Update Label Text property disabled) or disassociated labels. 
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� From the Labels menu, choose Update Selected Labels.

� Select the objects that have the labels you want to update. 

� Press ENTER.

or

� Select the objects that have the labels you want to update.

� Right-click to display the shortcut menu.

� Click Update Labels. 

Updating All Dynamic Labels in the Drawing

If you disabled the global updating options in the Label Settings dialog box, 
and you want to update all of the dynamic labels in your drawing, then you 
can use the Update All Labels command. This command updates the label 
style, label position, and label content.

NOTE This command does not work with static labels (labels that have the 
Dynamically Update Label Text property disabled) or disassociated labels.
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� From the Labels menu, choose Update All Labels.

NOTE An alternative to using this command is to re-enable the global updat-
ing options in the Label Settings dialog box. For more information, see “Speci-
fying How Labels Are Updated” on page 518.

Swapping Label Text

You can switch which labels are above and below a line by using the Swap 
Label Text command. This command is useful if you label a parcel or bound-
ary and want all the labels on the outside of the boundary to label one feature 
of the line (for example, distance), and all the labels inside the boundary to 
label another feature of the line (for example, direction). 

NOTE This command does not work with static labels (labels that have the 
Dynamically Update Label Text property disabled) or disassociated labels.
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� From the Labels menu, choose Swap Label Text.

� Select the objects that have the labels you want to swap.

� Press ENTER.
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Changing the Angular Direction of a Label

You can switch the bearing or azimuth of a line label by using the Flip 
Direction command. For example, if a line is labeled N74°53'51"E and you 
flip the label’s direction, the label changes to S74°53'51"W.

NOTE This command does not work with dynamic labels on polylines, static 
labels (labels that have the Dynamically Update Label Text property disabled) or 
disassociated labels. However, you can flip the label direction for individual 
objects (like polylines) by using the Edit Label Properties command to force the 
bearing to use a specific direction, like North.
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� From the Labels menu, choose Flip Direction.

� Select the lines that contain the labels you want to flip.

or

� Select the lines that contain the labels you want to flip.

� Right-click to display the shortcut menu.

� Click Flip Direction.
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Disassociating Labels to Prevent Auto-Updating

You can turn dynamic labels into labels that never update by disassociating 
the label from the object.

WARNING! You cannot use the Update Selected Labels, Update All Labels, 
Flip Direction, or Swap Label Text commands on disassociated labels. Nor can 
you change the labels back to dynamic labels after you use the Disassociate Labels 
command. If you think you may need to update the labels at some time, instead 
of disassociating the labels, you can disable the dynamic updating property for 
the selected labels and then enable it when you must update the labels. For more 
information, see “Changing the Properties of Labels” on page 571.
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� From the Labels menu, choose Disassociate Labels.

� Select the objects that have the labels you want to disassociate.

� Press ENTER.

or

� Select the objects that have the labels you want to disassociate.

� Right-click to display the shortcut menu.

� Select Disassociate Labels.

Deleting Labels

To delete labels from your drawing, use the Delete Labels command. If you 
select an object that does not contain dynamic or static labels, such as a con-
tour object, then the command ignores it.

NOTE This command does not work with disassociated labels.
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� From the Labels menu, choose Delete Labels.

� Select the objects that have the labels you want to delete.

� Press ENTER.

or

� Select the objects that have the dynamic labels you want to delete.

� Right-click to display the shortcut menu.

� Select Delete Labels.

Grip Editing Label Text

Each label that you place on an object has grips. Use these grips to move the 
text along the object, or to rotate the text.
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� Verify that grips are enabled. For more information, see “Editing with Grips” 
in the AutoCAD 2000 User’s Guide. 

� Click on the label text that you want to move or rotate.

� Click on a grip to activate it.

� Move the grip to the new location, or press SPACEBAR to cycle to another grip 
editing option.

NOTE The ROTATE option does not work on arcs.

If you are moving the label text on a curve, the label text flips automatically 
as you move it to maintain its legibility in plan view.

Changing the Properties of Labels

After you label an object in your drawing with a dynamic or static label, you 
can modify the label properties. The label properties include dynamic updat-
ing, label alignment, label swapping, and the type of bearing labels that are 
being used.

You can turn a static label into a dynamic label, and vice versa, by changing 
the Dynamically Update Label Text property.
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� Select the label(s) that you want to edit.

IMPORTANT You must select the label itself, not the object that is 
labeled.

� Right-click to display the shortcut menu, and then select Edit Label 
Properties. 

� Select or clear the following check boxes to change the behavior of the 
selected labels:

� Dynamically Update Label Text: This check box switches the state of 
labels between static and dynamic. When this check box is selected, the 
label is dynamic and updates if the style or the object changes (however, 
this updating behavior is dependent on the global update settings in the 
Label Settings dialog box). When this check box is cleared, the label is 
static and does not update if the style or object changes.

NOTE For point labels, Dynamically Update Label Text is the only label 
property that is editable in the Label Properties dialog box.

� Swap Label Text: This check box switches the label (including arrow and 
crows feet) above the object with the label below the object.

� Align Label Text on Object: This check box changes the label’s align-
ment property. To align the text on the object, select the Align label text 
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on object check box. If you clear this check box, then the label is reori-
ented so it matches the non-aligned label rotation angle in the Label 
Settings. In addition, the label is not repositioned if the object is edited.

� Force Bearings: This check box specifies how bearing labels for lines are 
formatted. To force all bearing labels and arrows to point in one direction, 
you can select North or South from the Force Bearings list. To mix (North 
or South) the bearing arrows, select Mixed. This setting only applies to line 
labels.

� Tag Number: This option specifies the current tag number for tag labels 
only. You can select a different, unused tag number for the tag label if 
needed. If you select more than one tag label from the drawing and then 
use the Edit Label Properties command, this option is unavailable.

� Click OK.

NOTE When you use the Label Line By Points or Label Curve by Points com-
mand to create tag labels, the editable label properties are limited to tag number 
only. This is because the labels are not associated with objects. Even if you 
change the tag number in the properties, the tag in the drawing is not updated. 
You must edit the tag in the drawing with the DDEDIT command to change it.

Static Labels

If you do not want the labels you create to be updated when you edit a label 
style or a labeled object, then label the objects with static labels.

Static labels:
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� Never update when you edit the object or label style.
� Never update when you use the Update Selected Labels or Update All 

Labels commands.
� Are not affected by the automatic updating settings in the Label Settings 

dialog box.
� Cannot be swapped from one position on an object to the other (above/

below the object).
� Cannot have their directions flipped.

You can use any label style to create static labels—the dynamic or static 
nature of a label is not defined within the label style. Whether a label is 
dynamic or static depends on the command you use to create the label. 

If you create static labels and later want them to update, you can enable the 
Dynamically Update Label Text option in the Label Properties dialog box. 
Doing this makes the label dynamic. For more information, see “Changing 
the Properties of Labels” on page 571. If you never want anyone to have the 
ability to update the labels, then you can disassociate the static labels so no 
one can ever enable their updating properties. For more information, see 
“Disassociating Labels to Prevent Auto-Updating” on page 570.

NOTE Curve labels always move with the curve if you edit the curve’s position, 
even when the label is static. However, the label text itself does not change val-
ues when the label is static.

Creating Static Labels

To create labels that do not automatically update if you change the label style 
or edit the object that is labeled, use the Add Static Labels command. 

Using this command, you can select any group of objects to label. For exam-
ple, the selection set can contain lines, arcs, spirals, and points, or any com-
bination of these different objects. If you select an object that cannot be 
labeled with the Add Static Labels command, such as a contour object, then 
the command ignores it.

NOTE In order to label points, the Use the Current Point Label Style When 
Inserting Points check box must be selected in the Point Settings dialog box. For 
more information, see “Changing the Point Insertion Settings” on page 98.
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NOTE The global update settings in the Label Settings dialog box have no 
effect on static labels.
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� Select the current label styles. For more information, see “Selecting the Cur-
rent Label Style” on page 529. 

� From the Labels menu, choose Add Static Labels.

� Select the objects that you want to label.

� Press ENTER.

or

� Select the current label styles.

� Select the object(s) that you want to label.

� Right-click to display the shortcut menu.

� Select Add Static Labels.

Labeling Line and Curve Segments

To label line and curve segments instead of entire lines and curves, you can 
use the Label Lines By Points and Label Curves By Points commands. These 
commands give you the flexibility of labeling lines and curves that are shared 
and may require more than one label, such as the lines in a parcel map. By 
using the label by points commands, you can create the labels you need with-
out having to break shared objects, or draw duplicate objects. 

Using the label by points commands, you can create full text labels, or you 
can create tag labels. After you create the tag labels, you can create tag tables.

The labels created with the label by points commands are not associated with 
any object or object segment. Therefore, they cannot update dynamically if 
the objects or label styles change.

When you use the label by points commands to create tag labels, the only 
property of the tag labels you can change later (by using the Edit Label 
Properties command) is the current tag number. All the other options in the 
Label Properties dialog box are grayed out. If you change the tag number in 
the Label Properties dialog box, the tag in the drawing does not automati-
cally update. You must edit the tag label text using the DDEDIT command to 
match the text in the drawing with the assigned tag number. An object table 
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you create always uses the tag displayed in the drawing, regardless of a tag 
label’s assigned tag number.

NOTE You cannot change any property of regular, full-text labels created with 
the label by points commands.

Labeling Line Segments By Selecting Points to 
Define the Line Segments

You can use the Label Line By Points command to label a selected line seg-
ment with a static label by selecting points to define the line segment or by 
selecting the line itself.

By being able to select a line segment to label, instead of the entire line, you 
have added flexibility when labeling lines that are shared, such as the lines 
in a parcel map. You do not have to break those shared lines, or draw dupli-
cate lines, to label the segments you want.

Using the Label Line By Points command, you can label line segments with 
full text labels, or you can label the line segments with tag labels. After you 
create the tag labels, you can use the Line Table command to create a tag 
table.

The labels created with the Label Line By Points command are not associated 
with the line or line segment. Therefore, they cannot update dynamically if 
the line segment or style change. Unlike static labels you create with the Add 
Static Labels command, labels created with the Label Line By Points com-
mand can never be turned into dynamic labels.
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� Select the current label styles. 

The Label Line by Points command uses the current line label style (or cur-
rent tag style) to label the lines. For more information, see “Selecting the Cur-
rent Label Style” on page 529. 

� From the Labels menu, choose Label Line By Points.

The following prompt is displayed:
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� Type one of the following:

� Type No to label the line segments with full text labels.
� Type Yes to label the line segments with tag labels.
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NOTE When you use this command to create tag labels, the only property of 
the tag label you can change later (by using the Edit Label Properties command) 
is the current tag number. However, if you change the tag number in the label 
properties, the tag in the drawing does not automatically update. You must edit 
the tag label text using the DDEDIT command to match the text in the drawing 
with the assigned tag number. A line table you create always uses the tag dis-
played in the drawing, regardless of a tag label’s assigned tag number.

The following prompt is displayed:
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� Do one of the following to select the line that you want to label:

� Points: Select the end points of the line. If the line segment you want to 
select connects COGO points, then you can use the .G, .P, and .N point 
selection filters to select these points. You can also use object snaps to 
accurately select the points. If the POints option is not active, then type 
PO and press ENTER before selecting the points.

� Line: Type Line and then select the line using any standard AutoCAD 
selection method. This selection method selects the entire line.

TIP You can tell whether or not a label in your drawing was created with the 
Label Line By Points command by looking at the Label Properties. Select the 
label, right-click, and select Edit Label Properties. The Label Properties dialog box 
appears but everything is grayed out (except for the tag number setting if the 
label is a tag label). The dialog box is grayed out because labels created by the 
Label Line By Points command are not associated with any line object. Therefore, 
they cannot be dynamically updated and are not affected by changing the Label 
Properties.

� Continue to select lines to label, or press ENTER to end the command.

Labeling Curve Segments by Selecting Points to 
Define the Curve Segments

You can use the Label Curve By Points command to label a curve segment by 
selecting points to define the curve segment, or by selecting the curve itself. 

By being able to select a curve segment to label, instead of the entire curve, 
you have added flexibility when labeling curves that are shared, such as the 
curves in a parcel map. You do not have to break those shared curves, or draw 
duplicate curves, to label the segments you want.
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Using the Label Curve By Points command, you can label curve segments 
with full text labels, or you can label the curve segments with tag labels. After 
you create the tag labels, you can use the Curve Table command to create a 
tag table.

The labels created with the Label Curve By Points command are not associ-
ated with the curve or curve segment. Therefore, they cannot update dynam-
ically if the curve segment or label style changes. Unlike static labels you cre-
ate with the Add Static Labels command, labels created with the Label Curve 
By Points command can never be turned into dynamic labels.
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� Select the current curve label styles. The Label Curve By Points command 
uses the current curve label style (or current tag style) to label the curves. For 
more information, see “Selecting the Current Label Style” on page 529. 

� From the Labels menu, choose Label Curve By Points.

The following prompt is displayed:
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� Type one of the following:

� Type No to label the curve segments with full text labels.
� Type Yes to label the curve segments with tag labels.

NOTE When you use this command to create tag labels, the only property of 
the tag label you can change later (by using the Edit Label Properties command) 
is the current tag number. However, if you change the tag number in the label 
properties, the tag in the drawing does not automatically update. You must edit 
the tag label text using the DDEDIT command to match the text in the drawing 
with the assigned tag number. A curve table you create always uses the tag dis-
played in the drawing, regardless of a tag label’s assigned tag number.

The following prompt is displayed:
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� Do one of the following to select the curve segment that you want to label:

� Points: Select the point of curvature, a point on the curve, and the point 
of tangency. If the curve segment you want to select connects COGO 
points, then you can use the .G, .P, and .N point selection filters to select 
these points. If not, you can use object snaps to accurately select the 
points. If the POints option is not active, then type PO and press ENTER 
before selecting the points.
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� Curve: Type Curve and then select the curve using any standard 
AutoCAD selection method. This selection method selects the entire 
curve.

� Continue to select curve segments to label, or press ENTER to end the 
command.

TIP You can tell whether or not a label in your drawing was created with the 
Label Curve By Points command by looking at the Label Properties. Select the 
label, right-click, and select Edit Label Properties. The Label Properties dialog box 
appears but everything is grayed out (except for the tag number setting if the 
label is a tag label). The dialog box is grayed out because labels created by the 
Label Curve By Points command are not associated with any curve object. There-
fore, they cannot be dynamically updated and are not affected by changing the 
Label Properties.

Labeling Polylines

You can label polylines with the current line and curve label styles. Straight 
polyline segments are labeled with the current line label style. Curved 
polyline segments are labeled with the current curve label style. Each 
polyline segment can have more than one label.

NOTE Only lightweight polylines can be labeled. 
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� Select the current label styles for lines and curves. For more information, see 
“Selecting the Current Label Style” on page 529. 

� Select the polyline(s) you want to label.

� Right-click to display the shortcut menu.

� Select Add Dynamic Labels or Add Static Labels.

NOTE If you use the TRIM command to edit the polylines after they are 
labeled with dynamic labels, then the polyline labels disappears if the resulting 
segment type is different than the original segment type. 
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Labeling Points with Northing and Easting 
Coordinates

You can create northing/easting labels for points in your drawing. These 
labels are not dynamic and they are not based on the current point label 
style. Instead, they use the current text style for the labels.
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� From the Labels menu, choose Label North/East.

� Select the point that you want to label. You can use point filters to select 
exact points.

� Select a location in the drawing where you want to insert the label.

� Do one of the following to define the rotation angle of the label:

� Type a rotation angle at the command line in the format indicated.
� Pick a point in the drawing to define the rotation angle. The angle used is 

the angle between the insertion point of the label and the rotation angle 
point you select.

� Select an additional point to label, or press ENTER to end the command.

Labeling Points with Geodetic Information

You can label points and lines in your drawing with specific geodetic features. 
You choose which features you want to label by adjusting the geodetic point 
label and line label settings. These features include latitude and longitude, 
grid northing and grid easting, scale factor, convergence, and local northing 
and local easting, grid angle, grid distance, local angle, local distance, and 
geodetic distance.

NOTE These labels do not use the current point and line label styles. Instead, 
they use the current text style. They are placed on the layers specified in the 
Geodetic Annotation Settings dialog box.
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Changing the Geodetic Point Label Settings
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� Set the Current Zone and the Transformation Settings. For more information, 
see “Changing the Current Zone for a Drawing” on page 57, and “Changing 
the Geodetic Zone Transformation Settings” on page 81.

� Display the Geodetic Annotation Settings dialog box by doing one of the 
following:

� From the Labels menu, choose Geodetic Labels ➤ Geodetic Label Settings.
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Geodetic Labels and click the Edit Settings 
button.

You can label each point with up to six different pieces of information. These 
six features are represented by fields. The field number is displayed on the far 
left of the dialog box.

� Under Point Annotation, set the Type for each field number. You can select 
one of the following options for each field: 

� None
� Grid northing 
� Grid easting 
� Latitude 
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� Longitude 
� Convergence 
� Scale Factor 
� Local northing 
� Local easting 

For example, to label a point with only Grid northing and Grid easting, set 
field #1 to Grid northing, and field #2 to Grid easting, and all the other fields 
to None.

� To use any kind of prefix or suffix for the labels, type the text in the Prefix 
and Suffix boxes.

For example, the default prefix for Grid northing, Grid N, places Grid N in 
front of the value.

� In the Precision edit boxes, type the precision for each point label field.

! To use a bracket to set off the labels when they are placed in the drawing, 
select the Leader Bracket check box. 

" In the Layer edit box, type the name of the layer for the point labels.

# Set the Label Line Settings for labeling lines with geodetic features, or click 
OK to exit the dialog box. For more information, see “Changing the Geodetic 
Line Label Settings” on page 582.

Changing the Geodetic Line Label Settings
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� Set the Current Zone and the Transformation Settings. For more information, 
see “Changing the Current Zone for a Drawing” on page 57, and “Changing 
the Geodetic Zone Transformation Settings” on page 81.

� Display the Geodetic Annotation Settings dialog box by doing one of the 
following:

� From the Labels menu, choose Geodetic Labels ➤ Geodetic Label Settings.
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Geodetic Labels and click the Edit Settings 
button.

� Under Line Annotation, do one of the following to determine whether the 
directions of the lines are labeled with azimuths or bearings:

� Select the Azimuths check box to label the direction with an azimuth.
� Clear the Azimuths check box to label the direction with a bearing. When 

you clear the Azimuths check box, the Az label changes to Brg. 
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� In the Precision box, type the line label precision.

� In the Layer edit box, type the name of the layer for the line labels.

! Select one or more of the following options to determine how you want to 
label lines:

� Select the Grid check box to label lines with the grid data. Select the Az/
Brg check box to label the grid angle of the lines. Select the Grid Dist check 
box to label the grid distance of the lines. The Grid northing and easting 
is based on the current zone. 

� Select the Ground check box to label lines with the direction and distance 
calculated with the local northing and easting coordinates. Select the 
Ground Az/Brg check box to label the local angle of the lines. Select the 
Ground Dist check box to label the local distance of the lines. 

� Select the Geodetic Dist check box to label lines with the geodetic dis-
tance, which is a distance in which the Earth’s curvature is taken into 
account. 

" Using the Placement lists, select the label placement. You can place the labels 
Above or Below the lines. The labels are placed at the same angle as the line.

# To use a prefix or suffix for the labels, type the text in the Prefix and Suffix 
edit boxes.

$ Using the Distance Unit scroll box, select either Feet or Meters as the unit of 
measurement for the distances.

�% In the Distance Precision edit box, type the precision for labeling distances.

�� Click OK to exit the dialog box.

Labeling a Point with Geodetic Data

You can label a location or a COGO point with geodetic features. 
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� Change the Geodetic Label Settings. For more information, see “Changing 
the Geodetic Point Label Settings” on page 581.

� From the Labels menu, choose Geodetic Labels ➤ Label Location. The cur-
rent zone is listed at the command line.

The following prompt is displayed:
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� Select the point you want to label. You can use point filters to select the 
point. 

� You can select a point to define a leader.



584 | Chapter 24 Labeling Objects

If you draw the leader to the left of the point, then the label text is right-jus-
tified. If you draw the leader to the right of the point, the label text is left-
justified.

� You can continue to select leader points.

! Press ENTER to place the label in the drawing.

Labeling a Line with Geodetic Data

You can label lines in your drawing with geodetic features. 
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� Set the geodetic annotation settings. For more information, see “Changing 
the Geodetic Line Label Settings” on page 582.

� From the Labels menu, choose Geodetic Labels ➤ Label Line. 

The current zone is listed at the command line.

� To select the line, do one of the following:

� Click the line.
� Type PO and then select points to select the object.

� Continue selecting lines to label, or press ENTER to end the command.

Creating a Building Offset Label

You can label the perpendicular offset distance between a building corner 
and a property line by using the Building Offset command. An object repre-
senting a building corner and another representing a property line must exist 
in the drawing to use this command.

NOTE This command is affected by the current AutoCAD dimension variables.
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� On the Labels menu, choose Building Offset. 

� Select the building corner. The AutoCAD OSNAP mode is automatically set 
to ENDPOINT for this selection, but you can override it.

� Select a point on the property line. The AutoCAD OSNAP mode is automati-
cally set to PERPENDICULAR at this prompt. Do not override this setting.
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After you select the points, the perpendicular distance is labeled on the cur-
rent layer.

The following illustration shows an offset label placed between a building 
and a property line:
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25Creating Object Tables

You can label the lines, curves, spirals, and polylines 

in your drawing with tag labels, and then create object 

tables that list the detailed information about each 

object.

In this chapter

� Tag Labels and Object Tables

� Tag Label Styles

� Creating Tag Labels

� Creating Object Tables

� Editing Object Tables

� Updating Object Tables

� Deleting Object Tables
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Tag Labels and Object Tables

If the objects in your drawing are too short for regular labels, or if you want 
to present all the information about the objects in a table, then you can label 
the objects with tag labels. You can then create an object table that lists the 
detailed information about each object.

Tag labels have their own label styles. Default styles are included with 
AutoCAD Land Development Desktop, which you can use as-is or customize. 
Tag label styles do not determine which information is displayed in the 
tables. To control what pieces of information are created for an object, you 
must set up the table columns. You can then save this setup to a file which 
you can use in the future.

Tag Label Styles

Each tag label is based on a tag label style. A tag label style determines how a 
label appears. However, it does not determine what information is displayed 
in the object table. 

� Tag label appearance is controlled by the tag label style text properties, 
such as the text style used for the label, the layer for the label, and the jus-
tification of the label text. 

� The content of the object table is controlled by setting up table columns 
with the Line Table, Curve Table, and Spiral Table commands. 

Three default tag label styles are included in AutoCAD Land Development 
Desktop, one each for lines, curves, and spirals. You can edit these styles and 
create new ones, depending on your requirements.

Editing Line Tag Label Styles
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� Display the Edit Tag Label Styles dialog box by doing one of the following: 

� From the Labels menu, choose Edit Tag Label Styles.

� From the Labels menu, choose Show Dialog Bar, verify that  is visible, 

and then click .
� Select a tag label, right-click, and select Edit Label Style.
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NOTE Be sure that you select the label text; do not select the object that is 
labeled. 

� From the Projects menu, choose Edit Data Files to display the Edit Data 
Files dialog box. From the Program list, select Land Development Desktop. 
From the Data Files list, select Tag Styles and click Edit Data.

� Click the Line Label Styles tab.

� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit. 

� To create a new label style, type a new name in the Name list. Be sure to 
click Save to save the new style.

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label looks like. 

� You can specify any of the following label style items:
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� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Line Tag Labels” on page 
590.

� Data Elements: Controls the items that the label style will label. For tag 
label styles, there is only one data element, Tag Number. For more infor-
mation, see “Data Elements for Line Tag Labels” on page 590.

� Text Above and Text Below: Controls where the tag label is placed, 
either above or below the object. For more information, see “Text Above 
and Text Below for Line Tag Labels” on page 591.

� Arrow, Tick, Crows Feet: Controls whether symbols are placed on the 
object along with the label. For more information, see “Arrows, Ticks, and 
Crows Feet for Line Tag Labels” on page 591.

� Units: Unit settings are not applicable to tag label styles.

Text Properties for Line Tag Labels

� Complete steps 1–4 in “Editing Line Tag Label Styles” on page 588.

� Under Text Properties, select a text Style for the label. If you select *Current*, 
then any time that you label an object using this style, the label is created 
using the current text style.

� If you selected a zero-height style, then specify a height in the Height box. 

NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an Offset for the label. This value is not a distance; it is a fac-
tor. The offset value that you specify is a factor that is multiplied by the text 
height to compute the actual offset distance. 

See the illustration in “Text Properties for Line Label Styles” on page 535.

� Select a Layer for the label. If you select *Current*, then any time you label 
an object using this style, the label is placed on the current layer. 

� Select one of the following justification methods for the text: 

� Left: Left-justifies the label on the object.
� Right: Right-justifies the label on the object. 
� Center: Centers the label on the object.

Data Elements for Line Tag Labels

Tag labels have only one data element, Tag Number. You can control whether 
the tag number is displayed above or below the object.
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� Complete steps 1–4 in “Editing Line Tag Label Styles” on page 588.

� From the Data list, select Tag Number. 

� Do one of the following:

� Click the Text Above button to place the Tag Number in the Text Above 
box. This places the tag above the object when you label an object with 
this style.

� Click the Text Below button to place the Tag Number in the Text Below 
box. This places the tag below the object when you label an object with 
this style.

Text Above and Text Below for Line Tag Labels

This information follows the steps in “Editing Line Tag Label Styles” on page 
588.

The Text Above and Text Below boxes contain the data elements for label 
styles. For tag label styles, the only data element you can use is Tag Number. 
The box on the right shows a preview of what the label looks like. In the fol-
lowing example, L precedes the tag number because this is the line tag label 
style.

You can type text into these boxes. This text appears in the label. For exam-
ple, you can type Line instead of L. 

In the Text Above or Text Below box, you can type, select, delete, copy, and 
paste text. 

Arrows, Ticks, and Crows Feet for Line Tag 
Labels
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� Complete steps 1–4 in “Editing Line Tag Label Styles” on page 588.

� Under Text Above and/or Text Below, do the following:

� Select the Arrow check box to insert arrows on the objects you label to 
indicate their direction. 

� Select either Tick or Crows Feet to insert either tick marks or crows feet on 
the objects you label.
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Editing Curve Tag Label Styles
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� From the Labels menu, choose Edit Tag Label Styles. 

� Click the Curve Label Styles tab.

� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit. 

� To create a new label style, type a new name in the Name list. Be sure to 
click Save to save the new style.

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label looks like. 

� You can specify any of the following label style items:

� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Curve Tag Labels” on page 
592.

� Data Elements: Controls the items that the label style will label. For tag 
label styles, there is only one data element, Tag Number. For more infor-
mation, see “Data Elements for Curve Tag Labels” on page 593.

� Text Above and Text Below: Controls where the tag label is placed, 
either above or below the object. For more information, see “Text Above 
and Text Below for Curve Tag Labels” on page 593.

� Arrow, Tick, Crows Feet: Controls whether symbols are placed on the 
object along with the label. For more information, see “Arrows, Ticks, and 
Crows Feet for Curve Tag Labels” on page 594.

� Units: Unit settings are not applicable to tag label styles. 

Text Properties for Curve Tag Labels

� Complete steps 1–4 in “Editing Curve Tag Label Styles” on page 592.

� Under Text Properties, select a text Style for the label. If you select *Current*, 
then any time that you label an object using this style, the label is created 
using the current text style.

� If you selected a zero-height style, then specify a height in the Height box. 
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NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an Offset for the label. This value is not a distance; it is a fac-
tor. The offset value that you specify is a factor that is multiplied by the text 
height to compute the actual offset distance. 

See the illustration in “Text Properties for Line Label Styles” on page 535.

� Select a Layer for the label. If you select *Current*, then any time you label 
an object using this style, the label is placed on the current layer. 

� Select one of the following justification methods for the text: 

� Left: Left-justifies the label on the object.
� Right: Right-justifies the label on the object. 
� Center: Centers the label on the object.

Data Elements for Curve Tag Labels

There is only one data element for tag labels, Tag Number. You can control 
whether the tag number is displayed above or below the object.

� Complete steps 1–4 in “Editing Curve Tag Label Styles” on page 592.

� From the Data list, select Tag Number. 

� Do one of the following:

� Click the Text Above button to place the Tag Number in the Text Above 
box. This places the tag above the object when you label an object with 
this style.

� Click the Text Below button to place the Tag Number in the Text Below 
box. This places the tag below the object when you label an object with 
this style.

Text Above and Text Below for Curve Tag Labels

This information follows the steps in “Editing Curve Tag Label Styles” on 
page 592.

The Text Above and Text Below boxes contain the data elements for label 
styles. For tag label styles, the only data element you can use is Tag Number. 
The box on the right shows a preview of what the label looks like. In the fol-
lowing example, C precedes the tag number because this is the curve tag label 
style.
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You can type text into these boxes. This text appears in the label. For exam-
ple, you could type Curve instead of C. 

In the Text Above or Text Below box, you can type, select, delete, copy, and 
paste text. 

Arrows, Ticks, and Crows Feet for Curve Tag 
Labels
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� Complete steps 1–4 in “Editing Curve Tag Label Styles” on page 592.

� Under Text Above and/or Text Below, do the following:

� Select the Arrow check box to insert arrows on the objects you label to 
indicate their direction. 

� Select either Tick or Crows Feet to insert either tick marks or crows feet on 
the objects you label.

Editing Spiral Tag Label Styles
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� From the Labels menu, choose Edit Tag Label Styles. 

� Click the Spiral Label Styles tab.

� Do one of the following:

� From the Name list, select the name of the label style that you want to 
edit. 

� To create a new label style, type a new name in the Name list. Be sure to 
click Save to save the new style.

When you select a style, the Text Above and Text Below sections of the dialog 
box display the selected data elements. The box on the right shows you a pre-
view of what this label looks like. 

� You can specify the following label style items:

� Text Properties: Controls the text style, offset, layer, and justification. 
For more information, see “Text Properties for Spiral Tag Labels” on page 
595.
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� Data Elements: Controls the items that the label style will label. For tag 
label styles, there is only one data element, Tag Number. For more infor-
mation, see “Data Elements for Spiral Tag Labels” on page 595.

� Text Above and Text Below: Controls where the tag label is placed, 
either above or below the object. For more information, see “Text Above 
and Text Below for Spiral Tag Labels” on page 596.

� Arrow, Tick, Crows Feet: Controls whether symbols are placed on the 
object along with the label. For more information, see “Arrows, Ticks, and 
Crows Feet for Spiral Tag Labels” on page 596.

� Units: Unit settings are not applicable to tag label styles. 

Text Properties for Spiral Tag Labels

� Complete steps 1–4 in “Editing Spiral Tag Label Styles” on page 594.

� Under Text Properties, select a text Style for the label. If you select *Current*, 
then any time that you label an object using this style, the label is created 
using the current text style.

� If you selected a zero-height style, then specify a height in the Height box. 

NOTE If the selected text style has a fixed height, then the value in the Height 
box has no effect on the height. 

� You can specify an Offset for the label. This value is not a distance; it is a fac-
tor. The offset value that you specify is a factor that is multiplied by the text 
height to compute the actual offset distance. 

See the illustration in “Text Properties for Line Label Styles” on page 535.

� Select a Layer for the label. If you select *Current*, then any time you label 
an object using this style, the label is placed on the current layer. 

� Select one of the following justification methods for the text: 

� Left: Left-justifies the label on the object.
� Right: Right-justifies the label on the object. 
� Center: Centers the label on the object.

Data Elements for Spiral Tag Labels

Tag labels have only one data element, Tag Number. You can control whether 
the tag number is displayed above or below the object.

� Complete steps 1–4 in “Editing Spiral Tag Label Styles” on page 594.

� From the Data list, select Tag Number. 
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� Do one of the following:

� Click the Text Above button to place the Tag Number in the Text Above 
box. This places the tag above the object when you label an object with 
this style.

� Click the Text Below button to place the Tag Number in the Text Below 
box. This places the tag below the object when you label an object with 
this style.

Text Above and Text Below for Spiral Tag Labels

This information follows the steps in “Editing Spiral Tag Label Styles” on 
page 594.

The Text Above and Text Below boxes contain the data elements for label 
styles. For tag label styles, the only data element you can use is Tag Number. 
The box on the right shows a preview of what the label looks like. In the fol-
lowing example, SP precedes the tag number because this is the spiral tag 
label style.

You can type text into these boxes. This text appears in the label. For exam-
ple, you can type Spiral instead of SP. 

In the Text Above or Text Below box, you can type, select, delete, copy, and 
paste text. 

Arrows, Ticks, and Crows Feet for Spiral Tag 
Labels
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� Complete steps 1–4 in “Editing Spiral Tag Label Styles” on page 594.

� Under Text Above and/or Text Below, do the following:

� Select the Arrow check box to insert arrows on the objects you label to 
indicate their direction. 

� Select either Tick or Crows Feet to insert either tick marks or crows feet on 
the objects you label.
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Creating Tag Labels
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� Select the current label styles for lines and curves. For more information, see 
“Selecting the Current Label Style” on page 529.

� From the Labels menu, choose Add Tag Labels.

� Select the objects that you want to label.

� Press ENTER.

or

� Select the current tag label styles.

� Select the object(s) that you want to label.

� Right-click to display the shortcut menu.

� Select Add Tag Label.

Creating Object Tables

After you tag the objects in your drawing with tag labels, you can create 
object tables that display detailed information about each object you tagged. 
You can insert multiple tables in a drawing. You can also specify a row limit 
for a table, and when that limit is reached, the table is split into pages.

To control what information is displayed about the objects, you must set up 
table columns when you are using the Add Tables commands. After you set 
up the table columns the way you want, you can save this setup to a file. The 
next time you want to create a table, you can load this file to use the same 
settings that you did previously.

Tables do not update automatically. To update tables with changes you’ve 
made to objects or tag styles, you can select a text object in the table, right-
click, and select Re-Draw Table. 

Creating a Line Table

After you label your lines with tag labels, you can draw a line table. Tables 
display detailed information about the objects that you labeled with tags.
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� From the Labels menu, choose Add Tables ➤ Line Table to display the Line 
Table Definition dialog box.

NOTE If you already formatted a line table and saved the setup to a file, then 
you can skip the following steps by loading the table setup file. For more infor-
mation, see “Loading an Existing Line Table Setup File” on page 603.

� In the Text box, type a title for the table. By default the title is Line Table.

� In the Layer box, select or type a layer for the table title. By default the layer 
is Line Table Header.

� Select a Text Style for the table title. If you select a zero-height text style, then 
type a height in the Text Height box. 

� You can control any of the following line table items:

Line Table Sorting: Select the Sort table check box to have the table entries 
appear in the table in alpha-numeric order. If you clear this check box, then 
the tags are placed in the table in the order that the objects appear in the 
drawing database.

Line Table Border: Select the Draw border check box to draw both a border 
and column and row lines on your table. If you select the Draw border check 
box, then select a layer for the border from the Border Layer list.
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Splitting a Line Table: To limit the rows in a table, type a limit in the Max-
imum Rows Per Page box. For example, if you have 20 lines and you limit the 
rows per table to 10, then the first table ends at L10 and the next table page 
begins at L11. Setting this value to 0 creates one continuous table.

� To control what pieces of information are displayed in the table, set up the 
column definitions. For more information, see “Changing the Column Def-
initions of a Line Table” on page 599.

NOTE By default, the first column in a table contains the Entity Description 
data element, which places the tag number in the first column. Be sure to not 
remove Entity Description from this column or the tag number will not be 
included in the table. 

! To save the settings to a file that you can use the future, choose Save As and 
save the file. 

By default, this file is named linetabledef.ltd and is stored in the following 
folder:

c:\Program Files\Land Desktop R2\data\labels 

" Click OK.

# Select the insertion point for the table. 

This point corresponds to the upper-left corner of the table.

Changing the Column Definitions of a Line Table

You can customize each column of a line table to display the information 
that is relevant to your project. 
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� Complete steps 1–5 in “Creating a Line Table” on page 597.

� Under Column Definition, place your cursor in the column that you want to 
edit and then click Edit to display the Column Definition dialog box. You can 
also double-click in the column that you want to edit. 

NOTE To insert a new column, click Insert. To delete an existing column, click 
Delete. 

To change the appearance of the column, make modifications in the Column 
Header Information section of the dialog box.

� In the Header box, type the column heading. 

� In the Width box, type the width of the column. This value is in text charac-
ters, and is based on the text style that you specify for the header.

NOTE The text in a column does not wrap if it exceeds the column width. Be 
sure that you specify a column width that is large enough to accommodate all 
the text that appears in the column. 

� Select a text Style for the header. If you select a zero-height style, then also 
specify a text Height. 



Creating a Line Table | 601

� Under Justify, specify whether you want the header text to be right-justified, 
left-justified, or centered.

! From the Layer box, choose a layer for the column header.

" Under Display Value Information, choose the information that you want to 
appear in the column, and then click the Add Value button to add it to the 
Text box..

The Text box shows you the Display Value Information that you selected. You 
can choose to have more than one Display Value in a column. The box on 
the right of the Text list shows you a preview of how the column information 
appears. 

To remove a category from the Text box, select the text in the Text box and 
delete it. You can type text in the Text box, such as m for meters.

You can also add formulas to tables. For more information, see “Using a For-
mula Within a Label Style to Convert Values” on page 560.

Information for line table columns

%� 	�����	�� %���� ���


Length Lists the length of the line.

Direction Lists the direction of the line.

Start Northing Lists the northing coordinate of the start point of the line.

Start Easting Lists the easting coordinate of the start point of the line.

End Northing Lists the northing coordinate of the end point of the line.

End Easting Lists the easting coordinate of the end point of the line.

Text Break Inserts a text break into the label. A text break can be 
used to separate the labels on an object. When you insert 
this data element, it shows up as “100” in the preview 
box.

Plus/Minus 
Symbol

Inserts a plus/minus ( + ) symbol into the label.

Entity Description Displays the tag number in the column. The first column 
of a table is automatically configured to display the Entity 
Description. To display the tag number in the column, 
make sure you do not remove the Entity Description 
category.
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# Use the Text Properties section to format the column text style, layer, and jus-
tification. For more information, see steps 5–7.

�& Click Linear to select the linear precision values for table entries. For more 
information, see “Changing the Precision of the Display of Linear Units in 
Tag Tables” on page 602.

�� Click Angle to select the angular precision values for table entries. For more 
information, see “Changing the Precision of the Display of Angular Units in 
Tag Tables” on page 602.

�� Click OK to return to the Line Table Definition dialog box.

Changing the Precision of the Display of Linear 
Units in Tag Tables

You can change the precision values for displaying linear units in tag tables.
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� Change the column definitions of the line table. For more information, see 
“Changing the Column Definitions of a Line Table” on page 599.

� In the Linear box, enter the precision for displaying lengths in tag table col-
umns.

NOTE You can either type a value in the boxes, or use the up and down arrows 
to select a value. 

� In the Formula box, enter the precision for displaying the results of formula 
calculations.

� In the Coordinate box, enter the precision for displaying northing and east-
ing coordinates.

� Click OK to return to the Column Definition dialog box.

Changing the Precision of the Display of Angular 
Units in Tag Tables

You can change the label precision for displaying angular values in tag tables. 
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� Change the column definitions of the line table. For more information, see 
“Changing the Column Definitions of a Line Table” on page 599.
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� Select the Allow Text Spaces check box to place spaces in the display of angu-
lar units in the tag table columns. When this check box is selected, an angle 
is labeled in the format (N 52°14'39" N). If you do not select this check box, 
then an angle is labeled without spaces (N52°14'39"N).

� In the Angular box, enter the precision for displaying angles in tag table col-
umns.

NOTE You can either type a value in the boxes, or use the up and down arrows 
to select a value. 

� In the Formula box, enter the precision for displaying the results of formula 
calculations.

� Click OK to return to the Column Definition dialog box.

Loading an Existing Line Table Setup File

If you have already defined and saved a table setup file, then you can load it 
whenever you want to create a table.

� Create a line table and save the definition to a file. For more information, see 
“Creating a Line Table” on page 597.

� From the Labels menu, choose Add Tables ➤ Line Table to display the Line 
Table Definition dialog box. 

� Click the Load button.

� Select the line table definition file that you want to use.

� Click Open.



604 | Chapter 25 Creating Object Tables

Creating a Curve Table

After you label your curves with tag labels, you can draw a curve table. Tables 
display detailed information about the objects that you labeled with tags.
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� From the Labels menu, choose Add Tables ➤ Curve Table to display the Curve 
Table Definition dialog box.

NOTE If you already formatted a curve table and saved the setup to a file, then 
you can skip the following steps by loading the table setup file. For more infor-
mation, see “Loading an Existing Curve Table Setup File” on page 607.

� In the Text box, type a title for the table. By default the title is Curve Table.

� In the Layer box, select or type a layer for the table title. By default the layer 
is Curve Table Header.

� Select a Text Style for the table title. If you select a zero-height text style, then 
type a height in the Text Height box. 

� You can control any of the following curve table items:

Curve Table Sorting: Select the Sort table check box to have the table entries 
appear in the table in alpha-numeric order. If you clear this check box, then 
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the tags are placed in the table in the order that the objects appear in the 
drawing database.

Curve Table Border: Select the Draw border check box to draw both a border 
and column and row lines on your table. If you select the Draw border check 
box, then select a layer for the border from the Border Layer list.

Splitting a Curve Table: To limit the rows in a table, type a limit in the Max-
imum Rows Per Page box. For example, if you have 20 lines and you limit the 
rows per table to 10, then the first table ends at C10 and the next table page 
begins at C11. Setting this value to 0 creates one continuous table.

� To control what pieces of information are displayed in the table, set up the 
column definitions. For more information, see “Changing the Column Def-
initions of a Curve Table” on page 605.

NOTE By default, the first column in a table contains the Entity Description 
data element, which places the tag number in the first column. Be sure to not 
remove Entity Description from this column or the tag number will not be 
included in the table. 

! To save the settings to a file that you can use the future, click Save As and save 
the file. By default, this file is named curvetabledef.ctd and is stored in the 
following folder:

c:\Program Files\Land Desktop R2\data\labels

" Click OK.

# Select the insertion point for the table. 

This point corresponds to the upper-left corner of the table.

Changing the Column Definitions of a Curve 
Table

You can customize each column of a curve table to display the information 
that is relevant to your project. 
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� Complete steps 1–5 in “Creating a Curve Table” on page 604.

� Under Column Definition, place your cursor in the column that you want to 
edit and then click Edit. You can also double-click in the column that you 
want to edit. 

The Column #1 Definition dialog box is displayed. 
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NOTE To insert a new column, click Insert. To delete an existing column, click 
Delete. 

To change the appearance of the column, make modifications in the Column 
Header Information section of the dialog box.

� In the Header box, type the column heading. 

� In the Width box, type the width of the column. This value is in text charac-
ters, and is based on the text style that you specify for the header.

NOTE The text in a column does not wrap if it exceeds the column width. Be 
sure that you specify a column width that is large enough to accommodate all 
the text that appears in the column. 

� Select a text Style for the header. If you select a zero-height style, then also 
specify a text Height. 

� Under Justify, specify whether you want the header text to be right-justified, 
left-justified, or centered.

! From the Layer box, choose a layer for the column header.

" Under Display Value Information, choose the information that you want to 
appear in the column, and then click the Add Value button to add it to the 
Text box.

Information for curve table columns
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Radius Lists the radius of the curve.

Length Lists the length of the curve.

Delta Angle Lists the central angle of the curve.

Tangent Lists the tangent length of the curve.

Chord Direction Lists the direction of the chord.

Chord Lists the length of the chord.

Text Break Inserts a text break into the label. A text break can be 
used to separate the labels on an object. When you insert 
this data element, it shows up as “100” in the preview 
box.
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The Text box shows you the Display Value Information that you selected. You 
can choose to have more than one Display Value in a column. The box on 
the right of the Text list shows you a preview of how the column information 
appears. 

To remove a category from the Text box, select the text in the Text box and 
delete it. You can type text in the Text box, such as m for meters. 

You can also add formulas to tables. For more information, see “Using a For-
mula Within a Label Style to Convert Values” on page 560.

# Use the Text Properties section to format the column text style, layer, and jus-
tification. For more information, see steps 5–7.

�& Click Linear to select the linear precision values for table entries. For more 
information, see “Changing the Precision of the Display of Linear Units in 
Tag Tables” on page 602.

�� Click Angle to select the angular precision values for table entries. For more 
information, see “Changing the Precision of the Display of Angular Units in 
Tag Tables” on page 602.

�� Click OK to return to the Curve Table Definition dialog box

Loading an Existing Curve Table Setup File

If you have already defined and saved a table setup file, then you can load it 
whenever you want to create a table.

� Create a curve table and save the definition to a file. For more information, 
see “Creating a Curve Table” on page 604.

� From the Labels menu, choose Add Tables ➤ Curve Table to display the Curve 
Table Definition dialog box. 

� Click the Load button.

� Select the curve table definition file that you want to use.

Plus/Minus Symbol Inserts a plus/minus ( + ) symbol into the label.

Delta Symbol Inserts a delta symbol into the label.

Entity Description Displays the tag number in the column. The first column 
of a table is automatically configured to display the Entity 
Description. To display the tag number in the column, 
make sure you do not remove the Entity Description 
category.

Information for curve table columns (continued)

%� 	�����	�� %���� ���
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� Click Open.

Creating a Spiral Table

After you label your spirals with tag labels, you can draw a spiral table. Tables 
display detailed information about the objects that you labeled with tags.
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� From the Labels menu, choose Add Tables ➤ Spiral Table to display the Spiral 
Table Definition dialog box.

NOTE If you already formatted a spiral table and saved the setup to a file, then 
you can skip the following steps by loading the table setup file. For more infor-
mation, see “Loading an Existing Spiral Table Setup File” on page 612.

� In the Text box, type a title for the table. By default the title is Spiral Table.

� In the Layer box, select or type a layer for the table title. By default the layer 
is Spiral Table Header.

� Select a Text Style for the table title. If you select a zero-height text style, then 
type a height in the Text Height box. 

� You can control any of the following spiral table items:
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Spiral Table Sorting: Select the Sort table check box to have the table entries 
appear in the table in alpha-numeric order. If you clear this check box, then 
the tags are placed in the table in the order that the objects appear in the 
drawing database.

Spiral Table Border: Select the Draw border check box to draw both a border 
and column and row lines on your table. If you select the Draw border check 
box, then select a layer for the border from the Border Layer list.

Splitting a Spiral Table: To limit the rows in a table, type a limit in the Max-
imum Rows Per Page box. For example, if you have 20 lines and you limit the 
rows per table to 10, then the first table ends at C10 and the next table page 
begins at C11. Setting this value to 0 creates one continuous table.

� To control what pieces of information are displayed in the table, set up the 
column definitions. For more information, see “Changing the Column Def-
initions of a Spiral Table” on page 609.

NOTE By default, the first column in a table contains the Entity Description 
data element, which places the tag number in the first column. Be sure to not 
remove Entity Description from this column or the tag number will not be 
included in the table.

! To save the settings to a file that you can use the future, click Save As and save 
the file. By default, this file is named spiraltabledef.std and is stored in the 
following folder:

c:\Program Files\Land Desktop R2\data\labels

" Click OK.

# Select the insertion point for the table. This point corresponds to the upper-
left corner of the table.

Changing the Column Definitions of a Spiral 
Table

You can customize each column of a spiral table to display the information 
that is relevant to your project. 
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� Complete steps 1–5 in “Creating a Spiral Table” on page 608.

� Under Column Definition, place your cursor in the column that you want to 
edit and then click Edit to display the Column Definition dialog box. You can 
also double-click in the column that you want to edit. 
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NOTE To insert a new column, click Insert. To delete an existing column, click 
Delete. 

To change the appearance of the column, make modifications in the Column 
Header Information section of the dialog box.

� In the Header box, type the column heading. 

� In the Width box, type the width of the column. This value is in text charac-
ters, and is based on the text style that you specify for the header.

NOTE The text in a column does not wrap if it exceeds the column width. Be 
sure that you specify a column width that is large enough to accommodate all 
the text that appears in the column. 

� Select a text Style for the header. If you select a zero-height style, then also 
specify a text Height. 

� Under Justify, specify whether you want the header text to be right-justified, 
left-justified, or centered.

! From the Layer box, choose a layer for the column header.

" Under Display Value Information, choose the information that you want to 
appear in the column, and then click the Add Value button to add it to the 
Text box. 

Information for spiral table columns
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Radius Lists the radius of the spiral at the point of transition from 
spiral to curve (SC) or curve to spiral (CS). 

Length Lists the length of the spiral.

Theta Lists the theta angle of the spiral.

X Lists the tangent length between TS and SC, or 
CS and ST.

Y Lists the offset distance at SC from TS or at CS from ST.

Short Tangent Lists the length of the short tangent.

Long Tangent Lists the length of the long tangent. 
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The Text box shows you the Display Value Information that you selected. You 
can choose to have more than one Display Value in a column. The box on 
the right of the Text list shows you a preview of how the column information 
appears. 

To remove a category from the Text box, select the text in the Text box and 
delete it. You can type text in the Text box, such as m for meters. 

You can also add formulas to tables. For more information, see “Using a For-
mula Within a Label Style to Convert Values” on page 560.

# Use the Text Properties section to format the column text style, layer, and jus-
tification. For more information, see steps 5–7.

�& Click Linear to select the linear precision values for table entries. For more 
information, see “Changing the Precision of the Display of Linear Units in 
Tag Tables” on page 602.

�� Click Angle to select the angular precision values for table entries. For more 
information, see “Changing the Precision of the Display of Angular Units in 
Tag Tables” on page 602.

�� Click OK to return to the Spiral Table Definition dialog box.

P Lists the offset of the initial tangent in to the PC of the 
shifted curve, or the offset of the initial tangent out to the 
PT of the shifted curve.

K Lists the abscissa of the shifted PC referred to the TS, or 
the abscissa of the shifted PT referred to the ST.

A Lists the spiral A parameter, which is the square root of 
the product of the length and radius.

Text Break Inserts a text break into the label. A text break can be 
used to separate the labels on an object. When you insert 
this data element, it shows up as “100” in the preview 
box.

Plus/Minus Symbol Inserts a plus/minus ( + ) symbol into the label.

Entity Description Displays the tag number in the column. The first column 
of a table is automatically configured to display the Entity 
Description. To display the tag number in the column, 
make sure you do not remove the Entity Description 
category.

Information for spiral table columns (continued)

%� 	�����	�� %���� ���
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Loading an Existing Spiral Table Setup File

If you have already defined and saved a table setup file, then you can load it 
whenever you want to create a table.

� Create a spiral table. For more information, see “Creating a Spiral Table” on 
page 608.

� Click the Load button.

� Select the spiral table definition file that you want to use.

� Click Open.

Editing Object Tables

You can change the column definitions or the appearance of an existing 
object table.

���������
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� From the Labels menu, choose Edit Table.

� Select the table you want to edit by selecting either the table text or the lines 
that separate the rows/columns.

� Press ENTER to display the Line Table Definition dialog box.
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� Modify the options as necessary. For more information, see “Creating a Line 
Table” on page 597.

� Click OK to exit the Table Definition dialog box.

� Use the Re-Draw Table command to update the table. For more information, 
see “Updating Object Tables” on page 613.

or

� Click on the table in your drawing that you want to edit.

� Right-click to display the shortcut menu.

� Select Edit Table Layout to display the Table Definition dialog box.

� Modify the options as necessary.

� Click OK to exit the Table Definition dialog box.

� Use the Re-Draw Table command to update the table.

Updating Object Tables

Object tables do not update automatically. You must use the Re-Draw Table 
command to update the tables when you do any of the following:

� Edit an object that is tagged
� Delete an object that is tagged
� Delete a tag label
� Change the tag label style 
� Change the table layout and edit column definitions

���� ���������������	�

� Select a text object in the table, such as the table title, or a table line.

� Right-click to display the shortcut menu.

� Select Re-Draw Table.

or

� From the Labels menu, choose Edit Tables ➤ Re-Draw Table.

The following prompt is displayed:

���������	���
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� Select a text object in the table you want to re-draw, such as the table title, or 
select a table line.

� Press ENTER to re-draw the table.
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NOTE Tag labels created by the Label Line by Points command and the Label 
Curve by Points command are not dynamic and therefore are not updated in a 
table if the object changes and you use the Re-Draw Table command. However, 
if you manually edit the tag label text using the DDEDIT command, this change 
is updated in the table when you use the Re-Draw Table command.

Deleting Object Tables
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� Select a text object in the table, such as the table title.

� Right-click to display the shortcut menu.

� Select Delete Table.

or

� From the Labels menu, choose Edit Tables ➤ Delete Table.

The following prompt is displayed:
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� Select a text object in the table you want to re-draw, such as the table title, or 
select a table line.

� Press ENTER to re-draw the table.
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26Creating Surface Models

Use the Terrain Model Explorer to create and build sur-

face models. You can add point, DEM file, contour, 

breakline, and boundary data to the surface folders in 

the Terrain Model Explorer, and then you can build the 

surface based on that data.

In this chapter

� Using the Terrain Commands

� Creating Surfaces

� The Terrain Model Explorer

� Creating a New Surface

� Building a Surface

� Creating Surface Data and 
Adding It to Surface Folders

� Adding Point Groups to the 
Surface Folder

� Adding Point Files to the 
Surface Folder

� Creating Surface Point Data 
from Objects

� Using DEM Files as Surface 
Data

� Creating Contour Data

� Creating Breakline Data

� Creating Boundary Data

� Using Roadway Cross Sections 
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Creating Surfaces

The Terrain menu contains all the surface creation, editing, and output 
commands.

All of the surface creation commands are consolidated into an explorer-style 
dialog box called the Terrain Model Explorer. Using the right-click shortcut 
menus, you can create surfaces, choose which surface data to include in sur-
faces, and build surfaces. The Terrain Model Explorer makes it easy to see 
which data is included in a surface. You can also create data for the surface 
from within the Terrain Model Explorer, such as breaklines and boundaries.

After you have built a surface, you can use the surface editing commands to 
add or delete surface TIN (Triangulated Irregular Network) lines, add or delete 
points, and so on. For visualization purposes, you can draw waterdrop paths 
across the surface, draw slope arrows, or create 2D or 3D graphical represen-
tations of the surface slopes and elevations. 

When you are ready to output data, you can generate contours, cross sec-
tions, and volumes. Two types of volume creation methods create surfaces 
which you can manage from within the Terrain Model Explorer. You can cre-
ate surface models from point, breakline, boundary, and contour data. 

When AutoCAD Land Development Desktop creates a surface from point 
data, it computes the Delaunay triangulation of the points. With Delaunay 
triangulation, no point lies inside the circle determined by the vertices of any 
triangle.

The following illustration shows a TIN surface created from point data:
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Breakline data (from breaklines, contours, or boundaries) changes how the 
surface is triangulated. A breakline edge between the points causes the pro-
gram to connect these points with a triangle edge in the TIN, even if doing 
so violates the Delaunay property.

The following illustration shows a TIN surface created from contour data:
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In most surveying and civil engineering operations, you gather elevational 
information to generate surface contours that represent a model of the 
ground surface. When you gather data for the model, you must be thorough 
so the model you create is an accurate representation of the surface. Points 
or contours are usually a primary part of the original surface information and 
are supplemented with breaklines and boundaries. Breaklines are constraint 
lines such as retaining walls, stream banks and beds, ridge lines, curbs, and 
other abrupt changes in the surface. Boundaries control the extents of a sur-
face.

All the surface data definition and creation commands are located in the 
Terrain Model Explorer dialog box. 
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The process of surface generation includes:

� Creating a new surface
� Creating and adding surface data
� Choosing which data you want to build the surface from
� Building the surface

The Terrain Model Explorer

The Terrain Model Explorer contains every surface creation command. It is a 
modeless dialog box, which means that it stays open while you do other 
work in your drawing. 

The Terrain Model Explorer is divided into two sections: Terrain surfaces and 
Volume surfaces. The Terrain folder is where all of your regular surfaces, such 
as existing ground or finished ground, are stored. The Volume folder is where 
surfaces created by the volume commands are stored.

Each surface has its own folder in the Terrain Model Explorer. These surface 
folders contain subfolders that contain the data to be used in the surface gen-
eration. 
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When you click on a folder in the Terrain Model Explorer, relevant statistical 
information displays in the right-hand pane. For example, when you click a 
surface name, the surface statistics are displayed.

You can right-click on each item in the Terrain Model Explorer to use 
shortcut menus. 

Creating a New Surface

The first step in surface generation is to create a surface folder in the Terrain 
Model Explorer. To do this, use the Create New Surface command. 

This command creates a new folder for surface data in the Terrain Model 
Explorer that you can use to add data to the surface. The command also cre-
ates a surface subfolder in your project folder for data storage and creates a 
file named <surface name>.dat that contains the basic information for the 
surface. For example, if you create a surface named “existing,” then the data 
file is stored in the following folder:

c:\Land Projects R2\<project name>\dtm\existing
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on  to display the shortcut menu.

� Click Create New Surface.

A folder for the surface is created in the Terrain Model Explorer: 

NOTE To name the surface, you can click on its default name and type a new 
name, or you can use the Rename command. Surface names are limited to 40 
characters. For more information, see “Renaming a Surface” on page 698.

You can open a surface folder to see the subfolders where the surface data is 
stored. Each subfolder has a shortcut menu that you can use to access com-
mands to add surface data to the folders. For more information, see “Creating 
Surface Data and Adding It to the Surface Folders” on page 625.
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Building a Surface

You can build a surface from any combination of point, breakline, boundary, 
and contour data that you add to the surface folders in the Terrain Model 
Explorer. 

NOTE If you have previously built a surface and subsequently edited the sur-

face, then the surface edits are saved to the surface’s  folder. You 
can reapply the Edit History to the surface when you build it. This means that if 
you re-build a surface using the Build Surface command, the program processes 
and builds the surface from the surface data first, and then applies in sequential 
order all Edit History items for that surface. 

�����
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� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Add surface data to the surface folders if you haven’t already. For more infor-
mation, see “Creating Surface Data and Adding It to the Surface Folders” on 
page 625.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder, for example  to display the 
shortcut menu.

� Click Build to display the Build Surface dialog box.
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� Click the Surface tab if it is not already active.

� In the Description box, you can type a description for the surface. The surface 
description can be up to 255 characters.

� Select one or more of the following options to control how the surface is 
built:

� Log Errors to file: Select this check box to create a <surface name>.err file 
in the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name> 

This log file records the time it takes to build the surface, and records each 
step that the Build Surface command performs, such as adding point files 
or point groups to the surface.

� Build Watershed: Select this check box to build a watershed at the same 
time the surface is built. If you select this option, then be sure to click the 
Watershed tab and set up the watershed options.

� Compute Extended Statistics: Select this check box to generate 
extended surface statistics. These statistics are displayed when you click 

the surface name, for example  in the Terrain Model Explorer.

� Select any of the following surface data options to control how surface data 
is processed: 
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� Use point file data: Select this check box to build the surface using the 

data in the surface’s  folder. If you clear this check box, then 
the surface is built without the point file data.

� Use point group data: Select this check box to build the surface using the 

data in the surface’s  folder. If you clear this check box, 
then the surface is built without the point group data.

� Use DEM File data: Select this check box to build the surface using the 

DEM file data in the surface’s  folder. If you clear this check 
box, the surface is built without the DEM file data.

NOTE Building a surface using DEM files that contain large numbers of 
points can use significant system resources, especially if the “Build 
Watershed” check box is selected.

� Use breakline data: Select this check box to build the surface using the 

data in the surface’s  folder. If you clear this check box, then 
the surface is built without the breakline data.

� Convert proximity breaklines to standard: Select this check box to con-
vert proximity breaklines to standard breaklines when the surface is built. 
Proximity breaklines obtain their exact point location and elevation by 
snapping to the nearest point on the surface. If you convert proximity 
breaklines to standard breaklines when building the surface, the break-
lines are saved with fixed locations and elevations. Therefore, if any of the 
surface point data that the proximity breaklines were snapping to is sub-
sequently changed, the breaklines are not updated with these changes.

When a proximity breakline is converted to a standard breakline, one or 
more standard breaklines are added to the breakline file in the Terrain 
Model Explorer, each with the description of the breakline from which it 
was converted.

Clear this check box if you want to preserve proximity breaklines when 
building the surface. 

� Use contour data: Select this check box to build the surface using the 

data in the surface’s  folder. If you clear this check box, then 
the surface is built without the contour data.

� Minimize flat triangles resulting from contour data: When building a 
surface, select this check box to check each contour in the surface for any 
triangles that have three points at the same elevation. The program 
attempts to remove any such triangle by flipping faces. For more informa-
tion, see “Minimizing Flat Triangles Resulting from Contour Data” on 
page 624.
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� Apply boundaries: Select this check box to build the surface using the 

data in the surface’s  folder. If you clear this check box, then 
the surface is built without the boundary data.

� Apply Edit History: Select this check box to apply the Edit History to the 
surface after it is built. The Edit History records all the surface editing that 
you have performed. For example, if you built a surface and edited it, but 
need to build it again, you do not have to make all the edits that you made 
previously. Just select the Apply Edit History check box and the edits 
repeat automatically.

� Don’t add data with elevation less than: Select this check box to 
exclude any surface data that has an elevation less than the elevation you 
type in the box.

� Don’t add data with elevation greater than: Select this check box to 
exclude any surface data that has an elevation greater than the elevation 
you type in the box.

�� If you selected the Build Watershed check box, then click the Watershed tab.

�� In the Minimum Depression Depth box, type the minimum depth at which 
a depression in the surface is to be considered a watershed. This setting pre-
vents minor depression depths from being defined as watershed subareas.

�� In the Minimum Depression Area box, type the minimum area at which a 
depression in the surface is to be considered a watershed. This setting pre-
vents minor depression areas from being defined as watershed subareas.

�� Select or clear the Must Exceed Both Minimum Area And Minimum Depth 
check box:

� Select this check box to create watershed subareas of only those depres-
sions that exceed both the minimum area and the minimum depth. 

� Clear this check box to create watershed subareas of those depressions that 
exceed either the minimum area or the minimum depth. 

�� Click OK to build the surface. 

A message dialog box is displayed, informing you that the program has 
finished building the surface. 

�� Click OK.
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�� If you want to view and edit the surface triangulation, then Import 3D Lines 
into the drawing. For more information, see “Importing the Surface as 3D 
Lines” on page 726. 

Minimizing Flat Triangles Resulting from 
Contour Data

When building a surface, select the Minimize Flat Triangles Resulting From 
Contour Data check box to check each contour in the surface for any trian-
gles that have three points at the same elevation. The program attempts to 
remove any such triangle by flipping faces.

For example, during the first pass at creating the surface model from con-
tours, you might find that the surface has a triangle from three points on the 
same contour. A typical example would be a site that includes finger-like con-
tours such as those along a stream. If you clear the Minimize Flat Triangles 
Resulting From Contour Data check box, then the surface model may trian-
gulate between a point on a contour on one side of the stream and a point 
on the same contour on the other side of the stream. The Minimize Flat Tri-
angles Resulting From Contour Data Option searches those situations and 
resolves the problem by triangulating to another contour.

TIP You can view these flat triangles graphically by using the 2D Solids slope 
shading command. If you run this command for just one range with a slope of 
0.00 percent, you will see the flat areas along the contour data. For more infor-
mation, see “Creating 2D Solids Using the Average Method that Show the 
Elevations of a Surface” on page 750.

NOTE If you generate contours from a surface that you created using only 
contour information, you might need to place spot elevations or breaklines in 
areas where the contour lines change direction drastically and contour data is 
sparse. Areas where this is likely to happen include a crowned roadway, a swale, 
or a ridge. In these places, contours might tend to triangulate onto themselves, 
creating flat triangles. In most instances, the Minimize flat triangles resulting 
from contour data option resolves the problem. In more drastic situations, you 
might need to add additional point or breakline data. For more information, see 
“Proximity Breaklines” on page 661.
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Creating Surface Data and Adding It to the 
Surface Folders

Each surface can be made up of a combination of points, breaklines, bound-
aries, and contours. To create or add data to the surface, use the surface folder 
shortcut menus. 

For example, to add contour data, right-click on the Contours folder and 
select Add Contour Data. 

When you add data to the surface folders, surface data files are created in the 
following folder:

c:\Land Projects R2\<project name>\dtm\<surface name> 

� For points, a <surface name>pnt.txt file is created. 
� For breaklines, a <surface name>flt.bin file is created. 
� For contours, a <surface name>brk.bin file is created.
� For boundaries, a <surface name>bnd.bin file is created.

Adding Point Groups to the Surface Folder to 
Use in Surface Generation

If you want to use points that exist in the project point database as surface 
data, then you can create point groups and add them to the surface folder. 
You can create point groups that contain specific points, like all existing 
ground points, making it easier to manage the surface points.

NOTE You can also add COGO points to surface data by selecting the points 
in the drawing and by importing point files. For more information, see “Adding 
to the Surface Point File by Selecting AutoCAD Point Nodes and COGO 
Point Objects” on page 629 and “Adding Point Files to the Surface Folder to 
Use in Surface Generation” on page 626.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Point Group to display the Add Point Group dialog box.

NOTE If no point groups are defined, then a message dialog box is displayed, 
asking if you want to run the Point Group Manager to create a point group. Click 
Yes to create a point group. For more information, see “Creating a Point 
Group” on page 117. 

� From the Point Group Name list, select the point group that you want to add.

� Click OK.

The point group statistics are then updated in the right-hand pane of the Ter-
rain Model Explorer.

Adding Point Files to the Surface Folder to Use in 
Surface Generation

If you have ASCII text files that contain point data—point files that you cre-
ated either manually or when downloading a data collector—you can use 
them as surface data. You can also create point data to use in surfaces from 
AutoCAD objects, such as point nodes, lines, blocks, text, polyfaces, and 3D 
faces.

If you have an ASCII text file or a Microsoft® Access .mdb file that you want 
to use as surface data, then you can add the point file to the Point File folder 
in the Terrain Model Explorer. An import/export format is required when you 
use Point Files so AutoCAD Land Development Desktop can interpret the for-
mat of the point file. For more information, see “Creating a Point Import/
Export Format” on page 267.

You can manually create ASCII text files that contain point data; they can 
also be a result of downloading a data collector. For more information, see 
“Creating a Surface Point File Manually” on page 628.

To create .mdb files, you must use Microsoft Access.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Point File to display the Format Manager - Read Points dialog box.

� From the Format list, select the import format. You must set up this format 
to match the contents of the point file. For example, if you have a comma 
delimited ASCII text file that contains point number, northing, easting, and 
elevation data, then use a comma delimited PNEZ format that recognizes the 
data. 

TIP To create a new format, click  to create the format. For more informa-
tion, see “Creating a Point Import/Export Format” on page 267. 

� Click  to display the Select Source File dialog box.

� Locate the file you want to use.

� Click Open to return to the Format Manager - Read Points dialog box.

�� Click OK.
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The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Creating a Surface Point File Manually
You can create a text file with point information for creating a surface, and 
use point data created in any software program to produce a surface.
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� Open a text editor such as Notepad.

� Type the point number, easting, northing, and elevation (for example). Sep-
arate each value by one or more spaces or with a comma.

Type the information for each point on a separate line. For best results, do 
not include extra spaces at the end of a line or blank lines at the end of the 
file. The file should consist entirely of point data, however, you can add a 
comment line by typing a # sign at the beginning of a line.

� Save the file as a text file to the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name>

NOTE If you have used the Terrain Model Explorer to add AutoCAD objects to 
the surface point file, then a <surface name>pnt.txt file already exists in that 
folder. Use a different name to avoid overwriting this file. For more information, 
see “Creating Surface Point Data from Objects” on page 628.

� Add the file to the surface folder. For more information, see “Adding Point 
Files to the Surface Folder to Use in Surface Generation” on page 626.

The following example shows a point file:
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Creating Surface Point Data from Objects

If there are objects in your drawing that you want to use as surface data, such 
as 3D lines, then you can add them to the surface Point File folder. AutoCAD 
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Land Development Desktop interprets the objects that you select as point 
data. Specific point data is created for each object type that you add to the 
surface folder. 

This data is saved to a <surface name>pnt.txt file that is saved in the follow-
ing folder:

c:\Land Projects R2\<project name>\dtm\<surface name> 

The first time that you add objects to this file, you are not prompted to 
append or overwrite the file. However, for each subsequent addition, you are 
prompted to either append or overwrite the file with the new point data. For 
more information, see “Appending or Overwriting the Surface Point File” on 
page 629.

Appending or Overwriting the Surface Point File
If a point file already exists in the surface folder, then the following prompt 
is displayed:
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Type Append or Overwrite:

� Append: Adds the object points to the surface data file.
� Overwrite: Overwrites the surface data file and creates a new file from the 

object points.

Adding to the Surface Point File by Selecting AutoCAD Point 
Nodes and COGO Point Objects
You can add COGO points and AutoCAD point nodes with elevations to the 
surface data file by selecting the points in the drawing.

NOTE You can also add COGO point data to surface data by adding point 
groups.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the subfold-
ers.

� Right-click on  to display the shortcut menu.
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� Click Add Points from AutoCAD Objects ➤ Points.

The Terrain Model Explorer closes so you can view the drawing, and the fol-
lowing prompt is displayed:
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NOTE If you already defined point data from objects in the drawing, then an 
append or overwrite prompt is displayed. For more information, see “Append-
ing or Overwriting the Surface Point File” on page 629.

� Do one of the following to select the points:

� Type Entity to select the points from the drawing, and then use any stan-
dard selection method to select the points.

� Type Layer to select the objects by layer, and then select one object on the 
layer that you want to select. All valid 3D points on that layer are added 
to the surface data file.

� Type Layer, press ENTER, and then type the layer name. All valid 3D points 
on the layer are added to the surface data file.

The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Adding to the Surface Point File by Selecting Lines
If your drawing file has 3D lines, then you can add the endpoints of these 
lines to the surface data file.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Points from AutoCAD Objects ➤ Lines.

The Terrain Model Explorer closes so you can view the drawing and the fol-
lowing prompt is displayed:
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NOTE If you already defined point data from objects in the drawing, then an 
append or overwrite prompt is displayed. For more information, see “Append-
ing or Overwriting the Surface Point File” on page 629.

� Do one of the following to select the lines: 

� Type Entity to select the lines from the drawing, and then use any stan-
dard selection method to select the lines.

� Type Layer to select the lines by layer, and then select one line on the 
layer that you want to select. All valid 3D lines on that layer are added to 
the surface data file.

� Type Layer, press ENTER, and then type the layer name. All valid 3D lines 
on the layer are selected and their end points are added to the surface data 
file.

The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Adding to the Surface Point File by Selecting Blocks
If you have blocks that are inserted at an elevation in the drawing, then you 
can add the insertion points of the blocks to the surface data file.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Points from AutoCAD Objects ➤ Blocks.

The Terrain Model Explorer closes so you can view the drawing and the fol-
lowing prompt is displayed:

,���!���-.�!�	�-��$/����&0����*�"0����#+

NOTE If you already defined point data from objects in the drawing, then an 
append or overwrite prompt is displayed. For more information, see “Append-
ing or Overwriting the Surface Point File” on page 629.

� Do one of the following to select the lines: 



632 | Chapter 26 Creating Surface Models

� Type Entity to select the blocks from the drawing, and then use any stan-
dard selection method to select the blocks.

� Type Layer to select the blocks by layer, and then select one block on the 
layer that you want to select. All valid blocks on that layer are selected and 
their insertion points are added to the surface data file.

� Type Layer, press ENTER, and then type the layer name. All valid blocks on 
the layer are selected and their insertion points are added to the surface 
data file.

The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Adding to the Surface Point File by Selecting Text
If you have AutoCAD text that is inserted at an elevation in the drawing, 
then you can add the insertion points of the text to the surface data file.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Points from AutoCAD Objects ➤ Text.

The Terrain Model Explorer closes so you can view the drawing and the fol-
lowing prompt is displayed:

,���!���-.�!�	�-��$/����&0����*�"0����#+

NOTE If you already defined point data from objects in the drawing, then an 
append or overwrite prompt is displayed. For more information, see “Append-
ing or Overwriting the Surface Point File” on page 629.

� Do one of the following to select the text: 

� Type Entity to select the text from the drawing, and then use any standard 
selection method to select the text.

� Type Layer to select the text by layer, and then select one piece of text on 
the layer that you want to select. All valid text blocks on that layer are 
selected and their insertion points are added to the surface data file.
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� Type Layer, press ENTER, and then type the layer name. All valid text 
blocks on that layer are selected and their insertion points are added to the 
surface data file.

The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Adding to the Surface Point File by Selecting 3D Faces 
You can add points to the surface data file by selecting existing AutoCAD 3D 
faces in the drawing. The corners of the selected faces become points in the 
surface point file.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the subfold-
ers.

� Right-click on  to display the shortcut menu.

� Click Add Points from AutoCAD Objects ➤ 3D Faces.

The Terrain Model Explorer closes so you can view the drawing and the fol-
lowing prompt is displayed:

,���!���-.�!�	�-��$/����&0����*�"0����#+

NOTE If you already defined point data from objects in the drawing, then an 
append or overwrite prompt is displayed. For more information, see “Append-
ing or Overwriting the Surface Point File” on page 629.

� Do one of the following to select the 3D faces: 

� Type Entity to select the 3D faces from the drawing, and then use any 
standard selection method to select the 3D faces.

� Type Layer to select the 3D faces by layer, and then select one 3D face on 
the layer that you want to select. All valid 3D faces on that layer are 
selected and the corner points of the selected faces are added to the surface 
data file.

� Type Layer, press ENTER, and then type the layer name. All valid 3D faces 
on that layer are selected and the corner points of the selected faces are 
added to the surface data file.
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The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Adding to the Surface Point File by Selecting Polyfaces
You can add points to the surface data file by selecting existing AutoCAD 
polyfaces in the drawing. The vertices of the selected polyfaces become 
points in the surface point file.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Points from AutoCAD Objects ➤ Polyface.

The Terrain Model Explorer closes so you can view the drawing and the fol-
lowing prompt is displayed:

,���!���-.�!�	�-��$/����&0����*�"0����#+

NOTE If you already defined point data from objects in the drawing, then an 
append or overwrite prompt is displayed. For more information, see “Append-
ing or Overwriting the Surface Point File” on page 629.

� Do one of the following to select the polyfaces: 

� Type Entity to select the polyfaces from the drawing, and then use any 
standard selection method to select the polyfaces.

� Type Layer to select the polyfaces by layer, and then select one polyface 
on the layer that you want to select. All valid polyfaces on that layer are 
selected and the vertices are added to the surface data file.

� Type Layer, press ENTER, and then type the layer name. All valid polyfaces 
on that layer are selected and the vertices are added to the surface data file.

The point file statistics are then updated in the right-hand pane of the 
Terrain Model Explorer.

Using DEM Files as Surface Data

DEM files (Digital Elevation Models) are used to store and transfer large-scale 
topographic relief information for use in GIS, earth sciences, resource man-
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agement, land planning, surveying, and engineering projects. DEM files typ-
ically contain land XYZ information at a regular grid-spaced interval to rep-
resent ground relief. 

In AutoCAD Land Development Desktop Release 2i, you can use DEM files as 
part of your surface data in the Terrain Model Explorer. You can add and 
remove DEM files, import DEM boundaries, and view DEM information. To 
transform DEM coordinates so they match the coordinate system of the cur-
rent drawing when the surface is built, you can specify a coordinate system 
for the DEM file.

DEM files are a valuable data source for many planning and engineering tasks 
that do not necessarily need the type of precision gained by doing a ground 
or aerial survey. DEM files can also, in some places, completely eliminate the 
need for specific surveys. Usually, the DEM data is not precise enough to use 
on small-scale studies, but is ideal for large-scale planning and analysis tasks. 

Some examples of projects that can benefit from DEM information include 
hydrologic studies, corridor planning for highways and pipelines, land use 
planning and analysis, slope analysis, and large-scale project visualization.

DEM Files and Memory Usage
Surfaces that contain DEM files can require a substantial amount of memory 
(RAM and virtual memory) and disk space to build and save the surface. It is 
important to make sure you have sufficient resources before you build a sur-
face using a DEM file. Also, be aware that certain commands may take longer 
than expected when working with these surfaces.

General guidelines for DEM file memory usage:

� When building a surface, memory usage will peak at about 23 megabytes 
(MB) of memory for each 1 MB of DEM file.

� A surface that has been built using a DEM file will require approximately 
21 MB of memory for each 1 MB of DEM file. This will be used when the 
surface is opened, set current, or just after it has been built.

� A surface that has been built using a DEM file will require approximately 
15 MB of disk space (to save the surface) for each 1 MB of DEM file.

As a general rule, a 1 MB DEM file contains 160,000 points. For larger DEM 
files, the number of points grows proportionately to the DEM file size at a 
rate of approximately 160,000 points per 1 MB of DEM file size.

Obtaining DEM Files
DEM files are widely available on the Internet. For example, the United States 
Geological Survey (USGS) provides many DEM files at http://www.usgs.gov.
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NOTE SDTS (Spatial Data Transfer Standard) format DEM data is not sup-
ported for this release of AutoCAD Land Development Desktop. However, there 
are free utilities you can use to convert SDTS data to DEM format. For more infor-
mation, go to http://software.geocomm.com/translators/sdts.html or 
ftp://ftp.blm.gov/pub/gis/sdts/dem/.

Adding DEM Files to Surface Data
To work with a DEM file, you add it to a surface in the Terrain Model Explorer. 
When the surface is built, the DEM file data is combined with any other sur-
face data that is defined for the particular surface. 
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� To show the surface data, click the plus (+) sign next to the Surface name.

� Right-click on  to display the shortcut menu.

� Select Add DEM File to display the Add DEM File dialog box.
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� To select the DEM file to add, click  to display the Select DEM File dialog 
box.

� Locate the DEM file you want to add, and then click Open.
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NOTE DEM files must have the extension .dem. If you downloaded a com-
pressed file, such as a .tar file, you must uncompress it before adding it.

The full path of the DEM file is shown in the Selected DEM File box.

TIP To select a DEM file to add to a surface, you can also type the DEM file 
name, including the path and file extension (.dem), directly into the Selected 
DEM File box.

Under DEM File Information, statistics about the DEM file, including coordi-
nate system data, are displayed. For more information, see “About DEM File 
Data” on page 646.

If the coordinate system information of the DEM file is different than the 
current drawing’s coordinate system (which is displayed under Current 
Drawing Coordinate System (Destination) in the lower part of the dialog 
box), specify a Coordinate System for the DEM file. 
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NOTE You must specify a coordinate system for the DEM file if the coordinate 
system of the DEM file is different than the current coordinate system of the 
drawing and you want a coordinate transformation to occur when the surface is 
built.

� Under DEM File (Source) Coordinate System, click Select to display the Select 
Coordinate Zone dialog box.

TIP If you know the Coordinate System Code, you can type it directly into the 
CS Code box.

IMPORTANT If you want to perform a coordinate transformation, the 
coordinate system you specify for the DEM file must match the data defined 
in the DEM file itself (as shown in the DEM File Information box) or the data 
will not be transformed correctly. For example, if the DEM File Information 
box lists the DEM coordinate system as NH State Plane NAD83, then you 
must specify NH State Plane NAD83 as the coordinate system for the DEM 
file. If you make a mistake when you add the DEM file, then you can change 
the specified coordinate system by using the Properties command. For more 
information, see “Changing the Specified Coordinate System of a DEM 
File” on page 641.

� From the Categories list, select the type of coordinate system the DEM file 
was created in. For example, the Categories list contains Lat/Longs, coun-
tries, US States, UTM, and other categories of zones.
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When you select a Category, the Available Coordinate Systems list is popu-
lated with the coordinate systems that are available for the selected Category.

�� Select the coordinate system of the DEM file from the Available Coordinate 
Systems list.

The CS Code box is updated with the code of the coordinate system you 
selected.

�� Click OK to return to the Add DEM File dialog box.

�� Click OK to add the DEM file to the surface folder in the Terrain Model 
Explorer.

The DEM file name, date the file was last modified, and size in KB are listed 
in the right pane of the Terrain Model Explorer. You can right-click on the 
file to display a shortcut menu that you can use to remove the DEM file, view 
DEM file information, change the DEM file coordinate system, or import the 
DEM boundary. 

�� Build the surface to incorporate the DEM data into the surface. For more 
information, see “Building a Surface that Contains DEM File Data” on page 
642.

Removing a DEM File from the Surface Data
If you no longer wish to use a DEM file as part of the surface data, you can 
remove the DEM file. 

NOTE To prevent DEM file data from being used when you build a surface, 
you can clear the Use DEM File Data check box in the Build Surface dialog box.
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� If the Terrain Model Explorer is not already open, choose Terrain Model 
Explorer from the Terrain menu.

� To show the surface data, click the plus (+) sign next to the Surface name.

� Click  to update the right pane of the Terrain Model Explorer with 
the DEM file information.

� Right-click on a DEM file to display the shortcut menu.

� Select Remove.

� Rebuild the surface if necessary.
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Changing the Specified Coordinate System of a DEM File
When you add a DEM file in the Terrain Model Explorer, you can specify a 
coordinate system for the DEM file if the coordinate system of the DEM file 
is different than the current coordinate system of the drawing. The coordi-
nate system you specify for the DEM file should match the data defined in 
the DEM file itself. 

NOTE You only need to specify a coordinate system for the DEM file if the 
coordinate system of the DEM file is different than the current coordinate system 
of the drawing and you want a coordinate transformation to occur when the sur-
face is built.

If you chose the wrong coordinate system when adding the DEM file, you 
can select a different coordinate system for the file by changing the DEM file 
properties.
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� If the Terrain Model Explorer is not already open, choose Terrain Model 
Explorer from the Terrain menu.

� To show the surface data, click the plus (+) sign next to the Surface name.

� Click  to update the right pane of the Terrain Model Explorer with 
the DEM file information.

� Right-click on a DEM file to display the shortcut menu.

� Select Properties to display the DEM Properties dialog box.
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� Click Select to display the Select Coordinate Zone dialog box, where you can 
select a different coordinate system for the DEM file. Or, if you know the cor-
rect coordinate system code, you can type it directly into the CS Code box.

� Click OK.

� Rebuild the surface if necessary. For more information, see “Building a Sur-
face that Contains DEM File Data” on page 642.

NOTE The coordinate system of the DEM file is not automatically selected. By 
default, no coordinate system is selected, meaning no coordinate system trans-
form will occur. You must select a coordinate system for both the drawing and 
DEM file for coordinate transforms to occur.

Building a Surface that Contains DEM File Data
After you add a DEM file to the surface data, build the surface. The Build Sur-
face command reads, processes, and compiles the DEM file data into the sur-
face, but it leaves the original DEM file unmodified. When the surface is 
built, all DEM file units are converted into the units of the current drawing.
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Coordinate system transformation occurs when you build the surface, and is 
based on the coordinate system of the DEM file and the coordinate sytem of 
the drawing.

To use the DEM file data when the surface is built, the Use DEM File Data 
check box must be selected in the Build Surface dialog box. For more infor-
mation about building a surface, see “Building a Surface” on page 620.

The following table lists some specific examples about how coordinates are 
read and processed depending on different coordinate system settings in 
your drawings and DEM files.

DEM Coordinate System Transforms
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NH State Plane 
NAD27

NH State Plane 
NAD83

The DEM file coordinate data is transformed 
from NAD27 to NAD83 when the surface is 
built.

NH State Plane 
NAD27

None The DEM file data is not transformed when the 
surface is built, meaning that the DEM file data 
is taken at face value. For example, point 
100,100,100 in the DEM file is point 
100,100,100 in the terrain model.

None None The DEM file data is not transformed when the 
surface is built, meaning that the DEM file data 
is taken at face value. For example, point 
100,100,100 in the DEM file is point 
100,100,100 in the terrain model.

None NH State Plane 
NAD83

The DEM file data is not transformed when the 
surface is built, meaning that the DEM file data 
is taken at face value. For example, point 
100,100,100 in the DEM file is point 
100,100,100 in the terrain model.

NH State Plane 
NAD83

NH State Plane 
NAD83

No transformation is applied.

/0�% Specifying a coordinate system for a 
DEM file is not necessary in this situation. 
However, if you are working with multiple 
drawings in the current project and the 
drawings have different coordinate systems, it is 
recommended that you specify a coordinate 
system for the DEM file in case you need to 
rebuild the surface in a drawing that has a 
different coordinate system.
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Importing DEM Extents
To view the extents of the points contained in a DEM file, you can import the 
DEM extents. The extents are based on the four corner points defined in the 
DEM file, and reflect any coordinate transformation that may occur. 

The quadrilateral extents are meant to show you the location of DEM files so 
you can verify you have added the correct files. For example, when using 
quad sheet or tiled DEM files, you can import their extents to make sure you 
have the correct files, they are positioned properly, and the DEM coordinate 
systems are correct.

TIP Before building the surface, you can import the DEM extents to check the 
coordinate system setting of the DEM file.

The DEM extents border is imported as a 2D polyline and is placed on the 
border layer as defined in the Surface Display Settings. By default this layer is 
SRF-BDR. For more information, see “Changing the Surface Display Settings” 
on page 742.
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� If the Terrain Model Explorer is not already open, choose Terrain Model 
Explorer from the Terrain menu.

� To show the surface data, click the plus (+) sign next to the Surface name.

� Click  to update the right pane of the Terrain Model Explorer with 
the DEM file information.

� Right-click on a DEM file to display the shortcut menu.

� Select Import DEM Extents.

The Erase Layer dialog box is displayed.

� Click No to preserve the DEM extents and surface borders that exist on the 
layer, or click Yes to erase all other DEM extents, as well as surface borders, 
from the layer.

The extents border is then inserted into the drawing as a 2D polyline.

� To view the DEM extents, minimize the Terrain Model Explorer or move it 
out of the way of your drawing display.
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� If the extents border is not visible, zoom to the extents of the drawing by typ-
ing ZE. 

TIP “ZE” is a macro. For more information about macros, see “AutoCAD Land 
Development Desktop Macros” on page 1064.

Viewing DEM File Properties
Each DEM file contains information as specified by the USGS DEM standards. 
Certain data, such as coordinate system information, is available for viewing 
when you add a DEM file to a surface folder and when you view DEM file 
properties. 
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� If the Terrain Model Explorer is not already open, choose Terrain Model 
Explorer from the Terrain menu.

� To show the surface data, click the plus (+) sign next to the Surface name.

� Click  to update the right pane of the Terrain Model Explorer with 
the DEM file information.

� Right-click on a DEM file to display the shortcut menu.

� Select Properties to display the DEM Properties dialog box.
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Details about the DEM file are listed in the File Information list. For more 
information, see “About DEM File Data” on page 646.

� Click OK.

About DEM File Data
DEM files are created to strict standards, as specified by the USGS. For com-
plete information about the DEM file format, see the “Standards for Digital 
Elevation Models,” part of the “National Mapping Program Technical 
Instructions,” published by the U.S. Department of the Interior, U.S. Geolog-
ical Survey, National Mapping Division. This documentation can be found 
on the USGS web site, at http://rockyweb.cr.usgs.gov/nmpstds/acrodocs/dem/
PDEM0198.PDF.

In general, the DEM source data is contained in one section of the DEM file 
(Logical record type ‘A’), and the actual data (x,y,z) information is contained 
in another part of the DEM file (Logical record type ‘B’).  
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The following data, based on logical record type ‘A’, is displayed for each 
DEM file that you add to a surface folder in AutoCAD Land Development 
Desktop:

DEM File Information
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Description 1 The first 140 characters of a DEM file, which may 
include the file name and location.

Estimated Point 
Total

N/A The estimated number of points in the DEM file, 
rounded up to three significant digits.

Coordinate 
System Type

5 The ground planimetric reference system: UTM, 
State Plane, or Lat/Long.

Zone 6 Code which defines the zone in ground planimetric 
reference system. These can be found in 
Appendixes 2-E and 2-F of the Standards for Digital 
Elevation Models. The Zone is meaningful only if 
the Coordinate System Type is UTM or State Plane.

Horizontal Datum 27 The horizontal datum of the ground planimetric 
reference system, such as NAD27.

Vertical Datum 26 1 = local mean sea level
2 = National Geodetic Vertical Datum 1929 (NGVD 
29)
3 = North American Vertical Datum 1988 (NAVD 
88)
For more information, see Appendix 2-H of the 
Standards for Digital Elevation Models.
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Vertical Datum 
Shift

31 The value is the average shift value for the four 
quadrangle corners obtained from program 
VERTCON. AutoCAD Land Development Desktop 
adds this value to the vertical datum to convert to 
NAVD88. If the vertical datum is NAVD88 then the 
vertical datum shift value should be zero.

DEM Level 3 There are three possible DEM Levels. 
� Level 1 DEM’s are elevation data sets in a 

standardized format. This level includes 7.5-
minute DEM’s or an equivalent that is derived 
from stereo profiling or image correlation of 
National High Altitude Photography Program, 
National Aerial Photography Program, or 
equivalent photographs.

� Level 2 DEM’s are elevation data sets that have 
been processed or smoothed for consistency 
and edited to remove identifiable systematic 
errors. DEM data derived from hypsographic 
and hydrographic data digitizing, either 
photogrammetrically or from existing maps, 
are entered into the level 2 category after 
review on a DEM editing system. 

� Level 3 DEM’s are derived from DLG data by 
using selected elements from both 
hypsography (contours and spot elevations) 
and hydrography (lakes, shorelines, and 
drainage). If necessary, ridge lines and 
hypsographic effects of major transportation 
features are also included in the derivation.

X-Y Units 8 The unit of measure for ground planimetric 
coordinates throughout the file, such as radians, 
feet, meters, or arc-seconds.

Elevation Units 9 The unit of measure for elevation coordinates 
throughout the file, such as feet or meters.

Minimum 
Elevation

12 The minimum elevation for the DEM. The value is in 
the units of measure defined by the Elevation Units.

Maximum 
Elevation

12 The maximum elevation for the DEM. The value is 
in the units of measure defined by the Elevation 
Units.

DEM File Information
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Creating Contour Data to Use in Surface 
Generation

To build a surface from contour data, you must add the contour data to the 
 folder in the Terrain Model Explorer. When you add contour 

data, AutoCAD Land Development Desktop reviews, organizes, and stores 
the contour data. The contour data is stored in the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name>

When you add contour data in the Terrain Model Explorer, the Contour 
Weeding dialog box is displayed.

The Create as contour data check box in the Contour Weeding dialog box 
controls whether the contour data is written out as contour data or as point 
data. 

� Select this check box to have the data written out as contour data to the 
<surface name>brk.bin file and have the contours treated as breaklines. 
No surface triangulation occurs across the contour lines.

X Spacing 15 DEM spatial resolution for X values. The value is in 
the units of measure defined by the X-Y Units.

Y Spacing 15 DEM spatial resolution for Y values. The value is in 
the units of measure defined by the X-Y Units.

DEM File Information
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� Clear this check box to have the contour data written out as point data to 
the <surface name>pnt.txt file and treated as point data. Using this 
method, surface triangulation could occur across the contour lines. 

You can create contour data from contour objects that you created with the 
Create Contours, Digitize Contours, or Convert Polylines command. For 
more information, see “Creating Contours From a Built Surface” on page 
805, “Digitizing Contours” on page 818, and “Converting Polylines to Con-
tours” on page 817. You can also create contour data from polylines drawn 
at an elevation or that were assigned elevations. For more information, see 
“Assigning Elevations to Contours or Polylines” on page 822.

Creating Contour Data to Use in Surface Generation
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� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Contour Data.

The Terrain Model Explorer closes and the Contour Weeding dialog box is 
displayed.

� Select or clear the Create as contour data check box:

� Select this check box to write out the vertices as contour data, which has 
the same behavior as breaklines. When this box is selected, the program 
saves the data to the <surface name>brk.bin file.

� Clear this check box to create random point data using the contour verti-
ces and save the data to the <surface name>pnt.txt file.

� Type the Weeding Distance and Angle factor values. 

Use the weeding factors to reduce the number of points generated along the 
contours. The weeding factors ignore vertices that are closer together than 
the distance factor and vertices that deflect less than the angle factor. A larger 
distance and deflection angle weeds a greater number of points. The distance 
factor is measured in linear units and the angle factor is measured in angular 
units. The weeding factors must be less than the supplementing factors.

A point on the contour is weeded by calculating its location in relation to the 
vertices before and after it. If the length between these three points is less 
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than the weeding length value, and the deflection angle is less than the 
weeding angle value, then the middle point is not added to the contour data 
file.

The following illustration shows the weeding factor parameters:
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� Type the Supplementing Distance and Bulge factor values. Use the supple-
menting factors to supplement or add vertices along contours. The supple-
menting distance is the maximum distance between vertices. If the distance 
between vertices on a contour is greater than the supplementing factor, then 
points are added along the contour at the specified distance. The smaller the 
distance, the greater the number of supplemented points. 

The following illustration shows the supplementing factor parameters: 
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For contours that contain curves, the bulge value is a ratio of the distance 
from the arc to the chord divided by half the length of the chord. The bulge 
factor adds vertices to a polyline curve, creating an approximation of the 
curve using straight line segments. The length of these segments varies 
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depending on the bulge factor and the degree of curvature.

The following illustration shows the bulge factor parameters:
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� Click OK.

The following prompt is displayed:
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�� Do one of the following to select the contours or polylines:

� Type Entity to select the contours from the drawing, and then use any 
standard selection method to select the contours.

� Type Layer to select the contours by layer, and then select one contour on 
the layer that you want to select. All valid contours or polylines on that 
layer are selected.

� Type Layer, press ENTER, and then type the layer name. All valid contours 
or polylines on that layer are selected.

The Terrain Model Explorer is redisplayed and the contour statistics are 
updated in the right-hand pane. 

Deleting Contour Data from a Surface Folder
After you add contour data to a surface folder, you can delete it if you no 
longer want to use it as part of the surface definition.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Remove All Contour Data.
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A message box is displayed, informing you that all contour data will be 
deleted from the surface.

� Click Yes to proceed, or click Cancel to end the command without deleting 
the contour data.

Contour Data and Surface Triangulation
Information obtained from a contour map differs greatly from data taken 
randomly in the field. Because contour map data is interpolated, the infor-
mation may be less accurate than direct field data. The accuracy of the final 
surface model depends on the quality of your contour map and the contour 
interval.

If you bring contour data back into the drawing as points, then the points 
would not be very random. In steep areas, points would be close together. In 
flat areas, there is a greater distance between points on different contours. In 
both cases, the points along the contours are generally close together. There-
fore, information taken from contours does not make effective random point 
data. Random data points generate the best triangulation.

Missing Contour Information
When you create a model from contours and then generate contours from 
this model, there are some cases where the Create Contours command may 
fail to generate contours. In the most common situation, a contour is missing 
in a low or high area. The missing contours might be located near the top of 
a hill, at the bottom of a valley, or on the edge of the site. 

To correct both problems, place spot elevations or another contour line near 
the place where the contour is missing. For example, if a contour line is miss-
ing along the top of a hill with an elevation of 100, place a new contour, 
breakline, or spot elevations just above the 100 foot elevation (i.e. at 100.01). 
We suggest that you place any interpolated data, points, or contours on a 
separate layer.

NOTE If you generate contours from a surface that you created using only 
contour information, you might need to place breaklines or spot elevations in 
areas where the contour line changes direction drastically. Areas where this is 
likely to happen include: a crowned roadway, a swale, or a ridge. In these places, 
contours might tend to triangulate onto themselves. In most instances, the 
Minimize Flat Faces command resolves this problem. In more drastic situations, 
you might need to add additional point or breakline data. 
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Creating Breakline Data to Use in Surface 
Generation

You can use breaklines to define retaining walls, curbs, tops of ridges, and 
streams. Breaklines force surface triangulation along the breakline and pre-
vent triangulation across the breakline. 

Breaklines are typically critical to creating an accurate surface model, because 
it is the interpolation of the data, not just the data itself, that determines the 
shape of the model. 

Breakline data is stored in the <surfacename>flt.bin file, located in the fol-
lowing folder:

c:\Land Projects R2\<project name>\dtm\<surface name>

All breaklines are created and managed in the Terrain Model Explorer dialog 
box.

NOTE The breaklines are automatically drawn on the SRF-FLT layer by default, 
but you can change this layer. For more information, see “Changing the Surface 
Display Settings” on page 742. 

The following illustration shows the effects of breaklines:
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Creating Breaklines from Points
You can define a breakline by selecting COGO points along the breakline. 
You can pick any part of the COGO point to select the point. The X,Y,Z coor-
dinates of each point are written to the breakline file.
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Define By Point.

The Terrain Model Explorer closes so you can see the graphics window.

� Select the first point of the breakline.

� Continue selecting points to add to the line.

� At the select point prompt, press ENTER to complete the breakline. 
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� Type a description for the breakline. 

A dialog box is displayed that asks if you want to Delete existing objects.

�� Click Yes or No:

� Click Yes to erase the original breakline which is created on the current 
layer, and create a new object in the breakline file. The program places the 
new object on the breakline layer.

� Click No to keep the existing breakline and to create a new object in the 
breakline file. The program places the new object on the breakline layer.
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Creating Breaklines from Point Numbers
You can define a breakline by entering point numbers from one end of the 
breakline to the other. You can use individual numbers and/or groups of 
numbers separated by dashes. The X,Y,Z coordinates of each point are writ-
ten to the breakline file
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Define By Point Number.

The Terrain Model Explorer closes so you can see the graphics window.
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� Type the point numbers of the breakline. You can type individual points 
separated by commas, and ranges of points separated by dashes 
(1,2,3,10-100).

� Press ENTER to complete the breakline.

� Type a description for the breakline.

Creating Breaklines from 2D or 3D Polylines or Lines
You can use 2D or 3D polylines as breaklines to create a surface. The X, Y, and 
Z coordinates of each vertex on the polyline that you select are written to the 
breakline file. 

WARNING! If you select a 2D polyline with a zero elevation, then it is saved 
in the breakline file with that elevation. Use proximity breaklines if you want the 
program to calculate the elevations.
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Define By Polyline.

The Terrain Model Explorer closes so you can see the graphics window.

� Type a description for the breakline.

� Select the polyline(s) to use as a breakline.

� Press ENTER to complete the selection set. 

A dialog box is displayed that asks if you want to Delete existing objects.

� Click Yes or No:

� Click Yes to erase the original polyline and create a new object in the 
breakline file. The program places the new object on the breakline layer.

� Click No to keep the existing polyline and to create a new object in the 
breakline file. The program places the new object on the breakline layer.



658 | Chapter 26 Creating Surface Models

If you selected a polyline that is already defined as a breakline, then a warn-
ing message is displayed with the following options:

� Ignore: Keeps the existing breakline data on the polyline, and does not 
add new breakline data..

� Modify: Changes the breakline definition to include any changes to the 
graphic polyline selected.

� Overwrite: Deletes the original breakline data from the polyline and 
defines a new breakline from the polyline that you selected. This option 
does not delete the original breakline definitions from the breakline file.

Each option has a second choice: Ignore All, Modify All, Overwrite All. If you 
select any All option, then the program suppresses this message and repeats 
the option selected on any other breaklines selected until the command is 
ended.

Creating Breaklines from 3D Lines 
You can use 3D lines as breaklines to create a surface. Each line that you select 
is defined as a two-point breakline. The X,Y,Z coordinates of each point are 
written to the breakline file.

TIP If you lost all the project files associated with the line drawings, but still 
have the 3D TIN lines that you created with the Import 3D Lines command, then 
you can use this command to recreate a surface.
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Define By 3D Lines.
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The Terrain Model Explorer closes so you can see the graphics window.

� Type the description for the 3D line breaklines.

The following prompt is displayed:
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� Do one of the following:

� Type Entity and then use any standard selection method to select the 
lines.

� Type Layer to select the 3D lines by layer, and then select one 3D line on 
the layer that has the 3D lines you want to select. All valid 3D lines on that 
layer are selected and their endpoints are added to the breakline file.

� Type Layer and then press ENTER and then type the layer name. All valid 
3D lines on that layer are selected and their end points are added to the 
breakline file.

Importing Breakline Definitions from a Text File
You can create a breakline file with a text editor. You can then import this 
text file into the drawing to use as breakline data for building the surface. The 
X,Y,Z coordinates of each point are written to the breakline file.
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� Create a breakline file. For more information, see “Creating a Breakline File 
Manually” on page 660.

� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Define Breaklines From File to display the Read ASCII Breakline File 
dialog box.
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� Select the file to import. The files all have an .flt file extension. 

� Click OK.

Creating a Breakline File Manually
You can create your own breakline file by performing the following steps. If 
the coordinate information is supplied to you in a similar format, then you 
can easily create this import file.
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� Open an ASCII text editor such as Notepad or Wordpad.

� Type the file using the following structure:

� Use the (#) symbol as the first character in a comment line.
� Use the letters P, S, L, and R to describe the breakline type. These letters 

stand for Proximity, Standard, Wall Left, and Wall Right. Identify a break-
line type for each new breakline.

� Type the X, Y, and Z coordinates separated by a space.
� A description for the breakline can follow the first coordinate of the line.
� By entering in the breakline type letter at the beginning of a line, a new 

breakline is created. For instance, in the example below an S is placed at 

the beginning of the 8th line of the file. All the points from this point until 
the next breakline letter modifier are in one breakline. This breakline is 
called EOP.

� Save the file with an .flt file extension.

The following is an example of a breakline file:
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Proximity Breaklines
Proximity breaklines reference sampled points (any breakline point, contour 
point, or COGO point used to create a TIN) that are in proximity to the 
points or polylines that you select as the breakline. You can define proximity 
breaklines quickly because you don’t have to exactly snap to the sampled 
points that you want to use for the breakline. You can just pick locations that 
are near to the sampled points that you want to use. The breakline vertices 
automatically snap to the nearest sampled point when the surface is built the 
first time.

You can define proximity breaklines by selecting locations in the drawing or 
from a polyline. The polyline method is similar to the point method. You 
don’t have to draw the polyline exactly between sampled points. The break-
line definition automatically snaps to the sampled point that is nearest each 
polyline vertex when the surface is built the first time. 

Proximity breaklines are 2D polylines with elevations of 0. When you run the 
Build command to build the surface, the northing, easting, and elevation are 
calculated for each vertex according to the closest sampled surface point. By 
default proximity breaklines are converted to standard breaklines when the 
surface is built. The conversion of proximity breaklines to standard break-
lines can be turned off in the Build <Surface Name> dialog box.

NOTE Proximity breaklines do not support curves. If a 2D polyline with a curve 
is selected the resulting breakline will only have the chord of the curve.



662 | Chapter 26 Creating Surface Models

Defining Proximity Breaklines by Selecting Points
You can define proximity breaklines by selecting locations close to sampled 
points (any breakline point, contour point, or COGO point used to create a 
TIN). A breakline is added into the database based on the northings and east-
ings of the selected locations.

When you build the surface model, the proximity breakline points snap to 
match the nearest sampled points. After the model is created, you can import 
the proximity breakline to see what points were used in the breakline 
definition.
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, “Creating a New Sur-
face” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Draw Proximity Breakline.

The Terrain Model Explorer closes so you can see the graphics window.

� Using your mouse, select the first point of the breakline. You do not have to 
snap to the point, but you can use point filters to select points.

� Using your mouse, select the next point. Continue selecting points until all 
points are selected.

� Press ENTER to end the point selection.

� Type the description for the breakline. 

A dialog box is displayed that asks if you want to Delete existing objects.

�� Click Yes or No:

� Click Yes to erase the original breakline and create a new object with links 
to the breakline file. The program places the new object on the breakline 
layer.

� Click No to keep the existing breakline and to create a new object with 
links to the breakline file. The program places the new object on the 
breakline layer.

Defining Proximity Breaklines by Selecting Polylines
You can define proximity breaklines from polylines that are not drawn 
exactly from sampled point to sampled point, but are in the proximity of the 
points. Each vertex point in the polyline can be in the proximity of a sam-
pled point. When the surface model is calculated, each vertex point of that 



Creating Surface Data and Adding It to the Surface Folders | 663

breakline snaps to the nearest sampled point. Because you don’t have to draw 
the polylines from exact points, the proximity breakline command makes it 
quicker and easier to define a breakline.

This command adds a breakline into the database based on polyline vertex 
northing and easting coordinates. The elevational value at each vertex point 
of the breakline is 0. When you build the surface model, the proximity break-
line points snap to match the nearest sampled points. After the model is cre-
ated, you can import the proximity breakline to see what points were used in 
the breakline definition. 
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Proximity By Polylines.

The Terrain Model Explorer closes so you can see the graphics window.

� Type the description for the breaklines.

� Select the polylines to create breaklines from.

� Press ENTER to end the polyline selection. 

A dialog box is displayed that asks if you want to Delete existing objects.

� Click Yes or No:

� Click Yes to erase the original polyline and create a new object with links 
to the breakline file. The program places the new object on the breakline 
layer.

� Click No to keep the existing polyline and to create a new object with 
links to the breakline file. The program places the new object on the 
breakline layer.

The following illustration shows the relationship between the proximity 
points and the polyline selection point after you build the surface and re-
import the breaklines:
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Defining Walls or Curbs as Breaklines
You can define retaining walls or curbs as breaklines to be used as surface 
data. By creating wall breaklines, you can more accurately represent the con-
ditions of the terrain. For example, for a retaining wall, you can define the 
differences in elevation between the material on both sides of the wall so that 
elevations are correctly represented. 

You can define wall breaklines by selecting an existing polyline. The Define 
Wall Breaklines command extends this polyline by creating new polyline seg-
ments and vertices parallel to the original polyline, but offset at an incre-
mented distance to represent the differences in elevation between the mate-
rial on either side of the wall.

The command continues through each polyline vertex in sequence until all 
control and offset elevation values are entered, defining the top and bottom 
configuration of the wall breakline.

After you defined the wall breakline, you can create a new surface that recog-
nizes this breakline, with the polyline vertices becoming new surface points. 
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NOTE When you define wall breaklines, we recommend that you define no 
more than five walls at one time. When running, the command uses much of 
your system’s resources. Resources are cleared when you end the command. 
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Define Wall Breaklines.

The Terrain Model Explorer closes so you can see the graphics window.

� Type the description for the wall breakline.

� Select the polyline to define the wall breakline. 
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After you select the existing polyline, you need to specify the offset side for 
the wall breakline. The existing polyline side of the wall is the control side.

� Select the offset side. This is the side for the new offset line that represents 
the elevation of material on the other side of the wall.

A temporary arrow originating from each vertex shows the direction of the 
offset point. 
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� Type the elevation of the first control point (original polyline vertex), then 
the associated offset point (new polyline vertex) immediately below or above 
it. 

The prompts provide two ways to define elevations for each offset point: as 
an elevation or as the elevational difference between the control point and 
the offset point. Elevational differences may be either positive or negative 
values. 
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�� Type the elevation, or difference in elevation, for the offset.

�� Repeat steps 9 and 10 until all points receive elevations.

�� If you want to create another wall, then type the wall description and repeat 
steps 7 through 11.

�� Press ENTER to end the command.
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Identifying Breaklines in a Drawing
You can list a breakline’s number, description, and type by selecting it from 
the drawing.

���
���	
�!�������"
��

� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Id Breakline.

The Terrain Model Explorer closes so you can see the graphics window.

� Select a breakline.

The breakline number, description and type are displayed at the command 
line. Types include Standard, Proximity, and Wall.

� At the Select Polyline prompt, press ENTER to end the command.

Listing the Breaklines in the Project
You can display information about breaklines that exist in the project. The 
breaklines do not need to exist in the drawing in order to view the 
information. 
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� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select List Breaklines to display the List Breaklines dialog box.
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This dialog shows each breakline number and description.

� Select a breakline.

� Click List to see the detailed information for that breakline.

The following information is displayed: 

� Vertex: The number of the vertex in the breakline. (This is not the num-
ber of the point that was selected if the breakline was generated from 
point data.) 

� Northing: The northing value of a specific vertex in the breakline.
� Easting: The easting value of a specific vertex in the breakline.
� Elevation: The elevation of a specific vertex in the breakline.

� Click OK to return to the List Breakline dialog box.

� Click Cancel to return to the drawing.

Importing Breaklines into a Drawing
You can import any or all of the breaklines from the breakline file into a 
drawing. This is useful if you start another drawing in the current project, or 
erased the breaklines from the drawing and you want to edit them. The file 
that contains the breakline data is <surface name>flt.bin, a file located in the 
project directory.
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� From the Terrain menu, choose Terrain Model Explorer.
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� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Import Breaklines to display the Import Breaklines dialog box.

� Select the breakline to import by clicking on its name, or, use any of the fol-
lowing selection methods: 

� Select All: Selects all the breaklines in the list.
� Clear All: Clears the selection of all the breaklines in the list. 

Each breakline you select is marked with an asterisk (*).

� Click OK to insert the breaklines you selected.

When this command imports the breaklines, it creates them as 3D polylines 
in the drawing.

Editing Breaklines
You can edit any breakline that you have defined by selecting it from the 
screen. You can insert, move, and delete vertices, as well as redefine the ele-
vation at a selected vertex. 

NOTE To edit the location of a breakline, use AutoCAD editing commands, 
and then you can redefine the breakline to the database. For more information, 
see “Updating Edited Breaklines” on page 671.
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� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.
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� Right-click on  to display the shortcut menu.

� Select Edit Breakline.

The Terrain Model Explorer closes so you can see the graphics window.

� Select the breakline to edit. A graphic X displays at the beginning of the 
breakline you select.

The following prompt is displayed:
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� Do one of the following:

� Press ENTER or Next to move to the next vertex in the breakline. A tempo-
rary ✕ on the screen indicates the current vertex.

� Type Previous to move to the previous vertex in the breakline.
� Type Move to move the current vertex of a polyline to a new location, and 

then select a new location for the vertex at the New location prompt.
� Type Elevation to edit the elevation of the selected vertex, and then type 

the new elevation.

NOTE If the selected breakline is a wall, then the command prompts you 
for two elevations. 

� Type Insert to insert another vertex in the polyline at the selected loca-
tion, and then select the new vertex location and type an elevation.

� Type Delete to delete the current vertex.
� Type Exit to stop editing the breakline and exit the command.

NOTE Changes are made to the graphic polyline representation of the 
breakline only. Use the Update Breaklines command to incorporate these 
changes into the breakline database.  

Changing the Description of a Breakline
You can change the description of any breakline by selecting it.
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� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Edit Description.
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The Terrain Model Explorer closes so you can see the graphics window.

� Select the breakline whose description you want to change.

The breakline’s number, description, and type are displayed at the command 
line.

� Type the new description for the breakline.

Updating Edited Breaklines
You can use AutoCAD commands like MOVE to modify the position of a 
breakline. However, if you make changes to a breakline, you must run the 
Update Breaklines command to update the breaklines in the breakline file. 
The breakline in the breakline file, not the breakline in the drawing, is always 
used in surface creation.
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� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Update Breaklines.

The Terrain Model Explorer closes so you can see the graphics window.

� Select the breakline(s) that you have edited.

� Press ENTER to complete the selection set. 

Any edits that you made to the selected breaklines are saved to the breakline 
file.

Deleting Breaklines
You can remove a breakline definition from the breakline file. 
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� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Select Delete Breaklines to display the Delete Breaklines dialog box.
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� Select the breakline to delete by clicking its name, or, use any of the following 
selection methods:

� Select All: Selects all the breaklines in the list.
� Clear All: Clears the selection of all the breaklines in the list.
� Select: Closes the dialog box and lets you select the breakline to be 

deleted from the drawing. 

Selected breaklines are marked by an asterisk (*).

� Under Delete From, select where the breakline will be deleted from: 

� File: Deletes the selected breakline from the breakline file only. 
� Drawing: Deletes the selected breakline from the drawing only. 
� Both: Deletes the selected breakline from both the breakline file and the 

drawing.

� Click OK.

NOTE If all the breaklines are deleted, then the whole breakline file is deleted. 

Exporting Breakline Data to a Text File
You can export selected breakline information to an ASCII text file.
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� From the Terrain menu, choose Terrain Model Explorer.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.
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� Right-click on  to display the shortcut menu.

� Select Export to File to display the Write ASCII Breakline File dialog box.

� Type the name of the file to create.

� Click Save to save the file. 

The Select Breakline dialog box is displayed.

� Select the breaklines to write to the file by clicking their names, or use the 
following selection methods: 

� Select All: Selects all the breaklines in the list.
� Clear All: Clears the selection of all the breaklines in the list.

� Click OK to write the file and return to the drawing.

Creating Boundary Data to Use in Surface 
Generation

By defining boundaries, you can control the visible portions of a surface. You 
can define three different types of boundaries: outer, hide, and show. You can 
use these boundary types to hide triangulation outside of the bounds of the 
survey (outer), to hide areas so triangulation isn’t visible in an area (hide), 
and to show areas that were previously hidden (show). When you want to 
work with the entire surface again, you can remove the boundaries.

Before you define the boundary, you must draw a closed polyline that sur-
rounds the area you want to show or hide. This polyline is used to define the 
boundary. If you want to create a boundary at the limits of the surface, then 
you can create a surface border using either the 2D or 3D polyline border 
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commands, and then select it as a boundary. For more information, see “Cre-
ating Surface Borders” on page 738.

NOTE When you use a Hide boundary, the surface is not deleted. The full sur-
face remains intact. If there are surface TIN lines that you want to permanently 
remove from the surface, then use the Delete Line command. For more informa-
tion, see “Deleting TIN Lines from a Surface” on page 728.

Methods of Creating Surface Boundaries
You can define boundaries in two ways:

� Before building the surface, you can create boundaries from within the 
Terrain Model Explorer. These boundaries are added to the surface 
definition.

� After building the surface, you can edit the surface by creating (or delet-
ing) boundaries by using the Surface Boundaries command in the 
Terrain ➤ Edit Surface menu. When you add or remove boundaries after 
building a surface, the surface is modified and the change is added to the 
Edit History of the surface. 

The two methods have distinctly different behaviors and results.

Terrain Model Explorer Boundaries
When you add boundaries using the Terrain Model Explorer, the actual 
boundary definition is stored in the surface data file. You can add three types 
of boundaries: Outer, Hide, and Show.

� An Outer boundary excludes any points that exist outside of the bound-
ary. There can be only one Outer boundary for a given surface.

� A Hide boundary excludes any points that exist within the selected 
boundary. This is useful for such things as building footprints or “holes” 
in your surface where survey data is not present or applicable, and you do 
not wish to represent elevations for that area. 

� A Show boundary shows an area that was hidden by using a Hide bound-
ary. This is useful if you need to create “islands” of surface data within hid-
den regions. It is important to note that the Show boundary does not 
show points outside of an outer boundary.

Surface Boundaries Command in the Edit Surface Menu
Using the Surface Boundaries command from the Edit Surface menu is some-
what different than using the Terrain Model Explorer to create boundaries. 
The Surface Boundaries command does not add or remove surface boundaries 
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from the actual boundary definitions for a surface, but rather affects the sur-
face’s Edit History. 

The Surface Boundaries command has two options: you can choose to 
remove all boundaries (RemoveAll option), and to add new boundaries (Add 
option). The Add option also allows you to remove all boundaries before you 
add new boundaries.

When you select the Surface Boundaries command from the Terrain ➤ Edit 
Surface menu, the following prompt is displayed:

8���(����&����"���#+

If you choose the RemoveAll option, the command does not actually remove 
the boundaries from the surface, but instead adds an instruction to the Edit 
History called “Show all Faces,” which effectively negates any boundaries 
when you rebuild the surface and apply the Edit History.

If you choose the Add option, the following prompt is displayed:
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If you specify Yes, the command does not actually remove the boundaries 
from the surface, but instead adds an instruction to the Edit History called 
“Show all Faces,” which effectively negates any boundaries when you rebuild 
the surface and apply the Edit History.

When using the Add option, the command then prompts you for the type of 
boundary to add. Again, it is important to note that a boundary added with 
this command is not added to the boundary definitions in the surface, but 
rather becomes a set of instructions that are added to the Edit History. 

You can add two types of boundaries to the surface with this command: Hide 
and Show.

� The Hide boundary hides any triangles within the boundary, and over-
rides any show boundaries that are included in the boundary definitions 
for a surface. 

� The Show boundary shows any triangles within the boundary, and over-
rides any hide boundaries that are included in the boundary definitions 
for a surface.

NOTE You can view the Edit History for a surface by choosing the Terrain 
Model Explorer command from the Terrain menu, expanding the surface’s data 
tree, and then selecting the Edit History icon. When you use the Edit Surface 
commands on the Terrain menu to modify a surface, the commands prompt you 
to rebuild the surface to include the edits that you made. After editing a surface, 
if you rebuild a surface through Terrain Model Explorer and wish to apply the 
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edits you have made, you must select the Apply Edit History check box in the 
Build Surface dialog box. 

For more information about using the Surface Boundaries command from 
the Edit Surface, see “Editing a Surface to Define or Remove Surface Bound-
aries” on page 735.

Adding a Boundary to the Surface Folder to Use in Surface 
Generation
When you add a boundary to the surface’s  folder in the Terrain 
Model Explorer, the boundary can be used for surface generation. You must 
build the surface after adding a boundary to the  folder to see 
the effect of the boundary.

When you build a surface to which you have added boundaries, the bound-
aries are applied after the other data has been triangulated. If there is an outer 
boundary, it is applied first. Then the other boundaries are applied in the 
order in which they were added to the surface definition.

NOTE There is a Surface Boundaries editing command that you can use to add 
or remove boundaries after you have built the surface. For more information, see 
“Defining Surface Boundaries After Building a Surface” on page 736.
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� Draw the boundary using one of the following methods: 

� Use the PLINE command. 
� Use the Surface Borders commands to draw a 2D or 3D polyline border 

around the surface. For more information, see “Creating Surface Borders” 
on page 738.

NOTE The boundary must be a closed polyline. 

� From the Terrain menu, choose Terrain Model Explorer. 

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Add Boundary Definition.
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The Terrain Model Explorer closes and you are prompted to select a polyline.

� Select the closed polyline that represents the boundary.

� Type a name for the boundary.

The following prompt is displayed:
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� Do one of the following:

� Type Outer to create an outer boundary for the surface. A surface can have 
only one outer boundary. An outer boundary is always a Show boundary.

� Type Show to create an interior boundary that shows the TIN lines inside 
the selected polyline.

� Type Hide to create an interior boundary that hides the TIN lines inside 
the selected polyline.

The following prompt is displayed:

6�
��-���
���	����9���9�	=�":�	&4�#+

�� Type Yes or No:

� Type Yes to create non-destructive breaklines along the edges of the 
boundary. When you select this option, vertices are created where the tri-
angulation lines cross the boundary, and the surface is retriangulated. 

� Type No to remove the triangles that cross the boundary line (outer 
boundaries only) or to prevent the triangles from being affected by the 
boundary (interior boundaries).

The following illustration shows the effects of non-destructive breakline for 
an outer boundary: 
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The following illustration shows the effects of not creating non-destructive 
breaklines at the outer boundary:

0�	����������!��
	 ��	����6���	���	
'������"
�����	
��



Creating Surface Data and Adding It to the Surface Folders | 679

If you define a hide boundary for a building pad, for example, and you 
choose to make non-destructive breaklines at the boundary, then the follow-
ing effect occurs:
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The triangles are broken exactly where the boundary crosses them. Vertices 
are created where the triangulation lines cross the boundary, and the surface 
is retriangulated.

Importing a Surface Boundary
If you delete the polyline that represents a surface boundary, then you can 
import the polyline back into the drawing to redisplay the boundary. The 
Import Boundaries command imports the boundaries as lightweight 
polylines.

NOTE To see the effects of this command, at least one boundary must be 

defined in the surface’s  folder, and you must have deleted the 
polyline that represents the boundary from your drawing. 
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� From the Terrain menu, choose Terrain Model Explorer. 
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� Open the surface folder in the Terrain Model Explorer to display the 
subfolders.

� Right-click on  to display the shortcut menu.

� Click Import Boundaries.

Deleting Data from the Terrain Model Explorer 
Folders

To control which data in the surface folders is used when you build a surface, 
you can change the surface’s properties to exclude any data type, such as con-
tours. However, you can also delete point files, point groups, or boundaries 
from the Terrain Model Explorer if you no longer want to use them for the 
surface. 
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� Right-click on the Point Files, Point Groups, or Boundaries surface data folder 
that contains the data you want to delete.

� Select Remove or press the DELETE key on your keyboard.

For more information about removing contour data from the Terrain Model 
Explorer, see “Deleting Contour Data from a Surface Folder” on page 652.

Using Roadway Cross Sections as Surface Data

You can use roadway section data from Autodesk Civil Design to create a sur-
face model, using the following two methods:

Method 1:

� Import points from the cross section data.
� Create a point group from those points.
� Build a surface from that point group.

Method 2:

� Import a 3D Road Grid from the cross section data, which brings into the 
drawing a grid composed of 3D faces.

� Build a surface using point file data (AutoCAD objects) created from 3D 
faces.

To minimize surface editing, it is best to include data created by the sections 
only. Points close to but not on a section might cause triangles to be formed 
in an improper direction. If non-section points exist, then exclude them 
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from the point group. If the surface requires non-section points, then define 
breaklines along the alignment to represent features such as EOP, Centerline, 
and so on. This helps to ensure that the triangulation is correct.

NOTE If you want to create sections from an alignment where data in the field 
is taken on the same interval as the sections to be plotted, then the best method 
of determining the existing ground might be to create an ASCII file of station and 
offset information. You can then use the Civil Design Cross Sections menu and 
choose Existing Ground ➤ Sample From File to import the sections from the 
ASCII file. 
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27Surface Statistics

The Terrain Model Explorer shows data for each item in 

the Terrain and Volume folders. Just click any folder to 

update the view in the right-hand pane with statistics 

on how many point groups, contours, breaklines, and so 

on are included in the built surface. 

In this chapter

� Statistics for Terrain Surfaces

� Overall Statistics for a Surface

� Statistics for Surface Data 
Folders

� Volume Surface Statistics
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Statistics for Terrain Surfaces

When you click on the  folder in the Terrain Model Explorer, the 
following information is displayed in the right-hand pane:

Surface Name
Lists the terrain surfaces that are defined.

Status
Lists one of the following statuses for surfaces:

� No data: The surface has been created but no data exists in the surface 
folders. The surface has not been built, and no surface .tin file exists.

� Not built: The surface has been created and data has been added to the 
surface folders, but the surface has not yet been built and no surface .tin 
file exists.

� OK: The surface has been built and none of the surface files has been 
modified since the surface was built. A surface .tin file exists that is newer 
than all of the data files. This implies that the surface has been built with 
all of the current data, and no surface properties have been changed since 
it was built.

� Out of Date: The surface has been built but some data has been updated 
or surface properties have changed since the surface was built. Re-build 
the surface to update the surface with changes to the data.

# Points
Lists the number of points from which the surface was built.

Modified
Lists when the surface was last built or saved.

Size
Lists the size of the surface in KB.

Overall Statistics for a Surface

When you click on a surface name in the Terrain Model Explorer, for example 
 , the surface statistics appear in the right-hand pane. These sta-

tistics include the description of the surface as well as surface data, surface 
statistics, and extended surface statistics.
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Description
The description of the surface. You assign the description when you build the 
surface. 

Locked By
The AutoCAD login name of the person who has the surface open in a read-
writable state. NOT LOCKED is displayed when the surface is closed.

Surface Data
Point Groups
The number of points in the surface that were added from point groups.

Point Files
The number of points in the surface that were added from point files, includ-
ing <surface name>pnt.txt, the file that is created when you use the Add 
Points from AutoCAD Objects commands.

DEM Files
The number of points in the surface that were added from DEM files.

Contours
The number of points in the surface that were added from contours.

Breaklines
The number of points in the surface that were added from breaklines.

Boundaries
The number of points in the surface that were added from boundaries.

Estimated Total
The estimated total number of points the surface was created from. This 
number is an estimate because the actual number of points that is added to 
the surface may be less. There may be duplicate points between different data 
sources, some points may not have valid elevations, or some points 
referenced in point groups may have been deleted from the COGO point 
database.

Surface Statistics
Revision #
The first time a surface is built, the revision # is 1. Each time the surface is 
rebuilt or saved, the number is incremented.

No. of Points
The exact number of points used in the surface. 

Min Coordinates
The lowest northing and easting coordinates of the surface.
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Max Coordinates
The highest northing and easting coordinates of the surface.

Minimum Elevation
The minimum elevation of the surface.

Maximum Elevation
The maximum elevation of the surface.

Extended Surface Statistics
To generate extended statistics, select the Compute Extended Statistics check 
box in the Build dialog box when you build the surface. For more informa-
tion, see “Building a Surface” on page 620. Or, right-click on the surface 
name in the Terrain Model Explorer and select Calculate Extended Statistics. 

NOTE If you select the option to calculate extended surface statistics for a sur-
face in the Terrain Model Explorer, and then you edit that surface, the extended 
statistics are removed from the Terrain Model Explorer the next time the display 
is refreshed. 

If you edit the surface, and then recalculate the extended statistics, the surface 
is saved automatically. Saving a surface always increases the revision number by 
one. This is because extended statistics are always associated with a specific, 
saved version of the surface, and the extended statistics are shown only if that 
version of the surface is the version in memory.

Number of Triangles
The number of triangles in the surface TIN.

2D Surface Area
The 2D surface area is the apparent surface area if you look at the surface from 
plan view. It is obtained by projecting the visible triangles onto the XY plane 
along the Z axis and summing the areas of the triangles. 

If areas on the surface are hidden within boundaries, then these areas are not 
included in the surface area.

3D Surface Area
The 3D surface area is the true area of the surface and accounts for variations 
in the surface elevation. The 3D area is the sum of the areas of each of the 
visible triangles in the surface without projecting the triangles. The greater 
the variation in elevations, the more the 3D area differs from the 2D area.

An example of the difference between 2D and 3D areas is a building pad. The 
2D area is the area that you can see from only the top and doesn't vary with 
the height of the building pad. The 3D surface area of the building pad is the 
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sum of the areas of each face of the building pad, which would become larger 
the higher the building pad becomes.

Mean Elevation
The mean elevation of the surface.

Minimum Triangle Area
The area of the smallest triangle in the surface TIN.

Maximum Triangle Area
The area of the largest triangle in the surface TIN. 

Statistics for Surface Data Folders

There are three surface data folders underneath the surface name in the Ter-
rain Model Explorer: TIN Data, Edit History, and Watershed. Within the TIN 
Data folder are the Point Group, Point File, Contour, Breakline, and Bound-
ary folders. When you click each of these items, information is displayed in 
the right pane of the Terrain Model Explorer.

TIN Data Statistics

When you click on the  folder in the Terrain Model Explorer, the 
following information is displayed in the right-hand pane:

Point Groups
The number of points in the surface that were added from point groups.

Point Files
The number of points in the surface that were added from point files, includ-
ing <surface name>pnt.txt, the file that is created when you use the Add 
Points from AutoCAD Objects commands.

DEM Files
The number of points in the surface that were added from DEM files.

Contours
The number of points in the surface that were added from contours.

Breaklines
The number of points in the surface that were added from breaklines.

Boundaries
The number of points in the surface that were added from boundaries.
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Estimated Total
The estimated total number of points the surface was created from. This 
number is an estimate because the actual number of points that is added to 
the surface may be less. There may be duplicate points between different data 
sources, some points may not have valid elevations, or some points refer-
enced in point groups may have been deleted from the COGO point 
database.

Point Group Information

When you click on the  folder in the Terrain Model Explorer, 
the names of the point groups that you have added to the surface data are 
displayed in the right-hand pane.

Point File Information

When you click on the  folder in the Terrain Model Explorer, the 
names of the .txt files, the date the files were last modified, and the size of 
the files in KB are displayed in the right-hand pane. The point file <surface 
name>pnt.txt is created when you use the Add Points from AutoCAD Objects 
commands.

DEM File Information

When you click on the  folder in the Terrain Model Explorer, the 
following information is displayed in the right-hand pane:

Name
Lists the name of the DEM file.

Modified
Lists the date the file was last modified.
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Size
Lists the size of the DEM file in KB.

Contour Information

When you click on the  folder in the Terrain Model Explorer, the 
following information is displayed in the right-hand pane:

Total # contour points
The total number of points in the surface that were added from contours.

Total # of contours
The total number of contours in the surface.

Elevation range
The minimum and maximum elevations of the contour data.

Minimum coordinates
The lowest northing and easting coordinates for a contour point in the 
surface.

Maximum coordinates
The highest northing and easting coordinates for a contour point in the 
surface.

Breakline Information

When you click on the  folder in the Terrain Model Explorer, the 
following information is displayed in the right-hand pane:

Total # breakline points
The total number of points in the surface that were added from breaklines.

Total # of breaklines
The total number of breaklines in the surface.

Elevation range
The minimum and maximum elevations of the breakline data.

Minimum coordinates
The lowest northing and easting coordinates for a breakline point in the 
surface.

Maximum coordinates
The highest northing and easting coordinates for a breakline point in the 
surface.
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Boundary Information

When you click on the  folder in the Terrain Model Explorer 
the boundary name, type, and whether the TIN triangles are trimmed at the 
boundary is displayed. The boundary type can be Outer, Hide, or Show.

Edit History Information

When you edit a surface, your edits are recorded in an edit history. You can 
choose to apply these same edits to the surface the next time you build the 
surface by selecting the Apply Edit History option in the Build Surface dialog 
box. When the surface is rebuilt, the same edits are made in the order you 
made them. 

When you click on the  folder in the Terrain Model Explorer, 
each surface edit is displayed in the right-hand pane in the order that it was 
performed. You can delete an edit from the Edit History by selecting the 
name of the edit and pressing the DELETE key.

Watershed Information

If watershed data has been calculated, when you click on the  
folder in the Terrain Model Explorer, then the information about each water-
shed subarea is displayed in the right-hand pane:

� The watershed ID, which includes a number for each subarea and the 
subarea type. 

� The watershed area. 
� If the watershed is a flat area, multi-drain, multi-drain notch, or depres-

sion, then the watersheds that it drains into are listed by ID. 
� If the watershed is a depression, then the volume and depth when full are 

also displayed.

For more information about watershed types, see “Watershed Types” on page 
716. 

Statistics for Volume Surfaces

When you click on the  folder in the Terrain Model Explorer, the 
following information is displayed in the right-hand pane:
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Volume name
The name of the volume surface.

Cut
The total cut volume for the surface, without cut factor applied. 

Fill
The total fill volume for the surface, without fill factor applied.

Net
The difference between the cut and fill volumes.

NOTE Parcel volumes are not displayed in the Terrain Model Explorer. 

When you click on a volume surface folder in the Terrain Model Explorer, for 
example , the following information about the 
volume surface is displayed in the right-hand pane:

Description
The description of the volume surface.

Volume Information
Type
The method used to calculate volumes, such as grid or composite.

Strata
The stratum from which the site was defined. 

Surface 1
The first surface in the stratum.

Surface 2
The second surface in the stratum.

Cut Volume
The total cut volume for the site, without cut factor applied.

Fill Volume
The total fill volume for the site, without fill factor applied.

Net
The difference between the cut and fill volumes.
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Surface Statistics
Revision #
The first time a surface is built, the revision # is 1. Each time the surface is 
rebuilt or saved, the number is incremented.

Number of Points
The exact number of points used in the surface.

Minimum Elevation
The minimum elevation of the surface.

Maximum Elevation
The maximum elevation of the surface.

Minimum Coordinates
The lowest northing and easting coordinates of the surface.

Maximum Coordinates
The highest northing and easting coordinates of the surface.
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28Managing Surfaces

Before you use any of the surface editing or display com-

mands, set the current surface. You can set a current sur-

face, open, close, delete, copy, and rename Terrain and 

Volume surfaces using the Terrain Model Explorer. You 

can also view and edit the Edit History of a surface. The 

Edit History stores a record of all the edits you make to 

a surface so they can be reapplied to the surface if you 

ever need to rebuild them.

In this chapter

� Managing Surfaces

� Managing Volume Surfaces
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Managing Surfaces

Use the Terrain Model Explorer to manage your surfaces. From the Terrain 
Model Explorer you can open, close, save, copy, rebuild, rename, and delete 
surfaces. You can also use commands on the Terrain menu to select and save 
the current surface.

Making a Surface Current

Many surfaces can be open simultaneously. However, all surface editing, 
viewing, volumes, sections, and contour commands work on the current sur-
face only. There can be only one current surface.
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� From the Terrain menu, choose Set Current Surface to display the Select 
Surface dialog box.

� Select one of the following to filter the listed surfaces:

� Terrain Surface: To show the terrain surfaces in the list.
� Volume Surface: To show the volume surfaces in the list.

� Select the surface that you want to make current. 
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� Click OK.

NOTE In the Terrain Model Explorer, you can set a surface current by using the 
Open (Set Current) command. The last surface that you open using this com-
mand is the current surface. For more information, see “Opening an Existing 
Surface and Making It Current” on page 695. 

In the Terrain Model Explorer, the following conventions are used to indicate 
different surface states:

� The current surface is indicated by the solid green surface 

icon:

� Open surfaces are indicated by bold text:
� Closed surfaces are indicated by normal text:

Opening an Existing Surface and Making It 
Current

You must open a surface to either edit it or access the elevational information 
you need for operations such as creating profiles. After you open the surface, 
you can edit, query, or display the model any way you like. You can have an 
unlimited number of surfaces open at any one time. The most recent surface 
that you open is the current surface.

NOTE You can have only one current surface at a time. 

In the Terrain Model Explorer you can open a surface and set it current by 
using the Open (Set Current) command. 

� The current surface is indicated by the solid green surface 
icon:

� Open surfaces are indicated by bold text:
� Closed surfaces are indicated by normal text:
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to open, for 
example , to display the shortcut menu.

� Click Open (Set Current).
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Saving a Surface

When you edit a surface, you should save your changes before closing the 
surface. If you do not save the surface after you have modified it, then you 
are prompted to save it when either closing the surface or exiting the 
drawing.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to save, for 

example  to display the shortcut menu.

� Click Save.

Saving a Surface with a Different Name

You can save a surface with a new name. When you save a surface with a new 
name, the program makes a copy of the surface and all of the contents of the 
surface folders. 
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to save, for 

example , to display the shortcut menu.

� Click Save As to display the New Surface dialog box.

� Type the name for the new surface.

� You can type a description for the new surface.

� Click OK. 

The new surface is displayed in the left-hand pane of the Terrain Model 
Explorer.
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Saving the Current Surface

When you edit a surface, you should save your changes before closing the 
surface. If you do not save the surface after you have modified it, then you 
are prompted to save it when either closing the surface or exiting the 
drawing.

NOTE In the Terrain Model Explorer, the current surface is indicated by the 

solid green surface icon: .
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� From the Terrain menu, choose Save Current Surface.

Closing a Surface

If you are not working on a surface, then you can close it to free up memory 
or to allow someone else to edit it.

In the Terrain Model Explorer, the following conventions are used to indicate 
different surface states:

� The current surface is indicated by the solid green surface 

icon:

� Open surfaces are indicated by bold text:
� Closed surfaces are indicated by normal text:
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the open surface that you want to close, for 
example , to display the shortcut menu.

� Click Close.

Copying a Surface

�����������	
����

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to copy, for 

example , to display the shortcut menu.

� Click Copy.
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A copy of the surface is added to the Terrain Model Explorer named Copy of 
<surface name>. You can rename this surface. For more information, see 
“Renaming a Surface” on page 698. All surface data that was in the original 
surface is copied.

Deleting a Surface
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to delete, for 

example , to display the shortcut menu.

� Click Delete.

A warning dialog box is displayed, informing you that all files for the selected 
surface are about to be deleted.

� Click Yes to delete the surface. 

The surface folder is removed from the Terrain Model Explorer.

Renaming a Surface
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to rename, for 

example , to display the shortcut menu.

� Click Rename to display the Rename Surface dialog box.

� Type the new surface name. Surface names are limited to 40 characters.

� Click OK.



Managing Surfaces | 699

Calculating Extended Statistics for a Surface
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder of the surface that you want to calculate 

extended statistics for, for example , to display the shortcut 
menu.

� Click Calculate Extended Statistics.

The surface statistics are updated to show the extended statistics. For more 
information, see “Overall Statistics for a Surface” on page 684.

Surface Locking

To support multi-user access to a surface in a network environment, surfaces 
have a locking mechanism so that only one person can save edits at a time. 
Anyone else who opens the surface has read-only access to it. When a surface 
is locked, you can view it, extract information, or even edit it, but you can’t 
save it. 

In the Terrain Model Explorer statistics, you can see whether a surface is 
locked or unlocked. For more information, see “Overall Statistics for a Surface” 
on page 684.

It is important to coordinate efforts when working with surfaces, or any other 
project data, in a multi-user network environment.

Changing Surface Properties

You can change the surface properties before, during, or after building a sur-
face. To change the surface properties before or after building a surface, you 
can use the Properties command.

The properties that you change are not applied until you build the surface.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface folder, for example , to display the 
shortcut menu.

� Click Properties to display the Surface Properties dialog box.

� Click the Surface tab if it is not already active.
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In the Description box, you can type a description for the surface. The surface 
description can be up to 255 characters.

� Change the properties as needed. For more information, see “Building a Sur-
face” on page 620.

Managing Volume Surfaces

When you calculate volumes using either the grid method or the composite 
method, a volume surface is created. 

The elevational values of a volume surface are actually the differences 
between the two surfaces that make up the stratum. For example, at point 
1000, 1000, the bottom surface has an elevation of 100, and the top surface 
has an elevation of 150. The elevation of point 1000, 1000 on the volume 
surface is the difference between the two surfaces, which is 50. 

If a point on a volume surface is in a fill situation, then the elevation of that 
point is a positive number. If a point is in a cut condition, then the elevation 
of that point is a negative number.

Because surfaces are generated from the grid and composite volume calcula-
tions, you can create cut and fill contours from a volume surface to show the 
depths of cut and fill, and you can use any of the surface display commands 
to view the surface.

NOTE You can access some surface display commands from the volume sur-
face shortcut menu in the Terrain Model Explorer. For more information on 
changing the display of volume surfaces, see “Using the Surface Display Com-
mands” on page 742.

Opening a Volume Surface and Make it Current

To work with a volume surface, it must be open and it must be set current. 

In the Terrain Model Explorer, the following conventions are used to indicate 
different volume surface states:

� Open volume surfaces are indicated by bold text:
� Closed volume surfaces are indicated by normal text:
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� Calculate volumes using either the grid method or the composite method. By 
calculating volumes using these methods, a volume surface is created. For 
more information, see “Calculating Grid Volumes” on page 886 and “Calculat-
ing Composite Volumes” on page 894.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to open, for 

example , to display the shortcut menu.

� Click Open (Set Current).

Closing a Volume Surface

If you are not working on a surface, then you can close it to free up memory 
or to allow someone else to edit it.

In the Terrain Model Explorer, the following conventions are used to indicate 
different volume surface states:

� Open volume surfaces are indicated by bold text:
� Closed volume surfaces are indicated by normal text:
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� Calculate volumes using either the grid method or the composite method. By 
calculating volumes using these methods, a volume surface is created. For 
more information, see “Calculating Grid Volumes” on page 886 and “Calculat-
ing Composite Volumes” on page 894.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to close, for 

example , to display the shortcut menu.

� Click Close.

Saving a Volume Surface

When you edit a surface, you should save your changes before closing the 
surface. If you do not save the surface after you have modified it, then you 
are prompted to save it when either closing the surface or exiting the draw-
ing.
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� Calculate volumes using either the grid method or the composite method. By 
calculating volumes using these methods, a volume surface is created. For 
more information, see “Calculating Grid Volumes” on page 886 and “Calculat-
ing Composite Volumes” on page 894. 

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to save, for 

example , to display the shortcut menu.

� Click Save.

Renaming a Volume Surface

When you calculate volumes using the grid method or the composite 
method, a volume surface is created and given the name that you assigned 
to it when you were calculating volumes. You can rename this surface if 
needed.
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� Calculate volumes using either the grid method or the composite method. 
For more information, see “Calculating Grid Volumes” on page 886 and “Cal-
culating Composite Volumes” on page 894.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to rename, for 
example , to display the shortcut menu.

� Click Rename to display the Rename Surface dialog box.

� Type the new surface name. Surface names are limited to 40 characters.

� Click OK.

Copying a Volume Surface

�������������	����	
����

� Calculate volumes using either the grid method or the composite method. By 
calculating volumes using these methods, a volume surface is created. For 
more information, see “Calculating Grid Volumes” on page 886 and “Calculat-
ing Composite Volumes” on page 894.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to copy, for 

example , to display the shortcut menu.
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� Click Copy.

A copy of the surface is added to the Terrain Model Explorer that is named 
Copy of <surface name>. You can rename the surface if needed. For more 
information, see “Renaming a Surface” on page 698. All of the surface data 
that was in the original surface is copied.

Deleting a Volume Surface
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� Calculate volumes using either the grid method or the composite method. 
For more information, see “Calculating Grid Volumes” on page 886 and “Cal-
culating Composite Volumes” on page 894.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to delete, for 

example , to display the shortcut menu.

� Click Delete.

A warning dialog box is displayed, informing you that all files for the selected 
surface are about to be deleted.

� Click Yes to delete the surface.

The volume surface folder is removed from the Terrain Model Explorer.

Changing the Volume Surface Properties

When you generate a volume surface, you can name the surface, but you can-
not add a description to the surface. You can add a description of the surface 
by changing the volume surface properties in the Terrain Model Explorer.
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� Calculate volumes using either the grid method or the composite method. 
For more information, see “Calculating Grid Volumes” on page 886 and “Cal-
culating Composite Volumes” on page 894.

� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the folder of the volume surface that you want to change the 

properties of, for example , to display the shortcut menu.

� Select Properties to display the <surface name> Properties dialog box. 
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The volume calculation method used to create the surface is displayed on the 
tab in the dialog box: Grid or Composite. 

� In the Description box, type a description for the surface.

� Click OK.
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29Creating Watershed 
Models

Use the Watershed commands to calculate watershed 

areas and import them as polylines or solid fills into 

your drawing. You can choose an option to calculate 

watersheds during the process of building a surface, or 

you can use a command to calculate watersheds after a 

surface has been built.

In this chapter

� Creating Watershed Models

� Changing the Watershed 
Settings

� Changing Watershed 
Properties

� Creating a Watershed Model 
When Building a Surface

� Creating a Watershed Model 
After Building the Surface

� Importing Watershed 
Boundaries Into the Drawing

� Watershed Types
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Creating Watershed Models

You can calculate watersheds either while you build a surface or afterward. 
AutoCAD Land Development Desktop uses the surface TIN lines to calculate 
the channels that water would flow along the surface. From these channels, 
the drain targets and watershed subareas are determined.

Different drain targets are calculated for watershed subareas. For example, 
some subareas include a boundary point as a drain target, which is the point 
where the channel of water would drain off the surface. Some subareas have 
depression areas where the water flows to, and some subareas are defined as 
boundary segments if the drain target includes the boundary of a surface. For 
more information, see “Watershed Types” on page 716.

If the Calculate Watershed command determines that water from one TIN 
surface triangle could flow into more than one watershed subarea, then it 
splits the TIN triangle to make two triangles. This ensures that each water-
shed consists of complete triangles, and that the boundary of each watershed 
consists solely of TIN edges. 

After you build the watershed model, use the Water Drop command to draw 
polyline representations of the path that water would flow along the surface 
toward channels. 

Building a watershed involves three steps: configuring the settings, selecting 
the Calculate Watershed command from the Terrain Model Explorer, and 
then selecting the Import Watershed Boundaries command to draw the 
watershed boundaries. 

TIP You can use the watershed boundaries when you are using the hydrology 
commands in Civil Design to calculate watershed runoff.

Changing the Watershed Settings

The watershed settings control the default minimum and maximum water-
shed depths and areas, watershed layers for different watershed types, 
whether the watershed subareas are filled in with solids or outlined with 
polylines when the watershed boundaries are imported, whether the water-
sheds are numbered when imported, and whether the previous watershed 
boundaries are erased when boundaries are imported.
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box.

� Under Program, select Land Development Desktop.

� In the Settings list, click Watershed Settings.

� Click the Edit Settings button to display the Watershed Settings dialog box.

� Under Depression Criteria, in the Minimum Depression Depth box, type the 
minimum depression depth that a depression must have in order to be 
included in the model. This depth is the difference in elevation between the 
lowest point(s) on the depression boundary and the bottom of the depres-
sion. 

This value is used to filter out any smaller depressions that may be in a larger 
watershed. Any depression that is not as deep as this minimum depth may 
be considered part of the larger watershed that it empties into.
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For more information, see “Shallow Depressions” on page 719.

� In the Minimum Depression Area box, type the minimum depression area 
that a depression must have in order to be included in the model. This area 
is in the current (square) units that AutoCAD Land Development Desktop is 
set to, either feet or meters. 

This value is used to filter out any smaller depressions that may be in a larger 
watershed. Any depression that is smaller in area than this minimum area 
may be considered part of the larger watershed that it empties into. 

� Select or clear the Must exceed both criteria check box:

� Select this check box to build the model by only including areas that 
match or exceed both the minimum depression depth and the minimum 
depression area. 

� Clear this check box to include a depression area if it matches or exceeds 
either the minimum depth or minimum area criteria. 

� Under Options, select the Fill with solids check box to fill the watershed areas 
with solids instead of creating polyline boundaries (when you import the 
watershed boundaries). This option creates solid areas in the color of the sub-
area layer. Clear this check box to create polyline outlines.

� Under Options, select the Display ID Numbers check box to insert watershed 
numbers in the watersheds. 

NOTE You should clear the Fill with solids check box when you select Display 
ID Numbers, because the numbers are not visible if the watersheds are filled with 
solids.

�� Under Options, select the Erase previous layers check box to erase the layers 
on which you have created previous watershed boundaries (when you 
import the watershed boundaries). Clear this check box if you do not want 
to erase the layers.

�� Under Layers, select the default layer names for each watershed type. For 
more information about each of these watershed types, see “Watershed 
Types” on page 716. 

TIP Use the LAYER command to make these layers different colors so you can 
easily determine what type of watershed boundary is represented.

�� Click OK.
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Changing Watershed Properties

You can change the watershed properties before, during, or after building a 
surface. To change the surface properties before or after building a surface, 
you can use the Properties command.

The properties that you change are not applied until you build the surface.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Click on the  folder of the surface to display the shortcut menu.

� Select Properties to display the Watershed Properties dialog box. 

� In the Minimum Depression Depth box, type the minimum depression 
depth that a depression must have in order to be included in the model. This 
depth is the difference in elevation between the lowest point(s) on the 
depression boundary and the bottom of the depression. 

This value is used to filter out any smaller depressions that may be in a larger 
watershed. Any depression that is not as deep as this minimum depth may 
be considered part of the larger watershed that it empties into.

For more information, see “Shallow Depressions” on page 719.

� In the Minimum Depression Area box, type the minimum depression area 
that a depression must have in order to be included in the model. This area 
is in the current (square) units that AutoCAD Land Development Desktop is 
set to, either feet or meters. 
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This value is used to filter out any smaller depressions that may be in a larger 
watershed. Any depression that is smaller in area than this minimum area 
may be considered part of the larger watershed that it empties into. 

� Select or clear the Must exceed both minimum area and minimum depth 
check box:

� Select this check box to build the model by only including areas that 
match or exceed both the minimum depression depth and the minimum 
depression area. 

� Clear this check box to include a depression area if it matches or exceeds 
either the minimum depth or minimum area criteria. 

� Click OK.

Creating a Watershed Model When Building 
a Surface

You can create a watershed model of the current surface automatically when 
you build a surface. 

After the watershed is calculated, you can create polyline boundaries or solid 
areas that delineate each subarea (also known as catchment) for the surface 
by using the Import Watershed Boundaries or Import Individual Watersheds 
command. 

Watershed data that is created is saved as <surface name>.hdm and is saved 
to the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name> 

Two other files are also saved to this folder. Watershed boundary data is saved 
as <surface name>ws.bin and a text file that contains a list of the watersheds 
that are found is saved as <surface name>ws.txt.
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� From the Terrain menu, choose Terrain Model Explorer.

� Create a new surface if needed. For more information, see “Creating a New 
Surface” on page 619.

� Add the necessary surface data to the surface folders if needed. For more 
information, see “Creating Surface Data and Adding It to the Surface Folders” 
on page 625.
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� Right-click on the surface folder, for example , to display the 
shortcut menu.

� Click Build to display the Build dialog box.

� Click the Surface tab if it is not already active.

� Select the Build Watershed check box.

� If you are using contour data, then select the Minimize Flat Triangles Result-
ing from Contour Data check box. 

NOTE If surface data consists of contours, then it is highly recommended that 
you select the Minimize Flat Triangles Resulting From Contour Data check box if 
you are building a watershed. This minimizes the number of flat triangles on a 
surface. 

You must also select any other options on the Surface tab required to build 
the surface. For more information, see “Building a Surface” on page 620.

� Click the Watershed tab.

�� In the Minimum Depression Depth box, type the minimum depression 
depth that a depression must have in order to be included in the model. This 
depth is the difference in elevation between the lowest point(s) on the 
depression boundary and the bottom of the depression. 

This value is used to filter out any smaller depressions that may be in a larger 
watershed. Any depression that is not as deep as this minimum depth may 
be considered part of the larger watershed that it empties into.

For more information, see “Shallow Depressions” on page 719.

�� In the Minimum Depression Area box, type the minimum depression area 
that a depression must have in order to be included in the model. This area 
is in the current (square) units that AutoCAD Land Development Desktop is 
set to, either feet or meters. 

This value is used to filter out any smaller depressions that may be in a larger 
watershed. Any depression that is smaller in area than this minimum area 
may be considered part of the larger watershed that it empties into. 

�� Select or clear the Must exceed both minimum area and minimum depth 
check box:

� Select this check box to build the model by only including areas that 
match or exceed both the minimum depression depth and the minimum 
depression area. 

� Clear this check box to include a depression area if it matches or exceeds 
either the minimum depth or minimum area criteria. 
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�� Click OK to build the surface and the watershed model.

�� You can import the watershed boundaries into the drawing. For more infor-
mation, see “Importing the Watershed Boundaries into the Drawing” on 
page 713.

Creating a Watershed Model After Building 
the Surface

You can create a watershed model of the current surface after you build a 
surface. 

After the watershed is calculated, you can create polyline boundaries that 
delineate each different type of subarea (also known as catchment) for the 
surface by using the Import Watershed Boundaries command. 

Watershed data that is created is saved as <surface name>.hdm and is saved 
to the following folder:

c:\Land Projects R2\<project name>\dtm\<surface name> 

Two other files are also saved to this folder. Watershed boundary data is saved 
as <surface name>ws.bin and a text file that contains a list of the watersheds 
that were found is saved as <surface name>ws.txt.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface’s  folder.

� Select Calculate Watershed to display the Watershed Properties dialog box. 
For more information, see “Changing Watershed Properties” on page 709.

� Click OK.

The watershed model is calculated and the watersheds are listed on the right-
hand pane of the Terrain Model Explorer. For every watershed, the type and 
assigned number are listed. For an ambiguous watershed, the watershed into 
which it drains is also listed.

� You can import the watershed boundaries into the drawing. For more infor-
mation, see “Importing the Watershed Boundaries into the Drawing” on 
page 713.
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Importing the Watershed Boundaries into 
the Drawing

After you calculate the watersheds for a surface, you can import all of the 
watershed boundaries into the drawing as polylines or as solid fill areas. You 
can also display the watershed numbers if you import polyline boundaries.

NOTE To import individual watershed boundaries, use the Import Individual 
Watersheds command.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface’s  folder.

� Select Import Watershed Boundaries to display the Watershed Display 
Settings dialog box.

� Select or clear the Fill With Solids check box:

� Select this check box to fill the watershed areas with solids instead of cre-
ating polyline boundaries. This option creates solid areas using the color 
of the subarea layer. 

� Clear this check box if you want to create polyline boundaries that outline 
the watershed subareas.
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� To number the watersheds in the drawing, select the Display ID Numbers 
check box. This option numbers the watershed in the TIN triangle closest to 
the watershed’s centroid. 

NOTE If you select Fill With Solids check box, then you cannot see the water-
shed numbers. Clear the Fill With Solids check box if you want to view the water-
shed numbers.

� To erase the layers on which you have created previous watershed bound-
aries, select the Erase Previous Layers check box. Clear this check box if you 
do not want to erase the layers.

� Under Layers, select the default layer names for each watershed type. Each 
type of watershed is placed on a different layer, based on watershed types:

� Boundary Point: The layer for any watershed subarea that is categorized 
as a boundary point watershed. This region drains to a specific point on 
the boundary of the surface.

� Boundary Segment: The layer for any watershed subarea categorized as a 
boundary segment watershed. This region drains to an edge of the surface 
boundary.

� Depression: The layer for any watershed subarea categorized as a depres-
sion area watershed. This region does not drain off the surface.

� Flat Area: The layer for any watershed subarea categorized as a flat area 
watershed.

� Multi Drain: The layer for any watershed subarea categorized as a multi-
drain watershed. This region drains to two or more different regions.

� Multi-Drain Notch: The layer for any watershed subarea categorized as a 
multi-drain notch watershed. This region drains to two or more different 
regions from a flat notch in the surface.

TIP Use the LAYER command to make these layers different colors so you 
can easily determine what type of watershed boundary is represented.

For more information about each of these watershed types, see “Watershed 
Types” on page 716. 

� Click OK to import the watershed boundaries.
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Importing Individual Watershed Boundaries 
Into a Drawing

You can use the Import Individual Watersheds command to import water-
shed boundaries one-by-one.

NOTE To import all of the watershed boundaries at once, use the Import 
Watershed Boundaries command.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Right-click on the surface’s  folder.

� Select Import Individual Watersheds to display the Watershed Display 
Settings dialog box.

� Select or clear the Fill With Solids check box:

� Select this check box to fill the watershed areas with solids instead of cre-
ating polyline boundaries. This option creates solid areas using the color 
of the subarea layer. 

� Clear this check box to create polyline boundaries that outline the water-
shed subareas.

� To number the watersheds in the drawing, select the Display ID Numbers 
check box. This option numbers the watershed in the TIN triangle closest to 
the watershed's centroid. 

NOTE If you select Fill With Solids check box, then you cannot see the water-
shed numbers. Clear the Fill With Solids check box if you want to view the water-
shed numbers.

� To erase the layers on which you have created previous watershed bound-
aries, select the Erase Previous Layers check box. Clear this check box if you 
do not want to erase the layers.

� Under Layers, select the default layer names for each watershed type. Each 
type of watershed is placed on a different layer, based on watershed types:
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� Boundary Point: The layer for any watershed subarea that is categorized 
as a boundary point watershed. This region drains to a specific point on 
the boundary of the surface.

� Boundary Segment: The layer for any watershed subarea categorized as a 
boundary segment watershed. This region drains to an edge of the surface 
boundary.

� Depression: The layer for any watershed subarea categorized as a depres-
sion area watershed. This region does not drain off the surface.

� Flat Area: The layer for any watershed subarea categorized as a flat area 
watershed.

� Multi Drain: The layer for any watershed subarea categorized as a multi-
drain watershed. This region drains to two or more different regions.

� Multi-Drain Notch: The layer for any watershed subarea categorized as a 
multi-drain notch watershed. This region drains to two or more different 
regions from a flat notch in the surface.

TIP Use the LAYER command to make these layers different colors so you 
can easily determine what type of watershed boundary is represented.

� Click OK.

The following prompt is displayed:
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� Do one of the following to specify a watershed:

� Press ENTER and then click on a point on the surface to draw the water-
shed.

� Type Number and then type the number of the watershed you want to 
import.

�� Continue to specify watersheds by clicking on points or by typing numbers, 
and then press ENTER to end the command.

Watershed Types

AutoCAD Land Development Desktop distinguishes a number of types of 
watersheds. The watershed types are based on what type of drain target the 
watershed has. 

A drain target is the location where water flow stops or leaves the surface. 
Water that flows along a channel or across a surface triangle eventually flows 
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off the surface or it reaches a point from which there is no downhill direc-
tion. 

For each drain target of a surface, the Calculate Watershed command deter-
mines the region of the surface that drains to that target. This region is called 
the watershed for that drain target. 

Each watershed subarea that you delineate is categorized as one of the follow-
ing types, based on drain target. For each type of subarea, AutoCAD Land 
Development Desktop reports information about the subarea in the Terrain 
Model Explorer.

Boundary Point
If the downhill end of a channel edge is on the surface boundary, then water 
flowing through that channel continues off the surface. The boundary point 
is the lowest end of the channel. In the following illustration, point p5 is a 
boundary point, the drain target of the channel p7-p6-p5. 

If a watershed has this type of drain target, then it is called a boundary point 
watershed.

!������"�����
���
	��	���
�����
�#�

NOTE The “T” in the illustration indicates that the triangle was split between 
two watersheds because the water flowing across that triangle could go to either 
of two watersheds.
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Boundary Segment
If an edge on the surface boundary belongs to a triangle that slopes down 
toward that edge, then water flows off the surface all along that edge. A 
boundary segment is a connected sequence of such edges. 

In the following illustration, the edges p1-p2, p2-p3, and p3-p4 form a 
boundary segment. If a watershed has this type of drain target, then it is 
called a boundary segment watershed.
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NOTE The “T” in the illustration indicates that the triangle was split between 
two watersheds because the water flowing across that triangle could go to either 
of two watersheds.

Depression
If a point is at a lower elevation than all its neighboring TIN points, then 
when water flows to it, it has no downhill place to go. Similarly, a connected 
set of points that are at the same elevation and all of whose neighbors are at 
higher elevation, is a single drain target. A depression is any such set of 
points. 

In the following illustration, points p8 and p9 form a depression. If a water-
shed has this type of drain target, then it is called a depression watershed.
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NOTE The “T” in the illustration indicates that the triangle was split between 
two watersheds because the water flowing across that triangle could go to either 
of two watersheds.

Ambiguous Depression Watershed
A depression watershed can be ambiguous. A watershed is ambiguous if it 
doesn’t include any drain targets, but rain water falling on it can reach more 
than one drain target. An ambiguous depression occurs when the depression 
watershed depth is less than the threshold given to the Calculate Watershed 
command, but there are multiple neighboring watersheds at points of mini-
mum elevation on the boundary. 

When such a watershed fills to overflowing, water flows to all those neigh-
boring watersheds, so the Calculate Watershed command cannot merge it 
into any single one. Instead, the Calculate Watershed command keeps it as a 
separate watershed and lists the neighboring watersheds into which it will 
drain. 

Shallow Depressions
If a point is at a lower elevation than all its neighboring TIN points, then 
water that flows to it has no downhill place to go. Similarly, a connected set 
of points that are at the same elevation, and all of whose neighbors are at 
higher elevation, is a single drain target. A depression is any such set of 
points.
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The minimum depression depth is the difference between the points around 
a depression and the depression itself. The smaller this difference, the more 
quickly the depression fills and begins draining into neighboring watersheds.

If the depth of a depression watershed (defined as the difference in elevation 
between the lowest point on the boundary and the depression point) is less 
than this value, and if there is only one neighboring watershed at the 
point(s) of minimum elevation on the boundary, then the Calculate Water-
shed command considers the triangles draining to the depression point to be 
part of the neighboring watershed.

Flat Area Watershed
A flat area watershed is a watershed that has flat areas, and can be part of any 
type of watershed. A flat area is a connected set of triangles all of whose ver-
tices have the same elevation. Flat areas abut parts of the surface that slopes 
downhill. 

If for every edge on the boundary of a flat area, the opposing, non-flat trian-
gle slopes up from the edge, then the flat area is the bottom of a depression 
watershed, as shown in the following illustration:
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If some of the opposing, non-flat triangles slope down from the flat area 
boundary but all these flow to the same drain target, then the flat area is part 
of the watershed for that drain target, as shown in the following illustration 
for drain target A:
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In the following illustration, the flat area, plus whatever part of the surface 
flows down to it, becomes a flat area watershed. This watershed is ambiguous 
because water flowing through it can flow to more than one drain target. 
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Multi-Drain Watershed
One type of ambiguous watershed is called a Multi-Drain or Split Channel 
watershed.

In the following illustration, the channel edges e2 and e3 flow to different 
drain targets: 
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Then water flowing down edge e1 could eventually reach either of these 
drain targets. In a case like this, the Calculate Watershed command deter-
mines the region that flows to edge e1 and defines this region to be a multi-
drain watershed. 

The Calculate Watershed command also, in this situation, keeps track of the 
watersheds into which water from the multi-drain watershed might drain. 
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Multi-Drain Notch Watershed
A multi-drain notch watershed occurs where there is a notch in the surface, 
illustrated by the flat edge created between P1 and P2 in the following illus-
tration. This type of watershed is called a “multi-drain” notch because water 
flowing into the notch could drain to drain target A or drain target B.
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30Editing Surfaces

With the Edit Surface commands, you can edit the sur-

face after it is created. You have the option of importing 

the current Triangulated Irregular Network (TIN) surface 

into a drawing as 3D lines. You can also add and delete 

lines or points, change the elevations of surface points, 

minimize flat faces on a surface, and define or remove 

surface boundaries.

Using the Surface Border commands, you can create 2D 

or 3D line and 2D or 3D polyline surface borders.

In this chapter

� Editing Surfaces

� The Edit History of Surfaces

� Adding, Deleting, and Flipping 
TIN Lines on a Surface

� Adding Points to a Surface

� Changing the Elevations of 
Surface Points

� Adding Non-destructive 
Breaklines to a Surface

� Minimizing Flat Faces on a 
Surface

� Changing Surface Elevations

� Pasting Two Surfaces Together

� Defining or Removing Surface 
Boundaries

� Creating Surface Borders
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Editing Surfaces

After building a surface, you should review it for accuracy. If the triangula-
tion is incorrect, then you can add or delete Triangular Irregular Network 
(TIN) lines or flip triangle faces so the TIN lines follow ridges or depressions. 
You can add, delete, or edit points; add non-destructive breaklines; and 
change the elevation of the entire surface. 

To control triangulation, you can define surface boundaries and minimize 
the number of flat faces that are triangulated from contour data. If you have 
two or more surfaces that you want to join together, then you can paste one 
into the other.

All surface edits that you make to a surface are stored in the surface’s Edit His-
tory folder in the Terrain Model Explorer. Whenever you need to rebuild a 
surface after you edit it, you can apply the Edit History to the new surface so 
you don’t have to repeat the surface edits.

Surface editing commands work with the current surface. For more informa-
tion, see “Making a Surface Current” on page 694. You should set the current 
surface before selecting an editing command. To perform any of the line, 
face, or point edit commands on a surface you must import the surface as 3D 
lines.

After you edit a surface, you must save it to update the surface data file. For 
more information, see “Saving a Surface” on page 696. If you exit the draw-
ing without saving a modified surface, then you are prompted to save the 
surface.

Importing the Surface as 3D Lines

To edit a surface TIN, you must import the surface as 3D lines into the 
drawing.
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� From the Terrain menu, choose Edit Surface ➤ Import 3D Lines. 

� The following prompt is displayed:
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� Type Yes or No:

� Type Yes to erase the old surface view.
� Type No to keep previous surface lines in the drawing.



The Edit History of Surfaces | 727

The Edit History of Surfaces

When you use any surface editing command on a surface, the history of 
those commands is stored in the Edit History folder for the surface. You can 
delete items from the Edit History and you can reapply the edits to a surface 
when you rebuild the surface.

Deleting Edits from a Surface’s Edit History

You can delete an edit from the Edit History by selecting the name of the edit 
and pressing the DELETE key. When you delete an edit from the Edit History, 
it does not get reapplied to the surface the next time you build the surface. 

NOTE When you build a surface, the Apply Edit History check box on the Build 
dialog box must be selected in order to reapply the Edit History to the surface.
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� From the Terrain menu, choose Terrain Model Explorer. 

� Open the surface’s   folder. 

If you have made edits to a surface by using the Terrain ➤ Edit Surface com-
mands, then the Edit History folder contains a list of these edits.

� Select an edit to delete.

� Press the DELETE key on your keyboard.

The next time you build the surface and select the option to Apply Edit His-
tory, the edit that you deleted is not applied to the surface.

Adding TIN Lines to a Surface

You can add new lines to an existing surface by selecting the endpoints of the 
new line. By adding a new TIN line, you can modify the way the surface is 
triangulated. The endpoints of the new line must be located at the endpoints 
of other surface lines. The new line passes through one or more existing sur-
face lines. This forces the surface to re-triangulate in this area.
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� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.
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� From the Terrain menu, choose Edit Surface ➤ Add Line.

� Select the first point of the new line. This must be an existing point in the 
surface TIN.

� Select the second point of the new line.

� Press ENTER to end the command.

NOTE Use the Save command to update the surface data file with any edits 
you make. 

Deleting TIN Lines from a Surface

You can delete TIN lines from a surface. For example, if the model has lines 
on the perimeter that are long and narrow, then they might not be accurate 
for the surface and you should delete them. You can also delete surface lines 
within a pond or building foundation to create a void area, for example. By 
removing these lines, you can prevent contours from being drawn through 
the pond area.
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� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.

� From the Terrain menu, choose Edit Surface ➤ Delete Line.

� Select the line to delete.

� Press ENTER to end the command.

This command automatically removes lines from the model and changes the 
surface.

Flipping TIN Faces on a Surface

You can change the direction of two triangle faces in the surface model so 
that the triangle edges match ridges or swales. 

���������
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� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.

� From the Terrain menu, choose Edit Surface ➤ Flip Face. 
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� Select a triangle edge to flip.

� Press ENTER to end the command.

The following illustration shows the effects of the Flip Face command:
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Adding Points to a Surface

You can add points directly to the surface model with the Add Point com-
mand. 

WARNING! These points are not added to the Surface Point Data file. How-
ever, the edits are saved to the surface’s Edit History folder.
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� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.

� From the Terrain menu, choose Edit Surface ➤ Add Point.

� Select the location of the point.

NOTE You can insert points outside the surface border. 

� Type an elevation for the new point, then press ENTER.

� Press ENTER to end the command.

After you select the point, the surface triangulation is automatically updated.
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Deleting Points from a Surface

You can delete a point from a surface to remove inaccurate or unnecessary 
data.
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� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.

� From the Terrain menu, choose Edit Surface ➤ Delete Point.

� Select the point to delete. If you select a point from the screen, then the com-
mand automatically searches for an endpoint of a line.

� Press ENTER to end the command.

After you select the point, the surface triangulation is automatically updated.

Changing the Elevations of Surface Points

You can change the elevations of single or multiple surface points. To change 
the elevations of multiple points, draw a polyline border around the points 
you want to edit.
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� From the Terrain menu, choose Edit Surface ➤ Edit Point.

The following prompt is displayed:
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� Press ENTER to accept Single as the default.

� Select the point to edit. 

The command automatically searches for an endpoint of a line.

� Type the new elevation for the point.

� Select another point to edit or press ENTER to end the command.
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� From the Terrain menu, choose Edit Surface ➤ Edit Point.

The following prompt is displayed:
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� Type Multiple to edit multiple surface elevations.
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� Select the polyline border that surrounds the points to edit. 

The following prompt is displayed: 
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� Type one of the following to define how to change the elevations:

� Type Relative, and then type a relative change in elevation. For example, 
you can use this option to add 2 ft. to all elevations within the polyline.

� Type Absolute, and then type an absolute elevation. For example, you can 
use this option to make the entire surface within the polyline into a flat 
pad at elevation 100 ft. 

� Press ENTER to end the command.

Adding Non-Destructive Breaklines to a 
Surface

You can create a non-destructive breakline from an open or closed polyline. 
When you define a polyline as a non-destructive breakline, the program cre-
ates surface points at each vertex of the polyline and at each intersection of 
a surface triangle and the polyline. The new points create additional surface 
triangles. Non-destructive breaklines are often needed when deleting surface 
regions where a clean TIN edge does not exist. 

The program extracts the elevation of each new triangle from the original 
surface triangle, thus maintaining the integrity of the original surface. 
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� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.

� Draw the polyline that you want to define as a non-destructive breakline.

� From the Terrain menu, choose Edit Surface ➤ Nondestructive Breaklines.

The following prompt is displayed:
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� Type one of the following options:

� Type Entity, and then use any standard selection method to select 
polyline(s).

� Type Layer to select the objects by layer, and then select one polyline on 
the layer that has the polylines you want to select. 
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� Type Layer, and then press ENTER and type the layer name. 

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to draw temporary lines that show the changes made to the sur-
face triangulation. You can type REDRAW to remove these temporary 
lines from the screen.

� Type No if you do not want to view the re-triangulation.

The following illustration shows the effects of non-destructive breaklines:
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Minimizing Flat Faces on a Surface That is 
Generated from Contours 

The Minimize Flat Faces command on the Terrain menu checks each contour 
in the surface for any triangles that have either three points on the same con-
tour, or three points at the same elevation. The command eliminates any face 
found that fits this criteria. This command eliminates as many suspect faces 



Changing the Elevations of the Current Surface or Copying a Surface with a Relative

as possible, but some ambiguous cases may need manual intervention. 
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� From the Terrain menu, choose Edit Surface ➤ Minimize Flat Faces.

� If a surface already exists in your drawing, a prompt sequence similar to the 
following is displayed:
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� Type Yes or No:

� Type Yes to view the surface as temporary lines.
� Type No if you do not want to review the surface.

� Press ENTER to exit the command.

Changing the Elevations of the Current 
Surface or Copying a Surface with a Relative 
Elevational Change

The Raise/Lower Surface command changes surface elevations by adding or 
subtracting an amount from the existing elevation. A positive value increases 
the elevation; a negative value lowers elevation.
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� From the Terrain menu, choose Edit Surface ➤ Raise/Lower Surface.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to save the edits to a new surface. The New Surface dialog box is 
displayed.

� Type No to apply the elevational changes to the existing surface.
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� In the New Surface box, type a name for the surface.

� In the Description box, type an optional description for the surface.

� Click OK.

The following prompt is displayed:
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% Type the elevational value to add to, or subtract from, the surface:

� Type a positive value to increase the elevations.
� Type a negative value to decrease the elevations.

Pasting Two Surfaces Together

You can paste a surface into the current surface. For example, if you have a 
building pad model that you want to paste into a full site model, then you 
can set the full-site model current and then paste the building pad model 
into it. The building pad replaces that portion of the site model that it covers. 

NOTE Surfaces with void regions (areas where TIN lines have been deleted, 
like building footprints) cannot be pasted. 
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� Open the two surfaces you want to paste together. For more information, see 
“Opening an Existing Surface and Making It Current” on page 695.

� Set the current surface (the surface that you want to paste another surface 
into). In the previous example, this would be the full site model. For more 
information, see “Making a Surface Current” on page 694.

� From the Terrain menu, choose Edit Surface ➤ Paste Surface to display the 
Select Surface dialog box. This displays all open surfaces, other than the cur-
rent surface.
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� Select the surface to paste into the current surface.

� Click OK.

The surface you selected to paste is not modified and should be fully visible 
when the pasting is complete. The surface you pasted into is modified, and 
lines are edited to maintain the integrity of the surface you have pasted. 

Editing a Surface to Define or Remove 
Surface Boundaries

By defining boundaries, you can control where surface triangulation occurs. 
You can define two different types of boundaries: outer and interior. 

There can be only one outer boundary, which you define in the Terrain 
Model Explorer. The outer boundary defines the outer limits of the surface. 
An outer boundary is always a Show boundary, meaning that the TIN lines 
inside the boundary are visible, and the TIN lines outside the outer boundary 
are not visible. For example, the outer boundary prevents surface triangula-
tion from occurring outside the bounds of the survey. 

You can define multiple interior boundaries for a surface. Interior boundaries 
can be either Hide or Show boundaries. A Hide boundary hides the surface 
TIN inside the boundary. A Show boundary shows the surface TIN inside the 
boundary. For example, an inner boundary could prevent surface triangula-
tion from occurring within an area, such as a building.

When you want to work with the entire surface again, you can remove the 
boundaries.

Before you define the boundary, you must draw a closed polyline that sur-
rounds the area you want to show or hide. This polyline is used to define the 
boundary. To create a boundary at the limits of the surface, you can create a 
surface border using either the 2D or 3D polyline border commands, and 
then select it as a boundary. For more information, see “Creating Surface Bor-
ders” on page 738.

You can define boundaries in one of two ways:

� Before building the surface, you can create boundaries from within the 
Terrain Model Explorer.

� After building the surface, you can edit the surface by creating (or delet-
ing) boundaries. When you create (or delete) boundaries after building a 
surface, the surface is modified and the change is added to the Edit History 
of the surface. 
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For more information about the differences between these two methods, see 
“Methods of Creating Surface Boundaries” on page 674.

NOTE Hide boundaries mask the surface, but the surface is not deleted. The 
full surface remains intact. If there are surface TIN lines that you want to perma-
nently remove from the surface, then use the Delete Line command. For more 
information, see “Deleting TIN Lines from a Surface” on page 728.

Defining Surface Boundaries After Building a 
Surface

You can use boundaries to define the active area(s) of a surface. This lets you 
view only the surface area that is within the bounds of the survey, or hide 
surface areas, such as ponds. After you select the polyline, the Surface Bound-
aries command prompts for Show or Hide. 

� Show: Displays any face inside the polygon.
� Hide: Masks any face inside the polygon.
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� Draw the boundary as a closed polyline.

� From the Terrain menu, choose Edit Surface ➤ Surface Boundaries.

� Select the closed polyline.

The following prompt is displayed:
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� Type Add to add a new boundary to the surface definition.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to remove all existing boundary definitions and display all the 
faces that were visible after the surface was built without a boundary.

� Type No if you do not want to delete existing boundary definitions.

The following prompt is displayed:
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% Select a closed polyline.

The following prompt is displayed:
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& Type Show or Hide:

� Type Show to create the active surface area within the interior of the 
polyline, hiding the TIN lines that are outside the polyline.

� Type Hide to create the active surface area outside the polyline, hiding the 
TIN lines inside the polyline.

The following prompt is displayed:
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' Type Yes or No:

� Type Yes to create non-destructive breaklines along the edges of the 
boundary. This clips the triangle edges exactly where they cross the 
boundary.

� Type No if you do not want to make non-destructive breaklines along the 
boundary. This only affects those triangles that are completely within or 
outside of the boundary.

The following prompt is displayed:
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( Type Yes or No:

� Type Yes to import temporary vectors that show how the surface was mod-
ified.

� Type No if you do not want to review the surface.

TIP Re-import the surface as 3D lines to update the 3D lines that represent the 
surface. For more information, see “Importing the Surface as 3D Lines” on 
page 726.

Removing Surface Boundaries After Building a 
Surface

When you want to work with the entire surface again, you can remove all 
surface boundaries. The Remove All option of the Surface Boundaries com-
mand removes all surface boundaries, including the outer boundary. 
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� From the Terrain menu, choose Edit Surface ➤ Surface Boundaries.

The following prompt is displayed:

 �(���!������!		2��!		��
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� Type Remove All to remove all existing boundary definitions.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to create temporary vectors that show the surface triangulation 
after the boundary is removed.

� Type No if you do not want to create temporary vectors.

Creating Surface Borders

The Surface Border commands on the Terrain menu insert a border around 
the existing surface. Each command creates the border as specified by their 
names, including: 2D Lines, 3D Lines, 2D Polyline, and 3D Polyline.

Borders are created by default on layer SRF-BDR. For more information about 
changing this setting, see “Changing the Surface Display Settings” on page 
742.

Creating a 2D Line Surface Border

You can create a border that consists of 2D lines around an existing surface. 
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� From the Terrain menu, choose Surface Border ➤ 2D Lines.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to save the previous border.
� Type No to erase the previous border.

Creating a 3D Line Surface Border

You can create a border that consists of 3D lines around an existing surface.
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� From the Terrain menu, choose Surface Border ➤ 3D Lines.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to save the previous border.
� Type No to erase the previous border.

Creating a 2D Polyline Surface Border

You can create a border that consists of a 2D polyline.
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� From the Terrain menu, choose Surface Border ➤ 2D Polyline.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to save the previous border.
� Type No to erase the previous border.

Creating a 3D Polyline Surface Border

You can create a border that consists of a 3D polyline.
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� From the Terrain menu, choose Surface Border ➤ 3D Polyline.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to save the previous border.
� Type No to erase the previous border.
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31Displaying Surfaces

The Surface Display submenu provides commands that 

display the surface in different ways. You can view the 

surface TIN lines as temporary vectors, as 3D faces, or as 

a polyface mesh. Using either the Average or the Band-

ing Method, you can create 2D solids, 3D faces, or poly-

faces that show the elevations or slopes of a surface.

With the Surface Utilities commands, you can draw 

water drop paths on the current surface, or project lines.

In this chapter

� Display Commands

� Changing the Surface Display 
Based on Elevation Ranges

� Changing the Surface Display 
Based on Slope Settings

� Creating a Surface Grid of 3D 
Faces

� Creating a Surface Grid of 3D 
Polylines

� Using Surface Utilities
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Using the Surface Display Commands

So that you can better visualize the results of surface triangulation, AutoCAD 
Land Development Desktop provides several Surface Display commands you 
can use. For example, you can create 2D or 3D bands on a surface that show 
elevation ranges in different colors, making it easy to visually determine the 
surface’s elevations.

You can access the Surface Display commands from the Terrain menu and 
also from the Terrain Model Explorer. From the Terrain Model Explorer, right-
click on a surface folder and select a command from the Surface Display 
menu.

Changing the Surface Display Settings

By changing the Surface Display settings, you can control the layer on which 
surface faces, borders, and breaklines are created, whether or not skirts are 
created, and what the base elevation is. You can also define a vertical factor 
that exaggerates 3D faces and define a layer prefix. 
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� Do one of the following to display the Surface Display Settings dialog box:

� From the Terrain menu, choose Surface Display ➤ Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Surface Display and click the Edit Settings button.
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� In the Layer prefix box, type a surface layer prefix. This prefix applies to all 
the layers that may be created when using the Surface Display commands.

NOTE Type an asterisk in this box to set the prefix for all of the layers to the 
current surface name. For example, if you have a surface called EG, objects cre-
ated for this surface are placed on layers that start with EG. You can also type a 
value other than the surface name. 

� Type the surface layer name for the surface faces. By default, this layer is SRF-
VIEW.

NOTE The layer name should not exceed 255 characters. If the combined 
layer name exceeds 255 characters, the program truncates the prefix so that it 
fits 255 characters. 

� Type the layer name for the surface border. By default, this layer is SRF-BDR.

� Type the layer name for the breaklines. By default. this layer is SRF-FLT.

� Select the Create skirts check box to create vertical 3D faces from the border 
of the surface to the base elevation. 

� Type a base elevation. This must be a real number. The vertical base serves as 
a reference plane for the 3D skirts and the vertical factor. For 3D skirts, the 
base elevation is used to determine the elevation of the bottom of the 3D 
skirts. When the vertical factor is applied, the surface is scaled vertically from 
the base elevation.

� Type a vertical factor. This must be a real number. You can exaggerate the 
relief of a site by applying a vertical scale factor other than 1.0. The program 
finds the elevations of the 3D faces by applying the vertical scale factor to the 
difference between the real elevation and the base elevation, then adds the 
result to the base elevation.

� Click OK. 

Viewing the Surface TIN Lines as Temporary 
Vectors

To view the surface TIN lines, you can create temporary vectors that are 
erased when you use the REDRAW command, or a command that causes a 
REDRAW or REGEN to occur.
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� Do one of the following:
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� From the Terrain menu, choose Surface Display ➤ Quick View.
� Right-click on a surface folder in the Terrain Model Explorer and select 

Surface Display ➤ Quick View.

Viewing the Surface TIN Lines as 3D Faces

To view the surface TIN lines in 3D view, you can create 3D faces. If you select 
the Create skirts option in the Surface Display Settings dialog box, then skirts 
are also created.
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� Do one of the following:

� From the Terrain menu, choose Surface Display ➤ 3D Faces.
� Right-click on a surface folder in the Terrain Model Explorer and select 

Surface Display ➤ 3D Faces.

The Surface Display Settings dialog box is displayed. For more information 
on changing these settings, see “Changing the Surface Display Settings” on 
page 742.

� Click OK.

The following prompt is displayed if the Create Skirts option is selected in the 
Surface Display Settings:
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� Type Yes or No:

� Type Yes to erase any existing surface skirts.
� Type No to keep any existing surface skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to erase any existing 3D faces.
� Type No to keep any existing 3D faces.

TIP Use the Object Viewer command on the Utilities menu to view the surface 
in 3D.
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Viewing the Surface TIN Lines as a Polyface Mesh

You can create a polyface mesh that represents the surface TIN faces. A poly-
face is comprised of many 3D face objects but acts as one object when 
inserted into the drawing, so selecting one line highlights the entire mesh.

NOTE Skirts are not created for polyfaces. 
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� Do one of the following:

� From the Terrain menu, choose Surface Display ➤ Polyface Mesh.
� Right-click on a surface folder in the Terrain Model Explorer and select 

Surface Display ➤ Polyface Mesh.

The Surface Display Settings dialog box is displayed. For more information 
on changing these settings, see “Changing the Surface Display Settings” on 
page 742.

� Click OK.

The following prompt is displayed if the Create Skirts option is selected in the 
Surface Display Settings:
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� Type Yes or No:

� Type Yes to erase any existing surface skirts.
� Type No to keep any existing surface skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to erase any existing polyface.
� Type No to keep any existing polyfaces.

TIP Use the Object Viewer to view the surface in 3D.
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Changing the Surface Display Based on 
Elevation Ranges

To quickly determine the elevation ranges of a surface, you can create differ-
ent types of surface views.

� You can create 2D or 3D average views that use a centroid-averaging cal-
culation to determine which surface triangles belong in which elevation 
range. These options create sawtooth-looking ranges.

� You can create 2D or 3D banding views that split surface triangles based 
on elevation ranges to create smooth bands.

� You can create a polyface mesh that shows the surface elevation ranges in 
2D mesh view. This method uses the centroid-averaging calculation to 
determine which surface triangles belong in which elevation range.

The 2D options create solid colors that show the elevation ranges. The 3D 
options and the polyface option create wire frames that you must shade or 
render to view the elevation ranges as solid colors. 

As you view the results of these commands, you see bands or triangles drawn 
in different colors. This can be useful in identifying flood plains, mountain 
peaks, or low valleys. 

TIP To see the full effect of the Surface Display commands, you must select a 
different color for each elevation range. You can do this when you define the ele-
vation range settings or by controlling the layer color for each range that is cre-
ated.

Changing the Surface Elevation Shading Settings

You can specify which elevation ranges you want displayed when you use 
one of the Average or Banding commands to create 2D solids, 3D faces, or 
polyfaces.
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� Do one of the following to display the Surface Elevation Shading Settings dia-
log box:

� From the Terrain menu, choose Surface Display ➤ Elevation Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
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the Settings list, select Surface Elevation Shading and click the Edit 
Settings button.

� In the Layer prefix box, type a surface layer prefix. This prefix applies to all 
the layers that may be created when using the Surface Display commands. 

NOTE Type an asterisk in this box to set the prefix for all the layers created to 
the current surface name. You can also type a value other than the surface name. 
The surface layer name should not exceed 255 characters. If the combined layer 
name exceeds 255 characters, the program truncates the prefix so that it fits 255 
characters. 

� Select the Create skirts check box to create vertical 3D faces from the border 
of the surface to the base elevation. 

� Type a base elevation. This must be a real number. The vertical base serves as 
a reference plane for the 3D skirts and the vertical factor. For 3D skirts, the 
base elevation is used to determine the elevation of the bottom of the 3D 
skirts. When the vertical factor is applied, the surface is scaled vertically from 
the base elevation.

� Type a vertical factor. This must be a real number. You can exaggerate the 
relief of a site by applying a vertical scale factor other than 1.0. The program 
finds the elevations of the 3D faces by applying the vertical scale factor to the 
difference between the real elevation and the base elevation, then adds the 
result to the base elevation.

� Type the number of ranges, or use the slider bar to specify the number of ele-
vation ranges to create. This option designates how many ranges the Auto-
Range and User-Range options use.
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� Click one of the following to define the elevation ranges:

� Auto-Range: For more information, see the following section, “Defining 
the Auto-Range Elevation” on page 748.

� User-Range: For more information, see “Defining the User-Range Eleva-
tion” on page 749.

Defining the Auto-Range Elevation

� Complete steps 1–7 in the previous section, “Changing the Surface Elevation 
Shading Settings”.

� Click Auto-Range to display the Terrain Range Views dialog box. 

� In the Minimum box, type the minimum elevation you want to include in 
the range view. For example, if you want to create ranges that show the ele-
vations between 100 and 200 feet, then type 100.

� In the Maximum box, type the maximum elevation you want to include in 
the range view. For example, if you want to create ranges that show the ele-
vations between 100 and 200 feet, then type 200.

� Click OK.

The Surface Range Definitions dialog box is displayed. You can use this dialog 
box to control the beginning and ending elevations of the ranges, the range 
layers, and the range colors. The first column lists the range number. You can 
define up to 16 ranges each time you use this command.
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� In the Begin column, type the beginning value for the range. You can assign 
the beginning elevation for the respective range number. We suggest that the 
starting value of a range equal the ending value of the previous range.

� In the End column, type the ending value for the range. You can assign the 
ending elevation for the respective range number. We suggest that the end-
ing value of a range equal the starting value of the following range.

� In the Layer column, type the layer name for the range. 

� In the Color column, select a color for the range. You can either type the 
number of the color, or choose the color from the Select Color dialog box by 
clicking the box to the right of the number. If you set the colors to 0, then 
the ranges are created using the colors that are defined for each layer.

�# Click Next if you are defining more than five ranges.

�� Click OK.

Defining the User-Range Elevation

� Complete steps 1–7 in the previous section, “Changing the Surface Elevation 
Shading Settings”.

� Click User-Range to display the Surface Range Definitions dialog box. 
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The Surface Range Definitions dialog box controls the beginning and ending 
elevations of the ranges, the range layers, and the range colors. The first col-
umn lists the range number. You can define up to 16 ranges each time you 
use this command.

In the Surface Range Definitions dialog box, the first column displays the 
range number. You can define up to 16 ranges each time you use this 
command.

� In the Begin column, type the beginning value for the range. You can assign 
the beginning elevation for the respective range number. We suggest that the 
starting value of a range equal the ending value of the previous range.

� In the End column, type the ending value for the range. You can assign the 
ending elevations for the respective range number. We suggest that the end-
ing value of a range equal the starting value of the following range.

� In the Layer column, type the layer name for the range. 

� In the Color column, select a color for the range. You can either type the 
number of the color, or choose the color from the Select Color dialog box by 
clicking the box to the right of the number. If you set the colors to 0, then 
the ranges are created using the colors that are defined for each layer.

� Click Next if you are defining more than eight ranges.

� Click OK.

Creating 2D Solids Using the Average Method 
that Show the Elevations of a Surface

You can generate 2D solids that show elevations, using the Average Method. 
The color and layer that are assigned are determined by the elevation range 
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that the triangle falls in. The average elevation for each triangle is calculated 
and then drafted on the layer you define. 
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� From the Terrain menu, choose Surface Display ➤ Average − 2D Solids to dis-
play the Surface Elevation Shading Settings dialog box. 

For more information about changing these settings, see “Changing the Sur-
face Elevation Shading Settings” on page 746.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Elevation Shading Settings:

��������	�
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots 2D solids, and then displays the Range Statis-
tics dialog box. You can review the data in this dialog box and either create 
a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

� Click OK to return to the drawing.

Creating Legends that Explain Surface Views

The final option when creating an elevation or slope range map is to insert a 
legend that shows how the ranges were defined, such as which color each 
range uses. You can plot the legend on the drawing for future reference. 
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� Display the Surface Legend dialog box. This dialog box is displayed when you 
use the Average – 2D Solids command, for example.

� Type a Legend Title.

� Organize the data in columns 1 through 6 as you want to plot it:

� Color: Places the range’s color in the selected column.
� Layer: Places the range’s layer name in the selected column.
� Begin: Places the range’s beginning elevation (or slope) in the selected 

column.
� End: Places the range’s ending elevation (or slope) in the selected 

column.
� %: Places the range’s percent of the total surface model in the selected col-

umn. The percentage is based on all the faces that are in the defined range. 
This might not be the entire site. For example, you might have a site that 
ranges from 100' to 200'. When generating the range view, you might 
choose to include only the data between 150' and 170'. In this case, the 
percentage value relates to all surface area that falls into the 150' to 170' 
range. 

� Area: Places the range’s actual area in the selected column.
� None: Ends the legend at that column.

� Click OK.

� Select an insertion point for the legend.
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NOTE One field in the legend includes the percentage of overall range views 
that a specific range covers. This is useful in determining the percentage of a site 
that is suitable for development.

NOTE The insertion point of the legend is the midpoint of the legend's title. 
Text in the legend is drawn on the current layer. 

The following illustration shows a completed legend:
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Creating 3D Faces Using the Average Method 
that Show the Elevations of a Surface

You can generate 3D faces that show elevation ranges, using the Average 
Method. The color and layer that are assigned are determined by the eleva-
tion range that the triangle falls in. The average elevation for each triangle is 
calculated and then drafted on the layer you define. 
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� From the Terrain menu, choose Surface Display ➤ Average − 3D Faces.

The Surface Elevation Shading Settings dialog box is displayed. For more 
information, see “Changing the Surface Elevation Shading Settings” on page 
746.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Elevation Shading Settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
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� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots 3D faces on the correct layers, and then dis-
plays the Range Statistics dialog box. You can review the data in this dialog 
box and either create a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

� Click OK to return to the drawing.

The following illustration shows an example of the Average Method. Shades 
of gray have been substituted for colors:
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Creating a Polyface Using the Average Method 
that Shows Surface Elevations

You can create a polyface mesh from the existing surface, using the Average 
Method. The complete surface becomes one polyface mesh object.
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� From the Terrain menu, choose Surface Display ➤ Average − Polyface.

The Surface Elevation Shading Settings dialog box is displayed. For more 
information, see “Changing the Surface Elevation Shading Settings” on page 
746.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Elevation Shading Settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots a polyface mesh on the correct layer, and then 
displays the Range Statistics dialog box. You can review the data in this dialog 
box and you can create a legend or output the information to a text file.

� Click one of the following options:

� To File: .To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

� Click OK to return to the drawing.
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Creating 2D Solids Using the Banding Method 
that Show the Elevations of a Surface

You can create 2D solids that show the elevations of a surface by using the 
Banding Method. When a triangle spans an elevation range, the triangle is 
split along the range border.

The color and layer assigned to each solid is based on the elevation range.
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� From the Terrain menu, choose Surface Display ➤ Banding – 2D Solids.

The Surface Elevation Shading Settings dialog box is displayed. For more 
information, see “Changing the Surface Elevation Shading Settings” on page 
746.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Elevation Shading Settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots 2D solids on the correct layers, and then dis-
plays the Range Statistics dialog box. You can review the data in this dialog 
box and either create a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

� Click OK to return to the drawing.
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Creating 3D Faces Using the Banding Method 
that Show the Elevations of a Surface

You can create 3D faces that show the elevations of a surface by using the 
Banding Method. When a triangle spans an elevation range, the triangle is 
split along the range border.

The color and layer assigned to each 3D face is based on the elevation range. 
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� From the Terrain menu, choose Surface Display ➤ Banding – 3D Faces.

The Surface Elevation Shading Settings dialog box is displayed. For more 
information, see “Changing the Surface Elevation Shading Settings” on page 
746.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Elevation Shading Settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots 3D faces on the correct layers, and then dis-
plays the Range Statistics dialog box. You can review the data in this dialog 
box and either create a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

� Click OK to return to the drawing.
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Changing the Surface Display Based on Slope 
Settings

To quickly determine the slope ranges of a surface, you can create 2D solids, 
3D faces, or a polyface mesh. Each option creates color-coded triangles that 
represent the different slope ranges. The 2D solid option creates solid colors 
that show the slope ranges. The 3D face and polyface options create wire-
frames that you must shade or render to view the slope ranges as solid colors. 

You can also create arrows that indicate the slope of each triangle if you need 
to visualize the slope descent.

TIP To see the full effect of the Surface Display commands, you must select a 
different color for each slope range. You can do this when you define the slope 
range settings. As you view the results of these commands, you see groups of 
slope triangles drawn in different colors. This can be useful in identifying flat land 
masses, steep mountain faces, or smooth flowing terrain.

Changing the Surface Slope Shading Settings

You can specify which slope ranges that you want displayed when you use 
one of the slope shading commands to create 2D solids, 3D faces, or poly-
faces.
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� To display the Surface Slope Shading Settings dialog box, use one of the fol-
lowing methods:

� From the Terrain menu, choose Surface Display ➤ Slope Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Surface Slope Shading and click the Edit Settings 
button.
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� In the Layer Prefix box, type a surface layer prefix. This prefix applies to all 
the layers that may be created when using the Surface Display commands. 

NOTE Type an asterisk in this box to set the prefix for all the layers created to 
the current surface name. You can also type a value other than the surface name. 

� Select the Create skirts check box to create vertical 3D faces from the border 
of the surface to the base slope. 

� Type a base elevation. This must be a real number. The vertical base serves as 
a reference plane for the 3D skirts and the vertical factor. For 3D skirts, the 
base elevation is used to determine the elevation of the bottom of the 3D 
skirts. When the vertical factor is applied, the surface is scaled vertically from 
the base elevation.

� Type a vertical factor. This must be a real number. You can exaggerate the 
relief of a site by applying a vertical scale factor other than 1.0. The program 
finds the elevations of the 3D faces by applying the vertical scale factor to the 
difference between the real elevation and the base elevation, then adds the 
result to the base elevation.

� Type the number of ranges, or use the slider bar to specify the number of 
slope ranges to create. This option designates how many ranges the Auto-
Range and User-Range options use.

� Click one of the following to define the slope ranges:

� Auto-Range. For more information, see “Defining the Auto-Range Slope” 
on page 760.

� User-Range. For more information, see “Defining the User-Range Slope” 
on page 760.
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Defining the Auto-Range Slope
To define the auto-range slope

� Complete steps 1–7 in the previous section, “Changing the Surface Slope 
Shading Settings”.

When you click Auto-Range, the Terrain Range Limits dialog box is dis-
played. 

� Type the minimum and maximum slopes you want to include in the slope 
ranges.

� Click OK.

The Surface Range Definitions dialog box is displayed. You can use this dialog 
box to control the beginning and ending slopes of the ranges, the range lay-
ers, and the range colors. The first column lists the range number. You can 
define up to 16 ranges each time you use this command.

� In the Begin column, type the beginning value for the range. You can assign 
the beginning slope for the respective range number. We suggest that the 
starting value of a range equal the ending value of the previous range.

� In the End column, type the ending value for the range. You can assign the 
ending slopes for the respective range number. We suggest that the ending 
value of a range equal the starting value of the following range.

� In the Layer column, type the layer name for the range. 

� In the Color column, select a color for the range. You can either type the 
number of the color, or choose the color from the Select Color dialog box by 
clicking the box to the right of the number. If you set the colors to 0, then 
the ranges are created using the colors that are defined for each layer.

� Click Next if you are defining more than eight ranges.

� Click OK.

Defining the User-Range Slope
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� Complete steps 1–7 in the previous section, “Changing the Surface Slope 
Shading Settings”. 
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When you click User-Range, the Surface Range Definitions dialog box is dis-
played. You can use this dialog box to control the beginning and ending 
slopes of the ranges, the range layers, and the range colors. The first column 
lists the range number. You can define up to 16 ranges each time you use this 
command.

� In the Begin column, type the beginning value for the range. You can assign 
the beginning slope for the respective range number. We suggest that the 
starting value of a range equal the ending value of the previous range.

� In the End column, type the ending value for the range. You can assign the 
ending slopes for the respective range number. We suggest that the ending 
value of a range equal the starting value of the following range.

� In the Layer column, type the layer name for the range. 

� In the Color column, select a color for the range. You can either type the 
number of the color, or choose the color from the Select Color dialog box by 
clicking the box to the right of the number. If you set the colors to 0, then 
the ranges are created using the colors that are defined for each layer.

� Click Next if you are defining more than eight ranges.

� Click OK.

Creating 2D Solids that Show the Slopes of a 
Surface

You can generate 2D solids that show the slopes of a surface. The color and 
layer assigned to each solid is determined by the slope range each surface tri-
angle falls in.
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� From the Terrain menu, choose Surface Display ➤ 2D Solids.

The Surface Slope Shading Settings dialog box is displayed. For more infor-
mation, see “Changing the Surface Slope Shading Settings” on page 758.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Slope Shading settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots 2D solids on the correct layers, and then dis-
plays the Range Statistics dialog box. You can review the data in this dialog 
box and either create a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

NOTE One field in the legend includes the percentage of the overall range 
views that a specific range covers. This is useful in determining the 
percentage of a site that is suitable for development. 

� Click OK to return to the drawing.

Creating 3D Faces that Show the Slopes of a 
Surface

You can generate 3D faces that show the slopes of a surface. The color and 
layer assigned to each 3D face is determined by the slope range each surface 
triangle falls in.
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� From the Terrain menu, choose Surface Display ➤ 3D Faces.

The Surface Slope Shading Settings dialog box is displayed. For more infor-
mation, see “Changing the Surface Slope Shading Settings” on page 758.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Slope Shading settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.
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The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots 3D faces on the correct layers, and then dis-
plays the Range Statistics dialog box. You can review the data in this dialog 
box and either create a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

NOTE One field in the legend includes the percentage of the overall range 
views that a specific range covers. This is useful in determining the 
percentage of a site that is suitable for development. 

� Click OK to return to the drawing.

Creating a Polyface Mesh that Shows the Slopes 
of a Surface

You can create a polyface mesh that shows the slopes of a surface. The color 
of each mesh triangle is determined by the slope range each triangle falls in.
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� From the Terrain menu, choose Surface Display ➤ Polyface.

The Surface Slope Shading Settings dialog box is displayed. For more infor-
mation, see “Changing the Surface Slope Shading Settings” on page 758.

� Click OK.

The following prompt is displayed if the Create skirts option is selected in the 
Surface Slope Shading settings:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
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� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

The program creates and plots a polyface mesh, and then displays the Range 
Statistics dialog box. You can review the data in this dialog box and either 
create a legend or output the information to a text file.

� Click one of the following options:

� To File: To output the data. The Output Settings dialog box is displayed. 
For more information, see “Changing the Output Settings” on page 79.

� Legend: The Surface Legend dialog box is displayed. For more informa-
tion, see “Creating Legends that Explain Surface Views” on page 751.

NOTE One field in the legend includes the percentage of the overall range 
views that a specific range covers. This is useful in determining the 
percentage of a site that is suitable for development. 

� Click OK to return to the drawing.

Drawing Arrows on a Surface that Show Surface 
Slopes

You can show the slope of a surface by inserting arrows that point down the 
slope of each surface triangle. These arrows point in the downhill direction. 

NOTE Arrows that converge denote channels; arrows that diverge denote 
ridges. 
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� From the Terrain menu, choose Surface Display ➤ Slope Arrows.

The Surface Slope Shading Settings dialog box is displayed. For more infor-
mation, see “Changing the Surface Slope Shading Settings” on page 758.

� Click OK.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to erase any existing skirts.
� Type No to keep any existing skirts.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the Range View layers of any existing objects.
� Type No to keep any existing objects on the Range View layers.

� Type the scale factor for the arrow symbol.

The Range Statistics dialog box is displayed.

� Click OK.

The program places arrows on each triangle, and bases the color of each 
arrow on the slope ranges. The block that is inserted is named DTMARROW. 
You can modify this block.

The following illustration shows arrows pointing down the slope of a surface:
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Creating a Surface Grid of 3D Faces 

You can create a 3D face grid of the current surface at a grid spacing that you 
specify. 
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� From the Terrain menu, choose Surface Display ➤ Grid of 3D Faces.

� Specify the grid rotation angle by either picking two points or by typing an 
angle.

� Select the base point for the grid by either picking a location or by entering 
X and Y coordinates.

� Type the grid M spacing (the grid cell spacing in the M direction). The M 
direction corresponds to the X direction of a Cartesian plane. If a rotation 
exists in the plane, then the X axis is called the M axis. 

� Type the grid N spacing (the grid cell spacing in the N direction). The N direc-
tion corresponds to the Y direction of a Cartesian plane. If a rotation exists 
in the plane, then the Y axis is called the N axis. 

The following illustration shows the 3D grid parameters:
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� Select the upper-right limit of the grid. The snap is set to the size of the grid 
square for the selection of the upper-right corner.

One grid square and the extents of the grid are drawn so you can see the size 
of the grid.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to repeat steps 2 through 6 and change the size of the grid.
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� Type No to display the Surface 3D Grid Generator dialog box, where you 
can change the settings. For more information, see “Changing the Surface 
3D Grid Generator Settings” on page 768.

� After you finish changing the settings, click OK.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the grid layer of any existing objects.
� Type No to keep any existing objects on the grid layer.

If the 3D Skirts checkbox is on, the following prompt is displayed:
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�# Type Yes or No:

� Type Yes to clear the skirt layer of any existing objects.
� Type No to keep any existing objects on the skirt layer.

To view the grid in 3D, change the User Coordinate System (UCS) of the 
drawing by using either the VPOINT command or the Object Viewer.

The following illustration shows a 3D view of the surface grid:
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Changing the Surface 3D Grid Generator 
Settings

The Surface 3D Grid settings control how grids are created when you use the 
Grid of 3D Faces command on the Terrain ➤ Surface Display menu. 

The following illustration shows some of the 3D grid parameters:
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box. Under Program, select Land Development Desktop. In the Set-
tings list, select Surface 3D Grid. Click the Edit Settings button to display the 
Surface 3D Grid Generator dialog box.

� Select the Hold upper point check box if you want to pin the upper-right cor-
ner of the grid and adjust the cell size so that an even number of cells fit in 
each direction.

� Select 3D skirts if you want to show vertical faces on a surface that was cre-
ated using the object type of 3D faces. Turn this option off to suppress the 
creation of vertical faces around the exterior of the 3D grid.
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The following illustration shows skirts turned off and on:
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� In the Base elevation text box, the default is zero, but you can type a value to 
raise or lower the grid of polylines. This must be a real number.

� In the Vertical factor text box, type a value to exaggerate the surface vertically 
when using 3D lines or 3D faces as the object type. The exaggerated eleva-
tions are determined by subtracting the base elevation (minimum elevation 
if the base elevation is zero) from the elevation of the point and then apply-
ing the vertical scale factor (multiplying).

� Under M (x) Direction, do one of the following:

� Select Size and type a value in the Value box. The number you type for 
Value is interpreted as the spacing in the M direction. 

� Select Number and type a value in the Value box. The number you type 
for Value is interpreted as the number of cells in the M direction. 

The value in the Value box determines the cell size in decimal units in the M 
direction. This must be a real number. If the rotation angle on the grid is 0.0, 
M corresponds to the X direction. If the cell type is set to size, this number 
represents the spacing in the M direction. If the cell type is set to number, 
this number represents the number of cells in the M direction.

� Under N (y) Direction, do one of the following:

� Select Size and type a value in the Value box. The number you type for 
Value is interpreted as the spacing in the N direction. 

� Select Number and type a value in the Value box. The number you type 
for Value is interpreted as the number of cells in the N direction. 

The value in the Value box determines the cell size in decimal units in the N 
direction. This must be a real number. If the rotation angle on the grid is 0.0, 
N corresponds to the Y direction. If the cell type is set to size, this number 
represents the spacing in the N direction. If the cell type is set  to number, 
this number represents the number of cells in the N direction.
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� Under Number of facets per face, select either 1, 2, or 4 facets per 3D face.

The following illustration shows the different facet options:
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� In the Grid layer field, type the layer on which you want the 3D grid placed.

�# Click OK.

Creating a Surface Grid of 3D Polylines

You can create a 3D polyline grid of the current surface at a grid spacing that 
you specify. 
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� From the Terrain menu, choose Surface Display ➤ Grid of 3D Polylines.

� Specify the grid rotation angle by either picking two points or typing an 
angle.

� Select the base point for the grid by either picking a location or entering X 
and Y coordinates.

� Type the grid M spacing (the grid cell spacing in the M direction). The M 
direction corresponds to the X direction of a Cartesian plane. If a rotation 
exists in the plane, then the X axis is called the M axis. 

� Type the grid N spacing (the grid cell spacing in the N direction). The N direc-
tion corresponds to the Y direction of a Cartesian plane. If a rotation exists 
in the plane, then the Y axis is called the N axis. 

� Select the upper-right limit of the grid. The snap is set to the size of the grid 
square for the selection of the upper-right corner.

One grid square and the extents of the grid are drawn so you can see the size 
of the grid.

The following prompt is displayed:
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� Type Yes or No:
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� Type Yes to repeat steps 2 through 6 and change the size of the grid.
� Type No to display the Surface 3D Polyline Grid Settings dialog box, where 

you can change the settings. For more information, see “Changing the 
Surface 3D Grid Generator Settings” on page 768.

� After you finish changing the settings, click OK.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to clear the grid layer of any existing objects.
� Type No to keep any existing objects on the grid layer.

The following prompt is displayed:
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�# Type Yes or No:

� Type Yes to clear the skirt layer of any existing objects.
� Type No to keep any existing objects on the skirt layer.

To view the grid in 3D, change the User Coordinate System (UCS) of the 
drawing by using either the VPOINT command or the Object Viewer.

For an illustration of a 3D grid, see “Changing the Surface 3D Grid Generator 
Settings” on page 768.

Changing the Surface 3D Polyline Grid Settings

To change the surface 3D polyline grid settings 
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box.

� Under Program, select Land Development Desktop.

� In the Settings list, select Surface 3D Polyline.

� Click the Edit Settings button to display the Surface 3D Polyline Grid Settings 
dialog box.

� Select the Hold upper point check box if you want to pin the upper-right cor-
ner of the grid and adjust the cell size, so an even number of cells fit in each 
direction. 

� Under M (x) Direction, select the Draw in M (x) direction check box to gen-
erate cross sections in the M direction.
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� If you select the Draw in M (x) direction check box, then select either the Size 
or Number option:

� If you select Size, the number you type in the Value box is interpreted as 
the spacing in the M direction. 

� If you select Number, the number you type in the Value box is interpreted 
as the number of cells in the M direction. 

� Type a value in the Value box to determine the cell size in decimal units in 
the M direction. This must be a real number. If the rotation angle on the grid 
is 0.0, M corresponds to the X direction. 

� Under N (y) Direction, select the Draw in N (y) direction check box to gener-
ate cross sections in the N direction. 

� If you select the Draw in N (y) direction check box, then select either the 
Size or Number option:

� If you select Size, the number you type in the Value box is interpreted as 
the spacing in the N direction. 

� If you select Number, the number you type in the Value box is interpreted 
as the number of cells in the N direction. 

�# Type a value in the Value box to determine the cell size in decimal units in 
the N direction. This must be a real number. If the rotation angle on the grid 
is 0.0, N corresponds to the Y direction. 

�� In the M (x) direction layer text box, type the layer you want the polyline 
drawn in the M direction. 

�� In the N (x) direction layer text box, type the layer you want the polyline 
drawn in the N direction.

�� In the Base elevation text box, the default is zero, but you can type a value to 
raise or lower the grid of polylines. This must be a real number.

�� In the Vertical factor text box, type a value to exaggerate the surface vertically 
when using 3D lines or 3D faces as the object type. The exaggerated eleva-
tions are determined by subtracting the base elevation (minimum elevation 
if the base elevation is zero) from the elevation of the point and then apply-
ing the vertical scale factor (multiplying).

�� Click OK.

For an illustration of 3D grid parameters, such as M and N, see “Changing the 
Surface 3D Grid Generator Settings” on page 768. 
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Using Surface Utilities

You can use the Surface Utilities commands to visualize waterdrop paths, to 
project objects onto a 3D grid, and to view the surface along a polyline path 
or from a specified point. You can also label elevations of selected surface 
points.

Drawing Water Drop Paths on the Current 
Surface

You can trace the path that water would take across a surface by using the 
Water Drop command. This command draws a polyline that represents the 
water as it flows downhill. If the channel splits, then new polylines are drawn 
to follow each water drop path. 
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� Build the watershed model of the surface. For more information, see “Creat-
ing a Watershed Model When Building a Surface” on page 710.

NOTE This step is not required but it can make the waterdrop trails more accu-
rate. 

� From the Terrain menu, choose Surface Utilities ➤ Water Drop to display the 
Water Drop dialog box.

NOTE If the current surface is not selected, then the Select Surface dialog box 
is displayed. Select the surface and click OK.

� In the Water drop layer box, type the name of the layer for the water drop 
path, and then click OK to continue.

� Determine how you want to handle water drop paths by typing Yes or No:

� Type Yes to erase old water drop paths. 



776 | Chapter 31 Displaying Surfaces

� Type No to preserve existing water drop paths.

� Determine how you want to handle tick marks by typing Yes or No:

� Type Yes to place tick marks at the beginning of each path. 
� Type No to draw the polyline without tick marks. 

� Pick a point on a surface that represents the origin of the water drop path. 
This is the point where the water drop strikes the surface.

The Water Drop command draws the path the water would take across the 
surface.

� Pick the next water drop point, or press ENTER to end the command.

Projecting Lines, Curves, or Polylines into Three 
Dimensions

You can convert lines, curves, or polylines into three-dimensional objects by 
using the Object Projection command. This command creates 3D polylines 
from the objects that you select, and places them on the defined projection 
layer on the surface. 
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� (Optional) Construct a grid of 3D faces. For more information, see “Creating 
a Surface Grid of 3D Faces” on page 765. 

� From the Terrain menu, choose Surface Utilities ➤ Object Projection.

� Select the objects to project.

The Object Projection dialog box is displayed.

� Type the Projection Layer name for the new 3D objects.

� Click OK.

The following prompt is displayed:
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� Type Yes or No:

� Type Yes to delete all objects on the projection layer.



Using Surface Utilities | 777

� Type No to preserve all objects on the projection layer.

TIP Change the color of the projection layer to a color other than the grid of 
3D faces so you can see the projected objects.

The following illustration features objects projected onto a grid:
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Labeling the Elevation of a Surface Point

You can label different locations in a drawing with finished ground labels.

NOTE These labels are drawn on the FGLBL layer. 
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� From the Terrain menu, select Surface Utilities ➤ Label Spot Elevation.

The following prompt is displayed:
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� Do one of the following:

� Select a point in your drawing.
� Type Surface to display the Select Surface to Label dialog box. Select the 

surface and click OK. Then select the location you want to label. Surface 
statistics such as minimum and maximum elevations. The amount of sur-
face points that make up the surface are displayed in the Statistics area of 
the dialog box. The surface status—whether or not the surface is locked by 
another user—is also displayed. 

� Type the finished ground elevation.

NOTE If you chose a surface in step 2, then the elevation of the surface at the 
chosen location displays as a default. 

� Select a point for the end of the leader that points to the spot elevation label.

� Select additional leader points, if needed, and then press ENTER.

The following prompt is displayed:
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� Type the label rotation angle.

Labeling Slopes

With the Label Slope command, you can choose two methods for labeling a 
surface slope value with a text label and arrow. The Point-to-point method 
calculates the slope between two selected locations on the surface. The Spot-
label method calculates the slope value at a specific point on a TIN triangle. 

You can control the appearance of the label slope by changing the settings in 
the Slope Display Settings dialog box and using the current Dimension style 
settings for the arrow. The arrow is created using an AutoCAD leader.

The Label Slope command is available on the Terrain ➤ Surface Utilities 
menu as well as on the Surface Utilities toolbar.
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slope can’t be calculated at this location. The point selected is on an edge 
between two or more surface triangles so there are multiple solutions. Please 
select a different location.” If the point is not located on the current surface 
or is situated over a void in the surface, the following warning message is 
displayed: “An elevation could not be retrieved from surface <surface name> 
for the selected point.” In this case, the program cannot retrieve an elevation 
and displays the current surface name.

The command line sequence is then repeated, prompting you to select the 
first point.

� Type T for seTtings and press ENTER to display the Slope Display Settings 
dialog box. For more information, see “Changing the Slope Display Set-
tings” on page 782.

NOTE If you enter P at the command line, the program switches to the Point-
to-point method, prompting you to select two points on the surface between 
which to label the slope. For more information, see “Labeling the Slope Value 
Between Two Points” on page 779.

The program creates the arrow and text label, positioning them at the point 
you selected with the arrow pointing in the downhill flow direction. 

The Spot label method ignores the Full Length option that creates the arrow 
the entire distance between two points. If you have set this option in the 
Slope Display Settings dialog box, it will be substituted with the Text Length 
option. For more information, see “Changing the Slope Display Settings” on 
page 782.

� You can select another point, or press ENTER to exit the command.

Changing the Slope Display Settings
The Slope Display Settings dialog box controls how a slope value is displayed 
in your drawing when you use the Label Slope command on the Terrain ➤ 

Surface Utilities menu. You can use the current Dimension style settings to 
change the appearance of the arrow. For more information, see “Creating 
Dimensions” in the AutoCAD User’s Guide. 

NOTE The options are stored in the \Data\Labels folder in a file called “Slo-
peLabel<username>.dfm.” The user login name is appended to the filename to 
prevent people from changing each other’s settings in a multi-user environment.
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� Select the first point in your drawing. You can use Object Snaps to pre-
cisely select a location. 

NOTE If you selected a point precisely on the edge between two or more sur-
face triangles, the slope value and direction are plotted for one of the faces. The 
program searches the surface and uses the value of the first face it finds.

� Type T for seTtings and press ENTER to display the Slope Display Settings 
dialog box. You can position the arrow and text label using the settings in 
the Slope Display Settings dialog box and the current Dimension style set-
tings. For more information, see “Changing the Slope Display Settings” on 
page 782.

NOTE If you enter S at the command line, the program switches to the Spot 
Label method, prompting you to select a point on the surface where you want 
to label the slope. For more information, see “Labeling the Slope Value and 
Flow Direction on a Surface at a Specific Point” on page 780.

After you have selected the first point, the following prompt is displayed:
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� Select the second point and then press ENTER.

WARNING! If either of the two points you selected is not located over the 
current surface, or the point is situated over a void in the surface, then the pro-
gram cannot calculate an elevation. As a result, the following warning message 
is displayed: “An elevation could not be retrieved from surface <surface name> 
for the selected point.” The command line sequence is then repeated, prompt-
ing you to select the first point.

The program creates the arrow and text label at the midpoint of the two 
selected points.

� You can select another point, or press ENTER to exit the command.

Labeling the Slope Value and Flow Direction on a Surface at a 
Specific Point 
You can label a slope value and flow direction on a surface at a selected loca-
tion using the Spot-label method. The calculation is based on the slope of the 
individual surface triangle at that location. 

The label slope is created as static text, the value of which does not update 
based on changes to the surface. You can determine the appearance of the 
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label slope by using the Slope Display Settings dialog box and the current 
Dimension Style settings for the arrow. For more information, see “Changing 
the Slope Display Settings” on page 782.

The slope arrow is created as an AutoCAD leader and always points downhill 
in the flow direction. The slope value is labeled positive. 
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� Use the following AutoCAD dimension style variables to control the appear-
ance of the arrowhead:

� dimscale: The scale factor for the arrowhead.
� dimasz: The size of the arrowhead (scaled by dimscale).
� dimldrblk: The symbol that is used for the arrowhead.

NOTE If you use the AutoCAD DDIM command to override the dimension val-
ues, then the override values are used. For more information, see “Creating 
Dimensions” in the AutoCAD User’s Guide.

� Open an existing drawing.

� From the Terrain menu, choose Surface Utilities ➤ Label Slope.

NOTE If you haven’t already selected a current surface, the Select Surface dia-
log box is displayed. Use this dialog box to select a current surface. For more 
information, see “Making a Surface Current” on page 694. When you start a 
new AutoCAD session, the default is to label between two points. For more infor-
mation, see “Labeling the Slope Value Between Two Points” on page 779.

The following prompt is displayed:
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NOTE If the following prompt is displayed: Select first point or [Spot-label/
Options]: then you can type S to switch to the Spot-label method.

� Do one of the following: 

� Select a point in your drawing. You can use Object Snaps to precisely select 
a location. 

WARNING! If the point you selected is on the edge between two or more 
surface triangles, the following warning message is displayed: “The spot label 
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slope can’t be calculated at this location. The point selected is on an edge 
between two or more surface triangles so there are multiple solutions. Please 
select a different location.” If the point is not located on the current surface 
or is situated over a void in the surface, the following warning message is 
displayed: “An elevation could not be retrieved from surface <surface name> 
for the selected point.” In this case, the program cannot retrieve an elevation 
and displays the current surface name.

The command line sequence is then repeated, prompting you to select the 
first point.

� Type T for seTtings and press ENTER to display the Slope Display Settings 
dialog box. For more information, see “Changing the Slope Display Set-
tings” on page 782.

NOTE If you enter P at the command line, the program switches to the Point-
to-point method, prompting you to select two points on the surface between 
which to label the slope. For more information, see “Labeling the Slope Value 
Between Two Points” on page 779.

The program creates the arrow and text label, positioning them at the point 
you selected with the arrow pointing in the downhill flow direction. 

The Spot label method ignores the Full Length option that creates the arrow 
the entire distance between two points. If you have set this option in the 
Slope Display Settings dialog box, it will be substituted with the Text Length 
option. For more information, see “Changing the Slope Display Settings” on 
page 782.

� You can select another point, or press ENTER to exit the command.

Changing the Slope Display Settings
The Slope Display Settings dialog box controls how a slope value is displayed 
in your drawing when you use the Label Slope command on the Terrain ➤ 

Surface Utilities menu. You can use the current Dimension style settings to 
change the appearance of the arrow. For more information, see “Creating 
Dimensions” in the AutoCAD User’s Guide. 

NOTE The options are stored in the \Data\Labels folder in a file called “Slo-
peLabel<username>.dfm.” The user login name is appended to the filename to 
prevent people from changing each other’s settings in a multi-user environment.
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� Start a new AutoCAD session.

� From the Terrain menu, choose Surface Utilities ➤ Label Slope.

The Select Surface dialog box is displayed.

� Select a current surface. For more information, see “Making a Surface Cur-
rent” on page 694.

The following prompt is displayed:
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� Type T for seTtings and press ENTER. 

The Slope Display Settings dialog box is displayed.

� Under Display Type, select one of the following four formats to display the 
slope value:

� Select Percent if you want the slope value displayed as a percentage. For 
example, 2.00%. 

� Select Decimal if you want the slope value displayed as a decimal. For 
example, 0.02.

� Select Run:Rise if you want the slope value displayed as a ratio value. For 
example, 50:1. 

� Select Rise:Run if you want the slope value displayed as a ratio value. For 
example, 1:50.

� Under Precision, each display format supports its own display precision 
value. Adjust these precision values if needed. Under Preview, a preview value 
shows the format and precision.
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� Under Text Label, do the following to establish settings to control the cre-
ation of the slope text label: 

� From the Text Style list, select a defined text style for the label. If you select 
*Current*, then any time you label a slope value using this style, the label 
is created using the current text style.

� In the Height box, the height value is displayed if the text style has a fixed 
height. You cannot edit a fixed text style height. If the text style has a zero 
height, then you can set the text height using the Height box.

� From the Text Layer list, you can either select a defined layer in the current 
drawing, or select *Current* to create a label using the current layer name. 
You can also type a new layer name and the program will create the layer 
automatically when the label is added to the drawing.

� Under Arrow Length, select one of the following arrow lengths: 

� Select Full Length if you want the arrow the same length as the distance 
between the two selected points. 

� Select Text Length if you want the arrow the same length as the slope text 
label.

� Select Fixed Length if you want to enter a fixed length for the arrow based 
on the current drawing units.

NOTE The Full Length option does not apply to the Spot-label method. If 
you set this option to Full Length when a spot label is created, the program 
automatically uses the Text Length option.

In the case where a leader is too short to accommodate an arrowhead of 
the size specified by the DIMASZ setting, the Label Slope command will 
automatically resize the arrowhead to a size that will fit given the length 
of the leader. 

If you have leaders of differing length in your drawing and you need a uni-
form arrowhead size, set the DIMASZ setting to a value that will accom-
modate the minimum leader length.

� Under Arrow Label, do the following to control the characteristics of the 
arrow label:

� From the Arrow Position list, select either On Reference Line, Above Ref-
erence Line, or Below Reference Line to establish the arrow position in 
relation to the vector defined by the two selected points. For the Spot 
Label method, the flow direction is the reference line.

� From the Text Position list, select either Above Arrow or Below Arrow to 
position the text in relation to the arrow. 
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� From the Arrow Layer list, you can either select a defined layer in the cur-
rent drawing, or select *Current* to create a label using the current layer 
name. You can also type a new layer name and the program will create the 
layer automatically when the label is added to the drawing.

�# Click OK to exit the dialog box and save the changes.

The following illustration shows text in relation to the arrow and the arrow 
in relation to points:
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Viewing the Surface from a Specified Point

You can establish a line of sight between a fixed position and a target and 
then place the drawing in a selected dynamic view or view point. The eleva-
tions of the current surface are used, and the current base elevation and ver-
tical exaggeration are applied.

You will be prompted for an initial position (camera point), a height at that 
position, a target, and a height at that target. The heights you enter are rela-
tive to the current surface. 
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� From the Terrain menu, choose Surface Utilities ➤ Line of Sight.

� Select a point on the surface for the camera. 

� Type the height of the camera. This is the height of the camera above the sur-
face in real units.
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NOTE The Line of Sight command uses the current vertical exaggeration after 
you enter the camera and target heights.

� Select a target point.

� Type the height of the target. This is the height of the target above the surface 
in real units.

The Surface Line of Site dialog box is displayed. 

This dialog box shows the Line of Site Statistics. Here you can view informa-
tion about the selected camera, target, and surface. The camera and target's 
X and Y coordinates, and elevation are reported as well as the distance 
between the two. 

� The critical point defines the closest surface point to the line of sight 
between the camera and target. The critical point indicates whether there 
is an obstruction between the camera point and the target point. 

� The distance is the distance to the obstruction (or to the target if there is 
no obstruction). 

� The clearance is the vertical clearance or distance above the point or the 
depth of the obstruction. If the clearance is a negative number, then the 
camera cannot see the target as it is set up. 

� You can adjust the position and height of the camera and target by doing the 
following:

� If you want to adjust the position and height of the camera, then click the 
Camera button, and then select a new position for the camera and define 
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a new camera height. After you make changes, the dialog box displays the 
new information calculated.

� If you want to adjust the position and height of the target, then click the 
Target button, and then select a new position for the target and define a 
new target height. After you make changes, the dialog box displays the 
new information calculated.

� Select one of the following options to see the model in 3D space:

� Vpoint: changes the view to the viewpoint shown in the Horizon Statis-
tics dialog box. This activates the VPOINT command.

� Dview: changes the view as selected by the camera and target by using the 
DVIEW command.

NOTE If you use the Vpoint or Dview options, you can return your drawing 
view to plan view by typing PLAN, and then typing current.

The following illustration shows the line of sight parameters:
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Viewing the Surface Along a Polyline Path

You can view the surface along a polyline path by using the Fly By command. 
A polyline must exist in the drawing to use this command. This polyline 
defines the viewing path.
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� From the Terrain menu, choose Surface Utilities ➤ Fly By. 

� Select the polyline that you want to view the surface along.

The Surface Fly By dialog box is displayed.
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� Select one of the following Fly by types:

� Select Follow path to place the camera and target at each successive vertex 
on the polyline path, creating a slide for each position. The following 
illustration shows a follow path fly by:

� Select Fixed target to move the camera along the polyline path while keep-
ing the target at a selected point. The following illustration shows a fixed 
target fly by:
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� Select Fixed camera to move the target along the polyline path while 
maintaining the camera at a fixed location. The following illustration 
shows a fixed camera fly by:

� Select one of the following Viewpoint Types:

� Select Vpoint if you want the Fly By command to use the AutoCAD 
VPOINT command when creating the slides or named views.

� Select Dview if you want the Fly By command to use the AutoCAD DVIEW 
command when creating the slides or named views.

� Select one of the following View Types: 

� Select Shade if you want the Fly By command to shade the surface model 
when creating the slides or views, using the AutoCAD SHADE command.

� Select Hide if you want the Fly By command to hide the surface model 
lines when creating the slides or views, using the AutoCAD HIDE com-
mand.

� Select None if you want the Fly By command to capture the slides or views 
of the surface model as it currently exists.

� Type a Camera height. This height is above the surface elevation at the 
selected camera point and is vertically exaggerated after the height is 
selected.

� Type a Target height. This height is above the surface elevation at the selected 
target point and is vertically exaggerated after the height is selected.

� Type the Output prefix for the slides. When the slides are created, they are 
named using the output prefix and numbered sequentially.

� Select one of the following Output Types: 

� Select Slide to create a slide for every stop along the polyline. You can view 
the slides using the AutoCAD VSLIDE command.
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� Select View to create an AutoCAD view for every stop along the polyline, 
which can be displayed to the screen using the Restore option of the 
AutoCAD VIEW command.

�# Click OK to proceed.

� If you selected Follow path as the Fly by type, then the slides or views are 
created.

� If you selected Fixed target as the Fly by type, then choose the target point. 
� If you selected Fixed camera as the Fly by type, then choose the camera 

point.

The command creates slides or named views, depending on the Output type 
you selected. You can restore the named views by using the Restore option of 
the AutoCAD VIEW command. You can view the slides using the AutoCAD 
VSLIDE command. 
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32Creating and Managing 
Contours

The Contour commands create, edit, and label con-

tours. Using these commands, you can create contours 

from a surface, digitize contours, assign elevations to 

contours, and weed contours to remove and add points.

In this chapter

� Creating and Managing 
Contours

� Using the Contour Style 
Manager

� Managing Contour Styles

� Creating Contours From a Built 
Surface

� Creating Contours From a 
Surface

� Labeling Contours

� Using Contour Utilities to 
Create and Edit Contours

� Digitizing Contours

� Changing Contour Elevations

� Creating Contours by Copying 
and Offsetting
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Creating and Managing Contours

You can use contours during different phases of the design process:

� Contours can be used as data for building surfaces.
� Contours can be generated from a surface.

Contours can consist of polylines or contour objects. For more information, 
see “Advantages of Using the Contour Object” on page 792. To create con-
tours to use as surface data, you can convert polylines to contours, digitize 
contours, and assign elevations to existing polylines. You can also copy and 
offset existing contours.

To create contours from a surface, you can define contour styles and generate 
major and minor contours that mark the elevational changes of the surface 
at specified intervals. Contour and contour label appearance is controlled by 
Contour Styles. Styles control smoothing, label display, label position, and 
other options.

Advantages of Using the Contour Object

AutoCAD Land Development Desktop creates contours that are AutoCAD 
objects rather than polylines. This has several advantages: 

� Smaller drawing size. The contour object definition is much more com-
pact than the polyline representation of a contour.

� Improved speed for contour creation, redraw, and regeneration. 
� Context-sensitive shortcut menu that you can open by clicking the right 

mouse button.
� Better listing capabilities. You see only the information that is relevant to 

each AEC contour, such as elevation and layer, not a listing for every con-
tour vertex.

� Dynamic labeling capabilities. You can edit the contour and the label is 
automatically updated. 

� Better display control. When adjusting the view orientation of the draw-
ing using DVIEW twist, the contour label still appears to be upright as 
opposed to being upside down.

� More intuitive editing. If you delete a label, the gap in the contour is elim-
inated. 

To create contour objects from existing polylines in your drawing, use the 
Convert Polylines command. For more information, see “Converting 
Polylines to Contours” on page 817.
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To share your drawing with someone who is not using AutoCAD Land Devel-
opment Desktop, you can use the EXPLODE command to convert the AEC 
contours to lightweight polylines. For more information, see “Exploding 
Contours to Polylines” on page 817.

Using the Contour Style Manager

You can use the Contour Style Manager to change contour style settings and 
to create, edit, and manage contour styles and to change contour properties. 

When you select the Contour Style Manager command from the Terrain 
menu, you can set up styles based on the contour settings. Contour Styles 
control how contours and contour labels appear on screen. For example, you 
can use the Contour Style Manager to apply smoothing to contours and to 
turn off the display of contour labels.

You can also access the Contour Style Manager by selecting a contour, right-
clicking to display the shortcut menu, and then selecting Contour Properties. 
When you access the Contour Style Manager using this method, the changes 
you make are applied directly to the contour(s) you selected. For example, 
you can use the Contour Properties command to turn off or show contour 
labels and grips on existing contours, or to smooth existing contours. 

NOTE A contour’s color and linetype are controlled by the layer on which the 
contour is drawn. 

Changing the Contour Appearance Settings

Using the Contour Style Manager dialog box, you can change the contour 
appearance settings. These settings include how the contours are smoothed, 
and how contours and labels are displayed in the drawing.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.
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� Click the Contour Appearance tab.

The name of the current contour style is listed at the top of the property 
sheet.

TIP To create a new style, click the Manage Styles tab and type a name for the 
new style in the Contour Styles in Drawing box, and then click Add.

� Under Contour Display, select one of the following options:

� Contours and Grips: To display contours with a grip at each vertex that 
you can use to edit the contours.

� Contours Only: To display contours without a grip at each vertex.

NOTE It is easier to edit contour labels if contour grips are turned off. Also, 
in complex drawings, selecting Contours Only improves selection speed. 

� In the Line Width box, type the line width to use for the contours. You may 
want to make the line width greater than 0 if you intend to plot the contours. 
This makes all contours use the defined width. To control minor and major 
contours, you can control the plotted contours by defining specific layer col-
ors and correlating the plotting pen width.

NOTE This option affects only non-smoothed contours and contours 
smoothed with Add Vertices smoothing. It does not affect spline-smoothed 
contours.
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� Under Label Display, select one of the following options:

� Labels and Grips: To create labels with grips that you can use to edit the 
labels. By using the grips, you can slide the labels to different locations 
along the contour.

� Labels Only: To create labels without grips.
� Labels Off: To suppress the display of labels for the contour style. 

NOTE If you create contours using a contour style that uses the Labels Off 
option, then you cannot see any contour labels if you label the contours. You 
can edit the style to turn labels on. 

� Under Smoothing Options, select one of the following options:

� No Smoothing: If you do not want to smooth the contours.
� Add Vertices: To add vertices along the contours. This option supple-

ments points on the contours when smoothing them to give them a more 
noticeably curved appearance, while still maintaining the highest level of 
integrity relative to the surface.

� Spline Curve: To pass a spline curve through the contour points. This 
gives the smoothest contour representation.

� If you selected Add Vertices, then use the slider to increase the smoothing (or 
decrease existing smoothing). 

NOTE You cannot adjust the level of smoothing when you select the Spline 
Curve option. 

� Click OK.

The following illustration features smoothed contours:
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Changing the Contour Text Style Settings

Using the Contour Style Manager dialog box, you can change the contour 
text style settings for contour labels. These settings include text style, color, 
and height, the suffix and prefix for contour labels, and label precision.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Text Style tab.

� From the Style list, select a text style to use for contour labels.

TIP You can choose Current to always create labels using the current text style.

� Click the Color box to display the Select Color dialog box.

� Select a color for the labels.

NOTE Contours are drawn on a user-defined layer. You can control the con-
tour color and linetype by using the AutoCAD layer functions. The contour label 



Using the Contour Style Manager | 797

is part of the contour and therefore is on the same layer. The label color option 
allows you to independently control the color of the labels for display and plot-
ting purposes. 

� Click OK to return to the Text Style property sheet.

� From the Prefix list, you can select a label prefix. Defaults include EL and 
ELEV=. You can also type a different prefix in the Prefix box.

� From the Suffix box, you can select a label suffix. Defaults include ', FT, ft, 
and  m.

� If you select a zero-height text style, then type a text height in the Height 
box.

�� In the Precision box, select a precision for the contour labels.

�� Click OK.

NOTE Remember that these changes affect all contours that are drawn with 
the same contour style. 

Changing the Contour Label Position Settings

Using the Contour Style Manager dialog box, you can change the contour 
label position settings. The Label Position tab in the Contour Style Manager 
includes entries for the orientation, readability, and border of the contour 
labels in the drawing. 
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.
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� Click the Label Position tab.

� Under Orientation, select one of the following label positions:

� Above Contour: Calculates the actual offset by multiplying the label’s 
text height by the offset value. You can specify the offset of the label by 
typing a value in the Offset box. 

� Below Contour: Calculates the actual offset by multiplying the label’s 
text height by the offset value. You can specify the offset of the label by 
typing a value in the Offset box. 

� On Contour: Breaks the contour lines where the label is located. You may 
want to select the Break Contour For Label check box. The contour is still 
one object if you select this option.

� Under Readability, select one of the following options:

� Make Plan Readable: To orient the label text so that it is legible in plan 
view.

� Label Positive Slope: To orient the label text so that the top of the text is 
always positioned in the uphill direction. By using this option, the label 
text indicates the slope of the surface.

� Under Border Around Label, select one of the following options:

� Rectangular: To insert a rectangular border around contour labels.
� Round Corners: To insert rectangles with rounded corners around con-

tour labels.
� None: To insert no label borders.

� Click OK.
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The following illustration features the different contour label borders:
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Managing Contour Styles

You can use the Contour Style Management options to create new contour 
styles, delete contour styles, and to save contour styles to the Contour Style 
folder so that the styles can be used in other drawings and projects. Because 
settings are adjusted and saved only in the current drawing, you must save 
the contour styles to the External Contour Style folder in order to use them 
in other drawings. To use contour styles in the Contour Style folder, you must 
load them into your drawing.

NOTE After you create the contour style files using Release 2 of AutoCAD Land 
Development Desktop, the contour style files may not be used with any prior 
version of AutoCAD Land Development Desktop.

Creating a New Contour Style
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.



800 | Chapter 32 Creating and Managing Contours

� Use the tabs on the dialog box to set up the style you want to save.

� Click the Manage Styles tab.

� In the Contour Styles in Drawing box, type the name of the style you want 
to save.

 

This name cannot have any spaces in it.

� Click Add.

� Click OK.

Selecting the Current Contour Style
When you use the Contour Style Manager to edit contour styles, be aware 
that the edits you make are to the current contour style only. The current 
contour style is displayed at the top of the Contour Appearance, Text Style, 
and Label Position tab in the Contour Style Manager. 

When you edit a contour style, the contours in the drawing that were created 
with that contour style are updated automatically. No other contours are 
affected.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
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� From the Projects menu, choose Data Files to display the Edit Data Files 
dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Manage Styles tab.

� From the Contour Styles in Drawing list, select the style you want to make 
current.

Deleting a Contour Style from the Current Drawing
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Manage Styles tab.

� In the Contour Styles in Drawing list, select the style you want to delete.

� Click Remove.

� Click OK.

NOTE If you attempt to delete a contour style that is being used by any con-
tours in the drawing, then you are not allowed to remove the style. 

Saving Contour Styles to the Contour Style Folder
To use a contour style with another drawing, you must save the contour style 
to the contour style folder.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
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Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Manage Styles tab.

� In the Contour Styles in Drawing list, select the contour style you want to 
save to the contour style folder.

� Click Save to add the style to the Contour Style Directory list.

� Click OK.

Deleting Contour Styles from the Contour Style Folder
You can delete any contour styles that you have saved to the contour style 
folder. If you delete a style from this folder, then it is unavailable to use in 
other drawings.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Manage Styles tab.

� In the Contour Style Directory list, select the contour style you want to delete 
from the folder.

� Click Delete.

� Click OK.

NOTE This command does not delete the style that exists in the drawing. 

Renaming Contour Styles in the Contour Style Directory
You can rename any contour style that is saved to the contour style folder. 
This does not affect the name of the style in the current drawing.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
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� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Manage Styles tab.

� In the Contour Style Directory list, select the contour style that you want to 
rename.

� Click the Rename button to display the Rename a Contour Style dialog box.

� In the File name box, change the style’s name.

� Click Save.

� Click OK.

Loading Contour Styles into a Drawing
To use any of the contour styles that are located in the contour style folder 
but are not in the current drawing, you must load the contour styles into the 
drawing.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.
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� Click the Manage Styles tab.

� In the Contour Styles Directory list, select the contour style you want to load 
into the current drawing. Only one style can be loaded at a time.

� Click the Load button.

The contour style displays in the Contour Styles in Drawing list.

� Click OK.

Changing the Contour Styles Path
By changing the contour styles path, you can choose the folder in which to 
save contour styles and from which to load contour styles.
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� Do one of the following to display the Contour Style Manager dialog box:

� From the Terrain menu, choose Contour Style Manager.
� Select a contour, right-click and select Contour Properties.
� From the Projects menu, choose Data Files to display the Edit Data Files 

dialog box. Under Program, select Land Development Desktop. From the 
Data Files list, select Contour Style Manager, and click the Edit Settings 
button.

� Click the Manage Styles tab.

� Click Browse to display the Browse for Folder dialog box.

� Select the folder for the contour styles.

� Click OK to return to the Contour Style Manager dialog box.
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Creating Contours From a Built Surface

You can create contours from either a terrain or volume surface that you have 
built. When you create contours from a surface, you can specify the elevation 
range for the contours, the vertical exaggeration, the contour intervals, and 
the contour style to use.

You can quickly edit the contours you create by using grips and by using the 
Contour Properties shortcut command, and you can create labels for the con-
tours at their ends or at selected locations.

Creating Contours From a Surface

You can create contour objects in a drawing that represent the contours 
across your site. For more information, see “Advantages of Using the Contour 
Object” on page 792. The Create Contours command uses a specified contour 
style to determine contour appearance.
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� Build a surface. For more information, see “Building a Surface” on page 620.

� From the Terrain menu, choose Create Contours to display the Create Con-
tours dialog box. 

� From the Surface list, select the surface that you want to create contours for. 
If the surface name is not displayed in the list, then click Browse to search for 
it. Surfaces have the file extension .tin.
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� Under Elevation Range, define the range of the surface’s elevation for which 
to create contours by entering values in the From and To boxes. The low and 
high elevations of the surface are displayed as defaults.

TIP If you change the Elevation Range, then you can return to the default 
range by clicking the Reset Elevations button.

To exaggerate the elevational changes of the contours when you look at them 
in 3D, enter a value other than 1 in the Vertical Scale box.

NOTE If you exaggerate the vertical scale, the contours are drawn at an exag-
gerated elevation and are therefore incorrect when labeling or as a basis for 
future TIN creation. 

� Under Intervals, select one of the following options:

� Both Minor and Major
� Minor Only
� Major Only

� Define the contour intervals by entering values in the Minor Interval and 
Major Interval boxes. For example, if you enter a minor interval of 2, and 
your drawing units are meters, then a minor contour is created every place 
there is a 2-meter change in elevation.

� Specify the layers for the major and minor contours. By placing the minor 
and major contours on different layers, you can easily control the contour 
colors and linetypes. You can select a layer or type in a new layer name.

� Under Properties, select one of the following options:

� Contour Objects: To create contour objects. For more information, see 
“Advantages of Using the Contour Object” on page 792.

� Polylines: To create polyline contours.

NOTE If you select the Polylines option, then you cannot select a contour 
style to use. 

� From the Contour Style list, select the contour style to use for the contours.

TIP Click the Preview button to see a preview of the contour style.
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�� If you need to load a contour style, edit a style, or create a new style, then 
click the Style Manager button to display the Contour Style Manager dialog 
box. For more information, see “Managing Contour Styles” on page 799.

�� Click OK to generate the contours.

The following prompt is displayed:
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�� Type Yes or No:

� Type Yes to erase any existing contours that may be present on the con-
tour layers.

� Type No to preserve existing contours.

WARNING! If you type Yes to erase the old contours, then existing contours 
on both the major and minor contour layers are erased. When you develop grad-
ing plans, pay attention to the layers that the Create Contours command uses 
so that your existing ground contours are not erased.

The following illustration shows contours over a surface:
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Changing Contour Properties

You can smooth selected contours, and show label grips and contour grips, 
by modifying the contour properties.
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� Select one or more contours in the drawing.

� Right-click to display the shortcut menu.

� Select Contour Properties to display the Contour Style Manager dialog box. 
For more information, see “Using the Contour Style Manager” on page 793.

Showing or Hiding Contour Grips

You can show or hide the grips on a contour. When you click a contour to 
select it, grips are displayed at each contour vertex, and the contour is high-
lighted. You can select a grip to edit the contour.

NOTE Sometimes the contour grips can interfere with the label grips when 
you edit a label. Turn them off when you grip edit contour labels. For more infor-
mation, see “Editing Contour Labels Using Grips” on page 816.
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� From the Terrain menu, choose Contour Style Manager.

� Select the current contour style. 
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� Click the Contour Appearance tab.

� Under Contour Display, select one of the following options:

� Contours Only: To hide contour grips.
� Contours and Grips: To show contour grips.

� Click OK.

Editing Contours Using Grips

You can edit a contour object using grips. 
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� Create contours using the Create Contours command, the Digitize Contours 
command, or the Convert from Polylines command. 

For more information on the Create Contours command, see “Creating Con-
tours From a Surface” on page 805. For more information on the Digitize 
Contours command, see “Digitizing Contours” on page 818. For more infor-
mation on the Convert from Polylines command, see “Converting Polylines 
to Contours” on page 817.

� Click the contour in your drawing that you want to edit to display the grips 
along the contour.

NOTE Make sure contour grips are turned on. For more information, see 
“Showing or Hiding Contour Grips” on page 808.

� Click a grip to select it, and then move the grip to the new location.

Labeling Contours

Use the contour labeling commands to label any contour you created using 
the Create Contours or the Convert Polylines command. For more informa-
tion, see “Labeling a Contour at a Selected Location” on page 812 or “Con-
verting Polylines to Contours” on page 817. You can also use the contour 
labeling commands to label 2D polylines or contours. However, the contour 
labels function differently if you label polylines or contour objects. 

For example:

� You can slide a label along a contour object using grips. 
� You can turn off the display of contour object labels. 
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� If you change label properties after labeling contour objects, the labels are 
automatically updated. For more information, see “Changing the Con-
tour Label Position Settings” on page 797. To update polyline labels, you 
must label the polylines again. 

� When you label a polyline on the line and choose to break the line, then 
the label command breaks the polyline and inserts the text. If you label a 
contour object on the line, then the contour appears to be broken, but it 
actually is not. You can slide the label along the contour, and the break is 
moved with the label. 

Labeling the End of a Contour

You can label a contour with its elevation at the end of the contour line. Con-
tour objects, or contours consisting of 2D or lightweight polylines with ele-
vations, must exist in the drawing for this command to work properly. 
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� Change the contour label settings. For more information, see “Using the 
Contour Style Manager” on page 793.

� From the Terrain menu, choose Contour Labels ➤ End.

� Select the contour to label.

� Select the insertion point for the label. The insertion point corresponds to 
the lower left-hand corner of the inserted text label.

� Enter the rotation angle of the text by either picking two points or typing a 
value. 

� Repeat steps 3–5 for each contour you want to label.

� At the Select contour to label prompt, press ENTER to end the command.

NOTE This command draws labels on the same layer as the contour and the 
label appearance is based on the contour style. 

The following illustration shows a contour labeled at its end:
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Labeling the Ends of Multiple Contours

You can label a group of contours at the end of the contour lines with their 
elevation. Contour objects, or contours consisting of 2D or lightweight 
polylines with elevations, must exist in the drawing for this command to 
work properly. 
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� Change the contour label settings. For more information, see “Changing the 
Contour Label Position Settings” on page 797.

� From the Terrain menu, choose Contour Labels ➤ Group End.

The Contour Labels — Increments dialog box is displayed:

� In the Elevation Increment box, type the increment for the labels. For 
example, to label every fifth contour, type 5.

The other options in this dialog box are not available for Group End labels.

� Click OK.

� Enter the rotation angle of the text by either picking two points or typing a 
value.

� Select the contours to label by picking two points to drag a line across them.

The Group End command labels only the contours that intersect this line. 
The command places the contour label on the end of the contour closest to 
the dragged line.

NOTE When labeling a dashed contour line, the intersection location for labels 
may inadvertently be missed (for example, the crossing line passes through a 
gap in the dashed line). In some cases, it is advisable to use a continuous linetype 
for contours when adding labels. After labels are drawn, then you can reset the 
layer to a dashed linetype. 
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NOTE This command draws labels on the same layer as the contour and the 
label appearance is based on the contour style. 

The following illustration features a group of contours labeled at the ends:
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Labeling a Contour at a Selected Location

You can label a contour with its elevation at a selected location. Contour 
objects, or contours consisting of 2D or lightweight polylines with eleva-
tions, must exist in the drawing for this command to work properly. 
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� Change the contour label settings. For more information, see “Changing the 
Contour Label Position Settings” on page 797.

� From the Terrain menu, choose Contour Labels ➤ Interior.

� Select the contour line to label.

� Select a point on the contour for the middle point of the label.

� At the Select contour to label prompt, select another contour to label, or press 
ENTER to end the command.

NOTE This command draws labels on the same layer as the contour and the 
label appearance is based on the contour style. 

The following illustration shows interior contour labeling:
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Labeling Multiple Contours at a Selected 
Location

You can label a series of contours with their elevations at selected locations. 
The Group Interior command draws labels on the same layer as the contour 
and the label appearance is based on the contour style. Contour objects, or 
contours consisting of 2D or lightweight polylines with elevations, must 
exist in the drawing for this command to work properly. 
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� Change the contour label settings. For more information, see “Using the 
Contour Style Manager” on page 793.

� From the Terrain menu, choose Contour Labels ➤ Group Interior.

The Contour Labels—Increments dialog box is displayed:

� In the Elevation Increment box, type the increment for the labels. For exam-
ple, to label every fifth contour, type 5.

� Select the Add multiple interior labels along each contour check box to add 
several interior labels along each contour, instead of just one label per con-
tour. If you select this option, then the spacing distance between labels can 
be edited. Otherwise, the Spacing option is inaccessible.

� If you select the Add multiple interior labels along each contour check box, 
then type a value in the Spacing box. This is the distance between labels on 
the contours, and is measured in drawing units.
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� Click OK.

� Select the contours to label by picking two points to drag a line across them.

The Group Interior command draws labels on the same layer as the contour 
and labels only the contours that intersect this line. The command places the 
label at the intersection of the contour and the line (and at intervals specified 
by the Spacing box). If the selection line does not intersect a contour at the 
specified interval, then the program does not insert a label.

NOTE When labeling a dashed contour line, the intersection location for labels 
may inadvertently be missed (for example, the crossing line passes through a 
gap in the dashed line). In some cases, it is advisable to use a continuous linetype 
for contours when adding labels. After labels are drawn, then you can reset the 
layer to a dashed linetype. 

NOTE If the message “At least one break point must be valid” is displayed, 
then the text size for the label may be set too large for the location of the text. 

The following illustration features a group of contours labeled on the line:
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Deleting Contour Labels

If you don’t want to plot labels, you can either hide the contour labels or 
delete the contour labels. For more information about hiding contour labels, 
see “Showing or Hiding Contour Labels” on page 815.
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� From the Terrain menu, choose Contour Labels ➤ Delete Labels.

� Select the contour from which you want to remove the label.

� Select a location near the contour label you want to remove.

� To remove additional labels on the contour, continue to select points.

� To select another contour line from which to delete labels, press ENTER and 
select the contour.

Deleting All Contour Labels from Selected 
Contours

If each contour is labeled more than once and you want to delete those 
labels, then you can use the Delete All Labels command. 
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� From the Terrain menu, choose Contour Labels ➤ Delete All Labels.

� Select the contours from which you want to delete labels. You can use any 
standard AutoCAD selection method, such as a crossing or fence, to select the 
contours.

� Press ENTER to complete the selection set and delete all the labels from the 
selected contours.

Showing or Hiding Contour Labels

You can turn on or off the display of contour labels in your drawing. 

NOTE This option works only with labels that are on contour objects. It does 
not work with polyline contour labels. 
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� From the Terrain menu, choose Contour Style Manager to display the Con-
tour Style Manager dialog box. 

� Select the current contour style. For more information, see “Selecting the 
Current Contour Style” on page 800.

� Click the Contour Appearance tab.

� Select one of the following options:

� Labels Off: To hide the labels.
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� Either Labels Only or Labels and Grips: To show the labels.

� Click OK.

Showing or Hiding Contour Label Grips

You can show or hide the label grips on a contour. When you click a label to 
select it, a grip is displayed. You can move the label along the contour by 
selecting the grip and sliding it.
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� From the Terrain menu, choose Contour Style Manager to display the Con-
tour Style Manager dialog box.

� Select the current contour style. For more information, see “Selecting the 
Current Contour Style” on page 800.

� Click the Contour Appearance tab.

� Under Label Display, select one of the following options:

� Labels Only: To hide contour label grips.
� Labels and Grips: To show contour label grips.

� Click OK.

Editing Contour Labels Using Grips

You can edit a contour object label using grips. 
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� Create contours using the Create Contours command, the Digitize Contours 
command, or the Convert from Polylines command.

For more information on the Create Contours command, see “Creating Con-
tours From a Surface” on page 805. For more information on the Digitize 
Contours command, see “Digitizing Contours” on page 818. For more infor-
mation on the Convert from Polylines command, see “Converting Polylines 
to Contours” on page 817.

� Label the contours using one of the contour labeling commands. For more 
information, see “Labeling Contours” on page 809.

� Click the label you want to edit to display the grip. 
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NOTE Make sure contour label grips are turned on. For more information, see 
“Showing or Hiding Contour Label Grips” on page 816.

� Click the label grip to select it, and then move the grip to the new location 
along the contour.

Using Contour Utilities to Create and Edit 
Contours

You can use the Contour Utilities to create contours by doing any of the fol-
lowing tasks:

� Converting polylines to contours
� Digitizing contours
� Copying and offsetting contours

In addition, you can use the Contour Utilities to edit contour elevations and 
weed contour vertices (adding or removing points on the contours).

Converting Polylines to Contours

You can convert polylines to contour objects. Converting polylines to con-
tours reduces your drawing size. It also lets you take advantage of the contour 
shortcut menu commands and dynamic labeling features.
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� From the Terrain menu, choose Contour Utilities ➤ Convert Polylines.

� Select the polylines you want to convert.

� Press ENTER.

Exploding Contours to Polylines

To share your drawing with someone who is not using AutoCAD Land Devel-
opment Desktop (but using AutoCAD), you can explode the contour objects 
to polylines so that the other person can view and edit the contours.
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� At the command line, type EXPLODE.
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� Select the contour objects that you want to convert to lightweight polylines.

� Press ENTER to convert the contours.

If needed, you can convert the polylines back to contour objects using the 
Convert Polylines command. For more information, see “Converting 
Polylines to Contours” on page 817.

Digitizing Contours

If you have paper copies of plans with contours, or if you have a raster image 
of contours, then you can digitize (or trace) those contours. Digitizing con-
tours creates contour objects that you can use to build a surface model. 

Using your pointing device, you can digitize a scanned raster image of con-
tours that is inserted into your drawing. If you have a tablet, then you can 
trace a paper copy of a drawing.

If you are using a tablet, then you need to use the CALIBRATE command to 
configure your tablet so the coordinates of the hard copy drawing match 
your AutoCAD drawing. 
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� From the Terrain menu, choose Contour Utilities ➤ Digitize Contours to dis-
play the Digitize Contours dialog box.

� In the Starting Elevation box, enter the elevation of the first contour to 
digitize. 

For each subsequent contour that you digitize, this value is increased or 
decreased by the minor interval value.
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For example, if the starting elevation is 200', and the minor interval is 5', 
then the first contour you digitize is given an elevation of 200'. For the sec-
ond contour, you can increase or decrease this elevation by the minor inter-
val amount, so you could create a contour with an elevation of 195' or 205'.

� Under Intervals, select one of the following options:

� Both Minor and Major
� Minor Only
� Major Only

� Define the contour intervals by entering values in the Minor Interval and 
Major Interval boxes.

� Specify the layers for the minor and major contours. You can select an exist-
ing layer or type in a new layer name. By placing the minor and major con-
tours on different layers, you can easily control the contour colors and line-
types.

� Under Properties, select one of the following options:

� Contour Objects: To create contour objects. For more information, see 
“Advantages of Using the Contour Object” on page 792.

� Polylines: To create polyline contours.

NOTE If you select the Polyline option, then you cannot select a contour 
style to use. 

� From the Contour Style list, select the contour style to use for the contours.

TIP Click the Preview button to see a preview of the contour style.

� If you need to load a contour style, edit a style, or create a new style, then 
click the Style Manager button to display the Contour Style Manager dialog 
box. For more information, see “Managing Contour Styles” on page 799.

� Click OK to start digitizing.

�� Pick points to trace the contour lines.

After you have completed tracing a contour, press ENTER.

The following prompt is displayed:
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�� Type one of the following to define the calculation method for the next con-
tour:
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� A minus sign (-): To create a contour at the next lower contour interval.
� An equals sign (=): To create a contour at the same elevation as the last 

contour.
� Change: To change the elevation, and then type a value for the next ele-

vation.
� A plus sign (+): To create a contour at the next higher contour interval.

�� After you finish digitizing contours, press ENTER to end the command.

Digitized Contours
The methods you use to digitize the contours can greatly enhance the perfor-
mance of the surface generator. Remember that the contours ultimately 
become point data, so you should place just enough vertices to define the 
contour line adequately. If the contour line is fairly straight, then you do not 
need many points along it.

If you digitize contours from an existing map, then consider that when con-
tours are used to generate a surface, they are not sorted. You can speed up the 
triangulation process by digitizing the contours in sections, which minimizes 
disk access. Divide the site by drawing vertical and horizontal lines. You 
might do this by dividing the site in half both vertically and horizontally. 
Then draw a line both horizontally and vertically halfway through each sec-
tion. Continue to do this until the size of the sections allows for easy digitiz-
ing. This method of digitizing speeds up the search process and, therefore, 
the surface generation.

NOTE The Weed Contour Vertices command allows you to append or weed 
vertices in cases where too few or too many polylines or contour segments have 
been digitized. For more information, see “Weeding Contours to Remove and 
Add Points” on page 824.

Changing Contour Elevations

You can change the elevations of selected contours or polylines by using 
commands on the Contour Utilities menu. 

NOTE You can also use the Object Property Manager to change the elevations 
of contours.

Changing the Elevations of Selected Contours
You can change the elevation of any contour or polyline in the drawing.
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NOTE Use the Edit Elevation command to change the elevation of a contour 
object. Do not use the AutoCAD MOVE or CHANGE command. 
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� From the Terrain menu, choose Contour Utilities ➤ Edit Elevation.

� Select the contour line or polyline to edit.

The elevation value is displayed at the command line. If the contour does not 
have an elevation, then its elevation is listed as zero.

� Type the new elevation.

� Press ENTER to end the command.

NOTE All contour labels are automatically updated (on contour objects only, 
not on polylines) to the new elevation. 

Changing the Elevation of Each Contour on a Layer
You can change the elevation of each contour on a specific layer. The speci-
fied layer must contain contours consisting of 2D polylines or contour 
objects.
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� From the Terrain menu, choose Contour Utilities ➤ Edit Elevations by Layer.

The following prompt is displayed:
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� Type one of the following to select the contours:

� Type Entity and then use any standard selection method to select the con-
tours.

� Type Layer and then select one contour on the layer that you want to 
select.

� Type Layer, press ENTER, and then type the layer name.

NOTE When you use one of the Layer options, all valid contours on that 
layer are selected. 

A new elevation is prompted for each contour line on the designated 
layer:
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� Type the change in elevation. A positive value increases the elevations; a neg-
ative value decreases the elevations. 

� Press ENTER to end the command.

Changing Contour Elevation Datum by Adding or Subtracting 
a Value
You can change the elevations of a group of contours by adding or subtract-
ing an amount from the existing elevation. Contour objects, or contours 
consisting of 2D or lightweight polylines with elevations, must exist in the 
drawing for this command to work properly.
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� From the Terrain menu, choose Contour Utilities ➤ Edit Datum Elevation.

The following prompt is displayed:
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� Type one of the following options:

� Type Entity and then use any standard selection method to select the con-
tours.

� Type Layer and then select one contour on the layer that you want to 
select.

� Type Layer, press ENTER, and then type the layer name.

NOTE When you use one of the Layer options, all valid contours on that 
layer are selected. 

� Type the change in elevation. A positive value increases the elevations; a neg-
ative value decreases the elevations.

Assigning Elevations to Contours or Polylines
You can quickly enter the elevations for a group of contours. You begin by 
assigning an elevation to the first contour, and then you define an increment 
for the next. As you select contour lines, you define increasing or decreasing 
elevations. The command automatically calculates all subsequent contour 
elevations.

TIP This is a good command to use if you want to assign Z values to polylines.
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� From the Terrain menu, choose Contour Utilities ➤ Assign Elevation.

� Select the first contour or polyline.

� Enter the first contour elevation.

� Enter the contour increment.

� Select the next contour. 

The following prompt is displayed:
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� Type one of the following one of the following options:

� Increasing: To assign a higher elevation to the next contour.
� Decreasing: To assign a lower elevation to the next contour.

The current and new elevations are displayed.

� Press ENTER to accept the new elevation.

� Repeat steps 5–7.

� Press ENTER to enter a new first contour, or press ENTER twice to exit the com-
mand.

Finding and Changing Contours with Zero Elevations
When you work with contours, it is important that you review the contours 
to see if any have elevations of zero. If a contour is not intended to have an 
elevation of zero, then you can change the elevation.
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� From the Terrain menu, choose Contour Utilities ➤ Check for 0 Elevation.

The following prompt is displayed:
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� Type one of the following options:

� Type Entity and then use any standard selection method to select the con-
tours.

� Type Layer and then select one contour on the layer that you want to 
select.

� Type Layer, press ENTER, and then type the layer name.

NOTE When you use one of the Layer options, all valid contours on that 
layer are selected. 
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After the program finds a contour with a zero elevation, it highlights the con-
tour and prompts you for the new elevation. 

� Type a new elevation.

� Repeat steps for every contour found in the selection set that has an elevation 
of zero.

Weeding Contours to Remove and Add Points

You can add and subtract points on contours by using weeding and supple-
menting factors. The Weed Contours command adds or removes vertices on 
the contours in the selection set. This is helpful to control the drawing file 
size and contour appearance, or to remove redundant information.

���"		���������#	�
��	����������
����

� From the Terrain menu, choose Contour Utilities ➤ Weed Contour Vertices 
to display the Contour Weeding dialog box.

NOTE The Create as contour data check box is not used when weeding the 
contours in the drawing. This option is used only when writing the contour data 
for use in a surface model. 

� Type the Weeding Distance and Angle factor values.

� Type the Supplementing Distance and Bulge factor values. 

NOTE For more information about weeding and supplementing factors, see 
“Creating Contour Data to Use in Surface Generation” on page 650.

� Click OK.

The following prompt is displayed:

!���
���"#�
���"$�������$�%�$�����%�$����
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� Type one of the following options:

� Type Entity and then use any standard selection method to select the con-
tours.

� Type Layer and then select one contour on the layer that you want to 
select.

� Type Layer, press ENTER, and then type the layer name.

NOTE When you use one of the Layer options, all valid contours on that 
layer are selected.

When the operation is complete, the number of contour vertices added or 
deleted is displayed at the command line.

Creating Contours by Copying and Offsetting

You can create finished ground contours by copying and offsetting existing 
contours by using grade or slope offsets. These contours provide the informa-
tion necessary for creating or representing the finished surface. 

Copying Finished Ground Contours to Another Layer
You can use the Copy Finished Ground command to copy a group of con-
tours to another layer. Contours must exist in the current drawing to use this 
command. 

�������$�����	������������
����

� From the Terrain menu, choose Contour Utilities ➤ Copy Finished Ground. 

The following prompt is displayed:

��&���$�����+��

� Type the name of the new layer to which to copy the contours and press 
ENTER.

The following prompt is displayed:

!���
��������	�
�������

!���
���"#�
���

� Select the contours to copy.

� When you have finished selecting contours to copy, press ENTER to end the 
command. The contours are copied to the new layer.

You can now modify the copied contours to show the proposed grading or 
an existing subsurface. The original contours remain unchanged. The Copy 
Finished Ground command ensures that the original and secondary surfaces 
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match everywhere except where you modify the site. 

Copying and Offsetting the Contours Using a Slope and an 
Elevation Increment 
With the Copy by Slope command, you can create new contours at a speci-
fied slope and specified elevation increment. 

������������$$�	
����
����������������	��������	�	#�
��������	�	�


� From the Terrain menu, choose Contour Utilities ➤ Copy by Slope. 

The following prompt is displayed:

���������
��+����

� Type the contour increment and press ENTER. 

This is the vertical distance between successive contour lines.

The following prompt is displayed:

,��

� Type a value or select the slope by entering the two points of the run. 

The run is always a positive horizontal distance. Do not use a plus sign (+) to 
enter a positive rise. For example, to specify a -3:1 (3 to 1) slope, enter a run 
of 3 and a rise of -1.

The following prompt is displayed:

,����

� Type a value or select the slope by entering the two points of the rise. 

The rise is the vertical distance, positive or negative, for the slope. Do not use 
a plus sign (+) to enter a positive rise. For example, to specify a -3:1 (3 to 1) 
slope, enter a run of 3 and a rise of -1.

The following prompt is displayed:

����������������--����

� Select the contour line to offset in your drawing.

The following prompt is displayed:

!�	������--����

� Specify the side for the new contour line relative to the selected contour line.

� Select another contour to offset, or press ENTER to end the command.

The command uses the elevation and slope of the contour line selected and 
calculates the necessary horizontal offset distance for the new contour line. 
The new contour is placed on the same layer as the original contour. 
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In the following illustration, the new contour is placed six feet from the con-
tour being copied. The elevation of the contour is two feet less than the con-
tour selected for copying.

!�����������$$�	

�������
����� ���	��$����������	

Copying and Offsetting Contours by Using a Grade and an 
Elevation Increment 
You can create new contours at a specified grade and specified elevation 
increment using the Copy by Grade command. 

������������$$�	
����
����� ��������������	��������	�	#�
��������	�	�


� From the Terrain menu, choose Contour Utilities ➤ Copy by Grade. 

The following prompt is displayed:

���������
��+����

� At the command prompt, type the contour increment and press ENTER.

This is the vertical distance between successive contour lines.

The following prompt is displayed:

.��	��

� Specify the grade by entering a percentage change in elevation. 

Enter a minus sign (-) for a negative grade for decreasing elevation, but not a 
plus sign (+) when specifying a positive grade for increasing elevation.

The following prompt is displayed:

����������������--����

� Select the contour line to offset.

The following prompt is displayed:

!�	������--����

� Specify the side for the new contour line relative to the selected contour line.

The following prompt is displayed:

����������������--����

� Select another contour to offset, or press ENTER to end the command.
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The command uses the elevation of the contour line selected and the grade 
given, and calculates the necessary horizontal offset distance for the contour 
line. The new contour is placed on the same layer as the original contour. 

The following illustration shows contour lines copied at a grade:

!�����������$$�	

�������
����� ���	��$�����������	

Creating Multiple Offsets of a Contour Within a Specified 
Distance
With the Offset by Distance command, you can create multiple offsets of a 
contour at a specified elevation increment and grade until they meet the dis-
tance you specify. A contour must exist in the current drawing to use this 
command.

�����	�
	����
��	��$$�	
���$������
����"�
�������	��$�	�����
���	

� From the Terrain menu, choose Contour Utilities ➤ Offset by Distance. 

The following prompt is displayed:

����������������--����

� Select the contour line to offset in your drawing.

The following prompt is displayed:

!���
��������	�����
������--����

����,�/0,��-���������

� Define the distance for the offset contours using one of the following meth-
ods:

� Select a second point by clicking a point in your drawing to define the dis-
tance. The new contour will be created on the side of the drawing you 
selected.

� Press ENTER, and then type a distance value, then select the side of the 
drawing to create the new contours. 

The following prompt is displayed:

����������������
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� Type the contour interval.

The following prompt is displayed:

.��	��

� Specify the grade using one of the following methods:

� Select two points in your drawing. 
� At the command prompt, type a percentage change in elevation and press 

ENTER.

Enter a minus sign (-) for a negative grade for decreasing elevation, but not a 
plus sign (+) when specifying a positive grade for increasing elevation.

The following prompt is displayed:

1� ��� ������������

� Do one of the following:

The command creates contours between the selected contour line and the 
distance specified. If the selected contour line is not on an even interval, then 
the command adjusts the offset distance to obtain an even contour eleva-
tion.

The following prompt is redisplayed:

����������������--����

� Continue to select a contour line to offset, or press ENTER to exit the com-
mand.

Creating Multiple Offsets of a Contour Until the Elevation you 
Specify is Obtained
Using the Offset by Elevation command, you can create multiple offsets of a 
contour at a specified interval and grade until the elevation you specify is 
obtained. A polyline or contour must exist in the current drawing. 

�����	�
	����
��	��$$�	
���$������
������
���
�	�	�	#�
���������	��$�����
� 
���	�

� From the Terrain menu, choose Contour Utilities ➤ Offset by Elevation. 

&$�����"��
�
�… ��	�…

include highlighted contours type the highlight interval and press 
ENTER. 

exclude highlighted contours press ENTER. 



830 | Chapter 32 Creating and Managing Contours

The following prompt is displayed:

����������������--����

� Select the contour line to offset.

The following prompt is displayed:

!���
����	������--����

� Select the side to offset.

The following prompt is displayed:

������+���++�+���++�����������

� Enter the minimum/maximum elevation. 

For a positive grade, this value must be greater than the selected contour line. 
For a negative grade, it must be less than the selected contour line.

The following prompt is displayed:

����������������

� Type the contour interval and press ENTER.

The following prompt is displayed:

.��	��

� Specify the grade by entering a percentage change in elevation. 

Enter a minus sign (-) for a negative grade for decreasing elevation, but not a 
plus sign (+) for a positive grade for increasing elevation.

The following prompt is displayed:

1� ��� ������������

� Do one of the following:

The program creates offsets starting with the selected contour line until the 
elevation you entered is reached. If the selected contour line is not on an 
even interval, the command adjusts the offset distance to obtain even con-
tour elevations.

&$�����"��
�
�… ��	�…

include highlighted contours type the highlight interval and 
press ENTER. 

Then, type the name of the layer 
on which you want to include 
highlighted contours and press 
ENTER.

exclude highlighted contours press ENTER. 
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The following prompt is redisplayed:

����������������--����

� Continue to select a contour line to offset, or press ENTER to exit the 
command.
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33Working with 3D 
Polylines

You can use 3D polylines to create additional data to 

include in surfaces. You can convert 2D polylines to 3D 

polylines and vice versa. You can add vertices or remove 

vertices, and you can join 3D polylines together.

In this chapter

� Creating 3D Polylines

� Creating 3D Polylines by 
Referencing Elevation of Points

� Creating 3D Polylines by 
Referencing Points and Slopes

� Creating a Curb

� Creating a Step

� Converting 3D Polylines to 2D 
Polylines

� Converting 2D Polylines to 3D 
Polylines

� Editing 3D Polylines

� Filleting 3D Polyline Vertices

� Displaying 3D Polyline Grade 
Breaks

� Adding Vertices to a Polyline

� Joining 3D Polylines

� Weeding 3D Polylines
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Creating 3D Polylines

3D polylines are perhaps the most powerful and simple tool to create an 
accurate 3D representation of a design surface. The 3D polyline tools allow 
the designer to do the following tasks:

� Create and edit 3D polylines by specifying elevations, slopes, grades, and 
distances.

� Offset 3D polylines to represent curbs, steps, or walls.
� Accurately represent 3D curves, which are not a valid part of an AutoCAD 

3D polyline, by creating a series of 3D segments that lie on the geometric 
definition of an arc.

� Fillet 3D polyline vertices, which is not possible in AutoCAD alone, by cre-
ating a series of 3D segments that lie on the geometric definition of a fil-
leted arc. 

� Add and remove polyline vertices.
� Join 3D polylines.

Creating 3D Polylines by Referencing the 
Elevations of Points

With the Create by Elevation command, you can create a 3D polyline by ele-
vation by specifying an object or points for the polyline vertices. You can use 
a surface to calculate the vertex elevations, extract elevations from points, or 
type elevations at the command prompt.

����������	
������������������������������������������������

� From the Terrain menu, choose 3D Polylines ➤ Create by Elevation. 

The following prompt is displayed:

���������	�
�����	�	��

� Select the point or entity for the polyline vertices by doing one of the follow-
ing:

� Select points to define the vertices.

NOTE If you use the .G point selection filter to select point objects, the 
elevation for the point is reported in step 3.
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� Type E and select an existing entity in your drawing. 

	 Define the elevation for the points or the entity vertices as you select them. 
For more information, see “Defining the Elevations for Points or Entity Ver-
tices” on page 835.

The following prompt is displayed:

�������	�
���	��	���������������	�	��������	�����

� At the prompt, select the next point of the polyline. For more information, 
see “3D Polylines – Options for Defining the Polyline” on page 836.

� Select the next point for the polyline. 

After you draw two polyline segments, you can continue to use the options 
listed in step 3 to draw segments. You also have the following options:

� Type R for Redraw to redraw the temporary lines. Until you end the com-
mand, all the segments are temporary lines. If you use a transparent com-
mand like a ZOOM or PAN, the temporary lines disappear. Type R to 
redraw those lines.

� Type CL for Close to close the polyline.

� After you finish drawing the polyline, type X to create the polyline in the 
drawing.

Defining the Elevations for Points or Entity Vertices

� For points: Type an elevation for the first point. If you selected points 
using the .G filter, the elevation is reported at the command line. Press 
ENTER to accept this value, or type a new value. You can also type D to 
extract elevations from a surface, and select the surface from which to read 
the elevation. You can accept the elevation obtained from the surface 
model, or type a new elevation. 

� For a line or curve entity: Type an elevation for the first vertex, or type 
D to select the surface from which to read the elevation. You can then 
either accept the elevation obtained from the surface, or type a new eleva-
tion.

� For a contour: If you select a contour with multiple vertices, the follow-
ing prompt is displayed: 

����	���������������	��������
���	�������� ������	�����

!���	����"��

At this prompt, define the contour by typing one of the following options:

� Type N and then the number of vertices to use.
� Type M and then the mid-ordinate length.
� Type D and then the distance.
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� Type X to exit the command.

3D Polylines – Options for Defining the Polyline
Use the following options to define the polyline:

� Point: Select the next point, and define its elevation.
� eXit: Type X to exit the command.
� DTM: Type D to either turn on or off the surface option before selecting 

the next point. 
� Undo: Type U to undo the last point you selected.
� Transition: Type T to create a more continuous slope between polyline 

vertices. 

By defining the beginning and ending elevation, the command calculates all 
intermediate vertices on the slope of this line. 

When you select the Transition option, the following prompts are displayed: 

�������	�
���	��	���������������	�	��������	������

���#���	�
����������

���#���	�
���������������

After selecting the transition points, type E to end the transition. 

A total length of transition segments displays and you are prompted for the 
ending elevation. The calculated slope and grade appear for the transition 
segments, and you return to the previous polyline prompts.

� Entity: Type E and select an entity nearest the vertex you want to use.
� Curve: Type C, and draw a curve at an elevation by selecting the point on 

the curve and the endpoint of the curve, and defining the ending eleva-
tion for the curve. Then, after you draw the arc, you are prompted to spec-
ify how many vertices you want the curve to have. This is because you 
cannot actually draw a 3D curve in AutoCAD; you must draw line seg-
ments to create the representation of the arc. 

The following prompt is displayed:

����	���������������	��������
���	�������� ���

���	����

!���	����"��

At this prompt, you can type one of the following options:

� Type N and then the number of vertices to add.
� Type M and then the mid-ordinate distance.
� Type D and then the distance between each vertex.
� Type X to exit the command.
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Creating 3D Polylines by Referencing Points 
and Slopes

With the Create by Slope command, you can create a 3D polyline by specify-
ing an entity or points for the polyline vertices, and then give the polyline 
an elevation by specifying a slope. 

����������	
�����������������������������������������

� From the Terrain menu, choose 3D Polylines ➤ Create by Slope. 

The following prompt is displayed:

���������	�
�����	�	��

� At the command prompt, select the start point, or type E and select an exist-
ing entity in your drawing.

NOTE If you use the .G point selection filter to select point objects, the eleva-
tion for the point is reported in step 3. For more information, see “Selecting 
Points and Locations” on page 203.

	 Define the elevation for the point or first entity vertex. For more informa-
tion, see “Defining the Elevation for the Point or the First Entity Vertex” on 
page 838.

The following prompt is displayed: 

$�����
���%�����!&�'���	�"�

� Define the slope or grade from the first point to the second point using one 
of the following methods:

� Type a slope in the following format: 3:1.
� Type G and a grade.

NOTE An Infinite slope is a horizontal line. An Infinite grade is a vertical line.

The command reports the resulting elevation for the second point.

The following prompt is displayed: 

�������	�
���	�(����)��������*�����������	�	��

� At the command prompt, type one of the options to continue. For more 
information, see “Creating 3D Polylines by Referencing the Points and Slopes 
- Define the Polyline” on page 838.
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� After you finish drawing the polyline, type X for eXit to create the polyline.  

Defining the Elevation for the Point or the First Entity Vertex
For points: Type an elevation for the first point. If you selected points using 
the .G filter, the elevation is reported at the command line. Press ENTER to 
accept this value, or type a new value. You can also type D to extract eleva-
tions from a surface, and then select the surface from which to read the ele-
vation. You can then accept the elevation obtained from the surface, or type 
a new elevation. 

The following prompt is displayed:

�������	�
���	��������������	�	��

Use these options to select the second point, to draw a curve, to undo the last 
point, or to select a point on an entity. 

For a line or curve entity: Type an elevation for the first vertex, or type D 
to select the surface from which to read the elevation. You can then either 
accept the elevation obtained from the surface, or type a new elevation.

For a contour: If you select a contour with multiple vertices, the following 
prompt is displayed:

����	���������������	��������
���	�������� ������	�����!���	����"�

At this prompt, type one of the following options:

� Type N and then the number of vertices to use.
� Type M and then the mid-ordinate length.
� Type D and then the distance.
� Type X to exit the command.

Creating 3D Polylines by Referencing the Points and Slopes - 
Define the Polyline
You can use the following options to define the polyline:

� Point: Select the next point, and then define the next slope. For more 
information, see “Selecting Points and Locations” on page 203.

� eXit: Type X to exit the command.
� Redraw: Type R to redraw the temporary lines.
� Close: Type CL to close the polyline back to the start point.
� Undo: Type U to undo the last point you selected.
� Entity: Type E and select an entity nearest to the vertex you want to use.
� Curve: Type C and then draw a curve. Select the point on the curve and 

the endpoint of the curve, and then define the curve's ending slope. After 
you draw the curve, you are prompted to specify how many vertices you 



Creating a Curb by Offsetting a 3D Polyline and Applying a Single Elevational Change

839

want it to have. This is because you cannot actually draw a 3D curve in 
AutoCAD; you must draw polyline segments and then fillet each vertex to 
create the representation of the arc. 

The following prompt is displayed:

����	���������������	��������
���	�������� ������	�����!���	����"��

At this prompt, type one of the following options:

� Type N and then the number of vertices to add.
� Type M and then the mid-ordinate distance.
� Type D and then the distance between each vertex.

Creating a Curb by Offsetting a 3D Polyline 
and Applying a Single Elevational Change

With the Create Curb command, you can offset an existing polyline in your 
drawing and apply an elevational change to the entire polyline. This com-
mand is useful in creating any feature that has a constant depth, such as 
curbs or walks. 

��������������������������������	
������������������������������������������

������

� From the Terrain menu, choose 3D Polylines ➤ Create Curb. 

The following prompt is displayed:

$����	����������

� Select the polyline. 

NOTE If you select a 2D polyline that includes curves, the following prompt is 
displayed:

����	���������������	��������
���	�������� ������	�����!���	����"�

	 At this prompt, type one of the following options:

� Type N and then the number of vertices to use.
� Type M and then the mid-ordinate length.
� Type D and then the distance.
� Type X to exit the command.
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NOTE To draw a 3D polyline arc, you must specify how many vertices you 
want the curve to have. This is because you cannot actually draw a 3D curve 
in AutoCAD; you must draw polyline to create the representation of the arc.

The following prompt is displayed:

$����	��''��	������

� Select a side for the new polyline.

The following prompt is displayed:

+''��	�!,-,,"�

� At this prompt, specify an offset distance for the polyline using one of the 
following methods:

� Type an offset value.
� Select two points to define the offset distance.

NOTE The offset distance of the new polyline must not exceed a value that 
creates a polyline with fewer vertices than the existing polyline.

The following prompt is displayed:

�����	����
���	���''�������!,-,,"�

� At this prompt, specify the elevation for the new polyline by typing one of 
the following options:

� Type a value that is a uniform elevation for the entire polyline.
� Type D and the elevational difference between the original polyline and 

the new polyline, calculated at each vertex. Use the Difference option to 
add or subtract the difference value from each original elevation.

NOTE The new polyline is created with the same number of vertices as the 
original. 

The following illustration shows a 3D polyline that was offset to create a 
curb:
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��������������������������������

Creating a Step by Offsetting a 3D Polyline 
and Applying the Elevational Changes to Each 
Vertex

With the Create Step command, you can offset an existing polyline and 
apply an elevational change to each vertex on the polyline. This command 
is useful in modeling a vertical face when the top and bottom have different 
elevations, such as a retaining or wing wall. 

��������������������������������	
�������������������������������������

����������������������

� From the Terrain menu, choose 3D Polylines ➤ Create Step. 

The following prompt is displayed:

$����	����������

� Select the polyline.

NOTE If you select a 2D polyline that includes curves, the following prompt is 
displayed:

����	���������������	��������
���	�������� ������	�����!���	����"�

	 At this prompt, type one of the following options:

� Type X to exit the command.
� Type N and then the number of vertices to use.
� Type M and then the mid-ordinate length.
� Type D and then the distance.
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NOTE To draw a 3D polyline arc, you must specify how many vertices you 
want the curve to have. This is because you cannot actually draw a 3D curve 
in AutoCAD; you must draw polyline segments and then fillet each vertex to 
create the representation of the arc. 

The following prompt is displayed:

$����	��''��	������

� Select a side for the new polyline.

The following prompt is displayed: 

+''��	�!,-,,"�

� At this prompt, specify an offset distance for the polyline using one of the 
following methods:

� Type an offset value.
� Select two points to define the offset distance.

NOTE The offset distance of the new polyline must not exceed a value that 
creates a polyline with fewer vertices than the existing polyline. This occurs 
when the offset distance exceeds the radius of a curve on the existing polyline 
and the offset side is to the inside of the curve. 

The following prompt is displayed:

�����	����
���	���''�������!,-,,"�

This prompt repeats for all vertices on the polyline.

� Specify the elevation for each new vertex by typing one of the following 
options:

� Type a value that is a uniform elevation for the entire polyline.
� Type D and the elevational difference between the original polyline and 

the new polyline, calculated at each vertex. Use the Difference option to 
add or subtract the difference value from each original elevation.

NOTE This command creates the new polyline with the same number of 
vertices as the original. 

The following illustration shows a 3D polyline that was offset to create a step:
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��������������������������������

Converting 3D Polylines to 2D Polylines

Using the Convert to 2D Polyline command, you can convert 3D polylines 
to 2D polylines. 

By definition, a 2D polyline is coplanar, which means that all of its vertices 
have the same elevation. A 2D polyline may contain arcs. Comparatively, a 
3D polyline may have different vertex elevations, but cannot contain any 
arcs. However, a 3D polyline may have all of its vertices at equal elevation. 
When a 3D polyline is converted to a 2D polyline, all of its vertices are 
changed to the same elevation as the first vertex on the 3D polyline from 
which it was created.

�����������	
��������������
���������

� From the Terrain menu, choose 3D Polylines ➤ Convert to 2D Polyline.

The following prompt is displayed:

$����	����*�����
$����	����*�����

� Do one of the following to convert 3D polylines to 2D:

The program performs the conversion.

�������������… ����…

select the objects in your drawing type S for Selection at the command 
prompt and press ENTER.

select the object on a specific layer type L for Layer at the command prompt 
and press ENTER.

type the layer name on which the 3D 
polylines that you want to convert to 2D 
are located 

type L and press ENTER.
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Converting 2D Polylines to 3D Polylines

You can convert 2D polylines to 3D polylines using the Convert from 2D 
Polyline command.

By definition, a 2D polyline is coplanar, which means that all of its vertices 
have the same elevation. A 2D polyline may contain arcs. Comparatively, a 
3D polyline may have different vertex elevations, but cannot contain any 
arcs. However, a 3D polyline may have all of its vertices at the same elevation. 
When a 2D polyline is converted to a 3D polyline, all of its vertices have the 
same elevation as the original 2D polyline.

������������
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� From the Terrain menu, choose 3D Polylines ➤ Convert from 2D Polyline.

The following prompt is displayed:

$����	����*�����
$����	����*�����

� Do one of the following to convert 2D polylines to 3D.

The program performs the conversion.

Editing a 3D Polyline

With the Edit 3D Polyline command, you can edit any 3D polyline by select-
ing a vertex and changing its elevation and/or location. A temporary X is 
located at the current vertex for reference.

����������	
��������

� From the Terrain menu, choose 3D Polylines ➤ Edit 3D Polyline.

�������������… ����…

select the objects in your drawing type S for Selection at the command 
prompt and press ENTER.

select the object on a specific layer type L for Layer at the command prompt 
and press ENTER.

type the layer name on which the 2D 
polylines that you want to convert to 3D 
are located

type L and press ENTER.
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The following prompt is displayed:

$����	����������

� Select a polyline from your drawing.

The following prompt is displayed:

#�������������� ����(����)������	����$��������	���.	�!��.	"�

	 Select one of the following editing options:

� Next: Type N to move to the next polyline vertex. 
� Previous: Type P to move to the previous polyline vertex.
� Close: Type C to connect the last segment with the first. A polyline is con-

sidered open unless you close it using the Close option. After you use the 
Close option, the Open option is displayed.

� Open: Type O to open a polyline that you closed. 
� Move: Type M to move the current vertex, and then select the new loca-

tion.
� Redraw: Type R to redraw the display.
� Elevation: Change the elevation of the current vertex. Type E to display 

the following prompt:

�����	����
���	���''�������!,"�

Type a new elevation for the vertex, type D and a value to be added or sub-
tracted to the current elevation, or type X to exit this option.

� Slope: Change the slope of the current polyline segment. Type S to dis-
play the current slope of the segment and the following prompt:

$�������	����
��.	�#�����������	�!���	"��

You can type a new slope for the current segment, move to the next or pre-
vious vertex, or type X to exit this option.

� eXit: Exits the command.

Filleting 3D Polyline Vertices

You can round the corners of 3D polylines at selected vertices. This is called 
filleting. The result is not actually an arc in the 3D polyline, but a series of 
user-specified straight line segments that approximate the arc geometry.

One situation where you would fillet the corners of a 3D polyline object is to 
create a radial corner when using the Civil Design Daylighting commands. 
Another is when you want to create a 3D representation of an arc within a 
3D polyline. 
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When you draw a 3D polyline arc, you can specify how many vertices you 
want the curve to have. This is because you cannot actually draw a 3D 
polyline curve in AutoCAD; you must draw polyline segments and then use 
the Fillet 3D Polyline command to create the representation of the arc. The 
more vertices, the more realistic the representation of the curve. 

������������	
����������������

� From the Terrain menu, choose 3D Polylines ➤ Fillet 3D Polyline.

The following prompt is displayed:

�����	��������!/,-,,"�

� Define the fillet radius. 

The fillet radius defines the new arc segment at the vertex. You can either 
type a radius or select two points. When you fillet a 3D polyline arc, the arc 
is broken down into line segments. 

The following prompt is displayed:

 �.��������	�����	����	�����	���������������	����!,-0,"�

	 Determine the length of these line segments by defining the distance 
between each vertex using one of the following methods:

� Type a value at the command prompt.
� Select two points to define the distance.

� Select all the vertices you want to fillet, and then press ENTER to continue.

Determine whether to erase the existing polyline or leave it in the drawing. 

� You can press ENTER to erase the old polyline, or type No to leave the old 
polyline. 

NOTE After erasing the old polyline, use the AutoCAD REDRAW command to 
redraw the screen.

Displaying 3D Polyline Grade Breaks

With the 3D Polyline Grade Breaks command, you can display 3D polyline 
grade breaks (changes in slope/grade) on an existing 3D polyline in your 
drawing. The grade breaks are marked with a temporary X.

����������	
� �����������������!�

� From the Terrain menu, choose 3D Polylines ➤ 3D Polyline Grade Breaks.
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The following prompt is displayed:

*�����$����	����!$����	���"�

� At this prompt, do one of the following:

� Press ENTER to accept the default, select the objects(s) in your drawing that 
you want to display grade breaks for, and then press ENTER. 

� Type L for Layer and select an object on the layer the polylines are on, or 
type L, press ENTER, and type the layer name.

Temporary Xs are placed on the polyline to indicate where the grade breaks 
occur. You can type Redraw to remove the markers.

	 Select additional objects, or press ENTER to end the command.

Adding Vertices to Polylines

You can add vertices to any polyline. The polyline can have a constant eleva-
tion, or it can have varying elevations at its vertices. It can be an open or 
closed polyline.

The prompts that are displayed for this command are different depending on 
whether you are adding vertices to a 2D or a 3D polyline, as well as whether 
you select the entire polyline (the By Entity method), or just a segment (the 
By Points method).

Adding Vertices to a 3D Polyline - By Entity

You can add vertices to an existing 3D polyline by selecting the polyline with 
your pointing device. Using this method, you can add vertices along the 
entire length of the 3D polyline.

For information about adding vertices to a single segment of a 3D polyline, 
see “Adding Vertices to a 3D Polyline - By Points” on page 848.

�������������������������������	
��������

� From the Terrain menu, choose 3D Polylines ➤ Add Vertices.

The following prompt is displayed: 

��	�	��
���#���	��

� Select the 3D polyline with your pointing device.

The following prompt is displayed:

���	�����	����	�����	������	��1��	����	�����!2"�
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	 Type the distance to set the additional polyline vertices. This is the horizon-
tal distance between the new vertices. 

The following prompt is displayed:

������������3��	�
4������!4��"�

� At this prompt, type Yes to erase the old polyline, or type No to keep the old 
polyline.

NOTE If you do not erase the old polyline, then you may have trouble select-
ing the new polyline definition because there are now two objects in the same 
location.

New vertices are added along the polyline. The new vertices are assigned a Z 
value that matches the Z value of the first vertex (the original starting point 
of the 3D polyline) of the original 3D polyline you selected.

The following illustration shows an example of adding vertices:

"���������������������������

Adding Vertices to a 3D Polyline - By Points

You can add vertices to an existing 3D polyline by selecting two points that 
define a segment of the 3D polyline. 

For information about adding vertices to an entire 3D polyline, see “Adding 
Vertices to a 3D Polyline - By Entity” on page 847.

�������������������������������	
��������

� From the Terrain menu, choose 3D Polylines ➤ Add Vertices.

The following prompt is displayed: 

��	�	��
���#���	��

� Type P and select points to define the polyline. If you use this option, you 
can select only one segment of the polyline.
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The following prompt is displayed:

���	�����	����	�����	������	��1��	����	�����!2"�

	 Type the distance to set the additional polyline vertices. This is the horizon-
tal distance between the new vertices. 

The following prompt is displayed:

��	�����5�'���	�����	������	���---

�����	����!/,,-,,,"�

� Type the elevation for the first vertex of the selected polyline segment. This 
value is going to be the value of any new vertices that are created along the 
polyline with the Add Vertices command.

The following prompt is displayed:

�����	����6���	���''�������$����7�!/,,"�

� Do one of the following:

� Type the elevation for the second vertex of the selected polyline segment.
� Type D and the difference in elevation between the first and second 

polyline vertices of the selected segment.
� Type S to display the following prompt:

$�����
���%�����!&�'���	�"�

Then press ENTER to accept the default, Infinite, type a slope, or type G 
and a grade.

New vertices are then added to the 3D polyline using the distance specified, 
and elevations are assigned to the new vertices using the elevation defined in 
step 4.

Converting a 2D Polyline to a 3D Polyline and 
Adding Vertices - By Entity

You can convert a 2D polyline to a 3D polyline and add vertices to the new 
3D polyline. There are two options you can use: 

� If you select the existing 2D polyline with your pointing device, you can 
add vertices along the entire length of the new 3D polyline. 

� If you select the existing 2D polyline by selecting two points, you can cre-
ate a new 3D polyline from just that segment. 

This topic describes the first option. For more information about the second 
option, see “Converting a 2D Polyline to a 3D Polyline and Adding Vertices 
- By Points” on page 850.
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��������������������������������
��������

� From the Terrain menu, choose 3D Polylines ➤ Add Vertices.

The following prompt is displayed: 

��	�	��
���#���	��

� Select the 2D polyline with your pointing device.

The following prompt is displayed:

���	�����	����	�����	������	��1��	����	�����!2"�

	 Type the distance to set the additional polyline vertices. This is the horizon-
tal distance between the new vertices. 

The following prompt is displayed:

����	���������������	��������6������� ������	����7�!���	����"

� Type one of the following options:

� Type N and then the number of vertices to add.
� Type M and then the mid-ordinate distance.
� Type D and then the distance between each vertex.

The following prompt is displayed:

������������3��	�
4������!4��"�

� At this prompt, type Yes to erase the old polyline, or type No to keep the old 
polyline.

Converting a 2D Polyline to a 3D Polyline and 
Adding Vertices - By Points

You can add vertices to an existing 2D polyline by selecting two points that 
define a segment of the 2D polyline. 

For information about adding vertices to an entire 2D polyline, see “Convert-
ing a 2D Polyline to a 3D Polyline and Adding Vertices - By Entity” on page 
849.

��������������������������������
��������

� From the Terrain menu, choose 3D Polylines ➤ Add Vertices.

The following prompt is displayed: 

��	�	��
���#���	��

� Type P and select points to define the polyline. If you use this option, you 
can select only one segment of the polyline.
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The following prompt is displayed:

���	�����	����	�����	������	��1��	����	�����!2"�

	 Type the distance to set the additional polyline vertices. This is the horizon-
tal distance between the new vertices. 

The following prompt is displayed:

��	�����5�'���	�����	������	���---

�����	����!/,,-,,,"�

� Type the elevation for the first vertex of the selected polyline segment. This 
value is going to be the value of any new vertices that are created along the 
polyline with the Add Vertices command.

The following prompt is displayed:

�����	����6���	���''�������$����7�!/,,"�

� Do one of the following:

� Type the elevation for the second vertex of the selected polyline segment.
� Type D and the difference in elevation between the first and second 

polyline vertices of the selected segment.
� Type S to display the following prompt:

$�����
���%�����!&�'���	�"�

Then press ENTER to accept the default, Infinite, type a slope, or type G 
and a grade.

New vertices are then added to the 3D polyline using the distance specified, 
and elevations are assigned to the new vertices using the elevation defined in 
step 4.

Joining 3D Polylines

You can use the Join 3D Polyline to select two 3D polylines (with varying ele-
vations) and join them into one new 3D polyline.

���#����	
���������

� From the Terrain menu, choose 3D Polylines ➤ Join 3D Polylines.

� Select the 3D polylines you want to join.

	 Press ENTER.

The 3D polylines you selected are combined into one polyline.
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Weeding 3D Polyline Vertices

You can use the Weed Vertices command to remove extra vertices on 3D 
polylines. 

Using the Weed Vertices command you enter three criteria to determine if a 
vertex should be removed from the 3D polyline. For each of these criteria, the 
command looks at three consecutive vertices. If the three criteria for the 
three consecutive vertices are met, the middle vertex is removed, and the 
command continues to analyze and remove vertices until the end of the 3D 
polyline is reached. 

NOTE When you use the Weed Vertices command, duplicate X,Y vertices are 
removed, even if the Z values are different. If you want to weed a 3D polyline 
and maintain vertices that are duplicate in XY, but not in Z, then you must first 
move one of the vertices slightly away from the other (in the X,Y plane).

��������	
�����������������

� From the Terrain menu, choose 3D Polylines ➤ Weed Vertices.

The following prompt is displayed:

$����	���3��	�����6��	�	��*����7�!*����"�

� Do one of the following to select the 3D polylines you want to weed:

� Type Entity and then select the 3D polylines from the drawing.
� Type Layer and then select a polyline on the layer you want to select, or 

press ENTER to specify a layer name to select.

The 3D Polyline Weeding dialog box is displayed and the number of valid 3D 
polylines that you selected is displayed in the Number of 3D Polylines 
Selected box.
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	 Under Weeding Factors, specify the Maximum Horizontal Distance. For each 
of the criteria you specify for this command, the command looks at three 
consecutive vertices. The XY distance from the first and third vertices must 
be less than the Maximum Horizontal distance.

� Specify the Maximum Horizontal Deflection Angle. The XY deflection angle 
between the two segments formed by the three vertices must be less than 
Maximum Horizontal deflection angle.

� Select the Check for Grade Breaks check box if you want to use the Maximum 
Grade Change value as part of the criteria for weeding the polyline vertices.

� If you selected the Check for Grade Breaks check box, then specify the Max-
imum Grade Change (Percent) value. The vertical grade change (Z) between 
the two segments formed by the three vertices must be less than the Maxi-
mum Grade Change percent.

$ Select the Erase Existing 3D Polylines check box to erase the polyline(s) that 
you selected. If you clear this check box, then the new, weeded polylines are 
drawn on top of the existing polylines.

The program applies the weeding factors on the set of 3D polylines selected 
and highlights the removed vertices with a temporary red + or x. The com-
mand line displays the total number of original vertices, the total number of 
vertices removed, and the number of new vertices.
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34Creating and Managing 
Surface Sections

To help you determine a surface’s characteristics, you 

can create cross sections of the surface. AutoCAD Land 

Development Desktop has two different methods you 

can use to create sections. You can create quick sections 

that display in a window, or you can create cross sec-

tions that you can import into a drawing.

In this chapter

� Creating Surface Sections

� Creating Surface Sections to 
Import and Query

� Creating Quick Surface 
Sections
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Creating Surface Sections

To better visualize the slopes of a surface, you can create cross sections of the 
surface. You can create two types of sections: 

� Sections you can import into the drawing and query.
� Quick cross sections that are displayed in a separate window.

Creating Surface Sections that You Can 
Import and Query

You can create sections that you can import into the drawing, query, and use 
for final plotting. Creating the sections is a three-step process. First, you 
define where the sections will be cut. Next, you process the section data for 
those sections, and finally you can import the sections into the drawing. You 
can create sections that show section data for more than one surface, which 
can give you an idea of cut and fill situations.

Turning Multiple Surfaces On or Off for Creating 
Surface Sections

You can turn on the use of multiple surfaces, and then create a multiple sur-
face file for generating surface sections. For more information, see “Creating 
Surface Sections from Multiple Surfaces” on page 856.

����������	�
�	������������������

� From the Terrain menu, choose Sections ➤ Multiple Surfaces On/Off.

If multiple surfaces are on, then all the surfaces you select with the Define 
Multiple Surfaces command are used to create sections. The elevations for the 
section are extracted from the surface associated with each surface name in 
the file. If multiple surfaces are off, then only the current surface is used.

Creating Surface Sections from Multiple Surfaces

You can choose the surfaces from which to create cross sections.
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� Turn on the use of multiple surfaces. For more information, see “Turning 
Multiple Surfaces On or Off for Creating Surface Sections” on page 856.

� From the Terrain menu, choose Sections ➤ Define Multiple Surfaces to dis-
play the Multiple Surface Selection dialog box.

� Select the surfaces you want to use by clicking the surface names in the Select 
from list. As soon as you click a surface name in the Select from list, it is 
placed into the Current list. 

You can press the SHIFT key to select more than one surface name at a time, 
or press the CTRL key to select non-sequential surface names.  

� Click OK to create the multiple surface file. 

Defining Surface Sections

You can define which cross sections you want to view when you import them 
into a drawing. To do this, you name the cross section group that you want 
to create, and then pick points on the surface to define the start and end 
points of the cross section to create. 

������
�����������������
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� To create sections for more than one surface, choose the surfaces to use. For 
more information, see “Creating Surface Sections from Multiple Surfaces” on 
page 856.

� Import the surface as 3D lines. For more information, see “Importing the Sur-
face as 3D Lines” on page 726.

This is recommended so that you can see which points on the surface to 
select.

� From the Terrain menu, choose Sections ➤ Define Sections.

� Type a group label for the section. This label can have up to eight characters. 
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You can use this label to organize related sections together. For example, you 
can create a group of sections across a particular building pad that you can 
group together using the name of the building as the group label. 

� Type a section label for the section. This label can have up to eight characters. 
You can use this label to add a more descriptive label to the section, such as 
offset from a particular base line.

� Select the endpoints of the cross section by either picking points or typing 
coordinates of the endpoints. 

The following illustration shows a section line drawn across a surface:

����
���	
��

� Repeat steps 5–6 to define more cross sections for the group. 

To create a new group, press ENTER at the Section Label prompt. The Group 
Label prompt is displayed. You can type a new group label and create sections 
for the new group.

� Press ENTER twice to end the command. 

� Process the cross section elevational information before you import the cross 
sections into your drawing. For more information, see “Processing Surface 
Sections” on page 858.

Processing Surface Sections

After you define the sections that you want to view, you need to process the 
cross sections using the Process Sections command. This command extracts 
the elevations of the cross sections from the surface(s). For more information, 
see “Defining Surface Sections” on page 857.

��������������������
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� From the Terrain menu, choose Sections ➤ Process Sections. 
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If you defined more than one group of sections, then the groups that you 
defined are displayed at the command line. 

� Type the name of the group that you want to process. 

The command processes the sections.

� Type the name of another group to process, or press ENTER to end the 
command.

� Import the sections into the drawing. For more information, see “Importing 
Surface Sections into the Drawing” on page 859.

NOTE If you already processed cross sections, then you are prompted to 
append the new cross sections to the existing file. If you select Yes, then the 
newly processed sections are appended to the section file that you defined ear-
lier. If you select No, then the existing section information is deleted and a new 
section file is created. 

If a newly-defined group has the same name as an existing group, then the 
following prompt is displayed:

����������������	
	
��������������������������������������

������

If you type Yes, then the command prompts you to name the new group. If 
you type No, then the old group and sections within the group are deleted.

If multiple surfaces are turned on, then the surfaces as specified in the Define 
Multiple Surfaces command are accessed and elevations for each defined sec-
tion are extracted. These elevations are included in the section file used by 
the Import Sections command. 

For more information about multiple surfaces, see “Turning Multiple Sur-
faces On or Off for Creating Surface Sections” on page 856. For more infor-
mation on defining multiple surfaces, see “Creating Surface Sections from 
Multiple Surfaces” on page 856. For more information on importing sections, 
see “Importing Surface Sections into the Drawing” on page 859. 

Importing Surface Sections into the Drawing

After you process cross sections, you can import them into a drawing. For 
more information about processing cross sections, see “Processing Surface 
Sections” on page 858. 

���
����������������
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������������
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� Create a project with at least two overlapping surfaces.



860 | Chapter 34 Creating and Managing Surface Sections

� Turn on the use of multiple surfaces. For more information, see “Turning 
Multiple Surfaces On or Off for Creating Surface Sections” on page 856.

� Choose the surfaces from which to create cross sections. For more informa-
tion, see “Creating Surface Sections from Multiple Surfaces” on page 856.

� Define the surface sections. For more information, see “Defining Surface Sec-
tions” on page 857.

� Process the cross sections. For more information, see “Processing Surface Sec-
tions” on page 858.

� From the Terrain menu, choose Sections ➤ Import Sections.

The following prompt is displayed:

������������������������������������
�

� Type a layer name for the datum line and datum block, or press ENTER to 
accept the default.

The datum block is the block to the left of the imported section. This block 
contains the datum label, group label, and section label.

The following prompt is displayed:

 ���!����!�����!�����"#
�

� Type the vertical scale factor for the cross section.

To exaggerate the features of a cross section, make this number greater or less 
than 1.

� Pick an insertion point for the first cross section. The command line displays 
the group name and section name of the cross section that you are inserting. 

The command displays the minimum and maximum elevation of the cross 
section, and suggests a default datum elevation based on these numbers.

�� Accept the default, or type a new value for the datum elevation. 

�� Repeat steps 9 and 10 for each cross section that you want to import. 

If the defined sections are completely outside the surface or sections are not 
defined, then the following error message is displayed:

$���!���������!�������������������������������

The following illustration shows a surface section imported into a drawing:
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Placing a Grid Over Surface Sections

You can place a grid onto imported surface sections that shows elevation and 
spacing values, as shown in the following illustration:

 �
�����
������������������
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� From the Terrain menu, choose Sections ➤ Grid For Sections. 

� Type a layer name for the grid, or press ENTER to accept the default.

� Click any part of the datum block that contains the DATUM ELEV, GROUP 
name, and SECTION name. This block is located to the left of the section.

� Type an elevation increment for the grid.

This is the vertical spacing of the grid. For example, if you want a grid line to 
mark the change in elevation for every 2 meters, then type 2.

NOTE This spacing is exaggerated based on the vertical exaggeration of the 
cross section. 

� Type an offset increment for the grid.
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This is the horizontal spacing of the grid. For example, if you type 2, then a 
grid line is placed every 2 meters (or feet, depending on the units you use) 
along the cross section. 

� Select another datum block and repeat steps 4–5, or press ENTER to end the 
command.

Listing the Elevation of a Point on a Surface 
Section

You can list the elevation of a point on a surface section with respect to a 
selected section. 

���	
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� Import the cross section into the drawing. For more information, see 
“Importing Surface Sections into the Drawing” on page 859.

� From the Terrain menu, choose Sections ➤ List Elevation.

� Select the datum block of the section.

The datum block of the section labels the DATUM ELEV, GROUP name, and 
SECTION name. This block is located to the left of the section. 

� Pick the point in the cross section that you want to display the elevation of. 

The selected point’s elevation is displayed at the command line.

� Continue to pick more points to list, or press ENTER to display the Select 
desired section DATUM block prompt. At this prompt, you can select the 
datum block of another section, or press ENTER to end the command.

Listing the Elevational Difference Between Two 
Points on a Surface Section

You can list the elevational difference (vertical distance) between two points 
with respect to a selected section and its datum and scale. 
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� Import the cross section into the drawing. For more information, see 
“Importing Surface Sections into the Drawing” on page 859.

� From the Terrain menu, choose Sections ➤ List Depth.

� Select the datum block of the section.

The datum block of the section labels the DATUM ELEV, GROUP name, and 
SECTION name. This block is located to the left of the section. 

� Select two points that you want to list the elevational difference between. 
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The elevational difference between the two points is listed with respect to the 
selected datum block. The vertical scale of the selected section is taken into 
account.

� Choose another section at the Select desired section DATUM block prompt, 
or press ENTER to end the command.

Creating Quick Surface Sections

For quick visualization of surface slopes of the current surface, you can create 
quick section views. Quick sections appear in a separate window on the 
screen. As you move your pointing device over the section, the distance and 
elevation values are displayed on the section window title bar. 

When you create quick cross sections, you draw a line across the surface to 
indicate where the section is to be cut. These lines are called section lines. 
You can access a shortcut menu by right-clicking a section line. You can use 
the shortcut menu options to close the section window, to redisplay the sec-
tion in the section window, to view section statistics, and to change the color 
of a section line. Section lines are not saved with the drawing. However, to 
keep a line in the drawing to indicate where a section was cut, use the 
EXPLODE command to convert the section line into a polyline that is saved 
with the drawing.

NOTE These cross sections are intended for visualization purposes to help you 
edit the surface. To create final cross sections for plotting, use the Define 
Sections, Process Sections, and Import Sections commands. For more informa-
tion on these commands, see “Defining Surface Sections” on page 857, “Pro-
cessing Surface Sections” on page 858, or “Importing Surface Sections into 
the Drawing” on page 859.

Creating Quick Surface Sections and Profiles

You can create a quick section view in a separate window by drawing a sec-
tion line across the current surface. You can grip edit the section line to auto-
matically update the cross section. If you edit the surface, then you can 
update the cross section using the Update Section Views command. For more 
information, see “Updating Quick Surface Sections and Profiles” on page 
865.
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TIP If you use the Create Section View command to display more than one sec-
tion view, then you can drag the second cross section window to a new location 
on your screen so you can view both sections simultaneously. 
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� Select the current surface. For more information, see “Making a Surface Cur-
rent” on page 694.

� From the Terrain menu, choose Sections ➤ Create Section View. 

� Pick two or more points on the surface to draw a line where you want to cut 
the cross section. 

� Press ENTER to draw the cross section.

The cross section window is displayed on your screen, showing the cross sec-
tion along with the elevation and offset values of the cross section.

After you draw a cross section line and display a cross section view, you can:

� Change the cross section properties, such as color, vertical scale factor, and 
tick increment. For more information, see “Changing the Properties of 
Quick Sections and Profiles” on page 866.

� Close the window and redisplay it later. For more information, see “Clos-
ing the Section Window” on page 866 and “Redisplaying Quick Sections 
in the Section Window” on page 866.

� Save the cross section view as a Windows metafile. For more information, 
see “Saving Quick Surface Sections and Profiles as Windows Metafiles” on 
page 865.

� Copy the cross section to the clipboard to paste into your drawing files. 
For more information, see “Copying Quick Sections to the Clipboard” on 
page 865.

� Grip edit the section line to display a different cross section in the same 
window. For more information, see “Grip Editing Quick Section Lines” on 
page 869.
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� Edit the surface, and then run the Update Section View command, which 
refreshes the view(s) in the cross section window(s). For more informa-
tion, see “Updating Quick Surface Sections and Profiles” on page 865. 

� View the cross section statistics. For more information, see “Viewing the 
Statistics of Quick Sections and Profiles” on page 868.

� Use the EXPLODE command to explode the section line to a 3D polyline 
that you can save with the drawing. 

Updating Quick Surface Sections and Profiles

You can update a quick cross section after editing the surface.
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� From the Terrain menu, choose Sections ➤ Update Section Views.

All quick sections are automatically updated with any edits that you made to 
the surface.

NOTE The section window need not be visible to update the section. 

Saving Quick Surface Sections and Profiles as 
Windows Metafiles

You can save a cross section view as a Windows metafile. This is a common 
image format that you can insert into many different applications. 
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� Use the Create Section View command to create a cross section. For more 
information, see “Creating Quick Surface Sections and Profiles” on page 863.

� From the Section menu in the cross section window, choose Save As to dis-
play the Save As dialog box.

� Choose a location in which to save the file.

� In the File Name box, type a name for the file.

� Click Save to save the file.

Copying Quick Sections to the Clipboard

You can copy a cross section to the clipboard to paste into either an AutoCAD 
drawing or another application.
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� Use the Create Section View command to display a cross section. For more 
information, see “Creating Quick Surface Sections and Profiles” on page 863

� From the Section menu in the cross section window, choose Edit.

� Paste the cross section into AutoCAD or another application.

Closing the Section Window
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� Right-click on the title bar of the cross section window to display the shortcut 
menu.

� Select Close to close the section window.

Redisplaying Quick Sections in the Section 
Window

If you close the section window, then you can redisplay the cross section 
window. For more information, see “Closing the Section Window” on page 
866.
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� Click on the cross section line that you drew on the surface.

� Right-click to display the shortcut menu.

� Click View Section.

Changing the Properties of Quick Sections and 
Profiles

You can change both the grid settings and the color settings of the quick 
cross sections in your drawing.
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� Create a quick cross section. For more information, see “Creating Quick Sur-
face Sections and Profiles” on page 863.

� From the Section menu in the cross section window, choose View Properties 
to display the Quick Section Properties dialog box.

� Click the Grid Settings tab.
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You can modify the following settings:

� Vertical Factor: Changes the vertical exaggeration of the cross section. By 
default, the section displayed in this window uses the current ratio of hor-
izontal to vertical scale for the drawing that you set in the Drawing Setup 
dialog box.

� Number of Tick Marks: Changes the number of tick marks displayed 
along the elevation axis of the cross section window. 

� Minimum Interval Increment: Specifies what elevational change each 
tick mark along the elevation axis represents. For example, an interval 
increment of 10 causes each tick mark to represent an elevational change 
of 10 units. A value of 0 represents no minimum. Set the spacing based on 
both the elevation range of the section and number of tick marks set. 

� Click the Color Settings tab to change the colors of the line color, grid color, 
text color, or background color that are shown in the Section window.

To change the color of a cross section window component, click the color 
box next to a component to display the Select Color dialog box. Select a color 
and then click OK.
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NOTE If elevation labels start to overlap on the section view, then they are 
removed. To see this behavior, slowly make the window smaller and watch the 
text. 

Viewing the Statistics of Quick Sections and 
Profiles

You can view the statistics of a quick cross section.
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� Create a quick cross section.

� From the surface, click the section line to display the grips.

� Right-click to display the shortcut menu.

� Click Properties to display the Section Properties dialog box.

� Click the Statistics tab to view the cross section statistics.

NOTE You can change the color of the cross section line by clicking the Color 
tab. For more information, see “Changing the Color of Quick Section Lines” 
on page 869.

� Click OK.
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Changing the Color of Quick Section Lines
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� Create a quick cross section. For more information, see “Creating Quick Sur-
face Sections and Profiles” on page 863.

� From the surface, click the section line to display the grips.

� Right-click to display the shortcut menu.

� Select Properties to display the Section Properties dialog box.

� Click the Color tab.

� Click the Color box to display the Select Color dialog box.

� Select a color.

� Click OK to return to the Section Properties dialog box.

� Click OK to end the command.

Grip Editing Quick Section Lines

To edit a quick cross section so that it displays a different surface view, you 
can edit the section line using grips.
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� Click a cross section line to display the grips.

� Select the grip you want to move.

� Drag it to the new location.
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The cross section in the section window is updated automatically.

Exploding Quick Section Lines into Polylines

You can explode a cross section line into a 3D polyline that follows the ele-
vations of the surface. 

����'�	�������������
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� Create a quick cross section. For more information, see “Creating Quick Sur-
face Sections and Profiles” on page 863.

� Type Explode at the command line.

� Select the cross section line.

� Press ENTER.

The cross section line is converted to a 3D polyline that is saved with the 
drawing.
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35Calculating Volumes

The Volumes menu provides commands to define the 

site for volume calculations and compute the volume 

between two surfaces using one of the three methods of 

calculation: grid, composite surface, and section meth-

ods. Before running most Volume commands, you must 

select a current stratum.

Using the Volume Reports command, you can report 

total volume data for a site, create an ASCII file of total 

site volume data, and create a parcel volume table. 

In this chapter

� Volume Calculation Methods

� Using a Stratum for Volume 
Calculations

� Using Sites for Volume 
Calculations

� Managing Site Definitions

� Calculating Grid Volumes

� Calculating Composite Volumes

� Calculating Section Volumes

� Plotting Volume Sections

� Outputting Volume Data
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Performing Volume Calculations

AutoCAD Land Development Desktop provides three volume calculation 
methods that you can use to calculate volumes between two surfaces: Grid, 
Composite, and Section. For more information about each type of volume 
calculation method, see “Volume Calculation Methods” on page 872.

All methods use a stratum to define which two surfaces to calculate volumes 
from. For more information, see “Defining a Stratum” on page 877. All meth-
ods also require a site. A site defines the area inclusive of the stratum to cal-
culate volumes from. It also defines grid spacing for volume calculations.

After you calculate total site volumes using either the Grid or Composite 
methods, you can calculate parcel volumes. To calculate parcel volumes, 
valid parcels must be defined in the project.

Volume Calculation Methods

AutoCAD Land Development Desktop provides three methods for perform-
ing volume calculations: Grid, Composite Surface, and Section (which can be 
done with both the Average End and Prismoidal methods).

Both the Grid and Section methods are approximations controlled by the 
grid spacing. Therefore, varying results may occur if the surfaces are either 
not sampled often enough or are sparsely populated with data. We recom-
mend that when you use grid-based and average-end area (section) volumes, 
you make sure the grid spacing is not too small as to sample too often, and 
not too large as to result in an imprecise volume estimate. In any case, use all 
three volume calculation types (including different scenarios for each vol-
ume type) as redundancy checks. Use your own judgment when deciding 
which result is appropriate for the site.

The Grid and Composite Volume methods create volume surfaces that repre-
sent the depth of cut and fill. Any command that generates information 
based on a surface can be used with the volume surface. You can, for exam-
ple, create contours or points based on depth of cut and fill. Volume surfaces 
are displayed in the Terrain Model Explorer.

Using the Grid Method

The Grid method calculates volumes using a grid overlaid on the two surfaces 
that comprise the current stratum. This method calculates the volumes by 
using the prismoidal volume of all grids and summarizing. This method is 
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most accurate when the grid spacing is less than the average surface data 
spacing.

The following illustration shows this process:
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The Grid method breaks the site into a series of grid cells in rows and col-
umns that are determined by the Define Site command. For more informa-
tion, see “Defining a Site for Volume Calculations” on page 880. The Grid 
method uses the M and N size that you specify when you define the site to 
determine the dimensions of the grid cells. The Grid method samples the ele-
vations of the existing and proposed surfaces at the corners (or grid nodes) of 
each cell. It then breaks the resulting face into two triangular prisms. If any 
corner of the cell falls outside of the surfaces, then the entire cell area is dis-
carded. The cells are then split into individual prismoidal objects.

The Grid method uses approximations controlled by the grid spacing. When 
you use grid-based volumes, make sure the grid spacing is not too large, 
which might result in imprecise volume estimates. In any case, you can use 
both the Grid and Composite Volume methods, and then decide which 
result is appropriate for the site.

NOTE You can import the cut and fill grid ticks to view the sampling locations 
for the grid volumes. 
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Using the Composite Method

When you calculate the volumes using this method, instead of using a grid, 
the Composite method re-triangulates a new surface based on points from 
both surfaces. It uses the points from both surfaces, as well as any location 
where the triangle edges between the two surfaces cross. The command then 
calculates the new composite surface elevations based on the difference 
between the elevations of the two surfaces.

This method is the most accurate, giving the exact volumes between the two 
surface definitions.

Using the Section Method

The Section method calculates cross sections from the two surfaces of the 
current stratum, and generates volumes using either of two methods: 
Prismoidal or Average End Area. You can interpolate sections in either the M 
or N direction, with spacing based on the grid spacing of the defined site. You 
can then plot the sampled sections to verify the areas.

The following illustration shows the relationship of M and N to the AutoCAD 
X and Y axes in the Average End Area grid lines:
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The command defines each section line in the direction sampled to be a sta-
tion. For example, if the grid is designed to use a cell width of 20 units, then 
each station is 20 units apart. The first section is always station 0+00 (0+000 
in metric units). The fourth section would be assigned a station value of 0+60 
(0+060 in metric units).

As each section is sampled, the command calculates the offset and elevation 
for each triangle edge that the section crosses on the surfaces. The offsets are 
always positive, and calculated from left to right along the section line in the 
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direction of station progression. Each station (section) usually has several off-
sets and elevations. 

The following illustration shows this relationship:
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After the sections are sampled, the command uses either the Average End 
Area or Prismoidal method to calculate the volumes for the site. The follow-
ing illustration shows the Average End Area method:
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The Prismoidal method is similar to the Grid method. However, the 
Prismoidal method used for section volumes calculates the prismoidal 
objects between sections rather than between surfaces. 

The following illustration shows the Section Prismoidal method:
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Using a Stratum for Volume Calculations

Using the Select Current Stratum command on the Terrain menu, you can 
define, select, and delete a stratum in your drawing. 

A stratum contains two surfaces that exist in your project, usually the exist-
ing ground surface and a finished ground surface, and is used for calculating 
volumes. The following illustration shows a sample stratum:
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You can also define multiple strata with various types of combinations. 
When you calculate volumes, you are prompted for the stratum to be used 
for those computations.



Using a Stratum for Volume Calculations | 877

Defining a Stratum

You can define a stratum to use for calculating volumes. 
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� From the Terrain menu, choose Select Current Stratum. 

If you haven’t defined a stratum, then the Define Stratum dialog box is 
displayed.

If you have already defined a stratum, then the Select Current Stratum dialog 
box is displayed. Click the New button to display the Define Stratum dialog 
box. 

� In the Name box, type the name of the new stratum.

� In the Description edit box, type the description.

� Select the two surfaces that will make up the stratum. The order of these sur-
faces is important. For volume calculation purposes, Surface 1 is the existing 
ground surface and Surface 2 is the proposed surface. To select the two sur-
faces that will make up the stratum, you can:

� Type the names of the surfaces in the Surface 1 and Surface 2 boxes.
� Click the Select button to display the Select Surface dialog box, where you 

can select the surfaces to use.

 Click OK to define the stratum.

Selecting the Current Stratum

You can select the current stratum to work with. 
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� From the Terrain menu, choose Select Current Stratum to display the Select 
Current Stratum dialog box.
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� From the Selection list box, select the stratum to use. 

� Click OK.

Deleting a Stratum

You can delete a stratum from your project.

�
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� From the Terrain menu, choose Select Current Stratum to display the Select 
Current Stratum dialog box.

� From the Selection list box, select the stratum to delete.

� Click the Delete button. 

A warning message is displayed, informing you that the program is about to 
remove the strata.

� Click Yes or No:

� Click Yes to delete the stratum. 
� Click No to save the stratum.

 Click OK to exit the Select Current Stratum dialog box.

Using Sites for Volume Calculations

To calculate volumes, you must define a site. A site controls both the area on 
the stratum for which you want to calculate volumes, and the grid spacing 
which is used for both the Grid and Section methods.

Changing the Volume Site Settings

You can control both how sites are labeled with volume information, and 
how grid cells for volume calculations are defined.
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� Do one of the following to display the Volume Site Settings dialog box:

� From the Terrain menu, choose Site Definition ➤ Site Settings.
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� From the Projects menu, choose Drawing Settings to display the Edit 
Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Volume Site Definitions and click the Edit 
Settings button.

The first two parts of the dialog box, the M Direction and N Direction sec-
tions, control the grid cell definition for creating sites. You must set these set-
tings before defining a site.

� Under the M (x) Direction, define the grid parameters for the M direction. If 
the rotation angle on the grid is 0.0, then M corresponds to the X direction. 
When you define a site for volume calculations, the values you set here for 
the M Direction are the defaults.

� Determine how to size the grid by selecting either the Size or Number option. 
If you select Size, then the number you type in the Value box is the length of 
the cell in the M direction. If you select Number, then the number you type 
in the Value box is the number of cells in the M direction.

� Under N (y) Direction, define the grid parameters for the N direction. If the 
rotation angle on the grid is 0.0, then N corresponds to the Y direction. 
When you define a site for volume calculations, the values you set here for 
the N Direction are the defaults.

For information about these options, see step 3.

NOTE The Grid method for calculating volumes is an approximation con-
trolled by the grid spacing. When you use grid-based volumes, make sure the 
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grid spacing is not too large, which might result in an imprecise volume 
estimate.

NOTE The next sections of the dialog box control how the sites are labeled 
when you import them into the drawing with the Site Manager command. For 
more information, see “Managing Site Definitions” on page 884.

 Under Site Labeling, type a text style to use for the labels in the Text Style 
box. Or, click Select and select a text style to use, and click OK to return to 
the Site Settings dialog box.

NOTE If you use metric units, then only metric styles, plus Standard, Dimtext, 
and Ashade are displayed. If you use English units, then only English styles plus 
Standard and Dimtext are displayed. 

" Under Volume Labeling, set the precision, text style, and suffix for volume 
labels:

� Text style: Type the text style used for volume labeling. Or, click Select 
and select a text style to use, and click OK to return to the Volume Site 
Settings dialog box.

� Suffix: Type the suffix to use for volume labeling, such as yards or meters.
� Precision: Type the precision for labeling volumes, or use the slider to 

adjust the value. This precision value affects only the display of the vol-
ume labels.

# In the Site layer edit box, type the layer for the site lines and labels.

$ Select the Automatic Label Placement check box to place site labels automat-
ically as they are imported.

% Click OK.

Defining a Site for Volume Calculations

To calculate volumes, you must define the area that will be used in the vol-
ume calculations. This area is called a site, which you can define using grid 
cells. The site definition is stored in the control file, {project}.gcf. This file 
also holds any parcel definitions for the project and all the volume 
calculations.
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� Define a stratum. For more information, see “Defining a Stratum” on page 
877.

� In the Volume Site Settings dialog box, set the M Direction and N Direction 
parameters. For more information, see “Changing the Volume Site Settings” 
on page 878.

� From the Terrain menu, choose Site Definition ➤ Define Site.

The following prompt is displayed:
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� To define the rotation angle of the grid, do one of the following:

� Press ENTER to place the grid cells at zero rotation.
� Type another rotation angle in the format specified.
� Select two points to define the angle.

You can use a rotation angle for any site that is not positioned horizontally. 
For example, if a site has contours that run at approximately 30 degrees, you 
can rotate the grid accordingly.

 Select the site base point. This is the lower-left corner of the grid.

" Define the Grid M size and Grid N size, or the Grid M number and Grid N 
number if you want to use values other than the defaults you selected in the 
Site Settings dialog box.

� If you define the grid by size, type the size of the cells in the M and N direc-
tions at the following prompts:
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Generally, the Grid M and Grid N size can be related to the density of data 
on the surfaces. If surface points are, on average, 50 units apart, then the 
grid cells should be no larger than 50 units square, or an M size of 50 and 
a N size of 50, to generate accurate volumes.

The following illustration shows a grid with unequal M and N sizes:
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� If you define the grid cells by number, then type the number of cells in the 
M and N directions at the following prompts:
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The grid cells are sized according to the number of rows and columns spec-
ified by the M and N numbers, and the size of the site. 

The following illustration features grid cells as defined by number:
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NOTE A large grid cell size can adversely affect the grid or average end area 
section volumes. 

# Select the upper-right corner of the site. This corner must be in the rotated 
first quadrant with respect to the base point. If this corner is not selected in 
the correct location, then an error message is displayed and you have to 
repeat steps 4–7.

$ The command draws outlines to demonstrate both the extents of the site and 
the size of the grid cell.

The following prompt is displayed:
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% Do one of the following:

� Press ENTER to continue.

IMPORTANT Type Yes to change the rotation angle, base point, Grid M and 
Grid N values, and/or upper-right corner of the grid.

The following prompt is displayed:
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�* Type Yes or No:

� Type Yes to erase the old site outline.
� Type No to continue.

�� Type the name for the site. The site name can be up to 30 characters.

NOTE If an existing site has the same name, you are prompted either to 
change the name or overwrite the existing site. The command then defines the 
grid and either creates the control file or appends the new information to an 
existing file. If you delete the control file or remove the site definition, then you 
must recreate the site definitions and volumes. 

The following illustration shows the site definition parameters:
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Managing Site Definitions

Use the Site Manager to report data about sites, delete sites, and import sites 
that are defined in the project into the drawing.

Reporting Site Information

You can output the site definition details, such as the rotation angle, grid M 
and grid N values, and the lower-left and upper-right corners of the site.
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� From the Terrain menu, choose Site Definition ➤ Site Manager to display the 
Site Manager dialog box.

� Click the Output Settings button to display the Output Settings dialog box 
where you can select output options. For more information, see “Changing 
the Output Settings” on page 79.

� Click OK to return to the Site Manager dialog box.

� From the Select site list, select the sites to report. When you select a site, an 
asterisk (*) appears next to it.

TIP You can click the Select All button to select all sites in the list, or click the 
Clear All button to clear the selection set.

 Click the Info button to create the report.

The report is created as follows:
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Importing Sites into the Drawing

If you delete the rectangle from your drawing that represents the site, or if 
you create a new drawing and want to import the site rectangle, then you can 
import the site into a drawing.
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� Change the Volume Site Settings. For more information, see “Changing the 
Volume Site Settings” on page 878.

� From the Terrain menu, choose Site Definition ➤ Site Manager to display the 
Site Manager dialog box.

� From the Select Site list, select the sites to import. When you select a site, an 
asterisk (*) appears next to it.

TIP You can click the Select All button to select all sites in the list, or click the 
Clear All button to clear the selection set.

� Click the Import button.

A message dialog box is displayed.

 Click Yes or No:

� Click Yes to create site labels for the imported sites. 
� Click No if you do not want to label the sites.
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" If you click Yes, and you did not select the Automatic Label Placement check 
box in the setting, then select an insertion point for the label. 

The following prompt is displayed:
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# To define the label rotation angle, use one of the following methods:

� Press ENTER to place the label at zero rotation.
� Type another rotation angle in the format specified.
� Select two points to define the angle.

Deleting Sites from the Project

You can delete a site from the project if it is no longer needed.
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� From the Terrain menu, choose Site Definition ➤ Site Manager to display the 
Site Manager dialog box.

� From the Select Site list, select the sites to import. When you select a site, an 
asterisk (*) appears next to it.

TIP You can click the Select All button to select all sites in the list, or click the 
Clear All button to clear the selection set.

� Click the Delete button.

A warning dialog box is displayed.

� Click Yes or No: 

� Click Yes to delete the sites.
� Click No to keep the sites.

Calculating Grid Volumes

Use the Grid method to calculate volumes for a site and for parcels within the 
area of that site. The Grid method requires both a stratum and a site. For 
more information, see “Using the Grid Method” on page 872 in this chapter.
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Changing the Grid Volume Settings

To calculate the volume of a differential grid surface, you need to set the grid 
volumes settings.

�
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��������������

� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box.

� Under Program, select Land Development Desktop.

� Under Settings, click Grid Volumes.

� Click Edit Settings to display the Grid Volume Settings dialog box.

 Under Elevation Tolerance, type a value in the Minimum difference edit box.

The elevation tolerance factor determines how large a difference in elevation 
between two surfaces must exist in order to be included in volume calcula-
tions. The volume commands compare the two surfaces at each grid node. If 
the difference in elevation between the two surfaces is less than the elevation 
tolerance at a grid point, then it is considered to be 0.

For example, if the elevation tolerance factor is 0.5 units, then the calcula-
tions ignore any elevational difference between the two surfaces that is less 
than 0.5 units. The calculations include any elevational difference that is 0.5 
units or greater.

" Type a Cut factor and a Fill factor for the Grid Volumes Corrections values. 
These values compensate for expansion and compaction of the surface mate-
rial, and help to determine the actual volume of material that needs to be 
removed (the cut factor) or added (the fill factor) to the site.

� Cut factor: Compensates for the expansion factor of the material left 
after the cut.

� Fill factor: Compensates for the compaction factor of the fill material.
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For example, for a material that expands 15 percent, type the value 1.15. 
However, for a material that compacts to 93 percent of its original value, type 
0.93. A factor of 1.00 does not adjust the volumes.

# Under Grid Volumes Output, determine the type of output file that the 
Volume commands generate by selecting one of the following options:

� Select None if you do not want an external file to be written when grid 
volumes are calculated. Grid volume calculations are still written to the 
control file even when this option is selected.

� Select SDF (Space Delimited File) to output the grid volumes to an ASCII 
file that is broken down into columns. This file uses the output settings 
set in the Output Settings dialog box.

The following text illustrates an SDF file output:
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% % �7-8/905�.�7-::9%--%��78.89.:-8

% - �70/19%%.0�701:9%-85��7///9-011

% 0 �7.8�908-:�7.5�9�./���71%�9011/

% . �7.589-05/�7.809:�%���71%19�0//

� Select CDF (Comma Delimited File) to output the grid volumes to an 
ASCII file that is separated by commas. This format has no headers. The 
following text illustrates a CDF file:

%;%;7-8/905�.0/;7-::9%--%�.;78.89.:-8.�

%;-;70/19%%.-5.;701:9%-85�%;7///9-01:58

%;0;7.8�908-/51;7.5�9�.518-;71%�9011/-�

%;.;7.589-05510;7.809:�%�.%;71%19�0//08

$ Click OK.

Calculating Total Site Volumes Using the Grid 
Method

You can calculate the total site volume using the Grid method.

�
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� Define a stratum. For more information, see “Defining a Stratum” on page 
877.

� Define a site. For more information, see “Defining a Site for Volume Calcula-
tions” on page 880.

� From the Terrain menu, choose Grid Volumes ➤ Calculate Total Site Volume 
to display the Site Volume Librarian dialog box.
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NOTE If you haven’t selected a current surface or stratum, the Select Current 
Stratum dialog box displays. Select the surface or stratum and click OK. 

� Select the site for which you want to calculate volumes.

 Click OK.

The command derives a volume by computing the prismoidal volume of 
each face on the grid surface, and displays the Grid Volume Settings dialog 
box.

" You can change the Grid Volume Settings. For more information, see 
“Changing the Grid Volume Settings” on page 887.

# Click OK to display the Volume Results Surface dialog box.

$ In the New Surface box, type a name for the grid volume surface.

NOTE If you have already built a grid volume surface for the current stratum 
and site, the program prompts you to use the name of the new surface and over-
write the existing surface. If you click NO, the program prompts you for a new 
surface name. If you give the name of another existing surface, you are 
prompted to overwrite that surface. If you click NO, the prompt for a new name 
is repeated until you specify a valid surface name that is either new, or existing 
that you want to overwrite.
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% Click OK.

The volumes are calculated, and the volume surface is added to the Terrain 
Model Explorer.

Calculating Parcel Volumes Using the Grid 
Method

After you calculate the total site volumes, you can calculate the cut and fill 
volumes of selected parcels.

�
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� Calculate the total site volume using the Calculate Total Site Volume 
method. For more information, see “Calculating Total Site Volumes Using 
the Grid Method” on page 888.

� Define at least one parcel. For more information, see “Defining Parcels” on 
page 505.

� From the Terrain menu, choose Grid Volumes ➤ Calculate Parcel Volumes. 

If you haven’t selected the current stratum and surface, then you are 
prompted to do so. The Site Volume Librarian dialog box is displayed.

� Select the site for which you want to calculate parcel volumes.

 Click OK to display the Parcel Volume Librarian dialog box.

" Choose the parcel name(s) to calculate volumes for.

# Click OK.

The command processes each parcel, performs the volume calculations, and 
displays the status for the new cut and fill volumes.
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Creating a Grid of Ticks That Shows Cut and Fill 
Areas on Volume Surfaces

Based on the grid surface definition, you can insert labels and tick marks that 
show the elevations of grid volume surfaces, and whether each node is in a 
cut or fill situation.

The following illustration features a site with tick marks and labels:

���!���!������������
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�
�������������
�����!���	���	
������������������

� Calculate site volumes using the Grid method. For more information, see 
“Calculating Total Site Volumes Using the Grid Method” on page 888.

� From the Terrain menu, choose Grid Volumes ➤ Grid Volume Ticks to dis-
play the Site Librarian dialog box.

� Select the site on which to create the grid ticks.

� Click OK to display the Grid Volume Ticks dialog box.
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 Select the Create Tick Marks check box to create tick marks over the site. The 
command inserts two different blocks as tick marks. Fill situations are shown 
with a plus sign (+); cut situations with a minus sign (-).

" Type a tick interval value to control the frequency of the tick marks. For 
example, a 1 signifies that each grid point in the surface is marked with a tick 
mark, a 2 places a tick mark on every other point on the grid, and so on.

# Type a tick size.

$ Type a Cut Tick Layer name. The cut tick block, a minus sign (-), is placed on 
this layer.

% Type a Fill Tick Layer name. The fill tick block, a plus sign (+), is placed on 
this layer.

�* Select the Create Labels check box to create tick labels for the site.

�� Type a Label Interval value to control the frequency of the labels. For exam-
ple, a 1 signifies that each grid point is marked with a label, a 2 places a label 
on every other point on the grid and so on.

�� Type a Label Size.

�� Type a Label Precision or use the slider to set the precision.

�� Type a Cut Label Layer name.

� Type a Fill Label Layer name.

�" Under Label Position, select one of the following options to control where 
the label is placed in relation to the tick mark:
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� Center: Places the label centered on the tick mark.
� Right: Places the label to the right of the tick mark.
� Left: Places the label to the left of the tick mark.
� Top: Places the label above the tick mark.
� Bottom: Places the label below the tick mark.

�# Click OK to exit the dialog box.

The following prompt is displayed:
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�$ Type Yes or No: 

� Type Yes to erase any existing tick marks.
� Type No to keep any existing tick marks.

The command places tick marks and labels representing the difference in ele-
vation between the two surfaces. A negative number represents a cut area, a 
positive number a fill area.

TIP You may want to assign the cut and fill tick marks and label layers different 
colors in order to more clearly show the specific areas of cut and fill.

Change the Grid Volume Ticks Settings

�
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� From the Projects menu, choose Drawing Settings to display the Edit Settings 
dialog box. 

� Under Program, select Land Development Desktop. 

� From the Settings list, select Grid Volume Ticks. 

� Click the Edit Settings button to display the Grid Volume Ticks dialog box.

 Select the Create Tick Marks check box to create tick marks over the site. The 
command inserts two different blocks as tick marks. Fill situations are signi-
fied by a plus sign (+), while cut situations are shown by a minus sign (-).

" Type a Tick Interval value to control the frequency of the tick marks. For 
example, a 1 signifies that each grid point in the surface is marked with a tick 
mark, a 2 places a tick mark on every other point on the grid, and so on.

# Type a Tick Size.

$ Type a Cut Tick Layer name. This is the layer on which the cut tick block, a 
minus sign (-), is placed.
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% Type a Fill Tick Layer name. This is the layer on which the fill tick block, a 
plus sign (+), is placed.

�* Select the Create Labels check box to create tick labels for the site.

�� Type a Label Interval value to control the frequency of the labels. For exam-
ple, a 1 signifies that each point in the grid is marked with a label, a 2 places 
a label on every other point on the grid.

�� Type a Label Size.

�� Type a Label Precision or use the slider to set the precision.

�� Type a Cut Label Layer name.

� Type a Fill Label Layer name.

�" Under Label Position, select one of the following options to control where 
the label is placed in relation to the tick mark:

� Center: To place the label centered on the tick mark.
� Right: To place the label to the right of the tick mark.
� Left: To place the label to the left of the tick mark.
� Top: To place the label above the tick mark.
� Bottom: To place the label below the tick mark.

Calculating Composite Volumes

Use the Composite method to calculate volumes both for a defined stratum 
and parcels within the area of that stratum. For more information about the 
Composite method, see “Using the Composite Method” on page 874.

Changing the Composite Volume Settings

To calculate the volume of a differential composite surface, you need to set 
the Composite Volumes settings.
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� Do one of the following to display the Composite Volume Settings dialog 
box:

� From the Terrain menu, choose Composite Volumes ➤ Calculate Total Site 
Volume to display the Site Volume Librarian dialog box. From the list box, 
select a site and click OK.

� From the Projects menu, choose Drawing Settings to display the Edit Set-
tings dialog box. Under Program, select Land Development Desktop. From 
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the Settings list, select Composite Volumes and click the Edit Settings but-
ton.

� Under Elevation Tolerance, type a value in the Minimum difference box. The 
elevation tolerance factor determines how large a difference in elevation 
between two surfaces must exist in order to be included in volume calcula-
tions. For example, if the elevation tolerance is 0.5 units, then the calcula-
tions ignore any elevational difference between the two surfaces that is less 
than 0.5 units. The calculations include any elevational difference that is 0.5 
units or greater. 

� Type a cut factor and a fill factor for the Composite Volumes Corrections val-
ues. These values compensate for expansion and compaction of the surface 
material, and help to determine the actual volume of material that needs to 
be removed (the cut factor) or added (the fill factor) to the site.

� Cut factor: Compensates for the expansion factor of the material left 
after the cut.

� Fill factor: Compensates for the compaction factor of the fill material.

For example, for a material that expands 15 percent, type the value 1.15. 
However, for a material that compacts to 93 percent of its original value, type 
0.93. A factor of 1.00 does not adjust the volumes.

� Click OK.

Calculating Total Site Volumes Using the 
Composite Method

You can calculate the total surface volume using the Composite method. For 
more information about the Composite method, see “Using the Composite 
Method” on page 874.
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� Define a site. For more information, see “Defining a Site for Volume Calcula-
tions” on page 880.

� Define a stratum. For more information, see “Defining a Stratum” on page 
877.

� From the Terrain menu, choose Composite Volumes ➤ Calculate Total Site 
Volume.

NOTE If you haven’t selected a current surface or stratum, the command 
prompts you to do so. 

� Select the site for which you want to calculate volumes.

 Click OK to display the Composite Volume Settings dialog box. 

" Change the Composite Volume Settings if needed. For more information, see 
“Changing the Composite Volume Settings” on page 894.

# Click OK to display the Volume Results Surface dialog box.

$ Type a new composite volume surface name.

NOTE If you have already built a composite volume surface for the current 
stratum and site, the program prompts you to use the name of the new surface 
and overwrite the existing surface. If you click NO, the program prompts you for 
a new surface name. If you give the name of another existing surface, you are 
prompted to overwrite that surface. If you click NO, the prompt for a new name 
is repeated until you specify a valid surface name that is either new, or existing 
that you want to overwrite.

% Click OK.

The volumes are calculated and the volume surface is added to the Terrain 
Model Explorer.
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Calculating Parcel Volumes Using the Composite 
Method

After you calculate the total site volumes, you can calculate the cut and fill 
volumes of selected parcels.

�
����������������
�����

� Calculate the total site volume using the Calculate Total Site Volume com-
mand. For more information, see “Calculating Total Site Volumes Using the 
Composite Method” on page 895.

� Define at least one parcel. For more information, see “Defining Parcels” on 
page 505.

� From the Terrain menu, choose Composite Volumes ➤ Calculate Parcel 
Volumes to display the Site Volume Librarian dialog box. 

If you haven’t selected the current stratum and surface, then you are 
prompted to do so.

� Select the site for which you want to calculate parcel volumes. 

 Click OK to display the Parcel Volume Librarian dialog box.
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" Choose the parcel name(s) for which to calculate volumes. 

# Click OK. 

The command processes each parcel, performs the volume calculations, and 
displays the status for the net cut and fill volumes.

Calculating Section Volumes

Use the Section method to calculate volumes for a site. The Section method 
requires both a stratum and a site. Calculating volumes using the Section 
method is a two-step process. First, you must sample the sections along the 
surfaces in the stratum. Then you must calculate the section volume total. 
You cannot calculate parcel volumes using the Section method. For more 
information about the Section method, see “Using the Section Method” on 
page 874.

Changing the Section Volume Settings

You can change the settings for sampling section data for section volume 
calculations.
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� Do one of the following to display the Section Volume Settings dialog box:

� From the Terrain menu, choose Section Volumes ➤ Sample Sections to dis-
play the Site Volume Librarian dialog box. From the list box, select a site 
and click OK. 
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� From the Projects menu, choose Drawing Settings to display the Edit Set-
tings dialog box. Under Program, select Land Development Desktop. 
Under Settings, select Section Volumes. Click the Edit Settings button to 
display the Section Volume Settings dialog box.

� Select the type of volume calculation you want to perform: Average end area 
or Prismoidal. For more information, see “Using the Section Method” on 
page 874.

� Select the direction in which you want to sample the site for cross sectional 
volume calculations: 

� M (x): Sample sites along the M axis.
� N (y): Sample sites along the N axis.

The Sample Sections command uses the site grid to determine the points to 
sample. If the grid is sampled in the M direction, then each section line in 
the M direction is considered a station.

� Under Volume Corrections, specify the expansion and compaction factors 
that you want to apply to the volume calculations:

� Cut factor: Helps determine the actual volume of material that needs to 
be removed from the site. This value compensates for the expansion factor 
of the material left after the cut.

� Fill factor: Helps determine the actual volume of material that needs to 
be added to the site. This value compensates for the compaction factor of 
the fill material.

NOTE For a material that expands 15 percent, enter the value 1.15. For a 
material that compacts to 93 percent of its original value, enter 0.93. A factor 
of 1.00 does not adjust the volumes. 

 Click OK.
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Using the Prismoidal Volume Calculation 
Method

The Prismoidal method for calculating section volumes is also called the Grid 
method. When using this method, a regular grid is overlaid on the two sur-
faces. The elevations on both surfaces are calculated at each grid intersection. 
The resulting face is then broken into two triangular prisms. 

The following formula is used when you select the Prismoidal Volume 
Calculation method:

where:

V: Volume

L: Length (Distance between sections)

A1: First end area

A2: Second end area

Using the Average End Area Volume Calculation 
Method

The Average End Area method is the most common method of calculating 
volumes. The average of adjacent cross section areas is multiplied by the dis-
tance between them. 

The following formula is used when you select the Average End Area volume 
calculation method:

where:

V: Volume

L: Length (Distance between sections)

A1: Area of section 1

A2: Area of section 2
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Sampling Section Data for Volume Calculations

You can calculate volumes based on sampled cross sections, using average 
end or prismoidal methods of calculation. Use the Sample Sections com-
mand to sample and retrieve elevations from the triangulation data on the 
surface to calculate section volumes. 

�
������������
������
���
������������
��

� From the Terrain menu, choose Section Volumes ➤ Sample Sections.

If you haven’t selected a current stratum, then the Select Current Stratum 
dialog box is displayed. Select the stratum to use for volume calculations and 
click OK. 

The Site Volume Librarian dialog box is displayed.

� Select the site to use for volume calculations and click OK. 

The Section Volume Settings dialog box is displayed.

� Set the section settings. For more information, see “Changing the Section 
Volume Settings” on page 898.

� Click OK to sample the sections. 

The command uses the site grid to determine the points to sample. If the grid 
is sampled in the M direction, then each section line in the M direction is 
considered a station. Station numbers refer to the section line sampled. Sta-
tion numbers start at 0+00 (0+000 in metric units) and are assigned based on 
the grid cell width. For example, if the grid cells are 20 units in width, then 
the fourth grid sampled has a station value of 0+60 (0+060 in metric units).

The command then samples along each section, calculating elevations at 
each point where a TIN line crosses the section line. These points are consid-
ered offsets. The offsets are always positive, and calculated from left to right 
along the station line in the direction of station progression. You can view or 
edit the station and offset information for the sections using the Edit 
Sections command. For more information, see “Editing Sampled Section 
Data for Volume Calculations” on page 901.

Editing Sampled Section Data for Volume 
Calculations

You can edit cross sections that you sampled for a site using the Sample 
Sections command. You can edit offset, elevation, and grade information for 
individual stations. 
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� From the Terrain menu, choose Section Volumes ➤ Edit Sections to display 
the Site Volume Librarian dialog box.

� Select the site from which you calculated the section information.

NOTE Unlike multiple grid/composite surfaces, each site can have only one set 
of section volume data.

� Click OK.

The Existing Ground Section Editor dialog box is displayed. The current sur-
face and station are listed at the top. 

� To select a different surface to edit, click the Select Surface button and select 
another surface, and then click OK to return to the Existing Ground Section 
Editor dialog box.

 To select a different station to edit, click any of the following buttons:

� Previous: Moves to the previous station on the surface.
� Next: Moves to the next station on the surface.
� Select: Displays a dialog box to select the station to move to.

NOTE For more information on how stations are numbered, see “Using the 
Composite Method” on page 874.
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The offset, elevation, and grade of the selected station, as well as buttons to 
move through the information, are displayed in the dialog box. 

" Click any of the following buttons to view more information about a station:

� Home: Moves the cursor to the first page of the current station’s 
information.

� Page Up: Moves up one page at a time.
� Up: Moves up one line at a time.
� Down: Moves down one line at a time.
� Page Up: Moves up a page at a time.
� Page Down: Moves down a page at a time.
� End: Moves to the final page of the current station’s information.

# You can insert and delete offsets, stations, and surfaces using the following 
buttons:

� Insert Offset: Inserts an offset where the cursor is positioned.
� Delete Offset: Deletes the offset where the cursor is positioned. 
� Insert Station: Displays the Station Entity dialog box. Type the required 

station, and then click OK to return to the Existing Ground Section Editor 
dialog box.

� Delete Station: Deletes the current station.
� Insert Surface: Sets a new surface current in the Existing Ground Section 

Editor dialog box. This surface name is unique to the section volumes data 
file.

� Delete Surface: Permanently removes the current station’s surface data 
from the Existing Ground Section Editor dialog box.

$ Click OK.

Calculating Total Site Volumes Using the 
SectionMethod

You can calculate the total volume for a site using the Section method. You 
can use this command as an alternative to the Volume Report command for 
section volume processing, but it does not write information to a file. 
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� Sample the site information. For more information, see “Sampling Section 
Data for Volume Calculations” on page 901.

� From the Terrain menu, choose Section Volumes ➤ Calculate Volume Total 
to display the Site Librarian dialog box.

� Choose the site from which you calculated the section information.
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� Click OK to display the Section Volumes Settings dialog box.

 Choose the type of volume calculation you want to perform: Average end 
area or Prismoidal. “Changing the Section Volume Settings” on page 898.

" Choose the direction in which you want to sample the site for cross sectional 
volume calculations:

� M (x): Samples sites along the M axis.
� N (y): Samples sites along the N axis.

The Sample Sections command uses the site grid to determine the points to 
sample. If the grid is sampled in the M direction, then each section line in 
the M direction is considered a station.

# Specify the expansion and compaction factors that you want to apply to the 
volume calculations: 

� Cut factor: Helps determine the actual volume of material that needs to 
be removed from the site. This value compensates for the expansion factor 
of the material left after the cut.

� Fill factor: Helps determine the actual volume of material that needs to 
be added to the site. This value compensates for the compaction factor of 
the fill material.

NOTE For a material that expands 15 percent, enter the value 1.15. For a 
material that compacts to 93 percent of its original value, enter 0.93. A factor of 
1.00 does not adjust the volumes. 

$ Click OK.

The command processes the volumes and displays the total cut, fill, and net 
volumes for the processed site.

% Press any key to continue.
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Reporting Section Volume Data

You can write section volume data to an ASCII text file. 

�
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� Sample the site information. For more information, see “Sampling Section 
Data for Volume Calculations” on page 901.

� From the Terrain menu, choose Section Volumes ➤ Volume Report to display 
the Site Librarian dialog box.

� Select the site from which you calculated the cross section information. 

� Click OK to display the Section Volumes Settings dialog box.

 Set the volume calculation settings. For more information, see “Changing 
the Section Volume Settings” on page 898.

" Click OK.

# Press any key to continue.

The file lists the station cut and fill areas, station cut and fill volumes, station 
total volume, and the running mass ordinate.

Plotting Volume Sections

AutoCAD Land Development Desktop has commands that you can use to 
plot the sections from which the volumes were calculated. This lets you eval-
uate the surface data for any potential data errors. 

You can plot sections by:

� Importing individual sections, in which the command prompts you for 
each station to plot. 

� Importing all sections. The horizontal and vertical spacing of the page lay-
out control how the sections appear on the screen.

� Importing sections page by page.

Changing the Section Volumes Plotting Settings

You can specify which elements of the volume sections to display, and the 
layers on which they are displayed when plotted.
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NOTE The cross section output depends on the horizontal and vertical scale. 
These scales are set during the drawing setup. 
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� Do one of the following to display the Cross Section Plot Settings dialog box:

� From the Terrain menu, choose Section Volumes ➤ Plot Settings.
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Section Volume Plotting and click the Edit 
Settings button.

� Select which elements you want to display on the plotted cross sections:

� Existing Ground: Controls whether or not the existing ground surface is 
displayed.

� Grid: Controls whether or not the cross section grid is displayed.
� Grid text: Controls whether or not annotation text for the cross section 

is displayed.

� You can accept the default layer names for each of plotted item, or type new 
layer names in the Layer boxes. 

� Set the Section Layout settings. For more information, see “Changing the 
Section Layout Settings for Plotting Section Volumes” on page 907.

 Set the Page Layout settings. For more information, see “Changing the Page 
Layout Settings for Plotting Section Volumes” on page 909.

" Click OK.

The following illustration features the parameters used in plotting section 
volumes:
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Changing the Section Layout Settings for 
Plotting Section Volumes

You can control the factors that affect the plotting of individual site cross sec-
tions. These factors include grid and label increments. 
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� Do one of the following to display the Section Volume Plot Settings dialog 
box.

� From the Terrain menu, choose Section Volumes ➤ Plot Settings.
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Section Volume Plotting  and click the Edit 
Settings button.

� Click the Section Layout button to display the Section Layout dialog box.

� Under Offset, change the following settings that affect the cross section grid 
that is overlaid on the cross section. Enter these increments in drawing units:
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� Increment: Determines the distance between the vertical lines on the 
grid.

� Label interval: Determines which offset grid lines to label. If the label 
interval is one (1), then every grid line is labeled. If the label interval is two 
(2), then every other line is labeled.

� Label precision: Determines the precision used to label the volume sec-
tion offset grid lines.

� Under Elevation, change the following settings:

� Increment: Determines the distance between the horizontal lines on the 
grid.

� Label interval: Determines which elevation grid lines to label. If the label 
interval is one (1), then every grid line is labeled. If the label interval is two 
(2), then every other line is labeled.

� Label precision: Determines the precision used to label the volume sec-
tion elevation grid lines.

The following illustration shows the offset and elevation increments:
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 Under Section Height, specify how many extra grid cells are plotted with the 
cross section:

� Rows below datum: Determines how many rows of grid cells to place 
below the datum.

� Rows above maximum: Determines how many rows of grid cells to place 
above the highest point on the existing ground.

" Click OK to return to the Cross Section Plotting Settings dialog box.
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Changing the Page Layout Settings for Plotting 
Section Volumes

Use the Page Layout settings to determine the sheet size, margins, spacing, 
and number of vertical sheets that are used for the Plot Page and Plot All 
commands.

�
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� Do one of the following to display the Section Volume Plot Settings dialog 
box:

� From the Terrain menu, choose Section Volumes ➤ Plot Settings.
� From the Projects menu, choose Drawing Settings to display the Edit 

Settings dialog box. Under Program, select Land Development Desktop. 
From the Settings list, select Section Volume Plotting  and click the Edit 
Settings button.

� Click the Page Layout button to display the Page Layout dialog box.

� You can change the following settings:

� Sheet height: Determines the height of a page for cross sections in plot-
ted units.

� Sheet width: Determines the width of a page for cross sections in plotted 
units.

� Left margin: Determines the distance between the left edge of the sheet 
and the border in plotted units.

� Right margin: Determines the distance between the right edge of the 
sheet and the border in plotted units. The right margin is a minimum. 
This value is keyed to the values entered for both the offset increment and 
elevation increment in the Section Layout settings.
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� Top margin: Determines the distance between the top edge of the sheet 
and the border in plotted units. The top margin is a minimum. This value 
is keyed to the values entered for both the offset increment and elevation 
increment in the Section Layout settings.

� Bottom margin: Determines the distance between the bottom edge of 
the sheet and the border in plotted units.

� Column spacing: Determines the vertical spacing between sections. The 
column spacing is the number of cells placed horizontally between cross 
sections.

� Row spacing: Determines the horizontal spacing between sections. The 
row spacing is the number of cells placed vertically between the cross 
sections.

The cell width depends on the offset increment. The cell height depends 
on the elevation increment. For example, if the offset increment is set to 
10 and the column spacing to 4, then there are 40 units between columns 
of cross sections. The cell width is used to determine station numbering 
for section volume calculations.

� Under Plotting of Multiple pages, change the following setting:

� Maximum number of vertical pages: Determines how many sheets are 
drawn in the vertical direction when the Multiple option of the Page com-
mand is used.

 Click OK to return to the Cross Section Plot Settings dialog box.

Selecting the Text Size to Use for Plotted Volume 
Sections

You can select the text size to be used for the plotted section grid text.

�
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� From the Terrain menu, choose Section Volumes ➤ Set Text Style to display 
the Text Style dialog box.
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� From the list boxes, select a text style and font to use. For more information 
about the Text Style dialog box, see “Creating and Modifying Text Styles” in 
the online Help.

� Click OK.

Plotting a Single Volume Section

You can plot volume sections at specified stations into a drawing, one at a 
time.

��������	�
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� Change the section volumes plotting settings. For more information, see 
“Changing the Section Volumes Plotting Settings” on page 905.

� From the Terrain menu, choose Section Volumes ➤ Plot Single to display the 
Site Volume Librarian dialog box.

� Choose the site from which you calculated the cross section information. 

� Click OK.

The selected site is the only site processed. The command overwrites any 
existing section information for that site.

� Type the station of the first section that you want to plot. The default is the 
first station in the sampled range. If the station entered in response to this 
prompt lies outside the range of sampled stations, then the command draws 
the cross section of the nearest station. 

� Select an insertion point for the section. This is the lower-left corner of the 
imported cross section. Both surfaces in the sampled stratum are shown. 
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# You can plot additional sections, or press ENTER in response to the Station 
and Pick bottom insertion point prompts to end the command.

The following illustration features a single volume section:
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Plotting All Volume Sections for a Site

You can plot all volume sections for a site. The command draws the cross sec-
tions in columns from bottom to top and left to right. 

�
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� Change the section volume plotting settings. The Plot All command uses the 
sheet height from the plotting settings to determine the maximum height to 
plot the sections.

For more information, see “Changing the Section Volumes Plotting Settings” 
on page 905.

� From the Terrain menu, choose Section Volumes ➤ Plot All to display the Site 
Librarian dialog box.

� Choose the site from which you calculated the cross section information.

� Click OK.

The selected site is the only site processed. The command overwrites any 
existing section information for that site.

 Select the sheet origin point, or type X, Y coordinates. 

The following illustration features volume sections imported with the Plot 
All command:



Plotting Volume Sections | 913

1��
������
����������
���

Plotting a Page of Volume Sections

You can process a range of volume sections related to a site, and then either 
plot them in the current drawing or export them to another drawing. The 
volume sections are drawn in columns from bottom to top and left to right. 

�
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� From the Terrain menu, choose Section Volume ➤ Plot Page to display the 
Site Librarian dialog box.

� Choose the site from which you calculated the volume section information.

� Click OK.

The following prompt is displayed:
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� Type Single or Multiple:

� Type Single to import a single page.
� Type Multiple to import multiple pages.

The following prompt is displayed:

4�$�����
(�����������(���
�����6���� !
����"��!
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 Type Yes or No:

� Type Yes to import the sections into the current drawing as objects. For 
more information, see “Importing Volume Sections into the Current 
Drawing” on page 914.
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� Type No to import the sections into another drawing as objects. For more 
information, see “Importing Volume Sections into Another Drawing” on 
page 915.

The following illustration features a single page of cross sections:
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The following illustration shows all the volume section pages imported:

1��
������
����������
�������

Importing Volume Sections into the Current 
Drawing
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� Complete steps 1–5 of “Plotting a Page of Volume Sections” on page 913.
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� Type the station of the first section that you want to plot.

� Select a sheet origin point (the lower-left corner of the sheet).

Importing Volume Sections into Another 
Drawing

�
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� Complete steps 1–5 of “Plotting a Page of Volume Sections” on page 913.

� Type a prefix for the drawing in which the volume sections will be plotted. 
The drawing prefix can have a maximum of five characters. The name of the 
drawing that is created is determined by the drawing prefix and the sheet 
number. For example, if the drawing prefix is Site1, and the first sheet num-
ber is 1, then the drawing containing the first sheet of volume sections is 
named Site1001.dwg.

� Type the starting sheet number.

� Type the station of the first section that you want to plot.

 Select a sheet origin point (the lower-left corner of the sheet).

An AutoCAD Map message box may display. This dialog box is displayed 
whenever an object is WBLOCKed from a drawing.

" Click either button to continue.

NOTE If there are any drawing objects within the sheet boundary, then they 
are also written out. The current view must encompass the entire sheet, or the 
option for plotting the sections to drawing files does not work. 

Outputting Volume Data

After you calculate volumes using the Grid, Composite, or Section methods, 
you can either output the volume data to ASCII text files, or create volume 
tables to insert in the drawing.

Reporting Total Volume Data for a Site

You can display volume information for a site in a dialog box.
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.

� From the Terrain menu, choose Volume Reports ➤ Site Report to display the 
Site Volume Corrections dialog box.

This dialog box shows the corrections applied to the site volumes for the 
method used. 

� Type new correction factors if needed.

� Cut factor: Helps determine the actual volume of material that needs to 
be removed from the site. This value compensates for the expansion factor 
of the material left after the cut.

� Fill factor: Helps determine the actual volume of material that needs to 
be added to the site. This value compensates for the compaction factor of 
the fill material.

� Click OK.

If you selected the Screen check box in the Output Settings dialog box, then 
the command displays the Site Volumes dialog box. This dialog box displays 
the cut, fill, and total volumes.

Creating a Total Volume Table for a Site

You can create a table of volume data in the current drawing.
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� From the Terrain menu, choose Volume Reports ➤ Site Table to display the 
Site Volume Corrections dialog box.
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This dialog box shows the corrections applied to the site volumes for the 
method used. 

� Type new correction factors if needed.

� Cut factor: Helps determine the actual volume of material that needs to 
be removed from the site. This value compensates for the expansion factor 
of the material left after the cut.

� Fill factor: Helps determine the actual volume of material that needs to 
be added to the site. This value compensates for the compaction factor of 
the fill material.

� Click OK.

� Select the insertion point for the table by either selecting a point or by spec-
ifying X, Y coordinates. This is the upper-left corner of the table.

 Specify the rotation angle by typing a value or by either selecting two points 
to define the angle. The command then inserts a table on the current layer 
containing volume information. This information includes the site name, 
stratum name, surface names, total cut and fill volumes, net volume, units, 
and method used for each site.

The following illustration features a site volume table:
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Creating an ASCII File of Total Volume Data for 
a Site

You can write site volume data to an ASCII text file.

�
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� From the Terrain menu, choose Volume Reports ➤ Site ASCII File to display 
the Site Volume Corrections dialog box.
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This dialog box shows the corrections applied to the site volumes for the 
method used. 

� Type new correction factors in the edit boxes if needed.

� Click OK.

The Output Site Volumes File dialog box is displayed.

� Specify the name of the file to which the site volume data should be written. 
The default file path is the current project folder.

The command then creates a comma (,) delimited ASCII file that includes the 
site name, stratum, top and bottom surface names, volume calculation 
method, cut and fill volumes, and net volume information. 

Following is the basic format for the ASCII file:

���
;�������;�����(
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-;�
���;(���>�	��
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>�	��


Reporting Parcel Volume Data

You can report volume data for selected parcels in a dialog box. 

�
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� Change the Output Settings. For more information, see “Changing the Out-
put Settings” on page 79.

� From the Terrain menu, choose Volume Reports ➤ Parcel Report to display 
the Parcel Librarian dialog box.

� From the list box, select the parcel you want to report.

� Click OK. 

The Parcel Volume Corrections dialog box is displayed. This dialog box 
shows the corrections applied to the parcel volumes for the method used. 
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 Type new correction factors if needed.

" Click OK.

If you selected the Screen check box in the Output Settings dialog box, then 
the command displays the Parcel Volumes dialog box. This dialog box dis-
plays the cut, fill, and total volumes for the selected parcels.

Creating a Parcel Volume Table

You can create a table of parcel volume data in the current drawing.

�
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� From the Terrain menu, choose Volume Reports ➤ Parcel Table to display the 
Parcel Volume Librarian dialog box.

� From the list box, select the parcels.

� Click OK. 

The Parcel Volume Corrections dialog box is displayed. This dialog box 
shows the corrections applied to the parcel volumes for the method used. 

� Type new correction factors if needed.

 Click OK.

" Select the insertion point for the table by either selecting a point or by spec-
ifying X, Y coordinates. This is the upper-left corner of the table.

# Specify the rotation angle by either typing a value or by selecting two points 
to define the angle.

The command then inserts a table on the current layer containing volume 
information for the selected parcels. This information includes the parcel 
name, total cut and fill volumes, net volume, units, and the method used for 
each parcel. 

Creating an ASCII File of Parcel Volume Data

You can write parcel volume data to an ASCII text file.

�
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� From the Terrain menu, choose Volume Reports ➤ Parcel ASCII File to display 
the Parcel Volume Librarian dialog box.
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� From the list box, select the parcel(s) to which you want to write volume data 
to an ASCII text file.

� Click OK. 

The Parcel Volume Corrections dialog box is displayed. This dialog box 
shows the corrections applied to the parcel volumes for the method used. 

� Type new correction factors if needed.

 Click OK.

The Output Parcel Volumes File dialog box is displayed.

" Specify the name of the file to which the parcel volume information will be 
written. The default file path is the current project folder.

The command creates a comma (,) delimited ASCII file including the parcel 
name, stratum, top and bottom surface names, volume calculation method, 
cut and fill volumes, and net volume information.

Following is the basic format for the ASCII file:
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36Managing Terrain Layers

The Terrain Layers commands help you manage layers 

in a drawing. Terrain layers include: surface, border, 

range, contour, 3D grid, polyline grid, 3D projection, 

water drop, site grid, and volume ticks. 

In this chapter

� Using the Layer Commands
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Using the Layer Commands

AutoCAD Land Development Desktop has layer commands that you can use 
to quickly control terrain layers. The layer commands control layer visibility, 
such as whether the layer is on or off, or frozen or thawed. You can also use 
these commands to erase the contents of specified layer.

Managing the Surface Layer

You can turn the surface layer on or off, as well as freeze, thaw, or erase the 
layer.

����������	
�������������

� From the Terrain menu, select Terrain Layers ➤ Surface Layer.

The following prompt is displayed:

���������������	
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� Type one of the following options:

� ON: To turn the surface layer on.
� OFF: To turn the surface layer off.
� Freeze: To freeze the surface layer.
� Thaw: To thaw the surface layer.
� Erase: To erase all objects from the surface layer.

� Press ENTER.

Managing the Border Layer

You can turn the border layer on or off, as well as freeze, thaw, or erase the 
layer.

����������	
�����������

� From the Terrain menu, choose Terrain Layers ➤ Border Layer.

The following prompt is displayed:

���������������	
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� Type one of the following options:
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� ON: To turn the border layer on.
� OFF: To turn the border layer off.
� Freeze: To freeze the border layer.
� Thaw: To thaw the border layer.
� Erase: To erase all objects from the border layer.

� Press ENTER.

Managing the Range Layers

You can turn the range layers on or off, as well as freeze, thaw, or erase the 
layer.

����������	
������������

� From the Terrain menu, choose Terrain Layers ➤ Range Layers.

The following prompt is displayed:
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� Type one of the following options:

� ON: To turn the range layer on.
� OFF: To turn the range layer off.
� Freeze: To freeze the range layer.
� Thaw: To thaw the range layer.
� Erase: To erase all objects from the range layer.

� Press ENTER.

Managing the Contour Layers

You can turn the contour layers on or off, as well as freeze, thaw, or erase the 
layer.

����������	
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� From the Terrain menu, choose Terrain Layers ➤ Contour Layers.

The following prompt is displayed:

���������������	
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� Type one of the following options:

� ON: To turn the contour layer on.



924 | Chapter 36 Managing Terrain Layers

� OFF: To turn the contour layer off.
� Freeze: To freeze the contour layer.
� Thaw: To thaw the contour layer.
� Erase: To erase all objects from the contour layer.

� Press ENTER.

Managing the 3D Grid Layer

You can turn the 3D grid layer on or off, as well as freeze, thaw, or erase the 
layer.

����������	
�������������

� From the Terrain menu, choose Terrain Layers ➤ 3D Grid Layer.

The following prompt is displayed:

���������������	
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� Type one of the following options:

� ON: To turn the 3D grid layer on.
� OFF: To turn the 3D grid layer off.
� Freeze: To freeze the 3D grid layer.
� Thaw: To thaw the 3D grid layer.
� Erase: To erase all objects from the 3D grid layer.

� Press ENTER.

Managing the Polyline Grid Layer

You can turn the polyline grid layer on or off, as well as freeze, thaw, or erase 
the layer.

����������	
�������������������

� From the Terrain menu, choose Terrain Layers ➤ Polyline Grid Layer.

The following prompt is displayed:

���������������	
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� Type one of the following options:

� ON: To turn the polyline grid layer on.
� OFF: To turn the polyline grid layer off.
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� Freeze: To freeze the polyline grid layer.
� Thaw: To thaw the polyline grid layer.
� Erase: To erase all objects from the polyline grid layer.

� Press ENTER.

Managing the 3D Projection Layer

You can turn the 3D projection layer on or off, as well as freeze, thaw, or erase 
the layer.

����������	
����������	��������

� From the Terrain menu, choose Terrain Layers ➤ 3D Projection Layer.

The following prompt is displayed:
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� Type one of the following options:

� ON: To turn the 3D projection grid layer on.
� OFF: To turn the 3D projection grid layer off.
� Freeze: To freeze the 3D projection grid layer.
� Thaw: To thaw the 3D projection grid layer.
� Erase: To erase all objects from the 3D projection grid layer.

� Press ENTER.

Managing the Water Drop Layer

You can turn the water drop layer on or off, as well as freeze, thaw, or erase 
the layer.

����������	
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� From the Terrain menu, choose Terrain Layers ➤ Water Drop Layer.

The following prompt is displayed:
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� Type one of the following options:

� ON: To turn the water drop layer on.
� OFF: To turn the water drop layer off.
� Freeze: To freeze the water drop layer.
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� Thaw: To thaw the water drop layer.
� Erase: To erase all objects from the water drop layer.

� Press ENTER.

Managing the Site Grid Layer

You can turn the site grid layer on or off, as well as freeze, thaw, or erase the 
layer.

����������	
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� From the Terrain menu, choose Terrain Layers ➤ Site Grid Layer.

The following prompt is displayed:
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� Type one of the following options:

� ON: To turn the site grid layer on.
� OFF: To turn the site grid layer off.
� Freeze: To freeze the site grid layer.
� Thaw: To thaw the site grid layer.
� Erase: To erase all objects from the site grid layer.

� Press ENTER.

Managing the Volume Ticks Layers

You can turn the volume ticks layers on or off, as well as freeze, thaw, or erase 
the layer.

����������	
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� From the Terrain menu, choose Terrain Layers ➤ Volume Ticks Layers.

The following prompt is displayed:
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� Type one of the following options:

� ON: To turn the volume ticks layer on.
� OFF: To turn the volume ticks layer off.
� Freeze: To freeze the volume ticks layer.
� Thaw: To thaw the volume ticks layer.
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� Erase: To erase all objects from the volume ticks layer.

� Press ENTER.
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37Performing Inquiries on 
Drawing Features 

The Inquiry commands report specified information 

about drawing objects and spatial relationships between 

objects. You can select a location in the drawing and use 

the commands on the Inquiry menu to list the northing 

and easting coordinates, latitude and longitude, geo-

detic inverse, station and offset, and object geometry 

data.

Commands are also provided to list distances, areas, ele-

vations, and to track northing and easting coordinates 

and elevations.

In this chapter

� Using the Inquiry Commands

� Identifying Object Geometry

� Displaying Object Design 
Properties

� Listing Distances

� Listing Areas

� Listing Elevations

� Listing Slope Information 
Between Two Points

� Listing the Elevation at a Slope

� Tracking Coordinates and 
Elevations
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Using the Inquiry Commands

The commands on the Inquiry menu list statistics about your drawing and 
the objects drawn within. 

Listing the Northing and Easting of a 
Location 

You can display the X and Y coordinates, and the COGO northing and east-
ing coordinates of a selected location in the drawing. The relationship 
between the X, Y coordinates and the northing/easting coordinates are based 
on the drawing’s defined base point and north rotation angle. For more 
information, see “Changing the Base Point for a Drawing” on page 58 or 
“Changing the North Rotation for a Drawing” on page 61.

NOTE Use AutoCAD Object Snaps to accurately select the location. 

����������	�
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��
��	���
������������


� From the Inquiry menu, choose North/East.

� Select a point. 

� Select additional points, or press ENTER to end the command.

Listing the Latitude and Longitude of a 
Location

You can list the latitude and longitude of a location based on the current 
zone. Once this information is supplied, AutoCAD Land Development Desk-
top computes the grid northing/easting coordinates.

NOTE Use AutoCAD Object Snaps to accurately select the location. 
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� Set the current zone. For more information, see “Changing the Current Zone 
for a Drawing” on page 57.

� Set the Geodetic Transformation Settings. For more information, see “Chang-
ing the Geodetic Zone Transformation Settings” on page 81.

� From the Inquiry menu, choose Lat/Long.

� Select a point. 

The northing, easting, grid northing, grid easting, convergence, scale factor, 
latitude, and longitude are listed at the command line. Press F2 to view the 
information in the text window.

� Select another point, or press ENTER to end the command.

Listing the Geodesic Information of a Line

You can report the grid distance, geodesic distance, and the starting and end-
ing geodetic azimuths of a line. This is referred to as a geodetic inverse.

NOTE Use AutoCAD Object Snaps to accurately select the location. 

����	��������	��	�����
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� Set the current zone. For more information, see “Changing the Current Zone 
for a Drawing” on page 57.

� Set the Geodetic Transformation Settings. For more information, see “Chang-
ing the Geodetic Zone Transformation Settings” on page 81.

� From the Inquiry menu, choose Geodetic Inverse.

� Select the first point of the line.

When you select the first point, the following type of information is dis-
played about that point:
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� Select the second point of the line.

When you select the second point, the information for that point is dis-
played, and the geodetic inverse information is displayed for the line, as in 
the following example:
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Listing the Station and Offset of a Location in 
Relation to an Object

You can list the station and offset of any point relative to an existing line, 
curve, or spiral object in your drawing.
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� From the Inquiry menu, choose Station/Offset Object.

� Select the object the point is offset from.

To list the station and offset of a point that is adjacent to a roadway center-
line, you can select one of the objects that make up the alignment. You must 
specify a line, curve, or spiral object.

The command marks the nearest endpoint of the object with an X.

� Type the starting station of the object. After you select the starting station, 
the command calculates the ending station of the object you chose. 

� Select the point for which you want to determine the station and offset. 

The station and offset of the point is displayed. A negative offset is to the left 
of the object you selected; a positive offset is to the right based on station 
progression.

� Continue to select points, or press ENTER to end the command.

The following illustration shows how to select an object and specify the start-
ing station:
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Listing the Station and Offset of a Location in 
Relation to the Current Alignment

You can list the station and offset of any location relative to the current 
alignment.
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� From the Inquiry menu, choose Station/Offset Alignment.

� Select the point for which you want to determine the station and offset. This 
point must be adjacent to the current alignment.

The program displays the station and offset of the point. A negative offset is 
to the left of the alignment; a positive offset is to the right based on station 
progression.

� Continue to select points, or press ENTER to end the command.

Identifying Object Geometry

By using the Inquiry commands, you can obtain information about selected 
lines, roadway and railway curves, spirals, and angles. Such information may 
include the length of lines and curves and the external distance. 
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Listing Line, Curve, or Spiral Data

You can list information about an object, including start points and end-
points, radius or intersection points, lengths, radii, and orientation. The 
object must be a line, curve, or spiral.
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� From the Inquiry menu, choose Line/Curve/Spiral.

� Select the object. 

� Press F2 to view the information in the text window.

� Select another object, or press ENTER to exit the command.

Listing Roadway Curve Data

You can list data about any roadway curve. You describe roadway curve using 
the curve definition. The curve definition states that the degree of curve 
equals the angle between any two points on the curve, separated by 100 units 
measured along the curve.
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� From the Inquiry menu, choose Roadway Curves.

� Select the curve.

The information is displayed in the text window. For example:
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� Press F2 to return to your drawing.

Listing Railway Curve Data

You can list data about any railway curve. You describe railway curve using 
the chord definition. The chord definition states that the degree of curve 
equals the angle between any two points on the curve, separated by 100 units 
measured along the chord. 
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� From the Inquiry menu, choose Railway Curves.

� Select the curve. 

The information is displayed the text window. For example:
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� Press F2 to return to your drawing.

Listing a Spiral Radius

You can use the Spiral Radius command to list the radius at a fixed location 
along a spiral. You must create the spiral object using a spiral creation com-
mand on the Lines/Curves menu. This radius is calculated based on the spiral 
type. Because spiral representations are not always graphically accurate, the 
radius is calculated from the equations that have been generated.
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� From the Inquiry menu, choose Spiral Radius.

� Select the beginning of the spiral. The distance is measured from the nearest 
end point on the spiral.

The following prompt is displayed:
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� To select the location on the spiral at which to list the radius, do one of the 
following:

� Type the length (this defines the distance along the spiral at which the 
radius is to be measured).

� Type PO, and then select a point on the spiral at which the radius is to be 
measured.

The command displays the northing and easting of the selected point, the 
spiral radius at that point, and the direction of the spiral tangent at that 
point.
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� Continue to select points to list, or press ENTER to end the command.

Listing the Acute and Obtuse Angles Between 
Points or Intersecting Lines

You can list the acute and obtuse angles between points or intersecting lines 
in your drawing.

����������	����	�
�������	�
��	��

� From the Inquiry menu, choose Angles.

The following prompt is displayed:
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� Do one of the following:

� Select the first and second intersecting lines.
� Type PO, and then select three points to determine the angle. You can use 

either the following illustration for reference, or Point Filters (.P, .G, or .N) 
to select the three points to determine the angle. For more information, 
see “Filtering a Point List” on page 122.

The following illustration shows how to select lines or points for listing acute 
and obtuse angles:
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� Continue to select lines or points, or press ENTER to end the command.

Displaying Object Design Properties

You can view data in a dialog box about a line, curve, or spiral object in your 
drawing. 
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� Select the object by clicking on it or by picking two points to draw a window 
or crossing around it.

� Right-click to display the shortcut menu.

� Select Design Properties to display the Entity Data dialog box.

This dialog box displays the properties of the line, curve, or spiral that you 
selected.

This dialog box is a modeless dialog box, which means that you can leave it 
open while you perform other tasks, such as selecting another entity to dis-
play data about.

� To close the dialog box, click the upper-left corner. 

Line tab data

 �
	���

Length Displays the length of the line.

Direction Displays the direction of the line.

Start Northing Displays the northing coordinate of the start of the line.

Start Easting Displays the easting coordinate of the start of the line.

End Northing Displays the northing coordinate of the end of the line.

End Easting Displays the easting coordinate of the end of the line.

Curve tab data
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Radius Displays the radius of the curve.

Length Displays the length of the curve.



938 | Chapter 37 Performing Inquiries on Drawing Features

Delta Displays the central angle of the curve. Also known as Ic. 

Degree of Curve Displays the degree of curve.

Tangent Length Displays the tangent length of the curve.

Chord Length Displays the length of the long chord.

Middle Ordinate Displays the middle ordinate.

External Secant Displays the external secant.

Spiral tab data
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Type Displays whether the spiral is a clothoid, sinusoid, cosinusoid, or 
quadratic spiral.

Length Displays the spiral length.

Radius Displays the radius of the spiral at SC (point of change from spiral to 
curve) or CS (point of change from curve to spiral).

Theta Displays the central angle of the spiral.

Xs Displays the tangent distance from TS (point of change from 
tangent to spiral) to SC (point of change from spiral to curve) or CS 
(point of change from curve to spiral) to ST (point of change from 
spiral to tangent).

Ys Displays the offset distance at SC from TS or at CS from ST.

P Displays the offset of the initial tangent in to the PC of the shifted 
curve, or the offset of the initial tangent out to the PT of the shifted 
curve.

LT Displays the length of the long tangent.

ST Displays the length of the short tangent.

K Displays the abscissa of the shifted PC referred to the TS, or the 
abscissa of the shifted PT referred to the ST.

A Displays the spiral “A” value, or the “flatness” of the spiral. This 
value is equal to the square root of the product of the length times 
the radius. 
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Listing Distances

You can use the Continuous Distance and Add Distances commands to list 
specified information about spatial relationships between objects in your 
drawing. These two commands are similar, except that the Add Distances 
command does not hold the start point of the subsequent distances.

Listing the Distance of a Series of Points

The Continuous Distance command lists the distance between two points. 
This command continuously holds either the first or last selected point for 
distance selections. 
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� From the Inquiry menu, choose Continuous Distance.

The following prompt is displayed:
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� Type Base or Continuous:

� Type Base to hold the first point selected and use it as the first point for 
all distance calculations.

� Type Continuous to hold the last point selected for all distance 
calculations. The last point held is updated each time a new point is 
selected.

� Select the start point.

� Select the next point.

The distance is displayed at the command line.

� When you are finished selecting points, press ENTER.

The command displays the total distance in the current drawing units and 
the following prompt:
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" Do one of the following:

� Type Yes to insert text showing the total distance calculated on the draw-
ing. No dimension leaders are placed with this text.

� Type No to end the command.

If you type Yes, then the following prompt is displayed:



940 | Chapter 37 Performing Inquiries on Drawing Features

'����������5��@	���


# Select the point at which to insert the text.

The text is drawn on the current layer, using the current text style. A rotation 
angle of zero (0) is used for the text.

Listing the Total Distance of a Series of Points

The Add Distances command calculates the total of several disjunct 
distances.
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� From the Inquiry menu, choose Add Distances.

The following prompt is displayed:
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� Do one of the following:

� Enter the first distance.
� Select two points in your drawing that show the first distance to be used.

The command displays the last distance calculated and the running total:
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� Enter or select another distance at the previous prompt.

� When all of the distances have been entered or selected, press ENTER in 
response to the First distance (or Select) prompt.

The following prompt is displayed:
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� Press ENTER to place the distance in the drawing, or type No if you do not 
want to place the distance in the drawing.

The following prompt is displayed:
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" Select the point at which to insert the text.

The text is drawn on the current layer, using the current text style. A rotation 
angle of zero (0) is used for the text.
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Listing Areas

You can calculate the area and perimeter of boundaries that are defined by a 
sequence of points, lines, curves, or polylines.

Listing an Area Bounded by Lines and Curves

You can list an area bounded by lines and curves. This command lists the area 
in square feet and acres (square meters and hectares if working in metric 
units).
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� From the Inquiry menu, choose Area by Lines/Curves.

� Select the first object nearest the point of beginning (POB). 

� Use a window or crossing to select the rest of the objects, and then press 
ENTER to complete the selection set. 

The lines and curves cannot extend past the property line intersections. They 
must be separate objects meeting at endpoints.

If the boundary has any breaks, then a closure error prompt is displayed and 
an X is placed at the invalid closure point. If it is at the starting point of the 
boundary, then you can accept the default (Yes) to close back to the POB. If 
not, then type N (for No) to end the command and correct the closure error.

The command then reports the area.

� Press ENTER to end the command, or select another boundary to list.

The following illustration shows object selection guidelines:
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Listing an Area Bounded by a Polyline

You can list an area bounded by a single closed polyline.

NOTE Selecting a polyline that has been spline fitted causes erroneous areas 
to be reported. 
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� From the Inquiry menu, choose Area by Polylines.

� Select the polyline. 

The command calculates the area and lists it on screen.

NOTE If the area does not close, then a closure error prompt is displayed and 
an X is placed at the invalid closure point. Type either Yes to accept the default 
and close back to the point of beginning (POB), or type No to end the command 
and correct the closure error. 

Listing an Area Bounded by Points

You can list an area bounded by a series of selected points.

NOTE Use AutoCAD Object Snaps to accurately select the location. 
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� From the Inquiry menu, choose Area by Points.

� Select the area first point. 

� Continue selecting points along the perimeter in either a clockwise or 
counter-clockwise direction. You can also type C and define a curve. For more 
information, see “Defining a Curve by Points” on page 943.

� After you finish selecting points, press ENTER.

The following illustration shows point selection guidelines: 
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Defining a Curve by Points
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� Type C to define a curve.

The following prompt is displayed:
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NOTE This option automatically sets object snaps to Center. Do not override 
this setting. 

� Select a point on both the curve and end of the curve.

The command then prompts for the position of the chord relative to the 
boundary: 
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� Type O or I: 

� Type O if the chord is outside the boundary.
� Type I if the chord is inside the boundary.

If the chord is on the inside of the boundary, then the area of the curve is 
added to the area of the boundary. If the chord is on the outside, then the 
area of the curve is subtracted from the area of the boundary.

NOTE Curves are assumed to have an included angle less than 180 degrees. 
You must treat a curve with more than 180 degrees as two curves with included 
angles that are less than 180 degrees. 
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Listing Elevations

Topographic mapping, designing and laying out highways, and designing 
drainage systems all require determining differences in elevation. You can 
quickly list the elevations of contours or surfaces at selected locations.

Listing the Elevations of a Contour 

You can list the elevation of any contour or polyline in the drawing.
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� From the Inquiry menu, choose Contour Elevation.

� Select the contour line to list. 

The command calculates the contour elevation and lists it on screen. If the 
item has no elevation, then its elevation is zero.

� Press ENTER to end the command.

Listing the Elevations of the Current Surface 

You can list the elevations for points on the current surface. For more infor-
mation, see “Making a Surface Current” on page 694.

NOTE Use AutoCAD Object Snaps to accurately select the location. 

�������������	�	�	����
�

� From the Inquiry menu, choose Surface Elevation.

� Select a location on the surface at which you want to list the elevation.

The elevation value is displayed at the command line. If the selected location 
is not within the surface, the following message is displayed:
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Listing Slope Information Between Two 
Points

You can list slope information between two points in the drawing using the 
List Slope command.
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� From the Inquiry menu, choose List Slope. 

The following prompt is displayed:
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� Select the first point from your drawing by positioning the cursor and 
clicking. 

The following prompt is displayed:
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� Select the second point from your drawing by positioning the cursor and 
clicking.

The following information is displayed above the command prompt at the 
bottom of the AutoCAD screen:

� First elevation
� Second elevation
� Elevation difference
� Slope
� Grade
� Horizontal distance

� Press ENTER to end the command.  

Listing the Elevation at a Slope
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� From the Inquiry menu, choose List Elevation ➤ Slope. 

The following prompt is displayed:
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� Select a point from your drawing. 

� Do one of the following to define the grade or slope:

� Type a slope value.
� Select two points to define a slope.
� Type G and a grade value, or select two points to define the grade.

The following prompt is displayed:
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� Enter a distance by typing a value or by selecting two points.

The elevation is displayed above the command prompt at the bottom of the 
AutoCAD screen.

� Press ENTER to end the command.  

Tracking Coordinates and Elevations 

You can retrieve coordinate and elevational information as you move your 
pointing device across the drawing.

Tracking Northing and Easting Coordinates 

You can track northing and easting coordinates of the current pointer loca-
tion. You can keep the Coordinate Tracking dialog open while using other 
commands.
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� From the Inquiry menu, choose Track North/East.

Tracking Elevations 

You can track elevational information of the current surface. The elevation is 
displayed in the AutoCAD status bar.
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� From the Inquiry menu, choose Track Elevation.

� To stop the elevation tracking, press ENTER. 



Tracking Coordinates and Elevations | 947



948



949

38Utilities

With the Utilities commands, you can view objects, 

track revisions, and manage layers. These commands 

also perform simple mathematical calculations and 

insert symbols, leaders, and cameras into the drawing.

Using the Object Viewer, you can view objects in your 

drawing. If you aren’t satisfied with the viewing angle, 

you can set the drawing view to match that in the 

Object Viewer. 

In this chapter

� Utilities

� Using the Object Viewer

� Attaching Notes to Objects

� Tracking Revisions

� Layer Management

� Symbol Management

� Working with Curve Text

� Using Leaders

� Blocks

� Creating and Maintaining 
Schedule Templates and 
Legends

� Calculating Horizontal Curve 
Information

� Creating a Selection Set with 
Filters

� Using the Utilities Editing 
Commands

� Using the Camera
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Utilities

You can use the Utilities commands to draw a leader arrow with segmented 
leader line; perform simple mathematical calculations; insert symbols; and 
label the perpendicular offset distance between a building and property line. 
Commands are also available to insert notes from an ASCII file and insert text 
along the inside or outside of a curve. 

Using the Object Viewer

The Object Viewer displays objects you select in your drawing, based on the 
current view set in the drawing. You can manipulate the viewing angle and 
then set the drawing view equal to the view in the Object Viewer.

The view in the Object Viewer is the same as the drawing view. If the drawing 
is in plan view, the objects in the Object Viewer are in 2D plan view. If you 
are viewing your drawing in 3D, then the objects are displayed in 3D. 
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� From the Utilities menu, choose Object Viewer.

� Select the object(s) you want to view.

� Press ENTER.

The Object Viewer is displayed.

� To view selected objects, click any of the following icons:

� Wireframe - Displays objects in the current viewport with all lines 
present, including those hidden by other objects.

� Hide - Regenerates three-dimensional objects with hidden lines 
suppressed.

� Shade - Displays flat-shaded objects in the current viewport.

� Render - This option is not available in AutoCAD Land Development 
Desktop.

� Render Preferences - This option is not available in AutoCAD Land 
Development Desktop.

� Pan - Moves the current view without changing its size.
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� Zoom - Increases or decreases the apparent size of objects in the 
current viewport.

� Orbit - Sets the display window to 3D orbit. For more information, 
see “Interactive Viewing” in the AutoCAD User’s Guide. 

� Move - Displaces objects a specified distance in a specified direction.

� Select the following from the pull-down list.

� Top, Bottom, Left, Right, Front, or Back - Sets the current view to the 
selected view.

� SW Isometric, SE Isometric, NE Isometric, or NW Isometric - Sets the 
current view to the selected isometric view.

� Save Bitmap - Saves the current view as a bitmap file.

� Copy - Copies the view to the Clipboard.

� Parallel - Sets the view to a parallel plane.

� Perspective - Sets a perspective view.

� Lens Length - Stores the length of the lens used in perspective view-
ing for the current viewport.

� Zoom Window, Zoom Center, Zoom Extents, Zoom In, Zoom Out, or 
Zoom Factor - Increases or decreases the apparent size of objects in the 
current viewport.

� Set View - Sets the view in the drawing equal to the view in the 
Object Viewer.

� Display Configuration - Sets which display configuration is shown in the 
viewer. 

NOTE If you press SHIFT and the left mouse button simultaneously, you can 
Pan in the viewer. If you press CTRL and the left mouse button simultaneously, 
you can zoom dynamically in the viewer. 

Attaching Notes to Objects

With the Notes com-
mand, you can add 
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detailed information or reference information to a selected object(s). The 
Notes command lets you write textual information that can be viewed with 
the object and associate a separate reference file (document, spreadsheet, 
image or photo, and so on).

Attaching Text to an Object

 You can attach a text file to any AutoCAD object. 
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� From the Utilities menu, choose Notes.

� Select an object in your drawing on which you want to place a note.

� Press ENTER.

The Notes dialog box is displayed.

� Click the Text Notes tab. 

� In the text box, type the desired text.

� Click OK to attach the text file to your drawing.

Attaching External Reference Documents to an 
Object

 You can attach, edit, and delete external reference documents to any 
AutoCAD object in a drawing.
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� From the Utilities menu, choose Notes.

� Select an object in your drawing on which you want to attach an external ref-
erence document.

� Press ENTER.

The Notes dialog box is displayed.

� To attach, edit, or detach a reference file, click the Reference Docs tab, and 
do any of the following:

� To attach a reference file, click Add, select a document in the Select File 
dialog box, and click Open. You can type a description of the reference file 
on the Reference Docs tab.

� To edit a reference file, select the file name in the list, click Edit, and 
change the document or the description in the Reference Document dia-
log box. To edit the file itself, double-click the reference file name to start 
its application.
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� To detach a reference file, select the file name in the list and click Delete.

� Click OK.

Tracking Revisions

The Revisions commands are used to create and maintain a database of the 
drawing's revision history. To use the commands on the Revisions menu, 
make sure the Drawing Manager is enabled by using the Revision Settings 
command and selecting Enable drawing manager.

When the Drawing Manager is in use, changes are entered into the time log 
whenever a New, Open, Save, or Save As command from the File menu is 
used to save or exit the drawing. These commands also update the Drawing 
Manager whenever they are typed from the command line.

NOTE Revisions are not entered as they are made. The drawing must be saved 
in order for revisions to be updated. If the Discard Changes option is selected 
when using the New or Open commands, the revision changes are lost as well.

Any revisions made after the last time the drawing was saved are not reflected 
in any of the time logs. When entering an existing drawing with the Drawing 
Manager enabled, prompts for the initials of the person making the changes 
are displayed. This keeps the Drawing Manager updated with the revisions 
being made.

Changing the Revision Settings
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� From the Utilities menu, choose Revisions ➤ Revision Settings.

� The Revision Settings dialog box is displayed.

� Under General, select one of the following:

� Enable drawing manager: If you want to enable the drawing manager 
� Update daystamp before ending: If you want to update the daystamp 

before ending your drawing session.
� Update daystamp before plotting: If you want to update the daystamp 

before plotting your drawing.

� Click OK.
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Displaying Time Information

You can display time information in your drawing. 
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� From the Utilities menu, choose Revisions ➤ Current Time.

The Current Time command runs the AutoCAD TIME command. The com-
mand displays the current time and date, the time and date that the current 
drawing was created, elapsed time, and other information. See the AutoCAD 
manuals for more information.

Browsing the Time Logs

Use the Browse Time Logs command to view and edit the contents of the 
time log. To use the commands on the Revisions menu, make sure the Draw-
ing Manager is enabled. To do this, click Revision Settings, then select Enable 
drawing manager on the Revision Settings dialog box.

��������������������

� From the Utilities menu, choose Revisions ➤ Browse Time Logs.

The Edit Table dialog box is displayed, showing all the entries in the time log.

There are eight (8) fields listed in the Browse Time Logs screen. All of these 
fields are described in the following section:

� EDITOR: The editor field lists the initials of the person who made the 
revision. These initials are entered at the start of a drawing session or 
when the Drawing Manager is enabled.

� DATE: The date field lists the date of the listed revision. The date is 
updated from the system date automatically at the time the Save, End, or 
Quit commands are used.

� TIME (min): The time field lists the time spent in a drawing session for 
the revision listed. The time is taken from the time held using the 
AutoCAD time manager. For more information on this time manager, see 
the AutoCAD manuals.

� DRAWING: The drawing field lists the name of the drawing in which the 
revision was made.

� REVISION: The revision field lists the revision number for the listed revi-
sion. The revision number is entered by the person making the revisions 
at the time the drawing is saved or ended.

� CHANGES: The changes field lists the revision description entered by the 
person who made the revision at the time the drawing was saved. Descrip-
tions can be no longer than 20 characters. If a drawing session has ended 
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without saving changes, the changes field contains the description NO 
SAVED CHANGES.

� FHANDLE: The fhandle field lists the first handle created in the drawing 
session to which the revision was made. The drawing session for the fhan-
dle tag is defined as a period of time between drawing saves or ending. If 
the drawing session has ended with no changes made, this value is zero 
(0).

� LHANDLE: The lhandle field lists the last handle created in the drawing 
session to which the revision was made. The drawing session for the lhan-
dle tag is defined as a period of time between drawing saves or ending. If 
the drawing session has ended with no changes made, this value is zero 
(0).

� When you are finished viewing the time log information, press ESC to return 
to the AutoCAD drawing.

Making a Time Log Report

You can make a time log report by using the Make Time Log Report com-
mand. To use the commands on the Revisions menu, make sure the Drawing 
Manager is enabled. To do this, click Revision Settings, then select Enable 
drawing manager on the Revision Settings dialog box.

����	#�	��������������

� From the Utilities menu, choose Revisions ➤ Make Time Log Report.

The following prompt is displayed.

������������	���	��
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� To generate a report, do one of the following:

� Type E to create an editors report that is organized by user initials.
� Press ENTER to create a drawings report that is organized by drawing 

names.

NOTE Both editors and drawings reports list all the revision information for all 
the drawings in the current project.

� To assign a filename and path for the report, do one of the following:

� Type a new path and filename for the report.
� Press ENTER to use the default filename and path.
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NOTE The default file path and name is c:\Land Projects R2\<project 
name>\pp\timeman.rep.

� Do one of the following:

� Press ENTER to create and view the report. If you chose to view the report, 
then the report is displayed in the AutoCAD text screen.

� Type N to not view the report.

If you chose not to view the report, then the information is sent to the report 
file without being displayed on the AutoCAD text screen. Once the time log 
report is created, it can be modified using any text editor and printed.

The Make Time Log Report command creates a report based on information 
from the time log. There are two types of reports: drawing and editor. 

� Enter the type of report desired at the following prompt.

������������	���	��
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Both of these report types list all the revision information for all of the draw-
ings in the current project. The difference between these report types is the 
format. Drawing reports are organized by drawing names and editor reports 
are organized by user initials. 

After the report type has been selected, the command displays the following 
prompt.

���������	�����	���

The default name for this file is timeman.rep and is placed in the project 
folder. 

� Enter any name for the time log report, including the path and extension.

Once the file name has been entered, the command displays the following 
prompt:

�	�����	�������	������ �����	����!����

The report can be displayed on the AutoCAD text screen, as well as sent to a 
file. 

$ Accept the default of Yes to view the report.

The command sends the report information to the file specified. If N for No 
is entered in response to the "Would you like to view the report" prompt, the 
command sends the information to the file without displaying it on the 
screen. The time log report can then be modified using any text editor and 
printed.
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Adding a Revision Bar to the Drawing

The Add Revision Bar command draws a revision bar on the drawing. This 
revision bar uses the current revision number, editor, and date. 

To use the commands on the Revisions menu, make sure the Drawing Man-
ager is enabled. To do this, click Revision Settings, then select Enable drawing 
manager on the Revision Settings dialog box.

���	���	��"�������	����������	����

� From the Utilities menu, choose Revisions ➤ Add Revision Bar.

If this is the first revision bar to be added to the drawing, the command first 
prompts for the following insertion point.

"�����	���	���

� Select the insertion point for the revision bar from the drawing and press 
ENTER.

NOTE The insertion point is the lower-left corner of the revision bar. If there is 
already a revision bar in the drawing, the new revision bar is added directly on 
top of the old bar. Enter a description and other attribute data for the revision 
bar.

AutoCAD Land Development Desktop prompts you for the rotation angle for 
the revision bar.

#	���	���������$��

� Type the rotation angle and press ENTER.

The following command sequence is displayed at the prompt.

#���	�����%���
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� Type the desired revision number and press ENTER.

You are prompted for the description of the revision number.

���(���	��

� Type a description for the revision number and press ENTER.

The following prompts are displayed.

#������%��
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� Type the information at the command line, pressing ENTER after each entry.
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NOTE The Add Revision Bar command uses the block revis_i.dwg for drawings 
using imperial units and the block revis_m.dwg for drawings using metric units. 
These blocks are located in the following folder:

c:\Program Files\Land Desktop R2\land\dwg\lng 

These blocks can be modified to suit particular needs. However, when modifying 
these blocks, note that there is an invisible attribute held in this block that defines 
the height (in plotted units) of the block. This is necessary for the Add Revision 
Bar command to run properly. If either of these blocks are modified, the height 
attribute must also be updated to reflect the new block height. 

Identifying Who Created an Object

You can identify the creator of an object in a drawing by using the Identify 
Creator command. To use the commands on the Revisions menu, make sure 
the Drawing Manager is enabled. To do this, click Revision Settings, then 
select Enable drawing manager on the Revision Settings dialog box.

���������
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� From the Utilities menu, choose Revisions ➤ Identify Creator.

The following prompt is displayed.

-���(��	%.�(���	�����	�����

� Select an object in your drawing whose creator you want to identify.

If the object you selected was created with the Drawing Manager enabled, 
then the creation date, the creator's initials, and the revision number display 
on the command line. If the object you selected was created before the Draw-
ing Manager was enabled or after the last time the drawing was saved, then 
a message that there is no record of the object in the time log will display. To 
identify an object created since the last save, use the Save command to save 
the drawing and try the Identify Creator command again.

The Identify Creator command identifies the person who created any 
selected object. 

� Select the object to identify at the following prompt.

-���(��	%.�(���	�����	�����
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If the object selected was created before the Drawing Manager was enabled 
or if the object selected was created after the last time the drawing was saved, 
the following prompt is displayed.

2	���(	���	���������������	�&

Highlighting Objects Created by a Selected 
Editor

You can highlight objects created by an editor and insert that person's initials 
into the current drawing. To use the commands on the Revisions menu, 
make sure the Drawing Manager is enabled. To do this, click Revision Set-
tings, then select Enable drawing manager on the Revision Settings dialog 
box.

����������������������	����
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� From the Utilities menu, choose Revisions ➤ Editor's Additions.

� Type the initials of the person who created the objects.

All objects created by a particular person are highlighted in the current 
drawing. 

� Enter the initials of the person who created the objects at the following 
prompt:

���	�3���������	�����( ��	��

The following informational prompts are displayed.
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� Press any key to exit the Editor's Additions command.

All objects found by this command are placed in a selection set. This set can 
be used with any command by typing P in response to any "Select objects" 
prompt.

NOTE If there are objects that were created since the last time the drawing 
was saved, these objects are not included in the selection set. To include these 
objects, use the Save command from the File menu to save the drawing and try 
the Editor's Additions command again.
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Highlighting Objects Created in a Revision Level

You can highlight objects created in a current drawing's revision level by 
using the Revision Additions command. To use the commands on the Revi-
sions menu, make sure the Drawing Manager is enabled. To do this, click 
Revision Settings, then select Enable drawing manager on the Revision Set-
tings dialog box.

����������������������	������	��"�������"�

� From the Utilities menu, choose Revisions ➤ Revision Additions.

� Type the revision level number that you want to search for in the current 
drawing.

All objects created in a particular revision level in the current drawing are 
highlighted. 

� Enter the revision level number to search for at the following prompt:

#���	���������	�����( ��	��

The following informational prompts are displayed.
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� Press any key to exit the Revision Additions command. 

All objects found by this command are placed in a selection set. This set can 
be used with any command by typing P in response to any "Select objects" 
prompt.

NOTE If there are objects that were created since the last time the drawing 
was saved, these objects are not included in the selection set. To include these 
objects, use the Save command from the File menu to save the drawing and try 
the Revision Additions command again.

Inserting a Daystamp

You can insert a daystamp into your current drawing by using the Daystamp 
Drawing command.

To use the commands on the Revisions menu, make sure the Drawing Man-
ager is enabled. To do this, click Revision Settings, then select Enable drawing 
manager on the Revision Settings dialog box.
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���������	��	
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� From the Utilities menu, choose Revisions ➤ Daystamp Drawing.

If this is the first time you are adding a daystamp to your drawing, the Select 
Color dialog box is displayed.

� From the Full Color Palette, select the desired color.

� Click OK.

The Select Linetype dialog box is displayed.

� Select the desired linetype. 

� Click OK.

AutoCAD Land Development Desktop defines the new daystamp layer by 
scaling the inserted database and displays the following prompt:

"�����	���	���

� Select a point or type a coordinate to specify an insertion point for the day-
stamp.

The Daystamp Drawing command places the drawing name, date, and time 
in the current drawing as a block. If a daystamp already exists, it is updated 
automatically.

NOTE The format of the date and time in the daystamp are taken from the 
Window's regional settings. The date uses the Short Date Style. The time also 
appears with the region identifier. To change the appearance of the date and 
time styles, you need to edit the relevant settings in the Control Panel.

NOTE An easy way to ensure that the daystamp is included in all drawings is 
to place the daystamp block in the drawing template.

Layer Management

The Layer Manager helps you organize, sort, and group layers, as well as save 
and coordinate layering schemes. You can also use layering standards with 
the Layer Manager to better organize the layers in your drawings.

When you open the Layer Manager, all the layers in the current drawing are 
displayed in the right pane. You can work with individual layers: change 
layer properties by clicking the standard AutoCAD layer property icons; make 
a layer the current layer; and create, rename, and delete layers. You can also 
create groups of layers, which you can use to organize layers into hierarchies. 
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A layer standard contains predefined layer names and a set of rules that 
determine the names of new layers you create within that particular layer 
standard.

You can create layer snapshots to save specific sets of layers and view infor-
mation that you can edit, delete, and import and export. Layer snapshots 
help you quickly recall specific layer and view configurations from complex 
data sets. Once you create a layer snapshot, you can add and delete individ-
ual layers in the snapshot and import it into new drawings to automatically 
set up a layering scheme. 

Working with Individual Layers

When you open the Layer Manager in a drawing, the right pane lists the lay-
ers in the drawing. You can edit the standard AutoCAD layer properties by 
clicking the properties icons. In the Layer Manager, you can create new layers 
with or without using a layer standard. You can also use the Layer Manager 
to make a layer current, rename and delete layers, and add layers to layer 
groups. 

Making a Layer Current

����	#�	��	
��������

� From the Utilities menu, choose Layer Manager.

� In the right pane of the Layer Manager, do one of the following:

� Select the layer that you want to make current and click . 
� Double-click the layer that you want to make current.
� Select the layer that you want to make current, right-click, and choose 

Make Current from the shortcut menu.

NOTE You must select an individual layer to make current. You cannot make 
multiple layers or layer groups current.

� Click Apply.

The layer that you selected is now the current layer and is marked with a 
green check in the Layer Manager. The name of this layer is displayed next 
to the Current Layer button near the top of the Layer Manager. 
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Creating New Layers

You can create a layer that conforms to a layer standard, or you can create a 
layer that is not part of a layer standard. 

Creating a New Nonstandard Layer 

�����	��	���������	��	����	
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click 

� In the New Layer dialog box, select Non Standard on the Layer Standard list.

� In the Layer Name box, type a name for the new layer.

� Select Make Current to make the new layer the current layer.

� In the Description box, type a description for the new layer.

$ In the Color list, select a color for the new layer.

% In the Linetype list, select a linetype. 

& Click OK to return to the Layer Manager.

The new layer is listed in the right pane of the Layer Manager. If you made 
the new layer current, the layer is marked with a green check and the name 
of the layer is displayed next to the Current Layer button near the top of the 
Layer Manager.

Creating a New Layer with a Layer Standard

�����	��	�����	
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the New Layer dialog box, select the layer standard that you want to use 
from the Layer Standard list.

� Under Descriptive Fields, enter the layer standard information for the new 
layer.

� In the Layer Name box, type a name for the new layer.

� Select Make Current to make the new layer the current layer.

$ In the Description box, type a description for the new layer.

% In the Color list, select a color for the new layer.

& In the Linetype list, select a linetype. 
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�' Click OK to return to the Layer Manager.

The new layer is listed in the right pane of the Layer Manager. If you made 
the new layer current, then the layer is marked with a green check and the 
name of the layer is displayed next to the Current Layer button near the top 
of the Layer Manager. 

Renaming a Layer

�����	��	��	
�

� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, do one of the following:

� Select the layer that you want to rename, right-click, and select Rename 
Layer from the shortcut menu.

� Select the layer that you want to rename and press F2.

� Type a new name for the layer.

Deleting a Layer

�������	��	
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, select the layer that you want to delete, right-click, and 
select Delete Layer from the shortcut menu.

� In the Layer Manager, click Apply.

Changing the Layer Standard of a Layer

�����	�������	
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, select the layer that you want to change, right-click, 
and select Change Layer Standard from the shortcut menu.

� Select a layer standard or Nonstandard. 

NOTE If a layer standard is unavailable on the shortcut menu, then the layer 
that you selected is not valid for that standard.
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Changing the Layer Description

�����	�������	
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, select the layer that you want to change, right-click, 
and select Change Description from the shortcut menu.

� Type a new description for the layer.

� Select Apply.

Layer Groups

With the Layer Manager, you can create groups of layers to create working 
views and backgrounds from large building data sets. 

There are four different types of layer groups: 

� The All group is always present and lists all the layers and other layer 
groups in the drawing. 

� An Xref group lists any layers in external reference files linked with the 
current drawing. 

� User groups contain layers that you have assigned to them. 
� Filter groups contain layers based on a filter that you set for the group. 

The following group rules apply when you are creating and working with 
layer groups:

� You can list a layer in more than one layer group.
� Multiple listings of the same layer must always have identical property set-

tings. For example, a layer that is a member of two groups cannot be a dif-
ferent color in each group.

� You cannot list a layer twice in a group. You can delete layer groups with-
out affecting the layers in the group.

� Changing one of the properties of a layer group changes that property for 
all the layers in that group, except where the change would be invalid. For 
example, it is not possible to freeze the current layer.

� Layer group names need not be unique.
� There is no naming convention for layer groups. Group names can 

include spaces, non-alphanumeric characters, and both uppercase and 
lowercase letters.

You can add and subtract layers from existing layer groups. You can change 
the standard AutoCAD properties for the layers in groups, rename layer 
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groups, delete layer groups, and change the filters in filter groups.

Creating a Layer Group

With the Layer Manager, you can create two types of layer groups: user 
groups and filter groups. User-defined groups can contain any layers in the 
current drawing. You can manually add layers to and remove layers from user 
groups by dragging layers within the Layer Manager into the user group or 
by selecting an object in the drawing on the layer that you want to add to 
the user group.

A filter group contains layers that meet filter criteria that you specify for the 
group. Filter criteria can select layers according to layer states (on/off, frozen/
thawed, locked/unlocked), properties, or names. For example, you can create 
a filter group that includes all of the red layers in the current drawing.

Filter groups can be either dynamic or static. Dynamic filter groups are auto-
matically updated when you change the properties of layers that are part of 
the group. You cannot manually add layers to or remove layers from existing 
dynamic filter groups. Static filter groups are not automatically updated, and 
they include only the layers that met the filter criteria when the group was 
created. You can manually add layers to and remove layers from existing 
static filter groups.

Creating a User Group

�����	��	����������

� From the Utilities menu, choose Layer Manager.

� In the left pane of the Layer Manager, select a layer, right-click, and select 

New Group ➤ User from the shortcut menu, or click  in the Layer Man-
ager. 

� Type a name for the new user group.

The new user group is displayed in the Layer Manager with the name that 
you typed.

Manually Adding Layers to a Layer Group
You can manually add layers to a user group or to a static filter group within 
the Layer Manager. You can either drag them from the list of layers in the 
right pane of the Layer Manager to the group in the left pane or add the layer 
to the group by selecting an object in the current drawing that is on the layer 
that you want to add. 
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You can also replace all layers in an existing group by selecting objects on the 
layers that you want to replace the existing layers. 

Dragging a Layer into a Layer Group
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� From the Utilities menu, choose Layer Manager.

� In the left pane of the Layer Manager, double-click the All layer group to view 
all the layers in the drawing.

� Select a layer in the right pane of the Layer Manager and drag the layer to the 
user layer group or static filter layer group in the left pane.

The layer is added to the layer group. To view the contents of the layer group, 
click the layer group folder in the left pane of the Layer Manager.

Adding Layers to a Group by Selecting Drawing Objects
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, select the user group to which you want to add a layer, 
right-click, and select Select Layers ➤ Add from the shortcut menu.

� In the current drawing, select an object on each layer that you want to add 
to the user group.

� When you finish selecting objects, press ENTER to return to the Layer Man-
ager.

The layers that you selected are added to the layer group. To view the con-
tents of the layer group, click the layer group folder in the left pane of the 
Layer Manager.

Replacing Layers in a Group by Selecting Drawing Objects

������	��	�������	
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, select the user group whose layers you want to replace, 
right-click, and select Select Layers ➤ Replace from the shortcut menu.

� Select an object on each layer that you want to use to replace the layers in 
the user group.

� When you finish selecting objects, press ENTER to return to the Layer Man-
ager.

The layers that you selected replace all of the existing layers in the layer 
group. To view the contents of the layer group, click the layer group folder in 
the left pane of the Layer Manager.
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Creating a Filter Group
A filter group contains layers that meet filter criteria that you specify for the 
group. Filter criteria can select layers according to layer states (on/off, frozen/
thawed, locked/unlocked), properties, or names. For example, you can create 
a filter group that includes all of the red layers in the drawing. 

(����	����	�������
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� Dynamic filter groups are automatically updated when you change the 
properties of layers that are part of the group. You cannot manually add 
layers or remove layers. 

� Static filter groups are not automatically updated, and they include only 
the layers that met the filter criteria when the group was created. You can 
manually add layers and remove layers. 

Creating a Dynamic Filter Group

�����	��	��
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� From the Utilities menu, choose Layer Manager.

� In the left pane of the Layer Manager, select a layer group, right-click, and 
select New Group ➤ Filter from the shortcut menu.

� In the Filter Name box, type a name for the new filter group.

� In the Layer Filter Properties dialog box, select Dynamic.

� Set the filter criteria:

� Click the tab and set filter criteria by visibility state, or select Ignore this 
Filter to not filter by visibility state. For more information, see “Setting the 
Layer State Filter Criteria” on page 969.

� Click the  tab and set filter criteria by layer color, or select Ignore this Filter 
to not filter by layer color. For more information, see “Setting the Layer 
Color Filter Criteria” on page 970.

� Click the  tab and set filter criteria by linetype, or select Ignore this Filter 
to not filter by linetype. For more information, see “Setting the Layer Line-
type Filter Criteria” on page 971.

� Click the  and set filter criteria by a layer standard, or select Ignore this Fil-
ter to not filter by a layer standard. For more information, see “Setting the 
Layer Standard Filter Criteria” on page 971.

� Click the  and set filter criteria by defining a wildcard, or select Ignore this 
Filter to not filter by wildcard. For more information, see “Setting the Fil-
ter Criteria Using Wildcard Characters” on page 971.

� When you finish specifying the filter criteria, click OK.



Layer Groups | 969

Creating a Static Filter Group
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� From the Utilities menu, choose Layer Manager.

� In the left pane of the Layer Manager, select a layer group, right-click, and 
select New Group ➤ Filter from the shortcut menu.

� In the Filter Name box, type a name for the new filter group.

� In the Layer Filter Properties dialog box, select Static.

� Set the filter criteria:

� Click the tab and set filter criteria by visibility state, or select Ignore this 
Filter to not filter by visibility state. For more information, see “Setting the 
Layer State Filter Criteria” on page 969.

� Click the  tab and set filter criteria by layer color, or select Ignore this Filter 
to not filter by layer color. For more information, see “Setting the Layer 
Color Filter Criteria” on page 970.

� Click the  tab and set filter criteria by linetype, or select Ignore this Filter 
to not filter by linetype. For more information, see “Setting the Layer Line-
type Filter Criteria” on page 971.

� Click the  and set filter criteria by a layer standard, or select Ignore this Fil-
ter to not filter by a layer standard. For more information, see “Setting the 
Layer Standard Filter Criteria” on page 971.

� Click the  and set filter criteria by defining a wildcard, or select Ignore this 
Filter to not filter by wildcard. For more information, see “Setting the Fil-
ter Criteria Using Wildcard Characters” on page 971.

� When you finish specifying the filter criteria, click OK.

Setting the Layer State Filter Criteria
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� Clear the check box next to Ignore this Filter

� Choose one of the following options for the On/Off layer state filter:

� On includes all the layers in the drawing that are turned on. 
� Off includes all the layers that are turned off. 
� Both includes both layers that are turned on and layers that are turned off. 

� Choose one of the following options for the Freeze/Thaw layer state filter:

� Thawed includes all the layers in the drawing that are thawed. 
� Frozen includes all the layers that are frozen. 
� Both includes both thawed and frozen layers. 
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� Choose one of the following options for the Locked/Unlocked layer state 
filter:

� Unlocked includes all the layers in the drawing that are unlocked. 
� Locked includes all the layers that are locked. 
� Both includes both locked and unlocked layers.

� Choose one of the following options for the Viewport Thawed/Viewport Fro-
zen layer state filter:

� VP Thawed includes all the layers that are thawed in the current view-
port.

� VP Frozen includes all the layers that are frozen in the current viewport.
� Both includes all the layers in the current viewport, both thawed and 

frozen. 

� Choose one of the following options to filter for layers that are in use or 
unused:

� In Use includes all the layers in the drawing that are in use. 
� Unused includes all of the layers that are unused. 
� Both includes both used and unused layers. 

Setting the Layer Color Filter Criteria
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� Clear the check box next to Ignore this Filter.

� To add layer colors to the filter, do one of the following:

� Click Add All to add all of the available colors from the layers in the draw-
ing to the color filter. The colors in the Available Colors list are displayed 
in the Selected Colors list.

� Select an individual color in the Available Colors list, and click Add to add 
it to the color filter. The color you select in the Available Colors list moves 
to the Selected Colors list.

� To remove layer colors from the filter, do one of the following:

� Click Remove All to remove all of the layer colors in the color filter. The 
colors in the Selected Colors list move to the Available Colors list. 

� Select an individual color in the Selected Colors list, and click Remove to 
remove it from the color filter. The color you select in the Selected Colors 
list moves to the Available Colors list.

� To choose a new layer color, click Choose Color and select a new layer color.
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Setting the Layer Linetype Filter Criteria
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� Clear the check box next to Ignore this Filter:

� To add linetypes to the filter, do one of the following:

� Choose an individual linetype from the Available for Filtering list, and 
click Add. The linetype moves from the Available for Filtering list to the 
Already in Filter list.

� Click Add All to add all of the available linetypes to the filter. The line-
types move from the Available in Drawing list to the Already in Filter list.

� To remove linetypes from the filter, do one of the following:
� Choose an individual linetype from the Already in Filter list, and click 

Remove. The linetype moves from the Already in Filter list to the Available 
for Filtering list.

� Click Remove All to remove all of the linetypes in the filter. The linetypes 
move from the Already in Filter list to the Available for Filtering list.

Setting the Layer Standard Filter Criteria
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� Clear the check box next to Ignore This Filter, and do one of the following:

� To filter for layer categories that are not in a layer standard, select Non 
Standard. 

� To filter for layers that are in a layer standard, select the layer standard 
from the list.

� If you selected a layer standard in step 1, use Add and Remove to transfer 
layer standard categories to and from the Available Categories and Selected 
Categories lists. 

The Selected Categories list contains the categories that are included in the 
filter criteria. When you add categories to the Selected Categories list, the 
order in which you add them affects the hierarchical structure of the gener-
ated layer groups. 

Setting the Filter Criteria Using Wildcard Characters
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� Clear the check box next to Ignore This Filter.

� To set the wildcard filter criteria, do one of the following:
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� In the drop down list, click Wildcard layer names must match, and then 
type a wildcard string and an asterisk (*) to include in the filter all layers 
that contain that string. 

� In the drop down list, click Wildcard layer names must NOT match, and 
then type a wildcard string and an asterisk (*) to exclude from the filter all 
layers that contain that string. 

NOTE The wildcard string is not case-sensitive.

Changing an Existing Layer Group

In the Layer Manager, you can change the standard AutoCAD properties of 
all the layers in an existing layer group. You can also rename and delete exist-
ing groups of layers. If you are working with existing filter groups, then you 
can change the filter.

You can also save a layer group as a layer snapshot. A layer snapshot is a spe-
cific set of layers and view information that you can save, edit, and restore in 
your drawing. By saving layer and view information in a snapshots, you can 
quickly recall specific layer and view configurations from complex data sets.

Changing the Properties of a Layer Group
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, select the layer group whose properties you want to 
change, right-click, and select one of the following options from the shortcut 
menu:

� Lock locks or unlocks all the layers in the group depending on the layer 
state.

� Freeze/Thaw freezes or thaws all the layers in the group depending on the 
layer state.

� Viewport freezes or thaws all the layers in the group within the current 
viewport.

� Visibility switches all the layers in the group on or off depending on the 
layer state.

� Isolate Group freezes all the layers in the drawing except those in the 
selected layer group.

The layers in the layer group are updated to display the property changes.
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Renaming a Layer Group
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� From the Utilities menu, choose Layer Manager.

� In either the left pane or the right pane of the Layer Manager, do one of the 
following to rename the layer group:

� Select the layer group that you want to rename, press F2, and type a new 
name for the layer group.

� Select the layer group that you want to rename, right-click, choose 
Rename Group from the shortcut menu, and type a new name for the 
layer group.

Deleting a Layer Group
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� From the Utilities menu, choose Layer Manager.

� In either the left pane or the right pane of the Layer Manager, select the layer 
group that you want to delete.

� Do one of the following to delete the layer group:

� Press DELETE to delete the group.
� Right-click and choose Delete Group from the shortcut menu.

The layer group is deleted from the Layer Manager, but the layers listed in the 
group are not affected.

Changing a Layer Group Filter
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� From the Utilities menu, choose Layer Manager.

� In the left pane of the Layer Manager, select the layer group with the filter 
criteria that you want to edit, right-click, and select Properties from the short-
cut menu.

� In the Layer Filter Properties dialog box, set the filter criteria:

� Click the tab and set filter criteria by visibility state, or select Ignore this 
Filter to not filter by visibility state. For more information, see “Setting the 
Layer State Filter Criteria” on page 969.

� Click the  tab and set filter criteria by layer color, or select Ignore this Filter 
to not filter by layer color. For more information, see “Setting the Layer 
Color Filter Criteria” on page 970.
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� Click the  tab and set filter criteria by linetype, or select Ignore this Filter 
to not filter by linetype. For more information, see “Setting the Layer Line-
type Filter Criteria” on page 971.

� Click the  and set filter criteria by a layer standard, or select Ignore this Fil-
ter to not filter by a layer standard. For more information, see “Setting the 
Layer Standard Filter Criteria” on page 971.

� Click the  and set filter criteria by defining a wildcard, or select Ignore this 
Filter to not filter by wildcard. For more information, see “Setting the Fil-
ter Criteria Using Wildcard Characters” on page 971.

� When you finish specifying the filter properties, click OK.

Working with Layer Standards

You can use layer standards to establish individual, project, or office layering 
conventions. A layer standard contains predefined layer names and a set of 
rules that determine the names of new layers that you create within that par-
ticular layer standard. 

Each layer standard definition contains a set of rules that determine the 
names of new layers created within the layer standard. When you create a 
new layer, the layer name has a number of parts separated by delimiters (for 
example, hyphens). Each part of the layer name is determined by rules set in 
one field of the layer standard. You can edit the layer standard definition to 
change these rules. 

Editing the Layer Standard Definition

You can edit the layer standard definition to change the way new layers cre-
ated within the layer standard are named.
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Select Layer Standard dialog box, select the layer standard that you 
want to edit and click Edit.

� In the Layer Standards dialog box, edit the information on each of the tabs. 
These tabs set "rules" to determine the component fields and values in each 
layer name. See “Layer Standard Fields” on page 975 for a list of what values 
can be set in each field.
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� Click the Component Fields tab to specify how you want to set up the 
fields within the layer standard that determine the different parts of the 
layer names created with that standard. You can add, delete, or change the 
order of these component fields. For more information, see “Editing the 
Component Fields” on page 976.

� Click the Edit Descriptive Fields tab to add a description that is applied to 
each component field in the layer name. You can add a single description 
to a group of layer name component fields. For more information, see 
“Editing Descriptive Fields” on page 977.

� Click the Edit Descriptions tab to map longer or different descriptions to 
the component fields of the layer name. The layer descriptions are dis-
played in the Layer Manager under Description. For more information, see 
“Editing Descriptions” on page 978.

� Click the Description Specification tab to control how all the fields in the 
layer standard determine the layer description that is displayed in the 
Layer Manager. You can change the field that is used in the description 
and the order of the fields, and you can add text to the beginning of the 
layer description. For more information, see “Editing the Description 
Specification” on page 978.

� Click OK to return to the Select Layer Standard dialog box. 

Layer Standard Fields
The layer standard fields are described below.

� Field identifies the field. Field names should be as consistent as possible 
across layering systems to aid in translation.

� Optional, when set to Yes, allows the field to be omitted from the end of 
the layer. Optional layer fields cannot precede a required layer field unless 
the match option is set to Yes so that the fields can be identified according 
to a match against specific descriptions.

� Width represents the maximum width in characters that can be used.
� Fixed, when set to Yes, prevents a field from being shortened from the 

width setting.
� Wildcard is an AutoCAD wildcard pattern that the field must match.
� Match, when set to Yes, recognizes the field only if it exactly matches a 

description. You can omit fields from the middle of layer names. 
� Delimiter specifies the character used to separate fields with no fixed 

width. Delimiters are often also used in fixed-width fields for clarity.

For more information, see “Editing the Layer Standard Definition” on page 
974 .
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Creating a New Layer Standard from an Existing 
Layer Standard
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Select Layer Standard dialog box, click New.

� In the Create Layer Standard dialog box, type a name for the new layer stan-
dard.

� Select Based On, and select the layer standard that you want to use to create 
the new layer standard. 

� Click OK to return to the Select Layer Standard dialog box. 

$ Select the new layer standard and click Edit.

% In the Layer Standards dialog box, do any of the following:

� Click the Component Fields tab to specify how you want to set up the 
fields within the layer standard that determine the different parts of the 
layer names created with that standard. You can add, delete, or change the 
order of these component fields. For more information, see “Editing the 
Component Fields” on page 976.

� Click the Edit Descriptive Fieldstab to add a description that is applied to 
each component field in the layer name. You can add a single description 
to a group of layer name component fields. For more information, see 
“Editing Descriptive Fields” on page 977.

� Click the Edit Descriptionstab to map longer or different descriptions to 
the component fields of the layer name. For more information, see “Edit-
ing Descriptions” on page 978.

� Click the Description Specification tab to control how all the fields in the 
layer standard determine the layer description that is displayed in the 
Layer Manager. You can change the field that is used in the description 
and the order of the fields, and you can add text to the beginning of the 
layer description. For more information, see “Editing the Description 
Specification” on page 978.

& When you finish making changes to the layer standard, click OK.

Editing the Component Fields
Use the Component Fields tab to specify how you want to break down the 
individual component fields of a layer standard.
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� In the Layer Standard list, select the layer standard that you want to edit. 

� To delete a component field, select the field and click .

� To add a component field above an existing field, select the field, and click 

. Type a name for the new component field.

� To add a component field below an existing field, select the field, and click 

. Type a name for the new component field.

� To edit a field name, double-click the name of the field and type a new name, 
or select the name of the field and press F2. 

� To change the settings of individual component fields, select the values that 
you want to change, right-click, and select a new value from the shortcut 
menu. Refer to “Layer Standard Fields” on page 975 for changing layer stan-
dard fields.

Editing Descriptive Fields
Use the Edit Descriptive Fields tab to change the display order of layer stan-
dard components in the Layer Manager.
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� In the Layer Standard list, select the layer standard that you want to edit. 

� To delete a descriptive field, select the field and click .

� To add a descriptive field above an existing field, select the field, and click 

. Type a name for the new descriptive field. 

� To add a descriptive field below an existing field, select the field, and click 

. Type a name for the new descriptive field.

� To add a component field to a descriptive field, select the component under 
Component across from the descriptive field, right-click, and choose a new 
component field from the shortcut menu. You can add multiple component 
fields to a descriptive field. Multiple component fields are used for hierarchi-
cal fields such as the CISfB field used by the BS1192 layer standard.

� To delete a component field from a descriptive field, select the component 
field, right-click, and choose Delete from the shortcut menu.

$ To edit a field name, double-click the name of the field and type a new name, 
or select the name of the field and press F2.
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Editing Descriptions
Use the Edit Descriptions tab to map descriptions to component fields.
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� In the Layer Standard list, select the layer standard that you want to edit.

� In the Field to Edit list, select the field that you want to change.

� To delete a description, select the field description and click .

� To edit a description, select the field description and click . Make changes 
to the description in the Edit Descriptions dialog box and click OK.

� To add a field with a value and a description, click . Type a value and a 
description for the field in the Add Description dialog box and click OK.

Editing the Description Specification
Use the Description Specification tab to control how the fields of a layer stan-
dard determine the layer description.
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� In the Layer Standard list, select the layer standard with description specifi-
cation that you want to edit.

� To delete a layer standard field, select the field in the dialog box and click .

� To add a field above an existing field, select the field and click . Type a 
name for the new field.

� To add a field below an existing field, select the field and click . Type a 
name for the new field.

� To edit text under Prior Text, select the text you want to change and type new 
text. 

� To change the Field value, click the current value, right-click, and select a 
new value from the shortcut menu.

Purging Layer Standards
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .
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� In the Select Layer Standards dialog box, select the layer standards that you 
want to purge and click Purge.

� Click OK.

The layer standards that you selected are purged. 

Importing Layer Standards
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Select Layer Standards dialog box, click Import/Export.

� In the Import/Export dialog box, click Open.

� Select the drawing file with the layer standards that you want to import and 
click Open. 

All the layer standards in the drawing file are displayed in the External File 
list.

� In the External File list, select the layer standards that you want to import 
and click Import.

NOTE You can select more than one item in a list by holding down CTRL while 
you select the additional items.

NOTE If you import a layer standard that already exists in the target drawing, 
a message is displayed asking if you wish to overwrite the existing layer standard. 
Click Yes to overwrite the existing layer standard, or click No to cancel.

� Click OK to return to the Select Layer Standards dialog box.

The layer standards that you imported are displayed in the Select Layer Stan-
dards dialog box. 

Exporting Layer Standards to a New Drawing
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .
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� In the Select Layer Standards dialog box, click Import/Export. 

� In the Import/Export dialog box, click New.

� In the New Drawing dialog box, type a name for new drawing file you want 
to export the layer standards to and click OK. 

� In the Import/Export dialog box, select the layer standards that you want to 
export and click Export. 

NOTE You can select more than one item in a list by holding down CTRL while 
you select the additional items.

The layer standards are now in the new drawing.

$ Click OK to exit each dialog box.

Exporting Layer Standards to an Existing 
Drawing

You can export layer standards from the current drawing to another drawing.
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Select Layer Standards dialog box, click Import/Export.

� In the Import/Export Layer Standards dialog box, click Open. 

� In the Open drawing dialog box, select a drawing to export the layer stan-
dards to and then click Open.

� In the Import/Export Layer Standards dialog box under Current Drawing, 
select the layer standards to export and then click Export.

NOTE You can select more than one item in a list by holding down CTRL while 
you select the additional items.

NOTE If you export a layer standard that already exists in the target drawing 
a message is displayed asking if you wish to overwrite the existing layer standard. 
Click Yes to overwrite the existing layer standard, or click No to cancel.

$ Click OK to exit each dialog box.
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The layer standards that you selected are exported to the existing drawing 
file. 

Layer Snapshots

A layer snapshot is a specific set of layers and view information that you can 
save, edit, and restore in your drawing. By saving layer and view information 
in a snapshot, you can quickly recall specific layer and view configurations 
from complex data sets. 

You can create and name any number of layer snapshots. You can add and 
delete individual layers in an existing snapshot. You can edit, delete, and 
import and export the snapshot. Import snapshots into new drawings to 
automatically set up a layering scheme in your drawing. 

Creating Layer Snapshots

You can create snapshots of all the layers in the current drawing or all of the 
layers in a particular layer group. Create a snapshot of all the layers in a draw-
ing when you want to restore or export an entire layering scheme. Create a 
snapshot of a particular layer group to store a specific set of layering 
information.

Creating a Snapshot of All the Drawing Layers
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� From the Utilities menu, choose Layer Manager.

� In the left pane of the Layer Manager, click All to display all the layers or layer 
groups in your drawing. 

� Click .

� In the Snapshot dialog box, click New.

� In the Snapshots dialog box, type a name for the new snapshot.

� Click OK to create the snapshot and return to the Snapshots dialog box.

The new snapshot that you created is listed in the Snapshots dialog box.

Creating a Snapshot of a Layer Group
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� From the Utilities menu, choose Layer Manager.



982 | Chapter 38 Utilities

� In the left pane of the Layer Manager, click All to display all the layers and 
layer groups in your drawing.

� Select the layer group that you want to use to create the snapshot, and then 
right-click and choose Save as Snapshot from the shortcut menu.

� In the Snapshot dialog box, type a name for the new snapshot.

� Click OK to create the snapshot and return to the Layer Manager.

The layer group snapshot that you created is listed in the Snapshots dialog 
box. 

� To view the new layer group snapshot in the Snapshots dialog box, click  
in the Layer Manager.

Editing a Layer Snapshot
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Snapshots dialog box, select the snapshot that you want to edit and 
click Edit.

� In the Snapshot Edit dialog box, do any of the following:

� To add layers in the drawing that are not listed in the snapshot, click Add, 
select the layer that you want to add in the Select Layer dialog box, and 
click OK.

� To delete a layer from the snapshot, select the layer that you want to delete 
and click Delete.

� To edit the standard AutoCAD layer properties of the individual layers in 
the snapshot, click the property icons or descriptions.

� When you finish editing the layer snapshot, click OK to return to the Snap-
shots dialog box.

The snapshot is saved with the changes that you made and is displayed in the 
Snapshots dialog box.

Restoring a Layer Snapshot
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .
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� In the Snapshots dialog box, select the layer snapshot that you want to 
restore, and click Restore.

Deleting a Layer Snapshot
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Snapshots dialog box, select the snapshot that you want to delete and 
click Delete.

The snapshot that you deleted is no longer listed in the Snapshots dialog box.

Importing a Layer Snapshot
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Snapshots dialog box, click Import.

� In the Import Layer Snapshot dialog box, select the snapshot that you want 
to import.

You can import snapshots with the following file extensions:

� Layer Manager Snapshot Format (.ssl) saves a layer properties, descrip-
tion, and linetype file.

� Bonus Layer Format (.lay) is compatible with the AutoCAD 2000 Express 
Tools utility for saving layer snapshots. The layer description and linetype 
file are not saved with the snapshot.

� Comma-Delimited Format (.cdf) is an ASCII file that you can read or edit 
in a standard word processor.

� Click Open to return to the Snapshots dialog box.

� If a snapshot includes layers that are not in the current drawing, you are 
prompted to restore the snapshot settings. Click Yes to restore the settings. 

The imported snapshot is displayed in the Snapshots dialog box.
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Exporting a Layer Snapshot to a New Drawing
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� From the Utilities menu, choose Layer Manager.

� In the Layer Manager, click .

� In the Snapshots dialog box, select the snapshot that you want to export, and 
click Export.

� In the Export Layer Snapshot dialog box, type a name for the new file that 
you want to export the snapshot to.

� From the Save as type list, select one of the following file formats for the 
snapshot:

� Layer Manager Snapshot Format (.ssl) saves a layer properties, descrip-
tion, and linetype file.

� Bonus Layer Format (.lay) is compatible with the AutoCAD 2000 Express 
Tools utility for saving layer snapshots. The layer description and linetype 
file are not saved with the snapshot.

� Comma-Delimited Format (.cdf) is an ASCII file that you can read or edit 
in a standard word processor.

� Click Save to export the snapshot and return to the Snapshots dialog box.

The layer snapshot is exported to the file that you specified in the format you 
selected.

Symbol Management

You can access the Symbol Manager to create and manage groups of symbols 
and to insert individual symbols into your drawings. The groups within the 
Symbol Manager are called symbol sets. Groups are further divided into cat-
egories and palettes. You can view graphic representation of the symbols, 
called slides, in each palette.

The structure of a symbol set is illustrated below.
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AutoCAD Land Development Desktop includes four symbol sets:

� Annotation Symbols
� APWA Symbols
� COGO Symbols
� Landscape Symbols

You can use the Symbol Manager to insert individual symbols into drawings, 
edit the settings of a symbol, including the layer, elevation, and rotation, and 
to copy and move symbols across palettes. You can also use the Symbol 
Manager to create new symbol sets, add symbols to symbol sets, and edit 
symbol sets.

Inserting a Symbol in the Current Drawing
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� From the Utilities menu, choose Symbol Manager.



986 | Chapter 38 Utilities

� In the Symbol Manager, select the symbol set that you want to use from the 
Symbol Set list.

� In the Category list, select the symbol category that you want to use.

� In the Palette list, select the symbol palette that you want to use. 

� From the symbol palette, select the symbol that you want to insert, and click 
OK. You can click Next and Previous to browse through the symbols in the 
palette.

� Click OK to place the symbol in your drawing.

$ Specify the insertion point.

% Specify the rotation angle for the symbol.

& If the Insertion option is set to single, one symbol is placed. If the option is 
set to repeat, after you have placed the symbol, right-click and click Cancel 
to stop inserting the symbol. For more information, see “Setting the Inser-
tion Options for Symbols” on page 998.

Customizing a Symbol Palette

You can customize an existing symbol palette by adding or deleting symbols. 
You can copy or move the symbols that you commonly use to the same pal-
ette. You can create duplicate database entries for the same symbol, each with 
a different scale or layer setting.

Adding Symbols to a Palette
You can add new symbols to a symbol palette.
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� From the Utilities menu, choose Symbol Manager.

� In the Symbol Manager, click Add.

The Add Symbol dialog box is displayed.

� Type the name of the new symbol in the Symbol Name edit box.

� To change the symbol path, select a new path from the Symbol Path scroll 
box. 

� If you want to add a new path key, click the  button. For more information, 
see “Adding a Path Key” on page 994.

� To specify the icon for the symbol, do one of the following:

� Type a name in the Slide edit box.
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NOTE To specify a slide library, type the name of the slide image for the 
symbol in parentheses after the slide library name.

� Click Slide to select a slide or slide library.

NOTE Slide files must exist in the same folder as the symbol drawing file.

$ To specify the drawing file for the symbol, do the following:

� Type the name of the file in the Block edit box.
� Select Block to locate the drawing file.

% To change the default layer on which the symbol is placed, type the layer 
name in the text box under Layer.

NOTE The layer does not have to exist. The program creates it when you insert 
the symbol.

& Use the Symbol Units scroll box to specify the units of measurement in 
which you originally created the symbol drawing.

The program uses this value to calculate insertion scales. For annotation sym-
bols with text attributes of 1 unit, use the unitless setting. This ensures proper 
sizing in both imperial and metric unit systems.

�' In the Elevation (Preset) text box, specify the default elevation for the 
symbol.

This setting specifies the base elevation (above the current UCS) at which to 
insert the symbol. If you leave the edit box blank, the program inserts sym-
bols at the current elevation.

�� In the Rotation (Preset) text box, specify the default rotation angle for the 
symbol. If you leave the edit box blank, the program prompts you for a rota-
tion angle when you insert the symbol.

�� Under Scale Factors (Preset), type the default X, Y, and Z scale factors for the 
symbol. If these values are unspecified, then the program prompts you for 
scale factors when you insert the symbol.

NOTE If the scale values match and you change the X factor, then the pro-
gram updates the Y and Z values to match. To change the X factor only, you can 
return the Y and Z values to their original factors.
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�� Under Scale Factor Multiplier, select one of the following to adjust how sym-
bols are scaled:

� None: To use the scale factors that you set in the Scale Factors (Preset) text 
boxes. Use this setting for objects such as benchmarks or fire hydrants.

� Annotation: To apply the current annotation scale setting to the symbol.

NOTE Use this option for annotation symbols with text attributes that are 
1 unit high. This applies to most Autodesk annotation symbols. Annotation 
scaling controls the attribute text height to match a desired text height. The 
program scales any geometry around the attribute, such as circle or square, 
to fit the text.

� Drawing: To apply the current drawing scale setting to the symbol. Use 
this option for symbols that you have created at a specific plot size.

�� Click OK to exit the dialog box, or Advanced to continue setting the . For 
more information, see “Adding Symbols to a Palette” on page 986.

Using the Symbol Defaults Dialog Box
Use the symbol defaults dialog box when you want to configure the layer set-
tings, symbol units, elevation, rotation, and scale factors for symbols you 
import into a symbol set.
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� To change the default layer on which the symbol is placed, type the layer 
name in the text box under Layer.

NOTE The layer does not have to exist. The program creates it when you insert 
the symbol.

� Use the Symbol Units scroll box to specify the units of measurement in 
which you originally created the symbol drawing.

The program uses this value to calculate insertion scales. For annotation sym-
bols with text attributes of 1 unit, use the unitless setting. This ensures proper 
sizing in both imperial and metric unit systems.

� In the Elevation (Preset) text box, specify the default elevation for the 
symbol.

This setting specifies the base elevation (above the current UCS) at which to 
insert the symbol. If you leave the edit box blank, the program inserts sym-
bols at the current elevation.
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� In the Rotation (Preset) text box, specify the default rotation angle for the 
symbol. If you leave the edit box blank, the program prompts you for a rota-
tion angle when you insert the symbol.

� Under Scale Factors (Preset), type the default X, Y, and Z scale factors for the 
symbol. If these values are unspecified, then the program prompts you for 
scale factors when you insert the symbol.

NOTE If the scale values match and you change the X factor, then the pro-
gram updates the Y and Z values to match. To change the X factor only, you can 
return the Y and Z values to their original factors.

� Under Scale Factor Multiplier, select one of the following to adjust how sym-
bols are scaled:

� None: To use the scale factors that you set in the Scale Factors (Preset) text 
boxes. Use this setting for objects such as benchmarks or fire hydrants.

� Annotation: To apply the current annotation scale setting to the symbol.

NOTE Use this option for annotation symbols with text attributes that are 
1 unit high. This applies to most Autodesk annotation symbols. Annotation 
scaling controls the attribute text height to match a desired text height. The 
program scales any geometry around the attribute, such as circle or square, 
to fit the text.

� Drawing: To apply the current drawing scale setting to the symbol. Use 
this option for symbols that you have created at a specific plot size.

$ Click OK to exit the dialog box, or click Advanced to continue setting the 
Advanced Settings. For more information, see “Changing the Advanced Set-
tings” on page 997.

Using the Add Symbol Dialog Box
Use the Add Symbol dialog box to add a symbol to a palette.
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� Type the name of the new symbol in the Symbol Name edit box.

� To change the symbol path, select a new path from the Symbol Path scroll 
box. 

� If you want to add a new path key, click the  button. For more information, 
see “Adding a Path Key” on page 994.

� To specify the icon for the symbol, do one of the following:
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� Type a name in the Slide edit box.

NOTE To specify a slide library, type the name of the slide image for the 
symbol in parentheses after the slide library name.

� Click Slide to select a slide or slide library.

NOTE Slide files must exist in the same folder as the symbol drawing file.

� To specify the drawing file for the symbol, do the following:

� Type the name of the file in the Block edit box.
� Select Block to locate the drawing file.

� To change the default layer on which the symbol is placed, type the layer 
name in the text box under Layer.

NOTE The layer does not have to exist. The program creates it when you insert 
the symbol.

$ Use the Symbol Units scroll box to specify the units of measurement in 
which you originally created the symbol drawing.

The program uses this value to calculate insertion scales. For annotation sym-
bols with text attributes of 1 unit, use the unitless setting. This ensures proper 
sizing in both imperial and metric unit systems.

% In the Elevation (Preset) text box, specify the default elevation for the sym-
bol.

This setting specifies the base elevation (above the current UCS) at which to 
insert the symbol. If you leave the edit box blank, the program inserts sym-
bols at the current elevation.

& In the Rotation (Preset) text box, specify the default rotation angle for the 
symbol. If you leave the edit box blank, the program prompts you for a rota-
tion angle when you insert the symbol.

�' Under Scale Factors (Preset), type the default X, Y, and Z scale factors for the 
symbol. If these values are unspecified, then the program prompts you for 
scale factors when you insert the symbol.

NOTE If the scale values match and you change the X factor, then the pro-
gram updates the Y and Z values to match. To change the X factor only, you can 
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return the Y and Z values to their original factors.

�� Under Scale Factor Multiplier, select one of the following to adjust how sym-
bols are scaled:

� None: To use the scale factors that you set in the Scale Factors (Preset) text 
boxes. Use this setting for objects such as benchmarks or fire hydrants.

� Annotation: To apply the current annotation scale setting to the symbol.

NOTE Use this option for annotation symbols with text attributes that are 
1 unit high. This applies to most Autodesk annotation symbols. Annotation 
scaling controls the attribute text height to match a desired text height. The 
program scales any geometry around the attribute, such as circle or square, 
to fit the text.

� Drawing: To apply the current drawing scale setting to the symbol. Use 
this option for symbols that you have created at a specific plot size.

�� Click OK to exit the dialog box, or Advanced to continue setting the 
Advanced Settings. For more information, see “Changing the Advanced Set-
tings” on page 997.

Editing Symbol Dialog Box
Use the Edit Symbol dialog box to edit a symbol in a palette. You can change 
the name, the symbol block, and the insertion parameters.
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� Do one of the following:

� To change the symbol name, type a name in the Symbol Name box.
� To change the path key for the symbol block drawing and slide file, select 

a new path key in the Symbol Path list, or click Add Key to add a new path 
key to the sdsk.dfm file in the following folder:

c:\Program Files\Land Desktop R2 

� To specify a slide file or slide library that will provide the image of the sym-
bol in the Symbol Manager, type a new slide name in the edit box, or click 
Block and select a new drawing file.

� To change the layer that the symbol is inserted on, type a new layer name 
in the edit box.

� In the Symbol Units list, select a unit of measurement for the symbol.
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NOTE The Symbol Units setting specifies the units of measurement in the 
original symbol drawing. The value is used to calculate the scale when the 
symbol is inserted in a drawing. For annotation symbols with text attributes 
of one (1), set the Symbol Units to Unitless. This setting ensures proper sizing 
in both imperial and metric unit systems.

� To change the base elevation (above the current UCS) at which the symbol 
will be inserted, type a new value in the Elevation (Preset) box, or clear the 
check box to use the current elevation during insertion.

� To change the default rotation angle at which the symbol will be inserted, 
type a new value in the Rotation (Preset) box, or clear the check box if you 
want to be prompted for a rotation angle during insertion.

� To adjust the values set for the Scale Factors (Preset), select a Scale Factor Mul-
tiplier. Select one of the following:

� None: To use the Scale Factors (Preset) setting without any adjustments. 
Use this setting for objects such as fire hydrants or benchmarks.

� Annotation: To use the current annotation scale value to scale the sym-
bol. Use this option for annotation symbols with text attributes that are 1 
unit high. Annotation scaling controls the attribute text height to match 
a desired text height. Any geometry surrounding the attribute, such as a 
circle, is scaled to fit the text.

� Drawing: To use the current drawing scale to scale the symbol. Use this 
option for symbols that were created at a specific plot size.

� Click  to configure the additional advanced symbol settings, such as the sym-
bol insertion options, block styles, attribute defaults and any pre- or post-
insertion AutoLISP functions. For more information, see “Changing the 
Advanced Settings” on page 997.

� When you finish editing the symbol, click OK to return to the Symbol 
Manager.

The edited symbol appears in the Symbol Manager and can be inserted in a 
drawing with the new settings.

Moving Symbols Between Palettes
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� From the Utilities menu, choose Symbol Manager.

� Select the Symbol Set, Category and Palette, then highlight the symbol you 
want to move.
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� Click Move.

The Move Symbol dialog box is displayed.

� To specify a new location, do one of the following:

� Select an existing Category and Palette.
� Select an existing Category. In the New text box, type a new palette name.
� Type a new Category and new Palette name in the New text box.

� Select the Display destination palette box if you want the Symbol Manager 
to display the symbol in its new location when you return to the Symbol 
Manager dialog box.

� Click OK.

The selected symbol is moved from its original location to the specified cat-
egory and palette. If you typed a new Category and/or Palette, they are cre-
ated in the current Symbol Set.

Editing a Symbol
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� From the Utilities menu, choose Symbol Manager.

� In the Symbol Manager, select the symbol set that you want to use from the 
Symbol Set list.

� In the Category list, select the symbol category that you want to use.

� In the Palette list, select the symbol palette that you want to use. 

� From the symbol palette, select the symbol that you want to edit, and click 
Edit.

The Edit Symbol dialog box is displayed.

� Do one of the following:

� To change the symbol name, type a name in the Symbol Name box.
� To change the path key for the symbol block drawing and slide file, select 

a new path key in the Symbol Path list, or click Add Key to add a new path 
key to the sdsk.dfm file in the following folder:

c:\Program Files\Land Desktop R2

� To specify a slide file or slide library that will provide the image of the sym-
bol in the Symbol Manager, type a new slide name in the edit box, or click 
Block and select a new drawing file.

� To change the layer that the symbol is inserted on, type a new layer name 
in the edit box.

� In the Symbol Units list, select a unit of measurement for the symbol.
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NOTE The Symbol Units setting specifies the units of measurement in the 
original symbol drawing. The value is used to calculate the scale when the 
symbol is inserted in a drawing. For annotation symbols with text attributes 
of one (1), set the Symbol Units to Unitless. This setting ensures proper sizing 
in both imperial and metric unit systems.

� To change the base elevation (above the current UCS) at which the symbol 
will be inserted, type a new value in the Elevation (Preset) box, or clear the 
check box to use the current elevation during insertion.

� To change the default rotation angle at which the symbol will be inserted, 
type a new value in the Rotation (Preset) box, or clear the check box if you 
want to be prompted for a rotation angle during insertion.

$ To adjust the values set for the Scale Factors (Preset), select a Scale Factor Mul-
tiplier. Select one of the following:

� None: To use the Scale Factors (Preset) setting without any adjustments. 
Use this setting for objects such as fire hydrants or benchmarks.

� Annotation: To use the current annotation scale value to scale the sym-
bol. Use this option for annotation symbols with text attributes that are 1 
unit high. Annotation scaling controls the attribute text height to match 
a desired text height. Any geometry surrounding the attribute, such as a 
circle, is scaled to fit the text.

� Drawing: To use the current drawing scale to scale the symbol. Use this 
option for symbols that were created at a specific plot size.

% Click to configure the additional advanced symbol settings, such as the sym-
bol insertion options, block styles, attribute defaults and any pre- or post-
insertion AutoLISP functions. For more information, see “Changing the 
Advanced Settings” on page 997.

& When you finish editing the symbol, click OK to return to the Symbol 
Manager.

The edited symbol appears in the Symbol Manager and can be inserted in a 
drawing with the new settings.

Adding a Path Key

You can add a path key, which sets the key, location, and description for the 
location of the symbol drawing files. 
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� From the Utilities menu, choose Symbol Manager.
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The Symbol Manager is displayed.

� From the palette, select a symbol and click Edit.

The Edit Symbol dialog box is displayed.

� Click Add Key to display the Add Path dialog box.

� In the Key text box, type the name of the key. This references the information 
in the Value and Description text boxes.

� In the Value text box, type the path for the key.

� In the Description text box, type a description of the key.

$ Click OK to add the new key. 

Moving a Symbol

You can move a symbol from one palette to another.
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� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� From the Palette menu, select the symbol palette that you want to use. 

� From the Category menu, select the symbol category that you want to use.

� From the Symbol Set menu, select the symbol set that you want to use.

� From the symbol palette, click the symbol that you want to move. 

� Click Move. 

The Move Symbol dialog box is displayed.

$ Under Category, select a destination category, or type a new category in the 
New box.

% Under Palette, select a destination palette, or type a new palette in the New 
box.

& Select Display destination palette to display the symbol in the new palette 
after you move it. 

�' Click OK to move the symbol to the new palette.

The symbol that you selected is moved to the new palette and will display in 
that palette in the Symbol Manager.

Copying a Symbol
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� From the Utilities menu, choose Symbol Manager.
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The Symbol Manager dialog box is displayed.

� From the Palette menu, select the symbol palette that you want to use. 

� From the Category menu, select the symbol category that you want to use.

� From the Symbol Set menu, select the symbol set that you want to use.

� From the symbol palette, select the symbol that you want to copy. 

� Click Copy.

The Copy Symbol dialog box is displayed.

$ If you want to rename the symbol, then type a new symbol name in the 
Symbol text box.

% Under Category, select the category that you want to copy the symbol to, or 
type a new category in the New box.

& Under Palette, select the palette that you want to copy the symbol to, or type 
a new palette in the New box.

�' Select Display destination palette to display the symbol in the new palette 
after you copy it. 

�� Click OK to copy the symbol to the new palette.

The symbol that you selected is copied to the new palette and will display in 
that palette in the Symbol Manager.

Deleting a Symbol, Category, and Palette
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� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� From the Symbol Set menu, select the symbol set of the symbol that you 
want to delete.

� From the Category menu, select the symbol category of the symbol that you 
want to delete.

� From the Palette menu, select the symbol palette of the symbol that you want 
to delete.

� From the symbol palette, select the symbol that you want to delete. 

� Click Delete.

The Delete dialog box is displayed.

$ Under Select Type, select one of the following:

� Category: To delete the symbol category.
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NOTE There must be more than one category in the symbol set to delete 
a category.

� Palette: To delete the whole symbol palette.

NOTE If there is only one palette in the category, you can only select the 
category to be deleted.

� Symbol: To delete the individual symbol. 

NOTE If there is only one symbol in the palette, you can only select the 
palette or category to be deleted.

% Click OK.

The category, palette, or symbol is deleted from the drawing.

Changing the Advanced Settings

You can change the description that is displayed when a symbol is selected, 
the attribute settings, the insertion options, the insertion options for a sym-
bol block, and any AutoLISP functions you want to run before or after the 
symbol is inserted in the drawing.

Setting the Description for a Symbol
You can add a description to any symbol. The description displays in the 
lower left corner of the Symbol Manager.
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� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� Click Add.

The Add Symbol dialog box is displayed.

� Click Advanced.

The Advanced dialog box is displayed.

� To change or enter a new symbol description that will display at the bottom 
of the Symbol Manager dialog box when you select a symbol, type the 
description in the Extended Description text box.

� Click OK.
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Setting the Attribute Settings for Symbols

�����	������	���������������������
�����

� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� Click Add.

The Add Symbol dialog box is displayed.

� Click Advanced.

The Advanced dialog box is displayed.

� Under Attributes, select one of the following:

� Allow Attribute Edit: To prompt for attribute data after a symbol is 
inserted. This option allows you to edit symbol attributes (if the symbol 
includes attributes) after you insert a symbol. 

� Fix Attribute Angle: To adjust the angle of symbol attributes.
� Fix Attribute Size: To adjust the attribute heights automatically to the 

current text style settings.

� Click OK.

Setting the Insertion Options for Symbols
You can control the symbol insertion command by setting whether the sym-
bol is inserted once, multiple times, or whether you can change the base 
point, rotation, and location of the symbol before final placement.
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� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� Click Add.

The Add Symbol dialog box is displayed.

� Click Advanced.

The Advanced dialog box is displayed.

� Under Insertion Options, select one of the following to control symbol inser-
tion: 

� Single: Inserts the symbol once and then ends the insertion option.
� Repeat: Repeats the symbol insertion procedure until you cancel it.
� Enhanced: Dynamically provides the ability to reset the block base point, 

rotation, and position of the symbol, and to update attribute positions of 
the symbol, before final placement.
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� Click OK.

Setting the Block Style for Symbols
You can set how the symbol block is inserted in the drawing, as an AutoCAD 
block, as an exploded AutoCAD block, or as an AutoCAD external reference.
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� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� Click Add.

The Add Symbol dialog box is displayed.

� Click Advanced.

The Advanced dialog box is displayed.

� Under Block Style, select one of the following options to control how a sym-
bol block is inserted in the drawing:

� Insert: Inserts the symbol as an AutoCAD block.
� Explode: Inserts the symbol as an exploded AutoCAD block.
� Xref: Inserts the symbol as an AutoCAD external reference (Xref).

� Click OK.

Setting AutoLISP Functions for Symbols
You can set AutoLISP functions to run before and after the placement of a 
symbol.
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� From the Utilities menu, choose Symbol Manager.

The Symbol Manager dialog box is displayed.

� Click Add.

The Add Symbol dialog box is displayed.

� Click Advanced.

The Advanced dialog box is displayed.

� Under AutoLISP Functions, do the following:

� In the Pre-Insertion box, type an AutoLISP expression to run before sym-
bol insertion.
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NOTE If the block name entry is blank, a block is not inserted, but the 
functions are executed.

� In the Post-Insertion box, type an AutoLISP expression to run after symbol 
insertion.

NOTE AutoLISP is a programming language you can use to customize 
features of symbols within AutoCAD Land Development Desktop's Symbol 
Manager. The expressions you enter in these text boxes can change the 
parameters for the symbol insertion. For example, the expression (setvar 
"osmode" 1) sets the object snap to Endpoint for the symbol insertion when 
you enter it in the Pre-Insertion edit box. Also, you must encapsulate multiple 
expressions in an AutoLISP program function. For example, the following 
AutoLISP expression draws a line on the current layer: (progn (princ 
"\nPoints:")(command "_.line" pause pause)).

� Click OK.

NOTE See the AutoLISP Reference online Help for more information about 
AutoLISP expressions.

Creating and Managing Symbol Sets

Symbol sets are collections of predefined symbols. The symbols in a symbol 
set and the insertion settings for those symbols are saved in a database file 
with a .dbf file extension. This database file contains information such as the 
layer, scale, and block name for each symbol. You can create duplicate data-
base entries for the same symbol, each with a different scale or layer setting. 
You can view a slide of each symbol in the Symbol Manager. 

Within each symbol set, symbols are organized by categories and the catego-
ries are further organized by palettes. For example, a Landscape symbol set 
might include separate categories for site, plants, and people symbols. 
Within the plants category there might be separate palettes for 3D trees and 
conceptual plants.

See “Symbol Management” on page 984 to view an illustration of the struc-
ture of a symbol set.

You can use the Symbol Manager to create your own symbol sets for your 
own symbols. You can create symbol set databases for different projects or cli-
ents. Add symbols to symbol sets one at a time or import entire directories of 
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symbols to the Symbol Manager. You can also create your own custom sym-
bol palettes without having to create new symbol sets. You can copy symbols 
into new palettes, deleting any that you do not need.

NOTE The Symbol Manager uses two different types of keys to specify the 
location of symbol files: folder keys and file keys. Folder keys refer to a folder only, 
while the file keys refer to a specific file in a specific folder. File keys specify the 
database files that define symbol sets.

Creating a New Symbol Set
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� From the Utilities menu, choose Symbol Manager.

� In the Symbol Manager dialog box, click Manage.

The Symbol Data Management dialog box is displayed.

� Under Symbol Set, select a symbol set from the Existing menu. 

The Key and Description adjust automatically. The key specifies the name 
and location of the symbol set and is defined in the sdsk.dfm file. 

NOTE If you want to change the name of the symbol set, type a name, up to 
31 characters long, in the Key text box.

� Click File.

The Select Symbol Data File dialog box is displayed.

� Type the filename and path of the database (.dbf ) file. 

� Click Save.

NOTE The symbol manager creates this file when you add symbols to the new 
symbol set. Both the filename and path report to the sdsk.dfm file. The full path 
and filename displays under Expanded file.

$ To add symbols to the new symbol set, select Import Symbols and specify the 
symbols that you want to add under. For more information see, “Importing 
Symbols into a Symbol Set” on page 1002.

% Click OK to create the new symbol set.
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Using the Symbol Data Management Dialog Box
Use this dialog box to create a new symbol set and to add symbols into a sym-
bol set. 
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� Under Symbol Set, select a symbol set from the Existing menu. 

The Key and Description adjust automatically. The key specifies the name 
and location of the symbol set and is defined in the sdsk.dfm file. 

NOTE If you want to change the name of the symbol set, type a name, up to 
31 characters long, in the Key text box.

� Click File.

The Select Symbol Data File dialog box is displayed.

� Type the filename and path of the database (.dbf) file. 

� Click Save.

NOTE The symbol manager creates this file when you add symbols to the new 
symbol set. Both the filename and path report to the sdsk.dfm file. The full path 
and filename displays under Expanded file.

� To add symbols to the new symbol set, select Import Symbols and specify the 
symbols that you want to add under. For more information see, “Importing 
Symbols into a Symbol Set” on page 1002. 

Importing Symbols into a Symbol Set
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� Create symbol blocks and store them in the source path for the symbol set. 
For more information, see “Creating a New Symbol Set” on page 1001.

� From the Utilities menu, choose Symbol Manager.

� In the Symbol Manager, click the symbol set from the Symbol Set menu to 
which you want to add symbols.

� Click Manage.

The Symbol Data Management dialog box is displayed. 

� Select the Import Symbols check box. The right side of the dialog box 
becomes active.
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� Under Import Symbols, specify the symbols that you want to add. For more 
information, see “Adding Symbols to a Palette” on page 986.

$ Under Source Path, select the path for the symbol drawings.

NOTE If the symbols you want to add are in a folder not referenced by a path 
key, click Add Key to add a new key for the folder. The key is a short way to rep-
resent the path where the symbols are found. For more information, see “Add-
ing a Path Key” on page 994.

% In the Pattern text box, type the file extension of the symbol block files. You 
can specify a particular file name, or you can use an * (asterisk) to select all 
the files of the same extension.

& Select the Enter Symbol Descriptions check box if you want to enter symbol 
descriptions as the program adds symbols to the symbol set. You can also 
enter descriptions later by using the Edit option on the Symbol Manager dia-
log box.

�' Click Set Symbol Default Values to set the default symbol insertion values. 
For more information, see “Editing a Symbol Set” on page 1004.

�� Click Set Category and Palette to specify the category and palette the new 
symbols are added to. For more information, see “Moving Symbols Between 
Palettes” on page 992.

While you batch-load symbols, use values that are correct for the majority of 
the added symbols, because all imported symbols will initially have the same 
category and palette. You can use the Edit and Move options in the Symbol 
Manager dialog box to refine the organization and settings later.

�� Select the Create Slides check box if you want the program to create slides for 
symbol drawings as they are added to a symbol set, and then select one of the 
following:

� All: To create slides for all of the files.
� New Only: To create slides for only the new files.

NOTE For information about creating slides, see “Making a Slide” on page 
1004.

� Select the Create Slide Library check box if you want to create a slide 
library for the symbol slides, and then select the filename and path for the 
slide library by doing the following:

� Type the filename and path in the edit box.
� Click File and locate the path.
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�� Click OK to import the symbols to the symbol set.

Editing a Symbol Set
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� From the Utilities menu, choose Symbol Manager.

� In the Symbol Manager, click Manage.

The Symbol Data Management dialog box is displayed. 

� In the Existing menu, select the symbol set you want to edit.

� In the Key box, type a key that is up to 31 characters long for the symbol set.

The key specifies the name and location of the symbol set and is defined in 
the sdsk.dfm file in the following folder:

c:\Program Files\Land Desktop R2

� In the Description box, type a new description for the symbol set.

� In the File box, type the filename and path of the database (.dbf) file.

The Symbol Manager creates this file when you add symbols to the new sym-
bol set. Both the filename and path report to the sdsk.dfm file.

NOTE The full path and filename displays under Expanded file.

$ To add symbols to the symbol set, select  and specify the symbols that you 
want to add under Import Symbols. For more information, see “Importing 
Symbols into a Symbol Set” on page 1002.

% Click OK to save your changes.

The changes you made to the symbol set are saved.

Making a Slide
You can save a snapshot of a drawing by making a slide. You can make a slide 
of a symbol to use in the Symbol Manager, to reference one drawing while 
working on another drawing, or to exchange images with other graphics and 
desktop publishing systems.

Slides only show what is visible, and you cannot import, edit, or print a slide. 
You can only view it. When you view a slide, it temporarily replaces objects 
on the screen. You can draw on top of it, but when you change the view (by 
redrawing, panning, or zooming), the slide file disappears, and AutoCAD 
Land Development Desktop redisplays only what you drew and any preexist-
ing objects.
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NOTE Slides do not support solid fills. If you shade the image before creating 
the slide the slide will be created with filled areas. 
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� Display the view you want to use for the slide. If you want to make a slide of 
a symbol, zoom in so the symbol fills the screen.

� Type MSLIDE at the command prompt and press ENTER.

The Create Slide File dialog box is displayed.

� Type the slide File Name. This file will be saved with an *.sld extension.

� Click OK to make the slide.

Changing the Import Symbols Settings
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� From the Utilities menu, choose Symbol Manager.

� In the Symbol Manager, click Manage.

The Symbol Data Management dialog box is displayed.

� Select the Import Symbols check box.

� Under Source Path, from the pull-down menu, select the path key where the 
symbol drawings are located.

� If the symbol drawings are in a folder that is not referenced by a path key, 
then click Add Key to to the folder. For more information, see “Adding a Path 
Key” on page 994.

� In the Pattern text box, type the filename pattern to select symbol block files 
from the source path. You can specify a particular filename, or you can use 
wildcard characters to select multiple files, for example, "tree*" to select all 
the files that start with "tree".

$ If you want to enter symbol descriptions as you add symbols to the symbol 
set, select the Enter Symbol Descriptions check box.

% You can add symbol descriptions later by using the  function in the Symbol 
Manager. For more information, see “Editing a Symbol Set” on page 1004.

& To edit the default insertion values for the symbols, click Set Symbol Default 
Values.

You can edit these values later with the  function in the Symbol Manager. For 
more information, see “Editing a Symbol Set” on page 1004.

�' To specify a symbol category and palette for the new symbols, click Set Cat-
egory and Palette. 
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NOTE When batch-loading symbols, use values that are correct for the major-
ity of the symbols, as all symbols will initially have the same category and palette. 
You can use the  and  in the Symbol Manager to refine the organization and set-
tings later. For more information, see “Editing a Symbol” on page 993 and 
“Moving a Symbol” on page 995.

�� If you want to create slides for symbol drawings that do not already have cor-
responding slide files, then select the Create Slide check box.

NOTE For information about creating slides, see “Making a Slide” on page 
1004.

�� Select one of the following corresponding options to control how slides will 
be created:

� All: Creates slides for all symbol drawings that will be added to the sym-
bol set and replaces existing slides.

� New Only: Creates slide for only the symbol drawings that do not already 
have corresponding slide files. The slide files must be in the same folder as 
the symbol drawings, and they must have the same root filenames as the 
symbol drawings.

�� If you want to create a slide library for the symbol slides, then select  the Cre-
ate Slide Library check box.

�� Type a filename and path for the slide library in the edit box, or click File to 
browse for a filename and path.

NOTE This option is available only when the Create Slide option is selected.

�� Click OK.

Setting the Text Style

The Text Style dialog box controls the settings for text styles used in 
AutoCAD Land Development Desktop. These settings specify the text styles 
that are used for text objects created in the program.

����������!����
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� From the Utilities menu, choose Set Text Style.
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The Text Style dialog box is displayed.

� Select the text style that you want to use. 

TIP For information about creating text styles, see “Creating and Modifying 
Text Styles” in the AutoCAD User’s Guide. 

� Click OK.

Working with Curve Text

Using the Curve Text commands on the Utilities menu, you can draw, edit, 
or move curve text on any AutoCAD curve or circle object in your drawing. 
The curved text is referred to as CText. CText is a custom Autodesk object that 
simplifies the process of drawing and editing text on a curve.

Drawing Text on a Curve

You can draw text on any AutoCAD curve or circle using the Draw Curve Text 
command. This curved text is referred to as CText. CText is a custom 
Autodesk object that simplifies the process of drawing and editing text on a 
curve. 

������	�
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� From the Utilities menu, choose Curve Text ➤ Draw Curve Text.

� Select the curve or circle that you want to label.

� Press ENTER. 

The Curve Text Editor dialog box is displayed.

� In the Text Above box, type the text that you want above the curve.

� In the Text Below box, type the text that you want below the curve.

� Select a text style. If you select a zero-height style, then also specify a text 
height. 

NOTE For CText, you can also specify a new text height for a fixed-height text 
style.

� Specify an Offset. The offset value is not a distance; it is a factor. This factor 
is multiplied by the text height to compute the offset distance for the label. 
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An offset value of 0 will place the label on the curve. This value must be a 
positive number. 

% Click OK to draw the text on the curve.

& Modify the position of the label using grips, if necessary.

NOTE The text that is drawn using the Draw Curve Text command is a custom 
Autodesk object, not an AutoCAD text entity. Therefore, you can only edit the 
text using the  command. However, you can use the AutoCAD explode com-
mand to explode the CText into individual AutoCAD objects that you can edit. 
For more information, see “Editing Text on a Curve” on page 1008.

Editing Text on a Curve

CText makes it easy to draw and edit text on a curve. Because CText is a cus-
tom Autodesk object, you need to use Autodesk commands to edit it. 

AutoCAD Land Development Desktop uses CText for its curve labels when 
the Align text on object option is selected. Therefore, you can also use the 
editing commands described below to edit curve labels that you created 
using the Label command. For more information, see “Changing the Proper-
ties of Labels” on page 571.
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� Label a curve with Ctext. For more information, see “Drawing Text on a 
Curve” on page 1007.

� Click on the Autodesk CText. Be sure to select the text, not the curve or circle.

� Do one of the following:

� From the Utilities menu, choose Curve Text ➤ Edit Curve Text to display 
the Ctext Editor dialog box.

� Right-click to display the shortcut menu and select CAD Properties to dis-
play the Curve Text Editor dialog box.

� Edit the Text Above and the Text Below.

� Edit the Text Properties, if necessary.

� Click OK to update the CText.

Moving Text From One Curve to Another

You can move the CText from one curve to another. For more information, 
see “Drawing Text on a Curve” on page 1007.



Using Leaders | 1009

���	��	�������!�����	����"����	������������"���������

� Click on the Autodesk CText. Be sure to select the text, not the curve or circle.

NOTE This step requires that the AutoCAD pickfirst variable is set to <1>.

� Do one of the following:

� From the Utilities menu, choose Curve Text ➤ Move Curve Text.
� Right-click to display the shortcut menu and select Attach To Curve.

� Select the curve or circle that you want to move the CText to.

� Press ENTER to move the CText to the new curve. 

NOTE You can reposition the text on a curve using AutoCAD grips.

Using Leaders

Using the Leaders commands on the Utilities menu, you can insert a variety 
of leaders into your drawing, as well as change the annotation settings. The 
Leaders commands enable you to insert leaders with text, a symbol, or with 
variable pointers.

Inserting a Leader with Text

You can insert a text leader with a point at one end by using the Text Leader 
command. The leader type, pointer type, terminator, and text justification 
are set in the Leader Settings dialog box. If you draw the leader from right to 
left, then the text can be either right-justified or left-justified. 

The Text Leader command also supports keynoting, taking keywords entered 
at the command prompt and expanding them, based on a lookup in a key-
notes.dbf file to make the note.
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� From the Utilities menu, choose Leaders ➤ Text Leader.

The following prompt is displayed.

7��	���	���

� Select the points in your drawing where you want to position the leader. 



1010 | Chapter 38 Utilities

� Press ENTER.

NOTE The text “0.0000000” is echoed at the command line. This indicates 
that the rotation of the text is zero.

� At the command prompt, type the text that you want to appear on the leader. 

� Press ENTER.

NOTE Multiple keywords can be entered for the text leader. Single words or 
numbers can be expanded up to six lines of 50 characters.

Inserting a Leader and Symbol

You can insert a leader that has a pointer at one end and a symbol at the other 
end using the Symbol Leader command. The symbol can contain identifica-
tion text. The leader type, pointer type, and symbol are specified at the 
Leader Settings dialog box.
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� From the Utilities menu, choose Leaders ➤ Symbol Leader.

The following prompt is displayed.
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� Select the points in your drawing where you want to position the leader and 
symbol.

� Press ENTER.

� At the command prompt, type the ID and press ENTER.

� Type the description of the symbol and press ENTER. 

� Click OK.

Only the ID attribute is visible in the drawing.

Inserting Leaders With Variable Pointers

The Predefined Leaders command displays the Leaders dialog box. This icon 
menu provides commands that insert straight or curved leaders with arrows, 
dots, tildes, tilde and arrow, tick marks, loops, bars, or tails at one end and 
text at the other end. Commands are also provided to insert straight or 
curved leaders with hexagons, circles, squares, or diamonds at one end.
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� From the Utilities menu, choose Leaders ➤ Predefined Leaders.

The Leaders dialog box is displayed.

� Click the leader you want from the list box. 

� Click OK.

NOTE The Next button displays additional symbols, including hexagon, cir-
cle, square, and diamond, which can also be inserted with straight or curved 
leaders.

� Select the starting point in your drawing.

� Press ENTER.

The following prompt is displayed.
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� Select the endpoint of the curve. 

$ Press ENTER.

% Type the text you want added at the end of the leader. 

& Press ENTER.

NOTE Multiple keywords can be entered for the text leader. Single words or 
numbers can be expanded up to six lines of 50 characters.

Changing the Leader Settings

You can temporarily override the default leader settings by using the Over-
ride Settings command. The settings specified through the Override Settings 
command are used for the current drawing session only.
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� Do one of the following to display the Leader Settings dialog box:

� From the Utilities menu, choose Leaders ➤ Leader Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Leader Utilities and click the Edit Settings button.
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� Set the Annotation Plot Size. This specifies the size in plotted units of almost 
all annotation symbols. The value is used to size components of parametri-
cally generated items (like leaders or break marks). It also controls the text 
height for all tag symbols with attributes.

� Under Leaders, do the following:

� Type: Select the type of text you want. You can choose either Straight or 
Arc.

� Pointer: Select the type of pointer you want. You can choose either 
Arrow, Dot, Tick, Tilde, Tilde/Arrow, Loop, Bar, or None.

� Terminator: Select how you want the text to appear. You can choose 
either Bar, Tail, or None.

� Symbol: Select the type of symbol leader you want. You can choose either 
Circle, Square, Hex, or Diamond.

� If you want the text to be left-justified, select All Text Left Justified. Clear this 
check box if you want the text to be right-justified.

� Click OK.

Resetting Leader Settings to Project Defaults

The Reset Settings command changes the leader type, pointer type, text style, 
and symbol settings for annotations to reflect the current project's values for 
these settings. Use this command to reset leader settings if they have been 
modified by the Override Settings command.

�������	����	�������������������������	����

� Do one of the following to display the Leader Settings dialog box:

� From the Utilities menu, choose Leaders ➤ Leader Settings.
� From the Projects menu, choose Drawing Settings to display the Edit Set-

tings dialog box. Under Program, select Land Development Desktop. From 
the Settings list, select Leader Utilities and click the Edit Settings button.

� Under Leaders, do the following:

� Type: Select the type of text you want. You can choose either Straight or 
Arc.

� Pointer: Select the type of pointer you want. You can choose either 
Arrow, Dot, Tick, Tilde, Tilde/Arrow, Loop, Bar, or None.

� Terminator: Select how you want the text to appear. You can choose 
either Bar, Tail, or None.

� Symbol: Select the type of symbol leader you want. You can choose either 
Circle, Square, Hex, or Diamond.
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� Click OK.

AutoCAD Land Development Desktop changes the annotations to reflect the 
current project values for these settings.

Blocks

With the Block commands, you can create, edit, move, count, label, and 
chart the blocks in your drawings. You can create a block by specifying an 
insertion point for the new block and then selecting objects in your drawing 
to include in the block. Once you have a block in your drawing, you can edit 
the block by inserting an exploded copy of the block in your drawing and 
editing the copy. When you finish editing the copy of the block, you can use 
the copy to redefine the original block.

You can also replace a block in your drawing with another block in your 
drawing, swap the position and angle of two blocks, change the x, y, or z scale 
of a block, update the attributes of a block, count the occurrences of all 
blocks in a drawing, label all the blocks in a drawing, and create a chart of all 
the blocks in a drawing.

Replacing Blocks

You can replace a block in the drawing with another block in the drawing.
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� From the Utilities menu, choose Blocks ➤ Replace Blocks.

� Select a block to hold and use to replace other blocks.

� Select the block or blocks you want to replace.

Each block you select is replaced by the first block at the insertion point, 
scale, and rotation angle of the original block.

� Continue replacing blocks, or press ENTER twice to end the command.

Updating the Attributes of a Block

You can update all of the attributes of a block, including the angle, size, and 
text style of the attributes. All changes apply equally to all visible attributes 
within a block.
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� From the Utilities menu, choose Blocks ➤ Fix Attributes.
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� Select all of the blocks with attributes that you want to change.

WARNING! Do not use this command if you want each attribute to have 
unique settings. All changes are applied to all attributes within the blocks that 
you select.

� Do one of the following to select an angle for the block attributes:

� Select a new rotation angle for the block attributes, or press ENTER for zero 
(0) rotation.

� Type R to use right-reading to orient the attributes so they will always be 
read from the right independent of the orientation of the block.

� Specify a new text height for all of the attributes. You can press ENTER to 
retain the original text height.
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� Do one of the following to specify a style name:

� Type a style name.
� Select the style name from the screen menu.
� Select an object from the screen with the text style that you want to use.

NOTE If needed, the TRACKING (LINK) mode can be set to aid in the selection 
of an object. 

The block that you selected is updated to reflect the changes that you made 
to the attributes.

Counting the Occurrences of All Blocks

You can count all the occurrences of all the blocks in the current drawing.

���������	�������������������	�������#�

� From the Utilities menu, choose Blocks ➤ Count Blocks.

The block information in the drawing is compiled and a list of block infor-
mation displays in the AutoCAD Text Window. This information includes a 
list of all of the block names in the drawing, the number of times each block 
is inserted in the drawing, and the total number of blocks in the drawing. To 
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make a chart of all the blocks in a drawing, use the Make Block Chart com-
mand.

Labeling Blocks

You can label blocks in the current drawing with either the block name or the 
insertion point coordinates. 

Labeling Blocks By Name
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� From the Utilities menu, choose Blocks ➤ Label Blocks.

� Select an object in each block that you want to label. 

The labeling options prompt is displayed.
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� Type Name to label the block or blocks by name, with a leader that begins at 
the insertion point of the block.

� Type the distance to offset the text from the insertion point.

The block is labeled with a leader beginning at the insertion point of the 
block and the name of the block.

Labeling Blocks By Insertion Point
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� From the Utilities menu, choose Blocks ➤ Label Blocks.

� Select an object in each block that you want to label. 

� The labeling options prompt is displayed.
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� Press ENTER to label the block or blocks by point, with a leader that begins at 
the insertion point of the block, and the coordinates of that point relative to 
a selected origin point.

� Specify an insertion point. 

NOTE This origin point returns the x and y coordinates in world coordinates. 
This is the point from which the coordinates of the block insertion point are cal-
culated. If you want to label the block in relation to the current UCS coordinates, 
then specify an origin point accordingly. 
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� Do one of the following to choose a labeling method for your blocks:

� Type No to label the blocks with 2D coordinates (x, y).
� Press ENTER to label the blocks with 3D coordinates (x, y, z).

$ Specify the distance that you want to offset the text from the insertion point.

The block is labeled with a leader beginning at the insertion point of the 
block and the coordinates of that point relative to the origin point that you 
specified.

Making a Chart of All the Blocks in a Symbol 
Library

You can make a chart of all the blocks in a drawing folder.
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� From the Utilities menu, choose Blocks ➤ Make Block Chart.

� Type the name or names of the drawing files to include in the block chart. 
Do not include the .dwg suffix with the drawing file names.

NOTE You can use wildcard symbols such as the question mark (?) or asterisk 
(*) to search a range of drawing files. 

� Specify an insertion point for the block chart. This point corresponds to the 
upper-left corner of the block chart.

� Enter the number of rows you want to place across the block chart. The 
default value for this prompt is calculated from the number of blocks in the 
symbol library. 

The number of columns in the chart is calculated directly from the number 
of blocks and the number of rows entered. The user does not enter the num-
ber of columns.

� Enter the distance between rows. This is the distance in plotted units 
between the lines delineating the edges of the boxes which determines the 
width of each cell of the block chart. 

After you enter the distance between rows, the following prompt is dis-
played.
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� Do one of the following to specify the distance between columns (height of 
the cells):
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� Type a value for the distance between columns
� Press ENTER to use the default distance.
� Type Aspect and specify a value based on the aspect ratio of the monitor 

being used.

The default value for the distance between columns is calculated to keep the 
cells of the block chart square. 

$ Do one of the following to insert the symbols in the chart cells:

� Press ENTER to scale the symbols to automatically fit within the chart cells.
� Type No to specify the scales and insertion points of the symbols when 

inserting them in the block chart.

% Do one of the following:

� Type Yes to explode symbols so the representation in the block chart 
includes attribute tags and other objects that make up the block.

� Press ENTER to not explode the symbols.

& Do one of the following:

� Type Yes to insert a tick mark in the block chart cell showing where the 
insertion point of the block is located. 

� Press ENTER to not insert a tick mark.

�' Do one of the following:

� Type Yes to insert block names based on the drawing file name stored in 
the symbol library in each cell of the block chart.

� Press ENTER to not insert block names.

If you typed Y to insert block names, then an AutoCAD view is created for 
each cell of the block. Each view is given the same name as the block name. 
To use any of these views once the Make Block Chart command has finished, 
use the VIEW command with the Restore option. The graphics screen will 
zoom up on the cell corresponding to the block name chosen. Once all of 
these prompts have been responded to, the command begins to create the 
block chart. As the blocks are inserted, you will be prompted for any attribute 
values.

�� If you typed No in response to the "Fit symbols within area" prompt, then 
you are prompted to specify an X scale factor and an insertion point for each 
block. Type a scale factor and select the insertion point for each block.
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NOTE The Make Block Chart command only prompts for a X scale factor. The 
Y and Z scale factors used are the same as the X scale factor. To make the block 
chart, the command uses the layers, linetypes, and text styles specified by the 
current project settings.

The block chart is created with the layers, linetypes, and text styles specified 
by the current project settings. The block chart is based on the drawing folder 
information at the time that you created the chart, and will not be updated 
automatically. If changes are made to the drawing folder, then erase the block 
chart and create a new one with the Make Block Chart command.

Inserting a Block at the Current Drawing Scale

You can use the Insert At Drawing Scale command to insert a block and scale 
the block to the current drawing scale. 
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� From the Utilities menu, choose Blocks ➤ Insert At Drawing Scale to display 
the Block name dialog box.

� In the Block name dialog box, do one of the following: 

� Select a previously inserted block from the list.
� Type the name of the block into the Enter Item box.

� Click OK. You are prompted to select an insertion point for the block in your 
drawing.

� Enter the rotation angle for the block.

� Click OK to insert another block or press ESC to end the command.

Creating and Maintaining Schedule 
Templates and Legends

Using the List/Legends command on the Utilities menu, you can create a 
schedule template file (.txt) and attribute report specification file (.ars), as 
well as create and maintain an external database file that contains the names 
and descriptions of all symbols added to the drawing.
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Creating a Schedule Template

You can create a schedule template file (.txt) and attribute report specifica-
tion (.ars) file by using the Make Template command. The template file spec-
ifies which block attributes are extracted and how they are reported when 
you create a schedule.
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� From the Utilities menu, choose List/Legends ➤ Make Template.

� Select a block with attributes from the current drawing. 

� In the Template file name dialog box, type a name for a new template file, or 
select an existing template file to update, and click Save.

� In the Attribute Report Specification dialog box, specify the block attribute 
tags that you want to report in the schedule. For more information, see “Add-
ing Tags” on page 1022.

� Do one of the following:

� Click OK to save the new template file. 
� Click Cancel to return to the drawing without saving the new schedule 

template.

� Do one of the following:

� Edit the template.
� Extract attributes - then BOM.

$ The Make Template command generates the schedule template file (*.txt) 
and the attribute report specification file (*.ars) to specify which block 
attributes to extract from the drawing and how to report them. 

Editing a Schedule Template

The Edit Template command provides an interface for editing existing sched-
ule templates. 
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� From the Utilities menu, choose List/Legends ➤ Edit Template.

The Template file name dialog box is displayed.

� Select the template file you want to edit. You can click Locate and Find File 
to browse for the schedule file you want to use.

� Click Open.
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The Attribute Report Specification dialog box is displayed.

� Make the desired changes to the Template File. For more information, see 
“Creating a Schedule Template” on page 1019.

� Do one of the following:

� Click OK to save the template file with the change that you made.
� Click Cancel to return to the drawing without saving the changes.

Extracting Attribute Data From Blocks

The Extract Attributes command uses an existing schedule template to 
extract selected attribute information from blocks in the current drawing. 
You must create a template with the Make Template command before using 
this command.
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� From the Utilities menu, choose List/Legends ➤ Extract Attributes. 

The Attribute Extraction dialog box is displayed.

� Select one of the following options for the file format:

� Comma Delimited File (CDF): Exports attribute information to a file 
where commas separate the data fields in the file.

� Space Delimited File (SDF): Exports attribute information to a file where 
spaces separate the data fields in the file.

� Drawing Interchange File (DXF): Exports attribute information to a file 
in the AutoCAD .dxf format.

� Click Select Objects to select the objects in your drawing from which you 
want to extract attributes.

� In the Template File text box, type the name and path of the template file. 
You can click Template File to search for the file.

� In the Output File text box, type the name of the output file. You can click 
Output File to search for a file.

� Click OK.

The attribute information that you extract with this command will be saved 
in this file.



Creating and Maintaining Schedule Templates and Legends | 1021

Importing Block Attribute Data

You can use the Import/Update Attributes command to update block 
attributes by importing information from an attributes data file. Use the 
Extract Attributes command to create the attribute data file.
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� From the Utilities menu, choose List/Legends ➤ Import/Update Attributes.

� Select the block you want to update. For more information, see “Changing 
the Attribute Report Specification” on page 1021.

The Choose Key Tag dialog box is displayed.

� Click the attribute tag you want to update. For more information, see 
“Updating the Attributes of a Block” on page 1013. 

� Click OK.

� Select the template file that you made with the Make Template command. 
For more information, see “Creating a Schedule Template” on page 1019.

� Click OK.

$ Select the attribute data file (.ars), containing the attribute values you want 
to import into the drawing.

% Do one of the following:

� Type Yes to update the attributes in the drawing. 
� Press ENTER to not update the attributes.

Changing the Attribute Report Specification

��������������#�	���������	�	

� From the Utilities menu, choose List/Legends ➤ Import/Update Attributes.

� Select the block you want to update.

The Choose Key Tag dialog box is displayed.

� Click the attribute tag that you want to update. 

� Click OK.

� Select the template file that you made with the Make Template command.

� Click OK.

$ Select the attribute data file (.ars), containing the attribute values you want 
to import into the drawing.

% Do one of the following:

� Type Yes to update the attributes in the drawing. 
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� Press ENTER to not update the attributes.
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� In the Report Titles list, select Arrange title order.

� Click the tag that you want to move and the position where you want to 
place the tag.

� To change the name of an attribute tag, click the tag that you want to change 
in the Report Titles list. The name of the tag will display in the Title text box 
where you can edit it.

� To specify whether the tag contains character or numeric data, click the tag 
in the Report Titles list and select the Character data or Numeric data option.

� In the Width box, type the width in characters of the column for the current 
tag.

� If you specified a numeric tag in step 3, then type the decimal precision of 
the numeric attribute data in the Precision box.

$ If you want to add tags, click . For more information, see “Adding Tags” on 
page 1022.

% To , click the tag in the Tags list, and then click Remove. For more informa-
tion, see “Removing Tags” on page 1022.

Adding Tags
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� In the Attribute Report Specification dialog box, click Add Tag. This option 
allows you to add new attributes to the template.

The Add Attributes dialog box is displayed. 

� In the Blocks in Drawing list, click the block with attributes that you want to 
view. The Tags list displays the attribute tags in the block.

� In the Tags list, click the attribute tag you want to add to the template. 

� Click OK.

Removing Tags
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� In the Attribute Report Specification dialog box under Report Titles, select 
the tag you want to remove.

� Click Remove.
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Creating an Abbreviation List

You can use the Abbreviations command to construct an abbreviations list 
based on the abbreviations actually used in one or more drawings. 
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� From the Utilities menu, choose List/Legends ➤ Abbreviations. 

The command searches for abbreviations in your drawing and the following 
prompt is displayed.
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� Do one of the following:

� Specify the  that you want to use to create your abbreviation list. 

The default abbreviations dictionary, abbrev.txt, is located in the follow-
ing folder:

c:\Program Files\Land Desktop R2\land\lng 

You can modify or recreate this file by using any text editing program that 
outputs in pure ASCII code. The spacing between the item and description 
is not critical, but it reflects what is actually seen in the drawing. The 
description must start after at least ten characters. It is recommended that 
short abbreviations that are also words, such as A, IN, IS, and AS, have a 
period after them in the definitions file and whenever they are used as 
abbreviations. This prevents confusion between abbreviations and stan-
dard words. 

� Press ENTER to use the default dictionary, abbrev.txt.

After you specify the dictionary that you want to use, the following prompt 
is displayed.

@�������	�
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� Do one of the following to select an output option for your abbreviation list:

� Press ENTER to plot your abbreviation list.
� Type File to send your abbreviation list to a file 
� Type Printer to send the abbreviation list to a printer 

AutoCAD Land Development Desktop searches all text in your drawing to 
find abbreviations, regardless of whether they appear as separate items or are 
inside a sentence with or without a trailing period. The abbreviations are 
then searched in a dictionary and the meaning is placed on your drawing, 
sent to a file, or printed. 
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Creating a Symbol Legend

Use the Make Legend command to create and maintain an external database 
file that contains the names and descriptions of all symbols added to your 
drawing. These names and descriptions are placed in a symbol legend that is 
imported in the current drawing.
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� From the Utilities menu, choose List/Legends ➤ Make Legend. 

The Legend database file name dialog box is displayed.

� Select or type a filename, and click Save.

� Do one of the following:

� Select the blocks in the drawing you want to use to create the legend. 
� Press ENTER to use all the blocks in the drawing.

NOTE Type any AutoCAD wild-card symbols at the prompt to specify a range 
of block names. If a block that you select has visible attributes, then they will 
appear blank in the legend.

� Enter a title for your legend. You can type a period (.) to not include a legend 
title.

� Specify the start point of the legend in your drawing. This point corresponds 
to the upper-left corner of the legend.

� Do one of the following:

� Type a value for the width of the legend. 
� Drag the legend border on the screen to change the width of the legend.

NOTE Make sure that you specify a width that is wide enough to accommo-
date the longest symbol description string in the legend.

After you specify the width of the legend, the following prompt is displayed.

2��%���	���	������������
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$ Do one of the following to specify the number of rows per page that you 
want to place in your legend:

� Type the number of rows per page that you want to place in your legend.
� Type Show and drag the cursor to show the lowest possible point for the 

legend.
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� Press ENTER to place as many rows as possible based on the drawing limits.

The command creates the symbol database, checking every block on the sys-
tem that matches the search criteria that you entered in step 2. If the com-
mand finds a block that is defined in the current drawing, but not inserted, 
a message that the block is not used displays.

% Do one of the following to specify a description for each block:

� Type a description for each block that displays.
� Press ENTER to skip the description for each block.

NOTE If a description has been previously defined for a particular block, the 
command inserts that block with its description in the legend.

After you enter the block descriptions, the following prompt is displayed.

A	������������
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& Do one of the following to modify the legend results:

� Type Move to specify a new position for the legend in the drawing.
� Type Block to create a block from the legend.
� Type Wblock to write the legend block to a new file.
� Press ENTER to end the command without making any changes to the leg-

end.

The Make Legend command uses the layers and text styles specified in the 
current project settings.

Editing the Legend Database

Use the Edit Database command to modify the external database file that 
contains the names and descriptions of all symbols located on the system. 

����������������	�	

� From the Utilities menu, choose List/Legends ➤ Edit Database.

� Type the name of the database file you want to edit. 

� Press ENTER.

The Edit Table dialog box is displayed.

� Edit the database. 

� When you finish editing your database, click OK.
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Calculating Horizontal Curve Information

You can calculate and display information about any horizontal curve.

����	����	���������/���	�����"�������	����

� Select Utility ➤ Curve Solver.

� Enter the properties of the curve.

NOTE When two known properties of the curve are entered, the Curve Solver 
command calculates the remaining properties of the curve. The included angle 
or the radius must be one of the two known properties entered in order for the 
command to work.

� Press ENTER after you enter the known properties of the curve. The informa-
tion is displayed in the text window. 

For example:
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Creating a Selection Set with Filters

You can create a selection set by setting up object property filters to specify 
which objects in your current drawing that you want to include in your selec-
tion set. Objects in your current drawing that do not satisfy the filter criteria 
that you set up will not be a part of your selection set. 

You can filter objects for the selection set by:

� Specifying the object properties you want to include in the filter by name.
� Selecting objects in the current drawing with the object properties you 

want to include in your filter.
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You can use one or both of these methods to specify which object properties 
to include in the selection set.

Filtering Objects By Specifying Properties

You can filter objects by specifying properties you want to include in your 
selection set.

�����������������
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� From the Utilities menu, choose Build Selection Set. 

The Build Selection Set dialog box is displayed.

� Under Names in Drawing, click the button that corresponds to the property 
type that you want to include in your filter. A corresponding Select Property 
dialog box displays.

� Under Properties, select the property you want to include in your selection 
set. 

� Click OK.

� Continue to specify the object properties you want to include in your selec-
tion set filter.

� When you finish creating your filters, click Build Selection Set to add all the 
objects in the current drawing that meet the filter criteria to the selection set.

$ Click Apply to accept the current selection set.

A selection set is created from the objects in your current drawing which 
meet the filter criteria that you specified.

Filtering Objects by Selection

You can filter objects for the selection set by using the Build Selection Set 
command.

�����������������
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� From the Utilities menu, choose Build Selection Set. 

The Build Selection Set dialog box is displayed.

� Under Properties, select the object property or properties that you want to 
include in your filter.

� When you finish selecting properties, click Pick. 

� Select the object or objects in the drawing that have the properties that you 
want to include in your selection set.

� Press ENTER.



1028 | Chapter 38 Utilities

� When you finish creating your filters, click Build Selection Set to add all the 
objects in the current drawing that meet selection criteria to the selection set.

$ Click Apply to accept the current selection set.

A selection set is created from the objects in your current drawing which 
meet the filter criteria that you specified. 

Using the Utilities Editing Commands

You can use the Edit commands to modify blocks, text, surfaces, and proper-
ties of objects. 

Rescaling Blocks and Text

You can make blocks and text in your drawing smaller or larger by using the 
Rescale Blocks/Text command.

������	������#��	����!�

� From the Utilities menu, choose Edit ➤ Rescale Blocks/Text. 

The following prompt is displayed.

-(������(�	��
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� Do one of the following to define the scale:

� Type the scale factor and press ENTER.
� Type  and press ENTER. Type the reference length and press ENTER. Type 

the new length and press ENTER.

� Type the rotation angle.

� Press ENTER.

� Select the objects in your drawing that you want to rescale.

The objects you selected are adjusted to the scale you specified.

Setting the Z Coordinate of an Object to Zero

Use the Flatten Z Values command to change Z coordinates of selected 
objects to specified value.

���������/��������	�����	������
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� From the Utilities menu, choose Edit ➤ Flatten Z Values.
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� Select the objects whose Z values you want to adjust.

The following prompt is displayed.

2���������	���$��

� At the command prompt, type a new Z value for the objects.

The Z values for all points of the objects you selected are adjusted to reflect 
the elevation value you specified.

Performing a Quick Scale

You can use the Quick Scale command to scale all objects selected based on 
a command scaling reference. 

����������	�0���#���	�

� From the Utilities menu, choose Edit ➤ Quick Scale.

� Type a value, or select points to specify a reference value.

� Type a value, or select points to specify a new scale value.

NOTE All selected objects are re-scaled based on the scaling factor defined by 
the responses to these first two prompts. For example, if a reference value of one 
(1) is entered and a new scale value of two (2), all objects are scaled to be twice 
as large as they were originally.

� Select the objects in your drawing you want to scale.

The objects are scaled around either their base point or starting point (in the 
case of polylines or 3D faces).

� You can continue to select objects to scale, or press ENTER to exit the com-
mand.

Scaling All Objects on a Selected Layer

You can use the Layer Scale command to scale all objects found on one or 
more specified layers.
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� From the Utilities menu, choose Edit ➤ Layer Scale.

� Specify the layer of the objects you want to copy at the following prompt.

-���(��	%.�(��
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� Do one of the following:
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� Type a layer name.
� Press ENTER and select the layer name from the screen menu.
� Select a layer using layer aliases.
� Select an object that is already on the desired layer.

The command runs the AutoCAD SCALE command using the objects on the 
selected layers as the selection set.

NOTE If needed, the TRACKING mode can be set to aid in the selection of an 
entity. If a layer name is typed in, the command allows the use of wildcard char-
acters (*,?) to specify more than one layer name. All layers corresponding to the 
wildcards are selected. Another way to specify more than one layer name is to 
type in all layer names separated by commas (,).

� Select a point, or type a coordinate to specify a new base point for the objects.

� Specify a scale factor or a reference length for the objects at the following 
prompt.

�-(������(�	���#������(���

� Do one of the following:

� Type a value, or select points to specify a scale factor for the objects.
� Type R and specify a reference length and a new length for the objects.

$ Continue to select objects, or press ENTER to exit the command.

Hiding Edges of a 3D Face

You can use the Edge Hide command to hide selected edges of selected 3D 
faces or polymeshes.
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� From the Utilities menu, choose Edit ➤ Edge Hide.

� Select each edge of the 3D face or polymesh that you want to hide.

� Press ENTER.

The program hides the 3D faces or polymeshes you selected.

Trimming or Extend Objects to Meet a 3D Face

You can use the Trim/Extend to 3D Face command to trim or extend line 
objects to selected 3D faces.
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� From the Utilities menu, choose Edit ➤ Trim/Extend to 3D Face.

� Select the 3D face that defines the plane to which you want to trim or extend 
the lines.

� Select the line that you want to trim or extend to the plane.

The command trims or extends the line to selected 3D faces.

Combining 3D Faces to Form a Single Pface

You can use the Combine 3D Faces with Pface command to create a single 
AutoCAD pface out of selected 3D faces.
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� From the Utilities menu, choose Edit ➤ Combine 3D Faces with Pface.

� Select all the 3D faces you want to combine into a single Pface.

The command creates the Pface in your drawing.

Exploding Blocks Without Losing Properties

You can use the Explode Retain Properties command to explode a block. This 
command provides options for retaining or changing the properties of the 
block component, including color, linetype, and layer.
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� From the Utilities menu, choose Edit ➤ Explode Retain Properties.

� Select all the objects in your drawing that you want to explode.

� Press ENTER to exit the command.

The blocks you selected are exploded, but retain their properties.

Changing Sets of Attributes that Represent 
Numbers

You can use the Number Shift command to change the values (or paths) in a 
set of blocks that contain attributes representing numbers. This command 
only works on blocks that contain attributes whose values are real numbers 
or integers.
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� From the Utilities menu, choose Edit ➤ Number Shift.

� Select a block in your current drawing that represents the set of blocks that 
contain attributes representing numbers.

NOTE This command only works on blocks that contain attributes whose val-
ues are real numbers or integers.

The command searches the entire drawing and selects all the blocks that 
match the selected block.

� Do one of the following: 

� Type R to renumber the attributes.
� Press ENTER to shift attribute values by a specific amount.

The command displays a list of all the non-constant attributes associated 
with that block on the screen menu. If the block has attributes that were 
defined as constants, these attributes will not be listed.

� Do one of the following:

� Select the attributes from the screen menu.
� Type the attribute names.

NOTE Be sure to only specify attribute whose values are numbers.

The following prompt is displayed.
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The default value for the first prompt is based on the lowest value found 
among the selected attributes. 

� Specify the range of values to be changed at these prompts. 

The following prompt is displayed.

8 �����
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� If the Shift option was selected at the "Renumber or Shift attributes" prompt, 
enter the amount the values of the attributes are to be changed. For example, 
if an attribute has the value twelve (12), and a change of negative eight (-8) 
is entered, the attribute will be assigned a new value of four (4). 
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NOTE If the Renumber option was selected at the "Renumber or Shift 
attributes" prompt, the command changes the appropriate attributes of all the 
blocks selected that have values which match the numbers entered.

The command updates all relevant blocks and their associated attributes 
based on the change value entered.

Erasing All Objects on a Layer

You can use the Erase Layer command to erase all objects on a specific layer. 
This command first replaces the screen menu with a list of all layers in the 
drawing.
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� From the Utilities menu, choose Edit ➤ Erase Layer.

The following prompt is displayed.
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� Select the desired object. 

The Layer name to erase dialog box is displayed.

� Do one of the following: 

� Type a layer name.
� Select the layer name from the screen menu.
� Select a layer using layer aliases.
� Select an object that is already on the desired layer. 

� Click OK.

The command uses the AutoCAD ERASE command to remove the objects 
from the drawing.

NOTE If needed, the TRACKING mode can be set to aid in the selection of an 
object. If a layer name is typed in, the command allows the use of wildcard char-
acters (*,?) to specify more than one layer name. All layers corresponding to the 
wildcards are selected. Another way to specify more than one layer name is to 
type in all layer names separated by commas (,).
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Using the Camera

You can save perspective views of your drawing by using the camera. The 
camera is a quick and simple visualization tool, modeled after real cameras, 
that uses a point-and-shoot process to help you view the drawing as if you 
were standing within it.

You can use the camera grips to modify the view and see the results in 
selected viewports. You can add any number of camera views to your draw-
ing. 

NOTE To create more complex perspective view setups, for example, using 
clipping planes, use the AutoCAD 3D dynamic view. For more information see, 
“Defining a 3D View” in the AutoCAD User’s Guide.

You can also create a video run-through of your drawing with the camera.

Inserting a Camera into a Drawing

You generally insert cameras within plan views. To insert a camera, you spec-
ify a source point (camera insertion point) and a target point (what the cam-
era is looking at), and then you adjust the camera's zoom to change its field 
of view (FOV).

� From the Utilities menu, choose Camera ➤ Add Camera.

� In the Add Camera dialog box, type a name for the camera. 

� In the Zoom text box, select the camera's field of view.

� In the Eye level text box, specify the position of the camera.

If you want the view in the drawing to change to the camera's view after you 
set it, select Generate View after Add.

Specify the camera source point (location) using the pointing device, or enter 
X, Y, and Z values on the command line and press ENTER.

� To specify the camera nter X, Y, and Z values for the camera on the command 
line and press ENTER. 

You can change camera properties, such as the color of the viewing cone and 
values for zoom and field of view, by changing the entity display of the cam-
era. Use the HIDE or SHADE command to produce a final representation of 
your perspective view.



Using the Camera | 1035

Changing the Camera View Using Grips

After you insert a camera into a drawing, you can change the magnification 
of the view and the source and target points either by using the camera grips 
or by changing the camera view in the Camera Properties dialog box.

By selecting one of the grips on the field of view, you can change the zoom 
magnitude. 
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� Select the camera to display its grips. 

NOTE Selecting the camera restores it to its full size. 

The Plan View and 3D View of the Camera is illustrated below.

.�	������	����1����

� Select the target grip or the source grip and drag it to a new location.

The camera settings are automatically updated to reflect the new location.

� To change the camera's field of view (FOV), drag one of the grips. 

NOTE If you drag the camera in plan view, the Z axis is ignored, so that you 
do not accidentally snap the camera to a set of objects with a different Z value. 
The camera is effectively locked to the viewing plane. 

Modifying an Existing Camera

You can change the name of the camera and its zoom length.
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� Select the camera.

� Right-click, and then choose Camera Modify from the shortcut menu.

� In the Modify Camera box, change the name of the selected camera in the 
Name field.

� Change the zoom length. 

� Click OK.

Changing the Camera Properties

You can add notes and reference files to an existing camera, change the name 
of a camera, and move the camera. 

Attaching a Description to a Camera
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� On the Utilities menu, click Camera ➤ Camera Properties.

NOTE There must be a camera in the drawing before you can use this com-
mand.

� In the drawing, select the camera whose view you want to change.

� In the Camera Properties dialog box, click the General tab.

� To add a description to the camera, type it in the Description field.

� Click OK. 

Changing the Camera Name and Zoom Length
You can change the name of the camera and its zoom percentage. 

�����	�������	��	��	��	���/���������

� From the Utilities menu, choose Camera ➤ Camera Properties.

� Select the camera or press ENTER to select a camera from a list of existing cam-
eras.

� In the Camera Properties dialog box, click the Dimensions tab.

� Change the name of the selected camera in the Name field.

� Change the zoom length. 

� Click OK.
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Modifying the Camera Name and Zoom Length
You can change the name of the camera and its zoom percentage. 

�����	�������	��	��	��	���/���������

� Select the camera.

� Right-click and click Camera Modify.

� In the Modify Camera dialog box, change the name of the selected camera 
in the Name field.

� Change the zoom length. 

� Click OK.

Changing the Camera Location Properties
You can relocate an existing camera by changing the coordinate values of its 
insertion point. The camera also has an orientation with respect to the World 
Coordinate System or the current user coordinate system. For example, if the 
top and bottom of the camera are parallel to the XY plane, its normal is par-
allel to the Z axis. You can change the orientation of the camera by aligning 
its normal with another axis. You can also rotate the camera on its plane by 
changing the rotation angle.

NOTE Although you can change the location of the camera using this dialog 
box, it is recommended that you use grips and the view settings to move the 
camera.
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� From the Utilities menu, choose Camera ➤ Camera Properties.

� Select the camera or press ENTER to select a camera from a list of existing cam-
eras.

� In the Camera Properties dialog box, select the Location tab.

� Do any of the following:

� To relocate the camera, change the coordinate values under Insertion 
Point.

� To reorient the camera, change the axis to which the normal is parallel. To 
locate the camera on the XY plane, make the normal of the camera paral-
lel to the Z axis: under Normal, type 1 in the Z box, and type 0 in the X 
and Y boxes. To locate the camera on the YZ plane, type 1 in the X box 
and type 0 in the Y and Z boxes. To locate the camera on the XZ plane, 
type 1 in the Y box and type 0 in the X and Z boxes.



1038 | Chapter 38 Utilities

� To change the rotation of the camera, type a new value for Rotation Angle.

� When you finish making changes, click OK to exit the dialog box.

Associating Cameras with Viewports

You can change the viewport the camera is associated with. When the camera 
is created, it is associated with the viewport it is created in.
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� Select the camera.

� Right-click, and then choose Camera Modify from the shortcut menu.

� In the Camera Modify dialog box, click Viewport Association.

� Click Apply.

� Select the new viewport to associate the camera with.

� Click OK to exit each dialog box.

Setting the Viewport to the Camera View

You can set the viewport of your drawing to the camera's viewpoint.
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� From the Utilities menu, choose Camera ➤ Create Camera View.

� Select the camera in the drawing.

The view in the drawing is changed to the camera's view.

Changing the View of the Camera

You can change the view of the camera incrementally in various directions.
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� From the Utilities menu, choose Camera ➤ Adjust Camera View.

� Select a camera to adjust.

� In the Adjust Camera Position dialog box, the Adjustment Increments con-
trol how much each button changes the view. Do any of the following:

� Change the Step value. This numerical value controls how much each 
click of the following buttons moves the camera: Forward, Back, Left, 
Right, Up, Down.
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� Change the Angle value. This numerical value controls how much each 
click of the following buttons moves the camera angle: Turn Left, Turn 
Right, Look Up, Look Down.

� Change the Zoom percentage. This value controls how much each click of 
the button zooms the camera for Zoom In and Zoom Out.

� Click Hide to view the drawing with hidden lines removed. 

� Click the appropriate button to adjust the view. If the view in the drawing 
wasn't the camera's view, then the first selected button places the drawing 
into the camera's view.

As you click each button, the view changes in increments determined by val-
ues in the Adjustment Increments section. If Auto View is selected, you can 
see the change after you click each button. 

� Click OK to exit the dialog box.

Fixing the Camera View in a Perspective View

When you use the camera to create a perspective view, in a shademode other 
than 2D Wireframe, the zoom factor of the resulting image will be incorrect.
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� Type Dview and press ENTER.

� Pick any objects or press ENTER again to use the dview block.

� Type Distance and press ENTER. 

The current distance is displayed.

� Type the current distance again and press ENTER.

� Press ENTER to exit the Dview command.

Your view is now correct.

Creating a Video Dry Run with a Camera

You can watch the movement of a camera along the path before actually 
recording a video of the movement.
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� From the Utilities menu, choose Camera ➤ Create Video.

� Select the camera or press ENTER to select a camera from a list of existing cam-
eras.

� In the Camera Video dialog box, either click Pick Path in the Camera Path to 
select a polyline path in the drawing for the camera to follow, or click Pick 
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Point to select a point for the camera to move to.

If you select a path, type a name for the path in the Path Name dialog box 
and click OK.

� Either click Pick Path in the Target Path to select a polyline path in the draw-
ing for the camera to focus on as it moves along the camera path, or click Pick 
Point to select a point for the camera to focus on.

If you select a path, type a name for the path in the Path Name dialog box 
and click OK.

If you select the camera path as the target path, the camera maintains its orig-
inal view direction. 

� Select the Regen type.

� Select the number of frames and the rate for the frames. 

$ Click Dry Run.

% Click OK.

The camera moves along the camera path, pointing at the target path or 
point.

Creating a Video with a Camera

You can create a video file of the camera moving in your drawing pointing at 
a stationary point or along its own path.
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� From the Utilities menu, choose Camera ➤ Create Video.

� In the Camera Video dialog box, either click Pick Path in the Camera Path to 
select a polyline path in the drawing for the camera to follow or click Pick 
Point to select a point for the camera to move to.

If you select a path, type a name for the path in the Path Name dialog box 
and click OK.

� Either click Pick Path in the Target Path to select a polyline path in the draw-
ing for the camera to focus on as it moves along the camera path, or click Pick 
Point to select a point for the camera to focus on.

If you select a path, type a name for the path in the Path Name dialog box 
and click OK.

� Select the Regen type.

� Select the number of frames and the rate for the frames. Click OK.
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39What’s New

New features in Release 2i of AutoCAD Land Develop-

ment Desktop include AutoCAD Today, an interface you 

can use to open and create drawings, and to view 

dynamic content from the Internet. 

New Terrain features include DEM support for Terrain 

Model Explorer. You can use DEM files as part of your 

surface data, transforming coordinate systems if needed. 

Also new is Slope Annotation, labels you can use to indi-

cate the slope at selected locations in your drawing.
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What's New in AutoCAD Land Development 
Desktop

People who have used Release 1 of AutoCAD Land Development Desktop and 
Autodesk S8 Civil/Survey programs will notice several changes in Release 2 
and Release 2i of AutoCAD Land Development Desktop. 

Changes new to Release 1 of AutoCAD Land Development Desktop are 
marked as “Release 1” changes. Changes new to Release 2 of AutoCAD Land 
Development Desktop are marked as “Release 2” changes.

What’s New in AutoCAD Land Development 
Desktop R2i

New Features in Release 2i
AutoCAD Land Development Desktop Release 2i has been updated with the 
following features. 

Windows® 2000 Support
AutoCAD Land Development Desktop now supports the Windows 2000 
operating system in addition to Windows 95, Windows 98, and Windows NT 
4.0.

Internet Collaboration Tools
You can use new Internet collaboration tools to conduct online meetings, to 
create and post Web pages that include drawing images, and to pack the cur-
rent drawing and all associated files into a single folder or compressed file. 

Documentation
The Installation Guide is now provided in online format only. When you 
begin the installation process, you are now prompted to view the online doc-
umentation. You have the choice of viewing and printing either network or 
single-user installation instructions in HTML or RTF format.

Online Help is now in HTML Help format. New features include a Favorites 
tab for bookmarking frequently-used topics, a natural language Query tab to 
help you locate topics locally and on the Internet, and a table of contents 



What’s New in AutoCAD Land Development Desktop R2i | 1043

that updates to show you where the topic you are viewing is located in the 
Help system.

AutoCAD Land Development Desktop Today
AutoCAD Land Desktop Today replaces the former Startup dialog box. 
The Today window opens when you start AutoCAD Land Development Desk-
top and can be configured to connect to Autodesk Point A, the Internet por-
tal. You can use Today to open and create drawings, to access the Project Man-
ager, and load symbol libraries into AutoCAD DesignCenter™, as well as to 
download updates for AutoCAD Land Development Desktop and access 
information over the Internet. 

CAD Managers can configure the Bulletin Board section of Today to display a 
custom web page or text file to communicate directly with their local user 
base throughout the day with messages, reminders, and links to standards 
and content libraries. 

Using Autodesk Point A, the Internet portal, you can customize the contents 
of Today. For example, when you register, you can specify that you are in the 
GIS Land/Civil/Survey profession, and relevant industry links are displayed 
in the Today window.

Terrain
The new Label Slope command labels the slope between two selected points 
on a surface, or labels the slope of a TIN triangle.

The new DEM Support within the Terrain Model Explorer can be used to 
include DEM files (Digital Elevation Models) in surfaces.

ActiveX Object Model for Parcels
The new ActiveX Object Model for Parcels can be used to create custom com-
mands for working with parcels.

File Formats
The new GIS Data Transformer provides greater data translation abilities 
when importing and exporting file formats. Drivers are available for formats 
such as SDTS and VML. For example, you can import SDTS files into a draw-
ing and then export to VML to view the drawing in a Web browser.

Live Enabler
The Live Enabler automatically downloads Object Enabler functionality from 
the Internet for AutoCAD users when they open an AutoCAD Land Develop-
ment Desktop drawing that contains custom objects. 
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What’s New AutoCAD Land Development 
Desktop Releases 1 and 2

If you are upgrading to AutoCAD Land Development Desktop Release 2i you 
can use these links to review what’s new from releases 1 and 2 of AutoCAD 
Land Development Desktop.

General Changes

The following topics describe general changes to features in releases 1 and 2.

Release 2: Integrated Installation
Now the installation of AutoCAD Land Development Desktop is integrated 
with the installation of AutoCAD Map. 

Release 2: Multiple Drawing Environment Support
When you install AutoCAD Land Development Desktop, two icons are cre-
ated in your program group. In addition to the AutoCAD Land Development 
Desktop icon, there is a Land Enabled AutoCAD icon that you can use to run 
an “enabled” copy of AutoCAD. This program allows you to view all of the 
AutoCAD Land Development Desktop objects in a drawing, and it also allows 
you to have multiple drawings open at one time.

Release 2: Set Text Style Command Replaced with Standard 
AutoCAD Text Style Command
The AutoCAD Text Style command replaces the AutoCAD Land Develop-
ment Desktop Set Text Style command.

Release 1: Help Buttons
Most dialog boxes in AutoCAD® Land Development Desktop now include 
direct access to the online Help.

Release 1: Right Mouse Options
When you select an object, you have access to a variety of editing/query 
options by clicking your right-mouse button to display a shortcut menu. The 
available commands in the shortcut menus change depending on the object 
you select.
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Release 1: Menu Reorganization
To minimize the need for swapping menus, AutoCAD Land Development 
Desktop logically combines many of the commands found in Autodesk S8 
Civil Engineering and Surveying applications. You can easily mix and match 
the menus to fit your needs.

Grading Commands Moved From Civil Design to 
AutoCAD Land Development Desktop

Several commands that you can use for grading have been moved to 
AutoCAD Land Development Desktop from Autodesk Civil Design. These 
commands include the following:

Grading Commands Moved from the Points Menu

� Create Points ➤ Polyline/Contour Vertices - Automatic

This command was previously named By Polyline Elevations and was 
located in the Civil Design Grading ➤ Points On Polyline menu.

� Create Points ➤ Polyline/Contour Vertices - Manual 

This command was previously named By Manual Elevations and was 
located in the Civil Design Grading ➤ Points On Polyline menu.

� Create Points - Surface ➤ Polyline/Contour Vertices

This command was previously named By Surface Elevations and was 
located in the Civil Design Grading ➤ Points On Polyline menu.

The following commands were moved from the Civil Design Grading ➤ 
Grading Points menu to the Points ➤ Create Points - Slope menu:

� High/Low Point
� Slope/Grade - Distance
� Slope/Grade - Elevation

The following commands were moved from the Civil Design Grading ➤ 
Interpolate menu to the Points ➤ Create Points - Interpolate menu:

� By Relative Location 
� By Relative Elevation 
� Number By Distance 
� Perpendicular 
� Incremental Distance 
� Incremental Elevation 
� Intersection 
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In addition, the Interpolate command was moved from the Points ➤ Create 
Points - Surface menu to the Create Points - Interpolate menu.

Grading Commands Moved from the Terrain Menu
The following commands were moved from the Civil Design Grading ➤ Con-
tours menu to the Terrain ➤ Contour Utilities menu:

� Copy Finished Ground
� Copy by Slope
� Copy by Grade
� Offset by Distance
� Offset by Elevation

The following commands were moved from the Civil Design Grading ➤ 3D 
Polylines menu to the Terrain ➤ 3D Polylines menu:

� Create by Elevation
� Create by Slope
� Create Curb
� Create Step
� Convert to 2D Polyline
� Convert from 2D Polyline
� Edit 3D Polyline
� Fillet 3D Polyline
� 3D Polyline Grade Breaks

In addition, the Join 3D Polylines command that was formerly in the 
Utilities ➤ Edit menu was moved to the Terrain ➤ 3D Polylines menu

The Add Vertices command was added to the Terrain ➤ 3D Polylines menu.

Grading Commands Moved from the Inquiry Menu
The following commands were moved from the Civil Design Grading ➤ 
Grading Points menu to the Inquiry menu:

� List Slope
� List Elevation @ Slope

Active X Object Model

The Active X Object Model exposes AutoCAD Land Development Desktop 
objects through an ActiveX interface. You can program these objects using 
the Visual Basic for Applications programming environment, AutoCAD 
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Development System (ADS), Visual LISP, Visual Basic, Visual C++ or 
any other programming language that supports ActiveX Automation.

The Active X Object Model lets you manage your Land projects, drawings, 
and settings, and gives you access to the data in your Land projects such as 
COGO points, point groups, surfaces, and alignments. 

Because it is built on COM (the Component Object Model), you get interop-
erability with other Windows applications, such as Microsoft Excel and 
Microsoft Word. And since the Active X Object Model is fully integrated 
with the AutoCAD object model, you get a complete API for developing any-
thing from simple utilities to complete add-in applications.

For more information about the Active X Object Model, see the Land Active 
X and VBA Developers Guide online help.

What's New on the Projects Menu

The following topics describe the changes made to commands in the Projects 
menu for releases 1 and 2.

Release 2: Unload Applications
To release floating licenses for Autodesk Civil Design and Autodesk Survey 
without exiting AutoCAD Land Development Desktop, you can use the 
Projects ➤ Unload Applications commands. 

Release 2: New Menu Palette
A new menu palette, Land Desktop R2 Complete, was added for Release 2. 
This menu palette adds the AutoCAD Insert, Format, Tools, Draw, Dimen-
sion, and Modify menus to the default Land Desktop R2 palette.

Release 2: Toolbars in Menu Palettes
Release 2 menu palettes do not store toolbar configurations.

Release 2: Changed Menu Palette File Extensions
Menu palette file extensions are .apm2 for Release 2. Release 1 menu palettes 
have the extension .apm.

Release 2: Menu Palette Macros
You can use to load the Menu Palette Manager and default menu palettes. For 
more information, see “AutoCAD Land Development Desktop Macros” on 
page 1064.
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Release 1: User Preferences
You can control whether you want to use the AutoCAD Land Development 
Desktop New, Open, and Startup options, or the equivalent standard 
AutoCAD Release 14 commands. 

When you start a new drawing you can use the New command to create a 
new project on the fly or select an existing project to associate the drawing 
with. You assign a path for the drawing when you create it; this path can be 
the project's \dwg folder or any folder on your local or network drives.

Drawings are organized based on the project that they are in. The AutoCAD 
Land Development Desktop Open command allows you to list all of the 
drawings in a certain project and select the one you want to open. You can 
search on keywords (assigned by project) to locate the project that has the 
drawing you want to open.

You can also control locations of critical support files and drawing setup pref-
erences.

Release 1: Project Management
Changes include a more intuitive user interface, extended length project 
names (up to 64 characters for a project name), multiple project paths, and 
editing functions such as copying, deleting and renaming a project. You can 
also control the default path for all drawings that are in a project.

Release 1: Controlling Prototype and Drawing Settings
You can now access both the prototype settings and the drawing-specific set-
tings used in the AutoCAD Land Development Desktop (and Autodesk Sur-
vey and Autodesk Civil Design add-on applications when installed). This 
eliminates the need to swap from one module to another when setting pro-
totype and project settings.

Release 1: Managing Data Files
You now have access to all supporting data files such as speed tables, label 
and contour styles, import/export formats, and so on.

Release 1: Reassociate Drawing to Project
At any time, you can reassign a drawing to another project. 

Release 1: Drawing Setup
AutoCAD Land Development Desktop introduces a new, streamlined inter-
face for setting your drawing parameters such as scale, units, text style, and 
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so on. You can also set the coordinate zone, base point, and north rotation 
all from a single logical location.

Release 1: Menu Palettes
Menu palettes control the arrangement of pull-down menus and toolbars. 
Menu palettes are included for the AutoCAD Land Development Desktop 
(and also Autodesk Civil Design and Autodesk Survey add-on applications 
when they are installed). 

What's New on the Points Menu

The following topics describe the changes made to commands in the Points 
menu for releases 1 and 2.

Release 2: Grading Points Commands
Several commands were moved from the Grading menu in Autodesk Civil 
Design to the Points menu. For more information see “Grading Commands 
Moved From Civil Design to AutoCAD Land Development Desktop” on page 
1045. 

Release 2: Point Settings
A new check box on the Text tab, Automatic Leaders, allows you to enable/
disable automatic point leaders (which are created when you move point 
markers).

A new edit box on the Text tab, Text Rotation, allows you to set a rotation 
angle for the point marker text.

A new option on the Marker tab, Align Marker With Text Rotation, allows 
you to align the point marker with the rotation you specify for the point 
marker text.

Release 2: Display of Full and Raw Point Descriptions
The Point Group Manager and the List Points command display both the full 
and raw descriptions of points.

Release 1: Point Settings
The Point Settings dialog box allows you to control all settings that impact 
the way you work with points:

� Insert - Includes options for search paths for symbols, control over inser-
tion elevation, and use of point labels.
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� Update - You can use the AutoCAD MOVE command to move points 
graphically (and have the point database reflect the new location).

� Coordinates - You can use various formats to display point coordinates, 
including Easting-Northing or Y-X.

� Marker - The point is now inserted as an object as opposed to a block 
(although a point block can still be inserted by using the point label 
options). You can control the point marker appearance.

� Text - You can control the text that is displayed in the point object. The 
color and visibility of each component is controlled by changing the 
object properties rather than by changing layer properties. You can also 
choose to display the points at a fixed text and marker size or maintain a 
size that is relative to the screen display.

� Preferences - You can control the display of prompts and dialog display 
when working with points and point groups. You have an option to auto-
matically regenerate the display for any point objects in the drawing so 
they resize to match a relative size compared to the screen display.

Release 1: Point Groups 
Point groups are a way of creating, storing, and recalling specific lists of 
points in your projects. A point group may be as simple as all of your project 
points, or as complex as a group that meets a range of specifications such as 
numeric range, description, name, and so on. 

The point groups are used whenever you are prompted for a specific listing 
of points (point editing, terrain modeling, etc.).

Release 1: Description Keys
Changes to description keys provide a higher level of flexibility so that you 
can better achieve your end result. You can now work with multiple descrip-
tion key files.

Release 1: XDRefs
XDRefs provide an efficient way to incorporate more point-related informa-
tion to your project. When defining a point group, you can override specific 
data values in the included points (such as elevation or description). Data 
such as borehole readings can be stored in database files that the point can 
reference. Now, when building a surface from a point group, the elevation 
values for the included points represent the data in the user-defined external 
database (as opposed to the actual point elevation in the project).

Release 1: Import/Export Points
A new user interface has been developed that simplifies the process of defin-
ing a custom import/export format for points. 
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Release 1: Point Display Properties
Points are inserted as objects (as opposed to AutoCAD blocks). The objects 
provide a higher level of efficiency and performance when working with 
large numbers of points. Another benefit to the point object is better control 
over the appearance, visibility color, scale and point node symbol of points 
in your drawing. You also have enhanced drafting capabilities for adding 
leaders to points when a point object is moved in the drawing.

Release 1: Insert/Remove Points to/from Drawing
You now have better control over points that you want to either insert or 
remove from your drawing. A new option to insert/remove all points within 
a point group, makes it easier to insert/remove points that match a complex 
criteria. It also reduces steps when you are repeatedly drafting a particular 
grouping of points.

What's New on the Lines/Curves Menu

The following topics describe the changes made to commands in the Lines/
Curves menu for releases 1 and 2.

Release 1: Menu
The Lines/Curves menu includes all the line and curve creation options 
found in the Autodesk S8 COGO module and the Spiral creation commands 
that were found in the Autodesk S8 Advanced Design module.

Release 1: Line by Point Range
The Line by Point Range command has been adjusted to support the use of 
a point group. Because the point group stores the included points in the 
order that they were input, the line is drawn using the defined sequence.

What's New on the Alignments Menu

The following topics describe the changes made to commands in the Align-
ments menu for releases 1 and 2.

Release 2: Multi-User Alignment Database
The alignment database is now multi-user enabled, and locking is handled 
on a per-alignment basis. For more information, see “The Horizontal Align-
ment Database” on page 426.
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Release 2: Save As .ADB
A new command, Save as .adb, was added to the Alignments ➤ Alignment 
Commands menu. You can use this command to save the Release 2 align-
ment database, alignment.mdb, to a project.adb file that can be read by 
Release 1 of AutoCAD Land Development Desktop and S8. For more informa-
tion, see “Saving the Alignment Database as an .adb File” on page 432.

Release 2: Merge Database
The Merge Database command now allows you to specify which alignments 
you want to merge from the selected project into the current project.

Release 1: Station Display Format
You now have control over the values used for alignment station labeling. 
For example, you can define the data precision, display for negative values, 
station character, and more. 

Release 1: Alignment Label Terminology
You can control the labeling terminology used for key locations along an 
alignment such as tangent-spiral intersection or radius of curve location. 

What's New on the Parcels Menu

The following topics describe the changes made to commands in the Parcels 
menu for releases 1 and 2.

Release 1: Terminology
All references to lots have been changed to parcels in AutoCAD Land Devel-
opment Desktop.

Release 1: Parcel Labeling Settings 
Additional options are now included to make it easier to draft parcels and 
parcel labels into your drawing. A new feature lets you insert the parcel labels 
without importing in the parcel line work.

Release 1: Importing Parcels and Labels
You can now choose to insert parcel labels, lines, or labels and lines when 
drafting parcels from the Parcel Manager.
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What's New on the Labels Menu

The following topics describe the changes made to commands in the Labels 
menu for releases 1 and 2.

Release 2: Building Offset Label
The Building Offset Label command was added to the Labels menu. You can 
use this command to create labels that show the offset distance between a 
corner of a building to a line. For more information, see “Creating a Building 
Offset Label” on page 584.

Release 2: Re-Draw Table and Delete Table Commands Added 
to Pull-down Menu
The Re-Draw Table and Delete Table commands were added to the Labels ➤ 
Edit Tables menu. Previously, these commands were available only from the 
shortcut menu.

Release 1.x: Static Labels Can Be Turned into Dynamic Labels
Now after creating static labels, you can enable the Dynamically Update 
Label Text property so that the labels become dynamic. For more informa-
tion, see “Changing the Properties of Labels” on page 571.

Release 1: Settings
Settings (formerly preferences) have been simplified due to changes through-
out the labeling commands. Many of the changes relate to how tags are 
inserted and used when creating a line, curve, or spiral table. Tag label styles 
have been separated from line, curve, and spiral label styles and must be used 
when you are generating tables.

A new field to control the non-aligned rotation angle has been added to 
streamline the drafting process. This option lets you control the rotation of 
stacked labels in your sheet.

A major change from Autodesk S8 products is the introduction of Point 
Labels. Points in a drawing can be labeled (just as you would label a line or 
curve) for the purpose of representing point data in various ways in your 
drawings.

Release 1: Edit Label Styles
All labels styles can be accessed from a single dialog box. There is a new 
option for creating point label styles. Changes to the line, curve and spiral 
styles include additional data options; Mtext break and Plus/minus symbol. 
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Point Label styles are new in AutoCAD Land Development Desktop. You can 
choose a block to insert, or textual information representing key data for the 
point. You can control the label location relative to the point node. You can 
also control the use and impact of description keys (including description 
key file) that you want to use and whether the updated description and sym-
bol is added.

Release 1: Edit Tag Styles
Tags are used in cases when you want to draft a line, curve or spiral table. Tags 
are coded for use in a table (whereas regular line, curve, and spiral labels are 
not used in a table).

Release 1: Dialog Bar
In order to streamline menu picks and minimize confusion over the current 
label style, a label dialog bar has been created. This dialog can be left open 
(either docked or undocked) throughout your editing session so that you can 
easily set and confirm the label settings that you are currently using. Chang-
ing a style is a simple matter of selecting the desired style.

Other options include the ability to independently control settings for line, 
curve, spiral, and point labels (and line, curve, and spiral tag labels). You can 
specify whether the label is oriented along the object or at a fixed rotation. 

Icons are available to:

� Switch between Tag and Label settings
� Access the Label Settings dialog box
� Access the currently selected Label Style for editing
� Access the online Help

Release 1: Dynamic Labels
The following changes have been made to the use of dynamic (reactive) 
labels:

� Polyline support - You can now label polylines using dynamic (reactive) 
labels. If the polyline is edited, the affected labels are updated. If the 
polyline is deleted or exploded, the labels are deleted. 

� Multiple label support - You can now have multiple labels per object. 
� Editing a label - Because multiple labels can be applied to an object, you 

now find that more of the label's “intelligence” is found with the label (as 
opposed to being found on the line in S8).

NOTE The following options are no longer available: the option to convert 
from a full label to a tag when the parent object becomes shorter than the 
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label length and the option to automatically insert tags (instead of full labels) 
on lines that are short.

Release 1: Tag Labels
Tags labels are now separated from line, curve, spiral, and point labels. Only 
tag labels can be used in the creation of a table. This change simplifies label-
ing settings.

Release 1: Swap Label Styles
The Swap Label Styles command allows you to swap the above vs. below 
appearance of a drafted label. For instance, a label that initially appears with 
a distance above and direction below the line is converted inversely so that 
the direction is now above and the distance below the line.

Release 1: Flip Bearing
Unless the force bearing option is being used, the bearing direction is derived 
from the direction in which the line has been drawn. The Flip Direction com-
mand swaps the start/end point of the line. A result of this change is that all 
direction labels associated with the line are adjusted.

Release 1: Delete Labels
The Delete Labels command erases any labels associated to a selected line, 
curve, spiral or point. The parent object remains unchanged, but any labels 
are permanently erased. 

Release 1: Disassociate Labels
The Disassociate Labels command is used to remove any association between 
a parent object (line, curve, spiral and point) and the related labels. Once the 
objects are selected, all labels previously associated are now simple mtext 
that will not react to changes in either a style or the parent object.

Release 1: Tables
Changes have been made to the way that tables are drafted, including the 
ability to split a table into a maximum number of rows. 

NOTE In order to provide better control over the creation of tables, the auto-
matic update capabilities found in Autodesk S8 Civil/Survey programs are no 
longer available. If geometry changes, then use the Re-Draw Table command to 
adjust the values in the table. 
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What's New on the Terrain Menu

The following topics describe the changes made to commands in the Terrain 
menu for releases 1 and 2.

Release 2: Grading Commands Moved from Civil Design
Several commands were moved from the Civil Design Grading menu into the 
AutoCAD Land Development Desktop Terrain menu. These include several 
contour commands that were added to the Terrain ➤ Contour Utilities menu 
and commands that were added to a new Terrain ➤ 3D Polylines menu. For 
more information, see “Grading Commands Moved From Civil Design to 
AutoCAD Land Development Desktop” on page 1045.

Release 2: New Watershed Type
A new watershed type, multi-drain notch, was added to AutoCAD Land 
Development Desktop. For more information, see “Watershed Types” on 
page 716. 

Release 2: Import Individual Watersheds
A new command, Import Individual Watersheds, was added to the Water-
shed shortcut menu in the Terrain Model Explorer. This command allows 
you to import individual watershed boundaries by specifying the watershed's 
ID number or by clicking on a region in the drawing.

Release 2: Numbering Watersheds
The Import Watershed Boundaries command now allows you to insert water-
shed numbers onto the drawing when you import watershed boundaries. 

Release 2: Proximity Breaklines in Surfaces
When you build a surface that includes proximity breaklines, you now have 
the option to specify whether you want the proximity breakline to retain its 
definition as a proximity breakline, or whether you want it to be converted 
to a standard breakline.

Release 2: Line of Sight and Fly By Commands
The Line of Slight and Fly By commands, previously in S8 but not included 
with Release 1 of AutoCAD Land Development Desktop, are now located in 
the Terrain ➤ Surface Utilities menu.
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Release 2: Weed 3D Polyline Vertices Command
A new command, Weed Vertices, was added to the Terrain ➤ 3D Polylines 
menu. You can use this command to simplify the geometry of 3D polylines 
by removing unneeded vertices.

Release 1: Menu Organization
AutoCAD Land Development Desktop Terrain menu includes a variety of 
options from the S8 DTM and Earthworks modules. 

Release 1: Terminology

The following commands from Autodesk S8 Civil/Survey programs and ear-
lier releases of Softdesk/DCA products have been adjusted to reflect new ter-
minology: 

Breaklines (formerly Faultlines)

Minimize Flat Faces (formerly Optimize Contour Data)

Object Projection (formerly Project)

Release 1: Terrain Model Explorer
The Terrain Model Explorer replaces a variety of surface creation, data defini-
tion, and surface management assessment commands that existed in the S8 
DTM module. The benefits to this interface include better control over the 
data that is being used in the creation of a surface and more efficient TIN cre-
ating, editing, and management. The new interface combines many previous 
menu picks into a compact, easier to learn shortcut menu system.

Release 1: Raise/Lower Surface
The Raise/Lower Surface command allows you to raise or lower a surface by 
a relative vertical change, and to copy the surface to a new name.

Release 1: Changes to Contour Object
You can now perform typical AutoCAD editing operations to the contour 
object. You can trim, extend, explode, and offset a contour object using the 
standard AutoCAD editing commands. The contours reflect layer settings, 
such as linetype, and graphical controls, such as PLINEGEN (necessary to 
control dashed line consistency when using smoothed contours).

Other changes from Autodesk S8 Civil/Survey programs include increased 
contour creation performance, more natural smoothing, and better results 
when you use the EXPLODE command (the contour looks the same after it 
is exploded). Finally, contour styles are now being used to ensure that all con-
tours retain specific graphical properties, allowing you to have graphically 
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different contours for different aspects of a drawing (for example, existing vs. 
proposed contours).

Release 1: Contour Styles
Contour styles can be defined to control the appearance of grips, labels, con-
tour smoothing, label color and orientation, and more. Styles can be made 
for specific contour types such as existing ground, proposed grade changes, 
cut/fill contours, and so on.

Release 1: Create Contours
The Create Contours dialog box has been changed in the AutoCAD Land 
Development Desktop. The new features are intended to eliminate key-
strokes and to provide better flexibility.

Changes include the ability to select the desired surface that contours are 
generated for. The interval control options streamline mouse picks by main-
taining a user defined interval relationship. Finally, you have the option to 
work with either contour objects or AutoCAD polylines. When using contour 
objects, you can also specify the contour style that you want the contours to 
adhere to.

Release 1: Contour Labels
As in Autodesk S8 Civil/Survey programs, the contour labels are part of the 
contour object. You can slide contour labels along the contour, or delete 
them without leaving gaps in the contours. Changes in AutoCAD Land 
Development Desktop include the ability to control the label color and text 
style (using contour styles) for plotting purposes. You can also control the 
label orientation and use of a text box (additional style options). 

Another new feature is the way that labels react when using DVIEW - Twist. 
The contour label appears to flip 180 degrees to maintain a legible orienta-
tion on the sheet. This is purely a display control. The object has not been 
changed and still appears properly in other non-rotated viewports.

What's New on the Inquiry Menu

The following topics describe the changes made to commands in the Inquiry 
menu for releases 1 and 2.

Release 2: Grading Commands Moved From Civil Design
Two commands, List Slope and List Elevation @ Slope were moved from the 
Civil Design Grading menu to the Inquiry menu. For more information, see 
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“Grading Commands Moved From Civil Design to AutoCAD Land Develop-
ment Desktop” on page 1045.

Release 1: Menu organization
The Inquiry menu combines commands from many of the Autodesk S8 Civil/
Survey programs. This logical grouping makes it easier to find commonly 
used commands for tracking elevations and listing areas and lines/curves/spi-
rals. 

Release 1: Continuous Distance Track/Label Command
This is a new command allowing you to track the distance between various 
locations in your drawing. The resulting total can then be inserted using the 
AutoCAD TEXT command.

What's New on the Utilities Menu

The following topics describe the changes made to commands in the Utilities 
menu for releases 1 and 2.

Release 2: Curve Solver Command 
The Curve Solver command, formerly a retired macro, has been restored to 
the Utilities menu. 

Release 2: Layer Manager 
The Layer Manager now supports AutoCAD 2000 lineweights and plot styles.

Release 2: Build Selection Set
The Build Selection Set dialog box now includes lineweight.

Release 2: Object Viewer
The Object Viewer now includes a 3D Orbit interface.

Release 2: Moved/Removed Commands

� The XYZ Scale, Edit Block, Redefine Block and Make and Insert commands 
were removed from the Utilities ➤ Block menu. 

NOTE You can use the commands in the AutoCAD Modify ➤ In-place Xref 
and Block Edit menu to edit block definitions. You can use the AutoCAD Make 
command on the Draw ➤ Block menu instead of Make and Insert. You can 
use the Property Manager instead of XYZ Scale.
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� The Change Nested, Multiple Attribute Edit, and Erase Outside commands 
were removed from the Utilities ➤ Edit menu. 

NOTE You can use the AutoCAD Find command on the Edit menu instead 
of Multiple Attribute Edit. You can use the Property Manager and the 
commands in the AutoCAD Modify ➤ In-place Xref and Block Edit menu 
instead of Change Nested.

� The Join 3D Polylines command was moved to the Terrain ➤ 3D Polylines 
menu.

� The Reset Settings and Override Settings commands were removed from 
the Utilities ➤ Leaders menu. A new command, Leader Settings, replaces 
these commands.

Release 1: Menu organization
Many of the Utilities menu commands come from the former AEC Tools 
module. There are a variety of new commands to assist you in your daily 
work process.

Release 1: Object Viewer
The Object Viewer is a view window that displays any objects that you select 
from within AutoCAD. The viewer allows you to shade and reorient your 
view quickly and easily. You can also view the display in a perspective view. 
Finally, you can chose to reorient your AutoCAD view to match the orienta-
tion in the Object Viewer.

Release 1: Notes Command
You can add detailed information or reference information to a selected 
object or objects. The Notes command allows you write textual information 
that can be viewed with the object and to associate a separate reference file 
(such as a document, spreadsheet, image, or photo).

Release 1: Layer Manager
With the Layer Manager you can create layer filters and groups that can then 
be easily restored. This streamlines the process of adjusting layer visibility, 
color and linetype.

Release 1: Symbol Manager
Symbol palettes and drawings based on APWA symbol standards have been 
added to AutoCAD Land Development Desktop. These symbols are accessible 
through the Symbol Manager.
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Release 1: Join 3D Polylines
The Join 3D Polylines command has been restored. This command allows 
you to select two 3D Polylines (with varying elevations) and join them into 
one new 3D polyline.

Release 1: Camera Command
The Camera command allows you to define a camera and target view within 
AutoCAD for the purpose of reorienting your 3D perspective view or views. 



1062 | Chapter 39 What’s New



1063

40Macros

To quickly run commonly-used commands, you can use 

macros. A macro (also known as a command alias) is a 

combination of two or more characters that you can 

type at the AutoCAD command line to run commands. 

For example, to zoom to the extents of the drawing, you 

type ZOOM and then select the Extents option. With a 

macro, you can just type ZE to zoom to the extents of 

the drawing.
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AutoCAD Land Development Desktop 
Macros

This topic lists the macros that are supplied with AutoCAD Land 
Development Desktop. AutoCAD also has a list of command aliases that you 
can customize by adding your own command aliases. For more information, 
see “Command Aliases” in the AutoCAD help.

At any time when you need help with AutoCAD Land Development Desktop 
macros, type MH (for "macro help") at the AutoCAD command line.

Macros 

����� �����	
�	��

BA Break @ 
Corresponds to the AutoCAD BREAK command using the @ option.

BF Break First
Corresponds to the AutoCAD BREAK command using the F option

BOL Building Offset Label
“Creating a Building Offset Label” on page 584 

DSP Plot Daystamping
“Inserting a Daystamp” on page 960 

EA Attribute Edit
Corresponds to the AutoCAD ATTEDIT command

EH Edit Hatch
Corresponds to the AutoCAD HATCHEDIT command

LAI  “Layer Isolate Macro” on page 1066

LAF  “Layer Off Macro” on page 1068

LAK  “Layer Lock Macro” on page 1069

LAO  “Layer On Macro” on page 1070

LAP “Change Layer Color/Linetype Macro” on page 1071

LAS “Layer Set – New Layer Macro” on page 1073
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LAT  “Layer Thaw Macro” on page 1074

LAU  “Layer Unlock Macro” on page 1074

LAZ  “Layer Freeze Macro” on page 1075

LG Lengthen
Corresponds to the AutoCAD LEN macro, LENGTHEN command

LOA  “Layer On All Macro” on page 1076

LSU Ruled Surface
Corresponds to the AutoCAD RULESURF command

MB  “Make Block Macro” on page 1077

MH  “Macro Help Macro” on page 1078

MLD “Load AutoCAD Land Development Desktop Menu Palette Macro” on 
page 1078

MLC “Load AutoCAD Land Development Desktop Complete Menu Palette 
Macro” on page 1078

MMP “Load AutoCAD Map 2000 Menu Palette Macro” on page 1078

MCD “Load Civil Design Menu Palette Macro” on page 1078

MSV “Load Survey Menu Palette Macro” on page 1078

MP “Menu Palette Macro” on page 1079

MN “Menu Macro” on page 1079

PLT “Print/Plot Macro” on page 1080

PN Plan
Corresponds to AutoCAD PLAN command

RS “Reset Settings Macro” on page 1082

SA “Save Macro” on page 1082

SM Symbol Manager
“Symbol Management” on page 984 
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Layer Isolate Macro

You can isolate a layer by using the Layer Isolate macro (LAI). This macro 
turns all layers off except for the layers you specify. To select the layers to iso-
late, you can select the objects on the layers you want to isolate, you can 
select the layers from a list, or you can use wildcards.

SR Snap Rotate
Corresponds to the DSETTINGS command.

SS Build Selection Set
“Creating a Selection Set with Filters” on page 1026 

TT Text Title
Corresponds to the TEXT command

YE “Layer Erase Macro” on page 1083

YS Layer Scale
“Scaling All Objects on a Selected Layer” on page 1029 

ZA “Zoom All Macro” on page 1084

ZC “Zoom Center Macro” on page 1084

ZD “Zoom Dynamic Macro” on page 1085

ZE “Zoom Extents Macro” on page 1086

ZF “Zoom Left Macro” on page 1086

ZI “Zoom In Macro” on page 1086

ZL “Zoom Limits Macro” on page 1087

ZM “Zoom View Max Macro” on page 1087

ZO “Zoom Out Macro” on page 1086

ZP “Zoom Previous Macro” on page 1087

ZW “Zoom Window Macro” on page 1087
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��	�������������������������

� Type LAI at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on the objects whose layers you want to isolate and then press ENTER 
to display the Layer(s) to isolate dialog box. The names of the layers you 
selected are listed in the Enter Item box.

� Press ENTER to display the Layer(s) to isolate dialog box, where you can 
select the layers from a list.

� To add layers to the Enter Item list in the Layer(s) to isolate dialog box, do 
one or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 

� Hold down the SHIFT key to select a sequential list of layer names.

TIP Click Pick and then click on the objects whose layers you want to isolate, 
and then press ENTER to return to the Layer(s) to isolate dialog box.

Select the Pick nested entities check box to select the layer of a nested object 
or block. When this check box is selected, the original layer of the nested 
entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.

� Type the names of the layers to isolate into the Enter Item box. Separate 
each name with a comma.

� Enter wildcards in the Enter Item box to select layers. For example, you 
can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to close the dialog box and isolate the layers. 
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NOTE You can use the Layer On macro to turn all of the layers back on if 
needed. For more information, see “Layer On Macro” on page 1070.

 Layer Off Macro

You can turn off one or more selected layers by using the Layer Off macro 
(LAF). This macro turns off all layers you specify. To select the layers to turn 
off, you can select the objects on the layers you want to turn off, you can 
select the layers from a list, or you can use wildcards.

�����������������������������

� Type LAF at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor is displayed on the status line.

� Do one of the following

� Click on the objects whose layers you want to turn off and then press 
ENTER to display the Layer(s) to turn off dialog box. The names of the lay-
ers you selected are listed in the Enter Item box. 

� Press ENTER to display the Layer(s) to turn off dialog box, where you can 
select the layers from a list.

� To add layers to the Enter Item list in the Layer(s) to turn off dialog box, do 
one or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 

� Hold down the SHIFT key to select a sequential list of layer names.

TIP Click Pick and then click on the objects whose layers you want to turn 
off, and then press ENTER to return to the Layer(s) to turn off dialog box.

Select the Pick nested entities check box to select the layer of a nested object 
or block. When this check box is selected, the original layer of the nested 
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entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.

� Type the names of the layers into the Enter Item box. Separate each name 
with a comma.

� Enter wildcards in the Enter Item box to select layers. For example, you 
can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to close the dialog box and turn off the layers. 

 Layer Lock Macro

To prevent any item on a specified layer from being edited, you can lock that 
layer by using the Layer Lock macro (LAK). To select the layers to lock, you 
can select the objects on the layers you want to lock, you can select the layers 
from a list, or you can use wildcards.

�������������������������

� Type LAK at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on the objects whose layers you want to lock and then press ENTER 
to display the Layer(s) to lock dialog box. The names of the layers you 
selected are listed in the Enter Item box.

� Press ENTER to display the Layer(s) to lock dialog box, where you can select 
the layers from a list.

� To add layers to the Enter Item list in the Layer(s) to lock dialog box, do one 
or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 
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� Hold down the SHIFT key to select a sequential list of layer names.

TIP Click Pick and then click on the objects whose layers you want to lock, 
and then press ENTER to return to the Layer(s) to lock dialog box.

Select the Pick nested entities check box to select the layer of a nested object 
or block. When this check box is selected, the original layer of the nested 
entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.

� Type the names of the layers to lock into the Enter Item box. Separate each 
name with a comma.

� Enter wildcards in the Enter Item box to select layers. For example, you 
can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to close the dialog box and lock the layers. 

 Layer On Macro

You can turn on one or more selected layers by using the Layer On macro 
(LAO). This macro turns on all layers you specify. To select the layers to turn 
on, you can select the layers from a list, or you can use wildcards.

����������������������������

� Type LAO at the command line to display the Layer(s) to turn on dialog box.

� To select the layers to turn on, do one or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 

� Hold down the SHIFT key to select a sequential list of layer names.
� Type the names of the layers to lock into the Enter Item box. Separate each 

name with a comma.
� Enter wildcards in the Enter Item box to select layers. For example, you 

can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to close the dialog box and lock the layers. 
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Change Layer Color/Linetype Macro

You can change the color and linetype of a layer by using the Change Layer 
Color/Linetype macro (LAP). To select the layers to change, you can select 
objects on the layers, you can select the layers from a list, or you can use wild-
cards.

���������������������������	����
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� Type LAP at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on the objects whose layers you want to change and then press 
ENTER to display the Layer(s) to change properties dialog box. The names 
of the layers you selected are listed in the Enter Item box.

� Press ENTER to display the Layer(s) to change properties dialog box, where 
you can select the layers from a list.

� To add layers to the Enter Item list in the Layer(s) to change properties dialog 
box, do one or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 

� Hold down the SHIFT key to select a sequential list of layer names.

TIP Click Pick and then click on the objects whose layers you want to 
change, and then press ENTER to return to the Layer(s) to change properties 
dialog box.

Select the Pick nested entities check box to select the layer of a nested object 
or block. When this check box is selected, the original layer of the nested 
entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.
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� Type the names of the layers to change into the Enter Item box. Separate 
each name with a comma.

� Enter wildcards in the Enter Item box to select layers. For example, you 
can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to display the Select Color dialog box.

� Select a color for the layers you selected and click OK to display the Select 
Linetype dialog box.

� Select the linetype for the layers.

� Click OK to end the command.

 Layer Set – Current Layer Macro

You can select the current layer or create a new layer by using the Layer Set 
macro (LAS). To select the layer to set current, you can select an object on the 
layers, you can select the layer from a list, or you can use wildcards.

��������������������������

� Type LAS at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on an object whose layer you want to set current. The Set current or 
define new layer dialog box is displayed. The names of the layer you 
selected is listed in the Enter Item box.

� Press ENTER to display the Set current or define new layer dialog box, 
where you can select the layer from a list.

� To add a layer name to the Enter Item list in the Set current or define new 
layer dialog box, do one of the following:

� Click on the layer name in the Layers list. 
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TIP Click Pick and then click on an object that is on a layer you want to set 
current.

Select the Pick nested entities check box to select the layer of a nested object 
or block. When this check box is selected, the original layer of the nested 
entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.

TIP Type the name of the layer to set current into the Enter Item box. 

To create a new layer, type the name of a new layer into the Enter Item box.

� Enter wildcards in the Enter Item box to select a layer. For more informa-
tion about wildcards, see “Using Wild-card Characters” in the AutoCAD 
User’s Guide.

� Click OK to set the selected layer current.

Layer Set – New Layer Macro

You can create a new layer or select the current layer by using the Layer Set 
macro (LAS). 

������������� ������

� Type LAS at the command line.

The following prompt is displayed:

���������	����
����������

� Press ENTER to display the Set current or define new layer dialog box.

� Type the name of the layer to create into the Enter Item box.

� Click OK to display the Select Color dialog box.

� Select a color for the new layer and click OK to display the Select Linetype 
dialog box.

� Select the linetype for the new layer.

� Click OK to end the command.
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 Layer Thaw Macro

You can thaw frozen layers by using the Thaw Layer macro (LAT). To select 
the layers to thaw, you can select objects on the layers, you can select the lay-
ers from a list, or you can use wildcards.

����� ����������������

� Type LAT at the command line to display the Layer(s) to thaw dialog box.

� To select the layers to thaw, do one or more of the following:

� Hold down the CTRL key and click on the layers in the Layers list. 
� Hold down the SHIFT key to select a sequential list of layer names.
� Type the names of the layers to thaw into the Enter Item box. Separate 

each name with a comma.
� Enter wildcards in the Enter Item box to select layers. For example, you 

can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to thaw the selected layers.

 Layer Unlock Macro

You can unlock layers by using the Layer Unlock macro (LAU). To select the 
layers to unlock, you can select objects on the layers, you can select the layers 
from a list, or you can use wildcards.

������������������������

� Type LAU at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on the objects whose layers you want to unlock and then press 
ENTER to display the Layer(s) to unlock dialog box. The names of the layers 
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you selected are listed in the Enter Item box.
� Press ENTER to display the Layer(s) to unlock dialog box, where you can 

select the layers from a list.

� To add layers to the Enter Item list in the Layer(s) to unlock dialog box, do 
one or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 

� Hold down the SHIFT key to select a sequential list of layer names.

TIP Click Pick and then click on the objects whose layers you want to 
unlock, and then press ENTER to return to the Layer(s) to unlock dialog box.

Select the Pick nested entities check box to select the layer of a nested object 
or block. When this check box is selected, the original layer of the nested 
entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.

� Type the names of the layers to unlock into the Enter Item box. Separate 
each name with a comma.

� Enter wildcards in the Enter Item box to select layers. For example, you 
can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to unlock the selected layers.

 Layer Freeze Macro

You can freeze selected layers by using the Layer Freeze macro (LAZ). To select 
the layers to freeze, you can select objects on the layers, you can select the 
layers from a list, or you can use wildcards. 

NOTE The current layer cannot be frozen.

������!�����������������

� Type LAZ at the command line.

The following prompt is displayed:

���������	����
����������
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TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on the objects whose layers you want to freeze and then press ENTER 
to display the Layer(s) to freeze dialog box. The names of the layers you 
selected are listed in the Enter Item box.

� Press ENTER to display the Layer(s) to freeze dialog box, where you can 
select the layers from a list.

� To add layers to the Enter Item list in the Layer(s) to freeze dialog box, do one 
or more of the following:

� Hold down the CTRL key and click on the additional layers in the Layers 
list. 

� Hold down the SHIFT key to select a sequential list of layer names.

TIP Click Pick and then click on the objects whose layers you want to freeze, 
and then press ENTER to return to the Layer(s) to freeze dialog box.

Select the Pick nested entities check box to select the layers of a nested object 
or block. When this check box is selected, the original layer of the nested 
entity is selected when you use the Pick button. When this box is cleared, the 
layer on which the entire nested block is inserted is selected.

� Type the names of the layers to freeze into the Enter Item box. Separate 
each name with a comma.

� Enter wildcards in the Enter Item box to select layers. For example, you 
can type Align* to select all the layers that start with “Align.” For example, 
Align-1, Align-2, and so on. For more information about wildcards, see 
“Using Wild-card Characters” in the AutoCAD User’s Guide.

� Click OK to freeze the layers.

 Layer On All Macro

You can turn on all layers by using the Layer On All macro (LOA). This macro 
turns on all layers that are currently turned off, but it does not thaw frozen 
layers.
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������������		�	�
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� Type LOA at the command line.

Make Block Macro

You can make a block from objects in your drawing by using the Make Block 
macro (MB). When you use the MB macro, the original objects from which 
you create the block are erased from the graphics screen and the new block 
is inserted in their place. The block that you create is stored in the drawing 
file.

�����������	���

� Type MB at the command line.

The following prompt is displayed:

��������	
�

� Type a name for the new block. This block name cannot contain spaces and 
cannot exceed 255 characters.

NOTE If you enter a name that matches a block that is already present in the 
drawing, then the following message is displayed:

**Name already used- try another**

� Select the insertion point for the block. This point corresponds to the lower-
left corner of the block.

� Select the objects you want to add to the block, and then press ENTER.

The new block is inserted into the drawing, and the original entities from 
which the block was created are erased. 

NOTE If the block name you entered in step 1 contains an invalid character, 
then the following message is displayed:

Invalid block name.

Run the MB macro again to enter a valid block name.
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 Macro Help Macro

To view online Help about the AutoCAD Land Development Desktop mac-
ros, use the Macro Help macro (MH).

��#	� ����������


� Type MH at the command line.

 Load AutoCAD Land Development Desktop 
Menu Palette Macro
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�����������
������
������

� Type MLD at the command line.

 Load AutoCAD Land Development Desktop 
Complete Menu Palette Macro

�����������$���%$��&������#���
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� Type MLC at the command line.

 Load AutoCAD Map 2000 Menu Palette Macro
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� Type MMP at the command line.

 Load Civil Design Menu Palette Macro

�����������%	#	�����	��������
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� Type MCD at the command line.

 Load Survey Menu Palette Macro

�����������(��#��������
������

� Type MSV at the command line.
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 Menu Palette Macro

You can use the Menu Palette macro (MP) to run the Menu Palette Manager, 
where you can create and load menu palettes.

���������������)��������������

� Type MP at the command line.

 Menu Macro

You can use the Menu macro (MN) to switch between different AutoCAD 
Land Development Desktop menus. 

The AutoCAD Land Development Desktop menu files are as follows:

� Acad: shows only AutoCAD menus (File, Edit, View, Insert, Format, Tools, 
Draw, Dimension, Modify, Help).

� Acmap: shows only AutoCAD Map menus (Map, Help).
� Land: shows only Land Desktop menus (Projects, Points, Lines/Curves, 

Alignments, Parcels, Labels, Terrain, Inquiry, Utilities, Help)
� Civil: shows only Civil Design menus (Grading, Layout, Profiles, Cross 

Sections, Hydrology, Pipes, Sheet Manager).
� Survey: shows only Survey menus (Data Collection/Input, Analysis/Fig-

ures).

�������������

� Type MN at the command line.

The following prompt is displayed:
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� Do one of the following:

� Press ENTER to accept the default menu.  
� Type the name of the menu you want to load, for example, land.

WARNING! If you do not type a menu file extension after the menu 
name, then the .mnc file is loaded. However, if you type the .mnu extension, 
a warning dialog box is displayed, informing you that loading the .mnu file 
overwrites the menu source file (.mns file) and all customization of the menu 
and toolbars will be lost. Loading the .mnu file can seriously affect your 
menus and menu palettes.



1080 | Chapter 40 Macros

� Type a period (.) to load only the File and Help menus.

Print/Plot Macro

You can use the Print/Plot macro (PLT) to create a daystamp in your drawing 
and then plot the drawing. You can plot the visible contents of model space 
or you can specify a named layout to plot. A daystamp shows the drawing 
name, location, and date and time that the daystamp was created.

������������������
�����
����������� 	��

� Type PLT at the command line.

If the drawing does not contain a daystamp, then the following message is 
displayed:

*������+���,'���(���

#�'�������(�����

� Select the insertion point for the new daystamp. This insertion point corre-
sponds to the lower-left corner of the daystamp.

NOTE If the drawing already contains a daystamp, then the following mes-
sage is displayed and the daystamp is updated:

��,'���(��-�'�'������,����".��"���

/(&����+���,'���(���

� Press ENTER to continue.

The following prompt is displayed:

%���������,������������012����&���

� Do one of the following:

� Press ENTER or type Model to plot the visible contents of model space.

NOTE Only the objects currently visible on the screen are printed. Zoom to 
the appropriate level before using the PLT macro.

� Type the name of an existing layout name in the drawing, or type a ques-
tion mark (?) to query the names of the layouts in the drawing, and then 
enter the appropriate layout name.

The following prompt is displayed:

%�������(�+��'���(���������

� Type a page setup name, or press ENTER to accept the default. 
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NOTE You can configure page setups by using the PLOT command. If you 
previously used the PLOT command to assign a page setup name to model space 
or the layout you are plotting, then that page setup name is listed as the default. 

The following prompt is displayed:

%�����������(���&�3������������012��4��$�'��5�����6����7����

� Do one of the following:

� Press ENTER to accept the default output device name.
� Type an output device name.
� Type a question mark (?) to query the configured output devices, and then 

type the appropriate name.

The following prompt is displayed:

8������9��(��������������0.�'6:�2��:�

� Do one of the following:

� Type No to print the drawing to paper.
� Type Yes to print the drawing to a file. The Create Plot File dialog box is 

displayed. Assign a name to the file by typing a name in the File name 
box, and then click Save.

If you are plotting model space, then the following prompt is displayed:

��3���9��+�'������&�������0.�'6:�21��:

If you are plotting a layout, then the following prompt is displayed:

��3���9��+�'������,����0.�'6:�21��:

* Do one of the following:

� Type Yes if you want to associate the page setup name you specified in step 
5 with the layout or model space you are plotting. By typing Yes, the spec-
ified page setup name becomes the default page setup name for the layout 
or model space. 

� Type No if you do not want the specified page setup name to become the 
default for the layout or model space.

The following prompt is displayed:

������&�;��9�(����0.�'6:�2��.��

+ Type Yes to plot the drawing, or type No to cancel the command.
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 Reset Settings Macro

You can use the Reset Settings macro (RS) to return certain AutoCAD settings 
to their default states. 

These settings and their default values include the following:

For more information about these variables, see “Using System Variables” in 
the AutoCAD User’s Guide. 

NOTE The settings that the RS macro uses are located in the reset.lsp file, 
located in the c:\Program Files\Land Desktop R2\Land folder. You can 
customize this file to set your preferred default values for the settings.

The RS macro also turns on the UCS icon for all viewports.

������������	���

� Type RS at the command line.

 Save Macro

You can save a drawing by using the Save macro (SA).

����#����������������� 	��

� Type SA at the command line.

The following prompt is displayed:

��3�����;��+�"'�����$��&����	���'�������)<)�&;+�(����&;+�

� Do one of the following:

� Press ENTER to save the drawing to the default name and location.
� Type a new path and/or drawing name and then press ENTER.

PICKBOX 3 APERTURE 5 BLIPMODE 1

CMDECHO 0 EXPERT 0 HIGHLIGHT 1

MENUECHO 0 OSMODE 0 REGENMODE 0

SNAPANG 0.0 SNAPBASE (0.0 0.0) THICKNESS 0.0

USCFOLLOW 0
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NOTE If you type a name for the drawing but do not type the full path, 
then the drawing is saved to the c:\Program Files\Land Desktop R2 folder.

NOTE If you type a path that does not currently exist, then the following 
message is displayed:
Path does not exist: D:\drawings\
Please verify the correct path was given.

The Save Drawing As dialog box is displayed so you can create a new folder 
or locate an existing folder in which to save the drawing. 

 Layer Erase Macro

You can use the Layer Erase macro (YE) to erase the objects on a selected layer. 
Using this macro, you can erase one layer at a time. 

NOTE The Layer Erase macro does not delete the selected layer from the draw-
ing. It just erases the objects that are located on the selected layer.

�������������	��


 Type YE at the command line.

The following prompt is displayed:

���������	����
����������

TIP Press F5 to turn on tracking. Tracking shows you the name of the layer on 
which an object is located when your cursor is on the object. The layer name is 
displayed on the AutoCAD status line. When tracking is off, the coordinates of 
the cursor are displayed on the status line.

� Do one of the following:

� Click on the object whose layer you want to erase to display the Layer 
name to erase dialog box. The name of the layer you selected is listed in 
the Enter Item box.

� Press ENTER to display the Layer to erase dialog box, where you can select 
the layer from a list.
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� To add a layer to the Enter Item list in the Layer to erase dialog box, do one 
of the following:

TIP Click Pick and then click on the object whose layer you want to erase.

Select the Pick nested entities check box to select the layer of a nested object or 
block. When this check box is selected, the original layer of the nested entity is 
selected when you use the Pick button. When this box is cleared, the layer on 
which the entire nested block is inserted is selected.

� Type the name of the layer to erase into the Enter Item box. If you type 
more than one layer name into the Enter Item dialog box, only the last 
layer name you type is erased.

� Enter wildcards in the Enter Item box to select a layer. For more informa-
tion about wildcards, see “Using Wild-card Characters” in the AutoCAD 
User’s Guide.

� Click OK to close the dialog box and erase the layer. 

 Zoom All Macro

You can use the Zoom All macro (ZA) to display a view based on the drawing 
boundaries or the extents of the objects in the drawing. If the drawing objects 
extend beyond the drawing limits, Zoom All displays the extents of the 
objects. If the objects are drawn within the limits, Zoom All displays the 
drawing limits. This macro is equivalent to using the ZOOM command, All 
option.

��!�������������� 	���"����������������,����������"-����

� Type ZA at the command line.

 Zoom Center Macro

You can use the Zoom Center macro (ZC) to zoom to a given center point and 
magnification level. This macro is equivalent to using the ZOOM command, 
Center option.

��!����������������
�	��

� Type ZC at the command line.

� Select the center point for the zoom. When the display changes, this point 
will be at the center of the AutoCAD window.
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A prompt similar to the following is displayed:

��+��������������4��+9���)=>�<<�

� Do one of the following:

� Press ENTER to accept the default magnification level, which is the current 
magnification level of your drawing.

� Type a new magnification level for the zoom. The larger the magnification 
level is, the more of the drawing you can see in the AutoCAD window.

 Zoom Dynamic Macro

You can use the Zoom Dynamic macro (ZD) to zoom dynamically to an area 
in your drawing. This macro is equivalent to using the ZOOM command, 
Dynamic option.

��!���������	�����

� Type ZD at the command line.

A view of the drawing limits (or extents, if the extents of the drawing objects 
are outside the drawing limits) is displayed. Within this view, the drawing 
extents are marked by a dotted blue line, and the area of the drawing that the 
display was zoomed to is marked by a dotted green line. 

A box with an X in the center also appears. By positioning and sizing this 
box, you can select the area you want to zoom to.

� Move the box so that the left edge of it is positioned at the left edge of the 
location you want to zoom to, and click your pointing device once.

The X is replaced by an arrow at the right edge of the box. Now you can 
adjust the magnification level for the zoom.

� Move your cursor left or right to determine the magnification level of the 
zoom. Move your cursor up and down to determine the upper and lower 
boundaries of the zoom box. A larger box displays a smaller image. A smaller 
box displays a larger image.

� At this point you can do one of the following:

� Press ENTER to zoom to the area within the zoom box.
� Click your pointing device to reposition the zoom box.

The image enclosed by the view box becomes the current view.
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 Zoom Extents Macro

You can use the Zoom Extents macro (ZE) to zoom to the extents of the 
objects in your drawing. This macro is equivalent to using the ZOOM com-
mand, Extents option.

��!������������,��������������"-����

� Type ZE at the command line.

 Zoom Left Macro

You can use the Zoom Left macro (ZF) to zoom to an area with a given lower-
left corner and magnification level.

��!��������

� Type ZF at the command line.

� Select the lower-left corner of the zoom window.

� Do one of the following:

� With your pointing device, select an upper-right corner for the zoom win-
dow.

� Type a new magnification level and press ENTER.
� Press ENTER to accept the default magnification level, which is the current 

magnification level of the drawing.

 Zoom In Macro

You can use the Zoom In macro (ZI) to double the zoom level of the current 
display. This macro is the equivalent of using the Zoom command, Scale 
option, and typing 2x. 

��!����	�

� Type ZI at the command line.

 Zoom Out Macro

You can use the Zoom Out macro (ZO) to halve the zoom level of the current 
display. This macro is the equivalent of using the Scale option of the Zoom 
command and typing .5x. 
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��!����	�

� Type ZO at the command line.

 Zoom Limits Macro

You can use the Zoom Limits macro (ZL) to zoom to the drawing limits. The 
drawing limits are a user-defined rectangular boundary of the drawing area 
covered by dots when the grid is turned on. For more information on the 
drawing limits, see LIMITS in the AutoCAD help.

��!�������������� 	����	�	��

� Type ZL at the command line.

 Zoom View Max Macro

You can use the Zoom View Max (ZM) macro to zoom out as far as possible 
without forcing a regeneration of the drawing.

��!�������������,	����#	� 

� Type ZM at the command line.

 Zoom Previous Macro

You can use the Zoom Previous macro (ZP) to change the current magnifica-
tion level of the drawing to the previous magnification level. This macro is 
equivalent to using the ZOOM command, Previous option.

��!�����������
��#	��������	�	���	�����#��

� Type ZP at the command line.

 Zoom Window Macro

You can use the Zoom Window macro (ZW) to zoom to a given rectangular 
area of your drawing. This macro is equivalent to using the ZOOM com-
mand, Window option.

��!��������� 	��� 

� Type ZW at the command line.

� Select the first corner of the area you want to zoom to.

� Select the opposite corner of the area you want to zoom to.
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Erase Outside (Retired Macro)

This macro has been retired. 

�������������	����.�����/���	��������

� Type retired at the command line.

NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type EO.

  Multiple Attribute Edit (Retired Macro)

This macro has been retired. 

�������������	��������	
���$���	"����.�	�������

� Type retired at the command line.

NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type MAE.

  XYZ Scale (Retired Macro)

This macro has been retired. 

�������������	����012�(����������

� Type retired at the command line.

NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type XYZ.

  Change Nested (Retired Macro)

This macro has been retired. 
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�������������	����%������3�����������

� Type retired at the command line.

NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type CNS.

  Edit Block (Retired Macro)

This macro has been retired. 

�������������	����.�	��4����������

� Type retired at the command line.

NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type EB.

  Redefine Block (Retired Macro)

This macro has been retired. 

�������������	��������	
���$���	"����.�	�������

� Type retired at the command line.

NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type RB.

  Make and Insert Block (Retired Macro)

This macro has been retired. 

�������������	�������������5������4����������

� Type retired at the command line.
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NOTE Typing retired is required only once per drawing session in order to 
access retired commands.

� Type MIN.
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41Migrating from Earlier 
Versions of Land 
Development Desktop

When you upgrade from an earlier release of AutoCAD 

Land Development Desktop or from a Softdesk Civil/

Survey product, many data files are converted automat-

ically. Moving back to an earlier version of AutoCAD 

Land Development Desktop requires careful manage-

ment of files to function properly.

In this chapter

� Converting Projects From and 
To Autodesk S8 Civil/Survey

� Converting Projects From 
Earlier Releases of 
Softdesk/DCA

� Converting Projects From and 
To Land Desktop Releases 1 
and 2

� Managing Data Files When 
Upgrading From Land 
Development Desktop 
Release 1 and Release 2
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Converting Projects from and to Autodesk S8 
Civil/Survey

To use an Autodesk S8Civil/Survey project with AutoCAD Land Develop-
ment Desktop Release 2 (R2), some of the project files must be updated or 
converted to new formats. This process occurs automatically when a drawing 
that is attached to an Autodesk S8 project is opened with AutoCAD Land 
Development Desktop R2. The very first time you open a drawing that was 
created using Autodesk S8, you will be prompted to convert various parts of 
the project data, including point files, description keys, alignments, and 
drawing points. These conversions are necessary for AutoCAD Land Develop-
ment Desktop to function properly.

The conversion from AutoCAD Land Development Desktop R2 back to 
Autodesk S8 is not automatic and requires careful management to imple-
ment correctly. 

WARNING! You should always back up project information and program 
customizations (such as menus, label styles, templates, etc.) prior to upgrading 
the software and converting projects.

Click a topic in the following list for more information about changes to 
project and drawings files. Also noted in each topic is information about 
backward compatibility between AutoCAD Land Development Desktop R2 
and Autodesk S8.

� Drawing Files (S8)
� General Project Changes
� Long File Names
� Project Names
� Point Data Files
� Alignment Files
� Parcel (Lot) Files
� Surface Files
� Volume Files
� Profile and Cross Section Files
� Template Files
� Pipes Files
� Hydrology Files
� Sheet Manager Files
� Survey Files
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Information about earlier releases
� Converting Projects from Earlier Releases of Softdesk/DCA

Drawing Files (S8)

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

Click one of the following topics for more information about changes to 
drawing files:

� Saving AutoCAD Land Development R2 Drawings to R14 Format
� Replacement of the Softdesk Point Block
� Conversion of Information in the adcadd_zz Block
� Changes to Contour Objects
� Changes to Section View Objects
� Converting Labels
� Backward Compatibility for Drawings
� When Converting an S8 Drawing, Curve Label Delta Angles Are Con-

verted to a Value of Zero

Saving AutoCAD Land Development R2 Drawings to R14 
Format
Drawing Files (S8)Overview

AutoCAD 2000 and AutoCAD Release 14 drawing files are different due to the 
new objects, properties (such as lineweight), and options available in 
AutoCAD 2000. 

Autodesk S8 and Land Development Desktop Release 1 are based on 
AutoCAD Release 14, and Land Development Desktop Release 2 is based on 
AutoCAD 2000.

If you will be working with both platforms extensively, it is recommended 
that you use the following procedure to configure AutoCAD 2000 to save 
drawings in the Release 14 format:

���������	
���	������������������
���������������
��

� From the Projects menu, choose Menu Palettes.

� Select AutoCAD Map 2000 and click OK to view the standard AutoCAD 
menus.

� From the Tools menu, choose Options. 

� Click the Open and Save tab. 

� Under File Save, use the Save As list to select the AutoCAD R14/LT98/LT97 
Drawing (*.dwg) option. 
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This will force AutoCAD 2000 to save to the native Release 14 format when-
ever you use the Save or Save As command.

Replacement of the Softdesk Point Block
Drawing Files (S8)Overview

The most notable difference in an AutoCAD Land Development Desktop 
drawing is the replacement of the traditional Point block with the new point 
object. Although the point block is recognized when the project point data-
base is updated from a drawing, most commands do not recognize the 
Autodesk S8 Point block.

Autodesk S8 COGO Point blocks are not automatically converted to the new 
COGO point object. This is an optional but recommended step that can be 
performed with the command in the Point Utilities menu. 

Conversion of Information in the adcadd_zz Block
Drawing Files (S8)Overview

When an Autodesk S8 drawing file is opened with AutoCAD Land Develop-
ment Desktop R2, the information that was stored in the adcadd_zz block is 
converted to use the Land Development Desktop Drawing Setup Object. This 
information includes the name of the project that the drawing is attached to 
and the drawing setup information. The adcadd_zz block is maintained for 
use by any custom programs that may have accessed the information.

Changes to Contour Objects
Drawing Files (S8)Overview

Contour objects have undergone some changes in AutoCAD Land Develop-
ment Desktop. When a drawing is opened, Autodesk S8 contours are auto-
matically converted to the new Land Development Desktop contour object 
format, which now uses named styles to store contour display properties. 

The default style of "Standard" is applied to the S8 contours. The "Standard" 
contour style uses no smoothing, and uses a default text style of "Standard". 
Although the elevation text is preserved, if you used a prefix and/or suffix 
when labeling the contours in S8, they will be lost. 

To readjust the text style and smoothing of the contour objects, select the 
contours and right-click to select Contour Properties, or use the Contour 
Style Manager to adjust or create contour styles.

Changes to Section View Objects
Drawing Files (S8)Overview
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The Section View object is automatically converted to the new Land Devel-
opment Desktop section view object. The section view object, however, is not 
backward compatible and must be recreated in Autodesk S8.

Converting Labels
Drawing Files (S8)Overview

There are three options for converting S8 Dynamic label reactors when they 
are updated for AutoCAD Land Development Desktop R2. You are automati-
cally prompted to select one of the three options, described below:

� The first option retains the dynamic/static state that was in the S8 draw-
ing. Using this option, all converted labels will use the label styles found 
in the following path, C:\Program Files\Land Desktop R2\Data\labels\. 
If you modified Softdesk label styles, then copy the Softdesk label styles to 
the above path prior to conversion. All Softdesk labels that have the auto-
matic update properties turned on will dynamically update in Land Devel-
opment Desktop R2, and all labels that have the automatic update prop-
erties turned off will remain static. 

� The second option converts Softdesk labels to static labels and maintains 
the original appearance and location of the labels. Static labels do not 
update when the objects or the styles change. If you want to change the 
labels to a dynamic state at a later time, you may want to copy any mod-
ified label styles from Softdesk to the following path: C:\Program 
Files\Land Desktop R2\Data\labels\, prior to conversion. 

� Use the third option if you do not want to convert all Softdesk 7.6 and 
Autodesk S8 labels into Land Development Desktop labels. When you 
select this option, the convert labels dialog box will be displayed the next 
time you open the drawing.

For more information, see “When Converting an S8 Drawing, Curve Label 
Delta Angles Are Converted to a Value of Zero” on page 1095.

When Converting an S8 Drawing, Curve Label Delta Angles 
Are Converted to a Value of Zero
Drawing Files (S8)Overview

This is a known problem relating to changes in the structure of curve label 
styles. In Autodesk S8, the delta angle parameter was called {Delta}, which 
included both the delta symbol and the actual angle. 

In AutoCAD Land Development Desktop, there can be two parts of a delta 
angle label. The first is the delta symbol itself, called {Delta Symbol}, and the 
second is the actual angle value, called {Delta Angle}. When you open an S8 
drawing in Land Development Desktop and choose one of the options to 
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convert labels, the angle values of curve labels that contained the {Delta} 
parameter in S8 may be improperly converted to zero.

���
�����������
� !��"���������!!�����#

� From the Labels menu, choose Edit Label Styles to display the Edit Label 
Styles dialog box.

� Click the Curve Label Styles tab.

� Change all occurrences of {Delta} to {Delta Angle} in the curve label styles.

� Save the curve label styles.

The delta angle of the labels in the drawing will be updated as soon as you 
make this change and save the styles.

Backward Compatibility for Drawings
Drawing Files (S8)Overview

Click one of the following topics for more information about backward com-
patibility from AutoCAD Land Development Desktop R2 to Autodesk S8:

� Adcadd_zz Block
� Geodetic Zone
� COGO Points
� Contour Object
� Section View Object
� Dynamic Labels
� Slope Grading Object

Adcadd_zz Block
Backward Compatibility for DrawingsOverview

The adcadd_zz block is maintained in AutoCAD Land Development Desktop 
so that the project name and setup information can be read in Autodesk S8.

Geodetic Zone
Backward Compatibility for DrawingsOverview

Autodesk S8 does not recognize the geodetic zone from AutoCAD Land 
Development Desktop.

COGO Points
Backward Compatibility for DrawingsOverview

The point object displays as a proxy image and is not recognized by Autodesk 
S8 COGO as a point block. However, you can use the Point Block Only label 
style as the common block and AutoCAD Land Development Desktop will 
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fill in the point block attributes so that they can be recognized by Autodesk 
S8. For more information, see “Point Block Only Label Style” on page 529.

This can also be done in a bulk process using the Land Development Desktop 
project point database. First, start a new drawing, set up the drawing, and 
then select the Softdesk Point Block Only style as the current point label 
style. From the Points menu, choose Check Points ➤ Modify Drawing, and 
make sure Add all points to drawing is selected. This will insert all points 
from the database into the drawing using the current point label style. 

Another method to transfer point information to Autodesk S8 is to use the 
Import/Export functions of Land Development Desktop and Autodesk S8 to 
bring points into Autodesk S8 using an intermediate transfer file.

If you are creating new projects to be transferred to Autodesk S8, you should 
not use the point names option when creating a new point database and you 
should restrict the size of the description to 32 characters. If you use the 
default settings when the point database setup dialog box is displayed, there 
should not be any problems with sharing point information between the 
objects and the point blocks.

Contour Object
Backward Compatibility for DrawingsOverview

The contour object displays as a proxy image and is not recognized by 
Autodesk S8 DTM as a contour. AutoCAD S8 can view and print contours as 
proxy objects, but Land Development Desktop contours cannot be smoothed 
or edited using the Autodesk S8 tools. To avoid this problem, contours can 
be created as polylines in Land Development Desktop and then converted to 
the Autodesk S8 contour format by using the Contours from Polylines com-
mand from the Contour menu in the DTM module. 

These contours can then be manipulated at will. If a drawing is to be worked 
on in Autodesk S8 and Land Development Desktop simultaneously, it is best 
to keep all contours as polylines rather than contour objects. Both platforms 
can work with polyline representations of contours. The main drawback to 
this method is the loss of reactive contour labels and style editing functions 
when using Land Development Desktop.

Section View Object
Backward Compatibility for DrawingsOverview

The section view object displays as a proxy image and is not recognized by 
Autodesk S8 DTM as a section view object.

Dynamic Labels
Backward Compatibility for DrawingsOverview
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Dynamic labels do not react to any changes and are not recognized as 
dynamic labels by Autodesk S8 COGO.

Slope Grading Object
Backward Compatibility for DrawingsOverview

The slope grading object displays as a proxy image and is not recognized by 
Autodesk S8 Earthworks as a grading object. To use information contained in 
the grading object, you can explode the object prior to saving the drawing to 
use in Autodesk S8. The resultant entities containing true elevational infor-
mation are 3D polylines (for the footprint and daylight line) and 3D lines (for 
the daylight lines). These are recognized by Autodesk S8 Earthworks and 
DTM commands.

General Project Changes

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

The project structure and external data has changed in AutoCAD Land Devel-
opment Desktop, Autodesk Civil Design, and Autodesk Survey, but the entire 
project philosophy is carried over into Land Development Desktop. The links 
to projects are preserved between Autodesk S8 and Land Development Desk-
top, however, the linking mechanism has changed. If you open a drawing 
linked to a project in Land Development Desktop, you will have to re-link 
the drawing in Autodesk S8. That link will be preserved for all future drawing 
sessions, so this is a first-time only task.

When you set up a drawing in Land Development Desktop, you can select a 
geodetic zone for the drawing. Zones are not recognized by Autodesk S8 and 
must be set within Land Development Desktop for geodetic transformations 
and calculations.

NOTE A list of files created and used by AutoCAD Land Development Desktop, 
Autodesk Civil Design, and Autodesk Survey can be found in the help topics for 
those products.

Long File Names

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

To maintain compatibility of AutoCAD Land Development Desktop project 
files with Autodesk S8, it is important to limit the input of descriptive text 
fields (symbol names) to 32 characters with no spaces, and file names to 8 
characters. Symbol names apply to blocks, dimension style, layers, linetypes, 
text styles, ucs's, view ports, views, layouts, layer names, and linetypes.
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Project Names

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

There are no compatibility issues when converting project names from 
Autodesk S8 to Land Development Desktop.

Backward Compatibility
Autodesk S8 supported 8-character project names while the AutoCAD Land 
Development Desktop supports 64-character names. Projects that exceed 8 
characters or have spaces in the names cannot be used with Autodesk S8.

Point Data Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

When a project is converted from Autodesk S8 to AutoCAD Land Develop-
ment Desktop, the first data files that get converted are the point files. A 
series of dialog boxes prompt you to confirm the conversion process. The fol-
lowing steps occur when the point files are converted:

� The point information in the Autodesk S8 project point database, 

points.pdf, is converted to a MicrosoftAccess database called points.mdb 
in the <project name>\Cogo folder. The original points.pdf is left intact 
but is not used by AutoCAD Land Development Desktop once the conver-
sion is completed. 

� The <dwg name>.phf is converted into a dictionary in the drawing and is 
no longer required after the drawing is opened in AutoCAD Land Devel-
opment Desktop.

� The description key file description.dsc is converted to a Microsoft Access 
database called default.mdb in the <project name>\Cogo\DescKey folder. 
The original description.dsc is left intact but is not used by AutoCAD Land 
Development Desktop once the conversion is completed.

Backward Compatibility
The Autodesk S8 project point files (project.pdf) are left in their original state 
when the project is converted. If the files have not been manually deleted 
they can still be read by Autodesk S8. However, they will represent the state 
of the project point file when the conversion occurred and will not contain 
any new or modified point data from the AutoCAD Land Development Desk-
top. 

This makes it necessary to maintain two separate databases. Successful use of 
multiple point databases is dependent on proper drawing and project man-
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agement. All members of the project team must know the state of the current 
information to avoid overwriting new data with old.

You can convert Land Development Desktop point information so that is 
compatible with Autodesk S8 by completing the following steps:

� In AutoCAD Land Development Desktop, create a drawing that is attached 
to the desired project.

� Set the current Point Label Style to Point Block Only. 
For more information, see “Selecting the Current Label Style” on page 529 
and “Point Block Only Label Style” on page 529.

� Turn on the Use The Current Point Label Style When Inserting Points option 
in the Point Settings.
For more information, see “Changing the Point Insertion Settings” on page 
98.

� Insert all points into the drawing, then save the drawing.
For more information, see “Inserting Points into a Drawing” on page 197.

NOTE When you use this procedure, it will insert BOTH a Point Block and a 
Point Object at the same location. You may wish to erase the point objects prior 
to saving the drawing. To do this efficiently, use the Build Selection Set com-
mand on the Utilities menu to create a selection set using the point object as an 
entity type filter. This selection set can be erased before saving the drawing. For 
more information, see “Creating a Selection Set with Filters” on page 1026.

� Open the drawing in Autodesk S8.

$ From the Points menu, choose Check Points ➤ Modify Project and select the 
option to add points to the project point database.

NOTE Alternately, you can use the export points command in the AutoCAD 
Land Development Desktop Points menu to export the project points to an inter-
mediate text file, then import the points in Autodesk S8.

Alignment Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

When the project is converted from Autodesk S8 to AutoCAD Land Develop-
ment Desktop R2, the alignment database is converted from the Softdesk 
.adb format to the new Microsoft Access .mdb database automatically. This 
conversion only occurs when the program finds that there is a project.adb 
file in the project \align folder, but not an alignment.mdb. If the align-
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ment.mdb does exist, then that indicates that the conversion has already 
taken place. The original Softdesk .adb file is left intact but is not used by 
AutoCAD Land Development Desktop R2 once the conversion is completed. 
The Softdesk .adb file remains in the <Project Name>\align folder.

Previously, alignment names were limited to eight characters. To support 40-
character alignment names, a file called longfilenamesystem.mdb is created. 
This file correlates the new AutoCAD Land Development Desktop R2 long 
alignment names into the 8-character limited alignment database. 

When converting the alignment database file, the program first needs to 
check for the longfilenamesystem.mdb file. If it exists, it is read to correlate 
the full (long) alignment name with the 8-character name that exists in the 
Softdesk alignment database. If it doesn't exist, that means that it is an S8 or 
earlier project which didn't support long alignment names. In this case the 
alignment names will be converted directly from the .adb alignment data-
base.

Backward Compatibility
Once the database is converted and the alignment.mdb file is created, 
AutoCAD Land Development Desktop R2 no longer reads the project.adb 
file. This makes it necessary to maintain two separate databases. Backward 
compatibility with previous releases can be accomplished with the Save As 
.adb command to create the old format and the Merge Database command, 
which can read alignments from the old format for full round-trip capability. 
However, alignment names longer than eight characters or with spaces will 
not appear correctly in Autodesk S8 and may cause problems with any com-
mands that require an alignment to be used.

Successful use of multiple alignment databases is dependent on proper draw-
ing and project management. All members of the project team must know 
the state of the current information to avoid overwriting new data with old.

Parcel (Lot) Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

In AutoCAD Land Development Desktop, Lots were renamed to Parcels. 
However, the format of the database file hasn't changed, so no update to the 
file is required when the project is converted. However, parcels now support 
40-character names. 

Backward Compatibility
Autodesk S8 can read parcels created in the AutoCAD Land Development 
Desktop if the parcel names are 10 characters or less with no spaces. Parcels 
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defined with longer names will not appear correctly in Autodesk S8 and may 
cause problems with the Lot commands.

Surface Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

The surface data files are not significantly modified when converted to 
AutoCAD Land Development Desktop. The following occurs for each surface 
when the project is updated from Autodesk S8:

� The <surface name>.dat information is converted into the <surface 
name>.sdf file. The .sdf file also contains additional information that is 
new to the AutoCAD Land Development Desktop. The .sdf file contains 
information about the surface, such as whether it is a regular TIN surface, 
or a volume surface. The original <surface name>.dat file is left intact, but 
is NOT updated if any changes are made.

� The surface point data file <surface name>pnt.txt is shown in the Terrain 
Model Explorer interface as point file data.

� The <surface name>.dat and <surface name>pnt.txt files are left intact for 
use with Autodesk S8.

Backward Compatibility
AutoCAD Land Development Desktop surfaces support 40-character names, 
while Autodesk S8 only supported five characters. Any surface with more 
than five characters or with spaces in the name will cause Autodesk S8 DTM 
to fail. 

Surfaces with 5-character names and no spaces that have been created in 
AutoCAD Land Development Desktop can be used with Autodesk S8, but if 
they are rebuilt in Autodesk S8, the following surface data will be lost because 
it is not recognized by Autodesk S8:

� Point Groups
� Point files, except for the converted <surface name>pnt.txt
� Watersheds
� Defined Borders
� Edit History

Volume Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

The volume data files from Autodesk S8 are not modified when the project is 
opened in AutoCAD Land Development Desktop. When the Terrain Model 
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Explorer is opened in AutoCAD Land Development Desktop using an 
Autodesk S8 project, the <surface name>.dat file is read and converted to the 
new <surface name>.sdf (surface data file). This file contains information 
that designates the surface as a volume surface.

Terrain Model Explorer recognizes and treats these surfaces as volume sur-
faces. The original <surface name>.dat file is left intact, but will NOT be 
updated if any changes are made. However, surface, site, and stratum names 
now support 40 characters.

In general, volumes must be recalculated in AutoCAD Land Development 
Desktop to generate reports.

Backward Compatibility

� The AutoCAD Land Development Desktop surface and stratum names 
support 40-character names, while Autodesk S8 only supports five charac-
ters. Any surface or stratum with more than five characters or with spaces 
in the name will cause Autodesk S8 DTM and Earthworks to fail. 

� The Stratum file contained in <project name>\er\stratum.txt is backward 
compatible, unless long file names have been used in any surfaces or stra-
tum names.

� The AutoCAD Land Development Desktop supports 40-character site 
names, while Autodesk S8 only supported 8-character names. Site names 
longer than eight characters will cause Autodesk S8 DTM and Earthworks 
to fail.

Profile and Cross Section Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

When the project is converted from Autodesk S8 to Autodesk Civil Design, 
the profile and cross section data files are not updated. AutoCAD Land Devel-
opment Desktop R2 reads and converts the Autodesk S8 files when they are 
opened.

Backward Compatibility
The Civil Design profile data files can be read by Autodesk S8 because the for-
mat hasn't changed. Cross section and template control files have some addi-
tional data fields and control parameters relating to ROW holds, benching, 
and match slopes. These particular items should be verified for desired results 
if the information is used in Autodesk S8. 
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Compatibility applies only to alignment names that contain eight or fewer 
characters and no spaces. Autodesk S8 won't recognize alignment names that 
contain spaces or more than eight characters. 

NOTE All profiles and cross sections used in Autodesk S8 or Autodesk Civil 
Design require the existence of a valid alignment of the same name that they 
were created from.

Template Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

When the project is converted from Autodesk S8 to Autodesk Civil Design, 
template files are converted automatically to support long file names for sub-
assemblies.

Backward Compatibility
Once the template files are read and saved in Autodesk Civil Design, they are 
no longer compatible with Autodesk S8.

Pipes Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

The pipe run database is automatically converted from the Autodesk S8 .dbf 
format to a Microsoft Access database in Autodesk Civil Design when the 
pipe run database is opened and saved.

Backward Compatibility
The Autodesk S8 pipe run database files are modified when the pipeworks 
data is opened and saved in Autodesk Civil Design. This modification makes 
the new pipeworks database incompatible with Autodesk S8. If you wish to 
maintain compatibility of the pipe run database with Autodesk S8, you must 
NOT open and save the pipeworks database with Autodesk Civil Design. 

Alternately, you may maintain two separate databases. Successful use of mul-
tiple databases is dependent on proper drawing and project management. All 
members of the project team must know the state of the current information 
to avoid overwriting new data with old.

Hydrology Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview
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When the project is converted from Autodesk S8 to Autodesk Civil Design, 
the Hydrology project data files are automatically updated.

Backward Compatibility
Due to some file structure changes, the Civil Design Hydrology project data 
files are not backward compatible and cannot be read by Autodesk S8. If you 
wish to maintain compatibility of the hydrology database with Autodesk S8, 
you must not open and save the pipeworks database with Autodesk Civil 
Design.

Alternately, you may maintain two separate databases. Successful use of mul-
tiple databases is dependent on proper drawing and project management. All 
members of the project team must know the state of the current information 
to avoid overwriting new data with old.

Sheet Manager Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

If an Autodesk S8 project is opened in Autodesk Civil Design R2, the Sheet 
Manager data files are updated automatically when a sheet style is opened 
and saved.

Backward Compatibility
Due to Sheet Manager database structure changes that were made to support 
layout space, Autodesk Civil Design R2 Sheet Manager data files cannot be 
read by Autodesk S8. You may, however, use and maintain the S8 Sheet Man-
ager files with both versions so long as you do not save a style in Autodesk 
Civil Design.

Survey Files

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

Survey data files are not modified between Autodesk S8 and Autodesk Survey.

Backward Compatibility
The Survey data files created in the Autodesk Survey are backward compati-
ble and can be read by Autodesk S8. 
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Converting Projects from Earlier Releases of 
Softdesk/DCA

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

You can choose one of the following links for information on converting ear-
lier releases of Softdesk/DCA.

��!����������

� Converting Projects from Softdesk S7
� Converting Projects from DCA/Softdesk Release 12

Converting Projects from Softdesk S7

Converting Projects from Earlier Releases of Softdesk/DCAOverview

Converting from Softdesk S7 to AutoCAD Land Development Desktop is sim-
ilar to converting from Softdesk S8. There are no significant differences, 
other than the actual conversion of the drawing to AutoCAD 2000 format.

Converting Projects from DCA/Softdesk Release 
12

Converting Projects from Earlier Releases of Softdesk/DCAOverview

In addition to the conversion process that occurs when converting Softdesk 
S7 projects to AutoCAD Land Development Desktop, changes occur to the 
following areas when converting Release 12 projects to Land Development 
Desktop:

Project Names
No difference from S8 conversions, however, the project defaults file is no 
longer used and can be deleted when the project/drawing conversion is com-
pleted.

���������	
��������	
��������	����

Projects: Point Data Files
The point database is converted automatically when the project is opened. 
The Release 12 point database was a different format from the Softdesk S7-S8 
database. After converting a Release 12 project, the following files are no 
longer required and can be deleted:
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After opening and converting each drawing in the project, the following 
drawing specific files can be deleted.

�������	����

Projects: Surface Files
In Release 12, the DTM surface files were stored directly in the project folder. 
In S7 these files were moved into subfolders of the \dtm project folder. Each 
surface now has its own unique subfolder.

Surfaces and surface data in Release 12 used AutoCAD X,Y coordinate values. 
When these surfaces are converted for S7 or later, the data coordinates are 
converted to the civil Northing/Easting coordinate system. This conversion 
is based on correlating the AutoCAD X,Y with the Northing/Easting that is 
defined by the COGO Base Point and North Rotation for the current drawing 
when the files are converted.

Projects: Profile and Cross Section Files
The profile and cross section project files are reorganized. The files are moved 
from the \align folder to subfolders for each separate alignment.
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Converting Projects from and to Land 
Desktop Releases 1 and 2

Converting Projects from and to Autodesk S8 Civil/SurveyOverview

Making a smooth transition from AutoCAD Land Development Desktop 
Release 1 (R1) to Release 2 (R2) is a relatively simple process. When you open 
a project that you created with Land Development Desktop R1 in Land 
Development Desktop R2, many of the external project files are read and 
converted to the R2 format automatically and transparently. Other files are 
converted when you open and save them in Land Development Desktop R2.

NOTE As with any software or project change, it is strongly recommended 
that you make a backup of your project and drawings before making a transition 
from Land Development Desktop R1 to R2.

Moving data backward from Land Development Desktop R2 to R1 is a more 
difficult task. In general, the most significant item that causes data conflicts 
when attempting to transfer projects from Land Development Desktop R2 
back to R1 is the use of extended symbol names. An extended symbol name 
means that the name is greater than 32 characters, and/or the name contains 
spaces. 

Items that may have extended symbol names include blocks, dimension 
styles, layers, linetypes, text styles, ucs, viewports, views, and layouts. Sup-
porting extended symbol names has required changing parts of the project 
database.

Additionally, some product enhancements have changed the format of cer-
tain files within the project database. These changes make some of the Land 
Development Desktop R2 project files incompatible with Land Development 
Desktop R1.

This document outlines various parts of the project database, and how you 
can work with Land Development Desktop R2 to maintain compatibility 
with Land Development Desktop R1. This will help you in the event you 
wish to use Land Development Desktop R1 and R2 simultaneously on a sin-
gle project, or wish to transfer the project to a person using Land Develop-
ment Desktop R1.

NOTE Working on a project at the very same time with BOTH Land Develop-
ment Desktop R1 and R2 is not recommended. Land Development Desktop R2 
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has incorporated a new locking mechanism for alignments, terrain models, the 
point database, and pipes to allow multiple users simultaneous access to all parts 
of a project. This locking mechanism is not recognized by Land Development 
Desktop R1 and may potentially cause conflicts or data corruption.

Click one of the following topics for more information about project and 
drawing data migration in AutoCAD Land Development Desktop, Autodesk 
Civil Design, and Autodesk Survey:

� Drawing Files
� Point Project Files
� Description Key Project Files
� Alignment Project Files
� Terrain Project Files
� Parcel (Lot) Project Files
� Profile and Cross Section Project Files
� Hydrology Project Files
� Pipes Project Files
� Autodesk Survey Project Files

Drawing Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

Land Development Desktop R1 drawing files are automatically converted to 
AutoCAD 2000 format when the drawing is opened in Land Development 
Desktop R2. 

To use a Land Development Desktop R2 drawing in Land Development Desk-
top R1, use the Save As command to save the drawing to R14 format before 
opening the drawing in Land Development Desktop R1.

NOTE Land Development Desktop Release 1 is based on AutoCAD Release 14. 
Land Development Desktop Release 2 is based on AutoCAD 2000.

The point object has new functionality in Land Development Desktop R2, 
which is the addition of point text rotation and a leader option. This behav-
ior doesn't exist in Land Development Desktop R1, so the point objects do 
not respect the text rotation and the leader settings when the drawing is 
opened in Land Development Desktop R1. 

However, these settings are preserved so that when the drawing is reopened 
in Land Development Desktop R2, the objects reappear correctly. 
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Point Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

Point database files are compatible between Land Development Desktop R1 
and R2. 

In Land Development Desktop R2, the database includes an additional field 
to store program window states. Land Development Desktop R2 automati-
cally reads and converts a Land Development Desktop R1 point database file 
when opening it, but these changes have no effect on the function of points 
when the project is opened again in Land Development Desktop R1. 

All other data fields and data format remain unchanged. 

The point database file is located in the \<project>\cogo\ folder. The file 
name is points.mdb.

Description Key Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

The Land Development Desktop R1 description key file is automatically con-
verted in Land Development Desktop R2 to support extended symbol names. 
However, as long as you do not use extended symbols names for description 
keys in Land Development Desktop R2, then the R2 description key file is 
compatible with Land Development Desktop R1. 

By default, the project description key file is located in the 
\<project>\cogo\Desckey folder. The name of the file is DEFAULT.mdb.

NOTE You cannot add description keys that contain long layer names to a 
description key file that was created with Release 1 of AutoCAD Land Develop-
ment Desktop and converted to Release 2. Release 2 of AutoCAD Land Develop-
ment Desktop supports long layer names (up to 255), but the description key 
database created with Release 1 cannot support layer names greater than 31 
characters. To use long layer names with description keys, create a new descrip-
tion key file in Release 2 and add the description keys to the new description key 
file.

Alignment Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview
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For Land Development Desktop R2, the alignment database has been 
changed from a proprietary .adb binary format to a Microsoft Access .mdb 
database. 

The alignment database is automatically converted from the Land Develop-
ment Desktop R1 and Softdesk .adb format to the new Microsoft Access .mdb 
format when the project is accessed with Land Development Desktop R2 . 

This conversion only occurs when the program finds that there is a 
project.adb file in the project \align folder. The conversion does not occur if 
the program finds that there is an alignment.mdb. If the alignment.mdb 
does exist, then that indicates that the conversion has already taken place.

NOTE When the conversion occurs, the old alignment database files are not 
deleted. They remain in the \align folder.

The change in the alignment database was implemented to handle the new 
locking mechanism that allows the database to be read by multiple users. The 
format of the file locks has also changed. The lock files now include the PC 
name and the application ID with the user login name. Although the align-
ment database locks in Land Development Desktop R1 and R2 are different, 
a lock created by accessing alignment data in either version will prevent the 
other version from accessing the alignment database.

When converting the alignment database file, the program first needs to 
check for the longfilenamesystem.mdb file. It may or may not exist. If the file 
exists, the program correlates the full (long) alignment name with the 8-char-
acter name that exists in the .adb alignment database. If the file doesn't exist, 
that means that the project is an Autodesk S8 or earlier project that didn't 
support long alignment names. In this case the alignment names are con-
verted directly from the alignment database.

Once the database is converted, backward compatibility with previous 
releases is handled by the Save As .adb command to create the .adb format 
and the Merge Database command (both in the Alignment Commands sub-
menu), which can read alignments from the .adb format. 

It is up to you and others working on the project to maintain the alignments 
between the .mdb and .adb database if you are sharing the project between 
Land Development Desktop R2 and R1. 

Terrain Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview
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Terrain models are completely compatible forward and backward from Land 
Development Desktop R2 to R1, with a few minor exceptions. Conflicts may 
occur if the layers used to import portions of the terrain model use extended 
symbol names. 

Also, in Land Development Desktop R2 a new type of watershed called "Multi 
Drain Notch" was introduced. Watersheds of this type will not be recognized 
by Land Development Desktop R1, and will not import. All other watersheds 
for a given surface will import correctly. 

Terrain model files can be found in the \<project name>\dtm\<terrain 
model name> folder.

Parcel (Lot) Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

Parcel files are forward and backward compatible between Land Develop-
ment Desktop R1 and R2. 

The parcel file <project name>.gcf can be found in the folder <project 
name>\lots.

Profile and Cross Section Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

All Autodesk Civil Design R1 profile and cross section files are forward com-
patible with Civil Design R2. 

However, they are not all completely backward compatible. A portion of the 
cross section template control database has been changed. This has a slight 
impact on the backward compatibility of these files. 

Below is a list of the significant files for profiles and cross sections associated 
with an alignment. For a complete list of files, refer to the AutoCAD Land 
Development Desktop and Autodesk Civil Design user's guides.

<alignment name>.vrt - (vertical profile data file)
The format of the profile .vrt project file has not been modified from Civil 
Design R1 to R2. These files are forward and backward compatible. 

These can be found in the \align\<alignment name> subfolder. The filename 
is <alignment name>.vrt.
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<alignment name>.tcd, .tdf and .tcp (template design control 
data files)
The format of cross section template control files has been modified in Civil 
Design R2 to provide additional control of benches, match slopes, and ROW 
controlled slopes. Civil Design R2 files may be read by Civil Design R1, but 
the results and settings of those items should be verified. 

The template control file can be found in the \align\<alignment name> 
folder, and has the name <alignment name>.tcd.

<alignment name>.xsd and .xsp (existing ground cross section 
file)
The format of the existing ground cross section data files has not changed, 
so these files are forward and backward compatible between R1 and R2.

Hydrology Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

Autodesk Civil Design R1 hydrology project files are modified when they are 
saved in Civil Design R2. These changes, to support extended symbol names, 
are incompatible with Civil Design R1. 

To maintain compatibility, do not save Civil Design R1 hydrology files in 
Civil Design R2. 

The hydrology files can be found in the <project name>\hd folder.

Civil Design R2 pond files are automatically converted and saved into Civil 
Design R2 format when read. Once converted, the files are no longer compat-
ible with Civil Design R1, due to file structure changes.

Pond files are named <pond name>.psp, and can be found in the <project 
name>\hd folder.

Pipes Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

The Autodesk Civil Design R1 pipes database file, \pipewks\pipeworks.mdb, 
is automatically converted to the new Civil Design R2 format when the data-
base is opened with Civil Design R2. 

Once this change is made, the database is no longer compatible with Civil 
Design R1. This change was made to the database to support some additional 
features and data in Civil Design R2. 
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If you want to be able to use the pipes data in Civil Design R1, then you must 
not open the pipes database for that project in Civil Design R2. To effectively 
share project data between R1 and R2, you must maintain two separate data-
bases.

Sheet Manager Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

When opened by Autodesk Civil Design R2, Autodesk Civil Design R1 Sheet 
Manager database files are automatically read and converted to a new format 
compatible with Civil Design R2. Once the files are opened and saved in Civil 
Design R2, however, they are no longer compatible with Civil Design R1. You 
may maintain compatibility with R1 Sheet Manager database files with R2 
and R1 by leaving them in the original R1 format. 

The Sheet Manager database files have the extension .dbf, and are stored in 
the location you specify within Civil Design. 

Autodesk Survey Project Files

Converting Projects from and to Land Desktop Releases 1 and 2Overview

Autodesk Survey R1 files are forward and backward compatible with 
Autodesk Survey R2, unless extended symbol names have been used in any 
of the Survey defaults. 

Survey files are located in the \<project name>\survey subfolder by default.

Managing Data Files when Upgrading from 
Land Development Desktop Release 1 to 
Release 2

Making a smooth transition from Land Development Desktop Release 1 (R1) 
to Land Development Desktop Release 2 (R2) may involve the management 
of external files that are used to set up drawings and create entities. 

During the course of your use of Land Development Desktop R1, you may 
have customized styles, prototypes, and data used in the design and drafting 
process. This document is designed to help you make the best use of those 
files as you transition to Land Development Desktop R2. 



Managing Data Files when Upgrading from Land Development Desktop Release 1 to

NOTE For more information about migrating project and drawing data, see 
“Converting Projects from and to Land Desktop Releases 1 and 2” on page 1108.
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� Data Files
� Managing Individual Data File Types

Data Files

Managing Data Files when Upgrading from Land Development Desktop 
Release 1 to Release 2Overview

Data files are files that AutoCAD Land Development Desktop, Autodesk Civil 
Design and Autodesk Survey use to describe everything from setup defaults 
and drawing prototypes to label styles and sheet borders. 

During the installation of Land Development Desktop (both R1 and R2), you 
are prompted to select a general location for Data files. The installation uses 
this folder to place the Data files. By default, when you first run Land Devel-
opment Desktop, the program looks to the installation \Data folder to find 
this information.

The location of these files can be changed from within the product from var-
ious menus, and also by manually editing files that store the locations of the 
files. Changing the locations of the Data files gives you flexibility to use glo-
bal styles, drawing prototypes, and defaults to maintain intra-company stan-
dards (allowing all users to access common, centralized information), and 
also enables you to have separate locations for project and even user-specific 
standards.

This Help topic provides an inventory of all these files, where they are 
located, and how to change where the program searches for them. This topic 
also describes how the files can be moved to accommodate global or project 
standards, and how to utilize customized Land Development Desktop R1 
Data files with Land Development Desktop R2.

In general, most Land Development Desktop R1 Data files are compatible 
with Land Development Desktop R2 Data files and vice versa. 

NOTE If you are attempting to round-trip Data files between R1 and R2, the 
most important thing to note is that the new extended symbol names (such as 
Layers, Linetypes, and Text Styles with over 32 characters and/or spaces) are sup-
ported in R2, but will not work in R1. If you have saved a style in R2 with 
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extended symbol names, then it will not be compatible with Land Development 
Desktop R1.

Each item in this document contains the following information:

� Item Name (such as contour styles, cross section templates, etc.)
� Description, function and comments
� Compatibility of files
� Moving forward from Land Development Desktop R1 to Land Develop-

ment Desktop R2
� Moving back from Land Development Desktop R2 to Land Development 

Desktop R1
� How to change the location of files
� Moving folders
� Locating and changing the path in Land Development Desktop to point 

to the location of the files
� Storage location and editing preference files manually

The location where Land Development Desktop (R1 or R2) is installed is 
referred to as \Land Desktop, and \project refers to the project folder.

WARNING! Preference (.dfm) files should only be edited by experienced 
users or system managers. Always make a backup of the file before making edits. 
Editing should NOT be done while the program is running.

Managing Individual Data File Types

Managing Data Files when Upgrading from Land Development Desktop 
Release 1 to Release 2Overview

�!��%����������������!!������!�����
���
������
������� �	������
�������

������!��

� Drawing Templates
� Drawing Setup Files and Path
� Drawing Setup Border Files and Path
� Project Prototypes (Including Description Keys)
� Speed Table Files and Path
� Import/Export Formats File and Path
� Label Style Files and Path
� Menu Palette Files and Path
� Contour Style Files and Path
� Symbol Manager Files
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� Cross Section Template Files and Path
� Hydrology and Pipes
� Sheet Manager Templates and Files
� Survey Data Files

Contour Style Files and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for the contour styles that you save outside the drawing. 
These files have the extension *.CST. 

Default Location: Land Desktop\Data\Contours

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully forward compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Not compatible if the Contour Styles are saved in R2. If you wish to use 
Contour Styles in both R1 and R2, do not save the Contour Style in R2.
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Contour Styles.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "CON-
TOURS="

Cross Section Template Files and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for cross section templates and subassemblies used in corri-
dor (road) design. For cross sections to process properly, this folder must be 
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present and any referenced templates must exist in the folder. Template files 
have the extension *.TPL, and subassembly files have the extension *.SUB. 
This location is stored either globally or by project.

Default Location: Land Desktop\Data\tplates\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Fully compatible
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Cross Section Templates.

Project: Civil Menu, Cross Sections ➤ Set Template Path.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "ADTPL="

Project: Located in \Project\project.dfm, Keyname is "tmppath="

WARNING! If no keyname exists in project.dfm, then the default path will 
use the Global setting in SDSK.DFM.

Speed Table Files and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for speed tables used in roadway design. Speed table files 
have the extension *.SUP.  This location is stored either globally or by project.

Default Location: Land Desktop\Data\Speed Tables
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Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Fully compatible
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Speed Tables.

Project: Lines/Curves ➤ Speed Tables ➤ Set Table Path.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "ADTBL="

Project: Located in \Project\project.dfm, Keyname is "speedpath="

NOTE If no keyname exists in project.dfm, then the default path will use the 
Global setting in SDSK.DFM

Drawing Setup Border Files and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for borders (*.DWG files) inserted when using the Drawing 
Setup wizard when creating a new drawing, or when using the Drawing Setup 
command on the Projects menu.

Default location: Land Desktop\Data\borders\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2:

Compatible
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� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Not compatible unless saved back to AutoCAD R14 drawing format. As 
installed, Land Development Desktop R2 drawing borders are in 
AutoCAD2000 format.
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Drawing Setup Borders.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "BOR-
DERS="

Drawing Setup Files and Path

Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for loading a Drawing setup (*.SET) or Text style set (*.STP) 
when using the Drawing Setup wizard when opening a new drawing, or using 
the Drawing Setup command on the Projects menu.

Default location: Land Desktop\Data\setup\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

*.SET files are compatible, but *.STP files are not compatible. The file for-
mat of *.STP files in R2 has changed to a comma-delimited format to 
accommodate extended names and spaces. To use R1 *.STP files with R2, 
you must open the file in an ASCII editor and change the space delimiters 
to commas.

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

*.SET files are compatible, but *.STP files are not compatible. The file for-
mat of *.STP files in R2 has changed to a comma-delimited format to 
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accommodate extended names and spaces. To use an R2 *.STP file with R1, 
you must manually open the file and replace commas with spaces. All 
spaces in the file are treated as data delimiters, so symbol names with 
spaces will not work.
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Drawing Setup Files.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "SETUP="

Import/Export Formats File and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for the Format Manager file (FmtMgrDb.dat). This file con-
tains all of the Import/Export formats that appear in the Format Manager. 
Display the Format Manger by selecting the Format Manager command on 
the Points ➤ Import/Export Points menu. 

Default Location: Land Desktop\Data\Format Manager\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2:

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Fully compatible

How to change the location of files

� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Import/Export Formats.
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� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "FMT-
MGR="

Label Style Files and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for line, curve, spiral, and point label styles. The following 
file types are located in this folder: 

� *.LNS - Line Label Style
� *.LTD - Line Table Definition
� *.LTS - Line Tag Style
� *.CRS - Curve Label Style
� *.CTD - Curve Table Definition
� *.CTS - Curve Tag Styles
� *.SPS - Spiral Label Style
� *.STD - Spiral Table Definition
� *.STS - Spiral Tag Styles
� *.PTS - Point Label Style

These files define label styles. Label Styles can be accessed by selecting the 
Edit Label Styles command on the Labels menu.

Default location: Land Desktop\Data\labels\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Compatible, unless extended symbol names have been used when creat-
ing styles in R2
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.
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� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Label Style.

Drawing: Labels ➤ Settings ➤ General tab.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "CGLA-
BELPATH="

Drawing: Located in \<project>\Dwg\<drawing>.CGX file, Keyname is 
"stylePath ="

Menu Palette Files and Path
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for Menu Palettes. Land Development Desktop R2 uses the 
file extension *.APM2. Land Development Desktop R1 uses the file extension 
*.APM.

Default Location: Land Desktop\Data\Menu Palettes\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

However, to work properly, you must load the R1 menu palette, save it in 
R2 format and reload it. Be sure to change the name when you save the 
*.APM2 file, or you will see the same menu palette twice in the Menu Pal-
ette Manager. It is recommended that you add R2 or a similar designator 
to the end of the file name to prevent this.

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

R2 *.APM2 files are not compatible with R1
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:
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Global: Land Menu, Projects ➤ User Preferences, Menu Palette Path.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "MNPAL="

Project Prototypes (Including Description Keys)
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for Project Prototypes (in respective subfolders) that are cop-
ied to any newly-created project. Files in this folder include project.dfm, 
which is used as the project default file. 

The file default.dfm in the \DWG subfolder includes drawing-specific 
defaults, and is copied to the project \DWG subfolder when a project is cre-
ated. For each new drawing created in the project, the default.dfm file is cop-
ied and renamed to the new drawing name to store drawing-specific defaults. 

The DEFAULT.mdb file contained in the COGO\DescKey subfolder is the 
prototype description key file which is copied to any newly-created project. 

The SampleUserDB.mdb file contained in the COGO\UserDB subfolder is a 
sample format of External Data References (XDRefs) for customized point 
databases, and is copied to any newly-created project.

Default location: Land Desktop\Data\PROTOTYPES\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2:

DFM files are compatible, but it is recommended you use the R2 files. This 
is to ensure that any new defaults in the installed R2 files are present. 
Description key files are read and converted automatically.

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Compatible, but it is recommended you use the R1 files. Description key 
files are compatible, unless saved in R2 using extended symbol names.

How to change the location of files

� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.
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� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Project Prototypes

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "PROT="

Sheet Manager Templates and Files
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for Sheet Manager files. These include drawings and data-
base files used by Sheet Manager.

Default location: Land Desktop\Data\sheets\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Land Development Desktop R2 Sheet Manager files are not compatible 
with R1. If the file is not saved during an R2 session, then the files will 
remain in R1 format which can be used by both R1 and R2. The R2 Sheet 
Manager file format has changed significantly to support extended sym-
bol names.

How to change the location of files

� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Menu Palette Path.

Project: Civil Design Menu, Sheet Manager ➤ Settings.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "STYDB="

Project: Located in \<project>\Project.dfm, Keyname is "StyleDBPath ="
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Survey Data Files
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for global preference files used by Survey.

Default location: Land Desktop\Data\Survey\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Fully compatible, unless extended symbol names are used in R2

How to change the location of files

� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Survey Data Files.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "SVDATA="

Symbol Manager Files
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for Symbol Manager files including database files (*.DBF), 
and Symbol Manager Drawing files. This also determines the initial location 
of the search path for blocks inserted with points. 

NOTE Because of the AutoCAD search path for slide libraries, the associated 
*.SLB files are located in the \Support folder for AutoCAD. These files have the 
same name as the .DBF files used by Symbol Manager, and must exist in the 
\Support folder for whichever AutoCAD version the Symbol Manager files are 
being used in.
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Default location: Land Desktop\Data\Symbol Manager\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Fully compatible

Land Development Desktop R2 automatically converts the .dbf files when 
the R1 Symbol Manager files are opened and saved in Land Development 
Desktop R2.

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Once the Land Development Desktop R1 database files are opened and 
saved in R2, they are no longer compatible with R1. The R2 Symbol Man-
ager drawings are installed as AutoCAD 2000 drawings and are not com-
patible. These drawings must be saved in the AutoCAD R14 format to use 
in R1.

How to change the location of files

� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: Land Menu, Projects ➤ User Preferences, Symbol Manager Files.

Search path for Symbol Block Files (for use with description keys):

Drawing only: Land menu, Points ➤ Point Settings, Insert tab.

� Editing preference files manually:

Global: Located in \Land Desktop\SDSK.DFM file, Keyname is "SYM-
DATA="

Drawing: Only affects the search path for Symbol Block files, which are 
used by Description Keys. This key is located in 
\Project\Dwg\"Dwg".DFM. This value is initially set to the Global value 
for Symbol Manager Files. Changing this does not affect the location for 
Symbol Manager Files. Keyname is "SYM_PATH=".

Drawing Templates
Managing Individual Data File TypesOverview
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Description, function, and comments
This is the folder for drawing templates (*.DWT) used when creating a new 
drawing. These files contain the appropriate settings for newly-created draw-
ings in Land Development Desktop.

Default location: Land Desktop\Templates\

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2: 

Compatible, but not recommended. It is recommended to use the R2 
*.DWT files. This ensures the drawing templates contain appropriate set-
tings for use in R2.

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

All *.DWT files installed in R2 are in AutoCAD 2000 format, and must be 
saved to R14 format by using the Save As command and selecting the 
option to save the drawing to R14 format. Land Development Desktop R1 
templates will work with both R1 and R2, as long as they are not saved in 
the AutoCAD 2000 format. It is, however, recommended to use R1 draw-
ing template files with R1, and R2 drawing templates with R2.
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: This is an AutoCAD 2000 Options setting, and can be changed by 
using the Options command.

� Editing preference files manually:

Global: Use the Options command.

Hydrology and Pipes
Managing Individual Data File TypesOverview

Description, function, and comments
This is the folder for default Hydrology and Pipes files. These files are copied 
to a project when Hydrology or Pipes commands are first used in that project. 
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If these files cannot be located, then a file is created in the project from pro-
grammed defaults.

Default location: Land Desktop\Data\pipewks

Compatibility of files

� Moving forward from Land Development Desktop R1 to Land Develop-
ment Desktop R2:  

Fully compatible

� Moving back from Land Development Desktop R2 to Land Development 
Desktop R1: 

Fully compatible
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� Moving folders: Folders and files can be moved or copied in Microsoft 
Explorer.

� Locating and changing the path in Land Development Desktop to point 
to the location of the files:

Global: This cannot be modified within Land Development Desktop.

� Editing preference files manually:

Global: In \Land Desktop\SDSK.DFM, this is keyed off of keyname 
"CVDATA=" and \pipewks is appended by the program.
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1131

42Menus and Commands in 
AutoCAD Land 
Development Desktop

This section of the documentation contains informa-

tion about each menu and command in AutoCAD Land 

Development Desktop.
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AutoCAD Land Development Desktop 
Menus

Click any menu name for information. 

Projects

Points

Lines/Curves

Alignments

Parcels

Labels

Terrain

Inquiry

Utilities

Help

Projects Menu

Up a Level 

User Preferences Sets file paths, AutoCAD overrides, and 
first-time drawing setup options.

Project Manager Sets project paths and project setup 
options.

Prototype Manager Creates, copies, searches for, and deletes 
prototypes.

Prototype Settings Edits the default settings for a prototype.

Data Files Edits selected data files, including 
Import/Export Formats, Speed Tables, 
and Label Styles.

Drawing Settings Edits the project settings for the current 
drawing.
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Unload Applications Submenu (Projects)

Up a Level 

Points Menu

Up a Level 

Reassociate Drawing Changes the project association of the 
current drawing.

Drawing Setup Configures the current drawing for units, 
scaling, the current zone, sheet size, and 
so on.

Transformation Settings Sets the Grid to Local transformation 
settings for the current drawing.

Unload Applications ➤ Unload Applications submenu

Menu Palettes Manages menu palettes by loading, 
saving, renaming, and deleting.

Autodesk Civil Design Unloads the Autodesk Civil Design 
application.

Autodesk Survey Unloads the Autodesk Survey 
application.

Point Settings Establishes the point creation, insertion, 
and display settings.

Point Management ➤ Point Management submenu

Create Points ➤ Create Points submenu

Create Points-Intersections ➤ Create Points - Intersections submenu

Create Points-Alignments ➤ Create Points - Alignments submenu

Create Points-Surface ➤ Create Points - Surface submenu
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Point Management Submenu (Points)

Up a Level 

Create Points - Slope ➤ Create Points - Slope submenu

Create Points - Interpolate ➤ Create Points - Interpolate submenu

Import/Export Points ➤ Import/Export Points submenu

List Points Lists information about points in a 
drawing.

Lock/Unlock Points ➤ Lock/Unlock Points submenu

Edit Points ➤ Edit Points submenu

Check Points ➤ Check Points submenu

Insert Points to Drawing Inserts selected points from the database 
into your drawing.

Remove From Drawing Removes selected points from your 
drawing without affecting the external 
database.

Stakeout ➤ Stakeout submenu

Point Utilities ➤ Point Utilities submenu

Point Group Manager Creates and deletes point groups.

Description Key Manager Creates and deletes description keys 
and description key files.

XDRef Manager Creates and deletes references to 
external point databases.

Point Database Setup Closes the point database or opens the 
point database in single-user or multi-
use mode.
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Create Points Submenu (Points)

Up a Level 

Manual Creates points at selected locations in 
your drawing.

Northing/Easting Creates points in your drawing based on 
given northing and easting coordinates.

Direction Creates points at specified directions.

Turned Angle Creates points by a given turned angle or 
a deflection angle and distance.

Geodetic Direct Creates points by specified geodetic 
directions.

Resection Creates a point at a position calculated 
from the measured angles between three 
known points.

Station/Offset Object Creates a point at a given station and 
offset distance from a curve, line, or 
spiral.

Automatic Creates points at end, center, and spi 
points of selected lines, curves, and 
spirals.

Along Line/Curve/Spiral Creates points at a specified distance 
along a selected line, curve, or spiral.

On Line/Curve/Spiral Creates points at the ends of a selected 
line or at the ends, radius point and PI on 
a curve or spiral.

Divide Object Creates a given number of points along a 
selected object.

Measure Object Creates points a given distance apart 
along or offset from a selected object.

Polyline/Contour Vertices - 
Manual 

Creates points along a polyline or 
contour with manually entered 
elevations.
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Create Points - Intersections Submenu 
(Points)

Up a Level 

Polyline/Contour Vertices - 
Automatic 

Creates points along a polyline or 
contour using the vertex elevations.

Direction/Direction Creates a point at the intersection of two 
lines.

Distance/Distance Creates a point at the intersection of two 
circles.

Direction/Distance Creates a point at the intersection of a 
line and circle.

Direction/Perpendicular Creates a point perpendicular on a line 
definition.

Distance/Perpendicular Creates a point radial on a circle 
definition.

Direction/Object Creates a point at the intersection of a 
line and an object.

Distance/Object Creates a point at the intersection of a 
circle and an object.

Object/Object Creates a point at the intersection of two 
objects.

Perpendicular Creates a point on an object either radial 
or perpendicular to a selected point.

Direction/Alignment Creates a point at the intersection of a 
direction line and an alignment.

Distance/Alignment Creates a point at the intersection of a 
circle and an alignment.

Object/Alignment Creates a point at the intersection of an 
object and alignment.
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Create Points - Alignments Submenu (Points)

Up a Level 

Create Points - Surface Submenu (Points)

Up a Level 

Alignment/Alignment Creates a point at the intersection of two 
alignments.

Station/Offset Creates points at a given station and 
offset distance in relation to the current 
alignment.

Divide Alignment Creates a given number of points along a 
selected alignment.

Measure Alignment Creates points along the alignment at a 
specified interval.

At PC, PT, SC, etc. Creates a point at every point of 
intersection of an alignment.

Radial Or Perpendicular Creates a point on an alignment radial or 
perpendicular to a selected point.

Import From File Imports alignment points from an ASCII 
file.

Random Points Creates points based on the elevation 
from the current surface.

On Grid Creates points arranged in a grid that 
obtain their elevations from a surface.

Along Polyline/Contour Creates points along a polyline or 
contour that obtain their elevations from 
a surface.
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Create Points - Slope Submenu (Points)

Up a Level 

Create Points - Interpolate Submenu (Points)

Up a Level 

Polyline/Contour Vertices Creates points at polyline or contour 
vertices that obtain their elevations from 
a surface.

High/Low Point Adds a high or low point between two 
existing point objects.

Slope/Grade - Distance Creates a specified number of points 
from an existing point object, based on 
a slope/grade to a given direction and 
distance.

Slope/Grade - Elevation Creates a specified number of points 
from an existing point object, based on 
slope/grade to a given direction and 
elevation.

Interpolate Interpolates two points with known 
elevations.

By Relative Location Interpolates point objects between two 
points, based on distance from the first 
location.

By Relative Elevation Interpolates point objects between two 
points, based on desired elevations.  

Number By Distance Interpolates a specified number of point 
objects between two points. 

Perpendicular Interpolates point objects between two 
points, based on a location perpendicular 
to a selected point.
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Import/Export Points Submenu (Points)

Up a Level 

Lock/Unlock Points Submenu (Points)

Up a Level 

Incremental Distance Interpolates point objects between two 
points, based on an incremental distance 
from the first point. 

Incremental Elevation Interpolates point objects between two 
points, based on an incremental 
elevation from the first point.

Intersection Interpolates point objects between two 
points, based on an intersection with 
selected objects.  

Format Manager Creates a user-defined import/export 
format. 

Import Options Sets the import options to merge points 
into the point database.

Import Points Imports points from an external file into 
the point database.

Export Points Sends point information contained in the 
point database to an external ASCII file.

Transfer Points Transfers point information between two 
different formats.

Locked #'s Displays the locked point numbers in the 
project.

Lock Points Locks points in the project.

Unlock Points Unlocks points in the project.
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Edit Points Submenu (Points)

Up a Level 

Display Properties Changes the display properties for a 
group of points in the drawing.

Edit Points Edits point number, elevation, and 
description of selected points.

Datum Changes the elevations of a group of 
points.

Renumber Adjusts the point numbers by a given 
factor.

Move Moves points in the drawing and 
updates the coordinates in the point 
database.

Rotate Rotates points in the drawing and 
updates the coordinates in the point 
database.

Copy Copies points from one location to 
another and adds the points to the point 
database.

Erase Deletes point information from the 
drawing and point databases.

Unerase Restores erased points to the drawing 
and point database.

Translate Points Moves all project points from a base 
point to a destination point.

Rotate Points Rotates all project points.
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Check Points Submenu (Points)

Up a Level 

Stakeout Submenu (Points)

Up a Level 

Modify Project Updates the project point database 
based on the drawing points.

Modify Drawing Updates the drawing points based on the 
project point database.

Stakeout Settings Sets the directional or angular output for 
Stakeout commands.

Output Settings Changes report settings.

Radial Point Stakeout Performs a stakeout of points within a 
given criteria (by range, group, elevation, 
etc.) of the occupied point.

Curve By Direction Performs a curve stakeout with directions 
or angles as output.

Curve By Offsets Performs a curve stakeout of 
perpendicular offset distances from a 
specified curve.

Spiral By Directions Performs a spiral stakeout with directions 
or angles as output.

Spiral By Offsets Performs a spiral stakeout of 
perpendicular offset distances from a 
specified spiral.

Consecutive Stakeout Performs a stakeout along a series of 
consecutive points.
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Point Utilities Submenu (Points)

Up a Level 

Lines/Curves Menu

Up a Level 

List Available Point # Displays the point numbers that are 
available for use in the current project.

Quick View Places a temporary X in the drawing for 
each point in the project point database.

Zoom to Point Changes the view of the drawing so a 
selected point is located in the center of 
the screen.

Zoom to Extents Zooms to the limits in the project point 
file.

Draw Extents Draws a polyline rectangle around the 
extents of the points in the project point 
database.

Replace Softdesk Point Blocks Replaces old Softdesk point blocks with 
COGO point objects.

Convert from AutoCAD Points Converts AutoCAD point nodes to 
COGO point objects.

Pack Point Database Reduces the size of the point database by 
removing unused records.

Geodetic Calculator Relates local northing and easting 
coordinates to a coordinate zone.

Line Draws a line between points.

By Point # Range Draws a line between specified point 
numbers.
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By Direction Draws a line from a starting point to 
another point determined by direction 
and distance.

By Turned Angle Draws a line using a turned or deflection 
angle from a reference line.

By Station/Offset Draws a line at a given station and offset 
distance from a line.

Line Extension Lengthens or shortens a line.

From End of Object Draws a line from the end of an existing 
line.

Best Fit Line Draws a best fitting line between a range 
of points using the method of least 
squares.

Tangent Draws a line that is tangent to a selected 
object.

Perpendicular Draws a line that is perpendicular to a 
selected object.

Curve Between Two Lines Draws a curve from two lines and breaks 
the lines.

Curve On Two Lines Draws a curve from two lines and leaves 
the two lines connected out to the PI.

Curve Through Point Draws a curve that passes through a 
specified point.

Multiple Curves Draws multiple compound curves 
between selected tangents.

From End of Object Draws a curve off the endpoint of 
another object.

Reverse or Compound Draws a reverse or compound curve from 
the endpoint of a curve. 

Best Fit Curve Draws a best fitting curve between a 
range of points using the method of least 
squares.
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Create Spirals Submenu (Lines/Curves)

Up a Level 

Speed Tables Submenu (Lines/Curves)

Up a Level 

Create Spirals ➤ Create Spirals Submenu

Speed Tables ➤ Speed Tables Submenu

Attach Multiple Draws lines, curves, or spirals off of a 
selected object.

Special Lines Draws symbolic lines with regularly 
spaced text or symbols.

Spiral Type Sets the current spiral type: Clothoid, 
Sinusoid, Cosinusoid, or Quadratic. 

Fit Tangent - Tangent Draws a spiral curve between two 
existing tangents.

Fit Tangent - Curve Draws a spiral curve between an existing 
tangent and a circular curve.

Fit Curve - Curve Draws a spiral curve between two 
existing circular curves.

Attach Spiral Attaches a spiral to an existing object.

Set Table Path Establishes the location at which the 
speed tables will be stored.

Edit Speed Table Edits or creates a speed table.

Create Curves Creates a spiral/curve/spiral using speed 
table values.
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Alignments Menu

Up a Level 

Set Current Alignment Sets the current alignment name.

Define from Objects Defines an alignment made up of spirals, 
curves, and lines to the alignment 
database.

Define from Polyline Defines an alignment made up of a 
single polyline to the alignment 
database.

Station Equations Changes station values for the current 
alignment.

Station Display Format Edits the station display format.

Alignment Labels Edits the alignment label format.

Edit Edits the alignment data.

Import Imports an alignment into the drawing 
from the alignment database.

Delete Removes the current alignment from the 
screen, the alignment database, or both.

Alignment Commands ➤ Alignment Commands submenu

Create Offsets Creates offsets for the current alignment.

Station Label Settings Sets the stationing increments, stationing 
options, and the offset distances for 
labeling.

Create Station Labels Creates station labels for the current 
alignment.

Station/Offset ➤ Station/Offset submenu

Stakeout Alignment ➤ Stakeout Alignment submenu

ASCII File Output ➤ ASCII File Output submenu
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Alignment Commands Submenu 
(Alignments)

Up a Level 

Station/Offset Submenu (Alignments)

Up a Level 

Display Current Displays information about the current 
alignment.

List Defined Lists all the alignments defined within the 
project.

Multiple Selections Selects multiple alignments to delete or 
import.

Modify Properties Changes the description, color, layer, and 
linetype of a selected alignment.

Merge Database Brings an alignment from another 
project into your current project.

Save as .adb Saves the alignment database in the 
older .adb format for use with previous 
versions.

Close Database Closes and unlocks the alignment 
database.

Label Labels the station and offset of points in 
relation to the current alignment.

Display Points Lists the station and offset of points in 
relation to the current alignment.
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Stakeout Alignment Submenu (Alignments)

Up a Level 

ASCII File Output Submenu (Alignments)

Up a Level 

Parcels Menu

Up a Level 

Settings Sets the directional or angular output for 
stakeout commands.

Output Settings Changes the report settings.

Create File Performs a stakeout of the current 
alignment.

Output Settings Changes the report settings.

Alignment Creates ASCII output files of horizontal 
alignment information.

Parcel Settings Establishes the parcel settings such as 
parcel numbering and area labeling.

Parcel Manager Imports, deletes, renames, and creates 
reports for parcels.

Merge Parcels Merges parcel databases from other 
projects with the parcel database of the 
current project.

Define from Lines/Curves Defines lines and curves as a parcel.

Define from Polylines Defines a polyline as a parcel.

Define from Points Defines selected points as a parcel.
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Labels Menu

Up a Level 

Slide Bearing Calculates parcel size by sliding a line 
between two direction lines.

Radial Calculates a parcel size with a line that is 
radial to an existing curve.

Swing on Line Calculates parcel size by swinging a 
bearing line from a known point along a 
line.

Swing on Curve Calculates parcel size by swinging a 
bearing line from a known point to a 
curve.

Break Lines/Curves Breaks crossing parcel boundary lines.

Settings Sets the current label and tag styles and 
label updating options.

Edit Label Styles Changes or creates a label style.

Edit Tag Styles Changes or creates tag labels.

Show Dialog Bar Shows the Style Properties dialog bar.

Add Dynamic Labels Labels objects with dynamic labels.

Update Selected Labels Updates selected dynamic labels.

Update All Labels Updates all dynamic labels.

Swap Label Text Moves label lines to the opposite sides of 
the object.

Flip Direction Reverses the label's direction.

Delete Labels Deletes selected labels.

Disassociate Labels Changes dynamic labels to static labels.
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Add Tables Submenu (Labels)

Up a Level 

Edit Tables Submenu (Labels)

Up a Level 

Add Static Labels Labels objects with static labels.

Label Line By Points Labels a line between two points.

Label Curve By Points Labels a curve defined by points.

Add Tag Labels Labels objects with tag labels.

Add Tables ➤ Add Tables submenu

Edit Tables ➤ Edits Tables submenu.

Label North/East Adds northing/easting labels to the 
drawing for selected locations.

Geodetic Labels ➤ Geodetic Labels submenu

Building Offset Label Labels offset between building and lot 
line.

Line Table Creates a table that lists detailed data 
about lines.

Curve Table Creates a table that lists detailed data 
about curves.

Spiral Table Creates a table that lists detailed data 
about spirals.

Edit Table Layout Changes the layout and text size for a 
selected line, curve, or spiral table in the 
drawing.
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Geodetic Labels Submenu (Labels)

Up a Level 

Terrain Menu

Up a Level 

Re-Draw Table Redraws a selected table for changes to 
the line, curve, or spiral geometry in the 
drawing.

Delete Table Deletes a selected line, curve, or spiral 
table from the drawing.

Geodetic Label Settings Specifies how lines and points are labeled 
with geodetic data.

Label Location Labels points with geodetic data.

Label Line Labels lines with geodetic data.

Terrain Model Explorer Creates and manages surfaces.

Set Current Surface Selects the current working surface.

Save Current Surface Saves changes to the current surface.

Edit Surface ➤ Edit Surface submenu

Surface Border ➤ Surface Border submenu

Surface Display ➤ Surface Display submenu

Surface Utilities ➤ Surface Utilities submenu

Contour Style Manager Creates, modifies, and deletes contour 
styles.

Create Contours Creates contours for the current surface.
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Edit Surface Submenu (Terrain)

Up a Level 

Contour Labels ➤ Contour Labels submenu

Contour Utilities ➤ Contour Utilities submenu

3D Polylines ➤ 3D Polylines submenu

Sections ➤ Sections submenu

Select Current Stratum Selects the current stratum in the project.

Site Definition ➤ Site Definition submenu

Grid Volumes ➤ Grid Volumes submenu

Composite Volumes ➤ Composite Volumes submenu

Section Volumes ➤ Section Volumes submenu

Volume Reports ➤ Volume Reports submenu

Terrain Layers ➤ Terrain Layers submenu

Import 3D Lines Imports TIN lines into a drawing as 3D 
lines.

Add Line Adds new lines to an existing surface and 
forces retriangulation.

Delete Line Deletes TIN lines from the surface.

Flip Face Changes the direction of two triangle 
faces in the surface TIN.

Add Point Inserts points directly to a surface.

Delete Point Removes points from a surface.

Edit Point Edits surface point elevations.
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Surface Border Submenu (Terrain)

Up a Level 

Surface Display Submenu (Terrain)

Up a Level 

Nondestructive Breaklines Creates a breakline along which the 
surface is retriangulated.

Minimize Flat Faces Checks the surface for any triangles that 
have three points on the same breakline 
or at the same elevation.

Raise/Lower Surface Changes surface elevation by adding or 
subtracting an amount.

Paste Surface Pastes a surface into the current surface.

Surface Boundaries Defines the active area(s) of a surface.

2D Lines Inserts a border of 2D lines around an 
existing surface.

3D Lines Inserts a border of 3D lines around an 
existing surface.

2D Polyline Inserts a 2D polyline border around an 
existing surface.

3D Polyline Inserts a 3D polyline border around an 
existing surface.

Settings Changes the surface view settings.

Quick View Creates a temporary display of the 
current surface.

3D Faces Creates 3D faces in grid formation that 
represent a surface.
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Polyface Mesh Creates a polyface mesh that represents a 
surface.

Elevation Settings Changes the surface elevation shading 
settings.

Average - 2D Solids Creates each triangle of the surface as a 
2D solid based on elevation ranges.

Average - 3D Faces Creates each triangle of the surface as a 
3D face based on elevation ranges.

Average - Polyface Creates a polyface mesh from a surface 
based on elevation ranges.

Banding - 2D Solids Creates elevational bands as 2D solids.

Banding - 3D Faces Creates elevational bands as 3D faces.

Slope Settings Changes the surface slope shading 
settings.

2D Solids Creates 2D solids that show the surface 
slopes.

3D Faces Creates 3D faces that show the surface 
slopes.

Polyface Creates a polyface mesh that shows the 
surface slopes.

Slope Arrows Creates arrows that indicate the surface 
slopes.

Grid of 3D Faces Creates 3D faces in grid formation that 
represent a surface.

Grid of 3D Polylines Creates 3D polylines in grid formation 
that represent a surface.
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Surface Utilities Submenu (Terrain)

Up a Level 

Contour Labels Submenu (Terrain)

Up a Level 

Water Drop Displays the trail of a waterdrop as it 
follows the faces of a TIN.

Object Projection Projects selected objects onto the current 
terrain surface.

Label Spot Elevation Labels the elevation of a selected point 
on the current surface.

Label Slope Labels a slope value between two 
selected points on a surface with a text 
label and arrow.

Line of Sight Calculates a line of sight on the current 
surface with the option of setting the 
view.

Fly By Creates a series of slides or views at a 
given height above the surface at each 
vertex along a selected polyline.

End Labels a contour at its end.

Group End Labels selected contours at their ends.

Interior Labels a contour at a selected location.

Group Interior Labels contours at selected locations.

Delete Labels Deletes the indicated labels of selected 
contours.

Delete All Labels Deletes all of the labels of selected 
contours.
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Contour Utilities Submenu (Terrain)

Up a Level 

Convert Polylines Converts polylines to contours. 

Digitize Contours Digitizes contours from a raster image or 
paper map.

Edit Elevation Changes the elevation of a selected 
contour.

Edit Elevations by Layer Changes the elevations of contours on a 
specific layer.

Edit Datum Elevation Changes contour elevations by adding or 
subtracting an amount.

Assign Elevation Assigns elevations to contour lines.

Check for 0 Elevation Checks for contours with a zero 
elevation.

Weed Contour Vertices Adds or subtracts points on contours by 
using weeding and supplementing 
factors.

Copy Finished Ground Copy selected contours or polylines to a 
new layer.

Copy By Slope Offset a selected contour or polyline 
based on a slope and an elevation 
increment. 

Copy By Grade Offset a selected contour or polyline 
based on a percent grade and elevation 
increment.

Offset By Distance Offset a selected contour or polyline 
based on a percent grade and elevation 
increment to a given distance.

Offset By Elevation Offset a selected contour or polyline 
based on a percent grade and elevation 
increment to a given elevation.
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3D Polylines Submenu (Terrain)

Up a Level 

Create by Elevation Create a 3D polyline with elevations from 
a surface or manually entered. 

Create by Slope Create a 3D polyline with elevations 
calculated based on slope/grade 
between vertices.

Create Curb Offset a 3D or 2D polyline with a fixed 
elevation difference.

Create Step Offset a 2D or 3D polyline with a varying 
elevation difference.

Convert to 2D Polyline Convert 3D polylines to 2D polylines, 
applying the first vertex elevation to the 
new polyline.

Convert from 2D Polyline Convert 2D polylines to 3D polylines.

Edit 3D Polyline Graphically edit a 3D polyline.

Fillet 3D Polyline Fillet a 3D polyline by simulating an arc 
with short line segments.

Join 3D Polylines Create a single 3D polyline from separate 
3D polylines that connect at their 
endpoints.

Add Vertices Automatically insert intermediate vertices 
along a polyline based on a maximum 
distance.

Weed Vertices Remove unnecessary vertices from 3D 
polylines to reduce their complexity.

3D Polyline Grade Breaks Graphically display locations along a 3D 
polyline where there are grade breaks.
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Sections Submenu (Terrain)

Up a Level 

Site Definition Submenu (Terrain)

Up a Level 

Multiple Surfaces On/Off Changes the status of the use of multiple 
surfaces.

Define Multiple Surfaces Defines which sections are used for 
creating sections.

Define Sections Defines cross sections to be processed.

Process Sections Processes defined sections and extracts 
their elevations from the surface.

Import Sections Imports processed sections into the 
drawing.

Grid For Sections Superimposes a grid onto imported cross 
sections.

List Elevation Lists the elevation for a point in relation 
to a section.

List Depth Lists the elevational difference between 
two points in a section.

Create Section View Creates quick cross sections and profiles 
of a surface. 

Update Section Views Updates a quick cross sections after 
editing the surface.

Site Settings Changes settings for defining and 
labeling sites.

Define Site Defines an area that will be used in the 
volume calculations.



1158 | Chapter 42 Menus and Commands in AutoCAD Land Development Desktop

Grid Volumes Submenu (Terrain)

Up a Level 

Composite Volumes Submenu (Terrain)

Up a Level 

Section Volumes Submenu (Terrain)

Up a Level 

Site Manager Imports, deletes, and reports site data.

Calculate Total Site Volume Calculates the site volumes using the grid 
method.

Calculate Parcel Volumes Calculates the parcel volumes using the 
grid method.

Grid Volume Ticks Inserts grid markers that show the depths 
cut or fill.

Calculate Total Site Volume Calculates the site volumes using the 
composite method.

Calculate Parcel Volumes Calculates the parcel volumes using the 
composite method.

Sample Sections Samples site data for calculating section 
volumes.

Edit Sections Edits sections that you sampled for a site.

Calculate Volume Total Calculates volumes based on sampled 
sections.

Volume Report Writes volume data to an ASCII text file.
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Volume Reports Submenu (Terrain)

Up a Level 

Terrain Layers Submenu (Terrain)

Up a Level 

Plot Settings Sets the default layers and precision for 
volume sections.

Set Text Style Sets the text style for plotting volume 
sections.

Plot Single Plots a single volume section..

Plot All Plots all volume sections of a site.

Plot Page Plots a range of volume sections.

Site Report Shows the volume report for a site.

Site Table Inserts a table of site volume data.

Site ASCII File Writes site volume data to an ASCII text 
file.

Parcel Report Displays a volume report for selected 
parcels.

Parcel Table Inserts a table of parcel volume data.

Parcel ASCII File Writes parcel volume data to an ASCII 
text file.

Surface Layer Manages the layer that the surface is on.

Border Layer Manages the layer that surface borders 
are on.
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Inquiry Menu

Up a Level 

Range Layers Manages the layers that the surface 
elevation or slope ranges are on.

Contour Layers Manages the layers that contours are on.

3D Grid Layer Manages the layer that a 3D grid is on.

Polyline Grid Layer Manages the layer that a polyline grid is 
on.

3D Projection Layer Manages the layer that 3D projections 
are on.

Water Drop Layer Manages the layer that water drop trails 
are on.

Site Grid Layer Manages the layer that site grids are on.

Volume Ticks Layers Manages the layers that volume ticks are 
on.

North/East Lists the X, Y coordinates and the 
northing /easting coordinates of a 
selected location.

Lat/Long Lists the latitude and longitude of a point 
based on the current zone.

Geodetic Inverse Lists the grid distance, geodesic distance, 
and the geodetic azimuths of a line.

Station/Offset Object Lists the station and offset of any point 
relative to an object.

Station/Offset Alignment Lists the station and offset of any point 
relative to an alignment.

Line/Curve/Spiral Lists data about lines, curves, and spirals.

Roadway Curves Lists data about a roadway curve.
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Utilities Menu

Up a Level 

Railway Curves Lists data about a railway curve.

Spiral Radius Lists the radius of a selected spiral.

Angles Lists the acute and obtuse angles 
between points or intersecting lines.

Continuous Distance Lists consecutive distances.

Add Distances Lists multiple distances.

Area by Lines/Curves Lists the area of a series of selected 
objects.

Area by Polylines Lists the area of a closed polyline.

Area by Points Lists the area bounded by a series of 
points.

Contour Elevation Lists the elevation of a contour line.

Surface Elevation Lists the elevation of a surface at a 
selected point.

List Slope Lists the slope, grade, distance, and 
elevational change between two 
locations.

List Elevation @ Slope Calculates the elevation from a location 
and an elevation at a given distance.

Track North/East Displays northing and easting 
coordinates based on pointer location.

Track Elevation Displays surface elevations based on 
point location.

Object Viewer Controls how you view a selected object 
in your drawing.
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Revisions Submenu (Utilities)

Up a Level 

Notes Adds notes to a drawing.

Revisions ➤ Revisions submenu

Layer Manager Manages drawing layers using advanced 
options.

Symbol Manager Inserts and manages symbols.

Set Text Style Sets the current text style.

Curve Text ➤ Curve Text submenu

Leaders ➤ Leaders submenu

Blocks ➤ Blocks submenu

List/Legends ➤ List/Legends submenu

Curve Solver Calculates curve information based on 
the entry of two known curve values.

Build Selection Set Creates a set of objects using advanced 
selection options.

Edit ➤ Edit submenu

Camera ➤ Camera submenu

Revision Settings Edits the revision settings.

Current Time Displays the date and time information 
about a drawing.

Browse Time Logs Displays the contents of the time log.

Make Time Log Report Creates a report based on information 
from the time log.
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Curve Text Submenu (Utilities)

Up a Level 

Leaders Submenu (Utilities)

Up a Level 

Add Revision Bar Draws a revision bar in the drawing.

Identify Creator Identifies the person who created any 
selected object.

Editor's Additions Highlights all objects created by a 
particular person.

Revision Additions Highlights all objects created in a 
particular revision level.

Daystamp Drawing Places the drawing name, date, and time 
in the current drawing. 

Draw Curve Text Draws text on any curve or circle.

Edit Curve Text Edits text on a curve.

Move Curve Text Moves existing text on a curve to 
another curve.

Leader Settings Sets the current leader settings.

Text Leader Creates text leaders.

Symbol Leader Creates leaders that have associated 
symbols.

Predefined Leaders Creates leaders using predefined leader 
definitions.
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Blocks Submenu (Utilities)

Up a Level 

List/Legends Submenu (Utilities)

Up a Level 

Replace Blocks Replaces a block in the drawing with 
another block in the drawing.

Fix Attributes Updates all of the attributes of a block, 
including the angle, size, and text style of 
the attributes.

Count Blocks Lists all the occurrences of blocks in the 
current drawing.

Label Blocks Labels blocks in the current drawing with 
either the block name or the insertion 
point coordinates.

Make Block Chart Creates a chart of all the blocks in a 
drawing folder.

Insert At Drawing Scale Inserts a block at drawing scale.

Make Template Creates a template that specifies which 
block attributes are used in legends.

Edit Template Edits the template from which you create 
legends.

Extract Attributes Extracts attribute data from blocks.

Import/Update Attributes Imports attributes into the drawing.

Abbreviations Creates an abbreviation list.

Make Legend Creates a selected legend of blocks.

Edit Database Edits the legend data in table format.
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Edit Submenu (Utilities)

Up a Level 

Camera Submenu (Utilities)

Up a Level 

Rescale Blocks/Text Makes blocks and text in your drawing 
larger or smaller.

Flatten Z Values Sets the z coordinate of an object to zero.

Quick Scale Scales selected objects around either 
their base point or starting point.

Layer Scale Scales all objects on a selected layer.

Edge Hide Hides the edges of a 3D face.

Trim/Extend To 3D Face Trims or extends objects to meet a 3D 
face.

Combine 3D Faces with Pface Combines 3D faces to form a single 
polyface.

Explode Retain Properties Explodes a block, but retains the 
properties of the block.

Number Shift Changes sets of attributes that represent 
numbers.

Erase Layer Erases all objects that are on a specific 
layer.

Add Camera Adds multiple camera views in a 
drawing.

Camera Properties Controls how cameras are inserted and 
displayed in a drawing.

Create Camera View Creates a view from an existing camera.
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Help Menu

Up a Level 

Adjust Camera View Adjusts the camera view.

Create Video Creates an avi movie file from your 
drawing.

Help Topics Displays the AutoCAD Land 
Development Desktop help file.

Today Displays the AutoCAD Land 
Development Desktop Today window, 
where you can open drawings and access 
the Internet.

AutoCAD Map Tutorials Starts the AutoCAD Map tutorials.

Land Development Tutorials Starts the Land Development tutorials.

AutoCAD Learning Assistance Starts the AutoCAD Learning Assistance.

Support Assistance Provides technical support resources.

Autodesk User’s Group International Displays the AUGI Web site in the default 
browser.

Buy Online ➤ Displays a Web sites with purchasing 
information for Autodesk products.

About AutoCAD Land Development 
Desktop 

Displays the version of the product, the 
serial number, the licensee, and the name 
and telephone number of the person 
from whom you obtained AutoCAD Land 
Development Desktop.

About Autodesk Civil Design Displays the version and serial number of 
Autodesk Civil Design at the command 
line.

About Autodesk Survey Displays the version and serial number of 
Autodesk Survey at the command line.
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Buy Online Submenu

Up a Level

Buy Online Civil Displays a website with information 
about purchasing Autodesk Civil Design.

Buy Online Land Displays a website with information 
about purchasing Land Development 
Desktop.

Buy Online Survey Displays a website with information 
about purchasing Autodesk Survey.
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AFile List 

This appendix contains a list of files that AutoCAD Land 

Development Desktop creates and maintains.

In this appendix

� AutoCAD Land Development 
Desktop File List
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AutoCAD Land Development Desktop File 
List

������� ���� 	
����
� ��������
� �
����

Projects project.dfm <project> Project specific settings ASCII text file

longfilenamesystem.m
db

<project> Long file name 
correlation database

Microsoft 
Access 
database

<project>.lk# <project> Multi-user 
coordination lock file

ASCII text file

<drawing>.dfm <project>\Dwg Drawing specific 
settings

ASCII text file

Points points.mdb <project>\Cogo Point database Microsoft 
Access 
database

groups.mdb <project>\Cogo Point group database Microsoft 
Access 
database

xdrefs.mdb <project>\Cogo XDRef definition 
database

Microsoft 
Access 
database

default.mdb <project>\Cogo\
DescKey

Default description key 
database

Microsoft 
Access 
database

<name>.mdb <project>\Cogo\
DescKey

User defined 
description key 
database

Microsoft 
Access 
database

<name>.mdb <project>\Cogo\
UserDB

User defined database 
for XDREF

Microsoft 
Access 
database

Default.cor <project>\Cogo Translate/Rotate points 
– history of changes 
made

ASCII text file
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Points
(continued)

<drawing>.cor <project>\Cogo Translate/Rotate points 
- update multiple dwgs

ASCII text file

<project>.lk# <project> Multi-user 
coordination lock file

ASCII text file

<drawing>.dfm <project>\Dwg Drawing specific 
settings

ASCII text file

Alignments Alignment.mdb <project>\Align Alignment database Microsoft 
Access 
database

project.adb <project>\Align Alignment database of 
AutoCAD Land 
Development Desktop 
R1.0x or previous 
versions

Binary data file

<drawing>.ahl <project>\Align Alignment objects 
handle file for 
AutoCAD Land 
Development Desktop 
R1.0x or previous 
versions

Binary data file

align.lk# <project>\Align Multi-user 
coordination lock file

ASCII text file

<drawing>.dfm <project>\Dwg Drawing specific 
settings

ASCII text file

Parcels <project>.gcf <project>\Lots Parcel and Volume 
Sites database file

Binary data file

<drawing>.dfm <project>\Dwg Drawing specific 
settings

ASCII text file

lots.lk# <project>\Lots Multi-user 
coordination lock file

ASCII text file

Labels <drawing>.cgx <project>\Dwg Label settings ASCII text file

Terrain <surface>.sdf <project>\Dtm\
<surface>

Surface settings file ASCII text file

<surface>pnt.txt <project>\Dtm\
<surface>

Surface point data file ASCII text file

������� ���� 	
����
� ��������
� �
����
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Terrain 
(continued)

<surface>brk.bin <project>\Dtm\
<surface>

Contour data file Binary data file

<surface>flt.bin <project>\Dtm\
<surface>

Breakline data file Binary data file

<surface>.pnt <project>\Dtm\
<surface>

Surface model points Binary data file

<surface>.tin <project>\Dtm\
<surface>

Surface model 
definition

Binary data file

<surface>bnd.bin <project>\Dtm\
<surface>

Terrain Model Explorer 
boundaries definition

ASCII text file

<surface>.hdm <project>\Dtm\
<surface>

Watershed 
model definition

Binary data file

<surface>ws.bin <project>\Dtm\
<surface>

Watershed boundary 
file

Binary data file

<surface>ws.txt <project>\Dtm\
<surface>

Watershed 
description file

ASCII text file

<surface>.eds <project>\Dtm\
<surface>

Edit history log Binary data file

<surface>.err <project>\Dtm\
<surface>

Build surface log file ASCII text file

<surface>.xst <project>\Dtm New defined sections 
definition file

Binary data file

<surface>.xsb <project>\Dtm Sections definition file Binary data file

<surface>.xsr <project>\Dtm Processed sections 
data file

ASCII text file

surface.txt <project>\Dtm Multiple surface 
definition file

ASCII text file

strata.txt <project>\er Defined strata list ASCII text file

strata.dfm <project>\er Strata/Volume surface 
list

ASCII text file

<site>.xsd <project> Section volume data 
file

Binary data file

������� ���� 	
����
� ��������
� �
����
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Terrain 
(continued)

<site>.xsp <project> Section volumes 
pointer file

Binary data file

<surface>.lk# <project>\Dtm\
<surface>

Multi-user 
coordination lock file

ASCII text file

<drawing>.dfm <project>\Dwg Drawing specific 
settings

ASCII text file

Utilities passwords.def <project>\job Revisions password list ASCII text file

<drawing>.dbf <project>\job Revision log database dBase 
database

timeman.cdx <project>\pp Drawing revision 
database index file

Binary data file

timeman.dbf <project>\pp Drawing revision 
data file

dBase 
database

timeman.rep <project>\pp Time management 
report

ASCII text file

cr.dfm <project>\cr Leader and 
discontinued settings

ASCII text file

<name>.ssl <user path> Snapshot of layers Binary data file

<name>.ars <user path> Attribute report 
specification file

ASCII text file

<name>.txt <user path> Attribute extraction 
template file

ASCII text file

<name>.txt <user path> Extracted attributes ASCII text file

legend.dbf <project> Legend database dBase 
database

zzsdesk.ly <project> Leader/Legend and 
discontinued layer 
settings

ASCII text file

zzstyle.dat <project> Leader/Legend and 
discontinued text 
settings

ASCII text file

<drawing>.dfm <project>\Dwg Drawing specific 
settings

ASCII text file

������� ���� 	
����
� ��������
� �
����
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Glossary

���������	
� A polyline with all vertices at the same elevation.

�����
 A 3D face is an AutoCAD object that represents the surface of a 3- or 4-sided 
area, with each vertex potentially at a different elevation. You can view TINs (Triangu-
lated Irregular Networks) as 3D faces. Using the SHADE command, you can shade 3D 
faces. Using the RENDER command, you can render the 3D faces.

������� The 3D grid command projects the vertices of a 2D, regularly spaced, square 
or rectangular grid onto a TIN (Triangulated Irregular Network) surface. The calculated 
elevations of the projected vertices are then used to build 3D faces. The smaller the 
grid, the more detailed the representation of the surface becomes.

����������	
 A polyline with vertices at varying elevations.

��������� Vertical 3D faces from the border of the surface to the base elevation. 

��� A special case of the traverse mercator projection. An abbreviation for 3° trans-
verse mercator, it consists of a series of zones, which are each 3° wide in longitude.

�����
 (spirals) The spiral parameter A equals the square root of the product of the 
spiral length and the radius. This parameter measures the flatness of a spiral.

��
 A measure of land: 160 square rods; 4,840 square yards; 43,560 square feet in a 
closed shape of any form.

��
�	�
��	��� A second dimension using another standard of measure. These labels 
are usually placed after the dimension in square brackets ([ ]). A common use of alter-
nate units is to label a line's distance in feet with alternate units of meters.

	��
 The difference in direction between two convergent lines. In surveying, the 
angle is on a horizontal or vertical plane.

Angles are measured in several different ways. The major differences between them are 
the units of angular measurement and how they are referenced. The main units used 
are the degree, radian, and grad. Degrees are the result of dividing a complete circle 
into 360 equal parts. Grads are the result of dividing a complete circle into 400 equal 
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parts. A radian is the angle subtended by an arc with a length equal to the radius of the 
circle.

The two major angular references that are used in AutoCAD Land Development 
Desktop are the azimuth and bearing.

An azimuth angle is referenced from North, and is always measured clockwise. 
South of the equator, however, azimuth angles are not referenced to due north, but 
to due south. 

A bearing angle is measured from either due north or south, with an east or west 
reference angle. For example, the notation N45°45�58� E means that this angle was 
referenced from due north and was turned 45 degrees, 45 minutes, and 58 sec-
onds toward the east. Bearing angles can never exceed 90 degrees (PI/2.0 radians 
or 100 grads). In addition, bearings are usually referenced by quadrant number. A 
quadrant is any of the sections resulting from dividing a circle into four equal 
parts. Quadrant one is considered to be the NE corner, and quadrants 2, 3, and 4 
proceed clockwise.

Also, in AutoCAD, all lines have an angle in the X,Y plane, with 0 degrees typically 
to the right, or 3:00 on the dial, and all angles measured counter-clockwise. 

�� A part of a mathematically defined circular curve.

�
 The quantity of plane space in a horizontal plane enclosed by the boundary of 
any polygonal figure.

����
��������	�
� A set of coordinates assigned to a point that are not the actual 
point coordinates. All points are set relative to these coordinates. For example, the 
coordinates N5000, E5000 can be assigned to the beginning point of a traverse. Later, 
the actual coordinates were found to be N4578.99, E20987.66. Knowing these coordi-
nate values, you can adjust the points relative to the actual coordinates.

����
��
�
����	 An elevation assigned to a base point that is not the actual point 
elevation. All other points are set relative to this elevation. For example, an elevation 
of 200 may be assigned to the beginning point of a traverse. Later, the actual elevation 
was found to be 405.67. Knowing these values, you can re-assign elevations relative to 
the actual, not the assumed, elevation.

������������	�	�
 When you install AutoCAD Land Development Desktop, an 
AutoCAD login name is generated for you. This login name is based on your Windows 
login name, and is used by the program to manage the locfiles for a project.

�
��
�
	���
 A type of Section volume. The most common method of calculat-
ing volumes. The average of adjacent cross section areas is multiplied by the distance 
between them. For drawings that use feet as units, the volume is reported in cubic 
yards; for drawings that use meters as units, the volume is reported in cubic meters.

The following formula is used when you select the average end area volume calcula-
tion method:

S
h

A A= +
2

1 2( )
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�
��
��
���� (Surface Display) You can use the Average method to create surface 
views that show the elevation or slope ranges of a surface. The average method uses a 
centroid-averaging calculation to determine which surface triangles belong in which 
range. This may result in ranges that appear ″saw-toothed″.

See also banding method (Surface Display).

��� One of a set of reference lines for certain systems of coordinates.

������ A clockwise angle measured from a reference meridian. Also known as 
north azimuth. It can range from 0 to 360 degrees. A negative azimuth is converted to 
a clockwise value.

See also south azimuth.

�������� A previously established point used as a direction reference to another 
point. A survey instrument's movements typically are locked to an angle of 0 degrees, 
and the vertical crosshair is set on the backsight. All subsequent shots are then taken 
by turning the instrument and the upper movement together, while the lower move-
ment stays set on the backsight. All angles measured are, therefore, relative to the back-
sight.

�	��	���
���� (Surface Display) You can use the Banding method to create sur-
face views that show the elevation or slope ranges of a surface. The Banding method 
splits surface triangles based on elevation ranges to create smooth bands. 

See also average method (Surface Display)

��
�
�
����	 A reference plane for 3D skirts and the vertical factor for a surface. 3D 
skirts use the base elevation to determine the elevation at the bottom of the 3D skirts. 
If you apply a vertical factor for scaling a 3D view of a surface, then the surface is scaled 
vertically from the base elevation.

��
����	� The point of coordinate control for the AutoCAD Land Development 
Desktop coordinate system. This is the point on the Northing/Easting grid that is 
assigned to a point on the AutoCAD World Coordinate System X,Y grid. The base point 
setting is specific to each individual drawing, and typically starts with North = 0, East 
= 0 set on AutoCAD's X = 0, Y = 0. 

You can use the base point setting to assign any northing/easting coordinate to any 
X,Y coordinate, effectively moving (but not rotating) the northing/easting grid over 
the X,Y grid. The northing/easting coordinates of the points in the database are 
unchanged by a base point manipulation. This feature is sometimes used when work-

Variable Value

S volume

h distance between 
sections

A1 area of section 1

A2 area of section 2
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ing with a dataset with high coordinates to move the area of the northing/easting grid 
closer to AutoCAD's 0,0.

�
��	� An angle measured from North or South, whichever is nearest, with the 
added designation of East or West. The angle is always less than 90 degrees (ππ/2 radi-
ans or 100 grads) and is usually referenced by quadrant number. For example, the nota-
tion N45°45�58� E means this angle was referenced from due North and was turned 45 
degrees, 45 minutes, and 58 seconds toward the East (in the first quadrant).

���	��� (surface) A closed 2D or 3D polyline that limits the triangulation of the 
digital terrain model by not allowing TIN lines to cross it. Most common are surface 
boundaries constructed just outside the extremities of the dataset, eliminating 
unwanted interpolations across empty space where the surface has a concave shape. 
You can also use two types of internal surface boundaries: hide boundaries, to punch 
holes in a surface, (for example, a building footprint), or show boundaries, to create 
smaller surfaces by eliminating areas that fall outside the boundary. 

��
���	
 A breakline is used to connect the data representing a distinct surface fea-
ture, like a ridge line, edge of pavement, toe of a slope, centerline of a road, or flowline 
of a ditch or stream. When a breakline is defined, the surface triangulation must follow 
the breaklines first, by placing triangle edges coincident with the breakline segments. 
This ensures the feature in the model is accurately depicted. The rest of the interpola-
tion is then performed based on proximity. Breaklines are typically critical to creating 
an accurate surface model, because it is the interpolation of the data, not just the data 
itself, that determines the shape of the model.

In previous versions of Softdesk Civil/Survey software, breaklines were called faults.

��
���	
����	�� A breakline point is a point of surface data included in the defined 
breakline's list of vertices.

����
 For contours that contain curves, the bulge value is a maximum mid-ordinate 
distance along a polyline curve. If the mid-ordinate distance is longer than specified, 
then points are added to better define the shape of the curve. 

Polyline curves are not actually curves; they are small, straight segments that 
mimic the appearance of a curve. The bulge factor can add more vertices to a 
polyline curve, making it appear more curve-like. The smaller the value, the more 
vertices are added.

Used when creating contour data for a surface; not for creating contours.

�����
	���
 The area tributary to a lake, stream, or drainage system.

�
	�
���	
 (CL) The center of an alignment. Road lanes are created by offsetting the 
centerline a specified distance. When designing roadway templates, the centerline is 
usually the finished ground reference point.

 !�" The following illustration labels the central angle of a circular arc as Lc:

{bmc ha-def-3.bmp}

�
	�����
����	 The longitude of the origin of a map projection. For example, if 
you use the Transverse Mercator projection, the cylinder touches the Earth at a single 
line of longitude: the central meridian. For minimum distortion, the central meridian 
should be in the center of the area you are mapping. It is used only for transverse mer-
cator projection types. 
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����� A straight line connecting two points on a curve: the Point of Curvature (PC) 
and Point of Tangency (PT). The curve joins with a line or another curve at these 
points.

See also length of the long chord of an arc.

�������������� A spiral in which the curvature function is a linear function chosen 
such that the degree of curve is zero (0) where the spiral meets the tangent. The func-
tion then increases linearly until it equals the degree of the adjacent curve at the point 
where the spiral and curve meet.

�#$# Short for Coordinate Geometry.

�#$#����	����%
�� The point objects that you create using the Points menu com-
mands (and other AutoCAD Land Development Desktop commands that create 
points) can have several pieces of information associated with them. The point object 
has a point node and a point number, northing and easting values, elevation, descrip-
tion, and optional name. The point data is stored in an external point database, and 
all elements of a point object are inserted on the same drawing layer unless description 
keys are used. 

Replaces point blocks in earlier versions of Autodesk Civil/Survey programs.

See also point database.

������	���
�� When you are prompted to enter a color number either at the com-
mand line, or in a dialog box, you can type the following numbers of the standard 
Windows colors:

In addition, you can use any other color number from 0-255.

��������
������
������
� The composite volume method creates a surface that 
represents the depth of cut and fill over the site. You can use any of the Terrain com-
mands that generates information based on a surface with the composite surface. For 
example, you can create contours or points based on depth of cut and fill.

When you calculate the volumes using this method, the surface is re-triangulated 
based on points from both surfaces. This method uses the points from both surfaces, 
as well as any location where the triangle edges between the two surfaces cross. It then 

Number Color

1 Red

2 Yellow

3 Green

4 Cyan

5 Dark blue

6 Magenta

7 Black or white, depending on the 
background color of AutoCAD
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calculates the new composite surface elevations based on the difference between the 
elevations of the two surfaces.

������	������
 A curve consisting of two or more arcs of different radii curving in 
the same direction, which have a common tangent or transition curve at their point 
of junction.

������	������� A spiral that provides a transition between two circular 
curves of different radii.

��	���������%
����	 Projection types that preserve local angles. For example, the 
Lambert Conformal Conic projection. Conformal maps distort areas although shapes 
are true. 

{bmc lambert.bmp}

��	������%
����	 To visualize a conic projection, imagine a piece of paper wrapped 
onto a cone around the Earth, and the Earth's surface projected onto the surface of the 
paper cone. There is no distortion along the line where the cone touches the Earth's 
surface. 

This projection type is used as the basis of the Lambert Conformal Conic projection, 
shown in the following illustration.& 

{bmc lambert.bmp}

��	���� An imaginary line that connects points of the same elevation or value rela-
tive to a specified reference datum.

��	������� Contours are one of the four major categories of data (others are 
points, breaklines, and boundaries), that you can use to build a surface. Contour data 
is unique inasmuch as it is the only data type that weeding and supplementing factors 
are applied to. The Create as contour data check box in the Contour Weeding dialog 
box actually determines whether the contours are defined as point data (unchecked), 
or breakline data (checked). 

��	�
��
	�
 As meridians (lines of longitude in a standard Mercator projection) pass 
from the equator to the poles, they get closer together until they meet at the poles. 
This is called convergence. In state plane coordinate systems, the convergence angle is 
the difference between a geodetic (local) azimuth and the projection of that azimuth 
onto a grid (grid azimuth). Also called mapping angle.

geodetic azimuth = grid azimuth + convergence + second term (also known as t-T cor-
rection)

������	�
�����
�� Also called X, Y, Z point filters, coordinate filters are used to 
extract individual X, Y, and/or Z coordinate values from different points to create a 
new, composite coordinate.

See also point filters. 

������	�
���	��������	 Also known as geodetic transformation. A coordinate 
transformation converts values established in one coordinate system and translates 
them to another. 

������	�
� By its mathematical definition, a point is a geometric entity with no 
length. To specify exactly where that point is in space, you must specify its location in 
three different coordinate planes: X, Y, and Z; or Northing, Easting, and Elevation. This 



Glossary | 1181

is based on the system called Cartesian coordinates developed by the French mathe-
matician, Descartes.

����	
������ A spiral in which the curvature function is a cosine function chosen 
such that the degree of curve is zero (0) where the spiral meets the tangent. The func-
tion then increases until it equals the degree of the adjacent curve at the point where 
the spiral and curve meet.

�������
����	 Section views taken at a 90-degree angle to the alignment.

����
�����
����	 In volume calculations, the length between the end areas on hori-
zontal curves is taken from the length along the centerline curve. With curve correc-
tion, the length is taken from the path of the area's average centroid for a more accu-
rate result.

����
��������� (CS) A point where a curve meets a spiral is labeled as a CS.

����	���������%
����	 To visualize a cylindrical projection, imagine a sheet of paper 
wrapped around the Earth at the equator, and the Earth's surface projected onto the 
cylindrical sheet from the center of the Earth. The data on the paper is clearest and 
least distorted where the paper touches the surface of the Earth (at the equator), but is 
most distorted at the poles.

This type of cylindrical projection is used by the standard Mercator projection and 
is often used for maps of the whole world, resulting in exaggerated land sizes near 
the two poles.

���� A reference value. All elevations or coordinates are set relative to this value. 
In surveying, two datums (horizontal and vertical) are generally used.

For global coordinate systems, a datum refers to the ellipsoid information and the 
techniques used to determine positions on the Earth's surface. An ellipsoid is part 
of a datum definition.

�
������
��

 One of the five AutoCAD choices for degree units, decimal degrees 
express the minutes and seconds of an angle as its decimal equivalent. For example, 
3°30′36″ equals 3.51 decimal degrees.

In contrast, when using the DD.MMSS convention, in which the numbers after the 
decimal are read as minutes and seconds, not decimal degrees, 3°30′36″ is entered 
as 3.3036, not 3.51. Care must given not to confuse the two methods, as they 
clearly yield very different results. 

See also degrees, minutes, seconds.

�
���	���	 The angle between the equator and a point on a great circle perpendic-
ular to the equator.

See also great circle.

�
��
����	�	��
 A horizontal angle measured from an extension of the preceding 
line, right or left.

{bmc S-O-ANGL.BMP}

�
��

�����������
'& (D) The following illustration labels the degree of curvature of 
a circular arc Lc:

{bmc ha-def-3.bmp}
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�
��

�(���	��
�(��
��	�� (DMS) A representation of an angle in degrees, minutes, 
and seconds in which a full circle contains 360 degrees, each degree 60 minutes, and 
each minute 60 seconds. A typical bearing in DMS measurement looks like: 
N45°45�58�E. Using this format, 3°30�36� is entered as 3.3036.

�
����	��
�������
�����
����	 The correction added to Universal Coordinated 
Time (UCT) to get UT1 time.

�)� A Digital Elevation Model (DEM) consists of an array of elevations taken on a 
regularly spaced horizontal grid. You can get USGS (United States Geological Survey) 
topographic data in this form. 

�
��������	��
�� When new point data is created in the point database, regardless of 
the method you use, the descriptions that you enter can be checked against a user-
defined list of description keys. These consist of case-sensitive, literal character strings, 
with or without wildcards. Depending on how you set up the description keys, if a 
match is found, then:

� The current description can be replaced with an alternate description of up to 254 
characters.

� The COGO point in the drawing that represents the record in the point database 
can be assigned to a specific layer.

� A symbol can be placed at the node of the point.

� The symbol can be assigned to a specific layer.

Using description keys to translate descriptions can help standardize point data if a 
variety of data sources are used. For example, descriptions of EROAD, EPAVE, ERD, and 
EDGEROAD can all be changed to EOP. The other layer and symbol options can greatly 
enhance automatic base plan generation and the overall organization of the drawing 
file.

�������
 To digitize a paper drawing is to convert it into AutoCAD vector objects. Dig-
itizing has traditionally been done by taping a paper drawing onto a digitizing tablet 
and tracing over it using AutoCAD commands. 

Alternately, you can trace bitmap files that are inserted in the drawing. Tracing bitmaps 
onscreen with AutoCAD commands is referred to as heads-up digitizing. 

Whatever the method used, the end result is AutoCAD objects that you can place on 
layers, edit, and use as a data source for design work.

����	�
 A length between two points. It can be expressed as either feet or meters, 
and can be a horizontal or slope distance. In some functions, a negative distance 
reverses direction.

��*�	���
���	�� Drawing settings control many different command parameters in 
AutoCAD Land Development Desktop. Each drawing in a project can have its own 
drawing settings. Drawing settings are broken down by feature. For example, there are 
drawing settings for points, terrain, and so on. 

��*�	���
����
 You can base a new drawing on a drawing template. A drawing 
template is a drawing file with pre-established settings for new drawings and has the 
extension .dwt. For example, you can set up all your standard layers in a drawing and 
save the drawing as a .dwt file. If you base a new drawing on this template, then the 
new drawing is created with all your standard layers. Templates also store text styles, 
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line types, dimension styles, and AutoCAD variables like Aperture. They can also store 
blocks, such as a border or a company logo. 

A template also stores drawing setup values. For example, if you use the Drawing 
Setup Wizard or the Drawing Setup command to set up a drawing, and then save 
that drawing as a .dwt file, then the next time you create a new drawing based on 
the drawing template, all of the drawing setup values will be loaded.

��	������
�� Dynamic labels are labels that can change position, content, or style 
after you create them. Dynamic labels have the ability to auto-update whenever you 
edit the object the label is associated with, or whenever you edit the style of the label. 
You can turn off auto-updating options, and use commands to update the labels if 
desired. Or, you can convert the dynamic labels to static labels if you never want them 
to be updated.

See also static labels.

)����
� (superelevation) The maximum allowable superelevation rate in either ft/ft 
or m/m. An E value of 0.10 equals a 10 percent grade.


���	� A linear distance eastwards from the North-South line which passes through 
the origin of a grid. Equivalent to the X coordinate in an X, Y, Z coordinate system. 


��
	������� (e) In a conic, the ratio of the distance from any point on the conic to 
a focus to its distance from the directrix. The following formula calculates the eccen-
tricity of an ellipse:

where a is the semi-major axis and b is the semi-minor axis. The eccentricity for an 
ellipse is always less than one (1).

)�)+ XYZ Cartesian Earth Centered Earth Fixed.


����������� When you edit a surface, your edits are recorded in an edit history 
which you can play back when you rebuild the surface. When the surface is rebuilt, the 
same edits are made in the order you made them. 


�
����	 The vertical distance from a datum to a point or object on the Earth's sur-
face. The datum is generally considered to be at sea level.


�
����	��	��	� The process of dividing a surface into user-defined elevation 
ranges and creating 2D solids or 3D faces on separate layers to represent the part of the 
surface that falls within each range.


�������� An ellipsoid is an approximation of the shape of the Earth at sea level. It 
does not account for the irregularity of the Earth's shape.

The rotation of the Earth generates a centrifugal force that causes the surface of the 
oceans to protrude more at the equator than at the poles. Thus the Earth's shape is not 
a sphere but closer to a 3D ellipse, or ellipsoid. This term, synonymous with spheroid, 
is used to describe the shape of the Earth. 

An ellipsoid is used as part of a datum definition for a global coordinate system. 

See also geoid.

e
a b
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	����	�����	� Refers to the symbol at the end of lines or other objects. End condi-
tion symbols can be arrows, crows feet, and so on.


	���� Synonymous with object. Any vector object that appears in the drawing. 


,����	� (stationing) Station equations are used to define points on an alignment 
where stationing is discontinuous.


,������	�����%
����	 Projections that preserve distances. On an equidistant map, 
distances are true along lines radiating only from the center of the projection. 


,����
	�����%
����	 Projections that preserve area are called equivalent or equal-
area projections. Equal-area maps distort shapes. 


���� The difference between a quantity's observed or computed values and its ideal 
or true value.


�����	������	� An undeveloped terrain as it currently exists.


��
�	���
�	�����������������'& (Ec) The following illustration labels the exter-
nal secant of a circular arc Ec :

{bmc ha-def-3.bmp}

��
 A three-dimensional (planer) surface triangle. A face is represented by either a 
3D face object or 3D line objects.

��
� The planar face of a grid cell. Each grid cell has one, two, or four facets. 

���
�
���	� An easting value used in a global coordinate system to force all eastings 
to be positive numbers. 

For example, if you use the Transverse Mercator projection, and the central meridian 
bisects the mapping region, then half the X coordinates are negative values. Coordi-
nate system definitions usually include a false origin that is added to all coordinates to 
make them positive.

���
�	�����	� A northing value used in a global coordinate system to force all 
northings to be positive numbers. A false northing value may not be necessary if you 
establish the map's zero point for the Y origin outside and to the south of the region 
you are mapping.

��	���
������	� A digital terrain model of a proposed final design, and the represen-
tation of that surface as linework on a profile or section. The proposed or actual terrain 
model of a developed terrain. 

���� Unit of linear measurement. An international foot is based on the conversion 1 
in. =2.54 cm. while a US survey foot is based on 39.37 in. =1 meter.

���������	����	�������� Symbols you can use to create labels that show specific 
values. For example, you can use a multiplication formula function symbol to multiply 
feet by .3048 to get meters. This is helpful if your dataset is in feet, but you want the 
plotted design to show both feet and meters.

������
��������	 The description of a point after any point description key substitu-
tion has occurred.

See also raw description.

� Acceleration due to gravity, ft/s2 or m/s2.
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�
��
��� On a surface, the shortest line between two points. The line or curve from 
one point along an ellipsoid to another.

�
��
�� The science that determines the Earth's size and shape and the exact posi-
tions of points on its surface.

�
��
��� Signifies a basic relationship to the Earth that takes into account the curva-
ture of the Earth's sea level surface. For example, a geodetic distance is a distance or 
angle in which the Earth's curvature is taken into account, versus a distance or angle 
measured on a flat paper map. 

�
��
�������*�� A technique that locates or establishes a point on an ellipsoid, 
given both an initial starting point or location and a geodesic distance and direction 
from the existing starting point. Also called geodetic direct.

�
��
�����	�
��
 The geodesic distance and direction from one point to another, and 
the geodesic azimuth at each point.

�
��
������	��������	 Also known as coordinate transformation. Converts val-
ues established in one coordinate system and translates them to a different coordinate 
system. 

�
��� An ellipsoid with a highly irregular surface. Describes the non-uniformity of 
the Earth's shape. To avoid the geoid's mathematical complexity, cartographers instead 
use the ellipsoid model as their mapping reference.

See also ellipsoid.

������������	�
�����
� Describes how the Earth's sphere is projected onto a sheet 
of paper and converted to the Cartesian coordinate system. A global coordinate system 
can differ based on the projection type, datum, and units that are used. For example, 
a global coordinate system can be based on the Lambert Conformal Conic projection, 
the North American Datum of 1983, and metric units.

���
 The slope of a surface, with the vertical rise or fall expressed as a percentage of 
the horizontal distance.

���� A system of measure in which one grad equals 1/100 of a 90° angle, or 360° = 
400 grads.

��
�������
 A circle described on the sphere's surface by a plane which includes the 
sphere's center.

��

	*���������	��
 Local hour angle at the Greenwich meridian.

��

	*�����
	����
 Mean solar time at the Greenwich meridian.

���� A system of lines parallel to a given set of axes at a specific spacing. Grids are 
used in AutoCAD Land Development Desktop to visualize surfaces and calculate vol-
umes. A grid is also used for geodetic purposes.

����������� At the point of observation, the angle in the projection's plane mea-
sured between the central meridian of the plane coordinate projection system and a 
line containing the object sighted.

���������	�
 The distance between two points based on a coordinate zone, not on 
local northing and easting coordinates.

�����
���	� The easting coordinate based on a selected coordinate zone, versus the 
local easting, which is based on the surveyor's base point.
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����������
 The dimension of the grid cell in the M direction (equivalent to the 
drawing's X-axis if grid rotation angle is 0).

�����	����
 The dimension of the grid cell in the N direction (equivalent to the draw-
ing's Y-axis (if the grid rotation angle is 0).

�����	�����	� The northing coordinate based on a selected coordinate zone, versus 
the local northing, which is based on the surveyor's base point.

��������
������ The value used to reduce (or enlarge) a local (geodetic) distance so 
that it equals the grid distance. The scale factor is applied to geodetic units to obtain 
grid units.

grid distance = geodetic distance � scale factor

Each point has a different grid scale factor. 

����������
������
� The grid method of volume calculation measures the differ-
ence in elevation between two surfaces at each intersection in a user-defined grid. If 
only one surface exists at a grid intersection, then that point is not used in the volume 
calculation. Surface 2 in the defined stratum is always compared to surface 1. If surface 
2 is lower than surface 1, then it is a cut condition, and if surface 2 is higher than sur-
face 1, then it is a fill condition. 

The difference in elevation between the surfaces at all the usable grid intersections 
is then used as the Z value for a new grid surface data point. For example, a grid 
point with a fill condition of 2.3� generates a surface data point with an elevation 
of 2.3, a grid point with a cut condition of 1.7� generates a surface data point with 
an elevation of -1.7. AutoCAD Land Development Desktop then builds a grid vol-
ume surface, and compares it to a flat plane surface at elevation 0 to determine 
the cut and fill volumes. 

��������� A mark made at each sampled location in a volume grid. The ticks are 
placed on two different layers, depending on if they represent a cut condition or a 
fill condition, and are typically accompanied by labels showing the amount of cut 
or fill, similarly placed on separate layers. You can then use the ticks and labels to gen-
erate a color-coded graphic depicting the areas and amounts of cut and fill earthwork.

-�./ High Accuracy Reference Network. HARN files are used to transform data from 
one coordinate system to another. HARN files that contain latitude data have a .las file 
extension; files that contain longitude data have a .los file extension.

�
���
 A measure of area, generally relating to land, of 10,000 square meters or 
approximately 2.47 acres.

������	������	�
	� A series of 2D coordinates (northings and eastings), con-
nected by lines, circular curves, and/or spiral curves, that AutoCAD Land Devel-
opment Desktop stores as an external data file. This defined alignment, in con-
junction with a surface, can produce the station, offset, and elevation data needed 
to generate profiles and/or cross-sections. You can station the horizontal align-
ment and create parallel offsets to represent features such as edges of pavement, 
sidewalks, or right-of-ways. 

������	������
 In the drawing setup, the horizontal scale controls the size of anno-
tation placed in the drawing, including text, scaled blocks, and special lines. It does 
not affect the line lengths or point coordinates because they are always defined in real 
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world coordinates, not to any scale. Neither does it affect the design data in the draw-
ing or project files.

If you change the horizontal scale in the middle of a drawing session, then any 
annotation added subsequently is scaled accordingly. 

�	�
�����
 The process of calculating the elevation of any point on an infinite imag-
inary line that passes through two known horizontal and vertical control points. 

�	�
��
����	 The point where two or more lines, arcs, figures, or objects join or cross 
in two- or three-dimensional space.

���
�����	��������	�� To visualize a conic projection, imagine a piece of paper 
wrapped into a cone around the Earth's diameter, and the Earth's surface projected 
onto the surface of the paper cone. There is no distortion along the line where the cone 
touches the Earth's surface. This projection type is the basis of the Lambert Conformal 
Conic projection, which is good for zones with East-West orientation. 

{bmc lambert.bmp}

������
 The angular distance measured on a meridian north or south from the equa-
tor.

�
����,��
� A method of balancing a traverse in which the squares of the differ-
ences between the unadjusted and adjusted measurements (angles and distances) are 
summed and reduced to a minimum. This method uses the error specifications in the 
current equipment settings to determine the expected source of errors, and weights the 
individual measurements accordingly.

�
	�������	���'& (L) The length of an arc is labeled L in the following illustration:

{bmc ha-def-3.bmp}

��
	���������
���	�����������	���'& (LC) The length of the long chord of an arc is 
labeled LC in the following illustration:

{bmc ha-def-3.bmp}

�
	����*
����
�������������	 A vertical adjustment that distributes the vertical 
closing error to each line, at the same ratio as the length of that line is to the total 
length of the traverse (similar to the Compass rule).

�
�
��	� Methods and procedures by which the elevation of points are measured.

��	
��������� The line of sight between a fixed position and a target on the surface. 
You can either place the fixed position and the target directly on the surface or at a 
height above the surface. 

�����
���	� The easting coordinate based on the surveyor's assumed horizontal 
base point, versus the grid easting, which is based on the global coordinate zone.

�����
�
����	 The elevation coordinate based on the surveyor's assumed vertical 
base point, or benchmark, versus a real world elevation value.

�����	�����	� The northing coordinate based on the surveyor's assumed horizontal 
base point, versus the grid northing, which is based on the global coordinate zone.

��	�����
 The angle between the plane of a given meridian and the plane of the 
Greenwich meridian.
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�����
����	 The M and N directions are used for defining grids in AutoCAD Land 
Development Desktop, due to the fact that a grid rotation angle can cause the grid axes 
to be different from either the X-Y axes or the Northing/Easting axes in the current 
drawing. The m direction is roughly equivalent to the X direction.

������%
����	 A systematic means of producing part of the Earth (ellipsoid) on a 
flat grid, which is established by mathematical computation.

�
	�
�
����	 The average elevation computed within the limits of the surface 
border or boundary.

�
���������%
����	 The mercator projection uses the standard cylindrical projec-
tion type and is often used for maps of the whole world. It is the only projection in 
which a straight line represents a true direction, but distances and areas are greatly dis-
torted near the poles. Mercator projections can be standard (the straight line is at the 
equator), oblique (the straight line is at an angle to the equator), or transverse (the 
straight line matches a longitudinal line).

�
�
� The basic metric measurement of length. In comparison to the international 
foot 1 in. = 2.54 cm.

�$.0 Military Grid Reference System.

�����
�����	�
 On a circular arc, the distance from the midpoint of the chord to 
the midpoint of the subtended arc. 

In the following illustration, Mc is the middle ordinate for the circular arc:

{bmc ha-def-3.bmp}

���� A unit of angular measurement equal to 1/6400 of 360°.

��	����
�������
� Minimizing the flat faces of contours helps to ensure that trian-
gulation does not occur from one point on a contour to another point on the same 
contour, creating flat ridges. A typical example is on a site that includes finger-like con-
tours such as you might find along a stream. Minimizing flat contours prevents the 
surface model from triangulating between a contour on one side of the stream and a 
contour on the other side of the stream. Formerly known as optimize contours. 

	����
����	 The M and N directions are used for defining grids in AutoCAD Land 
Development Desktop, due to the fact that a grid rotation angle can cause the grid axes 
to be different from either the X-Y axes or the Northing/Easting axes in the current 
drawing. The N direction is roughly equivalent to the Y direction.

/����1���	
 North American Datum of 1927. A datum acts as a reference point, 
line, or surface for mapping. In general, NAD 27 uses feet as its unit of measurement.

/���2����	
 North American Datum of 1983. A datum acts as a reference point, 
line, or surface for mapping. In general, NAD 83 uses meters as its unit of measure-
ment.

/$0 National Geodetic Survey.

	�	3�
��������
���
���	
 Triangulation lines in a TIN do not cross a non-destruc-
tive breakline. Instead, new vertices are added to the breakline at the intersection of 
each TIN line and the breakline. The new points create additional surface triangles. 
This is useful when you do not want the elevation of a surface to be interpolated inside 
an area that you know to be a constant elevation.
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	�����������	 Means of specifying a north rotation or direction in AutoCAD draw-
ing files. Bearings and azimuths are referenced from the drawing's north rotation.

��%
�� Any 2D or 3D vector figure that is displayed graphically in the drawing. This 
includes contours, points, lines, arcs, polylines, and so on.

����,�
�����	���������%
����	 To visualize an oblique cylindrical projection, imag-
ine that a sheet of paper is wrapped around the Earth at an angle to the equator. The 
data on the paper is clearest and least distorted where the paper touches the surface of 
the Earth. This can be any angle to the equator other than 90°° or 270°°. At 90°° and 
270°°, the projection type is called the Transverse cylindrical.

This type of projection is used by the Hotine Oblique Mercator projection and is often 
used for mapping the Panhandle of Alaska. 

The following illustration shows the cylinder wrapped around the Earth in an oblique 
great circle. The areas closest to the circle (where the paper touches the Earth) have the 
truest values.

{bmc o-mercat.bmp}

����
������	�
 A perpendicular distance from an object or point to a reference line 
or arc.

����
� A distance measured, usually at a right angle from an established line, that is 
used to locate a new position. A positive number indicates a right offset, a negative 
number indicates a left offset.

����
�� Can represent such things as edges of pavement, sidewalk lines, and shoulder 
lines for a road. You create these as either symmetric or asymmetric offsets from the 
alignment.

���
� A discrete piece of land. For example, a subdivision is comprised of numerous 
parcels. Synonymous with lot.

���
�� When you specify a pixel value for point markers, it means that the point 
marker will always be that number of screen pixels, no matter what your screen reso-
lution is set to or what zoom level you are using.

This is because your computer monitor has a resolution which is based on pixels (or 
dots) per inch. The higher the resolution, the more pixels are displayed on screen. For 
example, a screen resolution of 800 x 600 means that your monitor is showing 800 pix-
els by 600 pixels. 

A point marker that is 10 pixels will look smaller on a monitor that is set to a resolution 
of 1024 x 768, and larger on a monitor that is set to a resolution of 800 by 600.

���	������
 AutoCAD Land Development Desktop uses a project point database 
to store the point information for a project. This file is named points.mdb and is stored 
in the project's \cogo folder (for example, c:\Land Projects R2\<project name>\cogo). 
AutoCAD Land Development Desktop will prompt you to set up this point database 
whenever you start a new project. 

� Multiple people working over a network can have access to the point database. 

� You can erase points from your drawing and the information will still exist in the 
database. This means that you can work with project points from the database that 
are not in the drawing or insert the project points into your drawing at any time.
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� The point database is editable by many common spreadsheet and database pro-
grams, like Microsoft Access.

���	������
�� Key combinations that you can use to select COGO point objects in spe-
cific ways.

� Type .g (dot g) to select a point by clicking on it.

� Type .p (dot p) to select a point by typing the point number.

� Type .n (dot n) to select a point by typing its northing and easting coordinates.

A point filter remains active until you turn it off by entering either the point filter 
again or another point filter.

���	������� Point groups are used to group the points in the project into smaller, 
more manageable units. You can use point groups for selecting points you want to edit, 
or for specifying which points to use in a surface. For example, you can create a point 
group that contains all of the points in a project or only those points that represent 
existing ground elevations. 

Point groups are a collection of point numbers. When you use a point group, the point 
data is pulled from the point database for each point number in the group.

The point group definitions are stored in c:\Land Projects R2\<project 
name>\cogo\<groups.mdb>.

���	������ A point group is comprised of a point list. A point list contains the point 
numbers of all the points that you want to be in a group.

See also point group.

���	��������	 When you are prompted to select a point from your drawing, you can 
select any location in your drawing, regardless of whether it is actually a COGO point 
object. This location is called a point location.

���	�����
� A point marker is a point location marker (like a dot or a �) and text 
that usually indicates the point number, point description, and point elevation. When 
you create COGO points, point markers are created to represent the points on the 
AutoCAD graphics screen. 

���	��	��
 You can place point nodes in a drawing by using the AutoCAD POINT 
command. Point nodes are useful as reference points that you can snap to. You can 
specify a full three-dimensional location for a point. The current elevation is assumed 
if you omit the Z coordinate value. Also you may change the appearance or size of a 
point objects using the AutoCAD PDMODE or PDSIZE command. 

A point node is made up of only a point symbol and X,Y,Z data and is placed on the 
current layer. It does not have any associated northing, easting, or elevational data 
associated with it. It does not store point information in an external database. 

See also COGO point object.

���	������������
 (PC) The point where an arc is drawn from a tangent.

���	������	�
��
����	 (PI) The point where two tangents meet on a horizontal align-
ment. Curves and spirals also have points of intersection, which are based on where 
the tangents would meet if they were extended outward. 

The following illustration shows points of intersection for curves and spirals. 
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{bmc HA-DEF-5.bmp}

���	������	�
	�� (PT) The point where a curve meets a tangent.

���	������
�������	�
��
����	 (PVI) The point where two tangents meet on a vertical 
alignment.

������ A star in the constellation Ursa Minor (Little Dipper) also known as the North 
Star. It is well situated for determining an astronomic azimuth.

������
 A 3-dimensional (polygon) mesh object. Each face is capable of having 
numerous vertices. 

��
�����	 The number of decimals to the right of the decimal point. For example, 
49.96 has a precision of two.

����
��
����	 The meridian at 0 degrees longitude. The prime meridian runs 
through the original site of the Royal Observatory at Greenwich, England, and is also 
known as the Greenwich meridian. 

���������������
� A type of Section volume. When using this method, a regular 
grid is overlaid on the two surfaces. The elevations on both surfaces are calculated at 
each grid intersection. The resulting face is then broken into two triangular prisms. 
This method is most accurate when both surfaces have some amount of variation 
within them.

The following formula is used when you select the prismoidal volume calculation 
method:

������
 A longitudinal section based on a horizontal alignment. Also, vertical section 
of the surface of the ground along any fixed line - usually parallel to the centerline.

���%
�� A project is a way to help you organize all the drawing files and support data 
files and settings that are associated with each job that you work on. This is done 
through a directory structure that AutoCAD Land Development Desktop maintains for 
you. This directory structure is called a project.

Variable Value

V volume

L distance between

sections

A1 area of section 1

A2 area of section 2

V
L

A A A A= + +
3

1 1 2 2( * )
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Every drawing is assigned to a project. A project can contain many drawings that share 
the same project files like the point database, the alignment database, the parcel data-
base, and surface files.

���%
����
�*���� To quickly locate a project, you can assign keywords to it. Then 
when you are trying to locate the project among many different projects, you can use 
the keywords to filter the list of projects. For example, you can assign a keyword of 
State to all state projects. Then when you are trying to locate a state project, you can 
use the keyword filtering option to show only state projects in the project list.

��������
 A prototype is a saved group of settings that you base a project on. You 
select a prototype every time you create a new project. Default prototypes are included 
with AutoCAD Land Development Desktop: one is based on feet, another on meters. 

You can save drawing settings to a prototype. After you save drawing settings to a pro-
totype, then all new drawings that you create, based on that prototype, will be created 
with the new settings, making it easier to maintain standard program settings for your 
drawings and projects.

Prototypes are stored in the c:\Program Files\Land Desktop R2. 

���%
����	����
 Map makers have to cope with the problem of taking lines that 
appear straight on a globe's curved surface and drawing them on a flat map. Map pro-
jections refer to the techniques cartographers and mathematicians have devised over 
the centuries to depict all or part of a 3-dimensional, roughly spherical surface (like the 
Earth) on a 2-dimensional, flat surface (like a map). 

Map projections are either cylindrical or conic. To visualize a cylindrical projection, 
imagine that a sheet of paper is wrapped around the equator of the globe in a cylindri-
cal shape, and the surface features are projected onto the cylindrical sheet from the 
center of the globe. The data on the paper is clearest and least distorted where the 
paper touches the surface of the globe (the equator), but is most distorted at the poles. 
To visualize a conic projection, imagine that a sheet of paper is wrapped around the 
globe in a cone shape. The latitude at which the cone touches the globe has the least 
amount of distortion.

When using a projection type, there will always be some distortion, either of the true 
direction, true distance, true area, or true shape. The standard mercator projection is 
the only projection type in which a straight line represents a true direction, but dis-
tances and areas are greatly distorted. However, if you rotate the mercator projection 
by 90°°, creating a transverse mercator, the projection will represent the poles more 
accurately. 

To reduce distortion, you can reduce the diameter of the cylinder or cone so that part 
of the cylinder or cone intersects the globe. This method reduces the distance between 
the wrapped surface and the globe, and also creates two lines of zero distortion where 
the map touches the surface. These lines are called the lines of true scale. The following 
illustration shows a transverse mercator projection intersecting a globe.

{bmc t-mercat.bmp}

For more information, see the AutoCAD Map User's Guide.

������������
���	
 A polyline, representing a breakline, that is drawn without 
snapping to points in the drawing. The northing, easting, and elevation of the break-
line vertices are determined from the nearest point contained in the surface point data, 
after generating the surface.
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,���	� Bearings are usually referenced by quadrant number. A quadrant is any 
one of the sections resulting from dividing a circle into four equal parts. Quadrant 1 is 
the NE corner, and quadrants 2, 3, and 4 proceed clockwise around the compass.

,������������ A spiral in which the curvature function is a quadratic function 
chosen such that the degree of curve is zero (0) where the spiral meets the tangent. The 
function then increases until it equals the degree of the adjacent curve at the point 
where the spiral and curve meet.

���	� A system of measure in which ππ radians equals 360°.

��������������������'& (R) The radius of a circular arc is labeled R in the following 
illustration:

{bmc ha-def-3.bmp}

���
� Raster data is a series of dots, or pixels, that represents an image. This type of 
data is produced when you scan a paper drawing, blueprint, or a photograph. Raster 
images can be 2-color, grayscale, or color. 

�*��
��������	 The original description of a point, before any description key sub-
stitution has occurred. 

See also full description.

�
�
��
�����
 A curve composed of a clockwise and counterclockwise curve, back-to-
back in a horizontal alignment. These two curves form an S-shape.

�����3��3*� (ROW) When building an alignment, one crucial factor is the allowable 
work area. Property lines of the property owners who reside adjacent to the construc-
tion site generally specify these limits, which are called right-of-way lines.

����
����

��	� Matching a distorted raster image or vector object to known vector 
points. Because a raster image, such as an aerial photograph, likely contains some dis-
tortion, you can select control points on the raster image and match them to vector 
control points (known points in the X,Y,Z coordinate system). You can also match vec-
tor-to-vector. 

�
����	 Short for cross section. Cross sections are section views taken at a 90-degree 
angle to the alignment.

�
����	������
� A method of calculating volumes. The section method calculates 
cross sections from two surfaces and generates volumes using either of two methods: 
Prismoidal or Average End Area. 

�
����������
 (drawing) A setup profile is a saved group of drawing settings. Default 
drawing setup files that are included with AutoCAD Land Development Desktop 
include the following:

i100.set (Imperial, 1″=100′)

i20.set (Imperial, 1″=20′)

i40.set (Imperial, 1″=40′)

i50.set (Imperial, 1″=50′)

m1000.set (Metric, 1:1000)

m2000.set (Metric, 1:2000)
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m250.set (Metric, 1:250)

m500.set (Metric, 1:500)

NOTE None of the default setup files contain any information about the current zone. 
You must set the current zone yourself.

����������
	� A menu that is displayed when you select an object and then click 
the right button of your mouse. Shortcut menus are context-sensitive so that only 
commands that are relative to the object that you selected are displayed.

��	������������ A spiral in which the curvature function is a sine function, chosen 
such that the degree of curve is zero (0) where the spiral meets the tangent. The func-
tion then increases until it equals to the degree of the adjacent curve at the point 
where the spiral and curve meet.

���
 To calculate volumes, you must define the area that will be used in the volume 
calculations. This area is called a site, which you can define using grid cells. The site is 
limited to rectangular shapes. The site definition is used by the Grid, Composite, and 
Section volume methods, and is stored in the control file, {project}.gcf. This file also 
holds any site definitions for the project, and all the volume calculations.

The following figure illustrates a defined site:

{bmc DEF-SITE.BMP}

����
�����	��
� Triangles that have comparably little area, resulting from the trian-
gulation of three points in which one point is only slightly offset from the edge that 
is created from the other two points. 

����
 The incline or decline of a surface, expressed as a ratio of either horizontal dis-
tance to vertical distance or run to rise. For example, the ratio for a 2-to-1 slope is 
expressed as 2:1 (2’ of run to 1’ of rise).

������������ Azimuths south of the equator are referenced to due South clock-
wise. 

The following figure illustrates two lines, one with south azimuths on and the other 
with north azimuths on. 

{bmc S-AZIMTH.BMP} 

��

�����
 Common references that are found in various publications on highway 
design. A speed table for a horizontal alignment includes a design speed with a list of 
the following: degree of curve, radius, superelevation rate (e), spiral length or A factor 
for 2 lane designs, and spiral length or A factor for four-lane designs.

���
���������� A mathematical value representing the ellipsoid radius locally. You 
can determine the spheroid radius from the ellipsoid and latitude of the point of inter-
est.

����� A curve comprised of short segments that does not have a consistent rate of 
curvature or radius. 

{bmc AP-SPI-1.bmp}

In modern transportation design, vehicle dynamics, as well as safety and comfort con-
siderations, dictate the need to avoid abrupt changes in horizontal curvature. Such 
changes, which are encountered either where a tangent meets a circular curve or at 
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points of compound curvature, can be avoided by using spiral (or transition) curves. A 
spiral also provides the logical location for the introduction of superelevation, so that 
it is matched to the local curvature of the alignment at every point.

�������������
 (SC) The point where a spiral meets a curve.

����������	�
	� (ST) The point where a spiral meets a tangent.

�����
�
����	 Refer to the elevation of a single point in the drawing. Use spot ele-
vations to define areas that are sparse in contour data when generating a TIN using the 
contour information. Areas that may also need spot elevations are the top of hills, val-
leys, and bottom of swales.

���
��� The process of placing stakes in the ground at control points on a site that 
is being developed. For example, after you place points in your drawing, or after you 
design an alignment, you can create stakeout reports that list the coordinates of each 
stake. Someone else can then use these stakeout reports to place (or adjust) the stakes 
at the site.

��	������
���	
 A breakline defined from selecting consecutive points or point 
numbers, or selected 3D polyline or 3D line objects.

���
���	
 The plane-rectangular coordinate systems for use in defining geodetic 
stations. A grid is imposed upon a map projection of a specified zone or area. Northing 
and easting coordinates in a state plane system are called Grid Northing and Grid East-
ing.

��������
�� Static labels are labels that never change position, content, or style after 
you create them. Static labels are not updateable. They will never be updated when you 
edit the object the label is associated with, or when you edit the style of the label. 

See also dynamic labels.

�����	�	� (Chainage) Horizontal alignments are generally labeled to provide a ref-
erence when talking about a specific point along the reference baseline. This labeling 
is called stationing and is marked out every 100 feet along the alignment (U.S. 
method). When referring to any point along the alignment, the station is given in 
hundreds of feet. For example, for information for a point that sits 1776.85 feet into a 
project, the station is 17+76.85. In the metric system, it is displayed in thousands of 
meters. For example, information for a point that sits 1776.85 meters into a project, is 
at station 1+776.85.

����4������ The difference between two surfaces that exist in a drawing, usually 
the existing ground surface and a finished ground surface, and is used for calculating 
volumes. Strata is the plural of stratum. 

The following illustration shows an example of a stratum. 

{bmc stratum.BMP} 

����������	 An unimproved tract of land surveyed and divided into parcels for pur-
poses of sales.

���
�
�
����	 Used on curves to compensate for the centrifugal force on a vehicle. 
In order to maintain safe, continuous operation of a vehicle, the traveling lanes are 
superelevated, or banked, around the curve.

�����
�
	��	������	�
 The supplementing distance is the maximum distance 
between contour vertices. If the distance between vertices on a contour is greater than 
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specified, then points will be added along the contour. Used when creating contour 
data for a surface; not for creating contours.

�����
�
	��	�������� You can use the supplementing factors to supplement or add 
vertices along contours that are long and contain few vertices. The supplementing dis-
tance is the maximum distance between vertices. If the distance between vertices on a 
contour is greater than specified, then points will be added along the contour at the 
specified distance along the contour. The smaller the distance, the greater the number 
of supplemented points. 

For contours that contain curves, the bulge value is a minimum mid-ordinate distance 
along a polyline curve. Polyline curves are not actually curves; they are small, straight 
segments that mimic the appearance of a curve. The bulge factor can add more vertices 
to a polyline curve, making it appear more curve-like.

Use supplementing factors when creating contour data for a surface, not for creating 
contours.

�����
 A triangular irregular network (TIN) of elevational data. The points of a sur-
face are connected into triangles, which are then used to interpolate contours, and to 
generate profiles, cross-sections, and random elevation data. A surface represents the 
ground condition at a particular time or event. For example, the existing ground sur-
face defines a ground before it was modified, and a proposed or finished ground sur-
face is based on a site design of proposed earthwork.

�����
��
 The 3-dimensional (3D) area of a triangle face computed from the 
northing, easting, and elevation of each triangle point. The total surface area is the 
sum of the 3D triangle face areas within the surface boundary(s).

�����
�����
� The limits of a surface based on the 2-dimensional extents (mini-
mum and maximum northing and eastings) of the triangulated surface data.

�����
����	��� The active area(s) of a surface defined from a closed polyline.

���
 (tag) When objects are too short for full labels, you can label them with tags. 
You can create tables for these tags that list full object information. 

�����
� Tag labels are shortened labels used to mark a line, curve, or spiral. By 
default, a line is tagged with L, a curve with C, and a spiral with S. Each line, curve, 
and spiral is also given a tag number. For example, your lines would be tagged with L1, 
L2, and so on. 

After you label your objects with tags, you can create tables which display the tag num-
ber and then list detailed information about the object. When you use a table, you can 
usually display more information about an object than you could if you were labeling 
the object itself.

�	�
	� A straight line that touches a given curve at only one point, and does not 
intersect it (line slope equals curve slope at point).

�	�
	���
	������������������'&� ��" The tangent length of a circular arc is 
labeled Tc in the following illustration:

{bmc ha-def-3.bmp}

�
���	 A terrain model represents the surface of the Earth, either as it currently exists 
(existing ground or as-built), or at a future time (finished ground).
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�5/ Triangular Irregular Network. Created when you build a surface. A TIN is the 
most common method of interpolating elevational data. The points are connected 
into triangles which are used to interpolate for contours, profiles, cross-sections, and 
random elevation data. The lines that make up the surface triangulation are called TIN 
lines.

��������� The features of the actual surface of the Earth.

�������� A group of associated objects in a map. For example, a topology can be 
comprised of the rivers or county boundaries in the area that you are mapping.

��	��
��
�����	���������%
����	 To visualize a transverse cylindrical projection, 
imagine that a sheet of paper is wrapped around the Earth at 90°° or 270°° rotation from 
the equator, and the surface features are projected onto the cylindrical sheet. The data 
on the paper is clearest and least distorted where the paper touches the surface of the 
Earth, but most distorted at the open ends of the cylinder. This type of projection is 
called the Transverse Mercator, Gauss-Kruger, or Gauss Conformal projection.

To reduce distortion, the diameter of the cylinder can be reduced so that part of the 
cylinder intersects the globe. This method reduces the distance between the wrapped 
surface and the globe, and also creates two lines of zero distortion where the map 
touches the surface. These lines are known as the lines of true scale. 

The following illustration shows a transverse mercator projection intersecting a globe. 
The areas closest to the circle (where the paper touches the Earth) have the truest val-
ues. By drawing the cylinder so that it intersects the Earth, there are more true values. 
See also transverse cylindrical projection.

{bmc t-mercat.bmp}

���	��
��
 The 2-dimensional (2D) area of a triangle face computed from the 
northing and easting of each triangle point. The total triangle area is the sum of all 2D 
triangle areas with the surface boundary(s).

����� �����
" The process of removing unwanted TIN lines from a surface, thereby 
removing triangles.

���	
��	��
'& The following illustration shows turned and deflected angles:

{bmc S-O-ANGL.BMP}

�	��
������	��
��
��
���������%
����	 A military grid reference system based on 
the transverse mercator projection. Abbreviated as UTM. 

See also transverse cylindrical projection.

60$0 United States Geological Survey.

6�7����
 Universal Coordinate Time (UTC) corrected by ∆∆ UT1 (DUT1). UT1 = UTC 
DUT1.

6�����	
 Universal Transverse Mercator. A military grid reference system based on 
the transverse mercator projection. 

See also transverse cylindrical projection.

�
���� Vector data is a group of mathematical equations that generates lines, arcs, 
and so on. This type of data is produced when you draw objects in your drawing. 

�
����������� A real number, other than 1.0, used to exaggerate the vertical repre-
sentation of a surface. To determine the elevations of the surface, apply the vertical fac-
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tor to the difference between the real elevation and the base elevation, then add the 
result to the base elevation.

�
���������
 The vertical scale is compared against the horizontal scale to calculate 
the vertical exaggeration in profiles and cross sections. It does not actually change the 
scale that is used when the drawing is plotted. 

�����
������
 A volume surface is created when you calculate volumes using the 
grid or composite methods. The surface is created from the two surfaces that make up 
the stratum. The elevational values of a volume surface are actually the difference 
between the two surfaces. For example, at point 1000,1000, the bottom surface has an 
elevation of 100, and the top surface has an elevation of 150. The elevation of point 
1000,1000 on the volume surface is the difference between the two surfaces, which is 
50. 

In terms of cut and fill situations, if a point is in a fill situation, then the elevation of 
the volume surface at that point is a positive number. If a point is in a cut condition, 
then the elevation of the volume surface at that point is a negative number.

Because surfaces are generated from the grid and composite volume calculations, you 
can create cut and fill contours from a volume surface to show the depths of cut and 
fill, and you can use any of the surface display commands to view the surface.

8�����$
��
����0���
� Abbreviated as WGS. Satellite measurements have led to 
the use of WGS-84 as one of two best ellipsoids for the entire geoid. The largest discrep-
ancy between the geoid and the WGS-84 ellipsoid is 60 meters above and 100 meters 
below. Because the Earth's radius is about 6,000,000 meters, the maximum error is one 
part in 100,000. Global ellipsoids ensure consistency among all maps.

*�����
���	
 Represents terrain features such as retaining walls, curbs, bridge abut-
ments, and so on. You can define these breaklines by selecting an existing polyline. 
The command extends this polyline by creating new polyline segments and vertices 
that are parallel to the original polyline, but offset at a very small incremented dis-
tance.

*�
����������� A polyline representing the trail of a water drop as it follows the 3D 
triangle faces of the surface. The path of the water drop trail continues until it reaches 
an outflow area.

*�
���
� The catchment area for rainfall that is delineated as the drainage area pro-
ducing runoff. Base flow in a stream also usually comes from the same area.

*

��	�������� You can use the weeding factor settings to reduce redundant points 
along the contours by ignoring contour vertices that are close together or along a 
straight line. A larger distance and deflection angle will weed a greater number of 
points. Distance is an absolute measure and the angle is measured in degrees. The 
larger the distance value, the greater the number of weeded points. The weeding fac-
tors must be less than the supplementing factors.

A point on the contour is weeded by calculating its location in relation to the vertices 
before and after it. If the length between these three points is less than the weeding 
length value, and the deflection angle is less than the weeding angle value, then the 
middle point will not be added to the contour data file.

Used when creating contour data for a surface; not for creating contours.

{bmc weed-fac.bmp}
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*

��	�� The removal of points along a selected polyline representing a contour. 
The weeding factors determine the amount of points removed. You can use weeding 
to reduce the amount of point information taken from the contours that may not be 
necessary to generate an accurate surface.

See also weeding factors.

9�.
� An XDRef is a pointer to an entire column of data in an external database. 
The database must be keyed by point number. Then when an XDRef is used to get a 
value for some attribute of a point, the point number is looked up in the database, and 
the value from the specified column is used, in place of the point's original attribute 
value.

�����
 Elevational value in an X, Y, Z coordinate system.

�
���
�
����	� Contours created at an elevation of zero.

�
��3�
������
�������
 An AutoCAD text style that has a height of zero assigned to it. 
For example, by default, the AutoCAD STANDARD text style is a zero-height style. 

A zero-height text style requires you to specify the height each time you use the text 
style. In contrast, a fixed-height text style does not require you to specify the text 
height each time that you use it. 

��	
 Synonymous with Global Coordinate System. The global coordinate system 
describes how the sphere of the Earth is projected onto a sheet of paper and converted 
to the Cartesian coordinate system. A global coordinate system can differ based on the 
projection type, datum, and units that are used.

You can define a new global coordinate system by choosing a projection type, units, 
and a datum. For example, a global coordinate system may be based on the Lambert 
Conformal Conic projection, the North American Datum of 1983, and metric units.
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Index

2D line
surface border, 738

2D polyline
converting

from 3D polyline, 843
to 3D polyline, 844

surface border, 739
3D grid layer, 924
3D line

surface border, 738
3D polyline

converting
from 2D polyline, 844
to 2D polyline, 843

displaying grade breaks, 846
editing, 844
filleting, 845
joining, 851
surface border, 739

3D polyline vertices
adding, 847
weeding, 852

3D polyline, creating, 834
by referencing point elevations, 834
by referencing points and slopes, 837
curb, 839
step, 841

3D polyline, grade breaks, 846
3D projection layer, 925
3D surface grid, 765, 771

A
acute and obtuse angles, listing, 936
alignment, 426

creating
defining, 436
drawing, 434
from objects, 436
from polyline, 438

creating offsets, 440
deleting, 464, 465
deleting multiple, 467

displaying current, 463
editing, 447
importing, 463, 464
importing multiple, 466
label settings, 476
locking, 427
making current, 434
merging, 471
moving to different layer, 468
output to ASCII file, 488, 489
point of intersection, 449
sharing data, 427
stakeout, 484

settings, 484, 486
alignment database, 426

closing, 433
locking, 428
saving, 432

alignment properties, 468
color, 469
description, 470
linetype, 470

alignment station equations, 443
changing, 443
clearing, 444
creating, 443
deleting, 446
exiting, 447
modifying, 445

alignment station labels, 478
creating, 480
offset values, 482
settings, 476, 478

alignment stations, 236, 478
display format, 474

alignment, reporting data, 457
by curve, 459
by increments, 461
by station, 458
by station and curve, 460
stakeout, 484, 486
station and offset, 483
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ASCII file output, 488, 489
AutoCAD Land Development Desktop See Land 

Development Desktop
Auto-Range

slope, 760
average end area, 875, 900
average method, elevation

2D solids, 750
3D faces, 753
polyface, 755

B
banding method, elevation

2D solids, 756
3D faces, 757

barbed wire fence, drawing, 422
base point, 58
blocks, 631
border

layer, 922
line, 65
scaled block, 66
style, 65
unscaled block, 66

border (surface)
2D line, 738
2D polyline, 739
3D line, 738
3D polyline, 739

boundary
creating, 673
importing, 679
information, 690
Terrain Model Explorer folder, 690

breakline
changing description, 670
defining

curbs, 664
walls, 664

deleting, 671
editing, 669
exporting, 672
folder, 689
identifying, 667
importing, 668
importing definitions, 659
information, 689
listing, 667
proximity, 661
updating, 671

breakline data, surface generation, 654
breakline file, 660

creating, 660
importing, 659

breakline, creating, 654
from 3D lines, 658
from point numbers, 656

from points, 655
from polylines, 657
manually, 660

building offset label, 584

C
chain link fence, drawing, 423
chord definition, railway curve, 934
clipboard, copying quick sections, 865
clothoid spiral, 401
COGO database import options, 265
COGO points, 90
column headings, 274

thickness, 277
user defined, 276
XDRef, 278
Z-, 277
Z+, 276

composite method, volume calculation, 895, 
897

composite volume settings, 894
compound spiral, 404
contour

data, 649
digitize, 818, 820
editing, 817
exploding to polylines, 817
folder, 689
layer, 821, 923
managing, 792
properties, 808
surface generation, 650
surface triangulation, 653
text style, 796
utilities, 817
weeding, 824

contour elevations
assigning, 822
changing, 820

by addition or subtraction, 822
each contour on a layer, 821

listing, 944
zero, 823

contour grips
hiding, 808
showing, 808
using, 809

contour information, 689
missing, 653

contour label, 809, 810, 811, 812, 813
deleting, 814, 815
editing, 816
grips, 816
hiding, 815
position, 797
showing, 815

contour points



Index | 1203

adding, 824
removing, 824

contour settings
appearance, 793, 796, 797, 799, 800, 801, 

802, 803, 804
label position, 797
text style, 796

contour style, 793
creating, 799
deleting current, 801
deleting saved, 802
folder, 801
loading, 803
managing, 799
path, 804
renaming, 802
saving, 801
selecting current, 800
settings, 793, 796, 797, 799, 800, 801, 

802, 803, 804
contour, copying and offsetting, 825

creating multiple offsets, 828, 829
using grade, 827
using slope, 826

contour, creating, 792, 817
by copying and offsetting, 825
from built surface, 805
from existing contour, 825
from surface, 805

converting points, 294
coordinate display settings, 102
copying points, 306
cross sections, quick See quick cross sections
curb breakline, 664
curb, creating, 839
current

drawing scale, 153
point number for a drawing, 95
point number for a user, 96

current alignment
displaying, 463
selecting, 434

current zone, 57
curve

attaching to object, 336, 410
data, 934
drawing See draw curve
label, 523
railway, 934
roadway, 934
selecting, 203

curve definition
by chord length, 358
by degree, 357
by external secant, 357
by length, 357
by middle ordinate distance, 358

by minimum distance, 358
by radius, 359
by tangent length, 357

curve label styles, editing, 540
arrows, 545
crows feet, 545
data elements, 543
precision values, 545
text above/below, 544
text properties, 542
ticks, 545

curve stakeout report, 317
curve table

border, 605
column definition, 605
creating, 604
loading, 607
sorting, 604
split, 605

cut and fill areas, 891

D
data files, editing, 75
database, alignment, 426
DEM files

adding to surface data, 636
building surface with DEM data, 642
changing properties, 641, 645
data in, 646
importing boundaries, 644
memory usage, 635
obtaining, 635
removing, 640
using as surface data, 634

DEM statistics, 688
description key, 144

creating, 147
deleting, 157
description parameters, 162, 163
importing older description key files, 159
manager, 147
matching, 136
properties, 159
rotating, 163
scaling, 163
settings, 104
substitution, 170
symbol, 146

rotating, 150, 152
scaling, 150, 152

wild card characters, 164
description key file, 156, 160

deleting, 158
loading from a prototype, 161
saving to a prototype, 160

description keys
fixed scale, 154
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scaling globally, 154
description parameters, 162
digitize contour, 818, 820
direction, lines and alignments, 229
draw curves, 356

best fitting, 364, 367
between two lines, 356
compound, 363
defining See curve definition
fixed radius/start point, 340, 341
from end of object, 362
multiple curves, 361
on two lines, 359
radius, 362
reverse, 363
special curves, 414
through a point, 360
with two compound spirals, 385
with two reverse spirals, 387

draw lines, 338
best fit, 348
by defining direction, 342
by station and offset, 345
by turned or deflection angle, 344
COGO points, 339
defining a direction, 342
deflection angle, 344
from ends of objects, 347
perpendicular to an object, 352
point numbers, 339, 340
radial to an object, 352
range of point numbers, 340
selecting points, 338
selecting start and end points, 338
special lines, 414
station and offset, 345
tangent, 351
using COGO points, 339
using point numbers/range of point 

numbers, 340
with symbol, 420
with text, 419

draw spirals, 370
between curves, 378
between tangents and curves, 375
between two lines, 372
with curve, 385, 387

drawing settings
changing, 76
loading, 78
output settings, 79
saving, 77

drawing setup, 48, 49, 74
loading profiles, 50
precision values, 54
saving setup profile, 51
scale, 55

sheet size, 57
units, 52
using the wizard, 48

drawings
base point, 58
border style, 65
creating new project, 10
current zone, 57
north rotation, 61
opening existing, 12
reassociate, 38
sheet size, 57
starting new, 6
text style, 63
units, 52
using existing project, 8
watershed boundaries, 713

duplicate point numbers, 194
dynamic label

angular direction, 569
deleting, 570
disassociating, 570
grip edit, 571
properties, 571
swapping text, 568
updating

all, 568
preventing, 570
selected, 567

E
edit

alignment curve, 451
alignment spiral, 453

edit history folder
deleting edit, 727

edit label styles
curve label, 540
line label, 533
point label, 552
spiral label, 546
using a formula, 560

elevation
changing, 733, 820
contour, 820
listing, 944
listing at slope, 945
surface points, 730
tracking, 946
zero elevation, 823

erasing points, 307
explode contours to polylines, 817
export points, 264

import/export format, 267
point data, 289

external data references See XDRefs
external database file, 179
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external point data references, 172
external point database

creating, 173

F
fence

barbed wire, 422
chain link, 423
stockade, 422

file locking, alignment, 428
backwards compatibility, 431
multiple sessions, 430
profile and cross section data, 431

filleting, 845
filters

finding a project, 11, 28
fixed scale factor, 152

G
geodetic calculator, 331
geodetic zone transformation settings, 81
grid

3D faces, 765
3D polylines, 771
tolerance factor, 887
volume, 878

grid method, 886, 888
grid volume ticks, 891
guard rail, drawing, 417

H
HIDD_EDIT_TAG_CURVE_LABEL, 592
HIDD_EDIT_TAG_LINE_LABEL, 588
HIDD_EDIT_TAG_SPIRAL_LABEL, 594
history folder

editing, 690
horizontal alignment editor

editing curve, 451
editing spiral, 453
navigating, 449

horizontal alignment. See alignment

I
import

3D Lines, 726
alignments, 463
breakline, 668
breakline file, 659
multiple alignments, 466
parcel lines and labels, 501
sites, 885
surface sections, 859
volume sections, 914, 915
watershed boundaries, 715

import points, 94, 264
import/export format, 267

into COGO point database, 286
point data, 286
using description keys, 144

import/export format
copying, 284
creating, 267
modifying, 285
removing, 285
viewing, 284

inquiry, 930
areas, 941
distances, 939
elevations, 944

contour, 944
surface, 944

geodetic inverse, 931
latitude and longitude, 930
northing/easting, 930
object design properties, 936
object geometry, 933

angles, 936
curve, 934
line, 934
railway curve, 934
roadway curve, 934
spiral, 934
spiral radius, 935

slope information, 944
station and offset, 932, 933

current alignment, 933
object, 932

inserting points, 197
interpolating points, 251

along a line, 252

L
label

alignment, 523, 532
building offset, 584
commands, 516
contours, 809, 810, 811, 812, 813
creating, 516

dynamic, 566
static, 574

curve, 523
by points, 577

deleting, 570
disassociating, 570
dynamic, 516, 518, 566

creating, 566
updating all, 568
updating selected, 567

geodetic, 516
grip edit, 571
line, 521, 576

by points, 576
polyline, 579
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properties, 571
spiral, 524
static, 516, 573

creating, 574
curve segment, 575, 577
line segment, 575, 576

station and offset, 482
storing, 517
swapping text, 568
tag, 516
type, 516
updating, 518

dynamically, 518
manually, 520

label point, 525
geodetic information, 580
northing and easting, 580

label settings, 517
curve, 523
line, 521
point, 525
spiral, 524

label style, 516, 528
current, 529, 530
curve, 540
folder path, 517
formula, 560
line, 533
point, 552
point block only, 529
spiral, 546

label style properties
curve, 540
line, 533
point, 552
spiral, 546
using a formula, 560

label styles
leroy, 528
metric, 528

Land Development Desktop, 2
AutoCAD options, 70
editing data files, 75
preferences, 71

AutoCAD New command, 74
AutoCAD Open command, 73
set up new drawings, 74

program paths, 71
settings, 70

changing, 76
loading, 78
saving, 77

starting, 6
unloading applications, 22

Civil Design, 22
Survey, 22

layer

3D grid, 924
3D projection, 925
border, 922
contour, 821, 923
polyline grid, 924
range, 923
site grid, 926
surface, 922
terrain, 922
volume ticks, 926
water drop, 925

least squares adjustment, 348
ledge, drawing, 416
leroy and metric label styles, 528
line

attaching attaching to object, 336, 410
defining

by azimuth, 343
by bearing, 342
by point selection, 343

direction, 342
drawing See draw lines
extending, 346
label, 521
selecting, 203
shortening, 346

line border, 65
line label styles, editing, 533

arrows, 540
crows feet, 540
data elements, 536
precision values, 539
text above/below, 538
text properties, 535
ticks, 540

line table
border, 598
column definition, 599
creating, 597
loading, 603
precision

angular, 602
linear, 602

sorting, 598
split, 599

listing an area
lines and curves, 941
points, 942
polyline, 942

listing breaklines, 667
listing data

angles, 936
areas, 941
curve, 934
distances, 939
elevations, 944
line, 934
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railway curve, 934
roadway curve, 934
slope, 944, 945
spiral, 934
spiral radius, 935

listing elevations
contour, 944
surface, 944

location
latitude and longitude, 930
northing and easting, 930
selecting, 203
station and offset, 932, 933

lock files, 35
managing, 35
projects, 35

lots, numbering, 495

M
manage projects, 26
margins, 909
menu palette

changing name or description, 20
creating, 18
deleting, 21
restoring original, 16
saving, 20
selecting, 16
using, 15

MENULOAD command, 16, 18
multiple surfaces, 856

N
New command, 6
north rotation, 61
numbering convention for points, 94

O
object geometry, 933
object table, 588

creating, 597
curve table, 604
line table, 597
spiral table, 608

deleting, 614
editing, 612
updating, 613

objects
attaching lines, curves, and spirals, 336, 

410
attaching spirals, 389
defining an alignment, 436

offset spiral, 405
Open command, 12
opening drawings, 12
OPTIONS command, 70

output settings, 79

P
palette See menu palette
parallel spiraled alignments, 406
parameter (rotation), 153
parameter (scaling), 152
parcel, 494

breaking crossing lines, 514
changing settings, 495
deleting, 502
drawing, 494
importing lines and labels, 501
managing, 498
merging, 503
renaming, 503
reporting data, 498
selecting curved line, 494
volume table, 919

parcel, defining, 505
from lines and curves, 505
from points, 507
from polyline, 506

parcel, sizing, 508
by swinging bearing line, 511
by swinging bearing to curve, 512
using radial line, 509
using slide bearing line, 508

plotting
all, 909
page, 909
settings, 905, 907, 909
volume sections, 905, 911, 912, 913

point
adding to drawing, 94
checking, 192
COGO, 90
converting, 294
coordinate display settings, 102
creating See point, creating
current, 95, 96

drawing, 95
user, 96

description key settings, 104
description settings, 97
display properties, 298
displaying information, 187
duplicate numbers, 194
editing See point, editing
elevation settings, 96
exporting, 264, 289
extents

drawing, 328
zooming, 327

import/export format, 267
importing, 264, 286
inserting, 197
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insertion settings, 98
interpolating, 251
locations, 326
locking and unlocking, 191
names, 91
preferences, 110
prompts, 202
properties

display, 298
removing from database, 326
selecting, 184, 203
transferring, 264, 291
update settings, 100
utilities, 326

point blocks, 328
point database

creating, 90
merging, 264, 295
packing, 330
removing points, 326
settings, 185
updating, 193

point file folder, 688
point group, 116

creating, 117
deleting, 129
manager, 116
overrides, 130, 131, 135, 136
properties, 137
removing points, 129
Terrain Model Explorer folder, 688

point label, 109, 146
settings, 525

point label styles, 552
data elements, 555
description keys, 559
marker text, 557
precision values, 558
symbols, 558
text, 557
text properties, 554
XDRef elements, 557

point list, 116
creating, 120, 136, 138
filtering, 122

options, 124, 125, 126
printing, 189
viewing, 127

point marker, 109, 146
symbol settings, 106
text settings, 107

point names, 91
point numbers

COGO points, 339
displaying, 326
drawing a line, 339
duplicates, 194

numbering convention, 94
renumbering, 304
zooming to, 327

point of intersection, alignment, 449
point settings, 202

coordinate display, 102
creating points, 93
description, 97
description key, 104
elevation, 96
insertion, 98
point marker, 106, 107
update, 100

point stakeout report, 314
consecutive points, 321
curve, 317, 318

direction, 317
offsets, 318

output settings, 315
radial, 316
spiral, 319, 320

direction, 319
offsets, 320

point, creating, 202, 204
at intersections, 218
based on a surface, 244
based on horizontal alignments, 236
based on slopes, 247
settings, 93

point, editing, 184, 301
changing coordinates, 308
changing elevation, 303
changing rotation, 310
copying, 306
erasing, 307
listing points, 189
moving, 305
removing, 198
renumbering, 304
restoring, 308
rotating, 305

polyface, 634
polyline

converting to contour, 817
defining an alignment, 438
grid layer, 924

polyline grid layer, 924
polyline label, 579
preferences

AutoCAD New command, 74
AutoCAD Open command, 73
points, 110
set up new drawings, 74

prismoidal method, 875
prismoidal volume calculation method, 900
profile, drawing setup, 50
program paths, 71
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project, 24
associating, 40
changing detail settings, 30
copying, 30
creating, 28, 39
creating externally, 25
deleting, 32
displaying details, 41
finding, 28
locks, 35
managing, 26
renaming, 33
selecting, 27, 39
using filters to find, 11

project path
adding, 26
removing, 27

project point information, 195
prototype, 41

changing settings, 45
copying, 42
deleting, 44
managing, 42
renaming, 43

proximity breakline, 661
defining

by points, 662
by polylines, 662

Q
quick cross sections

color, 869
copying, 865
creating, 863
exploding, 870
grip editing, 869
properties, 866
redisplaying, 866
saving, 865
statistics, 868
updating, 865
viewing, 864

R
radial stakeout report, 316
railroad track, drawing, 418
railway curve data, 934
range layer, 923
redisplaying quick sections, 866
remove

import/export format, 285
points from drawing, 198
points from point database, 326
points from point group, 129
vertices, 824

rename

project, 33
prototype, 43

renumber points, 304
report

data, 457, 459, 460, 461, 462, 915, 918
point stakeout, 314
site information, 884
station and offset, 483

reporting data, 905
resection, 209
restore points, 308
retaining wall, drawing, 419
rotate

coordinates, 310
fixed, 154
parameter, 153
points, 305

S
save

contour style, 801
menu palette, 20
profiles, 865
quick cross sections, 865
quick surface sections, 865

scale settings, 55
determining, 56

scaled block border, 66
SDTS data

converting to DEM, 635
section

plotting, 905
settings, 898, 907

section method, 903
section volume

importing, 914, 915
plotting

all, 912
page, 913
settings, 905, 907
single, 911
text size, 910

settings, 898
section window

closing, 866
redisplaying, 866

settings
drawing, 52, 55
plotting, 905, 907, 909
program paths, 71

sheet size, 57, 909
shore line, drawing, 416
site

grid layer, 926
reporting information, 884
total volume table, 916
volume calculations, 880
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slope ranges, 758
spacing, 909
special lines and curves, 414
speed table, 393

default, 394
editing, 397

spiral
attaching to object, 336, 389, 410
clothoid, 401
compound, 404
cosinusoidal, 402
creating

using speed tables, 393
drawing See draw spirals
graphic model, 407
label, 524
offset, 405
quadratic, 402
selecting, 203
selecting current type, 371
sinusoidal, 402
terminology, 408
types, 401

spiral label styles
editing, 546

arrows, 552
crows feet, 552
data elements, 549
precision values, 551
text above/below, 550
text properties, 548
ticks, 552

spiral stakeout report, 319
spiral table

border, 609
column definition, 609
creating, 608
loading, 612
sorting, 609
split, 609

stakeout
angle type, 314
files, 315
report, 314
settings, 484, 486

start a drawing
existing project, 8
new, 6
new project, 10

start up dialog box, using, 6
static label, 573

creating, 574
curve segments, 575
line segments, 575

station equations
clearing, 444
deleting, 446

exiting, 447
modifying, 445

statistics, 868
surface, 684
surface data folder, 687
terrain folder, 684
volume surface, 690

step, creating in polylines, 841
stockade fence, drawing, 422
stone wall, drawing, 414
stratum, 876

current, 877
defining, 877
deleting, 878

Style Properties dialog bar, 528, 531
style, label, 528

point block only, 529
selecting, 529
selecting current style, 530

supplementing factors, 650
surface

adding non-destructive breaklines, 731
adding points, 729
building, 620
calculating extended statistics, 699
changing elevations, 733
changing properties, 699
closing, 697
copying, 697
defining boundaries, 735
deleting, 698
deleting points, 730
deleting TIN lines, 728
edit history, 727
flat faces

minimizing, 732
flipping TIN faces, 728
import

watershed boundaries, 713
locking, 699
making current, 694
managing, 694
minimizing flat faces, 732
multiple, 856
non-destructive breaklines

adding, 731
opening existing, 695
pasting together, 734
removing boundaries, 735
renaming, 698
saving, 696
saving current, 697
saving with different name, 696
statistics, 684
TIN faces, flipping, 728
TIN lines

adding, 727
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deleting, 728
utilities, 775
viewing

along polyline path, 787
from specified point, 785

water drop paths, 775
watershed models, 706

surface borders
2D line, creating, 738
2D polyline, creating, 739
3D line, creating, 738
3D polyline, creating, 739

surface boundaries
defining, 735
removing, 735

surface creation, 616
2D line borders, 738
2D polyline borders, 739
3D line border, 738
3D polyline borders, 739
new, 619
sections, 856

surface data
adding to surface folder, 625
creating, 625
deleting from surface folder, 680
folder

statistics, 687
roadway cross sections, 680

surface display, 746, 758
elevation

shading, 746
User-Range, 749

legend, 751
settings, 742
slope

Auto-Range, 760
shading, 758
User-Range, 760

surface folder
adding contour data, 650
adding data, 625
adding point files, 626
adding point groups, 625
deleting contour data, 652
deleting data, 680

surface generation
creating a watershed model, 710
creating contour data, 650
from breakline data, 654
from contour data, 649

surface layer, 922
surface point

adding, 729
changing elevation, 730
deleting, 730
labeling elevation, 777

surface point data
creating from objects, 628

surface point file
adding to, 629, 630, 631, 632, 633, 634
appending, 629
creating, 628
overwriting, 629
selecting 3D faces, 633
selecting AutoCAD point nodes, 629
selecting blocks, 631
selecting lines, 630
selecting polyfaces, 634
selecting text, 632

surface sections
creating, 856
defining, 857
grid, 861
importing, 859
listing

elevational difference, 862
point elevation, 862

processing, 858
quick See quick cross sections

surface settings
3D grid generator, 768
3D polyline grid, 772
elevation shading, 746
slope shading, 758

surface triangulation, 653
surface, editing, 726

adding and deleting point, 729
adding line, 727
deleting line, 728
editing point, 730
flipping face, 728
nondestructive breaklines, 731
surface boundaries, 736

T
tag label, 588

creating, 597
tag label styles, 533, 588

editing curve tag
arrows, 594
crows feet, 594
data element, 593
text above/below, 593
text properties, 592
ticks, 594

editing line tag, 588
arrows, 591
crows feet, 591
data element, 590
text above/below, 591
text properties, 590
ticks, 591

editing spiral tag, 594
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arrows, 596
crows feet, 596
data element, 595
text above/below, 596
text properties, 595
ticks, 596

terrain folder statistics, 684
terrain layers, 922
Terrain Model Explorer, 615, 618

managing surfaces, 694
text, 632

size, 910
text style, drawing, 63
tick marks, 891
TIN lines, 726

adding, 727
deleting, 728
editing, 726
viewing as 3D faces, 744
viewing as polyface mesh, 745
viewing as temporary vectors, 743

tracking, 946
elevations, 946
northing and easting, 946

transfer points, 264, 291
transformation reference point, defining

from point coordinates, 86
from point in drawing, 86
from point number, 86

transformation rotation angle, defining
from grid north rotation, 87

transformation rotation point, defining
from point coordinates, 87
from point in drawing, 86
from point number, 87

transformation settings
changing, 81

tree line, drawing, 415
Triangular Irregular Network lines See TIN lines

U
unerase points, 308
unit settings, 52
unscaled block border, 66
update

labels, 518
profiles, 865
quick cross sections, 865
quick surface sections, 865

User-Range
elevation, 749
slope, 760

utility pole, 167

V
view

import/export format, 284
point list, 127
statistics of quick sections and profiles, 868
surface TIN lines as 3D faces, 744
surface TIN lines as polyface mesh, 745
surface TIN lines as temporary vectors, 743

volume
grid, 886
report, 915, 918
reporting, 905
settings, 878
stratum, 877

defining, 877
deleting, 878
selecting current, 877

table, 916
ticks layer, 926
total site, 888, 895, 903

volume calculation methods, 872
average end area, 900
composite, 874
grid, 872
prismoidal, 900
section, 874

volume composite, calculating, 894
volume folder, 690
volume ticks layer, 926
volume, outputting data, 915

ASCII file, 917, 919
parcel volume, 918
parcel volume table, 919
total volume of site, 915
total volume table, 916

volume, parcel
calculating, 897
settings, 887

volume, section
calculating, 898, 903
importing, 914, 915
plotting, 905, 911, 912, 913
reporting data, 905
sampling data, 901
settings, 898
text size, 910

volume, site
calculating, 895
defining, 880
deleting, 886
importing, 885
managing definitions, 884
reporting, 884, 915
settings, 878

volume, surface
changing properties, 703
closing, 701
copying, 702
deleting, 703
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managing, 700
opening, 700
renaming, 702
saving, 701

W
wall breakline, 664
water drop, 775
water drop layer, 925
watershed

information, 690
water drop path, 775

watershed boundaries, drawing, 713
watershed model

changing properties, 709
changing settings, 706
creating, 706

after building a surface, 712
when building a surface, 710

types, 716
watershed types, 716

boundary point, 717
boundary segment, 718

depression, 718
ambiguous, 719
shallow, 719

flat area, 720
multi-drain, 721
split channel, 721

weeding factors, 650
wild cards, 164
wildcard characters, 127
wildcards, 126
Windows metafile

saving cross-section views, 865

X
XDRef, 172, 278

creating, 175
deleting, 181
properties, 180
requirements, 172

Z
zone transformation settings, 81
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